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Key to Using this Guide
This installation guide is for all Thermo-Calc installations running on Windows, macOS or
Linux operating systems. It is also applicable to demo (trial) installations as well as
previously installed versions of Thermo-Calc (the new version is installed alongside the old
version).
This guide includes information about:
l
l

The types of licenses and installations available.
Installing the Thermo-Calc software and its components on stand-alone computers,
servers and client computers.

l

Installing the license management software for network installations.

l

Retrieving and installing license files.

l

Troubleshooting to solve common installation problems.

Icons in this Guide
Name

Description

Information

Provides important information and indicates that more detail is located in
the linked or named topic.

Note

The information can be of use to you. It is recommended that you read the
text or follow the link.

Operating
system

The operating system is indicated when the information is specific to a Windows, macOS
or Linux operating system.

License file

The license file, which contains the license keys and is installed on either a standalone
computer or a network server.

Thermo-Calc

The Thermo-Calc software and its components (including databases) to be installed.

Typographical Conventions
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Convention

Definition

Forward
arrow →

The forward arrow symbol → instructs you to select a series of menu items in a specific
order. For example, Tools → Options is equivalent to: From the Tools menu, select
Options.

Boldface font

A boldface font indicates that the given word(s) are shown that way in on a toolbar
button or as a menu selection. For example, if you are told to select a menu item in a
particular order, such as Tools → Options, or to click Save.

Italic font

An italic font indicates the introduction of important terminology. Expect to find an
explanation in the same paragraph or elsewhere in the guide.

code
bold

and code

A code font indicates you are to make a keyboard entry. It also shows a programming
code or code examples. The code bold font highlights the entry.
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Installation Terminology
Term

Definition

client

A computer without a license file of its own but connected through the network to a
computer with the license information. The client receives a license token from the
computer where the license management software is installed.

consolidated
network

A type of network installation where the Thermo-Calc software and a Thermo-Calc
licensing software are installed on a single server computer. This allows all computers in
the network to access both the software and a license on the server via a client
installation.

distributed
network

A type of network installation where the Thermo-Calc software is installed on one server
computer in a network and the Thermo-Calc licensing software is installed on a different
computer. After a thin client installation, all computers in the network can access both the
software and the network license key via the server.

host ID

The MAC address on the computer that a license is locked to.

license file

The file (called lservrc) that contains all the purchased license keys. It is issued by ThermoCalc Software, usually by email.

license key

The information contained in the license file that represents the products purchased and
which is then authorised for installation.

License
Manager
(Windows)

The Windows program used for license management: it distributes license tokens as
specified in the network license file issued by Thermo-Calc Software.

License
Server
(Linux)

The Linux program used for license management: it distributes license tokens as specified
in the network license file issued by Thermo-Calc Software.

license
server

The use of the term license server (lower case letters) is reserved for use for scripts and
option files (for example, in an Unattended Network Client Installations). For the purposes
of the step-by-step instructions it is not used to refer to the type of network installation
that runs the license management program. Also see License Manager (Windows) and
License Server (Linux).

licensing
software

The Thermo-Calc license management software. When working in Windows it is called
License Manager (full name is Sentinel RMS License Manager by SafeNet) and on Linux it
is called License Server (full name is Sentinel License Sever by Safenet).
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Term

Network
License
(NWL)

Definition
The license type used with the licensing software. The NWL can only be used on one
specific computer that hosts the licensing software. This restricts license usage to a certain
subnet or subnets.
The software may be used on the number of sites you have paid for and by the number of
persons you have paid for on any number of network connected computers

standalone
computer

A computer which uses a SUNLL license type.

Single-UserNode
LockedLicense
(SUNLL)

A unique license file for one designated computer at one designated site. It cannot be
copied or moved outside the site. If the software is installed on a portable computer, it
can be temporarily used off-site. The license can be used without network access (to the
License Server).

thin client

An installation where the software is installed on a file server but is run from a client
computer. The licensing software may be installed on the file server (consolidated
network installation) or on a different computer (distributed network installation).

XQuartz

An open-source X Windows System, which is required to run Thermo-Calc on a Mac.
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About the Thermo-Calc Components Being Installed
What is Installed with a Full Standalone or Full Network
Client Option?
At the start of the installation process, the following components are installed when you
choose either the Full Standalone or Full Network Client options. If you want to exclude a
component (perhaps one of the SDKs), then you would use the Custom option.

A full installation means that all listed feature components are installed but the availability
of the individual components is based on the license you have. This is also applicable to the
databases and software development kits (SDKs).

Thermo-Calc
The Thermo-Calc software includes several add-on features and capabilities that are
packaged with the software and included with a full standalone or network client
installation. For example, there are the specialized add-on products Diffusion Module
(DICTRA), Precipitation Module (TC-PRISMA), and Process Metallurgy Module as well as the
Steel Model Library. For most of these specialized features, demonstration (demo) versions
and examples area available for all users but advanced features are only available with a
license.

Databases
All the latest databases are installed. As with the software features, availability of a specific
database in the software itself is based on license. However, several demonstration
(demo) databases are included and available to all users.
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Software Development Kits (SDKs)
When the Full Standalone or Full Network Client option is chosen, it installs the TC-Python,
TC-API and TQ-Interface SDKs. It does not install TC-Toolbox for MATLAB® (available only for
Windows) unless the program finds a MATLAB® installation on your computer during this
installation process, at which point you are asked if this component should be also be
installed.
The TC-Python program is installed when the Full Standalone or Full Network Client option
is chosen, but there are additional steps required to complete the installation as described
separately in the TC-Python Quick Installation Guide.

What does the Custom option allow me to do during an
installation?
During the installation process, there is some flexibility to choose what to include or exclude
with the installation by choosing the Custom option. This is primarily to the level of being
able to choose the SDKs or to exclude all databases or Thermo-Calc itself. That is, you cannot
choose specific Thermo-Calc features or databases as these are controlled by the license
and not the installation procedure.
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System Requirements and Platforms Tested
About the Thermo-Calc Components Being Installed
A full list of system requirements and program availability are found on the Thermo-Calc
website. You can also see our roadmap for platform support to use for planning purposes.
The software development kits (SDKs) are available as follows for the indicated platforms:
SDK

Windows

Mac

Linux

TC-Python

x

x

x

TQ-Interface

x

not available

x

TC-API

x

not available

x

TC-Toolbox for MATLAB®

x

not available

not available

Thermo-Calc and its components are tested on these platforms for Thermo-Calc 2020b:
Windows

Mac

Windows 10 64-bit

macOS X Catalina
10.15.4

Linux1, 2
l

Ubuntu 19.04 (Disco)

l

CentOS 7.6

l

OpenSUSE 15.0

1 Thermo-Calc Software cannot guarantee full functionality if the software is installed on other Linux distributions.
2 If you are installing on CentOS 7, it is recommended you install gtk2 before you run the installation script.
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License and Installation Types
In this section:
License and Installation Types

11

About License Keys and Files

12

Standalone Installations (SUNLL)

13

Multi-User Network Installations (NWL)

14
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License and Installation Types
Installation procedures are based on the license type, the installation type and the operating
system.
Demo (trial) installations: Only a standalone installation is available and a
license file is automatically installed.
License
type

Installation Type

Windows

macOS

Linux

SUNLL

Standalone

Yes

Yes

Yes

Consolidated network

Yes

No

Yes

Distributed network

Yes

No

Yes

License installations on a server
network

Yes

Yes1

Yes

NWL

1 For macOS, the licensing software is installed on a Windows or Linux computer server.

www.thermocalc.com/purchase/licensing-options/
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About License Keys and Files
Demo (trial) installations: A license file is automatically installed with the
software. You do not need to request it.
To run Thermo-Calc and its components you need a valid license key for each product. The
license keys are included in the license file emailed to you by Thermo-Calc Software.
You can copy the license file to the applicable computer(s) before or after installing the
software––the license file itself is not required during the installation process. However, it is
required to make calculations in Thermo-Calc.
Request a License File from Thermo-Calc Software
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Standalone Installations (SUNLL)
The standalone installation is used with the Single-User Node-Locked License (SUNLL). The
Thermo-Calc software
and a Thermo-Calc license file
are installed on a
standalone computer. You can do a full (all operating systems) or a custom installation
(Windows and Linux only).

To get started, go to First Steps of Installation and then Standalone Installations.
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Multi-User Network Installations (NWL)
There are different types of multi-user network installations: consolidated, distributed and
where the licensing software is installed on a computer network. There is also a subtype of
installation called thin client, which is a step done with the consolidated and distributed
network installations.
Thin client installations: A thin client installation is where the Thermo-Calc
software is installed on a computer server but is run from a client computer.
The licensing software can be installed on the computer server (a consolidated
network) or on a different computer (a distributed network). This type of
installation is available for Windows and Linux operating systems. The client
computer must have the Thermo-Calc software installed. This type of
installation mainly sets environmental variables and paths on the client
computer.

Consolidated Network Installations
The consolidated network installation is used with a Network License (NWL) and it is
available for Windows and Linux operating systems.

The Thermo-Calc software

and the license management program are installed on the

same server where the license file
is also copied. A thin client installation allows all
computers (the clients) in the server network to access both the software and the licensing
on the same computer server.
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To get started, go to First Steps of Installation and then Network Client Installations.

Distributed Network Installations
The distributed network installation is used with a Network License (NWL) and is available
for Windows and Linux operating systems.

The Thermo-Calc software

is installed on one computer server in a network and the

licensing software is installed on a different computer server where the license file
is
also copied. A thin client installation allows all computers (the clients) in the server network
to access both the software and the licensing on the two computer servers.
To get started, go to First Steps of Installation and then Network Client Installations.

License Installations on a Server Network
When a license file is installed on a server network, it is used with a Network License (NWL).
It is available for all platforms. However, for macOS the server containing the licensing
software must be set up on Windows or Linux.
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The licensing software is installed on a computer server where the license file
copied. The Thermo-Calc software
needs it.

is also

is installed on every computer in the network that

To get started, go to First Steps of Installation and then Network Client Installations.
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Preparing for Installation
In this section:
First Steps of Installation

18

Installation Default Directories and the License File

19

Installation Default Directory: Windows

20

Installation Default Directory: macOS

22

Installation Default Directory: Linux

23

Installation Default Directory: Databases

24

Installation Default Directory: Materials

25

Installation Default Directory: Process Metallurgy Materials

26

Installation Default Directory: Custom Property Models

27

Installation Default Directory: TC-Toolbox for MATLAB®

28

Subnet Information for Network Licenses

29

macOS Installation Notes

29

Linux Installation Notes

31
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First Steps of Installation
This section reviews some of the things you need to do before installing the Thermo-Calc
software.
l

Learn about the default directories where the software and license files are installed.

l

For network installations, collect subnet information.

l

For Mac, install XQuartz and make sure the security preferences are set correctly.

l

For a Linux Cent OS 7 installation, also install gtk2 before you run the installation
script.
yum install gtk2

Should I get my license file before or after software installation? The license
file itself is not required during the installation process (and not at all for demo
installations). However, it is required to make calculations in Thermo-Calc. The
license file has details about your computer(s) that in some cases cannot be
determined accurately until after installation (especially for a network
installation). For most users it is recommended you request the file before you
start installing.
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Installation Default Directories and the License File
The default directories where the software and its components are installed, including
where the license file is stored, vary by platform and user type.
If you want to select specific components to install or if you want to install the software in a
non-default installation directory, then do a custom installation (Windows and Linux only). In
the table, <user> stands for the user name and <version> for the version of Thermo-Calc, for
example 2020b.

License File Installation Location for All Operating
Systems
The license file is installed outside of the installation program folder. If you have more than
one version of Thermo-Calc installed then there will be additional folders here and one
license file.
On a Mac the license file is put in /Users/Shared/Thermo-Calc. The example below is for
a Standalone Windows installation.

See the following topics for more information:
l

Installation Default Directory: Windows

l

Installation Default Directory: macOS

l

Installation Default Directory: Linux

l

Installation Default Directory: Databases

l

Installation Default Directory: Materials

l

Installation Default Directory: Process Metallurgy Materials

l

Installation Default Directory: Custom Property Models

l

Installation Default Directory: TC-Toolbox for MATLAB®
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Installation Default Directory: Windows

Windows
User Type

Default Directory

Administrative rights are required to install and uninstall the program.

The Thermo-Calc program is installed here:
Program Files\Thermo-Calc\<version>

The default folders where documents, materials files, examples, and other folders that
sometimes require additional licenses are installed under Public Documents for ALL
USERS. For a local user these files are copied to the user’s Documents folder where
this local copy is associated to the user login. The Public Documents folder always
contains the original set of contents as per the installation.
C:\Users\Public\Public Documents\Thermo-Calc\<version>

Administrator

After installing Thermo-Calc, and when you first open the program, the set of folders is
copied from the
source Public Documents location into a user Documents folder:
C:\Users\<user>\Documents\Thermo-Calc\<version>

It is recommended that you work with the files that are copied to the
user folder.
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Windows
User Type
License
software
installations on
a server
network (the
License
Manager
software)

Default Directory

C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS License
Manager\WinNT\
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Installation Default Directory: macOS
macOS User Type

Default Directory
The Thermo-Calc program is installed here in the Applications folder:
Thermo-Calc-<version>.app, Thermo-Calc-<version>-Demo.app,
and, uninstall-Thermo-Calc-<version>.app

Administrator (user name and
password required)

The documents, materials, examples and other folders that sometimes
require additional licenses are installed here:
/Users/Shared/Thermo-Calc/<version>

To go to this folder, in Finder, from the Go main menu select Go to
folder. Enter the above file path and click Go.
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Installation Default Directory: Linux
Linux User Type

Default Directory

Non root user

The Thermo-Calc program including the documents, materials,
examples and other folders that sometimes require additional
licenses are installed here:
/home/<user>/Thermo-Calc/<version>

Root user

The Thermo-Calc program including the documents, materials,
examples and other folders that sometimes require additional
licenses are installed here:
/opt/Thermo-Calc/<version>

License software installations on a
server network (the License
Server software)

If you are doing a network installation then these files are available
as a tar-file from the Thermo-Calc Software web site.
In the downloaded tar-file, there is a restart_lserv script file, which
can be used as a template for creating a script that starts up the
License Server.
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Installation Default Directory: Databases
The standard Thermo-Calc databases and the database initialization file tc_initd.tdb are
located in a subfolder to the Thermo-Calc installation. For example, in a Windows
Standalone installation, you can find these in a folder called data where the file path is
C:\Program Files\Thermo-Calc\<version>\data.

Database Checker Program
The Thermo-Calc software package includes a program to check that the syntax of
unencrypted database files is correct. The program applies the syntax rules set out in the
Database Manager User Guide and reports errors and issues warnings. This program is
intended for advanced users who develop and manage databases.
Thermo-Calc accepts deviations from these syntax rules. This means that a
database can work even if the Database Checker reports errors and warnings.
For example, an error is reported if an abbreviated phase name is found, but
phase name abbreviations are accepted by Thermo-Calc and its Add-on
Modules.
The executable DatabaseChecker file is found in the Thermo-Calc home directory. The
program can also be launched by selecting Tools→ Database Checker from the main menu.

Installation Guide ǀ 24 of 82

Thermo-Calc Documentation Set

Installation Default Directory: Materials
When you are working with the System Definer you can open the default Materials folder
included with your installation.
At the bottom of the window under Material, click Load material to navigate to a material
file.
There is a separate folder for materials saved using the Process Metallurgy
Calculator. See Installation Default Directory: Process Metallurgy Materials.

The default directory where these files are stored is based on operating system:
Operating
System
Windows

Linux

Materials Installation Directory
C:\Users\<user>\Documents\Thermo-Calc\2020b\Materials

On Linux all user files are installed where the program is installed. If installed as root
the default is:
/opt/Thermo-Calc/2020b/Materials

macOS

/Users/Shared/Thermo-Calc/2020b/Materials
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Installation Default Directory: Process Metallurgy
Materials
With the Process Metallurgy Calculator you can save materials to work with again. This is
the default folder where these are stored based on your operating system:
Operating
System
Windows

Linux

Process Metallurgy Materials Installation Directory
C:\Users\<user>\Documents\Thermo-Calc\2020b\ProcessMetallurgyMaterials

On Linux all user files are installed where the program is installed. If installed as
root the default is:
/opt/Thermo-Calc/2020b/ProcessMetallurgyMaterials

macOS

/Users/Shared/Thermo-Calc/2020b/ProcessMetallurgyMaterials
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Installation Default Directory: Custom Property
Models
All Property Models (whether these are predefined or custom models) must be
located in a subdirectory of the Property Model directory. You can go to Tools
→ Options and the Model directory field displays the default directory.

Predefined models included with the Property Model Calculator are installed in the locations
below based on your operating system. If you create your own models, this is the default
directory where these are saved. You can also use one of these as a template to create your
own Property Model.
Operating
System
Windows

Linux

Property Model Installation Directory
C:\Users\<user>\Documents\Thermo-Calc\2020b\PropertyModels

On Linux all user files are installed where the program is installed. If installed as
root the default is:
/opt/Thermo-Calc/2020b/PropertyModels

macOS

/Users/Shared/Thermo-Calc/2020b/PropertyModels
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Installation Default Directory: TC-Toolbox for
MATLAB®
Examples for the TC-Toolbox are placed under MATLAB® in the same documents folder as
the Thermo-Calc files (Documents folder):
..\Documents\MATLAB\Thermo-Calc-Toolbox-X\Examples

Where X is the installed version number of the toolbox.
For most installations the examples are available in the MATLAB window when the software
is opened.
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Subnet Information for Network Licenses
For network licenses, the subnet information is also required. Ask your network
administrator for the network address for the subnet. Additional requirements are included
elsewhere for network installations.
l

l

Subnets should be in the format aaa.bbb.ccc*** (for example: 192.168.29.0/24 or
192.168.29.*
A maximum of six subnets are permitted.

An alternative way to get this information is to run the command:
l

Windows:ipconfig

l

Mac/ Linux: ip

/all

a

macOS Installation Notes
How to Restart After an Installation
In some types of installations (e.g. a network installation), you may have to restart your Mac
to use Thermo-Calc for the first time.
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How to Install XQuartz
The XQuartz open-source X Windows system is required to run Thermo-Calc on macOS X but
it is not required to install Thermo-Calc. Before installing Thermo-Calc, you may also need
to ensure that the computer security permissions are set.
1. In a web browser go to https://www.macupdate.com or to download it directly from
XQuartz, http://xquartz.macosforge.org/landing/.
2. In the Search Mac Apps field, enter XQuartz.
3. Click the XQuartz search result. For example, based on the recent version, the name is
XQuartz-2.7.7.dmg.
4. Click Download.
5. Double-click the XQuartz.pkg file. Follow the instructions.
6. Click OK when the message about logging out displays and click Close when the
installation is successful.

How to Enable the Security Settings
1. From the Apple main menu, select System Preferences.
2. Click Security and Privacy.
3. Click General. At the bottom of the Security & Privacy window, click the lock icon to
make changes. Enter the administrator password as required.
4. If you have already tried to launch the Thermo-Calc installer, you can click Open
Anyway to proceed. Otherwise, under Allow apps downloaded from: click Anywhere
and then Allow from Anywhere.
5. Continue with the applicable installation type (standalone or network).
Remember to reset your security after installing Thermo-Calc.
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Linux Installation Notes
The following are details you need to know regarding your Linux installation as well as how
to open Thermo-Calc.

openSUSE Administration (sudo) Users
Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:
sudo ./linux-installation-x64-6.0.0.17347.run

When this command is used, you will do a text-based installation instead of having a
graphical interface to guide you. The information is the same, just without the user
interface.

Opening Thermo-Calc in Linux
To open Thermo-Calc double-click the Thermo-Calc-2020b application or from the ThermoCalc installation directory enter $ ./Thermo-Calc-2020b.sh in the terminal.
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Standalone Installations
You can either do a full or a custom standalone installation. The license type is called a
Single-User Node-Locked License (SUNLL).
In this section:
Full Standalone Installations

33

Custom Standalone Installations

37

Add New Components to an Existing Installation

40
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Full Standalone Installations
The following describes a full standalone installation. These steps assume you have
completed the section First Steps of Installation.

Step 1. Request your license file from Thermo-Calc
Software
Demo (trial) installations: Skip this step. A license file is automatically installed
with the software. You do not need to request it.
Updates to Thermo-Calc: Customers who subscribe to the annual maintenance
plan can skip this step if you have received your license file in an email from
Thermo-Calc Software AB. Save the license file to your computer to use during
software installation. The license file name must be the same as the existing file
name to ensure there are no errors during the update.
Follow the instructions for your operating system in the section Request a License File from
Thermo-Calc Software.

Step 2. Download your Thermo-Calc installation software
l

l

Web downloads: For web links sent in an email from Thermo-Calc Software, go to the
URL and log in with the information provided to download the software.
DVD installations: Insert the DVD and follow the instructions.

Step 3. Run the applicable installation file for your
operating system
1. Navigate to the folder for your operating system and click the link to download the
software package, then go to the folder where you downloaded it.

Administrative rights are required for Windows and Mac installations.
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Windows
Right-click the .exe file and choose Run as administrator to launch the Setup program.

macOS
Double-click the downloaded file then follow the instructions.

For macOS and when you first run the installer, you may see a message that
Thermo-Calc-osx-<version> can't be opened because Apple cannot check it for
malicious software. If this happens, select Show in Finder. Then, in the opened
Finder window right-click the downloaded file Thermo-Calc-osx-<version>
and select Open.

Linux
To start the Setup Wizard in a Terminal window, enter these commands in the directory
where the installation file is saved:
> chmod +x linux-installation-x64-2020b.run
> ./linux-installation-x64-2020b.run

If you are an openSUSE root user, see Linux Installation Notes for some
information about your installation.
2. On the Setup window click Next.
3. On the License Agreement window click the button to accept the license agreement
then click Next.
Demo (trial) installations: Your installation starts and is done when the
Completing the Thermo-Calc Demo Setup Wizard opens. Click Finish and start
using Thermo-Calc.
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Step 4. Select the installation type and upload the license
file
About the Thermo-Calc Components Being Installed
1. In the Select Installation Mode window click Full Standalone: Install all features.

If you want to exclude a component (perhaps one of the SDKs), then you
would use the Custom option. See Custom Standalone Installations.

When the Full Standalone or Full Network Client option is chosen, it
installs everything except the TC-Toolbox for MATLAB® (available for
Windows only). However, if the program finds a MATLAB® installation on
your computer during this installation process, you are prompted if this
component should be also be installed.
The TC-Python program is installed when the Full Standalone or Full
Network Client option is chosen, but there are additional steps required
as described separately for this SDK.
2. For a Full Standalone installation, in the Choose a license file field either enter the
file path or click the file button
to navigate to where you saved the license file
emailed to you from Thermo-Calc Software. The license file is called lservrc. Click
Next.
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To prevent errors, leave this field blank if you did not get a license file
yet.
3. TC-Python is installed for all users even if you do not have a license. The Install TCPython window is a reminder that additional installation procedures are required
after Thermo-Calc is installed. Click Next.

Step 5. Install the software and start using Thermo-Calc
1. In the Ready to Install window click Next.
2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back
in to finish the installation and start using Thermo-Calc.
macOS installations and if you have previous Thermo-Calc installations:
When you launch Thermo-Calc with the new or updated version, the
splash screen hides the Import User Settings dialog box. In order to
proceed you need to click the splash screen and then click Yes or No in
the dialog box.
If you did not get your license file see Request a License File from Thermo-Calc
Software.
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Custom Standalone Installations
About the Thermo-Calc Components Being Installed
Use the Custom option if you want more control over what component features to include or
exclude, for example use it to exclude an SDK.
This topic describes how to do a custom installation on a standalone computer for either a
Windows or Linux operating system. These steps assume you have completed these sections:
l
l

First Steps of Installation
Steps 1 to 3 of a Full Standalone Installations where you request your license file,
download the software and then have started to set up the program up to the Select
Installation Mode window.

Step 1. Select the installation mode and what components
to include or exclude
About the Thermo-Calc Components Being Installed
1. In the Select installation mode window click Custom (the option appears greyed
out, but it is available to select). Click Next.

2. On the Specify Configuration window the Create Shortcuts on Desktop check box is
selected by default. Click Next.
3. In the Select Components window, click to deselect the check boxes as needed. Click
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Next.

Step 2. Set the installation directory and choose the
license file
1. In the Installation Directory window, either accept the default path or enter a path
to where you want to install the software (see Installation Default Directories and the
License File ). Click the file button to Browse for Folder and navigate to another
directory. Click Next.

To prevent errors, leave this field blank if you do not have a license file
yet.
For the Windows TC-Toolbox for MATLAB® component, and if you get a
MATLAB not found message, enter the MATLAB® installation directory
and click Next.
2. In the Choose Setup Type window, click Standalone.
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3. In the Choose a license file field enter the path to your license file (called lservrc) or
click the file button to navigate to a location on the computer and open the file.
Click Next.
4. If TC-Python is selected to be installed, the Install TC-Pythonwindow is a reminder
that additional installation procedures are required after Thermo-Calc is installed.
Click Next.

Step 3. Install the software and start using Thermo-Calc
1. In the Ready to Install window click Next.
2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to
finish the installation and start using Thermo-Calc.
macOS installations and if you have previous Thermo-Calc installations: When
you launch Thermo-Calc with the new or updated version, the splash screen
hides the Import User Settings dialog box. In order to proceed you need to click
the splash screen and then click Yes or No in the dialog box.
If you did not get your license file see Request a License File from Thermo-Calc
Software.

Installation Guide ǀ 39 of 82

Thermo-Calc Documentation Set

Add New Components to an Existing Installation
If you want to add new components to an existing Thermo-Calc installation (for example,
you purchased a license for TC-Python), run the installation file again as in Step 3 of Full
Standalone Installations.
1. For all OS you need to have administrative level rights. For example in Windows,
right-click the executable Thermo-Calc installation .exe file and choose Run as
administrator to launch the Setup program.

2. Click Next. Click to accept the license agreement. Click Next.
3. Select the additional component(s) to install. Click Next.
4. Click Next to start the installation, which adds the new component(s).
Use the Uninstall program to remove components.
Uninstalling Thermo-Calc
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Network Client Installations
This installation type is available for all operating systems, however for macOS the License
Server must be run on a Windows or Linux computer. It is applicable to the consolidated and
distributed network types of installations as well as for the licensing installation on a server
network.
About the Thermo-Calc Components Being Installed
In this section:
Full Network Client Installations

42

Set Up the License Manager on Windows

44

Set Up the License Server on Linux

47

Thin Client Installations

50

Custom Network Client Installations

52

Unattended Network Client Installations

55
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Full Network Client Installations
The following outlines how you do a full network client installation.

Step 1. Install the licensing software
Follow the instructions for your operating system:
l

Set Up the License Manager on Windows, or

l

Set Up the License Server on Linux

Step 2. Complete Steps 1 to 3 of a full standalone
installation
These steps assume you have completed the instructions for Full Standalone Installations to
download and run the software up to the Select Installation Mode window. It is up to you
whether you get the computer information for the license files before or after installing the
software.

Step 3. Choose the installation type and enter the
computer server details
About the Thermo-Calc Components Being Installed
1. In the Select Installation Mode window click Full Network Client to Install all
features (the option appears greyed out, but it is available to select).

If you want to exclude a component (perhaps one of the SDKs), then use
the Custom option and see Custom Network Client Installations.

2. In the field, enter the name or IP number of the computer where the licensing
software is installed. Click Next.
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3. TC-Python is installed for all users even if you do not have a license. The Install TCPython window is a reminder that additional installation procedures are required
after Thermo-Calc is installed. Click Next.
4. In the Ready to Install window click Next.
5. When the Completing the Thermo-Calc Setup Wizard window opens, click
Finish.For Linux users, log out and log back in to start using Thermo-Calc.
macOS installations and if you have previous Thermo-Calc installations:
When you launch Thermo-Calc with the new or updated version, the
splash screen hides the Import User Settings dialog box. In order to
proceed you need to click the splash screen and then click Yes or No in
the dialog box.
If you did not get your license file see Request a License File from Thermo-Calc
Software.
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Set Up the License Manager on Windows
License Manager vs License Server: Both terms refer to the licensing software
program installed on a network computer. License Manger is for Windows and
License Server is for Linux. See Installation Terminology for more information.

Installation Requirements
This procedure explains how to install the License Manager on a computer that acts as a
license server in your network. It is a Sentinel RMS License Manager Windows service and it
supplies the client computers in your network with license tokens when it runs the ThermoCalc software. A network license can only be used on one specific computer that hosts the
License Manager. The network license determines which client computers receive license
tokens using their IP addresses and IP ranges.
l

l

l

For Mac installations, the server containing the license file must be set up on a
Windows or Linux computer.
For testing purposes, and in order to confirm the installation is working correctly,
install the Thermo-Calc software on the same computer as the Sentinel RMS License
Manager. Thermo-Calc can always be uninstalled after testing if required.
Administrator rights are required.

Installing the License Manager on Windows
STEP 1. INSTALL THE SENTINEL RMS LICENSE MANAGER SOFTWARE
1. Follow the instructions to download your Thermo-Calc installation software.
2. Open the directory for Windows and right-click the file Sentinel RMS License
Manager 8.5.1.msi.
3. Select Save target as and choose a suitable directory so that you can easily find the
file later.
4. Right-click the downloaded file and choose Install. Click Next.
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STEP 2. CHOOSE THE INSTALLATION DIRECTORY
1. Click to accept the license agreement. Click Next.
2. Enter your User Name and Organization and select to install the License Manager
for All users. Click Next.
3. In the Destination Folder window click Next to accept the suggested destination
directory or Change to select another directory. Click Next.

STEP 3. CHOOSE THE SETUP TYPE AND INSTALL THE SOFTWARE
1. In the Setup Type window, select Complete. Click Next.
2. Select the Unblock the system firewall for the Sentinel RMS License Manager
check box.

Selecting the check box is required to run Thermo-Calc.

3. Click Next and then Install.
4. Click Finish to exit the InstallShield Wizard.

STEP 4. COPY THE LICENSE FILES TO THE DESTINATION DIRECTORY
1. Copy the network license file to the destination directory. By default, it is installed in
the following directory with the name lservrc.
C:\Program Files (x86)\Common Files\SafeNet
Sentinel\Sentinel RMS License Manager\WinNT\

The name of the license file must be in lower case letters (lservrc). This
is especially important if both Windows and Linux operating systems are
part of your network; Linux commands and operations are casesensitive.

If the default file path does not work, you can set the environmental variable
LSERVOPTS to select the license file:
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a. In the Windows Control Panel, go to System → Advanced system settings.
b. In System Properties select Advanced → Environment Variables → New.
c. Enter the Variable name LSERVOPTS to specify the parameters with which
the License Manager is started.
d. To specify the path to the license file in the Variable value field enter the
following and include the complete license file path and name.
-s <license file path and name>

STEP 5. REBOOT OR RESTART THE LICENSE MANAGER
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Set Up the License Server on Linux
License Manager vs License Server: Both terms refer to the licensing software
program installed on a network computer. License Manger is for Windows and
License Server is for Linux. See Installation Terminology for more information.

Installation Requirements
There are a variety of things needed to prepare for a Linux License Server installation. The
following points are described in this section.
l

l
l

You need to stop older versions of the License Server before running the new one. To
stop the license server you run lsrvdown .
Root access to your computer is required or you need to be on the sudoers list.
To run the License Server on a Linux 64-bit computer, you need to install 32-bit
library support. For example, on CentOS this can be done by running the command:
>yum install glib2.i686

l

You need a valid lservrc network license file supplied by Thermo-Calc Software and
the actual License Server—a file(program) called lserv.
l

The name of the license file must be in lower case letters (lservrc)
because Linux commands and operations are case-sensitive.

l
l

The license file need to be read and writable by the license server(license manager)
If you have a license server; Upgrade your license server if the new one is a higher
version than the present one. Clients work with newer license servers(managers) but
not necessarily with ones older than client.

openSUSE Administration (sudo) Users
Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:
sudo ./linux-installation-x64-6.0.0.17347.run
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When this command is used, you will do a text-based installation instead of having a
graphical interface to guide you. The information is the same, just without the user
interface.

Installing the License Server on Linux
STEP 1. STOP ANY OLDER VERSIONS OF THE LICENSE SERVER
Skip this step if this is a new installation.
1. To stop an old version of the License Server that is already running, go to the
directory where the old file is found, and enter the commands:
>chmod +x <lsrvdown>
>./lsrvdown <host_name>

2. Edit existing scripts that start the older version of the License Server so that they
start the newer version instead.
For more information about the lservdown utility, go to
http://sentinelrms.safenetinc.com/RMSDocumentation/SysAdmin/Content/lsrvdown.htm

STEP 2. WRITE A SCRIPT TO START THE LICENSE SERVER
The following is an excerpt from the template script for starting the License Server found in
the restart_lserv file.
Replace the paths for LICENSE_SERVER_DIR, LICENSE_FILE_DIR and LOG_DIR to match your
system. Save it as a script:
# set the directory where the executables are located
LICENSE_SERVER_DIR=/usr/local/Thermo-Calc/2020b/Licensing-files
# set the directory of the license file lservrc
LICENSE_FILE_DIR=/usr/local/Thermo-Calc/2020b/Licensing-files
# set the directory where you wish to save the log-files
LOG_DIR=/tmp
# stop the running server
# (omit this line if calling this script at startup)
$LICENSE_SERVER_DIR/lsrvdown $HOSTNAME
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# start the license server
$LICENSE_SERVER_DIR/lserv -s $LICENSE_FILE_DIR/lservrc -l $LOG_DIR/lserv_use.log -f
$LOG_DIR/lserv_err.log

STEP 3. CONFIRM THE HOSTNAME VARIABLE AND OPEN THE UDP PORT
The hostname should always correspond to the DNS record verify this by doing the following.
1. Before starting the License Server make sure that the value of the $HOSTNAME
variable is correct. This value can be shown by typing the > nslookup $HOSTNAME
command in the terminal window:
The value should be the same IP address that is shown when you use the ifconfig
command.
2. Open the UDP port 5093 in your firewall. In case you have installed SELinux you
might also need to disable it by setting SELINUX=permissive in the
/etc/selinux/config file.

STEP 4. START THE LICENSE SERVER
1. To start the License Server, run the script created as root. Enter these commands in
the console:
> chmod +x <name_of_script_file>
> ./<name_of_script_file>

2. If you want the License Server to start when you boot the system, put a copy of the
start script under /etc/rc.d/init.d and start the script from the file
/etc/rc.d/rc.local.
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Thin Client Installations
This topic describes how you install a thin Thermo-Calc client to run Thermo-Calc from a file
server. It is applicable to consolidated and distributed network installations for either a
Windows or Linux operating system.

Installation Requirements
l

You need access to the directory where Thermo-Calc is installed on the file server.

l

You need the IP number or name of the computer where the license file is installed.

l

For Linux you may have to disable your firewall. If SELinux is installed, try disabling it
by setting SELINUX=permissive in /etc/selinux/config.

How to Install a Thin Client on Windows
1. Map the file server share as a network drive so that it gets an assigned drive letter
(e.g. E:).
2. Open the \Thermo-Calc\<version>\ directory on the file server, where version is the
current version of the software.
3. Open the directory Thin-client. Double-click the Thermo-Calc-client-windows<version>.exe file.
4. Click to accept the terms of the license agreement. Click Next.
5. Enter the name or IP number of where the license file and the License Manager
software is installed. Click Next.
6. By default the Create Shortcuts on Desktop check box is selected. Click Next.
7. In the Ready to Install window, click Next.
8. Click Finish. To start Thermo-Calc find the program on the server and start it from
there.

How to Install a Thin Client on Linux
1. Add the following to the smb.conf file, where <user> is your user name:
[public]
path=/home/<user>/Thermo_Calc/2020b
public=yes
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writable=yes
comment=smb share
guest OK=yes
force user=<user>

2. From the client, mount the directory on the server computer that contains the
Thermo-Calc server installation (by default, this directory is called /ThermoCalc/2020b). How the directory is mounted depends on the Linux distribution being
used as well as how the Thermo-Calc directory on the server computer is shared. Use
the Linux command mount. For example:
> mkdir public
> sudo mount -t cifs //ip_number_server_computer/public ./public -o
user=<user>

3. Open the mounted directory on your computer, and run client-install-linuxx64.run or client-install-linux-x86.run in the /Thin-client directory.
4. If you do this from the terminal window, use the following to start the installation
(assuming that the file server is a 64-bit computer):
> ./client-install-linux-x64.run
5. Click Forward and click to select the license agreement. Click Forward.
6. Enter the name or IP number of the License Server. Click Forward.
7. If you are installing as a non-root user, by default, the Create Shortcuts on Desktop
check box is selected. Click Forward.
8. In the Ready to Install window click Forward.
9. Click Finish. Log out and log back in to start using Thermo-Calc.
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Custom Network Client Installations
This installation type is available for all operating systems, however for macOS the License
Server must be run on a Windows or Linux computer.The requirements are the same as for
a full client installation.

Step 1. Install the licensing software
Follow the instructions for your operating system:
l

Set Up the License Manager on Windows, or

l

Set Up the License Server on Linux

Step 2. Complete Steps 1 to 4 of a full standalone installation
Follow the instructions for Full Standalone Installations to download and run the software. It
is up to you whether you get the computer information for the license files before or after
installing the software.

Step 3. Select the installation mode and what components to include or exclude
About the Thermo-Calc Components Being Installed
1. In the Select installation mode window click Custom (the option appears greyed
out, but it is available to select). Click Next.

2. On the Specify Configuration window the Create Shortcuts on Desktop check box is
selected by default. Click Next.
3. In the Select Components window, click to deselect the check boxes as needed. Click
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Next.

Step 4. Set the installation directory and the file path to the license
1. In the Installation Directory window, either accept the default path or enter a path
to where you want to install the software (see Installation Default Directories and the
License File ). Click the file button to Browse for Folder and navigate to another
directory. Click Next.

To prevent errors, leave this field blank if you do not have a license file
yet.
For the Windows TC-Toolbox for MATLAB component and if you get a
MATLAB not found message, enter the MATLAB® installation directory
and click Next.
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2. In the Choose Setup Type window, click Network Client and enter the name or IP
number of the computer where the licensing software is installed. Click Next.

If you have selected to install TC-Python there is a reminder window
that additional installation procedures are required after Thermo-Calc is
installed. Click Next.

Step 5. Install the software and start using Thermo-Calc
1. In the Ready to Install window click Next.
2. Click Finish and start using Thermo-Calc. For Linux users, log out and log back in to
finish the installation and start using Thermo-Calc.
macOS installations and if you have previous Thermo-Calc installations: When
you launch Thermo-Calc with the new or updated version, the splash screen
hides the Import User Settings dialog box. In order to proceed you need to click
the splash screen and then click Yes or No in the dialog box.
If you did not get your license file see Request a License File from Thermo-Calc
Software.

Installation Guide ǀ 54 of 82

Thermo-Calc Documentation Set

Unattended Network Client Installations
Terminology note: The use of the term license server (lower case letters) is
applicable to the option files as described in this section. For the purposes of the
step-by-step instructions it is not used to refer to the type of network installation
that runs the licensing software.
Sometimes it is convenient to install Thermo-Calc network clients without providing user
input after the installation is initiated (an unattended network client installation). This is
available for Windows and Linux operating systems.
Make sure you know the name or IP number of the computer where the
licensing software and the license file are to be installed.

Step 1. Create an option file in a text editor to enter the options
The following is an example of an option file for a custom network client installation, where
<name/IP number> is the name or IP number of the computer where the license file is
installed:
installation_mode=custom
setup_type=client
enable-components=thermo,databases,tq,tcapi,toolbox,tcpython
icons=1
license_server=<name/IP number>

Below is a shorter example, specifying that a full Thermo-Calc network client should be
installed:
installation_mode=full_client
license_server=<name/IP number>

Step 2. Go to the directory where the installation file is stored
Thermo-Calc can only be installed in unattended mode from the command line
prompt.
Start the installation in unattended mode using the option file created with this command:
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l

For Windows: <installationfile>.exe

--mode unattended --optionfile

<path\optionfile>
l

For Linux: <installationfile>.run

--mode unattended --optionfile

<path/optionfile>

To see other options when you start the Thermo-Calc installation program from the
command line prompt, run this command:
l

For Windows: <installationfile>.exe

l

For Linux: <installationfile>.run

–-help

–-help
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Request License Files
In this section:
Request a License File from Thermo-Calc Software

58

Getting License Information Using Thermo-Calc

59

Requesting the License File for Windows or Linux

60

Requesting the License File for macOS

62
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Request a License File from Thermo-Calc Software
The following explains how to retrieve the necessary diagnostic and network adaptor
information about your computer and then send an email to Thermo-Calc Software to get
your license file(s) containing the license key(s).
To set up the correct licensing (excluding demo installations where a license file is not
required):
1. Make a note of your company or organization’s site number. You can find the site
number on an invoice or any correspondence from Thermo-Calc Software.
2. Retrieve your computer diagnostic and network adapter information.
3. Email Thermo-Calc Software with this information.
4. A Thermo-Calc Software representative emails you the license file. Save the license
file lservrc (there is no file suffix) to a location where you can easily access it later.
Thermo-Calc Support on our website
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Getting License Information Using Thermo-Calc
If you have already installed Thermo-Calc, you can view the license information in the GUI.
Select Help → Show License Info.
In Console Mode you can run the SYS module command DISPLAY_LICENSE_INFO.
1. Open Thermo-Calc.
2. Click Switch to Console Mode.

3. At the SYS: prompt, enter DISPLAY_LICENSE_INFO (all caps).

4. You can output the information to a FILE or to the SCREEN.

5. For both options, the information is displayed on screen. Copy the section containing
the Ethernet and IP address. You can save it to a text file or paste it directly into an
email. If you choose FILE as the output, then you can attach the file to an email.
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Requesting the License File for Windows or Linux
Demo (trial) installations: Skip this section. A license file is automatically
installed with the software. You do not need to request it.
Upgrades to a new version of Thermo-Calc: Skip this section if you are
upgrading to a new version of Thermo-Calc and (and you have a maintenance
plan). Your license is sent to you in an email from Thermo-Calc Software AB.
Save it to your computer to use during software installation.
1. To access the computer information you need to provide to get a license, start
Thermo-Calc and select Help → Show License Info.

2. Copy the information from the License Information window. A lot of information
may be shown below the initial screen, so make sure you scroll down to the end
when you select and copy the window's contents. (Alternatively, you can copy the
same information from the console by using the SYS module command DISPLAY_
LICENSE_INFO.)
3. Send an email to support@thermocalc.com. Make sure to include the following in
the subject line:
License diagnostic information from <Name> where Name is replaced with your
name, the organisation name and the Site Number. You can find the five-digit site
number on an invoice or any correspondence from Thermo-Calc Software.
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4. A representative from Thermo-Calc Software replies to the email and attaches your
license file(s).
5. Save the license file(s) to your computer or network.
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Requesting the License File for macOS
Demo (trial) installations: Skip this section. A license file is automatically
installed with the software. You do not need to request it.
Upgrades to a new version of Thermo-Calc: Skip this section if you are
upgrading to a new version of Thermo-Calc and (and you have a maintenance
plan). Your license is sent to you in an email from Thermo-Calc Software AB.
Save it to your computer to use during software installation.
1. From the Apple main menu, select System Preferences.
2. Click Network.
3. In the left column select Ethernet or Built-in Ethernet (do not select a WiFi
connection as a local static MAC address is required).
4. Click Advanced → Hardware.
The Network window shows you the MAC Address. For example, the MAC address
(the host ID) might be 3c:07:54:28:5f:72.

5. Send an email to support@thermocalc.com and copy and paste the MAC address into
the body of the email. Make sure to include the following in the subject line:
License diagnostic information from <Name> where Name is replaced with your
name, the organisation name and the Site Number. You can find the five-digit site
number on an invoice or any correspondence from Thermo-Calc Software.
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6. A representative from Thermo-Calc Software replies to the email address provided
and attaches your license file or files.
7. Save your license file to your computer or network.
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Troubleshooting
In this section:
License Errors

65

Determining the Current License File Directory Path

67

Specifying a New Server Name or IP Number

70

MATLAB® Installation Directory

71

Firewalls

72

Client/Server Mismatch

73

macOS Installations: Running the License Initialization Script

75

Linux Installations: Running the License Initialization Script

76
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License Errors
Issue

Platform

Installation
type

Action or link to more
information

How do I add or update a
standalone (SUNLL)
license on a Windows
computer where ThermoCalc is already installed?

Windows

Standalone

Determining the Current License File
Directory Path

How do I add or update a
standalone (SUNLL)
license on a Linux
computer where ThermoCalc is already installed?

Linux

Standalone

Determining the Current License File
Directory Path

How do I add or update a
network license on
Windows?

Windows

Network

Determining the Current License File
Directory Path

How do I add or update a
network license on Linux?

Linux

Network

Determining the Current License File
Directory Path

No license file found.
Copy a valid license file to
the installation directory
after completing the
installation.

All

All

You get this message if the wrong path or
no license file is found at a path entered
during the installation process. See
Installation Default Directories and the
License File and Determining the Current
License File Directory Path

MATLAB® not found (for
the TC-Toolbox for
MATLAB component)

Windows

All

MATLAB® Installation Directory

Warning Environment
variable “LSHOST” is not
set. Software will not
function properly.

All

Network

Specifying a New Server Name or IP
Number

Problem running postinstall step. Installation
may not complete
correctly.

Linux and
Mac

Standalone

macOS Installations: Running the License
Initialization Script or Linux Installations:
Running the License Initialization Script

Installation Guide ǀ 65 of 82

Thermo-Calc Documentation Set

Platform

Installation
type

Action or link to more
information

Firewall warnings related
to license management
software (License
Manager and License
Server)

Windows
and Linux

Network

Firewalls

Client / Server naming
mismatches

Windows
and Linux

Network

Client/Server Mismatch

Network

You are not notified if the InstallScript
scripting engine is not installed. Install the
ISScript.msi file and then run the
downloaded file from Thermo-Calc again
as described in Set Up the License
Manager on Windows

Issue
Unable to run postinstallation script, run the
license initialization script
as root after the
installation.

InstallScript engine
missing

Windows
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Determining the Current License File Directory Path
This topic explains how to find out where your license file is installed, either by default or if
a different directory was chosen for previously installed versions. For new installations,
where you may not have had a license file when you installed Thermo-Calc (for example,
you had a demo version), you can also use these instructions to determine the correct file
path.

From Thermo-Calc
If you have already installed Thermo-Calc, you can view the path to the license file in the
GUI. Select Help → Show License Info.
In Console Mode you can run the SYS module command DISPLAY_LICENSE_INFO.

Windows Standalone Installations
How do I add or update a standalone (SUNLL) license on a Windows computer where
Thermo-Calc is already installed?
1. Unpack the .zip file that contains your standalone license and save the LSERVRC file
on your computer. Find out where to place the new license file by opening a
Command Prompt Window (cmd.exe) and type in the command line:
>set LSERVRC

2. Press Enter. The output from the command is the path to the license file (including
the name of the license file). For example: if the output is
LSERVRC=C:\Users\<user>\Documents\Thermo-Calc\lservrc

then the new license file should be placed in C:\Program

Files\Thermo-

Calc\2020b\

Linux Standalone Installations
How do I add or update a standalone (SUNLL) license on a Linux computer where ThermoCalc is already installed?
Find out where to place the new license file by opening a Terminal window and type in the
command line:
echo $LSERVRC

Windows Network Installations
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How do I add or update a network license on Windows?
1. You need administrator rights to do the following.
l

l

On Windows 7, click the Start button and in the search field type Services.
Double-click the Services result.
On Windows 8, move the mouse over the right edge of the screen to access
Search, click Settings and then enter and select View Local Services.

2. In the list of installed services, right-click Sentinel RMS License Manager and select
Properties from the pop-up menu.
3. On the General tab under Path to executable, click the line containing the path to
see where the file lservnt.exe is located. The license file (lservrc) is in the same
directory.

The default path for the license file is
C:\Program Files (x86)\Common Files\SafeNet
Sentinel\Sentinel RMS License Manager\WinNT\LSERVRC
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4. Move your copy of the license file (lservrc) to this directory.
5. Restart the Sentinel RMS License Manager by:
l
l

Restarting the computer, or
Right-clicking Sentinel RMS License Manager and selecting Restart from the
list of installed services.

Linux Network Installations
How do I add or update a network license on Linux?
Replace your current license file with the new license file. The license file is located in the
same directory as the license server.
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Specifying a New Server Name or IP Number
The Thermo-Calc Setup wizard does not warn you if the name or IP number entered to the
server (with the license management software) is incorrect.
If the name or IP number is not set at all, or if it is set to an empty string, then when you
start Thermo-Calc the following message displays: Warning Environment variable “LSHOST”
is not set. Software will not function properly.

Windows
This section explains how to specify or change the name or IP number of the server where
the License Manager is installed and for a consolidated network client installation.
To install a license for an existing Thermo-Calc program, follow these steps:
1. Close all running Thermo-Calc programs.
2. Open a command line window.
3. Specify the name or IP number of the licensing software server. Type:
set LSHOST=<name/IP number>

To display the current name or IP number, type:
set LSHOST

macOS
Permanently set the environmental variable LSHOST to specify a new licensing server name
or IP number. Refer to the file /Applications/Thermo-Calc2020b.app/Contents/Info.plist.
In this file, you can manually set the TC20B_HOME variable, which specifies the home
directory of the Thermo-Calc program. See the Info.plist file for an example.

Linux
You can set or change the name or IP number of the license server at a later time by setting
the environmental variable “LSHOST” to this name or number.
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MATLAB® Installation Directory
For Windows installations of the TC-Toolbox for MATLAB® component, you may get an error
message or window asking for the MATLAB installation directory path. If it is during the
installation Setup process, enter the path in the field.

How to Determine the Licensing Software Version
Sometimes you may need to know the version of License Manager (Windows) or License
Server (Linux) software being used. This can be useful while troubleshooting network
installations.
l

On Windows open a command prompt and go to the directory where lservnt.exe is
found. For example:
>C:\Program Files (x86)\Common Files\SafeNet Sentinel\Sentinel RMS
License Manager\WinNT

Type the command >lservnt.exe
l

–help

and the version is displayed.

On Linux open a Terminal window and go to the directory where the lserv
is saved. For example:

script

>cd opt/Thermo-Calc/<version>/Licensing-files

Type the command >./lserv

–help

and the version is displayed.
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Firewalls
Windows
For a Windows License Manager installation you may have to change the system firewall
settings to allow the License Manager to communicate with the computers running the
client applications. Go to the Windows Firewall settings window to see if there are any
problems. If prompted, select Unblock the system firewall for the Sentinel RMS License
Manager and click Next.

Linux
For a Linux License Server installation you need to open the UDP port 5093 in your firewall.
In case you have installed SELinux you might also need to disable it by setting
SELINUX=permissive in the /etc/selinux/config file.
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Client/Server Mismatch
For some network installations there can be a naming mismatch that causes errors. The
server (where the license management software is installed) gets information from its DNS
servers that an IP address (aaa.bbb.ccc) belongs to a computer (Computer A). But the client
computer identifies itself as having a different IP address (aaa.bbb.ccc.eee) for the same
computer (Computer A).
Even if the IP address of the client computer belongs to a subnet range listed in the license
file, there is a problem with accessing the license file because the computer name does not
match the information.
You may need your organisation’s network administrator to assist with this issue.

How to Check
Compare computer names on the client computer and server
1. On the client computer, start a command prompt cmd.exe and type ipconfig
Press Enter. A variety of data is displayed on screen. Write down the following
information for later comparison:
l Hostname
l

DNS Suffix

l

Current IPv 4 Address

/all.

2. In the command window, type nslookup <client_computer_name>, where client_
computer_name is the actual name of the client. Press Enter.
This shows what information is saved on the DNS Servers used by the client
computer. This information should match what is shown in the output from the
first step.
3. On the server that holds the license management software, open a command prompt
and run the command line: nslookup client_computer_name. The output lists the
information for this server.
Does it match the information given by the command ipconfig /all on the
client computer? If not try the following.
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Try these options to correct the issue
1. If the client computer has a dynamic (DHCP) IP address, either change it to a static
one or make a reservation on the DHCP Server so that the computer always get the
same IP address.
2. Update the records on the DNS Servers used by both the client computer and the
server computer.
You can also configure the computer names and IP addresses in the local Hostfile of the
client and server:
1. On the client computer, make a backup copy of the file
C:\Windows\System32\drivers\etc\hosts.
2. Open the original in a simple text editor.
3. Add a new line which contains the IP and name of the server, for example:
192.168.29.27 license_server.thermocalc.se.
4. Save the changes.
5. On the server, make a backup copy of the file /etc/hosts.
6. Open the original in a simple text editor.
7. Add a new line which contains the IP and name of the client, for example:
192.168.29.47 Computer_A.thermocalc.se.
8. Save the changes.
9. In the host file, there is an example of how the operating system (Windows or Linux)
wants the line in the hosts file to look like.
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macOS Installations: Running the License
Initialization Script
As part of the Standalone installation of Thermo-Calc, the Setup runs a license initialization
script. If this part of the installation process did not complete properly for a standalone
installation, you must manually run the license initialization script. You need the
administrator username and password for these steps.

How to Run the Script
For this script to successfully initialize the license, the license file must be called lservrc and
be located in the folder:
/Users/Shared/Thermo-Calc

Installation Default Directory: macOS
1. Open a terminal window. The Terminal application is in the /Applications/Utilities
folder.
2. At the prompt, enter this command:
$ sudo /Applications/Thermo-Calc2020b.app/Contents/Resources/license-initialization-macOSx86_64.sh

For demo installations, the path should be /Applications/Thermo-Calc-2020bDemo.app/Contents/Resources/ license-initialization-macOS-x86_64.sh.

If you are not already logged in as an administrator, you probably cannot run the
sudo command. If this is the case, then you can use the su command in the terminal
window to login as an administrator. Contact your local system administrator for
help.
3. Enter the administrator password and press Enter.
4. When you restart your computer and run the license initialization script, you are
ready to start using Thermo-Calc.
If you did not install a license file during this procedure, you can still
start Thermo-Calc although you will get the No license file found
message.
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Linux Installations: Running the License Initialization
Script
As part of a Standalone installation of Thermo-Calc, the Setup runs a license initialization
script. If you get a warning message during the standalone installation Unable to run postinstallation script, run the license initialization script as root after the installation, then you
need to manually run the script as root.

openSUSE Administration (sudo) Users
Note the following if you are a sudo user (administrator) in openSUSE installing Thermo-Calc
using this command:
sudo ./linux-installation-x64-6.0.0.17347.run

When this command is used, you will do a text-based installation instead of having a
graphical interface to guide you. The information is the same, just without the user
interface.

How to Run the Script
For this script to successfully initialize the license, the license file must be called
lservrc and be located in the directory where you have installed Thermo-Calc.
Installation Default Directory: Linux
1. In the console, go to the Thermo-Calc installation directory.
l The license file is put in /home/<user>/Thermo-Calc if you are installing as a
non-root user, where <user> is your user name.
l

If you are installing as root, then this directory is opt/Thermo-Calc/.

2. Enter this command:
$ sudo sh license-initialization-linux.sh

If you are not able to execute the sudo command because you are not on the sudoers
list, you must log in as a root user with the command su, and then use sh to run the
license initialization script. For example, on a 64-bit computer, enter the following:
$ sh license-initialization-linux.sh
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3. Log out of Thermo-Calc and then log back in to save these changes.
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Uninstalling the Software
In this section:
Uninstalling Thermo-Calc

79

Uninstalling Standalone Versions of TC-PRISMA

81
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Uninstalling Thermo-Calc
Windows 10
1. From the Control Panel Desktop app, go to Programs → Programs and Features →
Uninstall or change a program.
2. In the list of programs, locate the version of Thermo-Calc you want to uninstall. Click
to highlight that row.
3. Click Uninstall/Change.
4. In the Setup window, Uninstallation Mode dialog box, choose to uninstall the Entire
application or Individual components. Follow the instructions to finish.

macOS
Deleting the program from the Applications folder does not remove the program from your
operating system. Run the Thermo-Calc-<version>-uninstaller program located in the
Applications folder. This is also applicable to the Demo version of the software.
1. Go to the Applications folder and double click the file that starts with Thermo-Calc<version>-uninstaller. Enter the administrator’s user name and password.
2. Click Yes to choose Entire application or select individual components. Otherwise
click No to quit.
3. The Uninstalling Thermo-Calc window shows the progress. Click OK when prompted.

Linux
1. To start the uninstallation procedure, in the Thermo-Calc installation directory use
the command
./Thermo-Calc-2020b-uninstaller.run

For Thin Client installations, use the command
./Thermo-Calc-client-2020b-uninstaller.run

2. To remove the whole application, including all its components, select Entire
application and click Forward, or to remove specific components, select Individual
components and click Forward.
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If you intend to reinstall Thermo-Calc 2020b it is important to (1) Restart the
computer before you reinstall the software and (2) remove the environmental
variable TC20B_HOME.
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Uninstalling Standalone Versions of TC-PRISMA
As of Thermo-Calc version 2016a, TC-PRISMA is no longer a standalone
program. It is integrated into the Thermo-Calc Graphical Mode and considered
an Add-on Module called the Precipitation Module. It is also available for all
platforms (Windows, Mac and Linux). If you have older versions of the TCPRISMA software that you want to uninstall, follow these instructions.
1. Go to the Thermo-Calc uninstaller. For example, in Windows 7, go to Start → All
Programs → Thermo-Calc or in Windows 10 go to Start → All Apps → Thermo-Calc.
2. Click uninstall-Thermo-Calc-2015b (or the version of TC-PRISMA you have).

3. In the Setup window, click Individual components. Click Next.

4. Select the TC-PRISMA check box.
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5. Click Next and then OK when the software component is uninstalled.
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The Thermo-Calc Software
The Thermo-Calc software is a sophisticated database and programming interface package
used to perform thermodynamic calculations. It can calculate complex homogeneous and
heterogeneous phase equilibria, and then plot the results as property diagrams and phase
diagrams.
The Thermo-Calc software (also referred to as the Thermo-Calc program or the software to
distinguish it from the company name) fully supports stoichiometric and non-ideal solution
models and databases. These models and databases can be used to make calculations on a
large variety of materials such as steels, alloys, slags, salts, ceramics, solders, polymers,
subcritical aqueous solutions, supercritical electrolyte solutions, non-ideal gases and
hydrothermal fluids or organic substances. The calculations take into account a wide range
of temperature, pressure and compositions conditions.
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About the Thermo-Calc Add-on Modules
The Thermo-Calc program also includes Add-on Modules as briefly described below and at
the links to our website.
l

l

l

The Diffusion Module (DICTRA) is used to simulate diffusion controlled
transformations in multicomponent systems. You can find more about it on our
website.
The Precipitation Module (TC-PRISMA) is used to simulate diffusion controlled multiparticle precipitation process in multicomponent and multi-phase alloy systems. You
can find more about it on our website.
The Process Metallurgy Module is used to set up calculations used in steel making
and other metallurgical industries. You can find more about it on our website.

Diffusion Module (DICTRA)
The Diffusion Module (DICTRA) is an Add-on Module to Thermo-Calc. It is used for
simulation of diffusion controlled transformations in multicomponent systems. The
simulation calculations are both time- and space-dependent. The Diffusion Module (DICTRA)
is available in both Graphical Mode (as the Diffusion Calculator) and Console Mode (as the
DICTRA module).
The Diffusion Module (DICTRA), which is often just referred to as DICTRA, is ideally suited to
solve diffusion simulations that include a moving boundary (Stefan problems). The
multicomponent diffusion equations in the various regions of a material are solved under
the assumption that thermodynamic equilibrium holds locally at all phase interfaces.
Simulations are one-dimensional and three different geometries can be performed: planar,
cylindrical, and spherical.
Examples of cases that have been simulated using the Diffusion Module (DICTRA) include:
l

Microsegregation during solidification

l

Homogenization of alloys

l

Growth/dissolution of carbides, nitrides and intermetallic phases

l

Coarsening of precipitate phases

l

Interdiffusion in compounds, e.g. coating systems

l

Austenite to ferrite transformations in steel

l

Carburization, nitriding and carbonitriding of high-temperature alloys and steels
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l

Post weld heat treatment

l

Sintering of cemented-carbides

Precipitation Module (TC-PRISMA)
The Precipitation Module, or TC-PRISMA, is an Add-on Module to Thermo-Calc and it is
available in Graphical Mode as the Precipitation Calculator.
The Module treats concurrent nucleation, growth/dissolution and coarsening under arbitrary
heat treatment conditions in multi-component and multi-phase systems using LangerSchwartz theory and the Kampmann-Wagner numerical approach. It is a general
computational tool for simulating kinetics of diffusion controlled multi-particle precipitation
processes in multicomponent and multiphase alloy systems.
You can use the Precipitation Module for:
l

Concurrent nucleation, growth/dissolution and coarsening of precipitates

l

Temporal evolution of particle size distribution

l

Average particle radius and number density

l

Volume fraction and composition of precipitate

l

Nucleation rate and coarsening rate

l

Time-Temperature-Precipitation (TTP) diagrams

l

Continuous-Cooling-Transformation (CCT) diagrams

l

Estimation of multi-component interfacial energy

l

Estimation of yield stress using the Yield Strength Property Model

Process Metallurgy Module
The Process Metallurgy Module requires both a valid Maintenance and Support
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database
(TCOX8 or newer).
The Process Metallurgy Module is an Add-on Module to Thermo-Calc and it is available in
Graphical Mode as the Process Metallurgy Calculator. The Add-on Module is designed to
model reactions that occur in metallurgical processes. Although primarily used in
steelmaking and steel reﬁning processes (such as basic oxygen furnaces, electric arc
furnaces, ladle furnace metallurgy and so forth), applications are not limited to steelmaking.
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There are two main branches of calculations possible: Equilibrium and Process simulation.
Equilibrium calculations do not consider any kinetics, the process simulation includes
reaction kinetics.
In general, for both types, the main difference compared to using a standard Equilibrium
Calculator is that it is easy to handle the different materials present in a metallurgical
process. The materials used in the process can be pre-defined, saved and used for the
equilibrium calculations. Metallic materials can be defined in element weight percent, oxide
materials in weight percent of oxide components, the gas phase in volume percent of gas
components and its amount can be defined in normal cubic meters, and so forth. In principle
this can be done in a standard Equilibrium Calculator. However, it is much easier when using
the Process Metallurgy Calculator as this is designed for this specific purpose.
When using the Equilibrium branch of calculations, both isothermal and adiabatic
calculations are possible. Adiabatic calculations assume no heat and mass exchange with the
environment during the equilibrium reaction, meaning that the temperature changes as a
result of exothermal or endothermal reactions taking place.
For a Process simulation branch of calculation, the reaction kinetics of the process are
considered. This is done by dividing the system into zones. Typically one would have one
steel zone containing liquid metal and a slag zone containing liquid oxide (slag). The kinetic
model assumes that only a fraction of the steel zone reacts with a fraction of the slag zone
per time step. This reacting fraction of the whole system is termed the reaction zone (in
literature it has become known as Effective Equilibrium Reaction Zone or EERZ).
You can use the Process Metallurgy Module to calculate the following:
l

The equilibrium between custom-defined steels, slags and gasses.

l

The equilibrium between other metallic and non-metallic phases.

l

Desulfurization, dephosphorization, and decarburization.

l

Any partition coefficient, for example the partitioning of sulphur between the liquid
steel and slag phase.

l

Slag characteristics, such as slag basicity or sulphur capacity.

l

The fraction of liquid and solid in the slag.

l

The temperature change in an adiabatic process.

l

Kinetics of the reaction between phases. Typically this is the reaction between a
liquid metal and slag phase, but it could also be the reaction between a solid oxide
and slag (simulation of refractory wear) or between a solid metal and liquid metal
(simulation of dissolution of alloy), etc.

The Thermo-Calc Software User Guide ǀ 6 of 83

Thermo-Calc Documentation Set

Graphical Mode vs Console Mode
There are two interfaces available in Thermo-Calc: Graphical Mode with a graphical user
interface (GUI) and Console Mode, which uses a command line interface. Thermo-Calc and
the Diffusion Module (DICTRA) are available in both modes, and the Precipitation Module
(TC-PRISMA) and Process Metallurgy Module are only available in Graphical Mode.
If you are a new user, Graphical Mode is a good way to learn how to work with ThermoCalc. Depending on what you want to simulate, Console Mode can have more functionality
but until you are comfortable with the concepts, it is recommended you start in Graphical
Mode.
In Graphical Mode calculations are set up, carried out, and visualized as part of
a project. The steps in the project are performed with activities. There are
templates and a Wizard available to guide you through the process of defining
the project.
In Console Mode you work with modules, which are managed using commands
typed at a prompt. Some modules, called response-driven modules, ask you a
series of questions that typically take you through the process of defining your
system, setting calculation conditions, performing calculations and plotting the
results.
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How to Switch Between Modes
The first time you open Thermo-Calc, it defaults to Graphical Mode. For any future instance
it defaults to the last mode used.
Along the top of the GUI is the GRAPHICAL MODE TOOLBAR where you switch between modes.

In Console Mode, except for the SWITCH TO GRAPHICAL MODE button, the toolbar is not used.

See Menu, Toolbar and Keyboard Shortcuts for information about the Tools,
Window and Help menus, which are available in both modes.

File Extensions
The file extensions are different based on the mode you are in (Graphical vs. Console). In
Console Mode the extensions are also based on whether you are working with Thermo-Calc
or the Diffusion Module (DICTRA).
In Graphical Mode, the Thermo-Calc project files have the extension *.tcu. This
includes the examples for the add-on Diffusion Module (DICTRA) and
Precipitation Module (TC-PRISMA).
In Console Mode, Thermo-Calc macro files have a *.TCM extension and the
Diffusion Module (DICTRA) file extension is *.DCM. In addition to macro files in
Console Mode the are also Log files and Workspace files, which also differ.

Modes Run Simultaneously
The two modes can be run simultaneously, but there is no communication between them.
What you do in Graphical Mode does not affect the state of the Console Mode session and
vice versa. One exception is the plot settings. See Global Settings: Graphical and Console
Mode Plotting.

Data Optimization and Thermodynamic / Kinetic Assessments
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Although many calculations can be done in either mode, data optimization and
thermodynamic or kinetic assessments are only available in Console Mode.
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Graphical Mode Activities vs Console Mode Modules
Graphical Mode: About the Activity Nodes
Console Mode Modules
Although many calculations can be done in either Graphical Mode (GM) or Console Mode
(CM), only data optimization and thermodynamic or kinetic assessments are available in
Console Mode. Conversely, only the Property Model, Precipitation and Process Metallurgy
Calculators are available in Graphical Mode.

Graphical Mode (GM) versus Console Mode (CM)
GM
Activity

CM module
(Short
Name)

Primary Functions

Binary
Calculator

BIN

Calculate binary phase diagrams. Access to specific databases designed
for BIN, such as TCBIN, is required.

System
Definer

DATA

Select appropriate databases, define chemical systems and retrieve the
data required for calculations.

Diffusion
Calculator

DICTRA

Run simulations of diffusion controlled transformations in Thermo-Calc
using the Diffusion Module (DICTRA). An additional license is required
for this feature.

–

DIC_PARROT

This is to do data optimization for the Diffusion Module (DICTRA). It
allows you to assess experimental data and use such data to optimize
calculations. An additional license is required for this feature.

–

ED_EXP

Part of the PARROT submodule, use it to edit experimental data points
to make reliable optimizations.

GIBBS or GES

Handles thermodynamic models and quantities. Generally you do not
need to use this, but you can get information about models, and list,
add or amend the thermodynamic parameters in use.

PARROT

Used for data optimization to assess experimental data and use the data
to optimize calculations.

This is the
calculation
engine
–
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GM
Activity

CM module
(Short
Name)

Primary Functions

Precipitation
Calculator

–

Set the conditions for, and perform, a precipitation calculation.

Property
Model
Calculator

–

Predict and optimize material properties based on their chemical
composition and temperature. There are preconfigured General
Models and Steel Models available.

Equilibrium
Calculator

POLY

Equilibrium calculation command module. Specify conditions and make
calculations.

Plot
Renderer

POST

This is a submodule to POLY and is for post-processing and plotting of
calculation results. Modify property and phase diagrams, add labels,
change the diagram colors and so forth.

Ternary
Calculator

POTENTIAL

Calculate and plot gas potential diagrams in a ternary system. The
potential of two gas species are used as the diagram axes.

POURBAIX

Calculate and plot pH-Eh diagrams (Pourbaix diagrams) and property
diagrams for heterogeneous interaction systems involving aqueous
solutions.

–

Process
Metallurgy
Calculator

–

Use this to model reactions that occur in metallurgical processes.
Although primarily used in steelmaking and steel refining processes
(such as basic oxygen furnaces, electric arc furnaces, ladle furnace
metallurgy and so forth), applications are not limited to steelmaking.

REACTOR

Simulate chemical reaction processes in several feed-forward steadystate stages or in several dynamic stages.

SCHEIL

Simulate and plot Scheil-Gulliver solidification processes with no
diffusion in the solid phases and with/without consideration of back
diffusion of interstitial components (such as C, N, O, S).

–

SYS

In Console Mode, interact with the operating system and change
environmental settings. Create and execute macro files.

–

TAB

Tabulate properties of chemical reactions and substances
(stoichiometric or solution phases).

TERN

Calculate ternary phase diagrams.

–

Scheil
Calculator

Ternary
Calculator
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Graphical Mode vs Console Mode: Calculation Types
The Calculation Types in Graphical Mode
Calculations
When you are using Thermo-Calc and the Add-on Modules, you generally first set up a
system, select the databases to use, and then define various parameters related to the
simulation you want to conduct. Once this is set up you decide what calculation type to
perform, choose a plot type (or a table for single equilibrium, for example) to use and then
eventually get a result.
How Thermo-Calc handles the calculation behind the scenes is the same whether you use
Graphical Mode or Console Mode. However, there are differences with the workflow and for
historical reasons some calculation types are named differently based on whether you are in
one mode or another. In addition, the plot types (diagrams) you choose to output the
information are also different based on whether you are in Graphical or Console Mode.
These plot types are often based on the type of calculation being done, where in some cases
you can only do it in one mode and not the other. For example, precipitation calculations are
only available with the Precipitation Calculator, which is only available in Graphical Mode,
but you can do diffusion calculations in both Graphical and Console Mode.

Comparison of Calculation Types in Graphical Mode vs Console Mode
The table lists most of the calculation types that you will want to perform based on whether
it is in Graphical Mode or Console Mode. The first column is primarily based on the
calculation types you can select when working in Graphical Mode and when using the
various calculators as indicated in the second column. The third column is the module or
command in Console Mode that you would use to perform the same, or similar, type of
calculation.
Calculation
Type

Equilibrium
calculations

Graphical

Equilibrium Calculator

Console

Definition

POLY3 module

An equilibrium defines the amount(s)
and composition(s) of one or several
phases that have the minimum Gibbs
energy at a given temperature and
pressure. A prerequisite for a
successful equilibrium calculation is
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Calculation
Type

Graphical

Console

Definition
that the number of degrees of
freedom according to Gibb's phase
rule must be zero. This means that
the right number of independent
conditions must be set in order to
successfully be able to calculate an
equilibrium.
To calculate a single equilibrium. The
results from this calculation are
displayed as follows:

Single
equilibrium

Property Model
Calculator (Equilibrium
model) and
Equilibrium Calculator

l

POLY3 module

l

Graphical Mode: In the
Results window for a Table
Renderer or in the Event Log
window (for the Property
Model Calculator)
Console Mode: With the
LIST_EQUILIBRIUM command.

To calculate a single point. The results
from this calculation are displayed as
follows:
Single (no axes)

Property Model
Calculator and Process
Metallurgy Calculator

l

POLY3 module

l

One axis

Property
diagrams

Property Model
Calculator, Equilibrium
Calculator and Process
Metallurgy Calculator

One axis: available
with Equilibrium
Calculator or Property
Model Calculator

Graphical Mode: In the
Results window for a Table
Renderer or in the Event Log
window.
Console Mode: With the
LIST_EQUILIBRIUM command.

POLY3 module

To vary a quantity on the X-axis.

POLY3 module,
STEP command

A property diagram is calculated by
stepping one of the conditions that
were defined for the equilibrium
calculation and plotting some other
property against this variable. For
example stepping through
temperature and plotting equilibrium
composition of a certain phase, or
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Calculation
Type

Graphical

Console

Definition
stepping through composition and
plotting equilibrium phase fractions,
and so forth.

Phase diagrams

Equilibrium Calculator,
Binary Calculator, and
Ternary Calculator

POLY3 module,
MAP command,
BINARY module,
and
TERNARY module

A phase diagram is mapped within a
specific space constructed by two (or
more) independent mapping
variables. These are mostly
temperature and composition, but
can be many other, such as
temperature and pressure, activity of
oxygen and activity of sulphur, and so
forth.

Scheil
calculations

Scheil Calculator

Scheil module

Simulate a non-equilibrium
transformation or partial-equilibrium
transformation, also called a ScheilGulliver solidification.

Gibbs energy
curves

Binary Calculator

BINARY module

To calculate at a constant
temperature over the whole
composition range.

Activity curves

Binary Calculator

BINARY module

To calculate at a constant
temperature over the whole
composition range.

Phase fractions

Binary Calculator

BINARY module

To calculate as a function of
temperature at a constant
composition.

Isothermal
section

Ternary Calculator

TERNARY module

To calculate the ternary system for
the whole composition range at a
constant temperature.

Monovariant
lines

Ternary Calculator

TERNARY module

To calculate the variation of the liquid
compositions with temperature.

Liquidus
projection

Ternary Calculator

TERNARY module

The projection liquid surface and the
monovariant lines are calculated
over the given temperature range.
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Calculation
Type

Potential
diagrams

T0 temperature
simulations

Paraequilibrium

Graphical

not available

not available

not available

Console

Definition

Potential Diagram
module and
POLY3 module

A potential diagram uses the activities
of two major species in the gaseous
mixture phase as mapping variables.
For example, use this for a metaloxide/sulphide-gas interaction system
to calculate a diagram based on a
specific temperature and pressure .

POLY3 module

The T0-temperature is the temperature
at which two phases have the same
Gibbs energy for a certain composition
for a certain alloy composition.

POLY3 module

A paraequilibrium is a partial
equilibrium where one interstitial
component, such as carbon (C) and
nitrogen (N), in a multicomponent
alloy can diffuse much faster than the
other components (the substitutional
elements, including the matrix element
and alloying elements).

With the Equilibrium Calculator, it
computes the equilibrium of each
grid point in a two-dimensional grid.

Grid

Property Model
Calculator, Equilibrium
Calculator, and Process
Metallurgy Calculator

not available

Min/Max

Property Model
Calculator

not available

Evaluates the Property Model(s) for
all variations of the selected
quantities at the given limits.

Uncertainty

Property Model
Calculator and Process
Metallurgy Calculator

not available

Evaluates the Property Model(s)
where the values of the quantities
are sampled from Gaussian
distributions.

Equilibrium Calculator

Pourbaix
Diagram module,
POLY module

A Pourbaix diagram is a kind of phase
diagram that shows the stability
boundaries for a metal-aqueous
interaction system. The phase
boundaries are shown as a function

Aqueous
solutions,
Pourbaix
diagram

With the Property Model Calculator,
it evaluates two axis variables of the
selected quantities in the specified
range and number of steps.
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Calculation
Type

Graphical

Console

Definition
of pH (acidity) and Eh (standard
hydrogen electronic potential).

Tabulation
reaction

not available

TAB module

To tabulate thermodynamic functions
of any type of substance,
stoichiometric phase or solution
phase, or reaction.

Diffusion
simulation

Diffusion Calculator

DICTRA monitor

Detailed simulation of diffusion
controlled reactions in multicomponent systems.

POLY3, DICTRA
monitor

Isothermal calculations in general can
be done in all Console Mode
modules, for example an Isothermal
diffusion in DICTRA monitor and an
isothermal calculation in POLY3 using
the STEP command.

See above

You can calculate nucleation,
growth/dissolution and coarsening of
particles size classes under these
conditions: isothermic (precipitation
simulation at constant temperature)
or non-isothermic (precipitation
simulation with user-defined
temperature profile).

not available

The TTT (Time-TemperatureTransformation) and CCT (Continuous
Cooling Transformation) diagram can
be simulated for one or more
particles.

Isothermal

Isothermal and
non-isothermal

TTT and CCT

See below

Precipitation Calculator

Precipitation Calculator
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About the File Types and Formats
The file formats (and the file extensions / suffixes) are based on whether you are working in
Graphical or Console Mode, and in Console Mode, whether you are working with ThermoCalc and/or the Diffusion Module (DICTRA).

Graphical Mode
In Graphical Mode you work with one file type, a project file, which has a *.tcu file
extension. This is applicable to Thermo-Calc and the add-on Diffusion Module
(DICTRA)Precipitation Module (TC-PRISMA) and Process Metallurgy Module.

Console Mode
In Thermo-Calc Console Mode there are file types—macro (including log files) and
workspace—and extensions —*.TCM, *.POLY3, *.GES5, *.PAR, *.POP, and *.EXP.
A reminder that Linux and macOS are case sensitive; when applicable ensure
you enter file extensions with capital letters.
Workspace files are not currently available with GES6.
Working with the Console Mode File Types
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Displaying Thermo-Calc License Information
You can start (and install) the software without a valid Thermo-Calc license but you cannot
do any calculations. To show information about the available and installed licenses, from the
main menu select Help → Show License Info.
This is an example of part of a License Information window for a network installation. It only
shows the fields you would expect to see as the details are unique for each installation.

Network Licenses
For a network license, under each license type with instances checked out, there is a list of
who checked out each license.
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In Graphical Mode, an instance is checked out when an Equilibrium Calculator
activity is created, and checked back in when that Equilibrium Calculator is
removed. For the Add-on Diffusion (DICTRA), Precipitation (TC-PRISMA), and/or
Process Metallurgy Modules this also applies to the Diffusion Calculator and the
Precipitation Calculator.
In Console Mode, an instance is checked out when you enter the POLY module
and is checked back in when you exit the POLY module.
l

l
l

l

The Features column is a list of the specific software, databases and API licenses
purchases.
The Version is an internal version number for the feature.
The number of licenses column is how many instances of each license type available
to be checked out simultaneously.
The in use column shows how many license instances are checked out.

Console Mode License Restrictions
l

l

l

l

If you start Thermo-Calc without a valid Thermo-Calc license you cannot leave the
SYS module.
If all the licenses are checked out for a network client installation of Thermo-Calc,
you may not be able to enter the POLY or DICTRA modules until a license is available.
To enter the DICTRA and the DIC_PARROT modules, you need a valid Diffusion
Module (DICTRA) license key.
If you enter and use either the DIC_PARROT module or the PARROT module, then
you cannot enter the other module in the same session. You must close down
Thermo-Calc and launch the program again to enter the other data optimization
module.

Network Computer License Restriction
If you have a network computer installation of Thermo-Calc, then you may not be able to do
any calculations even if you have access to a valid network license file. This is because
others who are part of your network installation may have checked out all allowed instances
of the software.
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If you are running a network installation of Thermo-Calc, you can see how many instances of
the client licenses are currently checked out and how many of them are left. You can also
see which client computers have checked out the licenses.
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Examples, Manuals and Materials Folders
There are several ways to access the examples, manuals (containing PDF documentation)
and materials data folders.

Item

Main
Menu

System
Definer

From the
Windows
Start
Menu

Manuals (PDF documentation,
DATAPLOT EXP files, and
Property Model Framework
Tutorial Examples)

x

-

x

x

x

SDK (TC-Python, TCAPI, TCToolbox for MATLAB®, and TQInterface APIs)*

x

-

-

x

x

Examples (project and macro files)

x

-

x

x

x

Materials

-

x

x

x

x

Property Models

-

-

-

x

-

Process Metallurgy Materials**

-

-

-

x

-

On your
Computer

Website

* The SDK folder is installed during installation and available when you have a license for the applicable
SDK.
** The Process Metallurgy Module user-defined material compositions are saved from the Process
Metallurgy Calculator and managed from the Tools → Options menu.

From the Main Menu
Once your Thermo-Calc software is installed you can open the Examples and PDF
documentation (Manuals) from the main menu:
l

To open the Manuals folder select Help → Manuals Folder. Note for Linux openSUSE
users: This link is not functional. To access the folder, navigate to the default location
based on your installation type
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l

To open the Examples based on whether you are in Console Mode or Graphical
Mode, select File → Examples Files or Help → Examples Files.

From the System Definer (Materials Only)
When you are working with the System Definer you can open the default Materials folder
included with your installation.
At the bottom of the window under Material, click Load material to navigate to a material
file.
There is a separate folder for materials saved using the Process Metallurgy
Calculator. See Installation Default Directory: Process Metallurgy Materials.

The default directory where these files are stored is based on operating system:
Operating
System
Windows

Linux

Materials Installation Directory
C:\Users\<user>\Documents\Thermo-Calc\2020b\Materials

On Linux all user files are installed where the program is installed. If installed as root
the default is:
/opt/Thermo-Calc/2020b/Materials
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Operating
System

Materials Installation Directory

macOS

/Users/Shared/Thermo-Calc/2020b/Materials

Start Menu (Windows Only)
On Windows, once Thermo-Calc is installed, you can locate the Examples and Materials
folders, plus all the Manuals using the shortcuts located in the Start menu. Go to Start → All
Programs or All Apps → Thermo-Calc and click Examples, Manuals, or Materials as
required to open the applicable folder.

On Your Computer (All Operating Systems)
The PDFs, example files and materials xml files are included with your installation in a folder
location based on the operating system.
In the table, <user> stands for the username and <version> for the version of Thermo-Calc,
for example 2020b.

Windows File Paths
User Type

Default Directory
Software
Program Files\Thermo-Calc\<version>

Administrator
Examples, Manuals, Materials, Property Models, Process Metallurgy Materials and
SDK folders:
Users\Documents\Thermo- Calc\<version>

macOS File Paths
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User Type

Default Directory
Examples, Manuals, Materials, Property Models, Process Metallurgy
Materials and SDK folders:

Administrator (user name and
password required)

/Users/Shared/Thermo-Calc/<version>
To go to this folder, in Finder, from the Go main menu select Go to
folder. Enter the above file path and click Go.

Linux File Paths
User Type

Default Directory

Non root user

home/<user>/Thermo-Calc/<version>

Root user

usr/local/Thermo-Calc/<version>

Website
You can download the PDF documentation and examples from the website.
1. Go to https://www.thermocalc.com/.
2. From the menu, select Support → Documentation and navigate to the applicable
section.
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About the PDF Documentation Folder
There is PDF documentation available as part of your installation. This is the same
information as that contained in the online help, just in a different format. The contents of
each folder are described below.

All Thermo-Calc Documentation
The Thermo-Calc Documentation Set is one large PDF that includes the information needed
to work with the Thermo-Calc software. By having all content in one PDF it enables you to
search the content just like you would when in the online help, although this PDF does not
include all the Add-on Module and SDK content.

It is recommended you search the help (press F1 in Thermo-Calc) if you cannot
find what you are looking for in a particular PDF.

The documentation set includes:
l

l
l

Thermo-Calc installation guides including Windows, macOS and TC-Python Quick
Install Guides
User guides for both Graphical Mode and Console Mode
Details about the Add-on Diffusion (DICTRA), Precipitation (TC-PRISMA), and/or
Process Metallurgy Modules based on what is included with Thermo-Calc. That is,
some information is contained in the separate guides.
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l

Data Optimization User Guide - Console Mode only

l

Database Manager User Guide - Console Mode only

l

DATAPLOT User Guide - Console Mode only

l

Pourbaix Diagrams Educational Material - Console Mode only

l

Property Model Development Framework Guide - Graphical Mode only
There is also the Thermo-Calc Console Mode Example Macros PDF available
with the installation.

Database Information Sheets
The technical details contained in the database information sheets is included in the online
help system. Some of the databases have PDF copies included in this sub-folder. However,
starting with Thermo-Calc 2020b, the database examples are being separated into separate
PDFs that will only available on the web or in the Help. All PDFs are available for download
from the Thermo-Calc website and the information is generally included in the help.

DATAPLOT Example EXP Files
The examples are available as supplementary information as described in the
DATAPLOT User Guide, which you can find in either the online help, Thermo-Calc
Documentation Set or Diffusion Module (DICTRA) Documentation Set.

Diffusion Module (DICTRA)
The Diffusion Module Documentation Set is one large PDF that contains information you
need to work with this Add-on Module. By having all content in one PDF it enables you to
search the content just like you would when in the online help, although this PDF does not
include any installation or SDK content.
The documentation set includes:
l
l

All the content available in the Thermo-Calc Documentation Set
Diffusion Module (DICTRA) user guides and quick start guides for both Graphical
Mode and Console Mode

The following guides are also available separately in this folder:
l

Diffusion Module Quick Guide - Console Mode
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l

Diffusion Module Quick Guide - Graphical Mode

l

Diffusion Module (DICTRA) Console Mode Example Macros

Installation Guides
Includes the quick install guides for Standalone Windows and macOS installations as well as
the full installation guide for all platforms and installation types. A quick install guide for TCPython is also there.

Precipitation Module (TC-PRISMA)
There is a stand-alone user guide in this folder. Use the Thermo-Calc Documentation Set for
all other details you need to work with this Add-on Module, which treats concurrent
nucleation, growth/dissolution and coarsening under arbitrary heat treatment conditions in
multicomponent and multi-phase systems using Langer-Schwartz theory and the KampmannWagner numerical approach.

Process Metallurgy Module
All the content is contained in the Thermo-Calc Documentation Set.

Property Model Development Framework
The PDF guide contains details about setting up a development environment so you can build
custom Property Models in Thermo-Calc.
The folder also includes two tutorial Python files you can copy and use in your own custom
Property Models. The examples are available as supplementary information as described in
the Property Model Development Framework Guide.

Software Development Kits (SDKs)
The TC-Python HTML documentation is stored in its own folder. It is also
available from our website. In this folder you will find the PDF version of the
help.

l

TQ-Interface Programmer Guide: The TQ-Interface is available as a way to make
Thermo-Calc an integral part of application programs such as those for process
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simulation, microstructure evolution modeling and materials property prediction.
l

l

TC Toolbox for MATLAB® Programmer Guide: Use this to enable communication
between Thermo-Calc and MATLAB® to be able to retrieve thermodynamic and
kinetic quantities.
TC-API Programmer Guide: This is the Thermo-Calc API that can be used by
programmers to set up your own applications to work with Thermo-Calc.

TC-Python (SDK)
TC-Python is an SDK and you can search and use the special HTML file located in this folder.
Double-click the Index.html file to open it. This help is also available via our website.
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About the Examples
To learn more about how to use the software you can open and run the example projects
(Graphical Mode) and macro files (Console Mode).

Graphical Mode Examples
Graphical Mode examples are available for Thermo-Calc and the Add-on Diffusion Module
(DICTRA), Precipitation Module (TC-PRISMA), and Process Metallurgy Module. These are in
the format of project files (*.tcu).

Console Mode Examples
Console Mode examples are available for Thermo-Calc and the Diffusion Module (DICTRA).
The macro files are in the format of *.TCM and *.DCM, respectively.

There are other file types when you are working in Console Mode. See Working
with the Console Mode File Types and About the File Formats in the Diffusion
Module Quick Start Guide.

Examples by Product
Thermo-Calc Examples
A description of the Thermo-Calc examples, and how to access them, is based on whether
you are using Graphical Mode or Console Mode.
Graphical Mode Examples
Thermo-Calc Console Mode Examples

Diffusion Module (DICTRA) Examples
A description of Diffusion Module (DICTRA) examples, which are available for both
Graphical Mode and Console Mode, is included in both the Thermo-Calc and Diffusion
Module (DICTRA) documentation.
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For Graphical Mode, see Diffusion Module (DICTRA) Graphical Mode Examples
For Console Mode, search the help or go to the Diffusion Module
(DICTRA) documentation set.
All the macro files and the outputs are also combined into one file that you can
search and read. This is included with your installation as a PDF (go to Help >
Manuals folder > Diffusion Module (DICTRA) and open Diffusion Module
Console Mode Example Macros.

Precipitation Module (TC-PRISMA)
A description of examples using the Precipitation Calculator, which is only available in
Graphical Mode, is included in both the Thermo-Calc and Precipitation Module (TC-PRISMA)
documentation.
Precipitation Module (TC-PRISMA) Graphical Mode Examples

Process Metallurgy Module Examples
A description of examples using the Process Metallurgy Calculator, which is only available in
Graphical Mode, is included in the Thermo-Calc documentation.
Process Metallurgy Module Examples Collection

TC-Python Examples
A brief description of the TC-Python SDK examples, and how to access these, is available in
the Help.

TQ-Interface and TC-Toolbox for MATLAB Examples
There are examples for the TQ-Interface and TC-Toolbox for MATLAB available as described
in Examples, Manuals and Materials Folders. You can also find information about these in
the respective user guides or by searching the online help.

Watch the Video Tutorials
Many of our Graphical Mode examples have video tutorials, which you can
access in a variety of ways. When in Thermo-Calc, from the menu select Help →
Video Tutorials, or you can go to the website or our YouTube channel.
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Help Resources
'Online' Help: No Internet Required
To access online help in a browser, open Thermo-Calc and press <F1> on the keyboard, or
select Help → Online Help.
The content opens in a browser but uses local content so you don't need an Internet
connection except for links to external websites.

Context Help (Graphical Mode Only)
When you are in Graphical Mode, you can access feature help (also called topicsensitive or context help) for the activity nodes in the tree.
1. In the Project window, click a node. For example, System Definer.
2. In the lower left corner of the Configuration window, click the help button

.

3. The Help window opens to the relevant topic.

The window that opens has the same content as the help you access in the browser.
There are these extra navigation buttons in this view.
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4. Use the buttons on the bottom of the window,
,
to navigate Back and Forward (these are only active once you have started using the
help to load pages and create a history), to Close the window, and Reload the
original content.

Console Mode Help
Console Mode is for Thermo-Calc and the Diffusion Module (DICTRA).
In Console Mode at the command line prompt, you can access help in these ways:
l

l

l

For a list of all the available commands in the current module, at the prompt type a
question mark (?) and press <Enter>.
For a description of a specific command, type Help followed by the name of the
command. You can only get online help about a command related to the current
module you are in.
For general system information type Information. Specify the subject or type ? and
the available subjects are listed. This subject list is specific to the current module.
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Typographical Conventions
The following typographical conventions are used throughout the documentation, both
online and in the PDF documents.

Text
Convention

Definition

Forward arrow
symbol →

The forward arrow symbol → instructs you to select a series of menu items in a
specific order. For example, Tools → Options is equivalent to: From the Tools
menu, select Options.

Boldface font

A boldface font indicates that the given word(s) are shown that way on a toolbar
button or as a menu selection. For example, if you are told to select a menu
item in a particular order, such as Tools→Options, or to click Save.

Italic font

An italic font in the body of the text indicates the introduction of important
terminology. Expect to find an explanation in the same paragraph or elsewhere
in the guide.

COMMAND

For features in Thermo-Calc that use Console Mode (i.e. the command line), this
font and all capital letters indicates that this is a Console Mode COMMAND.
Examples of how you can use a command are written with code font. For
example:
Use DEFINE_ELEMENTS followed by a list of the elements that you want in your
system. (To list the elements that are available in your current database, use
LIST_DATABASE and choose Elements).

HELP

Text in blue and underline and a page number is a link to another topic in the
current or referenced guide. Command names are often also topics. Clicking
the link takes you to more detail about a particular command or subject in the
PDF or documentation set.

<Enter>

Text with <angle brackets> indicates a keyboard entry. Usually to press <Enter>
(or Return) or to use a series of keys such as <Ctrl + S>.

code and code bold

A code font shows a programming code or code example. The code bold font
highlights the entry. It is also used for file names or paths to help distinguish it
from other text. e.g.
l

For Windows users, the documents, materials, examples and other folders

The Thermo-Calc Software User Guide ǀ 34 of 83

Thermo-Calc Documentation Set

Convention

Definition
that sometimes require additional licenses are installed in
C:\Users\Public\Public Documents\Thermo-Calc\<version>."

In general, you click with the mouse to perform an action on the screen (e.g.
click Save) and you press keys on a keyboard to enter a set of commands (e.g.
press Ctrl+S).
click vs press

When working in Console Mode, you can use keyboard shortcuts.
Sometimes a window opens where you have the option to Save,
Cancel or Open a file, for example. In these cases the instructions
might say click Save, whereas you would need to press the
applicable keys to perform the action.

Icons
Convention

Definition

Important

Provides important information. It is recommended that you
read the text or follow the link.

Note

The information can be of use to you. It is recommended that
you read the text or follow the link to more information.

Go to the link or guide to see more general information about
the topic being discussed. Usually includes both text and a link.
Also see

Tip

The small blue arrow is used when there is one (sometimes two) cross
reference and no text describing the link. Often used in settings pages
to link you to accompanying theory or extra detail.

This is general information that can be of use but is not required
knowledge.
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Convention

Definition

Examples

Go to the example collection to learn more.

Console Mode

This note relates specifically to something in Console Mode.

Video

Indicates there is a video tutorial on our website, usually in
relation to an example.

Graphical Mode

This note relates specifically to something in Graphical Mode.

Diffusion Module
(DICTRA)

This indicates that the information relates to the add-on Diffusion
Module (DICTRA).

Precipitation Module
(TC-PRISMA)

This indicates that the information relates to the add-on
Precipitation Module (TC-PRISMA).

Process Metallurgy
Module

This indicates that the information relates to the add-on Process
Metallurgy Module.
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Databases: Thermophysical Properties Data
In this section:
About Thermophysical Properties Data Parameters

38

Electrical Resistivity and Thermal Conductivity Models

40

Surface Tension of Metallic Liquid Alloys Model

45

Viscosity of the Metallic Liquids Model

48

Viscosity of the Ionic Liquids Model

50

Molar Volume Model

51
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About Thermophysical Properties Data Parameters
Parameters, Functions and Variables
Thermophysical Properties Variables
The so-called classic syntax is used in the examples below. It can be used in
Console Mode or when using the APIs, e.g. TC-Python. Graphical Mode in
Thermo-Calc has readable names for all of these.

Viscosity Model
Viscosity of the Metallic Liquids Model
Viscosity of the Ionic Liquids Model
To use this model, the database parameter VISC is needed. It can be used for liquids.
l

Dynamic viscosity (DVIS)

l

Kinematic viscosity (KVIS)

Examples in Console Mode:
l

In POLY module: SHOW DVIS(LIQUID)

l

Set as plot variable: SET-DIAGRAM-AXIS Y KVIS(LIQUID)

Thermal Conduction
Electrical Resistivity and Thermal Conductivity Models
To use the thermal conduction parameters, the database parameter THCD is needed. The
other two related properties are derived from THCD. These properties can be obtained for a
phase or for the whole system.
l

Thermal conductivity (THCD)

l

Thermal diffusivity (THDF)

l

Thermal resistivity (THRS)
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Examples in Console Mode:
l

In POLY module: SHOW THCD

l

Set as plot variable: SET-DIAGRAM-AXIS Y THDF(FCC_A1)

Electric Properties
Electrical Resistivity and Thermal Conductivity Models
To use the electric properties parameters, the database parameter ELRS is needed. ELCD is
derived from that. These properties can be obtained for a phase or for the whole system.
l

Electric conductivity (ELCD)

l

Electric resistivity (ELRS)

Examples in Console Mode:
l

In POLY module: SHOW ELCD

l

Set as plot variable: SET-DIAGRAM-AXIS Y ELRS(FCC_A1)

Surface Tension
Surface Tension of Metallic Liquid Alloys Model
Surface tension for liquids can be calculated if the database contains the two database
parameters SIGM and XI. From these, the surface energy is calculated:
l

Surface energy (SURF)

Examples in Console Mode:
l

In POLY module: SHOW SURF(LIQUID)

l

Set as plot variable: SET-DIAGRAM-AXIS Y SURF(LIQUID)
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Electrical Resistivity and Thermal Conductivity
Models
All binary systems are modeled by using experimental data or theoretical estimations.
Ternary and multicomponent systems can be extrapolated and the calculation results agree
very well with the measurements in the selected case studies.

Electrical Resistivity Model Description
The semi-empirical model for electrical resistivity is built based on the Matthiessen’s rule
[1997, De-Bruyn-Ouboter]. In general, the electrical resistivity of a metallic alloy consists of
residual resistivity ( ) and electron-phonon resistivity (
), as well as magnetic resistivity (
). The residual resistivity is due to the scatterings of impurities and defects that exist in
well-annealed and high purity alloys, and the value of is generally considered
independent of temperature.
[Eq. 1]
is described with the modified Bloch-Grüneisen equation [1928, Bloch; 1933, Grüneisen]
and corrections can be made in cases where other types of scatterings play considerable
roles.

[Eq. 2]

[Eq. 3]

[Eq. 4]
The characteristic temperature
plays a similar role and is also approximated as the
Debye temperature ( ), which can be readily obtained from low-temperature heat capacity
and elastic constants data as well as theoretical computations. The approximation of
as
indicates that transverse phonons play a role in electron scattering.
is the electron
wave number at the Fermi surface.
is the phonon Debye wave number. is the Planck
constant. is a constant representing the strength of the e-p interaction and cannot be
easily estimated.
is the electron effective mass. is the number of unit cells per unit
volume.
is the electron velocity at the Fermi surface.
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To describe the drastic change of the magnetic resistivity ( ) around the Curie (or Neel)
temperature, , of a magnetic alloy, an empirical model is proposed using the
dimensionless temperature
and a parameter
that stands for the resistivity due to
spin disordering. According to this model, Eq. 5,
approaches
, when the temperature
is well above , and is 0 when the temperature is far below .
depends only on
composition and is described with the Redlich-Kister (R-K) expression. Apparently,
has a
positive value for magnetic elements, and compounds as well as endmembers, and is 0 for
non-magnetic ones.
In a typical binary system made of a magnetic element A and a non-magnetic element B,
decreases usually from
to 0 at a certain composition ( ). Such a behavior is also
seen in magnetic moment and Curie temperature.
is expected to be zero in the
composition range from to element B, and will be forced to zero when the R-K expansion
leads inevitably to negative values over this composition range.
is available from the
thermodynamic description in the database.

[Eq. 5]
The semi-empirical model (as given in Eq. 1 to Eq. 5) is first fitted to experimental data. The
description is then extrapolated to a wider temperature range if necessary, either to
extreme temperatures where the structure is no longer stable or to where experimental
data are missing. Polynomials are then derived with the experimental data, together with
the extrapolated values, and stored in the database. The model as given in Eq. 5 is
implemented in Thermo-Calc, so the magnetic contribution can be excluded from the
polynomials and separately modeled, and it will be automatically included during the
calculations.

Thermal Conductivity Model Description
Experimental data of thermal conductivity are used to derive descriptions in polynomials,
which are stored in the database, despite that it consists of two components, electronic
thermal conductivity ( ) and lattice thermal conductivity . In other words, they are not
separately treated.
In cases where experimental data are absent or sparse, however, and can be
separately predicted and summed up to give the total thermal conductivity. can be
predicted from or vice versa, by employing the Wiedemann-Franz Law [1853, Franz; 1985,
Jones], respectively, to the residual resistivity, magnetic resistivity and intrinsic resistivity.
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[Eq. 6]
is known as the Sommerfeld value of the Lorenz number,

[Eq. 7]

[Eq. 8]
The intrinsic resistivity ( ) is based on Eq. 2 for the e-p processes, but corrections are
provided, as given in Eq. 8: the first term corresponds to large-angle scattering that satisfies
the original Wiedemann-Franz Law; the second one is due to inelastic small-angle (vertical
processes) and has no counterpart in the electrical resistivity; the third term is a correction
that accounts for situations where large-angle scattering can reverse the electron direction
without actually assisting to restore the distribution back to equilibrium.
can be predicted with the Slack model in a temperature range where only anharmonic
Umklapp phonon-phonon interactions are important. In other words, normal processes are
neglected as a first approximation [2002, Morelli; 1979, Slack]. The most reasonable version
among several ones is given below [1965, Julian].

[Eq. 9]

[Eq. 10]
The Debye temperature,
can be obtained from low-temperature heat capacity or elastic
constant data.
is the average atomic mass, the volume per atom, the number of
atoms in a unit cell, and the Grüneisen coefficient. A typical value for
is evaluated to be
using
as the Grüneisen coefficient, and can be used in the absence of
experimental information. It can also be obtained from e.g. DFT calculations of elastic
properties.

Model Parameters
The extended TDB format accepts parameters describing electrical resistivity and thermal
conductivity, together with spin disordering resistivity. Examples for unary and binary
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systems are given below:
ELRS(FCC_A1,AL:VA;0)
ELRS(FCC_A1,AL,CO:VA;0)
THCD(FCC_A1,AL:VA;0)
THCD(FCC_A1,AL,CO:VA;0)
ESPD(FCC_A1,CO:VA;0)
ESPD(FCC_A1,AL,CO:VA;0)

Calculation and Plot Variables
l

ELRS

– Electrical resistivity

l

ELCD

– Electrical conductivity

l

THCD

– Thermal conductivity

l

THRS

– Thermal resistivity

l

THDF

– Thermal diffusivity

All the above quantities can be calculated, retrieved, shown and plot in Thermo-Calc via the
variables in the Console Mode or via the quantity names in the Graphic Mode (see sections
below).

Console Mode
The quantities corresponding to the variables of ELRS, ELCD, THCD, THRS and THDF can be
calculated in Console Mode for a phase, e.g. ELRS(FCC_A1), or for a system, i.e. ELRS. The
results can be shown in the POLY module with the command SHOW_VALUE or illustrated as a
plot in the POST module with the command PLOT_DIAGRAM.

Graphical Mode
On the Plot Renderer in Graphical Mode, electrical resistivity, electrical conductivity,
thermal conductivity, thermal resistivity, and thermal diffusivity can be selected from the
axes lists, tabulated and plotted using the quantity names, with options for a specific phase,
all phases or for a system.

TC-Python
The quantities of ELRS, ELCD, THCD, THRS and THDF can be retrieved, for a phase, e.g. ELRS
(FCC_A1), or for a system, i.e. ELRS, via get_value_of() or get_values_of(), from most
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phase equilibrium calculations in TC-Python, for instance,
l

with_single_equilibrium_calculation(),

l

with_property_digram_calculation()

l

with_batch_equilibrium_calculation().

or
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Surface Tension of Metallic Liquid Alloys Model
All the surface tension of all elements and binary systems are assessed.

Model Description
The chosen model for the surface tension of metallic liquid alloys is the modified
Guggenheim model [2019, Vermot des Roche]:

where
l

l
l

l

l

is the bulk composition
is the surface tension
and

are the total and the partial molar surface of species defined as

being the Avogadro number and
species .

the molar volume of the system or the

is the composition of in surface, which is a function of bulk composition and
and defined as follows:

l

and
are called damping factors and these parameters are fitted for species 1
and 2 of binary systems.

The extrapolation to higher-order systems is straightforward. The ideal surface composition
for a multicomponent system is:
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and the surface tension of a multicomponent alloy is obtained from:

Reference
[2019, Vermot des Roche] M. Vermot des Roches, A. E. Gheribi, P. Chartrand, "A versatile
multicomponent database for the surface tension of liquid metals," Calphad. 65, 326–339
(2019).

Corresponding Variables
The corresponding variable for surface energy of pure elements is SIGM. For instance, the
surface tension of pure A is written as SIGM(LIQUID,A;0). The corresponding X1 and X2
parameters for A-B binary system are respectively written as following:
PARAMETER XI(LIQUID,A,B:0)
PARAMETER XI(LIQUID,B,A:1)

The surface energy of the liquid is accessed via SURF(LIQUID).

Plot Variables
Console Mode
The surface energy can be calculated through step calculations in Console Mode. The plot
variable is SURF(LIQUID).

Graphical Mode
The surface energy is calculated using the One-axis calculation type in Graphical Mode. The
corresponding plot variable is Surface tension.

TC-Python
In TC-Python, it can be plotted using property-diagram_calculation() or with_batch_
equilibrium_calculation(). The plot variable is SURF(LIQUID).

Graphical Mode and Console Mode Examples
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There are two basic examples included with your software installation and that use
demonstration (DEMO) databases.
Search the help (press F1 when in Thermo-Calc) for brief descriptions of these examples, or
browse to the examples located in your installation. From the main menu, Help→ Examples
Files:
l

Graphical Mode T_11_Surface_tension_in_Cu-Zr.tcu

l

Console Mode tcex56
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Viscosity of the Metallic Liquids Model
Model Description
The viscosity of metallic liquid alloys is modeled as follows:

where
l
l

is the dynamic (or shear) viscosity of the liquid,
is the viscosity at finite temperatures,

l

is the activation energy in J/mole,

l

is the gas constant, and

l

is the absolute temperature.

The SI unit of viscosity is pascal.second (Pa.s). The viscosity parameters are expanded via
Redlich-Kister polynomials.
For example, viscosity of a liquid A-B alloy is:

The two first terms are the contributions for the end-members, A and B elements and the
last term accounts for the excess viscosity. Basically, the activation energies are optimized.
and etc. are the parameters that are optimized to fit the viscosity data.
The kinematic viscosity, is the ratio of the dynamic viscosity to the density, , of the alloy:

The SI unit of kinematic viscosity is square meter per second (m2/s).

Corresponding Variables
In Console Mode, the viscosity can be plotted via a step calculation vs. temperature or
composition. The calculated property in Thermo-Calc is VISC of the liquid phase. The
calculated VICS property is not the viscosity ( ) but is related to via
, thus in order
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to plot the viscosity or you define a function for as follows:

The default unit is Pa.s.
However, it is also possible to directly get the values for dynamic and kinematic viscosity in
Console Mode and using TC-Python. The relevant properties are DVIS (dynamic viscosity)
and KVIS (kinematic viscosity). For example, once the equilibrium is calculated in Console
Mode, one can get the viscosity value by:
show DVIS(liq)

or show

KVIS(liquid).

In Graphical Mode, the viscosity ( ) is directly plotted when using the One-axis calculations
available with various calculators.

Graphical Mode and Console Mode Examples
There are two basic examples included with your software installation and that use
demonstration (DEMO) databases.
Search the help (press F1 when in Thermo-Calc) for brief descriptions of these examples, or
browse to the examples located in your installation. From the main menu, Help→ Examples
Files:
l

Graphical Mode T_12_Viscosty_in_Cr-Ni.tcu

l

Console Mode tcex55
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Viscosity of the Ionic Liquids Model
The model for TCS Metal Oxide Solutions Database (TCOX) viscosity of slag:

where is viscosity,

and

is activation energy.

The excess parameters are expanded via R-K. An example of viscosity of A-B liquid oxide:

The parameter of VISC stands for R⋅ T⋅ ln(viscosity). In Thermo-Calc software,
VISC is implemented as VISC(ionic). In order to quickly acquire the actual
viscosity, the parameter of DVIS(ionic) should be used. By coupling to the
database, it makes use of the site fractions of each species, which reflects the
structural change in the oxide melt.
Units for the viscosity of oxide slag:
l

Pa·s (pascal-second) is the SI unit, mostly used for oxide slag

l

CGS unit is poise (P), 1 poise=0.1 Pa·s

l

Centipoise is also common (cP) because it is equivalent to mPa·s.
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Molar Volume Model
Molar volume can be used to establish a connection with some significant physical
properties, for example, viscosity, electrical conductivity and surface tension. It is the
reciprocal of density multiplied by molar mass.

Model Description
The model used to describe the molar volume at ambient pressures is:

A simple polynomial is used to model non-magnetic volumetric expansivity above 298K:

The model described above is implemented in Thermo-Calc software with two parameters,
V0 and VA, and α is the linear thermal expansivity at 1 bar and 3α is the volumetric thermal
expansivity.

Molar Volume Descriptions

Parameter

Unit

Description

V0 (phase, constituent array)

m3/mol

Volume at 1 bar and reference temperature T0

VA (phase, constituent array)

None
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Database Files
In this section:
About the Database Files

53

Database Installation Folder

55

About Cached Database Files

56

Editing the Database Initialization File or Unencrypted Database File

57

Database Checker

58
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About the Database Files
Database Manager User Guide
Go to the Thermo-Calc website for links to all the current database information
sheets.

Encrypted vs Unencrypted Database Files
Any licensed databases purchased from Thermo-Calc Software are encrypted in files with
the extension .TDC; these files cannot be edited. These are referred to as encrypted
databases.
Unencrypted databases have the file extension .TDB and can be edited. For example, PURE5
or PG35 (the free databases) or a user-defined database file. If you plan to edit any of these
files.
Editing the Database Initialization File or Unencrypted Database File

Database Initialization File
The database initialization file is called tc_initd.tdb. Individual licenses are still required
to use each database.
The file is used differently by the program depending on whether you are working with
databases in Console Mode or Graphical Mode. For this reason, editing the file can be
problematic if you don’t understand the differences.
About Cached Database Files and Editing the Database Initialization File or
Unencrypted Database File

User Database Files
A user-defined database is considered to be an unencrypted database because you can make
changes to it.
In Graphical Mode you can add user databases via the Options → Graphical Mode →
System definer window. Once you have added the user database it is available from the
database list in the System Definer Configuration window.
Global Settings: System Definer to add a user database.
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In Console Mode, users may decide to add their own user-defined database to the database
initiation file, which then makes it available in the Console window. If you plan to edit this
file.
Editing the Database Initialization File or Unencrypted Database File

Custom Databases: GES5 and GES6 Calculation Engine Version
As of Thermo-Calc version 2019b, the default calculation engine is set to GES6. For custom
database users, you may sometimes see messages in the log indicating that additional
preparation is being done by Thermo-Calc prior to a calculation. The preparation is carried
out automatically; it is usually fast and only needed the first time a custom database is used
after a modification. While databases with warnings are tolerated, databases that contain
errors can only be loaded by GES6 after the errors are corrected.
The Database Checker tool uses the same parser as GES6 and can be used to verify the
consistency and correctness of databases during development, before the databases are
actually used.
Database Checker

To globally set the default from GES6 back to GES5, go to the Tools → Options
→ General tab and click Version 5 for the Preferred Gibbs Energy System
setting. The SET_GES_VERSION Console Mode command is used to change GES
versions for a single Thermo-Calc session.

Contact Thermo-Calc Software AB at info@thermocalc.com for more
information about the changes or if you encounter any issues you think are
related to the new version of the calculation engine.
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Database Installation Folder
The standard Thermo-Calc databases and the database initialization file tc_initd.tdb are
located in a subfolder to the Thermo-Calc installation. For example, in a Windows
Standalone installation, you can find these in a folder called data where the file path is
C:\Program Files\Thermo-Calc\<version>\data.
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About Cached Database Files
This is applicable to Graphical Mode.
Also see Global Settings General where you can set the default database
directory path. There is also an option to clear the database cache, which may
be helpful if you are having issues.
The first time you open a database in Graphical Mode it can take a little while for it to load,
especially if it is one of the large databases such as TCFE or TCNI. However, the next time
the database opens quickly because now the databases are cached, or stored, in Graphical
Mode.
Think of a cache as an intermediate storage area. Once a database cache is established the
file made easily accessible, even if you close the software program. It is the same concept as
when you load a web page for the first time. The next time the page opens faster. This is
also how it works for the databases in Thermo-Calc Graphical Mode.
Thermo-Calc caches the database files, both encrypted and unencrypted types, at two points
–when you first open a database, sometimes called an in-memory cache, and then later as a
disk-based cache.. The disk-based cache is what speeds up database loading and it is at this
point that Thermo-Calc refers to the database initialization file for information. The diskbased cache uses a lookup key to find the abbreviated database name (e.g. TCFE or TCNI)
contained in this initialization file.

It is important to understand the way databases are cached in Graphical Mode
to ensure best practices for those who also use Console Mode, especially if the
database initialization file is edited. If you plan to edit this file, see Editing a
Database Initialization File or Unencrypted Database File for important
information.
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Editing the Database Initialization File or
Unencrypted Database File
Some advanced users may decide to edit the database initialization file, for example to
reorder the list of encrypted databases displaying in the Console window or to add their own
user-defined database for use in Console Mode. It is important to understand that changes
to this file impact the database caching process used in Graphical Mode.
About the Database Files
About Cached Database Files
The following recommendations are also applicable if you edit an unencrypted database file,
which includes user databases and free databases such as PURE5 or PG35.

Best Practice Recommendations
Database Installation Folder
If you edit the database initialization file (tc.initd.tdb in Windows or initd.tdb in Mac and
Linux), then:
l

If a user database is added to the file, it is subject to the same caching as the
encrypted databases. This means that further changes (to the user database) will not
be detected when you are working with databases in the System Definer in Graphical
Mode.

If you have a user database, which is subject to regular updates, then:
l
l

If you make changes to a user database, you then need to clear the cache.
It is recommended that you create a separate directory to store unencrypted
database files.

If you edit an unencrypted database file included with the installation (such as the PURE5
and PG35 files):
l

Do not edit the file in the installation folder. Instead make a local copy and load it
into the application as a user database.
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Database Checker
The Thermo-Calc software package includes a program to check that the syntax of
unencrypted database files is correct. The program applies the syntax rules set out in the
Database Manager User Guide and reports errors and issues warnings. This program is
intended for advanced users who develop and manage databases.
Thermo-Calc accepts deviations from these syntax rules. This means that a
database can work even if the Database Checker reports errors and warnings.
For example, an error is reported if an abbreviated phase name is found, but
phase name abbreviations are accepted by Thermo-Calc and its Add-on
Modules.
The executable DatabaseChecker file is found in the Thermo-Calc home directory. The
program can also be launched by selecting Tools→ Database Checker from the main menu.
Database Manager User Guide
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Changing Global Settings
In the Options window (select Tools → Options) you can globally set general settings for
Graphical Mode as well as default settings for any new activities for both Graphical Mode
and Console Mode.
In this section:
General

60

Graphical Mode - Default Units

63

Graphical Mode: Activities

65

Global Settings: System Definer

66

Global Settings: Equilibrium Calculator

68

Global Settings: Diffusion Calculator

69

Global Settings: Precipitation Calculator

70

Global Settings: Process Metallurgy

71

Global Settings: Scheil Calculator

72

Global Settings: Tables

73

Global Settings: Graphical and Console Mode Plotting

74

Global Settings: Console Mode Default Appearance

82
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General

These settings are for both Graphical Mode and Console Mode. To open this window, from
the main menu select Tools → Options.

Tooltips enabled
Select whether to turn on tooltips information. By default the Tooltips enabled check box is
selected. This displays a small text box when you hover the cursor above some buttons or
other items.

Localization
To change the GUI language from the Localization list choose English (the default),
Swedish, Spanish, German, Russian, Chinese, Japanese or French.

Look and feel
To change the Look and feel of the GUI layout, choose Windows (the default), Metal,
Nimbus, CDE/Motif or Windows Classic.

Log level
Select the level and type of information to display in the Event Log window using the Log
level slide bar. Choose from a Debug, Info, Warning or Error level of detail.

Database directory
In the Database directory field, specify the path to the directory that contains the data
directory. This is where the Thermo-Calc database directory called data is located. Do not
specify the path to where the database files are found (that is, in the data directory).

Modifying the Database Directory Path (Graphical Mode Only)
Important Note: Database Directory Path (Graphical Mode only)
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When you open a database for the first time, it is stored in a cache (an intermediate storage
area), that is maintained even if you close the program. This improves the speed of loading
the next time you open that database. The cache is used for all databases that are listed in
the database initialization file, typically all the standard databases that are included with
Thermo-Calc.
If you modify your own user-defined database, or if you choose to edit an unencrypted
database, it is recommended that you create a separate directory to store these database
files. This way the most recent version of the user-defined or edited databases are loaded
into the program when the System Definer is performed.
About the Database Files

Model directory
This is where the predefined and custom Property Models are saved and stored by default.
Click Modify to open the default folder or to create a custom folder for your own models.

All Property Models (whether these are predefined or custom models) must be
located in a subdirectory of the Property Model directory. For that reason it is
recommended that you do not change the directory location.

See Property Model Calculator for information about using the predefined
models. Also see "Creating a New Property Model" in the Property Model
Development Framework Guide for details about creating a custom model.

Check update interval
From the Check update interval list, choose not to check (Do not check, the default) or On
startup. You can also manually check for updates – choose Help→Check for Updates.

Preferred Gibbs Energy System
About the Gibbs Energy System (GES) Module.
Use this setting to globally set the default GES version to be either GES6 (the default) or
GES5.
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This setting is useful if you are using the POURBAIX module (aqueous solutions) or if you
have a custom database that is not compatible with GES6. The SET_GES_VERSION Console
Mode command can also be used to change GES versions for a single Thermo-Calc session.
Contact Thermo-Calc Software AB at info@thermocalc.com for more
information about the changes or if you encounter any issues you think are
related to the new version of the calculation engine.

Reset all settings and the database cache to defaults
Click Factory reset to reset all the settings to the original defaults, including clearing the
database cache. The changes are applied when Thermo-Calc is restarted. This may be useful
when there are several versions of Thermo-Calc installed and there are conflicts between
settings or loading databases becomes problematic. See About Cached Database Files.

Reset to original settings
Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.
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Graphical Mode - Default Units

To open this window, from the main menu select Tools → Options and click the Default
Units tab.

Reset to original settings
Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.

Setting

Options

Temperature

Kelvin (the default), Celsius or Fahrenheit

Pressure

Pascal (the default), Atmospheres or Bar

Amount

Mole (the default), Gram, Kilogram, Tonne or Pound

Composition

Mass percent (the default), Mole percent, Mass fraction or Mole fraction

Energy

Joule (the default), Calorie , Electron volt, Gigajoule, Watt hour or Kilowatt hour

Volume

Cubic meter (the default), Cubic decimeter, Cubic centimeter or Normal cubic
meter

Density

Kilogram per cubic meter (the default) or Gram per cubic meter

Entropy

Joule per Kelvin (the default), Calorie per Kelvin or Electron volt per Kelvin

Dynamic viscosity

Pascal-second (the default), milliPascal-second, Poise or centiPoise

Kinematic
viscosity

Square meter per second (the default), Stokes or Centistokes
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Setting

Options

Length

Meter (the default), Micrometer or Nanometer

Time

Seconds (the default), Minutes, Hours or Days

Velocity

m/s (the default), μm/s or nm/s

Surface tension

Joule per m2 (the default) or Millijoule per m2
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Graphical Mode: Activities

To open this window, from the main menu select Tools → Options and click the Activities
tab.
There are System definition, Calculation, Precipitation, Diffusion, Scheil, Process
Metallurgy, Plotting and Tabulation settings windows.
For Plotting, the default settings are shared with the Graphical and Console
Modes. Any changes you make also apply to the default settings on the Console
Mode → Plotting tab in the Options window (and vice versa).
Global Settings: Graphical and Console Mode Plotting
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Global Settings: System Definer
When you create a new System Definer, the default databases are taken from these
defaults. The database selections for each System Definer can then be configured
individually. Once created, the specific (local) settings for a System Definer are not affected
if you later make changes to the global defaults.
To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click System definition.

System Definer
Creating a Database Package and Clearing a Database Package Message

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.

Default database selection
The Default database selection can be either for a Database or a Database Package.
l

l

If you choose Database, then select the default installed database to use globally for
all System Definer nodes. For example, choose the latest version of the TCS Steel and
Fe-alloys Database (TCFE) from the list if you have a license.
If you choose Database Package, select an option from the list. These Database
Packages are defined in the Database Packages section described below.

User Databases
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Under User Databases, define the Database name after adding a custom database.
Click Add to navigate to a custom database on your computer. After you have added the
user database it is available from the list to choose as the default.
Once a user database is added to the Database name list, you can also click the Remove
button to delete it from your project.

Database Packages
Based on the installed databases, there are also default Database Packages available. Use
this section to organize your own sets of databases that you use together often.
Create and remove Database Packages by clicking the Add a database package
Remove this database package button.

button or

The addition or removal of a database package does not take effect until a new
System Definer node is defined.

Click Show details to display the list of databases included with the package. Click Hide
details to only display the name of the package.
Creating a Database Package
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Global Settings: Equilibrium Calculator
When you create a new Equilibrium Calculator, its initial settings are taken from these
defaults. The settings of each Equilibrium Calculator can then be configured individually.
Once created, the specific (local) settings for an Equilibrium Calculator are not affected if
you later make changes to the global defaults.
To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Calculation.
Options Tab Settings

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.
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Global Settings: Diffusion Calculator
When you create a new Diffusion Calculator, its initial settings are taken from these
defaults. The settings for each Diffusion Calculator can then be configured individually. Once
created, the specific (local) settings are not affected if you later make changes to the global
defaults.
To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Diffusion.
Options Tab Settings

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.
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Global Settings: Precipitation Calculator
When you create a new Precipitation Calculator, some of its initial settings are taken from
these defaults. The settings for each Precipitation Calculator can then be configured
individually. Once created, the specific (local) settings for a Precipitation Calculator are not
affected if you later make changes to the global defaults.
To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Precipitation.
Conditions Tab Settings

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.
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Global Settings: Process Metallurgy
The Material Manager is only available from this window. Use it to create
material groups, as described below.

When you create a new Process Metallurgy Calculator, its initial settings are taken from
these defaults. The settings for each Process Metallurgy Calculator can then be configured
individually. Once created, the specific (local) settings are not affected if you later make
changes to the global defaults.
To open this window, from the main menu select Tools → Options → Graphical Mode and
click the Activities tab. Then click Process Metallurgy.
Except for the Material Manager (described below), you can globally adjust the
other settings on the Options Tab.

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.

Material Manager
For more information see Working with the Material Manager.
Use the Material group and Material lists to create and delete material groups, as well as
delete material compositions that are saved from the Process Metallurgy Calculator.
l

l

Material group: To create or delete a group, choose it from this list, e.g. Steel, Slag
or Gas. The Steel group is simply a generic Metal group. You can create other userdefined metal groups and then these would also be listed here. Click Create group or
Delete group as required to manage the list.
Material: To delete a material, choose the group type then select the material
composition to delete. For example, select the Slag material group, then choose the
Example Slag material and click Delete material to remove it from all lists.
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Global Settings: Scheil Calculator
When you create a new Scheil Calculator, its initial settings are taken from these defaults.
The settings of each Scheil Calculator can then be configured individually. Once created, the
specific (local) settings for a Scheil Calculator are not affected if you later make changes to
the global defaults.
To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Scheil.
Configuration Window Settings

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.
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Global Settings: Tables
When you create a new Table Renderer, its initial settings are taken from these default
settings. The settings of each Table Renderer can then be configured individually. Once
created, the settings of a Table Renderer are not affected by changes in the default settings.
To open this window, from the main menu select Tools → Options and click the Activities
tab. Then click Tabulation.
Configuration Settings

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.
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Global Settings: Graphical and Console Mode Plotting
The default settings are shared with both modes. Any changes you make also
apply to the default settings on the Console Mode → Plotting tab in the
Options window (and vice versa).

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.

Local Plot Property Settings
To make local changes to the appearance of a specific plot, in the Results window right-click
a plot and select Properties. In the Plot Properties window a variety of settings can be
made. These are the same settings as in the Options window.
You can also edit some properties for individual plot lines (the color, the line width and type,
and whether data points are included). In the Results window, hover the mouse over a plot
line. The crosshair cursor turns into a cursor resembling a pointing hand when it is over a
line that can clicked. Alternatively, hold down the <Ctrl> key while you move the cursor
around the plot to only display it as a crosshair and prevent unintended edits.

Global Configuration (Options)
To globally configure the default settings for plotting, from the main menu select Tools →
Options. You access the same settings either from the Graphical Mode or Console Mode
tabs.
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l

l

Click the Graphical Mode → Activities tabs and then click the Plotting node in the
tree, or
Click the Console Mode → Plotting tabs.

When you create a new Plot Renderer, its initial settings are taken from these
default settings. The settings can then be configured individually. Once created,
the settings of a Plot Renderer are not affected by changes to the default global
settings.

To configure the settings of an individual Plot Renderer rather than the default settings,
right-click a plot in the Results window and select Properties from the menu.
The following global settings are available for both Console Mode and Graphical Mode.
Most of the settings are found on the General tab. Additional settings below for the X-axis,
Y-axis or Image Quality tabs are indicated.

Titles, Legends and Labels
Title format and Label format
For the Title format or Label format, select Plain text (the default) or LaTeX formatted
text.
For LaTeX formatted text you can use the LaTeX math text to enter text. See
ADD_LABEL_TEXT and Plot Labels for more details.

Show legend
Select the Show legend check box to include a legend on the plot. By default no legend is
displayed.

Legend phase caption style
For the Legend phase caption style, choose None, All, Constitution description or
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Ordering description.
About Legend Styles
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Retain labels
Graphical Mode only.
By default the Retain labels check box is selected. Plot labels are kept (retained) when plots
are updated. It can be applied globally or locally to individual plots.

Show header
Console Mode only.
Click to select the Show header check box to display the basic details about the plot along
the top. This includes the date and time the plot is generated, the database used and the
properties.

Axis label format
Click the X-axis and Y-axis tabs to edit these settings.
Choose either Plain text or LaTeX-formatted text.

Axis label font
Click the X-axis and Y-axis tabs to edit these settings.
Click the Modify button to the right of the window to select a Font name, Style, Size and
color.
Choose or enter a Tick mark length (3 is the default). The defaults are to have the Tick
marks outside the chart and to Show tick labels. Click to clear the check boxes as required.

Tick label font
Click the X-axis and Y-axis tabs to edit these settings.
Click the Modify button to the right of the window to select a Font name, Style, Size and
color

Fonts and Background Colors
Title font, Legend font, Label font, Header font
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To change various attributes for the Title, Legend, Label and Header , click Modify to edit
the Font Name, Style, Size and Color.

Legend background color, Background color, Canvas color, Border color
To change various background color attributes, click Modify to choose a color or enter a
specific color.

Lines and Grids
Show grid
Click to select the Show grid check box to include a grid on the plot. By default no grid is
displayed.

Show every Nth tieline
Tielines are only applicable to phase diagrams.
Choose an integer value ranging from 0 to 99.

Color option (plot lines)
For the for plot line colors, choose a Color option from the list: Legacy, Printer friendly,
JFree chart, Pastel, Medium dark, Bright dark, Vivid or Earth.
This option is also available for specific plot lines. To change the color of an individual plot
line double-click it in the Results window and use the color palette to define it or enter a
specific color.

Border width
Choose a plot Border width between 1 (thin, the default) and 10 (thick).

Line width
For the plot line width, choose a Line width from the list. These options are also available
for specific plot lines. To change an individual plot line width double-click it in the Results
window.

Line type
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This option is only available for individual plot lines. To change an individual plot line type
double-click it in the Results window and choose a Line type from the list.
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Data Points, Anchors and Numbers
Show anchor
Click to select the Show anchor check box. By default, an anchor between the label and the
plot point is displayed.

Show data points
Click to select the Show data points check box to display the data points on the plot lines.
This option is also available for specific plot lines. To show data points on an individual plot
line double-click it in the Results window and select the check box.

Data points marker size
Choose the Data points marker size between 1 (small) and 10 (large). The default is 3.

Number of decimals
Choose the Number of decimals to display in the plot. The default is 2.

Numeric format
Choose the Numeric format to display in the plot Auto, Decimal or Scientific.

Plot Area Size
Plot area size
The Fit the plot area size to the enclosing window option is selected by default.
Click Define the plot area size to enter a Plot area height and Plot area width (not
applicable to triangular plots. The units are pixels and the size is kept as the size on the
screen (96 dpi).

Image Quality
Click the Image Quality tab to access the settings below.
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Choose a Default file format: Portable Network Graphics .png (the default),Graphical
Interchange Format .gif, Enhanced Windows Metafile .emf, Portable Document Format
.pdf, PostScript .ps, Scalable Vector Graphics .svg, or Joint Photographic Experts Group
.jpg.
The following settings are only available for .png and .jpg file formats.
To change the resolution of a *.png or *.jpg image, click to clear the Use default
resolution check box. Then enter a numerical value in the Dots per inch (DPI) field.
For .*jpg files, you can also use the slider to choose a number between 0 and 1 for the JPG
quality. The default is 0.9. The lower the number, the smaller the file.
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Global Settings: Console Mode Default Appearance
To open this window, from the main menu select Tools → Options. To change the name,
buffer size, fonts and colours for a specific Console window, right-click the label for that
particular Console and select Properties.

Reset to original settings: In the lower corner of the window, click the Reset to
original settings button to restore the original settings. You may have to scroll
or expand the window to see the button.

Console name
The default is Console or enter another name to display.

Buffer size
The default buffer size is 40,000.
In Console Mode, sometimes the output overflows the window text buffer. This is how to
increase the buffer size.
1. Right-click the Console tab header in the Console window (if this is the first Console tab,
it is labeled Console 1).
2. Click Properties, and increase the Buffer size in the Console Properties window.
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System output font
Click Modify to open the Select Font window and makes changes to the font type, style, size
or color as required.

User input font
Click Modify to open the Select Font window and makes changes to the font type, style, size
or color as required.

Command prompt font
Click Modify to open the Select Font window and makes changes to the font type, style, size
or color as required.

Background color
Click Modify to open the Select Color window to choose a background color for the Console
Mode window where you enter commands.

Default directory
Set the default directory file path to where the various file types are saved.
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Working in Graphical Mode
In this section:
The Graphical Mode Desktop Layout

3

Menu, Toolbar and Keyboard Shortcuts

4

Organizing the Windows on the Desktop

7
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The Graphical Mode Desktop Layout
Open Thermo-Calc to view the default graphical user interface (GUI) layout for Graphical
Mode.
The windows are:
1. Project: Create, manipulate and navigate between the activities that make up a
project. Click the My Project node to access the Quick Start wizard and a variety of
templates.
2. Configuration: Shows the settings that can be configured for the currently selected
activity.
3. Results: Shows the results of a calculation, either plotted as a diagram or displayed
in table format. In this example, there is a Plot Renderer tab in the Results window.
4. Scheduler: Displays information about jobs, such as calculations, that are being
performed or are scheduled to be performed. You can cancel scheduled jobs and if a
job has failed, then you can view information about the error.
5. Event Log: By default this window is closed but it displays during calculation
processes. You can always open it to view progress of calculations and to
troubleshoot.
In this example, the Results window also has a Plot Renderer tab. You can also have
a Table Renderer tab.
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Menu, Toolbar and Keyboard Shortcuts

The File menu and toolbar are reserved for Graphical Mode but in Console Mode the Tools,
Window and Help menus have the same options.
In Console Mode you use commands to access the other options, for example
see Main Menu Commands.

Graphical Mode Menu and Toolbar Options
Option

Description

Action (s)
Click New on the toolbar

New

Select File → New Project

Create a new project.

Windows: Press <Ctrl+N>
Mac: Press < ⌘N>
Click Open on the toolbar

Open

Open an existing project. See Saving and Opening Project
Files.

Select File → Open Project
Windows: Press <Ctrl+O>.
Mac: Press < ⌘O>
Click Save on the toolbar

Save

Save a project. See Saving and Opening Project Files.

Select File → Save Project
Windows: Press <Ctrl+S>.
Mac: Press < ⌘S>

Save
Project
As

Select File → Save Project
As
Save an existing project with a new name.

Windows: Press
<Ctrl+Shift+S>
Mac: Press < ⇧⌘S>
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Option

Description

Action (s)

Switch to
Console
Mode

Launch Console Mode and the command prompt.

Click the button to exit
Graphical Mode and open
Console Mode.

Switch to
Graphical
Mode

Launch Graphical Mode to work with the GUI version.

Click the button to exit
Console Mode and open
Graphical Mode.
Select File → Append
Project

Append
Project

Combine two projects into one project file. See Saving and
Opening Project Files.

Windows: Press
<Ctrl+Shift+O>
Mac: < ⇧⌘O>
In the upper right-corner
of the program, click the X.

Exit

Select File → Exit

Exit the program.

Windows: Press <Ctrl+Q>.
Mac: < ⌘Q>
Options

Change the global defaults for a variety of settings. See
Changing Global Settings.

Select Tools → Options

Database
Checker

Open the Database Checker, a program to check that the
syntax of Thermo-Calc database files is correct. This is for
advanced users who develop and manage databases.

Select Tools → Database
Checker

Window
menu

Highlight a specific window on the GUI

From the Window menu,
select an option to refocus
on that specific window.

Open the online help system where you can browse or
search all the Thermo-Calc documentation.
Help
This does not require an Internet connection.
The content is stored locally.

Video
Tutorials

Open a link to the Thermo-Calc website where a variety of video
tutorials are available.

Press <F1>
Select Help → Online Help

Select Help → Video
Tutorials
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Option

Description

Action (s)

Examples
Files

Open the examples folder based on whether you are in
Console Mode or Graphical Mode.

Select File → or Help →
Examples Files

Manuals
Folder

Open the folder on your computer that has the PDF
documentation and guides.

Select Help → Manuals
Folder

Open the License Information window.
Show
License
Info

Also see Displaying Thermo-Calc License
Information and the Thermo-Calc Installation
Guide

Select Help → Show
License Info

Check for
update

Check the Thermo-Calc Software website for updates to the
software.

Select Help → Check for
Updates

Request
Support

Open a link to the Support page on the Thermo-Calc website.
There are instructions about how to submit your question to
the Support email: support@thermocalc.com

Select Help → Request
Support

About

Includes the version number of the installed software and
information about third party software licenses.

Select Help →About
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Organizing the Windows on the Desktop
The windows on the Thermo-Calc desktop can be fixed or free-floating. By default, most
windows are fixed and open.

Auto-Hiding a Window
When a window is fixed it can also be set to auto-hide. Auto-hiding means that the window is
minimized when you select another window. The minimized window is then shown either
along the bottom or side of Thermo-Calc. A free-floating window is shown on top of the
other windows and can be moved outside the frame of Thermo-Calc.
The Event Log window is set by default to auto-hide.

Resetting the Desktop Layout
To return to the standard desktop layout, from the main menu, select Windows → Reset
Windows.

Floating, Hiding and Minimizing Windows in the GUI
For each window you can rearrange, resize, minimize and close it. At the top right corner
are the buttons listed in the table.
Button(s)

Description
Click to toggle on/off free-floating
Click to toggle on/off auto-hide.
Click to minimize an open window that has auto-hide turned on.
The window automatically minimizes if another window is selected.
Click to close the window. You can open the window again from the
Window main menu.
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Projects and Activities
In this section:
About the Activity Nodes

9

Graphical Mode Activity Node Workflow

13

Creating Activities and Successors

14

Cloning Activities and Trees

16

Moving Nodes in the Tree and Using the Grid

18

Node or Window Status Markers

20

My Project and Activity Menus

22

Saving and Opening Project Files

26

The Calculation Types in Graphical Mode

29

The Quick Start Wizard and Templates

32
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About the Activity Nodes
Graphical Mode Activities vs Console Mode Modules
In a project, a set of linked activities is called a tree. A result calculated within a tree is fed
as input into the next activity in the tree. Consequently, if you have an Equilibrium Calculator
with another Equilibrium Calculator as its successor, the successor takes the calculation
results of the predecessor as the starting values for its calculation. When working with
activities in the Project window these are also referred to as nodes (or activity nodes) in the
tree structure.
The example below shows a My Project node with two trees. In each tree, settings and
calculation results are propagated downward until the calculation and the visualization of
the results are completed in the Plot Renderer nodes.
The system definitions, settings and calculation results of the two trees are independent of
each other.

Activity Successor and Predecessor Nodes
An activity node located below another activity node in a tree is referred to as that activity’s
successor. An activity located above another activity is called that activity’s predecessor. A
predecessor is performed before the predecessor’s successors and its result is fed forward to
any successor activities.
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For example, to calculate and display a phase diagram, create a branch with three linked
activities: A System Definer activity linked to an Equilibrium Calculator activity, which in
turn is connected to a Plot Renderer activity.
You can determine the available successors by right-clicking a node in the Project window
and choosing Options from the menus. The example below shows that Binary Calculator 1
is a predecessor to the successors, Plot Renderer 2 and Table Render 1.

Creating Activities and Successors and Cloning Activities and Trees

Activity Node Descriptions
The table below is a brief description of the activity types you work with in the Project
window. When working with activities these are referred to as nodes in this documentation.
These are the project activity nodes available in Graphical Mode.
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Activity type

Description

System Definer

Define a certain thermodynamic system and read it from file into memory.

Property Model Calculator

Choose one or more General models and Steel models to predict and
optimize material properties. You can evaluate models simultaneously
over a range of compositions and cross plot the results. You can then
conduct an uncertainty analysis and plot the results as either a histogram
or as a probability plot.

Equilibrium Calculator

Set thermodynamic conditions and define axis variables when a series of
equilibrium calculations are to be performed in one or more dimensions.

Precipitation Calculator

Set the conditions for, and perform, a precipitation calculation using the
Precipitation Module (TC-PRISMA). You can also use this in DEMO mode
with up to three components.

Diffusion Calculator

Using the Diffusion Module (DICTRA), this activity is where you set the
geometry, add one or more regions, enter grids and phases in the regions,
and then enter compositions of phases. You can also use this in DEMO
mode with up to three components.

Process Metallurgy
Calculator

This calculator allows for efficient setup of advanced calculations involving
slag, metal and gas. Define the composition of a steel and slag system using
material groups: one each for steel, slag and gas.

Plot Renderer

Determine the layout of non-text based output.

Table Renderer

Use it for text-based output.
Use it for some calculations involving two components only. It is like a
combination of System Definer and Equilibrium Calculator activities with
adaptations to simplify the configuration of calculations on binary systems.

Binary Calculator
To perform this activity, you need a database designed for
the Binary Calculator, such as the TCBIN database.

Ternary Calculator

Use it for some calculations involving three components. It is like a
combination of System Definer and Equilibrium Calculator activities with
adaptations to simplify the configuration of calculations on ternary
systems.
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Activity type

Description
To get a reliable result you need a database that fully
assesses binary and ternary systems.

Scheil Calculator

Perform Scheil-Gulliver calculations (also known as Scheil calculations). A
default Scheil calculation is used to estimate the solidification range of an
alloy assuming that i) the liquid phase is homogeneous at all times and ii)
the diffusivity is zero in the solid. However, it is possible to disregard the
second assumption for selected components.

Experimental File Reader

Read experimental data files (*.EXP). This type of file contains information
specifying a plotted diagram, written in the DATAPLOT graphical language.
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Graphical Mode Activity Node Workflow
You can set up a tree in the Project window (starting with the My Project node) and then
perform all the activities at once, or create and perform one activity at a time.

You can also use the templates to add all the necessary activity nodes based on
your simulation needs. See Creating a Project from a Template.

The typical workflow is to:
1. Define a System: Add a System Definer activity (in the Project window) where you
select a database and the elements to have as system components (in the
Configuration window).
l To the My Project node, you can alternatively add and define a Binary
Calculator, Ternary Calculator, or Experimental File Reader or Process
Metallurgy Calculator activity node.
2. Set up and run a calculation: Add an Equilibrium Calculator activity (a successor to
the System Definer), where calculation conditions are set (temperature, pressure,
etc.). This is where axis variables are set to create a property or phase diagram.
These settings are also made in the Configuration window. You can also add a
Property Model Calculator, Precipitation Calculator, Diffusion Calculator or Scheil
Calculator to the System Definer.
Property Model Calculator Workflow
3. Visualize the results: Add either a Plot Renderer or a Table Renderer activity in the
Project window. When calculated, this creates a plot or table in the Results window.
The results are shown in a Plot Renderer or a Table Renderer tab.
You need to Perform a Plot Renderer or a Table Renderer activity to
visualize the calculation results from an Equilibrium Calculator.
The Quick Start Wizard and Templates
About the Activity Nodes
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Creating Activities and Successors
You can create a new activity in these ways:
l

l
l

l

In the Project window, right-click an activity and choose Create New Activity (My
Project node only) or Create New Successor (all other nodes).
Select the activity you want to create from the submenu.
At the bottom of the Configuration window, click Create New Activity or Create
New Successor and select the activity to create.
Use the Templates or the Quick Start Wizard (click the My Project node and select
templates from the Configuration window) to quickly add a set of activity nodes to
the tree.

Activity

Possible Predecessors

Possible Successors

My Project

None; this is the first node of the tree
structure. You can add activities using
the Quick Start wizard or templates.

System Definer, Binary
Calculator, Ternary Calculator,
Process Metallurgy Calculator,
Experimental File Reader. Also
choose templates from this
level.

The Quick Start Wizard and
Templates

System Definer

My Project, System Definer

Property Model Calculator,
Equilibrium Calculator,
Precipitation Calculator, Scheil
Calculator

Experimental File Reader

My Project

Plot Renderer

Binary Calculator

My Project

Plot Renderer, Table Renderer

Ternary Calculator

My Project

Plot Renderer

Process Metallurgy
Calculator

My Project

Plot Renderer, Table Renderer

Property Model
Calculator

System Definer

Plot Renderer, Table Renderer

Equilibrium Calculator

System Definer, Equilibrium Calculator

Equilibrium Calculator, Plot
Renderer, Table Renderer
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Activity

Possible Predecessors

Possible Successors

Precipitation Calculator

System Definer

Plot Renderer, Table Renderer

Diffusion Calculator

System Definer

Plot Renderer, Table Renderer

Scheil Calculator

System Definer

Plot Renderer, Table Renderer

Plot Renderer

Equilibrium Calculator, Property Model
Calculator, Binary Calculator, Ternary
Calculator, Scheil Calculator, Process
Metallurgy Calculator, Diffusion
Calculator, Precipitation Calculator,
Experimental File Reader

None

Table Renderer

Equilibrium Calculator, Property Model
Calculator, Binary Calculator, Scheil
Calculator, Process Metallurgy
Calculator, Diffusion Calculator,
Precipitation Calculator

None
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Cloning Activities and Trees
As described in Creating Activities and Successors, you can clone a single activity or the
selected activity and all the activities that come after it (successors). The predecessor of the
selected activity also is the predecessor of the clone.
Cloned activities are configured exactly like the activities that they were cloned from, and
any results of calculations or plots are also cloned. To clone a selected activity, right-click
the activity and select Clone.
For example, if you clone the Equilibrium Calculator in this project the result is an
Equilibrium Calculator 2 created as a successor to System Definer 1.
The following applies to clones.
l

l

l
l

The new Equilibrium Calculator has the same settings for conditions, functions and
options as its Equilibrium Calculator 1 clone.
If the Equilibrium Calculator is already performed, then the calculation results are
cloned.
If the activity is a Plot Renderer or a Table Renderer, then the plot or table is cloned.
If you want to clone all the successor activities that follow a selected activity, then
right-click and select Clone Tree instead.

Cloning an Equilibrium Calculator activity node

About Equilibrium Calculator Clones and Successors

Thermo-Calc User Guide: Graphical Mode ǀ 16 of 527

Thermo-Calc Documentation Set

If you create an Equilibrium Calculator as a successor to another Equilibrium Calculator,
then the successor inherits all the settings for conditions, functions and options from its
predecessor. In this respect, it is similar to a clone.

The Equilibrium Calculator successor is different from a clone in that it does not
inherit any calculated results and it is a successor to the Equilibrium Calculator
instead of a successor to its predecessor.

The calculated result from an Equilibrium Calculator that is the predecessor to another
Equilibrium Calculator is the starting value for the latter’s calculation. The clone of an
Equilibrium Calculator on the other hand, does not receive any data as input from the
Equilibrium Calculator that it is cloned from.
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Moving Nodes in the Tree and Using the Grid
In the Project window, you can work with the activity nodes in these ways.

Select and Move Individual Nodes
l

Click an activity node to select it.

l

To move activities, click and hold the activity node and move the cursor.

Select Several Nodes at a Time
l

l

To select several activity nodes, hold down <Ctrl> while clicking on each node you
want to select.
Click and hold the mouse button and draw a square around the activity nodes to
select. Both the name and the icon that represents an activity must be within the
square.

Apply Auto Layout
In the Project window, right-click anywhere and choose Apply Auto Layout from the menu.
The nodes and the tree default to the center of the Project window.

Show Grid and Snap to Grid
To show a grid of light-grey cross-hairs overlaid on a project, click Show Grid in the toolbar.
Click the button again to turn the grid off. Or right-click in the Project window and select
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Show Grid.
Click Snap to Grid in the toolbar or right-click in the Project window and select Snap to
Grid to automatically position each activity in the Project window at a cross-hairs point in
the grid.
The Project window with the grid turned on and activity nodes moved from the default
location. These nodes are snapped to the grid.
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Node or Window Status Markers
Status markers indicate whether an activity is ready to be performed, is being performed, or
has been performed. The markers are overlaid on the activity nodes in the Project window.
The status markers are displayed on a System Definer node.
About the Activity Nodes

Status Marker Descriptions
Node Status Markers for the Project and Scheduler Windows

Window

Status
marker

Description
No status marker means the activity is ready to be performed (it has not been
performed).

Project
window

A yellow triangle means the activity cannot be run. The necessary
configurations for the activity may not be set or other prerequisites are not
met.
A green disc means the activity is performed.
A red circle with a dial (a clock face) means the activity is currently being
performed.
No status marker means the activity (the job) is scheduled to be performed
(the job has not started).

A yellow triangle means there an error happened during the activity job.
Scheduler
window
A green disc means the activity (the job) performed successfully.

A green right-facing arrow means the activity (the job) is being performed.

Results Window Status Marker
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If you have plotted a diagram and then modify something in the tree that the Plot Renderer
is associated with, then a notification —an exclamation mark enclosed in a yellow triangle—
is shown in the Plot tab.
Node or Window Status Markers
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My Project and Activity Menus
When working in the Project window you can right-click nodes to open menus with the
available actions. For example, click the My Project node to open the menus. Most nodes in
the tree have a common menu with differences due to placement in the tree and the activity
type.
About the Activity Nodes

Menus
MY PROJECT NODE
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ACTIVITY NODE GENERAL

Menu Options for Activity Nodes
Option

Create New Activity

Create New Activity → Use
Template

Description

Action (s)

Add System Definer, Binary Calculator,
Ternary Calculator, Process Metallurgy
Calculator, and Experimental File
Reader nodes.

Choose from the available templates to
use the Wizard or add predefined
nodes.

Right-click My Project
and from the Create
New Activity menu
choose an option.
Creating Activities
and Successors
Right-click My Project
and from the Create
New Activity→ Use
Templates menu choose
an option.
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Option

Description

Action (s)
The templates are also
available on the
Configuration window,
which you can access by
clicking the My Project
node, or from the
Window menu.
Creating a Project
with the Quick
Start Wizard or
Creating a Project
from a Template

Create New Successor

Add a successor to the selected node.

Right-click the System
Definer, any Calculator
node or the
Experimental File
Reader. Then from the
Create New Successor
menu choose an option.
Creating Activities
and Successors
Right-click a node to add
a predecessor to it
(when available).

Add a Predecessor

Add a predecessor to the selected
node.

Right-click any node.

Perform Now or Perform Later

Perform a calculation or create a plot
or table immediately, or schedule it for
a time in the future.

Rename

Change the name of the node.

Right-click any node.

Remove

Delete the selected node from the
tree.

Right-click any node
except My Project.

Clone

Duplicate the selected node and add it
to the same tree.

Using the
Scheduler

Right-click any node
except My Project.
Cloning Activities
and Trees

Thermo-Calc User Guide: Graphical Mode ǀ 24 of 527

Thermo-Calc Documentation Set

Option

Description

Action (s)

Clone tree

Duplicate a tree and add it to My
Project.

Right-click any node
except My Project.

Apply Auto Layout

Apply an automatic layout to the nodes
in the tree.

Right-click any node.
Right-click any node.
Moving Nodes in
the Tree and
Using the Grid

Snap to Grid

Snap a node to align it with the grid.

Show Grid

Turn the grid on or off in the Project
window.

Right-click any node.

Zoom In, Zoom Out, Reset Zoom

Zoom in and out of the Project window
or reset the zoom to the default.

Right-click any node.
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Saving and Opening Project Files
Thermo-Calc Graphical Mode uses project files with the file name suffix .tcu. The Add-on
Diffusion (DICTRA), Precipitation (TC-PRISMA), and/or Process Metallurgy Modules also use
the same file format in Graphical Mode.
There are different types of file saving based on the stage of a project set up. For example,
as you begin to build and design a project simulation, adding and defining a System Definer
with applicable calculator, plot or table nodes, and then once you have run a simulation
where you now have the option to save with and without the results.

A project file always includes project activities and the configurations.
Optionally, the project file may also include calculation results. This increases
the size of the file but eliminates the need for re-calculating results when the
file is opened later.

Certain simulation results are also more likely to have large file sizes, particularly when
working with the Add-on Diffusion (DICTRA), Precipitation (TC-PRISMA), and/or Process
Metallurgy Modules.

Saving a Project File
To save your project, on the toolbar click the Save
button (or CTRL + S, or File → Save
Project). This saves the file as it is, so if you have previously generated results, it continues
to save these to the file. It is recommended that as you build and design your project that
you save as you go.

Saving a Project File with Results
If you have generated results you want to keep every time you open the project file, and not
previously saved these, from the menu, chose File → Save Project As (or CTRL + Shift + S)
and then make sure to select the Include calculated results in the project file check box.
The check box is not available (it is greyed out) if no results have yet been calculated. In this
case, go back to your project and click Perform Tree then repeat the steps above.

Click More information to learn about the particular results that are saved for
each simulation.
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Appending a Project
You can only have one project file open at a time in any one instance of Thermo-Calc.
However, you can attach (append) the trees from additional project files to the topmost My
Project node. To append an additional project file in this way, from the main menu select
File → Append Project and open a project file.
Saving and Printing the Output (Graphical Mode) and Saving Tabulated Data for the
Table Renderer

Opening a Project File
There are different ways to open project files.

In Thermo-Calc
l
l

From the main menu select File → Open Project.
On the toolbar, click the Open button or press <Ctrl+O> (Windows) or < ⌘O>
(Mac) on the keyboard. Then navigate to the file on your computer and click Open.

On Your Computer
l

Navigate to the project file and double-click to open it. This launches a new instance
of Thermo-Calc.

How to Open an Example Project File from Thermo-Calc
Some Add-on Module examples require additional licenses to run for more than
three elements.

To open an example project file for Thermo-Calc and the Add-on Diffusion (DICTRA),
Precipitation (TC-PRISMA), and/or Process Metallurgy Modules:
1. Open Thermo-Calc.
2. Confirm you are in Graphical Mode. If not, click the Switch to Graphical Mode
button.
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3. From the main menu, select File → or Help → Examples Files.
4. The examples are divided into folders. Navigate to the folder and project file you
want and double-click to open.

5. The Graphical Mode examples are stored without calculated results so you will want
to run the example calculation and generate a plot or table. To do this, click the first
node in the tree at the top of the Project window. Then right-click and select
Perform now.
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The Calculation Types in Graphical Mode
Graphical Mode vs Console Mode: Calculation Types

Binary Calculator
The following calculation types are available for a Binary Calculator activity node:
l

l

l

l

Phase diagram: To calculate in a defined multicomponent heterogeneous system,
from one or more initial equilibria. A phase diagram is usually mapped within a
specific space that is constructed by two (or more) defined independent mapping
axis-variables.
Gibbs energy curves: To calculate at a constant temperature over the whole
composition range.
Activity curves: To calculate at a constant temperature over the whole composition
range.
Phase fractions: To calculate as a function of temperature at a constant composition.

Diffusion Calculator
The following calculation types are available for a Diffusion Calculator activity node:
Detailed simulation of diffusion controlled reactions in multi-component systems. Diffusion
calculations are done with the Diffusion Calculator. There are no calculation types you need
to choose when setting up your simulation.
Equilibrium Calculator
The following calculation types are available for an Equilibrium Calculator activity node:
l

Single equilibrium (no axes): To calculate a single point. The results from this
calculation are displayed in the Event Log.

l

One axis: To vary a quantity on the X-axis.

l

Grid: Computes the equilibrium of each grid point in a two-dimensional grid.

l

Phase diagram: To calculate in a defined multicomponent heterogeneous system,
from one or more initial equilibria. A phase diagram is usually mapped within a
specific space that is constructed by two (or more) defined independent mapping
axis-variables.
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Precipitation Calculator
The following calculation types are available for a Precipitation Calculator activity node:
l

Isothermal: Precipitation simulation at constant temperature.

l

Non-isothermal: Precipitation simulation with user-defined temperature profile.

l

TTT diagram: Time-Temperature-Transformation diagram calculation.

l

CCT diagram: Continuous Cooling Transformation diagram calculation.

Process Metallurgy Calculator
The following calculation types are available for a Process Metallurgy Calculator activity
node when doing an Equilibrium simulation.
l

l
l

l

Single: To calculate a single point. The results from this calculation can be displayed
in the Results window using a Table Renderer.
One axis: To vary a quantity on the X-axis.
Grid: Evaluates two axis variables of the selected quantities in the specified range
and number of steps.
Uncertainty: Evaluates calculations where the values of the quantities are sampled
from Gaussian distributions.

Property Model Calculator
The following calculation types are available for a Property Model Calculator activity node:
l

l
l

l

l

Single: To calculate a single point. The results from this calculation are displayed in
the Event Log or if a Table Renderer is used, in the Results window.
One axis: To vary a quantity on the X-axis.
Grid: Evaluates two axis variables of the selected quantities in the specified range
and number of steps.
Min/Max: Evaluates the Property Model(s) for all variations of the selected
quantities at the given limits.
Uncertainty: Evaluates the Property Model(s) where the values of the quantities are
sampled from Gaussian distributions.

Scheil Calculator
The following calculation types are available for a Scheil Calculator activity node:
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Simulate a non-equilibrium transformation or partial-equilibrium transformation (a ScheilGulliver solidification). Scheil calculations are done with the Scheil Calculator. There are no
calculation types you need to choose when setting up your simulation.

Ternary Calculator
The following calculation types are available for a Ternary Calculator activity node:
l
l

l

Isothermal section: To calculate the ternary system for the whole composition range.
Monovariant lines: To calculate the variation of the liquid compositions with
temperature.
Liquidus projection: The projection liquid surface and the monovariant lines are
calculated over the given temperature range.
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The Quick Start Wizard and Templates
Use the Quick Start wizard or a Template to create all the activities for a certain type of
calculation. In the Project window click the My Project node to display the Quick Start and
other templates in the Configuration window.

Quick Start Wizard
Even before you understand how to work with Thermo-Calc projects, the Quick Start wizard
helps you set up a project and run calculations in Graphical Mode. You can set up, calculate
and visualize any of the following:
l

Single point equilibrium

l

One axis equilibrium

l

Phase diagram

l

Scheil solidification simulation
Creating a Project with the Quick Start Wizard

Templates
A variety of templates are available. You can add these from the Configuration window or
by right-clicking the My Project node and selecting one from the Create New Activity →
Use Template list:
l

Single Point Equilibrium: Creates a project for calculating a single point
equilibrium. The project consists of a System Definer, Equilibrium Calculator and a
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Table Renderer.
l

l

l

l

l

l

l

l

l

l

One Axis Equilibrium: Creates a project for calculating a one axis diagram. The
project consists of a System Definer, Equilibrium Calculator and a Plot Renderer.
Phase Diagram: Creates a project for calculating a phase diagram. The project
consists of a System Definer, Equilibrium Calculator and a Plot Renderer.
Scheil Solidification Simulation: Creates a project for performing a Scheil
calculation. The project consists of a System Definer, Scheil Calculator and a Plot
Renderer.
Binary Calculation: Creates a project for performing a binary calculation. The
project consists of a Binary Calculator and a Plot Renderer.
Ternary Calculation: Creates a project for performing a ternary calculation. The
project consists of a System Definer, Ternary Calculator and a Plot Renderer.
Property Model Calculation: Creates a project for a Property Model Calculator. The
project consists of a System Definer, Property Model Calculator and a Plot Renderer.
Diffusion Simulation: Creates a project for general diffusion simulations. The project
consists of a System Definer, Diffusion Calculator and a Plot Renderer.
Precipitation Simulation: Creates a project for simulating the evolution of particle
size distributions. The project consists of a System Definer, Precipitation Calculator
and a Plot Renderer.
Steel Library - TTT: Creates a project for a steel package. The project consists of a
System Definer, Property Model Calculator and a Plot Renderer.
Process Metallurgy: Creates a project to allow for calculation and efficient setup of
advanced calculations involving slag, metal and gas.
Creating a Project from a Template
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Creating a Project with the Quick Start Wizard
To set up, perform and visualize a calculation using the Quick Start wizard:
1. In the Configuration window click Quick Start. If you cannot see the Quick Start
button, first click My Project in the Project window.

2. In the Select Project Type window click to select the type of calculation to perform.
Single point equilibrium, One axis equilibrium, Phase diagram or Scheil
solidification simulation. Click Next.
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3. In the Define Systems window, choose an available Database.

4. Click to select Elements check boxes to include as system components. To add
elements from an existing material file, click the Material file button to enter the file
path to a material file or click the Select Material File button (to the right of the
field) to navigate to a file on the computer.
5. Click Next. The Select Conditions window has different options depending on the
Project type and the elements selected.
In this example figure, using a Single Point Equilibrium, choose the Composition
unit from the list and under Condition Definitions specify the values of the state
variables in the system.

For a One axis equilibrium or Phase diagram, specify the Axis Definitions of the
stepping or mapping operation. Choose minimum and maximum values for the
variable(s) (select Linear – min no. of steps, Linear – max step size or Logarithmic
–scale factors) and whether it is Normal or Separate phases. For a Scheil
solidification simulation, and where applicable, select Fast diffuser to account for
back diffusion of any fast-diffusing elements.
6. Click Finish. Click to expand the Event Log window to see information about the
progress of the calculation.
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The diagram is plotted in a Plot Renderer tab in the Results window. If you have
calculated a single-point equilibrium, then a Table Renderer tab shows information
about the equilibrium.

7. To save the project, click Save on the main toolbar. To save a diagram or table,
right-click the diagram or table and select Save As.

Creating a Project from a Template
Use a Template to create all the activities for a certain type of calculation. In the Project
window click the My Project node to display the templates in the Configuration window.
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When you click a template, an activity tree is added to the Project window. You can then
configure and perform the activities or the project.
For example, if you click One axis equilibrium, a tree is added to the My Project node with
System Definer, Equilibrium Calculator and Plot Renderer nodes.

You can also add templates by right-clicking the My Project node and choosing an option
from the Create New Activity → Use Template menu.
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The Quick Start Wizard and Templates
Steel Library TTT Diagram Template

Process Metallurgy Template
Use a Process Metallurgy template to add the Process Metallurgy Calculator and a Plot
Renderer to the Project window. The Process Metallurgy Calculator has several
preconfigured settings making is easier to setup the different groups and materials needed
to define a system for slag, metal and gas used in steelmaking.
Process Metallurgy Calculator

How to Add a Process Metallurgy Template to a Project
1. In the Project window click the My Project node to display the templates in the
Configuration window.
2. Under Templates, click Process Metallurgy.
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A Process Metallurgy Calculator and a Plot Renderer are added to the Project
window.
You can also add templates by right-clicking the My Project node and choosing an option
from the Create New Activity → Use Template menu.

Steel Library TTT Diagram Template
The use of this Steel Model Library template requires a valid maintenance
license plus licenses for both the TCFE (version 9 and higher) and MOBFE
(version 4 and higher) databases.

Use a Steel Library TTT template to add all the activities for a One axis Time-TemperatureTransformation (TTT) diagram calculation.
This template has several preconfigured settings to make it easy to set up and calculate the
TTT diagram using the Martensite temperatures and Pearlite Property Models.
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Property Model Calculator

How to Add a Steel Library TTT Template to a Project
1. In the Project window click the My Project node to display the templates in the
Configuration window.
2. Under Templates, click Steel Library - TTT.

A System Definer, Property Model Calculator (renamed to Steel models) and a Plot
Renderer (renamed to TTT) are added to the Project window. Also see Plot Settings:
TTT Mode.
You can also add templates by right-clicking the My Project node and choosing an option
from the Create New Activity → Use Template menu.
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Defining and Using the Activity Nodes
For information about the Process Metallurgy Calculator, see The Process
Metallurgy Module.
In this section:
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System Definer
In a System Definer activity, you select the database to use to retrieve thermodynamic data
and define which elements the system has as components. You can also select the species to
include as well as change the reference temperature and pressure for your components.
You can add the System Definer directly (right-click My Project and select it from the
Create New Activity menu) or use a variety of the available templates to automatically add
the node.
Almost all of the Graphical Mode Examples use the System Definer. For details
about the templates, seeThe Quick Start Wizard and Templates and Creating a
Project from a Template.
Once you have added a System Definer, the Configuration window has these settings tabs:
l

Elements

l

Species

l

Phases and Phase Constitution

l

Components

l

Data Sources

l

Description

Thermo-Calc User Guide: Graphical Mode ǀ 42 of 527

Thermo-Calc Documentation Set

Define the System
This topic describes how to define a system, specifically how to select one or more
databases and define the elements in the system with the System Definer activity node.
1. Right-click My Project and from the menu select Create New Activity→ System
Definer . You can also add any template and a System Definer is added to the Project
tree.
2. In the Project window, click the System Definer activity node.
3. In the Configuration window, choose Databases from the list or a database Package.
About the Database Files

OPTIONS:
l
l

l

From the Databases list, select <User database> to define your own.
You can choose to add one or more databases by clicking the Add a database
button.
From the Package list, choose a predefined database package to add multiple
databases at a time. Depending on your license, there are predefined database
packages available to select.

4. Select the Elements tab to choose the elements in the Periodic Table or use the
Alphabetic List to choose elements for the system.
5. As required click the tabs to make edits: Species, Phases and Phase Constitution,
and Components. The Data Sources and Description tabs provide information based
on the database.
Configuration Window Settings
6. Click Perform to start the System Definer activity immediately and retrieve data
about the system. Click the Event Log window to watch the progress of the job.

Configuration Window Settings
The System Definer Configuration window has many settings available, which are briefly
described below.
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Choose Database(s) or a Database Package

At the top of the Configuration window you can choose to add one or more Databases by
clicking the Add a database button. You can also choose a predefined or custom database
Package from the list. Depending on your license, there are predefined database packages
available to select. After adding a database, click Remove this database button as
required for your simulation.
If you have chosen a database package and then remove or change a database,
a message displays Selected databases and selected package may differ. This
means that the original package you selected, which added preset databases,
does not match the databases you are using for the project. For information
about how to clear the message, see Global Settings: System Definer.
Global Settings: System Definer
There are several settings tabs available for the System Definer activity.
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The following example uses the FEDEMO and MFEDEMO databases and Graphical Mode
example PM_G_03, which you can open from the Help → Examples Files menu.

Elements
On the Elements tab, and based on the databases or database package selected, you can
select and review elements using a Periodic Table or Alphabetic List format. Unavailable
elements, which are based on the selected database, are greyed out.

Periodic Table
In this example, using the demonstration databases FEDEMO and MFEDEMO, there are only
a select number of elements to choose from.

Alphabetic List
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Select the elements next to the check boxes for the selected database(s).

Material Composition
After selecting the elements and in the Periodic Table view, under Material, you can enter a
Material name and define the material composition Amount in Mass percent, Mole
percent, Mass fraction or Mole fraction.

At the bottom of the window, click Load material to open a material file. The default folder
opens to the Materials folder included with your installation.
About the Material Files and Examples, Manuals and Materials Folders
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You can also click Save material as to save the material you defined, for example Ferritic.
Global Settings: System Definer
If you load a material file and then change the composition, a message displays
The composition has changed. This means that the original values/composition
do not match the values you are using for the project. The message is cleared by
either reloading the material file or editing the composition field to the original
value.

Species
On the Species tab for each database you can select and edit the Species and view the
Stoichometry for the selected database species.
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At the bottom of the window, click Add new species and enter a New species name in the
field.

Phases and Phase Constitution
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At the top of the Phases and Phase Constitution tab for each database you can review and
edit the Status (Entered or Dormant) for the selectedPhases. Select the Check/uncheck all
check box to toggle between the options.
To review the Phase constitution for a specific phase, click it in the Phase list (for example
BCC_A2) and its details are displayed at the bottom of the window for the database selected.
Click Edit then click an element to select or reject a constituent. The last remaining
constituent on a sublattice cannot be rejected.

Components
The Components tab is where you can review and edit the Component, Reference phase,
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Reference temperature, and Reference pressure. Click to toggle the SER (Stable Element
Reference) check box on and off. Then choose a Reference phase from the list and edit
accordingly. Choose a unit for the Reference temperature (Kelvin, Celsius or Farenheit)
and Reference pressure (Pascal, Atmospheres or Bar).

Data Sources
Data source references are shown after performing the activity. Click Perform or Perform
Tree at the bottom of the window when your system is set up.

Description
The Description tab displays a description of the selected database(s). In this example,
MFEDEMO.

Thermo-Calc User Guide: Graphical Mode ǀ 50 of 527

Thermo-Calc Documentation Set

About the Material Files
Examples, Manuals and Materials Folders
When you are working with the System Definer in Graphical Mode you can open the default
Materials folder included with your installation. The files are in .xml format and the data
contained are from some common alloys. You can also save and create your own materials
files from the System Definer, or copy the xml files to the Materials folder.

Aluminum Alloys
l

UNS_A95005

l

UNS_A96053

Cast Iron Alloys
l

UNS_F10007

l

UNS_F33101

Nickel Alloys
l

UNS_N06600

l

UNS_N6600

l

UNS_N06625

l

UNS_N06690

l

UNS_N07001

l

UNS_N07718

l

UNS_N08800

l

UNS_N08825

Solder Alloys
l

ASTM_25A

l

ASTM_96TS

l

UNS_L50134
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l

UNS_L54321

Steel Alloys
Austenitic Stainless Steel
l

ASTM_304_(UNS_S30400)

l

ASTM_304L_(UNS_S30403)

l

ASTM_304LN_(UNS_S30453)

l

ASTM_316_(UNS_S31600)

l

ASTM_316L_(UNS_S31603)

l

ASTM_316LN_(UNS_S31653)

l

ASTM_317L_(UNS_S31703)

l

UNS_J92710

l

UNS_S30908

Duplex Stainless Steel
l

UNS_S31803_A

l

UNS_S32750_A

l

UNS_S32750_B

High Speed Steel
l

ASTM_M10_A5

High Temperature Steel
l

UNS_S31008

HSLA Steel
l

UNS_K12000
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Low Carbon Steel
l

UNS_H61180

Maraging Steel
l

UNS_K92810

Martensitic Stainless Steel
l

ASTM_420

l

UNS_J82090

l

UNS_J91639

l

UNS_S44004

Tool Steel
l

UNS_T30106

l

UNS_T30109

l

UNS_T51620

Training Steel
l

Ferritic

l

M7_Steel

Titanium Alloys
l

UNS_R54520

l

UNS_R56260

My Materials
This is where you can add your own material files to be able to load it to the System Definer.
When you are in the System Definer Configuration window, you define your material then
click Save material as. You can save the profile to this folder or create a folder with a new
name.
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Creating a Database Package
1. From the main menu select Tools → Options .
2. Click the Activities tab and click System definition.
3. Under Database Packages, click the Add a database package

button.

4. Replace the default text with a name for the package, for example My database
package.
5. Select a database from the Choose database list, for example, FEDEMO Iron Demo
Database.
6. Click the Add a database
another database.

button and from the Choose database list, select

7. Click OK . The software needs to relaunch for the Database Package to be available
to choose as the default for new System Definer activities.

The package is available for new System Definer nodes defined after
adding the package.

Clearing a Database Package Message and Global Settings: System Definer
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Clearing a Database Package Message
Sometimes when working on the System Definer Configuration window, you may add or
delete Databases. If you originally added a Database Package, the addition or removal of a
database means that the original package you selected does not now match the databases
you are using. To clear the message Selected databases and selected package may differ
and reset the databases you need to either:
l

l

Change the newly added database back to the one that matches the database package,
or
Choose another package from the Package list, then select the package you want.

For example, from the Package list you select Demo: Steels and Fe-alloys.

This adds the FEDEMO and MFEDEMO databases.

If you add or remove Databases, in this example MFEDEMO is removed, then this does not
match the Package and the message displays:

To clear the message, click the Add a database button and from the Choose database
list, select the database that belongs with the package, in this example, MFEDEMO. The
message is cleared.
You can also choose another package from the list, which changes the databases, and then
re-select the original package to reset the message.
Creating a Database Package and Global Settings: System Definer
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Equilibrium Calculator
An Equilibrium Calculator allows you to set the conditions for, and perform, a calculation.
You can add the calculator to the System Definer directly (right-click and select it from the
Create New Successor menu) or use a variety of the available templates.
Once you have added an Equilibrium Calculator, the Configuration window has these
settings tabs. An Equilibrium Calculator that is the successor of another Equilibrium
Calculator inherits all the settings of the predecessor.
l

l

l

Conditions: Set the conditions for your calculation that define the stepping or
mapping axis variables. This tab can be viewed in a simplified mode and in an
advanced mode.
Functions: Define your own quantities and functions, which you then can calculate
and plot.
Options: Modify numerical settings that determine how equilibria are calculated, as
well as how stepping and mapping calculations are performed.
The Options tab is where you can locally define specific Equilibrium Calculator
settings. These settings can also be applied globally. To open the Options
window: From the main menu select Tools → Options and click the Activities
tab. Then click Calculation.
For an example of how serially coupled Equilibrium Calculators can be used, see
example T_06. For details about the templates, seeThe Quick Start Wizard and
Templates and Creating a Project from a Template.

Define the Equilibrium Calculator
1. Add an Equilibrium Calculator node to the System Definer. If you used the Single
Point Equilibrium , One-Axis Equilibrium, or Phase Diagram template, click the
Equilibrium Calculator node to display the Configuration settings window.
2. In the Configuration window, enter the settings described in Conditions Tab Settings,
and as required from the Options Tab Settings. There are also settings you can define
on the Functions tab. See Calculating and Plotting Functions
3. Once you have finished defining the Equilibrium Calculator, you also choose settings
on the Plot Renderer.
Calculating with a Fixed Phase
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Conditions Tab Settings
Conditions and axis variables for the Equilibrium Calculator are set in the Conditions tab on
the Configuration window. The tab can be viewed in two modes: Simplified (the default) or
Advanced. The conditions to set depend on the type of calculation.

See examples T_01: Calculating a Single-Point Equilibrium ,T_02: Stepping in
Temperature in the Fe-C System and T_05: Stable and the Metastable Fe-C
Phase Diagrams.
Options Tab Settings

About Advanced Mode
Click Switch to advanced mode to add and remove conditions as well as set additional axis
definitions. However, the number and types of conditions set must still conform to the Gibbs’
phase rule. The Number of missing conditions is field, at the top of the tab shows how
many conditions that you have left to set. If the number is negative, then that number of
conditions need to be removed.
The following outlines what you can set on the Conditions tab in simplified mode.
Click Switch to advanced mode for more options.

Composition unit
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Choose from Mass percent, Mole percent, Mass fraction or Mole fraction.

Condition Definitions
Specify the values (and units) of the state variables: Temperature, Pressure, and System
size or any other available lists under Condition Definitions.

Calculation Type
Select a Calculation Type: Single equilibrium (no axes), One axis, Grid or Phase diagram.
l

Click Single equilibrium to only calculate the equilibrium. No additional settings are
required. Add a Table Renderer to perform the calculation and view the details in
the Results window.

l

Click One axis to vary a quantity on the X-axis.

l

Click Grid to compute the equilibrium of each grid point in a two-dimensional grid.

l

Click Phase diagram to calculate in a defined multicomponent heterogeneous
system, from one or more initial equilibria. A phase diagram is usually mapped
within a specific space that is constructed by two (or more) defined independent
mapping axis-variables.
l

When you use the Equilibrium Model with the Property Model
Calculator, it is the same calculation result as when you are using an
Equilibrium Calculator with the Single equilibrium calculation type.

Axis Definitions
l

l

l

One axis: Define the axis variable using these fields and menus: Quantity, Min, Max,
Step division, Type and Step Method.
Grid: Define the two axis variables using these fields and menus: Quantity, Min,
Max and Number of steps.
Phase diagram: Define the two axis variables using these fields and menus:
Quantity, Min, Max, Step division and Type.
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If the Equilibrium Calculator already has a Plot Renderer as a successor and you
change the stepping/mapping quantities, then the quantities represented on the
X- and Y-axis are automatically updated in the Plot Renderer.
For a One axis calculation, on the Plot Renderer, you can choose to plot a Heat
map, Contour or 3D diagram.
Heat Map, Contour and 3D Plots

Step Method (One axis)
From the list, choose Normal or Separate phases.
l

l

Normal allows a stepping calculation with the chosen independently-varying
equilibrium condition (axis-variable). Only the step axis value is changed between
each step.
Separate phases calculates how the Gibbs energy for a number of phases varies for
different compositions. This is particularly useful to calculate Gibbs energies for
complex phases with miscibility gaps and for an ordered phase that is never
disordered (e.g. SIMGMA-phase, G-phase, MU-phase, etc.).

Number of steps (Grid)
Set a fixed Number of steps. The number of steps along with the minimum and maximum
values for the axes define a grid. For each grid point an equilibrium is calculated.

Type and Step division (One axis and Phase diagram)
Type options: Linear - min no. of steps, Linear - max step size and Logarithmic - scale
factor.
l

l

For Linear - min no. of steps, the Step division value specifies a minimum number
of steps that is calculated between the minimum and maximum value during the
stepping/mapping operation.
For Linear - max step size, the Step division sets the maximum size of each step. For
Logarithmic - scale factor, Step division specifies the scale factor of a logarithmic
function that distributes the steps from the initial equilibrium to the minimum and
maximum values defined.
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Calculating and Plotting Functions
The Functions tab allows you to define your own functions that can be plotted in a Plot
Renderer.
For an example of how you can use functions that you define, see T_07: UserDefined Functions.
1. Add an Equilibrium Calculator node and click it in the Project window.
2. In the Configuration window click the Functions tab.
3. Under Quantity Definitions, define Q1. Click the add button to Add a new
quantity. Then from the lists, choose the variable for each quantity to define. The
quantities are called Q1, Q2, Q3 and so on. In this example, the quantity Q1 is
defined as the Amount of phase, with No normalization, LIQUID in Mole units.

4. Under Function Definitions, click the add button to add a new function. In the left
field edit the default name of each function and enter the function itself in the right
field after the equal sign. In this example, the quantity defined as Q1 is renamed to
fraction_solid, which gives as its output the fraction of solid phase (1-Q1).
You can also use Console Mode syntax when entering the function. For
example, the function above can be entered as 1-NP(LIQUID). See
Parameters, Functions and Variables for details related to Console Mode
and that are also applicable here.
5. To plot the defined function, right-click Equilibrium Calculator and choose Create
new successor→Plot Renderer.
6. Click the Plot Renderer node. In the tab for the Equilibrium Calculator that contains
the function, set an Axis variable to Function, then from the menu select the defined
function. In this example the Y-axis is set to plot the value of the function fraction_
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solid.
When run, the Plot Renderer plots the value of the function.

Options Tab Settings
These settings are for the Equilibrium Calculator and are located on the Configuration
window → Options tab.
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You can change these settings locally for a specific Equilibrium Calculator or
globally in the Options settings. To open the Options window: From the main
menu select Tools → Options. Click the Graphical Mode tab then click
Calculation.

Single Equilibrium and Grid
Under Single Equilibrium and Grid, there are these Calculation Type setting options.

Global minimization
The Global minimization check box is selected by default to ensure that the most stable
minimum under the specified conditions is computed.

Max grid points
For the Max grid points, the default is Coarse (2000 grid points), or choose Medium (20,000
grid points), Fine (200,000 grid points), or Custom to set your own number of grid points.

Approximate driving force for metastable phases
The Approximate driving force for metastable phases check box is selected by default,
which means the metastable phases are included in all iterations. However, these may not
have reached their most favourable composition and thus their driving forces may be only
approximate.
If it is important that these driving forces are correct, click to clear the check box to force
the calculation to converge for the metastable phases.

Force positive definite phase Hessian
The Force positive definite phase Hessian check box is selected by default and this setting
determines how to reach the minimum of an equilibrium state.
ADVANCED_OPTIONS

Control stepsize
The Control stepsize check box is selected by default and this setting determines how to
reach the minimum of an equilibrium state.
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ADVANCED_OPTIONS

Max no of iterations
Enter or choose a value for the Max no. of iterations. By default, the program tries 500
iterations before it gives up. As some models give computation times of more than 1 CPU
second/iteration, this number is also used to check the CPU time and the calculation stops if
500 CPU seconds/iterations are used.

Required accuracy
The default Required accuracy is 1.0E-6. This is a relative accuracy, and the program
requires that the relative difference in each variable must be lower than this value before it
has converged. A larger value normally means fewer iterations but less accurate solutions.
The value should be at least one order of magnitude larger than the machine precision.

Smallest fraction
The default Smallest fraction is 1.0E-12. This is the value assigned to constituents that are
unstable. It is normally only in the gas phase you can find such low fractions.
The default value for the smallest site-fractions is 1E-12 for all phases except for IDEAL
phase with one sublattice site (such as the GAS mixture phase in many databases) for which
the default value is always as 1E-30.
In Console Mode, the default of 1E-30 for IDEAL phases is true unless you are
using the command SET_NUMERICAL_LIMITS to reset an even-lower value (e.g.
1E-45, that is naturally enforced to all the phases in the system.

One Axis
Under One axis, there are these Calculation Type setting options.

Global minimization
The Global minimization check box is selected by default to ensure that the most stable
minimum under the specified conditions is computed.
ADVANCED_OPTIONS

Global test interval
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The default Every 10th eq is the recommended Global test interval i.e. every tenth step
and at each phase change during calculations. Or choose Always or Custom.
If you choose Custom, the integer number determines how often the global minimization
should be used during step and mapping. Any other positive integer number, n, suggests it
performs a global minimization test at every n-th step during calculations.

Phase Diagram
Under Phase diagram, there are these Calculation Type setting options.

Global minimization
The Global minimization check box is selected by default to ensure that the most stable
minimum under the specified conditions is computed.

Global test interval
The default At node points is the recommended Global test interval and is used only at
node points during the calculations.
l

l

If you choose Every 10th eq, this is every tenth step and at each phase change during
calculations.
If you choose Custom, the integer number determines how often the global
minimization should be used during step and mapping. Any other positive integer
number, n, suggests it performs a global minimization test at every n-th step during
calculations.

Generate starting points automatically
The Generate starting points automatically check box is selected by default.

Use inside meshing points
Click the Use inside meshing points check box as required. The initial mesh consists of
initial equilibrium points added only along the edge/border of the diagram defined by the
axis-variables. If you select the check box, then the initial equilibrium points added are also
added to the inside edge.

No of meshes along an axis
The default No of meshes along an axis is 3 , which represents how many intervals of initial
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equilibrium points are added along an edge in the diagram. For example, if set to 2 (two),
initial equilibrium points are added at the beginning, center, and end of each axis-variable
forming 2 intervals.

Calculating with a Fixed Phase
This describes how to use the advanced mode to set a phase to be fixed at a certain amount.
This allows you to, for example, find out at what temperature a material starts to melt. If
you set the phase to be fixed to liquid phase at zero amount, and do not define the
temperature state variable, then you can calculate at what temperature the material enters
a state where the liquid phase is no longer zero (that is, when it starts to melt).

For a fixed phase equilibrium calculation, it is recommended to serially couple
the Equilibrium Calculators. This is where one Equilibrium Calculator activity is
the successor to another Equilibrium Calculator activity that performs an
ordinary equilibrium calculation, and then, for the condition you are interested
in, you make a rough estimate of the value. This gives the fixed phase
calculation better starting values.

1. Right-click a node that can add an Equilibrium Calculator to your project.
2. In the Project window, click the Equilibrium Calculator activity node.
3. In the Configuration window, click Switch to advanced mode.
If the Default calculation mode is globally set to Advanced then by
default the Configuration window is already in advanced mode.
Changing Global Settings
4. Under Condition Definitions, click the Add quantity

button.

5. Select Fix phase from the first menu.
6. Select the phase that you want to fix in the second menu, and set the amount of that
phase you want to fix the phase to. For example, if you want to know when your
material starts to melt, set the phase to LIQUID and the value to 0.0:
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Above the Condition Definitions, the Number of missing conditions is field is
probably -1. This means that you must remove one condition.
7. To remove a condition, either click the Remove button, or click to clear the checkbox. For example, if you want to know at what temperature your material starts to
melt, then you cannot have a fixed temperature, in which case the temperature
condition is not selected:

The Number of missing conditions is field displays 0. When you have set all your
conditions, you can perform the Equilibrium Calculator (now or later).
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Binary Calculator
A Binary Calculator can be used for some calculations involving two components. You can
think of this activity as a combination of a System Definer and an Equilibrium Calculator, but
designed to simplify setting up and performing calculations on binary systems. There is also
a Binary Calculation template you can use to quickly set up a simulation.
The Binary Calculator relies on some specifications that are not supported by all databases.
You need a specially designed database for the Binary Calculator such as the TCBIN
database.
For an example of how a Binary Calculator can be used in a project, see T_03:
Fe-C Phase Diagrams. For information about the templates see Creating a
Project from a Template.

Configuration Window Settings
The Binary Calculator Configuration settings window and the associated tabs are similar to
what you see on a System Definer. The database TCBIN is added by default when you use the
Binary Calculation template, but you can choose any installed and licensed database from
the list.

The various versions of the TCFE (Thermo-Calc Steels and Fe-Alloys) databases
are not compatible with the Binary Calculator.
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Elements
On the Elements tab, and based on the database selected, select and review elements from
the periodic table. Unavailable elements, which are based on the selected database, are
greyed out.

Phases and Phase Constitution
At the top of the Phases and Phase Constitution tab, and based on the selected database,
you can review the Status for the selected Phases. Select the Check/uncheck all check box
to toggle between the options.
To review the Phase constitution for a specific phase, click it in the Phase list (for example
BCC_A2) and its details are displayed below the Phases list. Click Edit then click an element
to select or reject a constituent. The last remaining constituent on a sublattice cannot be
rejected.

Data Sources
Data sources are not available until the activity has been performed. Click Perform Tree to
display available data sources.

Description

Thermo-Calc User Guide: Graphical Mode ǀ 68 of 527

Thermo-Calc Documentation Set

The Description tab displays a description of the selected database.

Calculation Type
Choose a Calculation Type.

Phase diagram
Click Phase diagram to calculate in a defined multicomponent heterogeneous system, from
one or more initial equilibria. A phase diagram is usually mapped within a specific space
that is constructed by two (or more) defined independent mapping axis-variables.

Gibbs energy curves
Click Gibbs energy curves to calculate at a constant temperature over the whole
composition range. From the Temperature list select a unit (Kelvin, Celsius or Farenheit)
and enter a value in the field.

Activity curves
Click Activity curves to calculate at a constant temperature over the whole composition
range. From the Temperature list select a unit (Kelvin, Celsius or Farenheit) and enter a
value in the field.

Phase fractions
Click Phase fractions to calculate as a function of temperature at a constant composition.
From the Mole fraction list select a component and enter a value in the field.
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Ternary Calculator
A Ternary Calculator is used for some calculations involving three components. You can
think of this activity as a combination of a System Definer and an Equilibrium Calculator, but
designed to simplify setting up and performing calculations on ternary systems. There is also
a Ternary Calculation template you can use to quickly set up a simulation.
For an example of how a Ternary Calculator is used in a project, see T_04: FeCr-C Ternary Phase Diagram at 1000 K. For information about the templates see
Creating a Project from a Template.

Configuration Window Settings
Below lists the available settings that must be configured before performing the calculation
and the image shows the Configuration window for a Ternary Calculator activity.
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Databases
Select a database that contains specifications dedicated to the Ternary Calculator.

Elements
On the Elements tab, and based on the database selected, select and review elements from
the periodic table. Unavailable elements, which are based on the selected database, are
greyed out.

Phases and Phase Constitution
At the top of the Phases and Phase Constitution tab, and based on the selected database,
you can review the Status for the selected Phases. Select the Check/uncheck all check box
to toggle between the options.
To review the Phase constitution for a specific phase, click it in the Phase list (for example
BCC_A2) and its details are displayed below the Phases list. Click Edit then click an element
to select or reject a constituent. The last remaining constituent on a sublattice cannot be
rejected.

Data Sources
Data sources are not available until the activity has been performed. Click Perform Tree at
the bottom of the window to display available data sources.

Description
The Description tab displays a description of the selected database.

Calculation Type
Choose a Calculation Type.

Isothermal section
Click Isothermal section to calculate the ternary system for the whole composition range.
From the Temperature list select a unit (Kelvin, Celsius or Farenheit) and enter a value in
the field.

Monovariant lines
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Click Monovarient lines to calculate the variation of the liquid compositions with
temperature.

Liquidus projection
Click Liquidus projection so that the projection liquid surface and the monovariant lines are
calculated over the given temperature range. Then select the Temperature unit and in the
fields enter a range (Min and Max) and an Interval.
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Scheil Calculator
Thermo-Calc is often used to perform equilibrium calculations, but some non-equilibrium
transformations or partial-equilibrium transformations can also be simulated.
A well known example of a non-equilibrium calculation is the Scheil-Gulliver solidification
simulation.

Classic Scheil Simulation
For the Scheil-Gulliver solidification simulation, generally referred to in Thermo-Calc as a
classic Scheil simulation, the following assumptions are made.
l
l

l

Diffusion in the liquid phase is assumed to be very fast, that is, infinitely fast.
Diffusion in the solid phases is so slow that it can be ignored, that is, diffusion is
assumed to be zero.
The liquid/solid interface is in thermodynamic equilibrium.

In this Scheil simulation the temperature is decreased step-by-step. When the temperature
drops below the liquidus temperature the equilibrium amount and composition of solid and
liquid phase is calculated. The solid phase is removed from the system and only the amount
and composition of the liquid phase is used for the next calculation step at a lower
temperature. Again, the equilibrium amount and composition of solid and liquid phase is
calculated and again the solid phase is removed from the system for the next step. This
procedure is repeated until the last liquid disappears.
This calculation procedure is equivalent to assuming that there is no diffusion in the solid
phase and infinitely fast diffusion of all elements in the liquid phase. It has been shown to be
a good approximation of the solidification of most alloys such as Ni-superalloys, Cu alloys, Al
alloys, Mg alloys, and others. However, for steels it fails badly. The reason is that carbon is
one of the most important alloying elements in steels and it dissolves interstitially. Carbon
therefore has very fast diffusion rates. The assumption of no diffusion in the solid phase
during solidification is thus not correct for carbon at most industrial or lab-scale
solidification rates.
For this reason a variant of the Scheil simulation was developed and implemented in
Thermo-Calc, where one or more elements can be defined as fast diffusers.
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Scheil Simulation with a Fast Diffuser Element
The Scheil simulation with fast diffuser model in Thermo-Calc takes into account the concept
of the fast diffuser. Typically, C is defined as a fast diffuser, but also other elements such as
N, O, or others can also be defined.

Fast diffuser does not quite define this since diffusion is not actually simulated.
It is simply assumed that the “fast diffusers” distribute throughout the solid and
liquid phase according to thermodynamic equilibrium. This corresponds to
infinitely fast diffusion.

For the Scheil simulation with fast diffuser the following assumptions are made.
l
l

l

l

Diffusion of all elements in the liquid phase is infinitely fast.
Diffusion of all elements in the solid phases, except the ones defined as “fast
diffusers”, is zero.
Diffusion of the elements defined as “fast diffusers” is infinitely fast in the solid
phase.
The liquid/solid interface is in thermodynamic equilibrium.

The classic Scheil simulation and Scheil simulation with fast diffuser models can be
considered thermodynamic models. There are clear limitations as a certain amount of back
diffusion always takes place in the solid phase at real solidification. For this reason, a more
sophisticated kinetic model, the Scheil simulation with back diffusion is also available.

Scheil Simulation with Back Diffusion
The Scheil simulation with back diffusion kinetic model quantitatively takes into account the
real back diffusion of all elements in the primary solid phase (typically the FCC or BCC
phase). This model requires the use of both a thermodynamic and mobility database. The
calculation also requires the cooling rate to be specified; a fast cooling rate allows for less
time for back diffusion and the simulation result is similar to the classic Scheil-Gulliver
solidification simulation. A very slow cooling rate allows for almost complete back diffusion,
the solidification simulation is then close to an equilibrium calculation. It also requires that
the size of the solidification domain is specified. In most cases this domain size corresponds
to the secondary arm spacing, as this is where typically the liquid is trapped during
solidification.
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The secondary arm spacing also depends on the cooling rate. For this reason a
simple empirical relation between cooling rate and secondary arm spacing is
predefined in Thermo-Calc.
For the Scheil simulation with back diffusion the following assumptions are made.
l
l

l

Diffusion of all elements in the liquid phase is infinitely fast.
Diffusion of all elements in the primary solid phase are quantitatively calculated
using mobility data, a cooling rate and a domain size (typically this is the secondary
arm spacing).
The liquid/solid interface is in thermodynamic equilibrium.

Summary
The variants of the Scheil-Gulliver solidification simulation (classic Scheil simulation, Scheil
with a fast diffuser element, and Scheil with back diffusion) are set up in either the SCHEIL
module in Console Mode or the Scheil Calculator in Graphical Mode.
The Scheil with back diffusion feature is only available for systems with diffusion
data, i.e. it requires the use of a mobility database.
The Scheil calculation allows the calculation of:
l

The solidification range of an alloy.

l

Depression of the solidus temperature due to segregation.

l

Composition of the last liquid to disappear in segregation pockets.

l

Phases formed on final solidification in segregation pockets.

l

The composition gradient in the primary solid phase(s) (segregation profile).

By default, a Plot Renderer successor to a Scheil Calculator has the default plot axes Mole
fraction of solid (X-axis) and Temperature Celsius (Y-axis). When these default axes are
used in the Plot Renderer, the results of normal equilibria calculations are automatically
plotted in the same diagram as the Scheil calculations.
You can use either the Quick Start Wizard (for only Scheil-Gulliver) or the Scheil
Solidification Simulation template to quickly set up a simulation.
For information about the templates see Creating a Project with the Quick Start
Wizard and Creating a Project from a Template.
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For examples using the Scheil Calculator see T_08: Scheil and Equilibrium
Solidification and T_10: Scheil Solidification with Back Diffusion.

Define the Scheil Calculator
1. Add a Scheil Calculator node to the System Definer. If you used the Scheil
Solidification Simulation template, click the node to display the Configuration
settings window.
2. Enter the settings described in Configuration Window Settings. This includes details
about the Advanced Options settings.
3. Once you have finished defining the Scheil Calculator, you also choose settings on the
Plot Renderer.

Configuration Window Settings
An example of the main Configuration window of a Scheil Calculator activity is shown
below. These settings must be configured before performing the calculation.

Start temperature
Enter a Start temperature that is higher than the liquidus temperature of the alloy, in other
words, the temperature at which the alloy is completely melted.

Temperature step
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Enter a Temperature step. Decreasing the temperature step increases the accuracy, but the
default value is usually adequate.

Temperature unit
Select the Temperature unit: Kelvin, Celsius or Fahrenheit.

Composition unit
Select the Composition unit: Mass percent, Mole percent, Mass fraction or Mole fraction.

Back diffusion in primary phase
The Scheil with back diffusion feature is only available for systems with diffusion
data, i.e. it requires the use of a mobility database.
The Back diffusion in primary phase check box is available to select after adding a mobility
database and once components are defined on the System Definer. Click to select this check
box to enable back diffusion in the solid primary phase.
See Scheil Calculator for an overview of the different Scheil simulation models
available and more information about this model.

Cooling rate (available with back diffusion)
This field is available when the Back diffusion in primary phase check box is selected.
Specify the Cooling rate in Kelvin per second (K/s). An increased value moves the result
from equilibrium toward a Scheil-Gulliver calculation.

Secondary dendrite arm spacing (available with back diffusion)
This field is available when the Back diffusion in primary phase check box is selected.
The Secondary dendrite arm spacing is the distance in meters between two secondary
dendrite arms. It can be either a Constant or Calculated from the cooling rate as c*(cooling
rate)-n where c and n are entered in these fields.
Select Calculated or Constant.
l

For Calculated, enter values for c and n.
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l

For Constant, enter a value (unit = m) in the field.

Primary phase (available with back diffusion)
This field is available when the Back diffusion in primary phase check box is selected.
Select Automatic (the default) or choose an available phase from the list for the primary
phase. The primary phase is the phase where the back diffusion takes place. If Automatic is
selected, the program tries to find the phase which gives the most back diffusion. To
override this setting, choose a specific primary phase from the list.

Composition
The Composition settings display after you add components to the System Definer.

Fast diffuser
The Fast diffuser check box is available after you add components to the System Definer.
Click the check box to allow redistribution of this component in both the solid and liquid
parts of the alloy.

Advanced Settings
Click Show advanced options to access more settings.

Global minimization
By default the Global minimization check box is not selected. Click to select it to perform a
global minimization test when an equilibrium is reached. This costs more computer time but
the calculations are more robust.

Liquid phase
The default in the list is the Liquid phase already defined in the database.

Terminate on
From the Terminate on list, choose Fraction of liquid phase or Temperatureand enter a
value in the field.

Max no. of iterations
Enter or choose a value for the Max no. of iterations. By default, the program tries 500
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iterations before it gives up. As some models give computation times of more than 1 CPU
second/iteration, this number is also used to check the CPU time and the calculation stops if
500 CPU seconds/iterations are used.

Required accuracy
The default Required accuracy is 1.0E-6. This is a relative accuracy, and the program
requires that the relative difference in each variable must be lower than this value before it
has converged. A larger value normally means fewer iterations but less accurate solutions.
The value should be at least one order of magnitude larger than the machine precision.

Smallest fraction
The default Smallest fraction is 1.0E-12. This is the value assigned to constituents that are
unstable. It is normally only in the gas phase you can find such low fractions.
The default value for the smallest site-fractions is 1E-12 for all phases except for IDEAL
phase with one sublattice site (such as the GAS mixture phase in many databases) for which
the default value is always as 1E-30.
In Console Mode, the default of 1E-30 for IDEAL phases is true unless you are
using the command SET_NUMERICAL_LIMITS to reset an even-lower value (e.g.
1E-45, that is naturally enforced to all the phases in the system.

Approximate driving force for metastable phases
The Approximate driving force for metastable phases check box is selected by default,
which means the metastable phases are included in all iterations. However, these may not
have reached their most favourable composition and thus their driving forces may be only
approximate.
If it is important that these driving forces are correct, click to clear the check box to force
the calculation to converge for the metastable phases.

Thermo-Calc User Guide: Graphical Mode ǀ 79 of 527

Thermo-Calc Documentation Set

Property Model Calculator
A Property Model Calculator enables you to predict and optimize material properties based
on their chemical composition and temperature. The available calculation types are Single,
One Axis, Grid, Min/Max, and Uncertainty. Using these, you can evaluate models
simultaneously over a range of compositions and temperature and cross plot the results,
then conduct an uncertainty analysis and plot the results as either a histogram or a
probability plot.
The Configuration window for a Property Model Calculator using the Phase transition
model is shown and described in Configuration Window Settings.
There are General Models and Steel Models available. For more information, see
About the Property Models in Thermo-Calc.

You can also create custom Property Models. See Introduction to the Property
Model Development Framework.

Property Model Calculator Workflow
At the start when you are designing a project, it is recommended you first test it by
performing a Single calculation type. This verifies that the configuration of the model is
valid, otherwise you will get a Not a Number result in the Event Log Window, which indicates
the calculation did not work correctly.
Once the Single calculation performs successfully, you can experiment with other calculation
types such as Grid, Min/Max or Uncertainty. Best practice for both Grid and Uncertainty is
to start with a small number of steps (Grid) or samples (Uncertainty) to confirm that it works
before increasing the number of steps or samples.
For a Grid calculation, you can additionally plot a Heat map, Contour or 3D diagram. This
setting is done on the Plot Renderer.
In general, the workflow for each model differs. A recommended start point is to do a One
axis calculation (using the Equilibrium Calculator) to determine what phases you get and
where the transitions are before setting up the Property Model Calculator.
The Quick Start Wizard and Templates and Creating a Project from a Template
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About the Property Models in Thermo-Calc
The General models are available to all users. To run calculations with the
Steel models (Martensite and Pearlite) requires a valid maintenance license
plus licenses for both the TCFE (version 9 and higher) and MOBFE (version 4 and
higher) databases.

General Models
These General Property Models are available with the Property Model Calculator:
l

l
l

l

l

l

l

Coarsening Model: Calculates the coarsening rate coefficient K (m3/s) of a spherical
precipitate phase in a matrix phase.
Driving Force Model: Calculates the thermodynamic driving force for a phase.
Equilibrium Model: Calculates the equilibrium for the given conditions. Optionally
define additional function definitions.
Interfacial Energy Model: Estimates the interfacial energy between a matrix phase
and a precipitate phase using thermodynamic data from a CALPHAD database.
Liquid and Solidus Temperature Model: Use this to complete a common calculation.
For example, with this Model you can easily use uncertainty calculations, varying one
or more conditions, and see how that affects the liquidus and solidus temperatures.
Phase Transition Model: Calculates the point when a new phase may form by varying
set conditions. The Model is useful to determine melting temperature, boiling
temperature or solubility limits. It returns the phase transformation temperature, or
composition, depending on the varied condition.
Yield Strength Model: Calculates yield stress. It returns the calculated yield strength
at room temperature for the specified material using the equilibrium values
calculated at a particular temperature and by further defining the following
contributions to the total yield stress: precipitation strengthening, solid solution,
grain boundary strengthening, and constant addition of strength. For details see
About the Yield Strength Model.
About the Steel Property Models
About the Property Model Development Framework

Calculation Types
About the Uncertainty Calculations and Heat Map, Contour and 3D Plots
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The Property Model Calculator includes these calculation types:
l

Single: Calculates a single point.

l

One axis: Varies a quantity on the X-axis.

l

l

l

Grid: Evaluates two axis variables of the selected quantities in the specified range
and number of steps. You can then select to create heat map, contour and 3D plots
on the Plot Renderer.
Min/Max: Evaluates the Property Model(s) for all variations of the selected
quantities at the given limits. The Mean field is as defined under Condition
Definitions for the respective quantity. The total minimum and maximum of the
Model(s) results are shown in the Event log.
Uncertainty calculation: Evaluates the Property Model(s) where the values of the
quantities are sampled from Gaussian distributions. The Mean field is as defined
under Condition Definitions for the respective quantity. The result is visualized as a
histogram or normal probability plot by adding a Plot Render activity.

Examples and Video Tutorials

Website
For an introduction to the Property Model Calculator, go to the video tutorial
page on our website and under Release and New Products, click the arrow next
to Property Model Calculator.

YouTube
You can also go to YouTube channel to review the available training videos.
Subscribe to the channel to be updated when new videos are added. Also see the
video introduction to the Property Model Calculator.
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About the Steel Property Models
The General models are available to all users. To run calculations with the
Steel models (Martensite and Pearlite) requires a valid maintenance license
plus licenses for both the TCFE (version 9 and higher) and MOBFE (version 4 and
higher) databases.

These Steel Models are available with the Property Model Calculator. The following are
part of the Steel Model Library:
l

l

l

Martensite Fractions Model: Calculates the fraction of athermal martensite based on
available driving force.
Martensite Temperatures Model: Calculates the martensite start and finish
temperature based on modeling of the transformation barrier.
Pearlite Model: Calculates the thermodynamics and kinetics of pearlite formation
from austenite during isothermal heat treatment.
Steel Library TTT Diagram Template and Plot Settings: TTT Mode
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About the Property Model Development Framework
With the Property Model Calculator you can develop your own Property Models and
integrate these into Thermo-Calc. In other words, you can customize the software to meet
your modeling needs.
Models are developed using the programming language Python, and model development is
possible without any additional installation using a simple editor, such as Notepad++. You
can also use a Python Integrated Development Environment (IDE) to access advanced
features such as debugging of the Property Models and autocompletion.
Models are automatically encrypted for safe and secure file sharing.
Introduction to the Property Model Development Framework

Property Model Development Framework PDF and Examples
There is a PDF guide and tutorial examples included with your installation. In Thermo-Calc
from the menu, select Help → Manuals Folder. Then double-click to open the Property
Model Development Framework folder. This guide is also available on our website.
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Define the Property Model Calculator
1. Add a Property Model Calculator node to the System Definer. If you used the
Property Model Calculation template, click the node to display the Configuration
settings window.
2. From the left side of the Configuration window, click to select one or more of the
check boxes under the General models or Steel models folders.
Steel Models are only available if you have a license. Go to our website for
more information about the Steel Model Library.
A tab with the same name as the Property Model opens in the right side of the
window under Condition Definitions. When you select more than one Model, a
matching tab is added in the same order that the check box is selected.

3. Enter the settings described in Configuration Window Settings and for each
Calculation Type (Single, Grid, Min/Max, and Uncertainty).
4. For each Model on the Configuration tab, select or enter settings as required.

Click the Description tab for more information about the Model. When
the Property Model is not encrypted or it is a user-defined Property
Model, there is also a Python code tab that displays the related code.
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5. Once you have finished defining the Property Model Calculator, you also choose
settings on the Plot Renderer.

Configuration Window Settings

An example of the Configuration window settings when using a Phase Transition Model and an
Uncertainty calculation type.

Composition unit
Choose a unit: Mass percent, Mole percent, Mass fraction or Mole fraction.

Condition Definitions
Choose a unit (Kelvin, Celsius or Fahrenheit) and then enter a value for the Temperature
and Composition for each component.
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The values entered in Condition Definitions are used as the start values for the different
calculation types.

Define the Property Model
For each Property Model chosen, select or enter Configuration settings as required.
For links to each Model with the settings details, see About the Property Models in
Thermo-Calc.

Click the Description tab for more information about the Model. When the
Property Model is not encrypted or it is a user-defined Property Model, there is
also a Python code tab that displays the related code.

Calculation Type
Choose a calculation type: Single (no axes), One axis, Grid, Min/Max or Uncertainty.
l

Select Single to calculate a single point. Any model can use this calculation type and
no additional settings are required. The results from this calculation are displayed in
the Event Log or if a Table Renderer is used, in the Results window.
Equilibrium Model

l
l

l

l

Select One axis to vary a quantity on the X-axis.
Select a Grid to evaluate two axis variables of the selected quantities in the specified
range and number of steps.
The Min/Max calculation evaluates the Property Model(s) for all variations of the
selected quantities at the given limits. The Mean field is as defined under Condition
Definitions for the respective quantity. The total minimum and maximum of the
model(s) results are shown in the Event log.
The Uncertainty calculation evaluates the Property Model(s) where the values of the
quantities are sampled from Gaussian distributions. The Mean field is as defined
under Condition Definitions for the respective quantity. The result is visualized as a
histogram or normal probability plot by adding a Plot Render activity.

Axis Definition
For One axis, select a Quantity to vary along the X-axis, for example, Temperature then
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enter a Min, Max and Number of steps.

Grid Definitions
For the Grid calculation type, define the two axes variables using the fields and menus:
Quantity, Min, Max and Number of steps. The number of steps along with the minimum
and maximum values for the axes define a grid. For each grid point the selected models are
evaluated.
For a Grid, on the Plot Renderer, you can choose to plot a Heat map, Contour or
3D diagram.
Heat Map, Contour and 3D Plots

Min/Max Definitions
For the Min/Max calculation type, click to select the applicable check boxes under Quantity
to enable or disable an axis. The Mean field is as defined under Condition Definitions for
the respective quantity.
Enter numerical values in the ΔMin/Max fields to evaluate the change to the quantity. The
highest and lowest value of each selected model results are shown in the Event Log.

Sampling of Data from Gaussian Distributions
For the Uncertainty calculation type, click to select the applicable check boxes under
Quantity to vary this quantity. The Mean field is for the distribution function as defined
under Condition Definitions for the respective quantity. The default ΔMin/Max is a 95%
confidence interval.
About the Uncertainty Calculations

Sampling Parameters
For the Uncertainty calculation type, choose a number of Standard deviations where you
want to Truncate the distribution. Choose the Total number of samples.
About the Uncertainty Calculations
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Diffusion Calculator
The Diffusion Calculator is available with three elements if you do not have the
additional Diffusion Module (DICTRA) license. With the Add-on Module you can
use all available elements as per the licensed database selected. See Available
Graphical Mode Features for details.
A Diffusion Calculator allows you to set the conditions for, and perform, a diffusion
calculation. You can add the calculator to the System Definer directly (right-click and select
it from the Create New Successor menu) or use the Diffusion Simulation template.
Once you have added a Diffusion Calculator, the Configuration window has these settings
tabs:
l

l

Conditions: Set the conditions for your calculation that define the geometry, regions,
phases, grids, composition profiles and the thermal profile.
Options: Modify the simulation conditions such as the choosing the default solver
(automatic or homogenization) and the time integration method. Also define the
time step controls and if you choose homogenization as the solver, define further
settings such as the interpolation scheme and whether to use global minimization or
not.

Available Graphical Mode Features
The Diffusion Module is an Add-on Module to the core Thermo-Calc software.
A separate license is required to perform calculations for more than three
elements. Without it you are able to use the module in Demo Mode. This is not
available in Console Mode. See Demonstration (Demo) Mode to learn more.

Diffusion Simulation Template
A Diffusion Simulation template is available to all Thermo-Calc users when in Graphical
Mode.
If you are using the Diffusion Module in Demo Mode, see Demonstration
(Demo) Mode for what is available to you. Even if you have a license, you may
find yourself in Demo Mode if you have a network license and all the licenses
are checked out.
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USING THE TEMPLATE
When you first open Thermo-Calc in Graphical Mode, on the My Project window, click the
Diffusion Simulation button to add a System Definer, Diffusion Calculator and Plot Renderer
to the Project tree.
Click the Diffusion Simulation icon in the Templates window to add THESE NODES to the
Project.

Creating a Project from a Template.

Diffusion Calculator
A Diffusion Calculator allows you to set the conditions for your calculation that define the
geometry, regions, phases, grids, composition profiles and the thermal profile, plus
additional options. Many of the settings are automatically set as you define your system.
Details about this activity are described in Diffusion Calculator.

Demo Database Packages for the Examples Collection
Both a thermodynamic and mobility database are required to run the Diffusion Module
simulation. If you have a Diffusion Module (DICTRA) license you can run all the examples
because the demonstration database packages are included with your installation.
Select the database packages from the System Definer Configuration window to run a
simulation.
If you are in Demo Mode, see Demonstration (Demo) Mode to learn more.
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Demonstration (Demo) Mode
The Diffusion Module and some examples are available to all Thermo-Calc users but only for
simulations with three elements. If you do not have a license for then you are in Demo Mode
when using the Diffusion Calculator or Diffusion Simulation template.

DIFFUSION SIMULATION TEMPLATE
When you are in DEMO mode, in the Templates area this is indicated by the text under the
logo.

DIFFUSION CALCULATOR
If you are experimenting with the Diffusion Calculator in Demo Mode, you may have access
to a variety of databases based on your license. However, you can only define three
elements for a demo simulation.
If you define more than three elements on the System Definer, when you go to the Diffusion
Calculator, the Perform button is unavailable and the tooltip explains why.

Even if you have more than three elements, the Plot Renderer Perform button is
still available. However, if you click the button and try to run the simulation the
Event Log displays an error message.
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Define the Diffusion Calculator
Available Graphical Mode Features
Working with diffusion simulations is an advanced topic. It is recommended you review the
Diffusion Module (DICTRA) documentation and videos available or search for a specific
topic.

1. Add a Diffusion Calculator node to the System Definer. If you used the Diffusion
Simulation template, click the node to display the Configuration settings window.
2. In the Diffusion Calculator Configuration window, enter the settings described in
Conditions Tab Settings and Options Tab Settings.
3. Once you have finished defining the Diffusion Calculator, you also choose settings on
the Plot Renderer. Some additional settings are specific to the Diffusion Calculator
Plot Renderer.

Conditions Tab Settings
The following Configuration window is from the Graphical Mode Quick Start Guide. It is using
project example file D_07: Diffusion Carburization Multiphase.
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These are the settings available from the Conditions tab. To edit the defaults for some
settings, go to Tools → Options → Graphical Mode → Diffusion.
The Diffusion Module (DICTRA) in Console Mode has commands to perform
some of the settings also available on the Diffusion Calculator. Where possible
the name of the command is indicated and includes a link to the topic.
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General
Composition Unit
Choose from Mass percent, Mole percent, Mass fraction or Mole fraction.

Length Unit
Choose m, μm or nm.

Geometry
Choose Planar, Spherical or Cylindrical. For Cylindrical, also enter a value for the First
interface position .
With a cylindrical or spherical geometry, the system’s zero coordinate (left boundary) is at
the centre of the cylinder or sphere. The highest coordinate (right boundary) is defined by
the cylinder or sphere radius.

Region Settings
There should be one unique phase in each region.
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Left and Right interface boundary
Toggle between hiding and showing the Left interface boundary or Right interface
boundary.
Click the Add quantity or Remove quantity buttons as required to add a Phase and
then enter a value for the Driving force as required. The default driving force is 1.0E-5.

Name
Enter a Name for the region in the field. For example, enter Austenite. This name is
automatically updated on the tab and above the grid points graphic. You can also doubleclick the tab to enter the name.

Width
Enter a numerical value in the Width field. The unit is the one selected for the Length unit.

Points
Enter a numerical value in the points field. The default is 50.

Type (of Grid)
Select a type of grid, Linear, Geometric or Double geometric.
Choose Geometric for a grid that yields a varying density of grid points in the region. Then
enter a Ratio to determine the distribution. A geometrical factor larger than one yields a
higher density of grid points at the lower end of the region and a factor smaller than one
yields a higher density of grid points at the upper end of the region.
Choose Double geometric to have a high number of grid points in the middle or at both
ends of a region. Then specify two geometrical factors, the Upper ratio for the distribution
in the lower (left) part of a region, and Upper ratio for the distribution in the upper (right)
part of a region.

Phase
Choose a Phase from the list. The available options are defined in the System Definer. At
least one phase that dissolves all system elements must be selected.
Click the Add quantity

or Remove quantity buttons as required.

Composition Profile
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Click Edit to open the Initial Composition window.
Select a Dependent component for which the composition does not need to be given. The
available options depend on the phase description.
For each Component choose one of these options:
l
l

l

Linear: Enter numerical values in the from and to fields.
Step: Enter numerical values in the from , to , and step at fields. The unit is the
same as the Length unit selected at the top of the Configuration window.
Function: Enter a composition function in the field using SI units. The syntax to use
for writing functions is a Python syntax (a programming language). Any valid Python
expression that is a function of the distance variable x will work.
l

You can use the standard Jython math library but you must prefix these
functions with the text "math" For example: 10 + math.sin(x*2). The
Jython math library is available here:
http://www.jython.org/docs/library/math.html.

l

l

The error function erf(X) is also available in the Jython math library and can
be called with math.erf(x).
Another useful function is the Heaviside step-function hs(X). For example,
3+2hs(x-1e-4) provides a concentration of 3 at the left side and 5 at the
right side with a sharp step in the concentration profile at 1e-4m=100mm.

Click Apply when you are done.
As you add these settings, the plot helps you visualize the region based on whether you use a
Linear, Step or Function to define the components.
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Boundary Conditions
Boundary conditions are conditions that define how matter behaves at the boundaries of
your system. By default, matter is not allowed to cross the system boundaries.
You can change the setting for both the lower boundary (left side/centre) and the upper
boundary (right side/surface) of the system.
Examples D_06 and D_07 use boundary conditions, as described in Diffusion
Module (DICTRA) Graphical Mode Examples.
The boundary condition settings are done on the Diffusion Calculator. The following
describes the options available for the Left boundary and Right boundary conditions.
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Closed system
By default it is a Closed system. Choose Mixed zero flux and activity or Composition if the
system is not closed. Corresponds to a fix flux value, which is set to zero at all times. This is
the default boundary condition.
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Composition
Allows the user to set a fix composition at the boundary.
In Console Mode this is similar to the command STATE_VARIABLE_VALUE, but in
Graphical Mode this condition is limited to setting a fixed composition.

Mixed zero flux and activity
The flux of selected components is either set to zero or a prescribed activity value.
For Mixed zero flux and activity, and for each independent element selected in the
Composition profile, choose either Zero flux or Activity from the lists and enter a value in
the field when Activity is selected. The reference state for the components are taken from
the System Definer Components tab.
This image is from example D_07: Diffusion Carburization Multiphase.

Thermal Profile
Isothermal
Use an Isothermal calculation type to do a diffusion simulation at constant temperature.
Choose a unit of measurement and enter a numerical value for the Temperature and
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Simulation time.

Non-isothermal
Use a Non-isothermal calculation type to do a diffusion simulation with a user-defined
temperature profile. Select a Temperature unit and Time unit from the lists. Enter a
numerical value for the Simulation time.
Click Edit thermal profile to enter thermal profile Temperature and Time coordinates into
a table. A minimum of two points is required. You can also Import to add your own Thermal
profile from a text file in *.xls, *.xlsx, or *.csv formats.

EDIT THERMAL PROFILE WINDOW
This image is from example D_04: Diffusion Fe-C Moving Boundary Austenite to Ferrite.

Options Tab Settings
The following settings are available on the Options tab for a Diffusion Calculator.
You can edit the defaults for some of these settings by going to Tools →
Options → Graphical Mode → Diffusion. Also see Global Settings: Diffusion
Calculator.
The Diffusion Module (DICTRA) in Console Mode has commands to perform
some of the settings also available on the Diffusion Calculator. Where possible
the name of the command is indicated and includes a link to the topic.
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Simulation Conditions
DEFAULT SOLVER
Automatic or Homogenization.
Select Homogenization to define additional sections.

ABOUT THE HOMOGENIZATION SOLVER
The homogenization solver (called the homogenization model in Console Mode) is useful
when you want to simulate long-range diffusion through a multiphase mixture, under the
assumption that local equilibrium holds at each node point.
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Time integration method
Automatic , Trapezoidal or Euler backwards.
The default is Automatic where the default degree of implicity corresponds to trapezoidal
(0.5) for classic and Euler Backward (1.0) for the homogenization model. If large fluctuations
occur in the profiles it may be necessary to use the more stable but less accurate Euler
backwards.
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Save results on file
Yes, No or Every nth. . Select Every nth to enter a value in the field.
This setting is determine if the results are to be saved on file during the course of the
simulation.
l

Yes to always save on file

l

No to never save on file

l

Every nth. to save every nth time to file. Then enter an integer value ranging from 0
to 99.

Use forced starting values in equilibrium calculations
The default Automatic allows the software program to automatically use forced starting
values to perform the equilibrium calculations. When a phase with an ordering contribution
is entered into the simulation, for example the gamma-prime/fcc_l12 phase in Ni-base
superalloys, forced starting values are automatically turned on. Or choose Yes or No.

Default driving force for phases allowed to form at interfaces
Enter a value in the field. The required driving force (evaluated as DGM (ph)) to be used for
determining whether an inactive phase is stable. DGM is the variable for the driving force
that is already divided by RT, and it is dimensionless. The default is 1E-5.
Suffixes

Timestep Control
Max Relative Error
Enter a value in the field. The default is 0.05.

Max Absolute Error
Enter a value in the field. The default is 1.0E-5.

Timestep
Enter values in the fields.
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This value is always in seconds.

l
l

l

Initial. What is used as the initial time step. The default is 1.0E-7.
Smallest allowed. The smallest time step allowed during the simulation. This is
required when using the automatic procedure to determine the time step. The
default is 1.0E-7.
Max % of simulation time. The default is 10.

Factor specifying the maximum increase in the time step taken from one
time step to another
For example, if 2 is entered the maximum time step is twice as long as the previous time
step taken.
Enter a value in the field. The default is 2.

The timestep is to be controlled by the phase interface displacement during
the simulation
The default is Automatic. When a liquid phase is entered in a simulation this option is
automatically turned on. Optionally choose Yes or No to set whether the time step is to be
controlled by the phase interface displacement during the simulation.

Classic and Homogenization Model Settings
Classic Model Specific
Activity or Potential
Use the [activity or potential] of a component in order to find the correct tieline at the
phase interface.
Determines whether the program should use the potential or the activity of a component in
order to find the correct tie-line at the phase interface. The potential or the activity is varied
by the program and is set in order to reduce the degrees of freedom at the local
equilibrium.

Flux Balance Equation Accuracy
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Required accuracy during the solution of the flux balance equations. The default is 1.0E-16.

Homogenization Model Specific
This section is available when Homogenization is selected (or automatically
selected) as the Default solver. These settings are available on the Options tab.

Homogenization Function
Several functions are available. The default is Rule of mixtures (upper Wiener bound). See
About the Homogenization Functions.

Use global minimization
Select the check box for global minimization used in equilibrium calculations. In general,
using global minimization significantly increases the simulation time, but there is also a
significantly reduced risk for non-converged equilibrium calculations.

Interpolation scheme
When the homogenization model is used, simulations are run using an implicit finite volume
method to increase numerical stability. Because of this, and other factors, homogenization
model simulations generally run slower than other comparable simulations. You can reduce
simulation time with the Use Interpolation scheme check box. The check box is selected by
default.

Discretization
[Logarithmic or Linear] discretization with [number of] steps in each dimension.
l

For the linear discretization the scheme is not used at node points where the content
of one or more solutes fall below a certain critical value. For such cases, where
composition span many orders of magnitude, the logarithmic discretization can be
tried.
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l

Enter the number of steps in composition space. In the limit where an infinite
number of steps are used, exactly the same solution is obtained as without the
interpolation scheme. However, excellent results can be obtained with a reasonable
discretization. The default is 10000 steps.

Memory to use
This is the fraction of free physical memory to be used by the interpolation scheme.
Select Megabyte or Fraction of free and then enter a value in the field.

About the Homogenization Functions
The geometrical interpretation of the Hashin-Shtrikman bounds are concentric spherical
shells of each phase. For the general lower Hashin-Shtrikman bound the outermost shell
consists of the phase with the most sluggish kinetics and vice versa for the general upper
bound. The geometrical interpretation of the Hashin-Shtrikman bounds suggest further
varieties of the bounds, viz. Hashin-Shtrikman bound with prescribed matrix phase and
Hashin-Shtrikman bound with majority phase as matrix phase, where the outermost shell
consist of a prescribed phase or the phase with highest local volume fraction, respectively.
The geometrical interpretation of the Wiener bounds are continuous layers of each phase
either parallel with (upper bound) or orthogonal to (lower bound) the direction of diffusion.
The labyrinth factor functions (described below) are only available in Console
Mode.
The labyrinth factor functions implies that all diffusion takes place in a single continuous
matrix phase. The impeding effect on diffusion by phases dispersed in the matrix phase is
taken into account by multiplying the flux with either the volume fraction (Labyrinth factor f
with prescribed matrix phase), or the volume fraction squared (Labyrinth factor f**2 with
prescribed matrix phase), of the matrix phase.
The varieties with excluded phases (described below) are only available in
Console Mode.
The varieties with excluded phases are useful in several respects. First, if a phase is
modelled as having zero solubility for a component, the mobility of that component in that
phase is undefined, which causes a (non-terminal) error. Setting a phase as excluded causes
the mobility of all components in that phase to be set to zero. Second, often there are some
major matrix solid solution phases and some minor precipitate phases. If the mobilities in
the minor precipitate phases are zero the lower Hashin-Shtrikman bound is useless as it

Thermo-Calc User Guide: Graphical Mode ǀ 106 of 527

Thermo-Calc Documentation Set

produces a kinetic coefficient of zero. However, using General lower Hashin-Shtrikman
bound with excluded phase(s) the excluded phases are not considered when evaluating what
phase has the most sluggish kinetics.

Pause, Resume and Cancel Diffusion Calculations
Diffusion calculations are often complex simulations that take some time to complete.
Sometimes you may want or need to pause or resume a calculation, or make adjustments to
your compositions and start again.

Graphical Mode
In Graphical mode, you pause and resume from the Diffusion Calculator Configuration
window.
This is also available for the Precipitation Calculator (but not any other
calculators). See Pause, Resume and Cancel Precipitation Calculations.

HOW TO PAUSE AND RESUME A JOB
1. Run the job (i.e. click Perform Tree). In the Scheduler, you can see the job listed and
in the Event Log you can follow the progress of the calculation.
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2. In the Project window, click the Diffusion Calculator node.
3. In the Configuration window at the bottom, click Pause. If there are intermediate
results available these will be listed in the Event Log.

4. When ready, click Continue to resume your calculations from the last time step or
click Discard to discard the calculation (then click Yes or No on the window that
opens).

HOW TO CANCEL A JOB
l

In the Scheduler window, right-click the job you want to cancel and select Cancel
Job.

Console Mode
In response to a command or a lengthy calculation, Thermo-Calc may display a lot of text in
the Console window. Use these keyboard shortcuts to pause, resume or stop a process.
l

To pause the text on printing press <Ctrl+S>.

l

To resume the printing on screen, press <Ctrl+Q>.
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l

When Thermo-Calc is performing a stepping or mapping operation, the results are
continuously printed in the Console window. To stop the calculation of the current
region of the mapping and stop the output, press <Ctrl-A> (Windows) or <Ctrl-C>
(Linux).
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Precipitation Calculator
The Precipitation Calculator is available with three elements if you do not have
the additional Precipitation Module (TC-PRISMA) license. With the Add-on
Module you can use all available elements. See Precipitation Module: Available
Graphical Mode Features for more information.
A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation
calculation. You can add the calculator to the System Definer directly (right-click and select
it from the Create New Successor menu) or use the Precipitation Simulation template.
Once you have added a Precipitation Calculator, the Configuration window has these
settings tabs where there are many available conditions to set:
l

l

Conditions: Set the conditions for your calculation that define the Matrix phase and
Precipitate phase. Choose the Calculation Type.
Options: Modify Numerical Parameters that determine how the conditions are
calculated.
There are also unique settings available for this calculator once you add a
Precipitation Calculator Plot Renderer.

Precipitation Module: Available Graphical Mode Features
The Precipitation Module, previously referred to as TC-PRISMA, is an Add-on Module to the
core Thermo-Calc software. A separate license is required to perform calculations for more
than three elements. Without it you are able to use the module in Demo Mode.
Demonstration (Demo) Mode

Precipitation Simulation Template
A Precipitation Simulation template is available to all Thermo-Calc users.
If you are accessing the Precipitation Module in Demo Mode, see
Demonstration (Demo) Mode for what is available to you.
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USING THE TEMPLATE
When you first open Thermo-Calc in Graphical Mode, on the My Project window, click the
Precipitation Simulation button to add a System Definer, Precipitation Calculator and Plot
Renderer to the Project tree.
Click the Precipitation Simulation button in the templates section to add these nodes to the
Project.

Creating a Project from a Template

Precipitation Calculator
A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation
calculation.

Demo Database Packages for the Examples Collection
Both a thermodynamic and mobility database are required to run the Precipitation Module
simulation. If you have a Precipitation Module (TC-PRISMA) license you can run all the
examples as the demonstration database packages are included with your installation. Select
the database packages from the System Definer →Configuration window to run a
simulation.
If you are using the Precipitation Module in Demo Mode, see Demonstration
(Demo) Mode to learn more.
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Demonstration (Demo) Mode
The Precipitation Module, and some examples, are available to all Thermo-Calc users but
only for simulations of alloys with up to three elements. If you do not have a license for the
Precipitation Module then you are in Demonstration Mode when using the Precipitation
Calculator or Precipitation Simulation template.

PRECIPITATION SIMULATION TEMPLATE
When you are in DEMO mode, in the Templates area this is indicated by the text under the
logo.

PRECIPITATION CALCULATOR
If you are experimenting with the Precipitation Calculator in Demo Mode, you may have
access to a variety of databases based on your license. However, you can only define up to
three elements for a demo simulation.
If you define more than three elements on the System Definer, when you go to the
Precipitation Calculator, the Perform button is unavailable and the tooltip explains why. In
this case one of the chosen elements needs to be removed and then the Perform button is
made available.
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Even if you have more than three elements, the Plot Renderer or Table
Renderer Perform button is still available. However, if you click the button and
try to run the simulation the Event Log displays an error message.

Define the Precipitation Calculator
Precipitation Module: Available Graphical Mode Features
Working with precipitation simulations is an advanced topic. It is recommended you review
the Precipitation Module (TC-PRISMA) documentation and videos available or search for a
specific topic.
1. Add a Precipitation Calculator node to the System Definer. If you used the
Precipitation Simulation template, click the node to display the Configuration
settings window.
2. In the Precipitation Calculator Configuration window, enter the settings described in
Conditions Tab Settings. Additional advanced options settings are also available and
described Option Tab Settings.
3. Once you have finished defining the Precipitation Calculator, you also choose settings
on the Plot Renderer. Some additional settings are specific to the Precipitation
Calculator Plot Renderer.

Conditions Tab Settings
Below are details about the settings available from the Conditions tab on the calculator
Configuration window.
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Figure 1: This is the Configuration window for example P_04_Precipitation_Fe-C_Cemetite.tcu. In
this case, Show details is expanded to show the Precipitate Phase settings.

You can change these settings locally for a specific Precipitation Calculator or
globally for some defaults in the Options settings. To open the Options window:
From the main menu select Tools → Options. Click the Graphical Mode tab
then click Precipitation.

Show or Hide Details
Click Show details (found to the right of the section) to view some of the additional settings
listed below. You can also set the default to display in Phase view mode under Tools →
Options→Graphical Mode, then click the Precipitation node.
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COMPOSITION UNIT
Choose from Mass percent, Mole percent, Mass fraction or Mole fraction.

MATRIX PHASE
Phase
Only phases with kinetic data can be selected as the matrix phase. If the list is
empty, go to the System Definer to confirm that both thermodynamic and
kinetic databases are selected and defined.
Choose a Phase from the list. The list is based on the settings for the System Definer. When
setting up a system, choose a matrix phase with kinetic data available in the database.

Elastic properties
Choose Disregard to ignore the elastic properties.
Default elastic constants for Isotropic or Cubic are based on the major element of the alloy
system. The elastic properties can affect nucleation rate, nuclei size, and particle shape.
l

l

For Isotropic, enter values for Shear modulus (in GPa) and Poisson's ratio as
required.
For Cubic, enter values for c11, c12 and c44 as required.
constants.

are the elastic

Molar volume
Use the Database value (if the molar volume for the phase is defined in the thermodynamic
database) or select User-defined to enter another value.

Grain size
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Grain size is the "diameter" of a grain. The Grain size value changes the available nucleation
sites when Grain boundaries, Grain edges, or Grain corners is selected along with
Calculate from matrix settings in the Precipitate Phase. Enter a numerical value and choose
a unit from the list. The default is 1.0E-4 m.

Grain aspect ratio
For an elongated grain with a minor axis and a major axis, one may use the minor axis as
grain size and the major/minor ratio as the grain aspect ratio to characterize the grain. The
Grain aspect ratio value also changes the available nucleation sites when Grain
boundaries, Grain edges, or Grain corners is selected along with Calculate from matrix
settings in the Precipitate Phase. Enter a numerical value. The default is 1.0.

Dislocation density
The Dislocation density value changes the available nucleation sites when Dislocations is
selected along with Calculate from matrix settings in the Precipitate Phase. Enter a
numerical value. The default is 5.0E12 m-3.

Mobility enhancement prefactor
A parameter that multiplies to the mobility data from a database. This value scales the
mobility by a constant amount. This can be useful, for example, when the material has a
higher than normal vacancy concentration at the start of the precipitation simulation. (e.g.
from a prior solutionizing and quenching treatment).

Mobility enhancement activation energy
A value that adds to the activation energy of mobility data from a database. This value
scales the mobility by a temperature dependent amount. Similar usage as mobility
enhancement prefactor.

PRECIPITATE PHASE
Phase
The phases available to choose have both thermodynamic and kinetic data. If
the list is empty, go to the System Definer to confirm that both types of
databases are selected and defined.
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Choose a Phase from the list. The list is based on the System Definer settings.

Nucleation sites
The number of different nucleation sites is dependent on the shape and size of grains in the
matrix. Grain size is the "diameter" of a grain. Choose one of the following from the list.
l
l

Bulk, Grain boundaries, Grain edges, Grain corners, or Dislocations.
For Grain boundaries, Grain edges and Grain corners, enter the Wetting angle (090) in addition to the matrix settings. Wetting angle defines the deviation from
spherical shape (or dihedral angle).

Click to select the Calculate from matrix settings check box if you want to calculate the
number density of sites from the matrix grain size or dislocation density.
To enter a specific value for the number of Nucleation sites, deselect the check box.

Interfacial energy
Choose Calculated to use the estimated value. To adjust the estimate, enter a different
prefactor or choose User-defined to enter a value in J/m2. For the User-defined option, you
can also enter it as a function of radius (r) and temperature (T).

Growth rate model
Select Simplified, General , Advanced, Paraeq or NPLE. All models treat a particle
(precipitate) of stoichiometric composition or with negligible atomic diffusivity. Local
equilibrium or paraequilibrium at the precipitate-matrix interface is assumed.

Morphology
Choose the particle shape: Sphere (default), Cuboid, Plate or Needle. Options are based on
the Elastic properties selected for the Matrix phase:
l

For Cubic, Sphere, Plate , Needle and Cuboid are available.

l

For Isotropic, Sphere, Plate and Needle are available.

For Plate or Needle, select the Calculate aspect ratio from elastic energy check box or
enter a numerical value in the Aspect ratio field to provide a constant aspect ratio.
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Figure 2: The cuboid shape is described by a supersphere. Cuboids have six faces, which form a
convex polyhedron.

Figure 3: The plate is described as oblate spheroid. Oblate spheroids have rotational symmetry
around an axis from pole to pole.

Figure 4: The needle shape is described as prolate spheroid. A prolate spheroid is a surface of
revolution obtained by rotating an ellipse about its major axis.

Transformation strain
Choose Disregard to ignore the transformation strain. When Isotropic or Cubic is chosen in
Elastic properties in Matrix Phase, you can also choose Calculated from molar volume to
obtain a purely dilatational strain. If Plate or Needle is selected as the Morphology, you
can alternatively choose User-defined and enter the properties for ε11, ε12, ε13, ε22, ε23,
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and ε33.

Molar volume
Use the Database value (if the phase molar volume is defined in the thermodynamic
database) or select User-defined to enter another value.

Phase boundary mobility
A parameter that accounts for interface-controlled growth. Only effective if a very small,
positive value is used. Use with caution due to a tentative treatment.

Phase energy addition
An energy value that adds to the Gibbs free energy of the precipitate phase from a
database.

Approximate driving force
Select the check box to include this if simulations with several compositions sets of the same
phase create problems.

Preexisting size distribution
Select the check box to include this. Click Edit particle size distribution to open the
Preexisting Particle Size Distribution window where you can edit the parameters and view
a graph comparing the radius and number density for the selected component.
Press F1 and search for "Particle Size Distribution (PSD)" for detailed instructions.
See examples P_10 and P_11

CALCULATION TYPE
Isothermal
Use an Isothermal calculation type to do a precipitation simulation at constant temperature.
Choose a unit of measurement and enter a numerical value for the Temperature and
Simulation time.

Thermo-Calc User Guide: Graphical Mode ǀ 119 of 527

Thermo-Calc Documentation Set

See examples P_01, P_02, P_04, P_05, P_08 and P_09

Non-isothermal
Use a Non-isothermal calculation type to do a precipitation simulation with a user-defined
temperature profile. Select a Temperature unit and Time unit from the lists. Enter a
numerical value for the Simulation time.
Click Edit thermal profile to enter thermal profile Temperature and Time coordinates into
a table. A minimum of two points is required. You can also Import to add your own Thermal
profile from a text file in *.xls, *.xlsx, or *.csv formats.

See example P_06

TTT diagram
Use a TTT-diagram to calculate the time-temperature-transformation (TTT) curve for the
formation of the precipitate phase.
l

l

Temperature: Enter Min, Max, and Step numerical values and choose a
temperature Unit.
Max annealing time: Enter a numerical value and choose a time Unit.
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l

Stop criteria: Choose Volume fraction of phase or % of equilibrium fraction and
then enter a numerical value. For each temperature, the simulation stops when the
stop criteria is fulfilled or if the maximum annealing time is reached, whichever
happens first.
See example P_03.

CCT diagram
Use a CCT-diagram to calculate the continuous-cooling-transformation (CCT) curve for
precipitation.
l
l

l

Temperature: Enter Min and Max numerical values and choose a temperature Unit.
Cooling rate(s): Enter a range of values in the field, e.g. .01 .1 1 10 100. These
values are equal to K/s, °C/s or °F/s per second based on the temperature Unit
selected.
Stop criteria: Enter a numerical value for the Volume fraction of phase. For each
temperature, the simulation stops when the stop criteria is fulfilled.
See example P_07.

Particle Size Distribution (PSD)
On the Precipitation Calculator you can set the pre-exisiting particle size distribution
(PSD) parameters in the Show details section. The size distribution can be entered as a predefined distribution, by importing a file, or by manually entering information into a table.

ACCESSING THE 'PRE-EXISTING SIZE DISTRIBUTION' SETTINGS
1. To the right of the Precipitate Phase settings fields, click Show details.

2. Click to select the Preexisting size distribution check box.
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3. Click Edit particle size distribution to open the window as shown for example P_10.

DEFINING THE PREEXISTING SIZE DISTRIBUTION
1. Under Compositions, choose a Dependent component from the list and enter the
composition for the other component.
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2. Under Size Distribution define the following:
a. Choose a Length unit: m, μm, or nm.
b. Choose a Distribution: LSW (Lifshitz-Slyozov-Wagner), Normal, Log normal
or From file. You can also manually enter numbers into the table instead of
importing a file.

c. For LSW, Normal and Log normal, enter a Mean radius.
d. For Normal and Log normal, enter a value for the standard deviation (Std).
e. For From File, click Import and navigate to the file containing the required
information and click Open. This file can be in .xls, .xlsx, .csv or .txt formats.
The file should consist of two columns with values where the first column
contains radius data and the second contains number density data.
f. For all options, choose an Amount of phase: Volume percent or Volume
fraction and then enter a number in the field.
g. Once the Distribution is defined, click Generate.

Option Tab Settings
These settings are for the Precipitation Calculator and are located on the Configuration
window → Options tab.

You can change these settings locally for a specific Precipitation Calculator or
globally in the Options settings. To open the Options window: From the main
menu select Tools → Options. Click the Graphical Mode tab then click
Precipitation.

NUMERICAL PARAMETERS
Click Options to go to these settings.

Max time step fraction
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The maximum time step allowed for time integration as fraction of the simulation time. The
default is 0.1.

No. of grid points over one order of magnitude in radius
Default number of grid points for every order of magnitude in size space. The default is
150.0.

Max no. of grid points over one order of magnitude in radius
The maximum allowed number of grid points in size space. The default is 200.0.

Min no. of grid points over one order of magnitude in radius
The minimum allowed number of grid points in size space. The default is 100.0.

Max relative volume fraction of subcritical particles allowed to dissolve in
one time step
The portion of the volume fraction that can be ignored when determining the time step. The
default is 0.01.

Max relative radius change
The maximum value allowed for relative radius change in one time step. The default is 0.01.

Relative radius change for avoiding class collision
Set a limit on the time step. The default is 0.5.

Max overall volume change
This defines the maximum absolute (not ratio) change of the volume fraction allowed during
one time step. The default is 0.001.

Max relative change of nucleation rate in logarithmic scale
This parameter ensures accuracy for the evolution of effective nucleation rate. The default
is 0.5.

Max relative change of critical radius
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Used to place a constraint on how fast the critical radium can vary, and thus put a limit on
time step. The default is 0.1.

Min radius for a nucleus to be considered as a particle
The cut-off lower limit of precipitate radius. The default is 5.0E-10 m.

Max time step during heating stages
The upper limit of the time step that has been enforced in the heating stages. The default is
1.0 s.

Maximum relative solute composition change at each time step
Set a limit on the time step by controlling solute depletion or saturation, especially at the
isothermal stage. The default is 0.01.

Pause, Resume and Cancel Precipitation Calculations
Precipitation calculations are often complex simulations that take some time to complete.
Sometimes you may want or need to pause or resume a calculation, or make adjustments to
your compositions and start again. You pause and resume from the Precipitation Calculator
Configuration window.

To Pause and Resume a Job
1. Run the job (i.e. click Perform Tree). In the Scheduler, you can see the job listed and
in the Event Log you can follow the progress of the calculation.
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2. In the Project window, click the Precipitation Calculator node.
3. In the Configuration window at the bottom, click Pause. If there are intermediate
results available these will be listed in the Event Log.

4. When ready, click Continue to resume your calculations from the last time step or
click Discard to discard the calculation (then click Yes or No on the window that
opens).

To Cancel a Job
l

In the Scheduler window, right-click the job you want to cancel and select Cancel
Job.
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Plot Renderer
The Plot Renderer is where you define the settings and output results in a diagram that
displays in the Results window. The available Plot Renderer settings are based on the System
Definer and/or calculator activity node predecessors such as the Equilibrium, Scheil, Binary,
Ternary, and Property Model Calculators. Setting availability is also determined by the
calculation type as well as if you have the add-on Diffusion, Precipitation, or Process
Metallurgy Modules. If you used any of the templates, the Plot Renderer is automatically
added to the Project tree.
Configuration Settings
There are additional details for more advanced settings and the Add-on Modules:
Plotting Options, Diffusion Calculator Plot Renderer, and Precipitation
Calculator Plot Renderer

Plot Toolbar
Setting/Button

Description

Save Diagram

Save the plot diagram. From the Save window, choose the file type–png (the
default), jpg, ps, pdf, gif, svg, or emf. For PNG and JPG files you can also change the
image quality.
Saving and Printing the Output (Graphical Mode)

Show Triangular

Display the diagram in triangular form, with the X-axis along the base and the Y-axis
along the left side. Such a diagram is often useful if you want to plot the fractions of
two components in a ternary diagram.

Show Grid
Overlay a grid on the diagram.

Switch Axes
Show the plotting X axis variable on the diagram’s Y-axis, and the Y axis variable on
the diagram’s X-axis.
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Setting/Button
Retain Labels

Description
Toggle the default to keep labels displaying on the plot. By default labels are
retained.

Configuration Settings
Working with Plots and Tables
The following is an example of the Configuration window for a Plot Renderer that is the
successor to a Property Model Calculator. For some specialized calculators there is
additional functionality available and described with the individual topics.

Plot Settings: TTT Mode, Diffusion Calculator Plot Renderer, and Precipitation
Calculator Plot Renderer
Also see Working with the Process Metallurgy Module for additional detail for the
Process Metallurgy Calculator.
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Examples of Calculation Type Differences

Grid
If you choose a Grid Calculation Type, select a Plot type and whether to Interpolate the
data or not. With these calculation types you can choose to plot a Heat map, Contour or 3D
diagram. See Heat Map, Contour and 3D Plots.
For a Grid the X- and Y-axes always represent the quantities that define the calculation axes,
but you need to set a variable for the Z-axis (the axis perpendicular to the plane defined by
the X- and Y-axes).

Uncertainty
For an Uncertainty Calculation Type, you choose an Axis type: Frequency, Histogram or
Normal probability.
There are different axis types available such as Linear, Logarithmic, Logarithmic 10, and
Inverse.

Settings
The options along the top of the window are available for many of the calculation types (e.g.
Phase diagram, One-axis, Min/Max, Uncertainty and so forth).

Tie-lines
Select how many tie-lines to be plotted in the diagram. Every nth number of tie-line is
plotted, where n is the number set here. Consequently, the higher the number, the fewer the
number of plotted tie-lines in the diagram.
This setting is not available if the Plot Renderer is a successor to an Equilibrium
Calculator where only one axis is defined and varied (that is, an Equilibrium
Calculator that has performed a stepping calculation).

Legend option
Select whether the diagram’s legend displays the Stable phases, the Axis quantity, or
choose Off for no legend.

Legend style
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You can select a Legend style for the Stable phases or Axis quantity selected for Legend
option. Choose None, All, Constitution description, or Ordering description.
About Legend Styles

Grouped mode or Flexible mode
For a One axis Calculation Type, the Grouped mode or Flexible mode available on the Plot
Renderer help you more easily define the plot quantities.
l

l

Use Grouped mode to add and configure groups of axis quantities at the same time
and of the same type. For example, change units or settings in groups with similar
settings like temperature units or axis types.
Use Flexible mode to individually add and configure axes quantities and change the
units or other associated settings one at a time.
Plot Settings: TTT Mode

Plot type (Grid)
These settings are for a Grid Calculation Type.
Heat Map, Contour and 3D Plots
l

l

l

On a Heat map diagram, each Z-axis variable value in the grid is represented by a
colour-coded area, where dark red represents the highest Z-axis variable value and
dark blue represents the lowest Z-axis variable value.
On a Contour diagram, Z-axis variable values are traced with curves in the same
way that height values are traced with curves on a topographical map. The colors
used originate from the different data series.
On a 3D diagram, the 3D surface is created by Delaunay tesselation of the calculated
data. The surface uses a cold to warm color map where red represents the highest Zaxis variable value and blue represents the lowest Z-axis variable value. The color
map color legend can be turned on or off with the legend option.

Interpolate (Grid)
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From the Interpolate list, choose to interpolate data Never (the default), Once, Twice or 3
times. This means points are put in between calculated points in the grid and interpolated
instead of calculated in the calculation engine.
Choose how many points of data to interpolate to improve curve smoothness – Never,
20x20, 50x50, or 100x100. Try different settings for your own set of data.

Label decimal digits
Choose the number of decimal digits to display in the plot label. The default is 2.

Label number format
Choose from Auto (the default), Decimal or Scientific.

Axis variable
Set the state variable you want plotted along the X-axis and the Y-axis.
If the stepping/mapping variables are changed in the Equilibrium Calculator
that precedes the Plot Renderer, then the variables to be plotted along the
diagram’s X- and Y-axis are automatically updated to the appropriate quantities.

Axis type
Select the type of axis scale: Linear, Logarithmic, Logarithmic 10 or Inverse.

Automatic scaling
The Automatic scaling check box is selected by default to allow the program to set the
limits.

Limits
This setting is available when the Automatic scaling check box is cleared (the scaling is
turned off).
Enter the lower and upper Limits of the variables to display on the axis. You can also
determine the step size between the tick marks along each axis.
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If the Automatic scaling is turned off (i.e. the check box is not selected) then it
is important to enter a large enough number in the step field for the numerical
values to display correctly on the axis. That is, if the step size is too small, the
program ignores this setting and the axis labels will not be as expected.

For logarithmic axes, the step size is related to the exponent. For example, if the
step entered is 1.0, then the exponent increases by one each time (10-9, 10-8,
10-7 and so forth).

Contour values and Use custom contour values (Z-axis, contour plots).
The Use custom contour values check box is available when Contour is selected as the Plot
type. Select this check box to enter one or a series of numbers in the Contour values field.
Numbers can only be separated by a space.

Add an axis and Remove this axis buttons
Use the Add an axis and Remove this axis buttons to add additional X- and/or Y-axes to
a plot or to merge plots (to overlay one plot with another in the same diagram). When
merging plots, you define this variable as the Z-axis.
Plotting Options

Slag Property Options (Process Metallurgy)
For the Process Metallurgy Calculator when you are selecting axis variables on the Plot
Renderer, there is the option to choose Slag property. The associated quantity that you
select from the next drop-down list has these options to choose: All, B2, B3, B4, Bas2, Bells
ratio, Ls , or Log10 (Sulphur capacity).
Also choose In liquid slag only, In solid slag only or In all slag.
References and equations for these properties are described in Process Metallurgy
Slag Properties.

Unit (Process Metallurgy)
For the Process Metallurgy Calculator select a Unit for the quantity to plot: Tonne,
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Kilogram, Gram or Pound

Plot Settings: TTT Mode
Configuration Window Settings and Configuration Settings
About the Steel Property Models
Use TTT mode to define the Temperature on the y-axis and Time on the x-axis for all
selected quantities. The TTT mode is available for a Plot Renderer when it is a successor to
a Property Model Calculator that meets the following requirements:
l

l

If you are using both the Martensite temperatures and Pearlite Property Models
together this mode is available. These models also require specific maintenance and
database licenses.
A One axis Calculation Type is selected.

An example of when to use TTT mode is to configure the Temperature Unit and Axis type at
the same time for both the Ms and Growth rate quantities. This mode is available when both
time and temperature quantities are selected and set up to plot a Time-TemperatureTransformation (TTT) diagram.
When you add the Steel Library - TTT Template this mode is set by default on the Plot
Renderer (renamed TTT in the template). It is also available if a user-defined Property
Model has both Time and Temperature quantities defined, for example if you create your
own Property Model with the Property Model Development Framework. That is, if you select
or create any model where the resulting combination of stepping-quantity and resultquantities has both time and temperature definitions.
Steel Library TTT Diagram Template

Diffusion Calculator Plot Renderer
Conditions Tab Settings and Configuration Settings
The following is information about the settings available in both Simplified and Advanced
mode for a Plot Renderer when it is a successor to a Diffusion Calculator.

Simplified Mode
When you open the Diffusion Calculator Plot Renderer, it defaults to Simplified mode. Use
this mode to define the most common axis variables. The software automatically sets the
correct Plot condition and Independent variable. Use the Advanced mode to have more
flexibility.
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When you click the Switch to advanced mode button, this expands the variable
options available from both the X-axis and Y-axis lists. Otherwise the axis
variables default to the most logical combination.

x-axis Variable
Select the variable for the x-axis: Distance or Time.
l

l

For Distance also choose a unit (m, μm, or nm) and what region to include. The list
contains the regions defined on the Diffusion Calculator or you can choose All
regions.
For Time choose a unit (Seconds, Minutes, Hours, or Days).

y-axis Variable
Select the variable to plot on the y-axis. The available options are based on choices such as
whether Distance or Time is chosen for the x-axis, whether isothermal or non-isothermal is
selected, whether there is a homogenization solver, or if there is one or more regions.

Distance along the x-axis
If Distance is plotted along the x-axis, then by default the Composition is plotted along the
y-axis.
l
l

From the center list, choose the component to plot, or select All.
From the next list, choose the unit to be Mass percent, Mole percent, Mass
fraction, Mole fraction, or u-fraction.

Time along the x-axis (one region)
If Time is plotted along the x-axis, then choose the y-axis variable to plot plus the additional
settings:
l
l

Total phase fraction: By volume or By mass. Then select a phase from the list.
Total fraction of element: By mole or By mass. Then select a component from the
list.
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l

l

Total fraction of element in phase: By mole or By mass. Then select a component
and a phase from the lists.
For a non-isothermal thermal profile Temperature is available: Kelvin, Celsius, or
Farenheit.

Distance along the x-axis (Homogenization)
If Distance is plotted along the x-axis and a Homogenization solver is being used, then
choose Composition or Phase fraction to plot on the y-axis. Then select the applicable
settings.
l

l

Choose the component to plot, or select All and the unit Mass percent, Mole
percent, Mass fraction, Mole fraction, or u-fraction.
Choose By mole or By mass then select a component from the list.

Time along the x-axis (two or more regions)
If Time is plotted along the x-axis, then choose the y-axis variable to plot plus the additional
settings:
l
l

l

l

Total phase fraction: By volume or By mass. Then select a phase from the list.
Total fraction of element: By mole or By mass. Then select a component from the
list.
Total fraction of element in phase: By mole or By mass. Then select a component
and a phase from the lists.
Composition at interface: Mass percent, Mole percent, Mass fraction, Mole
fraction. Then choose a Region and whether it is Upper or Lower and a component.

l

Position of interface: Choose a unit (m, μm, or nm) and the interface.

l

Velocity of interface: Choose a unit (m, μm, or nm) and the interface.

l

Width of region: Choose a unit (m, μm, or nm) and the interface.

l

For a Non-isothermal profile, Temperature is available. Choose a unit Kelvin,
Celsius or Fahrenheit.

Axis Type
Select the type of axis scale: Linear, Logarithmic, Logarithmic 10 or Inverse.

Limits
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Specify the range along the axis to show in the plot. In the fields, enter the minimum and
maximum values of the axis variable. You can also determine the step size between the tick
marks along each axis.
Select the Automatic scaling check box to allow the program to set the limits.

Time
An alternative Time setting is available in Advanced mode.
When the x-axis variable is Distance, choose a Time unit (Seconds, Minutes, Hours, or
Days). Enter a numerical value.

Add and Remove Axes
Use the Add an axis and Remove this axis buttons to add additional X- and/or Y-axes to
a plot or to merge plots (to overlay one plot with another in the same diagram).

Advanced Mode
Choose Advanced mode to access settings that enable you to manually select any
combination of axis variables, Plot condition and Independent variable. Examples of
advanced plot options are activity of a component at an interface, diffusivities, and diffusion
paths. Also user-defined functions can be used as plot variable where Console Mode syntax
is used to define functions. In some cases, sensible default values are selected, but they can
be changed according to your needs.

Plot Axis Settings in Advanced Mode
l

l

l

If any plot axis variable of the type Integral is selected, then the plot condition is set
to Integral and the Independent variable is set to Time.
If a plot axis variable is set to Time then the plot condition is set to Time and the
Independent variable is also set to Time.
If a plot axis variable is set to Distance then the plot condition is set to Distance or
Interface and the Independent variable is set to Distance.
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Plot condition
Time: Choose a unit
(Seconds, Minutes, Hours, or
Days). Enter a numerical
value.

Distance: Choose a specific
Region from the list or use
the default All regions.

Interface: From the lists
choose a Region and
whether it is the Upper or
Lower region.

Independent Variable settings based on the Plot
condition
The default is Distance: Choose a Global or Local distance. A Global
distance is counted from the rightmost interface of the system. A Local
distance is counted from the lower interface of the Region selected.
You can also choose Time, which requires no further settings.
The default is Time and there are no further settings.
You can also choose a Global or LocalDistance. A Global distance is
counted from the rightmost interface of the system. A Local distance is
counted from the lower interface of the Region selected.
The default is Distance: Choose a Global or Local distance. A Global
distance is counted from the rightmost interface of the system. A Local
distance is counted from the lower interface of the Region selected.
You can also choose Time, which requires no further settings.
The default is Time and there are no further settings.

Integral

You can also choose a Global or LocalDistance. A Global distance is
counted from the rightmost interface of the system. A Local distance is
counted from the lower interface of the Region selected.

Precipitation Calculator Plot Renderer
Conditions Tab Settings and Configuration Settings
The following is information about the settings available for a Plot Renderer when it is a
successor to a Precipitation Calculator.
There are also specific settings related to non-isothermal simulations that are detailed in
this topic.

Plot Settings
Legend option
Select whether the diagram’s legend displays On or Off.

Axis variable
Set the state variable you want plotted along the X-axis and the Y-axis. The available
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variables in the list are based on how your system is set up.
Below are additional details related to the Axis variable chosen.

Separate Multimodal PSD
If you choose Mean radius, Number density, Size distribution, or Number density
distribution, select the Separate multimodal PSD check box to enter settings for Points,
Excess kurtosis, Valley depth ratio and Minimum peak.
See Non-Isothermal Simulations for definitions.

Yield Strength
If you choose Yield strength, you can further define the model. From the Total yield
strength drop down list, select any or all the check boxes to plot the respective contributing
elements to the yield strength. You can click Configuration panel to fine tune the model.
These options are described for the Yield Strength Model. The greyed out sections (e.g. the
Matrix and Precipitate phases) are defined on the Precipitation Calculator and cannot be
changed.
The P_01: Isothermal Precipitation of Al3Sc example demonstrates the use of
this Yield Strength Model.

Axis type
Select the type of axis scale: Linear, Logarithmic, Logarithmic 10 or Inverse.

Limits
Specify the range along the axis to show in the plot. In the fields, enter the minimum and
maximum values of the axis variable. You can also determine the step size between the tick
marks along each axis.
Select the Automatic scaling check box to allow the program to set the limits.

Unit (Time X Axis)
Choose a Unit : Seconds, Hours, or Days.

Add an axis and Remove this axis buttons
Use the Add an axis

and Remove this axis

buttons to add additional X- and/or Y-axes to
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a plot or to merge plots (to overlay one plot with another in the same diagram). When
merging plots, you define this variable as the Z-axis.

Axis Variables
l

l

l

l
l

l

l

l

l

l

l

l

Mean radius: Spherical radius of average volume of all particles for a specific phase
and nucleation type, regardless of their actual shapes.
Critical radius: Spherical radius of critical nuclei for a specific phase and nucleation
type.
Yield strength: To use the Yield Strength Property Model to calculate yield stress. For
more information see About the Yield Strength Model.
Matrix composition: Instantaneous compositions of the matrix phase.
Precipitate composition: To track the instantaneous composition of precipitate
particles. In particular, it is useful to distinguish different composition sets of the
same phase (for example, FCC_A1#2 and FCC_A1#3). Further choose Solutes or All.
Number density: Instantaneous number of particles per unit volume for a specific
phase and nucleation type.
Size distribution: Number of particles varying with their sizes per unit volume per
unit length, for a specific phase and nucleation type, at a specific time.
Number density distribution: Retrieve the number density (number of particles per
unit volume) of precipitates distributed in different particle sizes.
Volume fraction: Instantaneous volume fraction for a specific phase and nucleation
type.
Nucleation rate: Instantaneous number of nuclei per unit volume per unit time for a
specific phase and nucleation type.
Normalized driving force: Instantaneous nucleation driving force per unit mole of
elements for a specific phase and nucleation type. It is normalized with RT and
therefore, dimensionless.
Mean cubic factor: Average cubic factor of cuboid particles. Available only when
cuboid is selected as the Morphology.

The following settings area available as indicated when Needle, Plate or Cuboid are
selected as the Morphology in the Precipitate Phase section on the Precipitation Calculator.
l

Cubic factor distribution: Variation of cubic factor with particle size at a specific
time. Available with a cuboid morphology.
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l

l

l

Mean aspect ratio: Average aspect ratio of non-spherical particles. Available with a
needle or plate morphology. Note that this is always larger than 1, where 1 = a
sphere.
Mean particle length: Diameter of non-spherical particles along the longer axis.
Available with a needle or plate morphology.
Aspect ratio distribution: Variation of aspect ratio with particle size at a specific
time. Available with a needle or plate morphology.

Non-Isothermal Simulations
When doing non-isothermal simulations it is common that particles grow in different
generations. This results in multi-modal size distributions. To correctly estimate the
properties of these different generations of particles you need to separate the peaks of
multi-modal distributions.

Separate multimodal PSD
When the Separate multimodal PSD check box is selected on a Plot Renderer activity for
the Precipitation Calculator, the size distribution is evaluated at the given time steps and
checked for multi-modal peaks. These are separated and used to calculate the specified
property.

It can be applied on the following plot properties:
l

Mean radius

l

Size distribution

l

Number density

l

Volume fraction

Points
This field is available when Mean radius, Number density or Volume fraction is selected as
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the Axis variable. Since the evaluation of multi-modality at each time step is costly, you can
specify how many evaluation Points to use. The points are geometrically distributed over
the time scale where nucleated particles are found. The default is 40 points.

Time
This field is available when Size distributionor Number density distribution is selected as
the Axis variable. Enter one or a series of numbers in the field, separated by a space.
For example, if you enter 100.0, 1000.0 and 1.0E7 in the field:

When you click Perform the times are plotted:

Excess Kurtosis
The Excess kurtosis number specifies the sensitivity when the program evaluates whether a
curve is bimodal or not. The evaluation process calculates the excess kurtosis of the given
size distribution and compares it with the input value. If the value is lower than the given
value, the distribution is split. The excess kurtosis is a statistical measure that measures how
peaked and how heavy tail a distribution has. For the definition used see
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http://en.wikipedia.org/wiki/Kurtosis. The default is 25.0.

Minimum Separation Limit (Valley Depth Ratio)
The Minimum Separation Limit is a rough method to prevent that noise or wiggles are
interpreted as different distributions. If a local minima is encountered above this value the
following peak is not interpreted as a new distribution. The valley depth ratio is the ratio of
the minimum separation limit to the peak value. The default is 0.01.

Minimum Peak
Any separated peak below the entered Minimum peak value is removed. The default is
100000.0.
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Table Renderer
A Table Renderer visualizes calculation results in a table. Several Table Renderer activities
(as well as Plot Renderer activities) can be shown in the Results window as different tabs.
You can add the Table Renderer directly (right-click a calculator node and select it from the
Create New Succesor menu) or use a variety of the available templates to automatically
add the node. For example, the Single Point Equilibrium and Quick Start templates.
For details about the templates, seeThe Quick Start Wizard and Templates and
Creating a Project from a Template.
You can only successfully tabulate the results of a single equilibrium calculation or a
stepping operation. The tabulated data from an equilibrium calculation is different from the
tabulated data from a stepping calculation. Examples are given below.
The settings are described in the section Configuration Settings.

Results from an Equilibrium Calculation
The following tab shows the result of an equilibrium calculation (from example T_01:
Calculating a Single-Point Equilibrium).
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For each stable phase listed, from the Composition and constitution menu you can select
the information to view. In this example, the maximum amount of information is shown and
includes details about both composition and constitution for BCC_A2#1.
The default for the Phase description detail can be changed globally. To open
the Options window:From the main menu select Tools → Options and click the
Activities tab. Then click Tabulation.

Results from a Stepping Operation
The Table Render 1 tab in the example shows the results of a stepping calculation (from
example T_02: Stepping in Temperature in the Fe-C System).
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Process Metallurgy Module Single Equilibrium
When you use a Process Metallurgy Calculator, there is a variety of additional information
you can display in the table such as the Slag properties (see Process Metallurgy Slag
Properties for equations and references) and the Actitivies.

For the activities in the table, you can hover over the Component and the syntax of the
activity displays.

Yield Strength Property Model
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The Yield Strength Model is available with the Property Model Calculator. After defining the
Model and adding a Table or Plot, the Total yield strength variable is available. The Yield
strength variable is also accessible via a Table Renderer (or Plot Renderer) that is a
successor to the Precipitation Calculator.
About the Yield Strength Model

An example of the variable results when yield strength is chosen as the Axis variable for a Table
Renderer that is a successor to the Property Model Calculator (top) or Precipitation Calculator
(bottom).

Configuration Settings
The Table Renderer settings are done on the Configuration window. Depending on what
calculator node the table is a successor to, you can have different settings available. For
most tables, this is where you set the level of detail for the columns as shown in the figure.

Save the Table
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To save all the data in a table as a plain text file (.txt), Hyper Text Marketup (.html), or Excel
(.xls) format, in the Configuration window click Save table or in the Results window rightclick in the table and select Save As.
To copy the data from a single cell of a table to the clipboard, right-click the cell and select
Copy. To copy the whole table to the clipboard, select Copy all.
The data saved is what is shown in the Table Renderer tab on the Results
window. If data is calculated but not displayed it is not saved.

Number of Decimal Digits and Number Format
The table results can be presented in ordinary decimal number format or with normalized
scientific notion. Choose Scientific or Decimal to increase or decrease the number of
Decimal digits used in the table. The default is 5 digits. The Number format defaults to
Auto to use the most appropriate format based on the tabulated data.
The defaults for these settings can be changed globally. From the main menu
select Tools → Options and click the Activities tab. Then click Tabulation.

Process Metallurgy Settings
For the Process Metallurgy Calculator there are additional settings available.

Choose a Temperature unit: Kelvin, Celsius or Fahrenheit.
Choose a Mass unit : Tonne, Kilogram, Gram or Pound.
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Select the All stable phases check box and choose Composition or Condensed from the list.
Select the Slag properties check box and choose the associated quantity from the next dropdown list: All, B2, B3, B4, Bas2, Bells ratio, Ls , or Log10 (Sulphur capacity).
Also choose In liquid slag only, In solid slag only or In all slag.
Details, including references and equations, are described in Process Metallurgy Slag
Properties.
Select the Activity check box then from the first list choose a component (or keep the
default All). Then from the second drop-down list select Reference solid oxide or Reference
liquid slag.
The activity is always given relative to a phase. The liquid slag is always the IONIQ_LIQ
phase. The composition set of ION_LIQ depends on the calculation and the slag always
contains a high amount of oxygen. The reference phase for the solid oxides depends on the
components and it is always listed in the table.

Precipitation Calculator with Yield Strength
When you use a Precipitation CalculatorPrecipitation Calculator and choose Yield strength
as an Axis variable, there are additional settings available.
If you choose Yield strength, you can further define the model. From the Total yield
strength drop down list, select any or all the check boxes to plot the respective contributing
elements to the yield strength. You can click Configuration panel to fine tune the model.
These options are described for the Yield Strength Model. The greyed out sections (e.g. the
Matrix and Precipitate phases) are defined on the Precipitation Calculator and cannot be
changed.
The P_01: Isothermal Precipitation of Al3Sc example demonstrates the use of
this Yield Strength Model.

Thermo-Calc User Guide: Graphical Mode ǀ 149 of 527

Thermo-Calc Documentation Set

Experimental File Reader
The Experimental File Reader activity node can only be created from the top My Project
node. This activity allows you to read an experimental data file (*.EXP). This type of file has
information specifying a plotted diagram, written in the DATAPLOT graphical language.
From this activity node you can plot the EXP file or save a copy of the file to another
location.
Creating Activities and Successors and Plotting Experimental Data Files in the
DATPLOT User Guide included with this documentation set.

How to Plot an Experimental Data File
1. Right-click My Project and from the Create New Activity submenu choose
Experimental File Reader.
2. In the Configuration window in the EXP file field, enter the name of the EXP file to
plot. Or click the Select Exp file
button to navigate to a location on the computer
to add the dataset.
3. Once the .EXP file is added, under Dataset Selection you can choose to include or
exclude specific datasets. Use the Select/Deslect all datasets check box as required.
4. Right-click the Experimental File Reader node and from the Create New Successor
submenu choose Plot Renderer.
If the source EXP file is changed, you can also click the Reload the selected EXP file
from disk
button to refresh the data. If you want to save or export the loaded file,
click the Save EXP file
button, then navigate to where you want to save it and
give it a file name.
5. In the Configuration window click Perform or right-click the Plot Renderer node
and select Perform.
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The Property Models
Property Model Calculator
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Coarsening Model
The Coarsening Model calculates the coarsening rate coefficient K (m3/s) of a spherical
precipitate phase in a matrix phase.
This Model requires that the thermodynamic and kinetic databases used include
descriptions of molar volume of the matrix and precipitates as well as mobilities
for the matrix phase.
For an example of a Coarsening Model, see PM_G_02: Coarsening and
Interfacial Energy.

Configuration Settings
The settings are found on the Property Model Calculator when the Coarsening Model is
selected under General models.

Click the Description tab for more information about the Model. When the
Property Model is not encrypted or it is a user-defined Property Model, there is
also a Python code tab that displays the related code.

l
l

Matrix phase: Choose a Matrix phase.
Precipitate phase: Choose a Precipitate phase to calculate its coarsening rate. Click
the Add phase button to add another Precipitate phase. Click the Remove phase
button to remove a phase.
Returns the coarsening rate coefficient [m3/s] for the precipitate phase and the
interfacial energy [J/m2] between matrix and the precipitate phase.
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Particle Coarsening
In the coarsening regime where the driving force is capillarity, the change of mean particle
radius evolves according to the equation:

Following Morral and Purdy [1994, Morral], the rate constant of precipitating β phase in a
multicomponent α phase is

The mobility matrix M is not the same as the mobilites that can be obtained directly from
the Diffusion Module (DICTRA). The M matrix instead corresponds to the L’’ matrix as
defined by Andersson and Ågren [1992, Andersson].
Using the u-fractions that is defined as

where the summation only is performed over the substitutional elements give the final
equation for the coarsening rate coefficient.

The interfacial energy σ is calculated using the extended Becker’s model (that also is
available as a separate Property Model Calculator model).

References
[1992, Andersson] J.-O. Andersson, J. Ågren, Models for numerical treatment of
multicomponent diffusion in simple phases. J. Appl. Phys. 72, 1350–1355 (1992).
[1994, Morral] J. E. Morral, G. R. Purdy, Particle coarsening in binary and multicomponent
alloys. Scr. Metall. Mater. 30, 905–908 (1994).
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Driving Force Model
The Driving Force model calculates the thermodynamic driving force for a phase.
For an example of a Driving Force Model, see PM_G_03: Driving Force and
Interfacial Energy.

Configuration Settings
The settings are found on the Property Model Calculator when the Driving force Model is
selected under General models.

Click the Description tab for more information about the Model. When the
Property Model is not encrypted or it is a user-defined Property Model, there is
also a Python code tab that displays the related code.

l

l

Matrix phase: Choose a Matrix phase, the single phase region to start in. Select 'Any
phase' to use the phases that take part of the initial equilibrium or choose a specific
phase.
Precipitate phase: Choose a Precipitate phase to calculate its driving force.
The calculation result is the driving force divided by RT.
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Equilibrium Model
The Equilibrium Model calculates the equilibrium for the given conditions.

When you use this Model with the Property Model Calculator, it is the same
calculation result as when you are using an Equilibrium Calculator with the
Single equilibrium calculation type.

Configuration Settings
The settings are found on the Property Model Calculator when the Equilibrium Model is
selected under General models.

Click the Description tab for more information about the Model. When the
Property Model is not encrypted or it is a user-defined Property Model, there is
also a Python code tab that displays the related code.

Define additional Quantity Definitions and Function Definitions. All quantities that
normally can be obtained from an equilibrium calculation can also be obtained when
plotting the results, as well as the defined functions.
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Interfacial Energy Model
Use the Interfacial Energy Model to estimate the interfacial energy between a matrix phase
and a precipitate phase using thermodynamic data from a CALPHAD database. The
approximation model is based on Becker's bond energy approach and is also available in
Precipitation Module (TC-PRISMA). In the actual calculation, the coefficients taken
distinguish between only bcc and fcc structure for the (110) and (111) lattice plane,
respectively.
For other planes and/or other phases, the estimate is approximate. In most situations, it is
recommended to perform calibrations against some experimental data because the
interfacial energy is dependent on so many factors that are ignored in the estimation, for
example entropy, incoherency, orientation, and curvature, etc. Uncertainty factors must also
be considered as thermodynamic data in CALPHAD databases are not always accurate.
For an example, see PM_G_02: Coarsening and Interfacial Energy.

Configuration Settings
The settings are found on the Property Model Calculator when the Interfacial energy Model
is selected under General models.

Click the Description tab for more information about the Model. When the
Property Model is not encrypted or it is a user-defined Property Model, there is
also a Python code tab that displays the related code.
Select the Matrix phase and Precipitate phase to return the interfacial energy [J/m2].

Thermo-Calc User Guide: Graphical Mode ǀ 156 of 527

Thermo-Calc Documentation Set

Estimation of Coherent Interfacial Energy
Interfacial energy is an important parameter used in precipitation simulations to calculate
the rates of nucleation, growth/dissolution, and coarsening. The value of interfacial energy
can vary dramatically (usually between 0.01 to 2.0 J/m2).
The extended Becker’s model functions to estimate coherent interfacial energy by using
thermodynamic data from existing CALPHAD thermodynamic databases:

where is the coherent interfacial energy, is the number of atoms per unit area at the
interface, is the number of cross bonds per atomat the interface, is the coordination
number of an atom within the bulk crystal lattice, and
is the energy of solution in a
multicomponent system involving the two phases being considered [1938, Becker].

Reference
[1938, Becker] R. Becker, Die Keimbildung bei der Ausscheidung in metallischen
Mischkristallen. Ann. Phys. 424, 128–140 (1938).
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Liquid and Solidus Temperature Model
The Liquidus and solidus temperature Model calculates the liquid phase. If only the
liquidus temperature is required, the calculation times are reduced.

Configuration Settings
The settings are found on the Property Model Calculator when the Liquidus and solidus
temperature Model is selected under General models.

Click the Description tab for more information about the Model. When the
Property Model is not encrypted or it is a user-defined Property Model, there is
also a Python code tab that displays the related code.

l
l

l

l

l

Only calculate liquidus temperature: Select this check box as required.
Liquid phase: Choose the liquid phase of the system. This is a fallback choice.
Normally this should be handled automatically, even if multiple liquid phases are
present.
Upper temperature search limit: Initial temperature for the liquidus calculation.
This needs to be in the fully liquid state.
Max. number of iterations: Maximum number of phase transformation iterations
performed. The default is 10.
Global minimization for liquidus and Global minimization for solidus: Select one or
both of these check boxes to find all phases present in the equilibria. However, note
it significantly increases the calculation time.
l

Global minimization recommendation: First try to calculate without
global minimization, then if inaccuracies occur, switch global
minimization on. Problems mostly occur if many phases are present at a
given temperature.

l

Suspend gas phase: The occurence of a gas phase may mislead the liquidus
temperature determination. If the presence of the gas phase is absolutely required,
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you can activate it and then choose a user-defined phase.
l

Gas phase: Choose a phase from the list.
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Phase Transition Model
By varying set conditions, the Phase Transition Model calculates the point when a new
phase may form. The Model is useful to determine melting temperature, boiling
temperature or solubility limits. It returns the phase transformation temperature, or
composition, depending on the varied condition.
For an example see PM_G_01: Phase Transition.

Configuration Settings
The settings are found on the Property Model Calculator when the Phase transition Model
is selected under General models.

Click the Description tab for more information about the Model. When the
Property Model is not encrypted or it is a user-defined Property Model, there is
also a Python code tab that displays the related code.

Define the:
l

l

l

l

Matrix phase: The single phase region to start in. Select 'Any phase' to use the
phases that take part of the initial equilibrium or choose a specific phase.
Phase to form: For the new phase to be formed, select 'Any phase' or choose a
specific phase.
Condition to vary: Choose whether to vary a composition or temperature condition
when calculating the phase transition.
Search direction: For the composition or temperature condition being varied, choose
the Search direction to be in a Positive, Negative, or Positive and Negative
direction.
The start value (given in Condition Definitions) and phase transition point need
to be within these limits, otherwise the model returns Not a Number as result.
For example, a start temperature is 1100 K then the limits need to be outside
these, e.g. 500-1500.
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About the Yield Strength Model
The settings for these contributions are found on the Property Model Calculator
when the Yield Strength Model is selected under General models.
Yield strength is also available as a variable when working with Plots and Tables
that are successors to the Precipitation Calculator.
The Yield Strength Model is a general model to estimate the yield stress of a material that
considers these contributions to the overall yield stress of the material:
l

Intrinsic strength ( ) for the pure elements,

l

Grain boundary strengthening (

l

Solid solution strengthening (

l

Precipitation strengthening ( ), and

l

A user set, constant strength contribution ( ).

),
),

The temperature ( ) is used to evaluate the equilibrium state of the system, and the
resulting compositions and phase fractions are subsequently used in the evaluation of
mechanical properties. Below follows a short summary for each of the contributions.

Intrinsic Strength
Intrinsic strength, , is the base strength as evaluated from linear combination of the pure
elements' strength. If data is missing for one or more elements a message displays in the
software to indicate this.

Constant Addition of Strength
The parameter

is set by the user as a constant strength addition to the material.

Grain Boundary Strengthening
The grain boundary strengthening,
, is the contribution to the total strength stemming
from the grain boundary's ability to hinder dislocation movement described by the HallPetch relation [2004, Hansen].
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The parameters you enter are the Hall-Petch constant,
grain diameter in μm.

in MPa μm1/2, and the average
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Solid Solution Strengthening
PM_G_06_Yield_Strength_HEA
The solution strengthening,
, is the contribution to total strength due to the elastic
strains in the crystal lattice caused by alloying elements of a lattice parameter differing
from the main constituent. For the solid solution strengthening the option of evaluating the
strength at any temperature is available. The result is normalized with respect to the sum of
all mole fractions for FCC, BCC and HCP. This option uses the phase fractions and
compositions calculated at the overall equilibrium temperature. The model by Walbrühl et
al. [2017, Walbruhl] is implemented.
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Figure 5: Yield strength vs Ta-content for the binary high entropy Mo-Ta alloy.
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Precipitation Strengthening
The precipitation strengthening, , is the contribution to total strength due to
precipitation of a secondary phase, e.g. gamma prime in Ni-base alloys or Al3Sc precipitates
in Al-base alloys. This model is available for any number of precipitating phases. The
Simplified model (general), Seidman model (Al-base) and Reppich model (Ni-based) are
available to estimate the precipitation strengthening contribution.

Simplified Model (General)
PM_G_04_Yield_Strength
The simplified model is based on the work by Zander et al. [2008, Zander] and considers the
general mechanisms of cutting and looping without regard to any detailed dislocation
mechanisms. The default parameters are, however, optimized against experimental data for
the Al-0.3wt%Sc alloy described by Seidman et al. [2002, Seidman].
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Figure 6: Yield strength Property Model plot example using the 'Simplified model' as described in the
text.

Seidman Model (Al-base)
PM_G_04_Yield_Strength
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The Seidman model (Al-base) by Seidman et al. [4] considers several contributions to the
overall precipitation strengthening - ordering, coherency stresses, shear modulus mismatch,
and Orowan looping. The Seidman model is suitable for Al-base alloys with a low volume
fraction of spherical precipitates. In example PM_G_04_Yield_Strength, the simplified and
Seidman models are compared to experimental data on the increase in yield strength due to
precipitation hardening. Although the experimental set up was designed to eliminate grain
boundary and solid solution strengthening, these are also included by optimizing of model
parameters.

Figure 7: Yield Strength Property Model plot example using the 'Seidman model' as described in the
text [2002, Seidman].

Thermo-Calc User Guide: Graphical Mode ǀ 167 of 527

Thermo-Calc Documentation Set

Reppich Model (Ni-base)
PM_G_05_Yield_Strength_NiAlCr
The Reppich model (Ni-base) by Reppich et al. [1982a, Reppich] considers both weak and
strong coupling of dislocation as they propagate through an ordered secondary phase and is
thus suitable for Ni-base alloys with relatively high volume fractions of gamma prime or
gamma double prime.

The Reppich model is not valid for very small values of volume fraction
precipitate and precipitate radius.

Figure 8: Reppich model plotted with results and experimental data for PE16 [1982b, Reppich] , all
data is normalized with the square root of the volume fraction of precipitate.
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Figure 9: Reppich model yield strength vs mean precipitate radius for Ni-10Cr-10Al.
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Yield Strength Model
About the Yield Strength Model
The Yield strength Model is available with the Property Model Calculator and calculates
yield stress.
Yield strength is also available as a variable when working with Plots and Tables
that are successors to the Precipitation Calculator.
The Yield Strength Model returns the yield strength at room temperature for the specified
material using the equilibrium values calculated at temperature T. The Model is defined by
further setting these contributions:
l

Intrinsic strength ( ) contribution

l

Solid solution strengthening (

l

Grain boundary strengthening (

l

Precipitation strengthening ( )

l

Constant strength addition ( )

)
)

For examples using the Property Model Calculator, see PM_G_04_Yield_
Strength, PM_G_05_Yield_Strength_NiAlCr, and PM_G_06_Yield_Strength_HEA.
For an example when it is available as an axis variable with the Precipitation
Calculator, see P_01: Isothermal Precipitation of Al3Sc.

Configuration Settings
The settings for these contributions are found on the Property Model Calculator when the
Yield strength Model is selected under General models.
There are settings described elsewhere when Yield strength is selected as an
axis variable for a Plot Renderer or Table Renderer that are successors to the
Precipitation Calculator.
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Click the Description tab for more information about the Model. When the
Property Model is not encrypted or it is a user-defined Property Model, there is
also a Python code tab that displays the related code.

General Model Settings
Composition unit
Choose a unit: Mass percent, Mole percent, Mass fraction or Mole fraction.

Condition Definitions
Choose a unit (Kelvin, Celsius or Fahrenheit) and then enter a value for the Temperature
and Composition for each component.
The values entered in Condition Definitions are used as the start values for the different
calculation types.

Yield Strength Model Settings
Matrix
Matrix: Choose a Matrix phase.

Solid solution strengthening evaluation temperature
Click to select the Solid solution strengthening evaluation temperature check box to
further define this model.
Then enter a Solid solution strengthening temperature in the field. The unit of
temperature is the same as that selected above under Condition Definitions.
If no temperature is entered, room temperature is used.

Grain boundary strengthening
Click to select the Grain boundary strengthening check box to include calculated grain
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boundary strengthening (

). Then enter the following settings.

Grain size: The grain diameter in μm.
Select the User defined Hall-Petch coefficient check box to enter the Hall-Pletch
coefficient:
in MPa μm1/2.

Precipitation strengthening
Click to select the Precipitation strengthening check box to include calculated precipitation
strengthening ( ). Then enter the following settings.
Select a Precipitate from the list. Use the Add
additional precipitate phases.

and Remove

buttons to add and remove

The Precipitation Module (TC-PRISMA) has additional advanced functionality
when you are working with the Precipitation Calculator and add a Plot Renderer
or Table Renderer with Yield strength as a plot variable.

The precipitation strengthening contribution ( ) is calculated by one of these models:
Select a Precipitation strengthening model from the list:
l

Simplified model (general)

l

Seidman model (Al-base): Preferentially used for Al-based alloys.

l

Reppich model (Ni-base): Preferentially used for Ni-based alloys.

The Reppich model is not valid for very small values of volume fraction
precipitate and precipitate radius.

For the Simplified model (general), enter values in the fields for the following. The default
values of kp and are optimized against experiments for Al-Sc.
l
l

Mean radius Simplified model: The precipitate mean radius. The unit is meter (m).
kp: The prefactor for the simplified model, which adjusts the overall height of the
yield strength curve.

Thermo-Calc User Guide: Graphical Mode ǀ 173 of 527

Thermo-Calc Documentation Set

l

Critical radius , which determines the mean precipitate radius where transition
between cutting and looping occurs. The unit is meter (m).

For the Seidman model (Al-base), enter values in the fields for the following. The default
parameters are optimized against experiments.
l

l

l

l

Mean radius Seidman model: The precipitate mean radius. The unit is meter (m).
Anti-phase boundary energy:
, which is the average anti-phase boundary
energy for the precipitate phase. The unit is Jm-2.
m: A Seidman exponent, it is a constant in the expression for strengthening by
modulus mismatch.
alpha: A Seidman prefactor. It is a fitting constant in the expression for coherency
strengthening.

For the Reppich model (Ni-base), enter values in the fields for the following. The default
parameters are optimized against experiments.
l

l

l

l

Mean radius Reppich model: The precipitate mean radius. The unit is meter (m).
Anti-phase boundary energy:
, which is the average anti-phase boundary
energy for the precipitate phase. The unit is Jm-2.
w: A parameter that accounts for elastic repulsion between strongly coupled
dislocations.
A: Numerical factor reflecting particle morphology (0.72 for spherical).

Constant strength addition
Enter a value for the Constant strength addition,

. The unit is MPa.

Equilibrium minimization strategy
Select an Equilibrium minimization strategy.
The Minimization strategy setting is used to ensure that the most stable minimum under
the specified conditions is computed. The default uses the Global test preferred option.
With either the Global or Local preferred setting, the program cycles through options before
it gives up:
l

For Global test preferred the minimization starts with a global test and if that fails it
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runs full global minimization.
l

For Local minimization preferred the minimization starts with a local minimization,
in case of failure it tries a global test and finally a full global minimization.

If you choose Local minimization only or Global minimization only, the program just tries
the one setting and gives up if it fails.
For general information about global minimization, see the topic related to the
Console Mode command, GLOBAL_MINIMIZATION.
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Calculation Type Settings
Calculation Type
Choose a calculation type: Single (no axes), One axis, Grid, Min/Max or Uncertainty.
l

Select Single to calculate a single point. Any model can use this calculation type and
no additional settings are required. The results from this calculation are displayed in
the Event Log or if a Table Renderer is used, in the Results window.
Equilibrium Model

l
l

l

l

Select One axis to vary a quantity on the X-axis.
Select a Grid to evaluate two axis variables of the selected quantities in the specified
range and number of steps.
The Min/Max calculation evaluates the Property Model(s) for all variations of the
selected quantities at the given limits. The Mean field is as defined under Condition
Definitions for the respective quantity. The total minimum and maximum of the
model(s) results are shown in the Event log.
The Uncertainty calculation evaluates the Property Model(s) where the values of the
quantities are sampled from Gaussian distributions. The Mean field is as defined
under Condition Definitions for the respective quantity. The result is visualized as a
histogram or normal probability plot by adding a Plot Render activity.

Axis Definition
For One axis, select a Quantity to vary along the X-axis, for example, Temperature then
enter a Min, Max and Number of steps.

Grid Definition Settings
Grid Definitions
For the Grid calculation type, define the two axes variables using the fields and menus:
Quantity, Min, Max and Number of steps. The number of steps along with the minimum
and maximum values for the axes define a grid. For each grid point the selected models are
evaluated.
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For a Grid, on the Plot Renderer, you can choose to plot a Heat map, Contour or
3D diagram.
Heat Map, Contour and 3D Plots

Min/Max Definitions
For the Min/Max calculation type, click to select the applicable check boxes under Quantity
to enable or disable an axis. The Mean field is as defined under Condition Definitions for
the respective quantity.
Enter numerical values in the ΔMin/Max fields to evaluate the change to the quantity. The
highest and lowest value of each selected model results are shown in the Event Log.

Sampling of Data from Gaussian Distributions
For the Uncertainty calculation type, click to select the applicable check boxes under
Quantity to vary this quantity. The Mean field is for the distribution function as defined
under Condition Definitions for the respective quantity. The default ΔMin/Max is a 95%
confidence interval.
About the Uncertainty Calculations

Sampling Parameters
For the Uncertainty calculation type, choose a number of Standard deviations where you
want to Truncate the distribution. Choose the Total number of samples.
About the Uncertainty Calculations
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Martensite Fractions Model
To run calculations with the Steel models (Martensite and Pearlite) requires a
valid maintenance license plus licenses for both the TCFE (version 9 and higher)
and MOBFE (version 4 and higher) databases.

For an example see PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing.
The Martensite Fractions Model calculates fraction of athermal martensite based on an
analytical equation derived in Huyan et al. [2016, Huyan]. It is assumed that the first forming
martensite morphology is the only forming one. The first morphology is determined based
on the Ms-temperatures of all morphologies. This model is part of the Steel Model Library.
Quantities to set in the Property Model Calculator:
l

l
l

l

Intercritical annealing: Select No if the specified composition is used directly; select
Yes to assume intercritical annealing. If you choose Yes, an equilibrium calculation is
performed at the specified temperature and the composition of the austenite phase
is used for the martensite temperature calculation.
Enter an Annealing temperature.
Grain size [μm]: Enter the grain size of the austenite phase in μm. By default 100 μm
is set. The Ms temperature and martensite fractions change for significantly smaller
grain sizes.
Parent phase Gibbs energy addition [J/mol]: Enter a value in J/mol to add a Gibbs
energy offset to the parent austenite phase. This can be used, for example, to correct
database offsets. The default is 0 J/mol.

Axis variables you can choose on the Plot Renderer for the conditions defined on the
Property Model Calculator:
l

Total martensite percentage

l

Retained austenite percentage

Reference
[2016, Huyan] F. Huyan, P. Hedström, L. Höglund, A. Borgenstam, A Thermodynamic-Based
Model to Predict the Fraction of Martensite in Steels. Metall. Mater. Trans. A. 47, 4404–
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Martensite Temperatures Model
To run calculations with the Steel models (Martensite and Pearlite) requires a
valid maintenance license plus licenses for both the TCFE (version 9 and higher)
and MOBFE (version 4 and higher) databases.

For an example see PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing
and PM_Fe_02: Fe-Mn Martensite Morphologies.
The Martensite Temperatures Model calculates the martensite start temperature (Ms)
based on modeling the transformation barrier with fitted analytical equations. The Model is
based on Stormvinter et al. [2012, Stormvinter] with subsequent update and extension by
Gulapura Hanumantharaju [2017, Gulapura] and Thermo-Calc internal assessment. The
partitionless equilibrium temperature T0 is calculated using the thermodynamic database.
The Model also gives temperatures corresponding to 50%, 90%, and 99% transformations.
Martensite fractions are calculated with the same algorithm as in the Martensite Fractions
Model. This Model is part of the Steel Model Library.
Steel Library TTT Diagram Template and Plot Settings: TTT Mode
Quantities to set in the Property Model Calculator:
l

l

l

Intercritical annealing: Select No if the specified composition is used directly; select
Yes to assume intercritical annealing. If you choose Yes, an equilibrium calculation is
performed at the specified temperature and the composition of the austenite phase
is used for the martensite temperature calculation.
Grain size [μm]: Enter the grain size of the austenite phase in μm. By default 100 μm
is set. The Ms temperature and thus the martensite fractions change for significantly
smaller grain sizes.
Parent phase Gibbs energy addition [J/mol]: Enter a value in J/mol to add a Gibbs
energy offset to the parent austenite phase. This can be used, for example, to correct
database offsets. The default is 0 J/mol.

Axis variables you can choose on the Plot Renderer for the conditions defined on the
Property Model Calculator:
l

Ms: Martensite start temperature

l

Lath Ms: Martensite start temperature of lath alpha or alpha-prime martensite
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l

Plate Ms: Martensite start temperature of plate alpha or alpha-prime martensite

l

Epsilon Ms: Martensite start temperature of epsilon martensite

l

M50: 50% martensite temperature

l

M90: 90% martensite temperature

l

M99: 99% martensite temperature

References
[2012, Stormvinter] A. Stormvinter, A. Borgenstam, J. Ågren, Thermodynamically Based
Prediction of the Martensite Start Temperature for Commercial Steels. Metall. Mater.
Trans. A. 43, 3870–3879 (2012).
[2017, Gulapura] A. K. Gulapura Hanumantharaju, Master's thesis, KTH Royal Institute of
Technology (2017).
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Pearlite Model
To run calculations with the Steel models (Martensite and Pearlite) requires a
valid maintenance license plus licenses for both the TCFE (version 9 and higher)
and MOBFE (version 4 and higher) databases.

With the TCFE9 and TCFE10 database, the included elements in the pearlite
model are Fe (dependent element), C, Mn, Cr, Mo, W, Si, Al, Ni, Co. Other
elements are neglected by weight percent.
For an example see PM_Fe_03: Fe-C-Mn Pearlite.
Steel Library TTT Diagram Template and Plot Settings: TTT Mode
The Pearlite Model [2020, Yan] describes the thermodynamics and kinetics of pearlite
formation from austenite. It is assumed that the overall composition of pearlite is the same
as the austenite composition (system composition), and growth rate is constant over time.
Growth rate and lamellar spacing of pearlite are determined by a criterion where either
growth rate or Gibbs energy dissipation rate is maximized. The Model considers Gibbs
energy dissipation due to formation of ferrite-cementite interface in pearlite, finite
austenite-pearlite interfacial mobility, solute drag [1962, Cahn], and diffusion of elements
within austenite and along austenite-pearlite interface.
Pearlite growth with preexisting ferrite or carbide or any other phase is not
considered. Divergent pearlite, of which growth rate and lamellar spacing
change with time, is not considered. This Model only considers the
transformation from FCC_A1 phase to pearlite consisting of BCC_A2 and
CEMENTITE. Pearlite with other phases is not implemented.
Pearlite is assumed to nucleation on austenite grain boundaries. Grain boundary nucleation
rate is modeled as a function of composition and temperature. The isothermal
transformation kinetics follows Cahn [1956, Cahn]. Start, half, and finish times are taken as
2%, 50%, and 98% transformation, respectively.
Model parameters have been determined from published data of maximal growth rate,
minimal lamellar spacing, partition coefficients, and isothermal transformation kinetics in
ternary and multicomponent systems. This Model is part of the Steel Model Library.
Quantities to set on the Property Model Calculator:
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l

Criterion:
l Maximize growth rate: Pearlite growth rate is maximized with respect to
lamellar spacing (and for optimal pearlite, partition coefficients of
substitutional alloying elements between ferrite and cementite). The
calculation gives maximal growth rate and minimal lamellar spacing. This is
the default criterion.
l

l

Pearlite mode:
l Optimal pearlite: The partitioning of substitutional alloying elements
between ferrite and cementite is optimized according to the Criterion while
keeping carbon equilibrium between the two phases. This is the default mode.
This mode realizes a smooth transition between ortho-pearlite and parapearlite.
l

l

l

Maximize Gibbs energy dissipation rate Gibbs energy dissipation rate is
maximized with respect to lamellar spacing (and for optimal pearlite,
partition coefficients of substitutional alloying elements between ferrite and
cementite). The calculation gives a smaller growth rate than the maximal,
and a larger lamellar spacing than the minimal, which may better represent
the average growth rate and lamellar spacing of all pearlite colonies in the
material.

Para-pearlite: Ferrite and cementite are in para-equilibrium where
substitutional alloying elements do not partition and carbon reaches
equilibrium.
Ortho-pearlite: Ferrite and cementite are in ortho-equilibrium.

Grain size [μm]: Enter the austenite grain size in μm. By default 100 μm is set.

Axis variables you can choose on the Plot Renderer for the conditions defined on the
Property Model Calculator:
l

Growth rate

l

Lamellar spacing

l

Cementite molar fraction in pearlite

l

Driving force of pearlite formation

l

Start time (2% pearlite)

l

Half time (50% pearlite)

l

Finish time (98% pearlite)

References
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About the Process Metallurgy Module
All users can test the Process Metallurgy Module with the included OXDEMO
database, which is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For
more information about this and other products visit our website.

The Process Metallurgy Module requires both a valid Maintenance and Support
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database
(TCOX8 or newer).
The Process Metallurgy Module is an Add-on Module to Thermo-Calc and it is available in
Graphical Mode as the Process Metallurgy Calculator. The Add-on Module is designed to
model reactions that occur in metallurgical processes. Although primarily used in
steelmaking and steel reﬁning processes (such as basic oxygen furnaces, electric arc
furnaces, ladle furnace metallurgy and so forth), applications are not limited to steelmaking.
There are two main branches of calculations possible: Equilibrium and Process simulation.
Equilibrium calculations do not consider any kinetics, the process simulation includes
reaction kinetics.
In general, for both types, the main difference compared to using a standard Equilibrium
Calculator is that it is easy to handle the different materials present in a metallurgical
process. The materials used in the process can be pre-defined, saved and used for the
equilibrium calculations. Metallic materials can be defined in element weight percent, oxide
materials in weight percent of oxide components, the gas phase in volume percent of gas
components and its amount can be defined in normal cubic meters, and so forth. In principle
this can be done in a standard Equilibrium Calculator. However, it is much easier when using
the Process Metallurgy Calculator as this is designed for this specific purpose.
When using the Equilibrium branch of calculations, both isothermal and adiabatic
calculations are possible. Adiabatic calculations assume no heat and mass exchange with the
environment during the equilibrium reaction, meaning that the temperature changes as a
result of exothermal or endothermal reactions taking place.
For a Process simulation branch of calculation, the reaction kinetics of the process are
considered. This is done by dividing the system into zones. Typically one would have one
steel zone containing liquid metal and a slag zone containing liquid oxide (slag). The kinetic
model assumes that only a fraction of the steel zone reacts with a fraction of the slag zone
per time step. This reacting fraction of the whole system is termed the reaction zone (in
literature it has become known as Effective Equilibrium Reaction Zone or EERZ).
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You can use the Process Metallurgy Module to calculate the following:
l

The equilibrium between custom-defined steels, slags and gasses.

l

The equilibrium between other metallic and non-metallic phases.

l

Desulfurization, dephosphorization, and decarburization.

l

Any partition coefficient, for example the partitioning of sulphur between the liquid
steel and slag phase.

l

Slag characteristics, such as slag basicity or sulphur capacity.

l

The fraction of liquid and solid in the slag.

l

The temperature change in an adiabatic process.

l

Kinetics of the reaction between phases. Typically this is the reaction between a
liquid metal and slag phase, but it could also be the reaction between a solid oxide
and slag (simulation of refractory wear) or between a solid metal and liquid metal
(simulation of dissolution of alloy), etc.

Thermo-Calc User Guide: Graphical Mode ǀ 187 of 527

Thermo-Calc Documentation Set

Setting Up a Process Metallurgy Simulation
The following basic steps need to be carried out to set up calculations in the Process
Metallurgy Calculator. There are three branches of simulation to choose from on the
Configuration window when setting up the simulation (1) an isothermal equilibrium
calculation (2) an adiabatic equilibrium calculation and (3) a process simulation.

Examples of using the Process Metallurgy Calculator for Basic Oxygen Furnace
(BOF) (with and without kinetics), a Ladle Furnace (LF) simulation, and an Argon
Oxygen Decarbarization (AOD) simulation are included with your installation.
See the Process Metallurgy Module Examples Collection for links.

Thermo-Calc User Guide: Graphical Mode ǀ 188 of 527

Thermo-Calc Documentation Set

The three branches of simulations available for the Process Metallurgy Calculator (1) an isothermal
equilibrium calculation (2) an adiabatic equilibrium calculation and (3) a process simulation.

Equilibrium Simulations
Two Equilibrium simulation types are available, Isothermal and Adiabatic. In general for
the equilibrium simulation, the three most common material groups—Steel, Slag and Gas
are automatically included with the default composition input types that are relevant to
each material group. You can add materials and save your material compositions right from
the Process Metallurgy Calculator and quickly access these for other simulations. For
example, you might want to predefine compositions of steels, ferro-alloys, slags, and slag
additions. The overall composition of the steel and slag is then obtained by adding amounts
of these predefined materials.
Each group of materials is automatically added to the similar group where it is defined. You
can manage these groups using the Material Manager (see Working with the Material
Manager).
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For adiabatic calculations, the selection of material type (steel, slag, gas) has an
influence on the calculation. For isothermal calculations, the results are
identical.

The reason the selection of materials for adiabatic calculations has an influence is because
there are different strategies to calculate the enthalpy of the materials at the temperature
at which these are added. Therefore, defining FeO as a steel containing 50at% Fe and 50at%
O or as a slag with 50at% Fe and 50at% O or as slag with 100% FeO, all result in different
enthalpies assigned to the component FeO, which in turn results in different equilibrium
temperatures.
Defining the Equilibrium Simulation
Equilibrium Simulation: Conditions Tab
Adiabatic Calculations: Material Enthalpy

Process Simulations
When you choose to do a Process simulation it includes the reaction kinetics. Using the
EERZ (Effective Equilibrium Reaction Zone) model, you can first define your materials as you
do with an Equilibrium simulation. You also need to define the Process model where you
define the kinetic parameters of the simulation by setting up reaction zones, reaction rates,
heat transfer coefficients and so forth. You also need to define the Process schedule where
the sequence and amounts of added materials are defined.
Defining the Process Simulation
Process Simulation: Conditions Tab

Calculation Types
The calculations available for an Equilibrium simulation, for both isothermic and adiabatic
calculations, are Single equilibrium, One axis, Grid and Uncertainty. After adding a Plot
Renderer or Table Renderer, you can choose a variety of quantities, including slag
properties such as Bells ratio and B2, to output results that provide useful visual
representations of the steelmaking systems you are analyzing.
Process Metallurgy Calculator and Defining the Equilibrium Simulation
There are example project files included and some of these examples are also
explained in video tutorials available on our website and YouTube channel.
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Working with the Process Metallurgy Module
Working with the Process Metallurgy Calculator allows you to easily define complex
metallurgical reactions. The calculator streamlines how you set up these steel and slag
systems but there are details about various inputs and outputs that are different from other
calculators. This topic is a general collection of information related to the Process
Metallurgy Module and is intended to help you better understand how to interpret and make
choices when you are setting up your steelmaking simulation.

Database Dependency
It is not possible to use custom user databases with the Process Metallurgy
Module. This is because several internal calculations, such as determining the
component compositions of ionic phases, are dependent on the database.
Therefore, only TCS Metal Oxide Solutions Database (TCOX) versions 8 and
newer, and to a limited extent, OXDEMO, can be used with this Module.

Working with Material Groups (Steel, Slag and Gas)
For more details about these fields, see Defining the Equilibrium Simulation.
For information about saving and deleting materials, see Working with the Material
Manager.
There are three groups to define: Steel (or another user-defined Metal group), Slag and
Gas.
It is recommended you open the PMET_01: Basic Oxygen Furnace (BOF)
example to follow along with the descriptions.

Open the example project file from Thermo-Calc Help → Example Files →
Process Metallurgy → PMET_01_Basic_Oxygen_Furnace.tcu.
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In the image below, the red-highlighted area is where the Steel material group is defined.
The drop-down menu that displays Steel_BOF shows a user-defined material. This can be
defined and then saved to the material library.

The three material group areas on the Process Metallurgy Calculator where you can define
components and save materials. You can create your own material groups using the Material
Manager.

When you click Show composition next to any material group, additional fields display for
giving composition and input type where you can further define each material group. You
can remove materials and add and remove material groups using the Material Manager
(available via the Tools → Options menu).
In the example, click Show composition next to the Slag and Gas groups to see how the
Slag_BOF and Oxygen materials are defined.
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From this composition area you can click the Save material button to add the new material
to the group's list. The newly named material composition is then available for use with that
material group. In this example, the Steel_BOF material was defined first and then named at
the end. It is now available in the lists wherever you select the Steel material or need to
choose quantities to plot.

After defining and saving a material composition, the named material is available for selection in a
variety of places such as when choosing quantities on the calculator and defining axis variables on
the Plot Renderer.

To add one or more material groups click the green add button. Click the red
minus button to remove a material group. The new material inherits the
default settings of that group.

Understanding the Grid Definitions Quantities and How These Relate
to the Composition
When you choose a One axis or Grid Calculation Type, you also choose a Quantity under the
Grid Definitions. The relationship between these quantities and how the material group
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composition is defined is as follows.
The following uses Composition of C in Steel_LF (STEEL) as an example quantity for a One
axis calculation.
Under Grid Definitions, the availability of the Quantity in the list is based on the material
(Steel_BOF) that is defined and saved for the Steel group (or any user-defined metal, slag or
gas group).

Defining the Material Composition
When you choose the Input type for a steel the composition of the elements can be set up
using a combination of settings starting with Mass or Mole percent, Mass or Mole fraction
or Absolute amount. Then you further choose to define the composition using either the
Major component or Normalize to total of 100% options.

The Amount of X in Y quantities you can choose from the various drop-down lists
(such as under Grid Definitions) are defined as Min-Max variation of the
component X in Y. If a dependent element is present that is adapted as usual.
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When you use Major component, as you add other components or adjust the composition,
the major one is adjusted to be the rest of the composition.

When you use Normalize to total of 100%, the sum is adapted to 100%. This is useful if you
need to work with a given composition that does not sum up to 100%.
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Sometimes its preferable to use input of amount of each component Amount by weight
(Tonne, Kilogram, Gram or Pound), it can useful to choose Absolute amount as the Input
type. In this case, the total amount of material automatically adjusts the total.

For the Gas component, if you choose Normal cubic meter as the Amount, then beside
regular mass units, the amount of gas can also be provided in Nm3.
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Phase Groups
The phases that are plotted after you run a simulation are grouped together on the plot to
make the interpretation of the results easier.
Phases of similar type are bundled together in the groups liquid metal, solid metal, solid
oxides, liquid oxides and gas. Except for the gas phase, all the groups can have more than
one phase. This grouping is particularly useful for liquid metal and liquid oxide because they
are both described by the same phase, IONIQ_LIQUID, and because there is typically two or
more compositions sets of IONIQ_LIQUID. This is also useful for solid oxides, because a large
number of phases can be stable, making the interpretation of results difficult without this
grouping.

Thermo-Calc User Guide: Graphical Mode ǀ 197 of 527

Thermo-Calc Documentation Set

The term oxides in the Process Metallurgy Module can also mean carbides,
sulfides and fluorides.

Example of the plot labels with the phases grouped together. As you zoom in, only the phases that
you can see are listed in the label, making it easier to examine the results.

Slag Property Quantities
The slag properties are describing the capability of a slag to take up sulphur from the metal
melt. The Process Metallurgy Module defines so-called phase groups. They contain all
phases of a certain kind, for example all solid slag or all slag phases. The component
composition of such a phase group is calculated by weighting the component composition of
each phase with their fraction in the group.
This allows to calculate slag properties for the phase groups, for example for the overall
slag.
On the Plot Renderer (for axis quantities) and Table Renderer there is an option to choose or
define the Slag property. The associated quantity that you select has these options: All, B2,
B3, B4, Bas2, Bells ratio, Ls , or Log10 (Sulphur capacity).
Details, including references and equations, are described in Process Metallurgy Slag
Properties.

Adiabatic Calculations
When setting up the Process Metallurgy Calculator under the Equilibrium Kinetics branch,
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you choose the thermal control to be either Isothermal or Adiabatic. Adiabatic calculations
assume no heat and mass exchange with the environment during the equilibrium reaction.
The adiabatic process is implemented by an isenthalpic process with constant pressure (i.e.
H=const), which is equivalent.
Adiabatic Calculations: Material Enthalpy

Gas Volume Units
Beside regular mass units, the amount of gas can also be provided in Normal cubic meter
(Nm3). The applied reference conditions are 1013.25 hPa and 15.0 °C (according to ISO
2533).
There are slightly deviating definitions present in the industry, which need to be
converted for precise results. For most applications of the Process Metallurgy
Module this difference has a minor influence.

Calculation of Component Compositions
The composition of all ionic phases is provided as elemental as well as component
composition (i.e. Fe2O3, FeO, CaO, …). In order to provide a representation similar to that
usually used in the industry, the content of S is provided as elemental content and the
content of P is given as component content of P2O5. This is a simplification because P and S
can also be present as sulphates and phosphates in the slag and can bind to different metal
cations. This can cause deviations in the overall component composition if the content of S
and P is high in the phases. In doubt, the elemental composition can be used, it will always
be exactly correct.
For non-ionic phases such as ALABANDITE, always the elemental composition will be shown
only. This is also true if the IONIC_LIQ composition cannot be described by components only
due to constraints of the overall composition (for example if the material has been oxidized
completely and forces a certain composition of the ionic liquid slag).

Definition of Partial Pressure of Oxygen
The oxygen partial pressure in the gas phase is calculated with the following formula:

In the formula, p describes the total system pressure and AC the activity of oxygen in the gas
phase.

Activities of Slag Components
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The chemical activity of each component AC(COMPONENT, REFERENCE_PHASE) is available
either with reference to the liquid or the solid slag phase. It can only be calculated for
components being present in the thermodynamic database.

Process Schedule
When you are working with the Process simulation branch you set up a process schedule.
There are some useful details about this described in Working with the Process Schedule.

Dynamic Time Stepping
The nature of a Process simulation requires a dynamic choice of the time step lengths. To
understand this better, see About Dynamic Time Stepping. These settings are done on the
Options Tab.

Thermo-Calc User Guide: Graphical Mode ǀ 200 of 527

Thermo-Calc Documentation Set

Working with the Process Schedule
Defining the Process Simulation
Process Simulation: Process Schedule Tab
About Dynamic Time Stepping
Materials and heat can be added at any time in any amount. They can be either added to a:
l

bulk zone (such as steel, slag, etc.), or

l

reaction zone (interface between two bulk zones).

These types of materials are used in the process schedule set up:
l

Material addition (in tonne, kilogram, etc.)

l

Continuous material addition (in kilogram per minute, etc.)

l

Thermal / electrical power (i.e. a continuous heat addition in MW)

A material addition is typically used to model some event like emptying a bucket into the
melt. A continuous material addition is instead used to model a continuous material feeding
into the melt, such as wire feeding. Finally, heat can be added or removed during a time
step and this is defined as power.

Figure 10: A process schedule additions scheme.
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Generally the addition of materials and heat is modeled in the process simulations for any
time point tn as follows:
l

l

Material additions happen immediately after the previous time point tn-1, i.e. at the
beginning of the time step.
Continuous material and heat additions (power) are conceptually happening during
the complete time step between tn-1 and tn.

The data presented in the results is always referring to the time point, i.e. to the end of the
time step. This means that reactions and heat transfer have happened between adding
materials and heat at the beginning of the time step and the end of the time step. If for
example a strongly cooling material is added, a possibly quite large heating of the zone
might have happened until the end of the time step.
The first two time points are different:
l

l

The first time point t0 at t=0 does not represent a time step, instead only a mixing
and equilibrium reaction of the material additions in each bulk zone is taking place.
There are no reaction zones existing at this time point.
The second time point t1 represents the first time step in the simulation where the
different bulk zones react between each other via the reaction zones. Nevertheless it
is conceptually identical to any other time point.
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About Dynamic Time Stepping
Defining the Process Simulation
Working with the Process Schedule
Options Tab
The nature of a process simulation requires a dynamic choice of the time step lengths. On
the one hand the simulation needs to capture very fast changes of temperature and
composition, for example after addition of cold material. On the other hand it should
calculate processes that take several hours in reality within an appropriate calculation time.
The time step control algorithm is primarily controlling the change of the temperature in
each zone (including the reaction zones) such that it stays below a specified limit but is
always as large as possible.
The dynamic time stepping can be switched off by choosing a very large maximum allowed
temperature change per step (such as 1.0e6 K). In this case the maximum time step is
always used, however this is only recommended in special situations.
If a temperature change is too large, the algorithm reverts the time step and returns to the
previous time point in order to try a smaller time step. Therefore you can see in the Event
Log output that the time points can jump back. Except for larger additions this is a rare
event.
The parameters of the time-step control algorithm are:
l

initial time step a t=0,

l

smallest allowed time step,

l

largest allowed time step, and

l

maximum allowed temperature change of a zone within a time step.

The initial time step as well as the largest allowed time step are defined in percent of the
total duration of the process while the smallest allowed time step is given in seconds. This
allows that these parameters normally need no change even if switching between processes
with very short and very long duration.
Making the largest allowed time step bigger can reduce the number of steps and
consequently the calculation time, but only if the time step is not limited by the maximum
temperature change per time step. This means that both parameters need to be considered
together.
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Taking a too large smallest allowed time step can cause numerical difficulties, especially if
large cold material additions are part of the process schedule.
The initial time step is usually of limited relevance for the overall calculation time, but
should usually not be larger than the default value of 1.0%.
As different processes show very different temperature changes, it is probably most
common to adapt the maximum temperature change per time step in order to have a good
balance between accuracy of the results and calculation time. Usually it should be possible
to change this parameter without adapting the other algorithm parameters.
The effects of the dynamic time step algorithm can be inspected by activating the data
points in the plots.

To show the data points, in the Results window in Thermo-Calc, right-click in
the plot area and choose Properties, then click Show data points.
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Working with the Material Manager
The Material Manager is only available for the Process Metallurgy Calculator.
Use the Material Manager to create and delete groups of materials and delete materials
you have saved directly from the Process Metallurgy Calculator.
Go to the Material Manager from the main menu. Select Tools → Options → Graphical
Mode and click the Activities tab. Then click Process Metallurgy . See Global Settings:
Process Metallurgy.

For frequently used materials, save the material composition for each group—Steel (or any userdefined metal), Slag or Gas—from the Process Metallurgy Calculator. Use the Material Manager to
create and delete groups or delete a previously saved material.

Use the Material group and Material lists to create and delete material groups, as well as
delete material compositions that are saved from the Process Metallurgy Calculator.
l

l

Material group: To create or delete a group, choose it from this list, e.g. Steel, Slag
or Gas. The Steel group is simply a generic Metal group. You can create other userdefined metal groups and then these would also be listed here. Click Create group or
Delete group as required to manage the list.
Material: To delete a material, choose the group type then select the material
composition to delete. For example, select the Slag material group, then choose the
Example Slag material and click Delete material to remove it from all lists.

Saving a Material
This is done directly from the Process Metallurgy Calculator → Configuration window.
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1. Add the Process Metallurgy Calculator to My Project directly (right-click and select it
from the Create New Activity menu) or use the available Process Metallurgy
template.
2. On the Configuration window, next to the Material group you want to define, for
example Steel (or another user-defined metal group), Slag or Gas. Click Show
composition.
3. Enter the composition and the Major component of the material you want to save
for future use. You can alternatively select Normalize to total of 100% and enter the
percentages for each element.
4. Click Save material.
5. In the window that opens, enter a Material name. Click OK.
When you go to the Material Manager, you can select this saved material from the
applicable list if you need to delete it.
It is not possible to rename a saved material—you need to
recreate/redefine the material and save it again with the new name.

Deleting a Material
This is done with the Material Manager, located on the Tools → Options window.
1. After Saving a Material, go to the Material Manager.
2. Select the Material group associated to the material saved previously, for example,
Steel (or another user-defined metal group), Slag or Gas.
3. From the Material list, select the material you want to delete and click Delete
material.
4. In the window that opens, click Yes to delete the material and No to cancel.

Creating a Material Group
This is done with the Material Manager, located on the Tools → Options window.
1. Go to the Material Manager.
2. Click Create group.
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3. In the window that opens, select the Material group type (Metal, Slag or Gas) you
want to create.
4. Enter a Material group name. The new group is now available to select from the
Material group list.

Deleting a Material Group
This is done with the Material Manager, located on the Tools → Options window.
1. Go to the Material Manager.
2. From the Material group list, select the group you want to delete and click Delete
group.
3. In the window that opens, click Yes or No.
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Process Metallurgy Slag Properties
The slag properties are describing the capability of a slag to take up sulphur from the metal
melt. The Process Metallurgy Module defines so-called phase groups. They contain all
phases of a certain kind, for example all solid slag or all slag phases. The component
composition of such a phase group is calculated by weighting the component composition of
each phase with their fraction in the group.
This allows to calculate slag properties for the phase groups, for example for the overall
slag.
Various predefined slag properties such as different definitions of slag basicity, sulpur
capacity and so forth are available for plotting or tabulating. On the Process Metallurgy
Calculator when you are selecting axis variables on the Plot Renderer or choosing the
properties to list with the Table Renderer, there is an option to include these slag
properties.
The associated quantity that you select from the next drop-down list has these options to
choose: All, B2, B3, B4, Bas2, Bells ratio, Ls, or Log10(Sulphur capacity). Also choose In
liquid slag only, In solid slag only or In all slag. Depending on this setting, the composition
averaged over liquid, solid or all slag is applied as a basis for the slag property calculation.

Slag properties for a Table Renderer.
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Slag properties for a Plot Renderer.

Equations and References
The equations and references for the slag properties are defined below. Composition can be
given in mass (% or fraction).
The formulas are given in Thermo-Calc console-like syntax (B: mass, W: weight fraction, AC:
activity). A slag property will be available if all of its components are present in the phase
group. Steel and slag are the actual phase groups chosen depending on the user request, i.e.
the slag property can be calculated for the liquid slag only or for the overall slag (liquid and
solid).
Basicity is defined as:

Sulfur capacity is defined as:
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Adiabatic Calculations: Material Enthalpy
An adiabatic calculation requires the enthalpy of the input materials as an initial condition.
The Process Metallurgy Module uses different approaches for the different material types
metal, gas and slag. Any mechanical mixture is only applied for 1 bar / 1013 hPa.

Metal
Frozen-in global equilibrium calculation at T=700 °C, taking the resulting enthalpy at the
actual initial material temperature. This corresponds to a frozen-in microstructure. At initial
material temperatures above 700 °C the equilibrium is instead calculated directly.

Gas
Mechanical mixture between the enthalpy of the gas components. This is no limitation,
because all gas components in the database are assumed to be ideal gas.

Slag
l

l

Mechanical mixture: If the temperature is below T=1000 °C and every single
material component (such as MgO, CaO, …) is fully solid at the requested material
temperature, mechanical mixture is assumed. This means that the enthalpy of every
component is calculated separately and summed up (weighted by mass fraction).
This corresponds to the assumption that different separate components have been
added to the slag (such as burnt lime and magnesite). If any component forms gas or
liquid at the initial material temperature, this mode is not used. Note that
mechanical mixture is also applied if pure elements are added to the slag material,
i.e. it is not the same in respect to the material enthalpy to define CaO and Ca + O.
Equilibrium: If no mechanical mixture of the material components is possible or if
the temperature is above T=1000 °C. This corresponds to the assumption of a fully
homogenized slag material.
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Process Metallurgy Calculator
For information about licenses and availability, see About the Process Metallurgy
Module.
Use a Process Metallurgy Calculator to set up calculations for steel and slag used in steel
making. Define the composition of a steel (or other metal) and slag system using material
groups: one each for steel, slag and gas. You can save your material compositions right from
the calculator and quickly access and manage the materials and groups—it collects groups
of saved materials according to type, thus making it easy to retrieve them.
You can add the calculator to My Project directly (right-click and select it from the Create
New Activity menu) or use the available Process Metallurgy Template.
Your installation includes examples that you can run to see how the calculator
works.

Kinetics - Equilibrium or Process Simulation
Once you have added a Process Metallurgy Calculator, the Configuration window is further
branched based on the Kinetics option you choose, Equilibrium, where kinetics are not
considered, or Process simulation, where kinetics are considered using the Effective
Equilibrium Reaction Zone (EERZ) model.
All settings, no matter what kinetics branch, are defined on the Configuration window
Conditions and Options tabs.

Conditions Tab
Equilibrium
For information about the individual settings on this tab, see Equilibrium Simulation:
Conditions Tab.
Set the conditions for your calculation that define the slag, metal and gas. The topic,
Defining the Equilibrium Simulation, has instructions that walk you through the steps that
represent a simplified steelmaking process.

Process Simulation
For information about the individual settings on this tab, see Process Simulation:
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Conditions Tab.
Set the conditions for your calculation that best describes the process you want to simulate.
The topic, Defining the Process Simulation, has instructions that walk you through the steps.
Also the description of the kinetics examples are useful to help you better understand the
settings.

Options Tab
For information about the individual settings, see Options Tab.
The settings in Process material equilibrium and grid define certain numerical settings
used by the Thermo-Calc calculation engine for equilibrium calculations such as whether
tests for global minimization should always be performed (this significantly slows down the
calculations) or never be performed (this speeds up calculations but miscibility gaps might
not be found), and so forth.

Calculations of oxide systems are numerically challenging, and they can often
fail. The default values are chosen to give the best general performance and
reliability and should only be changed by an expert user. Also, a large amount
of logic is implemented in the Process Metallurgy Module to improve the
convergence and calculation speed of equilibrium calculations. The timestep
control is related to how finely the times defined in the Process schedule are
resolved. See About Dynamic Time Stepping for more information.

Thermo-Calc User Guide: Graphical Mode ǀ 213 of 527

Thermo-Calc Documentation Set

Local versus Global Options Settings
The Options tab is where you can locally define specific Process Metallurgy Calculator
settings. These settings can also be applied globally from the Options window. From the
Global options you can also manage the materials. See Working with the Material Manager.

To open the Options window: From the main menu select Tools → Options →
Graphical Mode and click the Activities tab. Then click Process Metallurgy.
See Global Settings: Process Metallurgy for details.

Plots and Tables
Right-click the node to add a Plot Renderer or Table Renderer to visualize your results.
Although both nodes work the same as with the other calculators in Thermo-Calc, there are
additional features and settings unique to the Process Metallurgy Module. Useful
information is included throughout the documentation. You can also read more about the
unique features in Working with the Process Metallurgy Module.
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Defining the Equilibrium Simulation
After adding a Process Metallurgy Calculator to your project, you can choose to conduct an
Equilibrium simulation, where you define the steel, slag and gas groups of materials, or a
Process simulation, where you set up a process using the EERZ (Effective Equilibrium
Reaction Zone) model.
The following steps are for Equilibrium simulations. If you choose to do a
Process simulation, see Defining the Process Simulation.
The following is a general overview of the setup based on the PMET_01: Basic Oxygen
Furnace (BOF) example, which walks you through the steps that represent a simplified
steelmaking process.
A variety of video tutorials are available for many of our products and features
on our website and our YouTube channel. The library keeps growing so be sure
to check back on a regular basis.

1: Add the Calculator and Choose the Simulation Type
1. Add a Process Metallurgy Calculator node to My Projects node. If you used the
Process Metallurgy template, click the node to display the Configuration settings
window.
2. Under Kinetics, choose the simulation type, Equilibrium or Process simulation. For
the following steps, choose Equilibrium.

2: Select a Database and Enter a Temperature
1. In the Configuration window, for the Database selection, the program automatically
defaults to the highest version of the TCOX database.
The Process Metallurgy Module requires both a valid Maintenance and
Support Subscription (M&SS) and a license for the TCS Metal Oxide
Solutions Database (TCOX8 or newer).

Thermo-Calc User Guide: Graphical Mode ǀ 215 of 527

Thermo-Calc Documentation Set

It is not possible to use custom user databases with the Process
Metallurgy Module. This is because several internal calculations, such as
determining the component compositions of ionic phases, are dependent
on the database. Therefore, only TCS Metal Oxide Solutions Database
(TCOX) versions 8 and newer, and to a limited extent, OXDEMO, can be
used with this Module.

For users without a license, the OXDEMO database is available and this
allows for calculations using only these elements: Fe, C, S, Ca, Si, Al and
O.

2. Set the Thermal Control as being Isothermal or Adiabatic.
3. Select a Temperature unit (Kelvin, Celsius or Fahrenheit) and enter a numerical
value in the field.
4. Select a Pressure unit (Pascal, Atmospheres or Bar) and then enter a numerical
value in the field.

3: Define the Conditions for the Steel, Slag and Gas Material Groups
Next define each material group—Steel (or any user-defined Metal group), Slag and Gas.
See Equilibrium Simulation: Conditions Tab for an overview of the layout of this
section. There is also an overview of these material groups in Working with the
Process Metallurgy Module.
1. Choose a Material to set up first, Steel (or any user-defined metal), Slag or Gas.
2. Select an Amount from the list—Tonne, Kilogram, Gram or Pound. Enter a
numerical value in the field.
3. If this is the first time you are defining a material, or at any time when User-defined
is selected, click Show composition to set the composition for the material (steel,
slag or gas or another user-defined metal).
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The composition for each material is hidden by default because the
module allows you to easily save materials and access these from the
material menu. Once you save a collection of materials, you will rarely
have to click Show composition. See Working with the Material
Manager for details about saving and deleting materials.

4. To the right of the Material list (e.g. for the Steel group), choose the material
composition you want to use for this simulation. Predefined Example Steel and
Example Slag compositions are included with your installation.
l If you chose Adiabatic as the Thermal Control, also enter a temperature in
the field for each material. This is the initial temperature before the material
is added to the process.
5. From the first Input type list select Mass percent, Mass fraction, Mole percent,
Mole fraction, or Absolute amount. For Absolute amount, you can directly enter
values in the fields in the unit selected above for Amount (Tonne, Kilogram, Gram
or Pound).
6. For the next list, the default is based on which group you are defining. For the Steel
(Metal) group it is Element, for Slag it is Component and for Gas it is Gas
component.
7. Choose Major component so that as you add other components, the major one is
adjusted to be the rest of the composition. Choose Normalize to total of 100% so
that the sum is adapted to 100%. This is useful if you need to work with a given
composition that does not sum up to 100% If you select Absolute amount,
Normalize to total of 100% is not available.
8. Based on which material group you are working with, add the Element, Component
or Gas component.

To add one or more material groups click the green add button. Click the red
minus button to remove a material group. The new material inherits the
default settings of that group.

9. After you have added and defined the element, component or gas component it is
recommended you save and name the material. This makes it easier to work with
because the name of the material is automatically updated in the lists (and available
as part of your library) instead of being named User-defined everywhere.
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The material is automatically saved in the relevant material group, so only steel
materials are shown in the steel menu, only slag materials are shown in the slag
menu and only gas in the gas menu. You can also create additional material groups if
there are groups you use regularly, such as scrap compositions, ferro-alloys or slag
additions. See Working with the Material Manager for more details about creating
and deleting material groups and deleting materials.
10. Continue adding and defining the material groups (e.g. Steel, Slag and Gas). You
could, for example, add another Steel group if you wanted to define a composition of
a steel scrap to add to a basic oxygen furnace (BOF).

4: Select the Calculation Type and Associated Definitions
These settings are described more in Equilibrium Simulation: Conditions Tab.
1. Under Calculation Type, click to choose Single (no axes), One axis, Grid or
Uncertainty.

For more complex calculations, it is good practice to start with a Single
equilibrium calculation to make sure the calculation converges. Also see
the settings described in Options Tab. These can be useful if your
calculation fails.

2. Based on the calculation type, define either the Grid Definitions (for One axis or Grid
calculations) or the Sampling of Data from Gaussian Distributions (for Uncertainty
calculations). The Quantity displays all the stepping options set up with the material
groups for Steel, Slag and Gas. The example shows the steel group quantities.
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The Amount of X in Y quantities you can choose from the various dropdown lists (such as under Grid Definitions) are defined as Min-Max
variation of the component X in Y. If a dependent element is present that
is adapted as usual.

How these quantities relate to the material definition is described in Working
with the Process Metallurgy Module.

5: Add and Define a Plot or Table and Run the Simulation
Once you have finished defining the Process Metallurgy Calculator, you also define the plot
or table settings. To add a Plot Renderer or Table Renderer, right-click the calculator node
and select an option from the Create New Successor menu.
The settings are generally described for the individual nodes. See Plot Renderer
and Table Renderer.
Some useful information about the plots is also described in Working with the Process
Metallurgy Module.
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Equilibrium Simulation: Conditions Tab
The following outlines what you can set on the Configuration window Conditions tab when
working with the Process Metallurgy Calculator and an Equilibrium simulation.
Also see Defining the Equilibrium Simulation for instructions that walk you
through the steps that represent a simplified steelmaking process. A more
complex process is described in Defining the Process Simulation.

An example of the different settings areas for a default Configuration window for a Process
Metallurgy Calculator when an Equilibrium simulation type is selected. There are many settings
available depending on the parameters.

Database
The most recent available version of TCS Metal Oxide Solutions Database (TCOX) is selected
by default.
The Process Metallurgy Module requires both a valid Maintenance and Support
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database
(TCOX8 or newer).
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It is not possible to use custom user databases with the Process Metallurgy
Module. This is because several internal calculations, such as determining the
component compositions of ionic phases, are dependent on the database.
Therefore, only TCS Metal Oxide Solutions Database (TCOX) versions 8 and
newer, and to a limited extent, OXDEMO, can be used with this Module.

All users can test the Process Metallurgy Module with the included OXDEMO
database, which is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For
more information about this and other products visit our website.

Thermal Control
Choose Isothermal or Adiabatic. When Adiabatic is selected, no global temperature is
defined (as this changes during the process). Instead the initial temperature has to be
defined separately for each material. Adiabatic calculations assume no heat and mass
exchange with the environment during the equilibrium reaction. Certain types of processes
run at almost constant temperatures. For such processes isothermal conditions are
acceptable. But in most metallurgical processes the temperature will change sometimes
dramatically in function of time due to heating or cooling of the system and due to
exothermal or endothermal reactions taking place. For such processes adiabatic conditions
are a better choice.

Temperature
Choose a Temperature unit (Kelvin, Celsius or Fahrenheit) and then enter a numerical
value in the field.

Pressure
Choose a Pressureunit (Pascal, Atmospheres or Bar) and then enter a numerical value in
the field.

Material Groups (Steel, Slag and Gas)
For more details about these fields, see Defining the Equilibrium Simulation. See also
Working with the Material Manager.
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There are three groups to define: Steel (or another user-defined Metal group), Slag and
Gas.
In the image below, the red-highlighted area is where the Steel material group is defined.
The drop-down menu that displays Steel_BOF is a user-defined material. This can be defined
and then saved to the material library.

The three material group areas on the Process Metallurgy Calculator where you can define
components and save materials.

When you click Show composition next to any material group, additional fields display (e.g.
Input type, Major components and so forth) where you can further define each material
group. You can add and remove materials using the Material Manager (available via the
Tools → Options menu).
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You can open the example project PMET_01: Basic Oxygen Furnace (BOF) from
Thermo-Calc (Help → Example Files → Process Metallurgy → PMET_01_
Basic_Oxygen_Furnace.tcu). Then click Show composition next to the Slag
and Gas groups to see how the Slag_BOF and Oxygen materials are defined.

From this composition area you can click the Save material button to add the new material
to the group's list. The newly named material composition is then available for use with that
material group. In this example, the Steel_BOF material was defined first and then named at
the end. It is now automatically available wherever you select the Steel material or need to
choose quantities to plot.

The Amount of X in Y quantities you can choose from the various drop-down lists
(such as under Grid Definitions) are defined as Min-Max variation of the
component X in Y. If a dependent element is present that is adapted as usual.

To add one or more material groups click the green add button. Click the red
minus button to remove a material group. The new material inherits the
default settings of that group.
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After defining and saving a material composition, the named material is available for selection in a
variety of places such as when choosing quantities on the calculator and defining axis variables on
the Plot Renderer.

Calculation Type
Single (no axes), One axis, Grid or Uncertainty.
The Calculation Types in Graphical Mode
l

l
l

l

Select Single to calculate a single point. No additional settings are required. The
results from this calculation can be displayed in the Results window using a Table
Renderer.
Select One axis to vary a quantity on the X-axis.
Select a Grid to evaluate two axis variables of the selected quantities in the specified
range and number of steps.
The Uncertainty calculation evaluates the equilibrium where the values of the
quantities are sampled from Gaussian distributions. The Mean field is as defined
under Condition Definitions for the respective quantity. The result is visualized as a
histogram or normal probability plot by adding a Plot Render activity.

Grid Definitions (One axis or Grid)
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The Quantity menu displays all the stepping options set up with the material groups for
Steel (or any user-defined metal group), Slag and Gas.
For One axis, select a Quantity to vary along the X-axis, for example, Temperature then
enter a Min, Max and Number of steps.
For the Grid calculation type, define the two axes variables using the fields and menus:
Quantity, Min, Max and Number of steps. The number of steps along with the minimum
and maximum values for the axes define a grid. For each grid point the selected equilibrium
is evaluated.
For a Grid, on the Plot Renderer, you can choose to plot a Heat map, Contour or
3D diagram.
Heat Map, Contour and 3D Plots

Sampling of Data from Gaussian Distributions (Uncertainty)
For the Uncertainty calculation type, click to select the applicable check boxes under
Quantity. The Mean field is for the distribution function as defined under Condition
Definitions for the respective quantity. The default ΔMin/Max is a 95% confidence interval.
About the Uncertainty Calculations

Sampling Parameters (Uncertainty)
For the Uncertainty calculation type, choose a number of Standard deviations where you
want to Truncate the distribution. Choose the Total number of samples.
About the Uncertainty Calculations

Thermo-Calc User Guide: Graphical Mode ǀ 225 of 527

Thermo-Calc Documentation Set

Defining the Process Simulation
Setting Up a Process Metallurgy Simulation
After adding a Process Metallurgy Calculator to your project, you can choose to conduct an
Equilibrium simulation, where you define the steel, slag and gas groups of materials, or a
Process simulation, where you set up a process using the EERZ (Effective Equilibrium
Reaction Zone) model.
The following steps are for Process simulation. If you choose to do an
Equilibrium, see Defining the Equilibrium Simulation.
A variety of video tutorials are available for many of our products and features
on our website and our YouTube channel. The library keeps growing so be sure
to check back on a regular basis.

1: Add the Calculator and Choose the Simulation Type
1. Add a Process Metallurgy Calculator node to My Projects node. If you used the
Process Metallurgy template, click the node to display the Configuration settings
window.
2. Under Kinetics, choose the simulation type, Equilibrium or Process simulation. For
the following steps, choose Process simulation.
Only adiabatic conditions are available for process simulations as this
corresponds best to most practical processes.

2: Select a Database and Enter a Temperature
Process Simulation: Conditions Tab
1. In the Configuration window, for the Database selection, the program automatically
defaults to the highest version of the TCOX database.

Thermo-Calc User Guide: Graphical Mode ǀ 226 of 527

Thermo-Calc Documentation Set

The Process Metallurgy Module requires both a valid Maintenance and
Support Subscription (M&SS) and a license for the TCS Metal Oxide
Solutions Database (TCOX8 or newer).

It is not possible to use custom user databases with the Process
Metallurgy Module. This is because several internal calculations, such as
determining the component compositions of ionic phases, are dependent
on the database. Therefore, only TCS Metal Oxide Solutions Database
(TCOX) versions 8 and newer, and to a limited extent, OXDEMO, can be
used with this Module.

All users can test the Process Metallurgy Module with the included
OXDEMO database, which is limited to these elements: Al, C, Ca, Fe, O,
S, and Si. For more information about this and other products visit our
website.

2. Select a Temperature unit (Kelvin, Celsius or Fahrenheit).
3. Select a Time unit (Seconds, Minutes, Hours or Days).

3: Define the Process Model
Process Simulation: Process Model Settings
1. Enter a Name for the process and the total Duration of the process.
2. Choose a Process model from the list or click Edit Process Model to define a new
model or edit an existing one.
3. In the Process model the following is defined:
a. Pressure. This is assumed to be constant throughout the process.
b. Zones of the Effective Equilibrium Reaction Zone model. Only two zones
can be defined. The densities need to be given manually. They are used to
calculate the volume of the reaction zones, which is in turn used for the
calculation of the reaction kinetics.
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c. Area of the Reaction zone and mass transfer coefficients. The area is
typically the area of the interface between the two zones. The mass transfer
coefficients state how fast material is moved into the reaction zone. Large
values result in fast kinetics, small numbers in slower kinetics. These values
strongly depend on the type of material (mass transfer in slags is slower than
in liquid steel due to its higher viscosity) and type of process (the violent
reactions in a basic oxygen furnace have higher mass transfer coefficients
compared to the gentle stirring performed in a ladle furnace. These
parameters are basically fitting parameters that need to be determined
based on comparison with experimental data. Typical values can also be
found in the literature.
d. Transfer of phase group. This defines how fast “foreign” phases are moved
from one zone to the other. Foreign phases could be solid or liquid oxide
inclusions in the liquid steel, or metallic droplets in the slag phase. A typical
application is the simulation of the flotation of oxide inclusions out of the
liquid steel into the slag phase during refining in a ladle furnace.
e. The Heat entering or leaving the system and being transferred between
the zones. Constant cooling defines how much heat is lost from the system by
radiation and convection. Separate values can be given to each zone if
needed. Heat is used when the system is actively heated by an external heat
source such as an electric arc or induction heater. Here only the heating
efficiency is given, which is the percentage of for example electrical power
that is transferred to the system as heat. The times and power are defined in
the Process schedule. Different amounts of heat and material are added to
the zones resulting in the zones having different temperatures. Heat transfer
defines how heat flows from one zone to the other. A high value results in a
quick equalization of temperature, a small value results in the zones keeping
their different temperatures.

4: Define the Materials
Process Simulation: Materials Tab
The materials can be defined, saved and retrieved in the same way as for an equilibrium
simulation. For a process simulation, it must be defined to which zone the material is added.
Typically, oxide materials are added to the slag zone and metallic materials are added to
the steel zone. Gas or other injected materials (such as carbon or lime powder) are typically
added to the reaction zone. But this choice depends on the process to be simulated and must
be carefully chosen. By defining the same material twice or even three times, it can be split,
so that part of the material is added to one zone and part of it to another zone.

5: Define the Process Schedule
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Working with the Process Schedule
Process Simulation: Process Schedule Tab
On the Process schedule tab, the sequence and amounts of additions during the duration of
the process are defined. All the materials defined in the Materials tab automatically are
included in the table. If a heat addition is defined in the Process Model this is also included
in the table. If the units Tonne, Kilogram or Pound are selected, then the additions are
defined as one-time additions at a certain time. If a rate is chosen as unit of the addition
(such as Kilogram per minute or Kilogram per second, for gas also Normal cubic meter
per minute or per second can be given) then the rate of addition is entered into the table.
The additions are visualized in a plot for clarity.

6: Run the Simulation and Add and Define a Plot or Table
When the simulation is set up, run it by clicking Perform Tree. Plots and tables can be added
in the same way as for equilibrium calculations.
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Process Simulation: Conditions Tab
See Defining the Equilibrium Simulation for instructions that walk you through
the steps that represent a simplified steelmaking process. A more complex
process is described in Defining the Process Simulation and where the settings in
the following topics are described.
See PMET_04: Basic Oxygen Furnace (BOF) Kinetics and other examples to learn
interactively about the available settings.
The following outlines what you can set on the Configuration window Conditions tab when
working with the Process Metallurgy Calculator.
Below is based on selecting a Process simulation under Kinetics. The settings to complete
are for the Process Model, the Materials and the Process Schedule.

An example of the different sections on the Configuration window for a Process Metallurgy
Calculator when a Process simulation type is selected. This screen shot is from the example PMET_
04. There are many settings available depending on the parameters.

Database
The most recent available version of TCS Metal Oxide Solutions Database (TCOX) is selected
by default.
The Process Metallurgy Module requires both a valid Maintenance and Support
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database
(TCOX8 or newer).
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It is not possible to use custom user databases with the Process Metallurgy
Module. This is because several internal calculations, such as determining the
component compositions of ionic phases, are dependent on the database.
Therefore, only TCS Metal Oxide Solutions Database (TCOX) versions 8 and
newer, and to a limited extent, OXDEMO, can be used with this Module.

All users can test the Process Metallurgy Module with the included OXDEMO
database, which is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For
more information about this and other products visit our website.

Temperature
Select a Temperature unit (Kelvin, Celsius or Fahrenheit).

Time
Select a Time unit (Seconds, Minutes, Hours or Days).
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Process Simulation: Process Model Settings
The following outlines what you can set on the Configuration window under
Process and when you click Edit Process Model. The overall steps to set this up
are described in Defining the Process Simulation.

Process
Under Process, enter a Name and Duration.

For more complex processes, you could, for example, enter the process
reference as its Name as is done for the EERZ example PMET_06_Ladle_
Furnace_Kinetics.tcu.

Process Model
Choose a Process model. Click Edit Process Model to enter details as below.

You can create your own Process model and name them so these are available
to choose from the list in the future. This is done using the Edit Process Model
window.

Edit Process Model
To open the Edit Process Model window, click Edit Process Model to access the following
settings.
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Pressure
Choose a Pressure unit (Pascal, Atmospheres or Bar) and then enter a numerical value in
the field.
Only constant pressure throughout the process can be used. Also, the pressure
only influences reactions involving the gas phase.

Zones
In this section you are defining the material zone(s), which are added to a Zone or Reaction
zone on the Materials tab.
Enter a Name and density (in kg/m3) for the zones.
For example, enter Steel and Slag, which in the next section are available to define for
Zone 1 or Zone 2 in the Reaction zone.
Click the Add

button to define additional items and the Remove

button to delete items.

Reactions
In this section you are defining either a Reaction zone and/or Transfer of phase group.
Click the Add

button to define additional items and the Remove

button to delete items.

Reaction Zone
If you choose Reaction zone from the list then enter an area (in m2).
Next choose from each Zone 1 and Zone 2 list the Zone as defined above, for example Steel
or Slag. Then enter a mass transfer coefficient in m/s for each of these.
Reaction zone area and mass transfer coefficient defines the kinetics of the reaction
between the two zones. A large area and fast mass transfer results in fast kinetics.

Transfer of Phase Group
If you choose to define a Transfer of phase group, then choose the state as Liquid metal,
Solid metal, All metal, Solid oxides, Liquid oxides, All oxides or Gas.
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Then choose the two zones (e.g. Steel or Slag) to define from zone and to zone and enter a
value of the %/min.
This parameter defines how fast “foreign” phases are transferred from one zone to another.
A typical example is the flotation of oxide inclusions in liquid steel up into the slag phase.

Heat
Choose the type of heat to apply to the process: Constant cooling, Heat transfer and/or
Heat.
Click the Add

button to define additional items and the Remove

button to delete items.

Constant Cooling
If you choose Constant cooling, enter a Name, choose either Zone or Reaction Zone and
enter a numerical value in the field in MW (megawatts).
If you choose Zone, you can further choose either Zone defined above (e.g. Steel or Slag). If
you choose Reaction Zone, then heat is lost from the EERZ, the size of which is calculated at
each timestep depending on the kinetic parameters defined in Reaction Zone.
This parameter defines how much heat is lost from a zone (or the reaction zone) by
radiation or convection and results in an overall cooling of the system.

Heat Transfer
If you choose Heat transfer, select two zones between where heat should flow and enter a
heat transfer coefficient in Wm2/K.
As different amounts of material and also different amounts of heat can be added to the
different zones, these temperature are different. As the two zones are in contact heat flows
from the hotter zone to the cooler zone thus equalizing the temperature. The amount of
heat flowing from one zone to the other is defined by the Heat transfer. A high heat transfer
coefficient leads to fast temperature equalization, a small heat transfer coefficient results in
the zones keeping different temperatures.

Heat
If you choose Heat, enter a Name, then select Zone or Reaction zone, choose a Zone (e.g.
Steel or Slag) and enter a percentage of MW efficiency in the field.
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Select Heat if the system is actively heated by an external heat source such as an electric
arc or induction coil. Here only the efficiency is defined, which is the percentage of power
(for example electrical power) that is transformed into heat that enters the system and
heats it up. The profile of power versus time is defined in the Process Schedule.
Click Save when the Process Model is defined and enter a Process model name. Each time
you save a process model it adds it to the list on the main Configuration window, which you
can use in future set ups.
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Process Simulation: Materials Tab
The following outlines what you can set on the Configuration window Materials
tab. The overall steps to set this up are described in Defining the Process
Simulation.

This section is similar to how you define the materials for the Equilibrium
branch. Some information is explained in more detail for Equilibrium
Simulation: Conditions Tab and not repeated here.

Material
Materials are grouped into Steel (or another user-defined Metal group), Slag (or another
user-defined non-metallic group) and Gas.
Some of what you choose from lists in this section depend on what you have entered as the
Process Model above. For example, the Zone or Reaction zone options are based on those
entries (e.g Steel or Slag).

To add one or more material groups click the green add button. Click the red
minus button to remove a material group. The new material inherits the
default settings of that group.

After choosing the Material for the section being defined, also enter a value of the
temperature in the field. Choose what Zone or Reaction zone it is to be Added to.
The times and amounts of additions are defined in the Process schedule.

Show Composition
When you click Show composition next to any material group, additional fields display
where you can further define each material group.
From this composition area you can click the Save material button to add the new material
to the group's list. The newly named material composition is then available for use with that
material group.
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From the first Input type list select Mass percent, Mass fraction, Mole percent, Mole
fraction, or Absolute amount. For Absolute amount, you can directly enter values in the
fields in the unit selected above for Amount (Tonne, Kilogram, Gram or Pound).
For the next list, the default is based on which group you are defining. For the Steel (Metal)
group it is Element, for Slag it is Component and for Gas it is Gas component.
Choose Major component so that as you add other components, the major one is adjusted
to be the rest of the composition. Choose Normalize to total of 100% so that the sum is
adapted to 100%. This is useful if you need to work with a given composition that does not
sum up to 100% If you select Absolute amount, Normalize to total of 100% is not
available.
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Process Simulation: Process Schedule Tab
The following outlines what you can set on the Configuration window Process
Schedule tab. The overall steps to set this up are described in Defining the
Process Simulation. Also see Working with the Process Schedule.

On the Process schedule tab, the sequence and amounts of additions during the duration of
the process are defined. All the materials defined in the Materials tab automatically are
included in the table. If a heat addition is defined in the Process Model this is also included in
the table.

Plot
Select the Plot check box to include or exclude the components in the process schedule plot
area, for example, to help you examine the changes in the plot window, after defining the
Steel, Scrap, Slag or Gas rows, see what happens when you remove one or more items from
the plot.

Unit
Enter a value and choose a unit Tonne, Kilogram, Pound, Kilogram per second or Kilogram
per minute. For Gas you can also choose Normal m3 per minute as the unit.
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If the units Tonne, Kilogram or Pound are selected, then the additions are defined as onetime additions at a certain time. If a rate is chosen as unit of the addition (such as Kilogram
per minute or second, for gas Normal cubic meter per minute or second) then the rate of
addition is entered into the table and it stays constant until a different value is entered.
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Options Tab
These settings are for the Process Metallurgy Calculator and are located on the
Configuration window → Options tab. Only unique settings are described below.

You can change some of these settings locally for a specific Process Metallurgy
Calculator or globally in the Options settings. To open the Options window:
From the main menu select Tools → Options. Click the Graphical Mode tab
then click Process Metallurgy.

You can manage your saved materials from the Tools → Options menu. For more
information see Working with the Material Manager.
Equilibrium Simulation: Conditions Tab

Process Material Equilibrium and Grid
Minimization Strategy
Under Process Material Equilibrium and Grid, the Minimization strategy setting is used to
ensure that the most stable minimum under the specified conditions is computed. The
default uses the Global test preferred option for Equilibrium simulations and the Local
minimization preferred option for Process simulations.
With either the Global or Local preferred setting, the program cycles through options before
it gives up:
l

l

For Global test preferred the minimization starts with a global test and if that fails it
runs full global minimization.
For Local minimization preferred the minimization starts with a local minimization,
in case of failure it tries a global test and finally a full global minimization.

If you choose Local minimization only or Global minimization only, the program just tries
the one setting and gives up if it fails.
For general information about global minimization, see the topic related to the
Console Mode command, GLOBAL_MINIMIZATION.

Max no of iterations
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Under Process Material Equilibrium and Grid, the default for the Max no. of iterations is
that the program tries 2000 iterations before it gives up.

Required accuracy
The default Required accuracy is 1.0E-6. This is a relative accuracy, and the program
requires that the relative difference in each variable must be lower than this value before it
has converged. A larger value normally means fewer iterations but less accurate solutions.
The value should be at least one order of magnitude larger than the machine precision.

Smallest fraction
Under Process Material Equilibrium and Grid, the default Smallest fraction is 1.0E-16. If
this value fails, the program tries other values. This is the value assigned to constituents that
are unstable.
The default value is for all phases except for the IDEAL phase with one sublattice
site (such as the GAS mixture phase in many databases) where the default value
is always as 1E-30.

Max grid points (in Global minimization)
Under Process Material Equilibrium and Grid, from the Max grid points list choose:
l

Coarse for 2000 grid points, the default,

l

Medium for 20,000 grid points,

l

Fine for 200,000 grid points, or

l

Custom to set your own number of grid points.

Approximate driving force for metastable phases
Under Process Material Equilibrium and Grid, the Approximate driving force for
metastable phases check box is selected by default, which means the metastable phases are
included in all iterations. However, these may not have reached their most favorable
composition and thus these driving forces may be only approximate.

Force positive definite phase Hessian
Under Process Material Equilibrium and Grid, the Force positive definite phase Hessian
check box is selected by default and this setting determines how to reach the minimum of an
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equilibrium state.

Control step size
Under Process Material Equilibrium and Grid, the Control step size check box is selected by
default and this setting determines how to reach the minimum of an equilibrium state.

Timestep Control
This section is used with the Process simulation calculations. Read About
Dynamic Time Stepping to better understand these settings.

Timestep
Under Timestep control, enter numerical values in the fields for the Timestep:
l

Initial %

l

Smallest allowed in seconds (s)

l

Max % of duration

Max temperature change per time step
Under Timestep control, in the field enter the Max temperature change per time step in
Kelvin (K).
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Scheduler and Event Log Windows
In this section:
Using the Scheduler

244

Event Log Window

246
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Using the Scheduler
The Scheduler window has activity information about current or scheduled jobs. A job is any
activity you have selected to be performed. The Scheduler also indicates if there is an error
during a job and when a job has stopped. If you have set an activity, tree or project to be
performed at a later time then this is also listed.

About the Scheduler Jobs
l

l

l

Whenever you trigger the performance of a whole project, tree or individual activity,
all the activities to be performed are shown under a job heading.
When all the activities belonging to a job are completed the job and its activities
disappear from the Scheduler window.
If there is an error during the performance of an activity, icons for that job and
activity remain in the Scheduler window until removed.
Node or Window Status Markers

Managing the Schedule
In the Scheduler window, you can cancel scheduled jobs, remove errors and show
information about errors.
l

l

To cancel all jobs: Right-click the Scheduled Jobs label or the cogwheel icon, and
select Cancel All Jobs
To remove (clear) all failed activities and jobs: Right-click the Scheduled Jobs label
or the cogwheel icon, and select Clear All Errors

Thermo-Calc User Guide: Graphical Mode ǀ 244 of 527

Thermo-Calc Documentation Set

l

l

l

To cancel a specific job: Right-click the job label (for example, Job no 1) and select
Cancel Job
To remove (clear) a specific failed job: Right-click the job label (for example, Job no
1) and select Cancel Job
To open a window with error details: Right-click the label for the failed job (for
example, Job no 1), and select Show Error Log
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Event Log Window
The Event Log window is closed by default. Information about what Thermo-Calc is
processing or doing is in blue text and error or warning messages are in red text.
Changing Global Settings

l

l

To open the Event Log window: Click the Event Log window once to expand it or
select it from the Window → Event Log menu. Double-clicking the window
maximizes it
To specify the level of detail in the Event Log: From the main menu select Tools
→Options. In the General tab set the Log level slide bar to anything between Debug
(most detailed) and Error (least detailed)
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Working with Plots and Tables
In this section:
Performing Projects, Trees and Activities

248

Saving and Printing the Output (Graphical Mode)

249

Zooming In and Out

252

Plotting Options

253

Plotting Several Calculations in One Diagram

256

Merging Plots into One Diagram

258

Adding Axes to a Diagram

260

Heat Map, Contour and 3D Plots

262

About the Uncertainty Calculations

270

Rotating 3D Plots

275
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Performing Projects, Trees and Activities
You can trigger the performance of an activity (also called a job) and all the activities below
it in the same tree in either the Project or Configuration window. In the Project window you
can also perform a single activity without performing its successors or perform the whole
project (all the activity trees).
In the Configuration window, click Perform Tree to perform the currently selected activity
and all the activities below it. If there are no activities below the selected activity, then the
button says Perform instead.
All activities that must be completed as prerequisites are automatically
performed first. For example, if you Perform Tree for a Plot Renderer, then the
predecessors, Equilibrium Calculator and System Definer, are automatically
performed before the Plot Renderer.
In the Project window, you can do any of the following:
l

l

l

Perform an activity: Right-click the activity and select Perform Now, or Perform
Later and schedule a time to perform the activity
Perform an activity and all activities below it in the tree: Right-click any node in the
tree and select Perform Tree Now. Or select Perform Tree Later and schedule a
time for all activities in the tree to be performed
Perform a project: Right-click My Project and select Perform Now or Perform Later
and schedule a time to perform all project activities in the tree
If there is an error during the performance of an activity, icons display status
markers, which are described in Node or Window Status Markers.
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Saving and Printing the Output (Graphical Mode)
Global Settings: Graphical and Console Mode Plotting

Output can refer to results in the form of tabulated data in a table or a
diagram.

The terms diagram and plot are interchangeable. The commands in Console
Mode generally use the term diagram and in Graphical Mode it is also called a
plot (e.g. the Plot Renderer).

In Graphical Mode the output is displayed in the Results window. The output can be in the
form of a table when you use the Table Renderer or a diagram (plot) when you use a Plot
Renderer. In both cases you can save from the Configuration or Results windows. You can
print the table or diagram from the Results window.

Saving Diagrams
You can save the output in a variety of file formats. For JPG and PNG images you can also
adjust the image quality.
In Console Mode, the diagram is output to the Console Results window after
using the PLOT_DIAGRAM command.
In Graphical Mode, the diagram is output to the Results window after
performing a tree that includes a Plot Renderer.
1. In the Results window, right-click the diagram and select Save as.
In the Graphical Mode Configuration window you can also click the Save
Diagram (or Save table) buttons to open the Save window.
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2. In the Save window:
a. Navigate to where you want to save the diagram.
b. Enter a File name.
c. From the Files of type list choose png(the default), jpg, ps, pdf, gif, svg, or
emf.
d. For PNG and JPG files only, under the Image Quality section, choose to
improve the resolution of the image. For JPG files you can also adjust the file
size.
l

l

To change the resolution of a PNG or JPG image, click to clear the Use
screen resolution check box. Then enter a numerical value in the Dots
per inch (DPI) field.
For JPEG files, you can also use the slider to choose a number between
0 and 1 for the JPG quality. The default is 0.9. The lower the number,
the smaller the file.

e. When you are ready, click Save.

Saving Tables
You can save the table output in different file formats.
In Graphical Mode, the diagram is output to the Results window after
performing a tree that includes a Table Renderer.
1. In the Results window, right-click the table and select Save as. Or in the Graphical
Mode Configuration window click the Save table button.
2. In the Save window:
a. Navigate to where you want to save the table.
b. Enter a File name.
c. From the Files of type list choose txt(the default), html, or xls.
d. When you are ready, click Save
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Printing Output
In the Results window, right-click the table or diagram and choose Print. Select additional
settings as required on the Print window.
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Zooming In and Out
In the Results window (where the plots are):
l
l

Use the mouse scroll wheel to zoom in and out.
Click and drag the mouse from left to right to highlight an area of the plot to zoom
into a specific point. Use the scroll wheel to continue zooming in or out.

Resetting a Plot to the Default View
l
l

For 2D plots, click and drag the mouse from right to left.
For 2D and 3D plots, click Perform Tree to regenerate the plot in the Results
window.
Rotating 3D Plots

In the Project window (where the activity nodes are):
l

Right-click and select Zoom In or Zoom Out.

l

To go back to the default zoom, select Reset Zoom.
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Plotting Options
The Plot Renderer is a dynamic activity node with options such as being able to:
l

add more than one Plot Renderer to its predecessor node (i.e. one of the calculator
activities),

l

add axes to the plots, and

l

merge results in one plot.

Plots Can Have More Than One Predecessor
A Plot Renderer can have several predecessors (if you want to plot several calculations in
the same diagram), in which case there are several tabs in the Configuration window, one
for each predecessor.
Plotting Several Calculations in One Diagram
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Several Plot Renderer activities (as well as Table Renderer activities) can be shown in the Results
window as different tabs. The figure is from Graphical Mode example T_04.

Add Axes to Plots
You can add additional X- and/or Y-axes to a plot to compare two or more variables at the
same time as in the figure.
Adding Axes to a Diagram

Two variables plotted on the Y-axis.

Merge Results in One Plot
You can merge (or overlay) calculated results for several variables into one plot. This is
similar to adding an axis, but instead of displaying different variables along the X- and/or Yaxes, the same X and Y variables are used to compare the third variable (defined in the Plot
Renderer as the Z-axis).
As in the figure (from example PM_G_03 in Graphical Mode Examples), the driving force
and interfacial energy results are combined into one diagram. The X and Y axis is the same
for both (Mass percent Cr/Mass percent Mn).
Merging Plots into One Diagram
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A contour plot showing both the driving force and interfacial energy calculation results comparing
Mass percent Cr to Mass percent Mn.
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Plotting Several Calculations in One Diagram
To plot several calculations in one diagram, you must have, in addition to the Plot
Renderer’s original predecessor, at least one available Plot Renderer predecessor in your
project, for example, the additional predecessor can be an Equilibrium Calculator, Binary
Calculator, Ternary Calculator, Scheil Calculator or Experimental File Reader.
1. In the Project window click the Plot Renderer node.
2. In the Configuration window click Add Predecessor. Or right-click the Plot
Renderer and choose Add Predecessor.

3. Select a predecessor. When added, the extra predecessor is linked to the Plot
Renderer. On the Plot Renderer’s Configuration window, the predecessors are shown
as two tabs:

4. Configure how you want each calculation plotted on the tabs in the Configuration
window, then click to Perform the Plot Renderer activity.
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The calculations are plotted in the same diagram in a tab in the Results window. If
any of the axis variables of the plots differ, then the label and scale of all calculations
are shown parallel to each other. The following shows two calculations where
different axes variables are plotted.
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Merging Plots into One Diagram
You can merge (or overlay) calculated results for several variables into one diagram. The
same X and Y variables are used to compare the third variable (defined in the Plot Renderer
as the Z-axis).
You cannot overlay heat map or frequency plots.
The following uses example PM_G_03: Driving Force and Interfacial Energy to describe the
steps to overlay two plots: the driving force and interfacial energy results are combined into
one diagram. The X and Y axis is the same for both (Mass percent Cr/Mass percent Mn).
1. In the Project window right-click the calculator node (e.g. Property Model
Calculator) and add a Plot Renderer node from the Create New Successor menu.
2. Click the Plot Renderer node.
3. In the Configuration window, define the plot. Available settings are based on the
calculation type.

Example
In this example the Property Model Calculator is set to a Grid calculation type.
Choose On for the Legend option and Contour as the Plot type.
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4. Click the Add an axis

button. A new axes settings section is added underneath.

5. From the Z Axis section choose the Axis variable. In this example, Interfacial energy.
6. Click Perform to plot both on the same diagram.
In this case, a contour plot showing both the driving force and interfacial energy
calculation results comparing Mass percent Cr to Mass percent Mn.
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Adding Axes to a Diagram
You can add additional X- and/or Y-axes to a plot to compare two or more variables at the
same time.
1. In the Project window right-click the calculator node (e.g. an Equilibrium Calculator)
and add a Plot Renderer node from the Create New Successor menu.
2. Click the Plot Renderer node.
3. In the Configuration window, define the plot. Available settings are based on the
calculation type.
4. Click the Add an axis

button. A new settings section is added underneath.

5. From the X Axis and/or Y Axis sections define another Axis variable and choose an
Axis type.
6. Click Perform to plot both variables on the selected axis, in this example, the Y-axis.
In this example Amount of phase and Volume are selected as the Y-axis variables
and Temperature as the X-axis variable. The plot is an example of the output.
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Heat Map, Contour and 3D Plots
Grid Calculations
Using an Equilibrium, Property Model, or Process Metallurgy Calculator, you can choose to
plot a Heat map, Contour or 3D diagram.
Equilibrium Calculator, Property Model Calculator, and Process Metallurgy Calculator

Heat Map
Each Z-axis variable value in the grid is represented by a color-coded area, where dark red
represents the highest Z-axis variable value and dark blue represents the lowest Z-axis
variable value.
Using an Equilibrium Calculator

Equilibrium Calculator: T_09: Carbide Driving Force Heat Map

Using a Property Model Calculator

Property Model Calculator: PM_G_02: Coarsening and Interfacial Energy
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Contour
Using a Property Model Calculator

Property Model Calculator example: PM_G_03: Driving Force and Interfacial
Energy
Z-axis variable values are traced with curves in the same way that height values are traced
with curves on a topographical map. The colors used originate from the different data
series.
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Using a Process Metallurgy Calculator

Process Metallurgy Calculator: PMET_02: Ladle Furnace (LF)
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3D
Rotating 3D Plots
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Using a Property Model Calculator

Using a Process Metallurgy Calculator

Process Metallurgy Calculator: PMET_02: Ladle Furnace (LF)
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Note when detaching a Results window with a 3D plot
If you detach a Results window that contains a 3D plot, the screen may go black. To get the
plot back simply regenerate it from the Configuration window (click Perform or Perform
Tree at the bottom of the window).

Note for Linux OS Using VirtualBox
The following is applicable to users running Thermo-Calc under Linux in a virtual machine
using VirtualBox.
Due to limitations in the OpenGL-drivers for VirtualBox, you will experience problems with
3D-plots unless the 3D-acceleration is disabled for the virtual machine being used.
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To disable the 3D-acceleration:
1. Open the main VirtualBox application.
2. In the list, right-click on the virtual machine running Thermo-Calc.
3. Select Settings.
4. Navigate to Display.
5. On the Screen tab, click to clear the Enable 3D acceleration check box.
If you are using other virtualization software and experience problems with the
3D plot, a similar solution might apply.

Uncertainty Calculations
Using a Property Model Calculator or Process Metallurgy Calculator (Uncertainty
calculation) you can choose to create either a histogram or probability plot.

The following use the Property Model Calculator example: PM_G_01: Phase
Transition
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Histogram

Probability
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About the Uncertainty Calculations
The Uncertainty calculation in Thermo-Calc uses the values (the mean) entered for
quantities under the Condition Definitions section as the starting point to estimate, within a
certain probability, the true variation of the quantity. Uncertainty calculations are available
with the Property Model Calculator and the Process Metallurgy Calculator.
An example of a Gaussian distribution is shown next. The example uses the Phase Transition
Model and an Uncertainty Calculation Type to describe how the sampling of data is
performed. The example PM_G_01: Phase Transition predicts the transition temperature to
the unwanted brittle Sigma phase and shows how the temperature is influenced by changes
to a steel alloy’s composition.
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Gaussian Distribution, the 3-Sigma Rule
l
l

The mean is at the peak of the curve (labeled μ).
The standard deviation (σ) is a plus and minus range, ±1σ, ±2σ or ±3σ, of the
variance from the mean.

Image by Dan Kernler: https://en.wikipedia.org/wiki/Normal_
distribution#/media/File:Empirical_Rule.PNG.

As long as the number of events (the sample size) is very large, then the Gaussian
distribution function can be used to describe physical events. A Gaussian distribution is
assumed to describe how each quantity varies in an uncertainty calculation, as shown next.

Condition Definitions and Sampling Settings
In Thermo-Calc, the mean of the quantity’s distribution is defined in the Condition Definitions
section. The Mean is then used in the Sampling of Data from Gaussian Distributions section
as the starting point for how much you want to deviate from this value.
The mean defined under Condition Definitions is used during the sampling.
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The values entered in the Δ Min/Max fields are the resulting width of the distribution
corresponding to the 95% confidence interval (approximately μ ± 2σ) shown in Gaussian
distribution, the 3-sigma rule.This confidence interval means that approximately 95% of the
sampled values fall within these limits, as shown next.

Sampling Parameter Settings
The default value for truncating the distribution is set at 3 standard deviations in the
Sampling Parameters section. This is also where you set the Total number of samples. The
default is 200. In order to maintain a Gaussian distribution for the varied quantities, this
number should not be too low.

You can experiment by varying the conditions and the number of samples to see the
distribution results smooth out as is to be expected based on the Central Limit Theorem, as
shown in the histogram plot. You can also plot the results as a normal probability.

Histogram Plot
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This series of histogram plots shows the uncertainty calculations sampling data from
Gaussian distributions. On the Plot Renderer the variable is set to measure the
Composition of Ni. It compares the Ni composition where the total sample size is increased.
In the example, the initial sample size uses the default, 200, and then the sample size is
increased to 300, 400, 600, 800, and 1000, showing how the plot follows the Gauss
distribution.

Normal Probability Plot
You can also plot the results as a Normal probability. Continuing with this example, for the
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Property Model Calculator the X Axis variable is plotted as Mass percent Ni and the Y Axis
variable is plotted as the Normal probability.

This is a normal probability plot example of the uncertainty calculations sampling data from
Gaussian distributions. It compares the Ni composition where the total sample size is 200.
The sampled data (blue line) closely follows the ideal normal distribution (red line).
Deviations are naturally larger at the tails (≈1%Ni and ≈2%Ni) since the number of samples
are fewer there compared to the center of the distribution.
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Rotating 3D Plots
Heat Map, Contour and 3D Plots
When you use a Grid calculation type you can plot the diagram in 3D.
In the Results window after you create the 3D plot:
l

l

l

Rotate the diagram automatically. Double-click in the Results window and the
diagram rotates clockwise. Click once to stop the automatic rotation.
Rotate the diagram manually. Click and hold the mouse and move it around the
Results window.
Use the mouse wheel to zoom in and out. To reset the plot to its default view click
Perform Tree to regenerate the plot.
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Plot and Table Formatting
In this section:
Setting Background Colours

277

Changing the Plot Properties

278

Plot Labels

279

Plot Labels: Entering a Mixture of Plain Text and Equations

280

Plot Labels: Rotation Angle and Show Anchor

281

Moving Plot Labels

282

About Legend Styles

283

Legend and Label Styles

284
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Setting Background Colours
To change the background colours of the table, in the Results window right-click a Table
Renderer tab, and select Properties. Modify as required.

The defaults for these settings can be changed globally. To open the Options
window: From the main menu select Tools → Options and click the Activities
tab. Then click Tabulation.
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Changing the Plot Properties
For global changes to the default settings plots see Global Settings: Graphical and Console
Mode Plotting. The settings are the same but applied to all new plots.
To make local changes to the appearance of a specific plot, in the Results window right-click
a plot and select Properties. You can also edit some properties for individual plot lines (the
color, the line width and type, and whether data points are included).
In the Results window, hover the mouse over a plot line. When it is over a line that can
clicked the crosshair cursor turns into a pointing finger.

To prevent unintended edits, hold down <Ctrl> while moving the cursor around
the plot to only display it as a crosshair.
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Plot Labels
To add a label text at a certain point in a plot, right-click the point, and select Add Label. For
phase diagrams, the program suggests a label that you can keep or edit. The suggested label
specifies the names of the stable phases at the coordinate where you clicked. For all other
plot types, you enter your own text, which can either be Plain text or LaTeX formatted text.

You can enter the label as Plain text or in LaTeX-formatted text. For LaTeX-formatted text
enter or edit the text as required. For example, underscores (_) are added before the
numbers to make subscripts in the label.
For a list of supported LaTeX commands, see:
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html.

By default when using LaTeX, you are in math mode and Thermo-Calc
automatically interprets the entered text as math. The above link uses the
dollar sign ($) in all the examples but this is NOT required. For example, if you
enter $E=mc^2$ this is displayed including the $ instead of the equation.
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Plot Labels: Entering a Mixture of Plain Text and
Equations
When you enter text using LaTaX formatted text it displays by default on the plot in italics
and treats the text as an equation.
As in the following example, the top label does not display correctly because the label is a
mixture of text (Mole-Fraction) and an equation (Al2O3). In the bottom image, when the
same information is added as Plain text to the plot it now does not include the subscripts.

To add a mixture of plain text and equation text, you can exit math mode using the string
\textrm followed by the text to display enclosed in curly brackets. For example \textrm
{Mole-fraction }Al_2O_3 results in the label as shown:

In this example, you need to add a space at the end of fraction in order to
separate the text from the equation part of the label.
When working in Console Mode, you can also use the above windows on the
Console Results window to add and edit labels. In addition, you can use the
command.
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Plot Labels: Rotation Angle and Show Anchor
By default the Show anchor check box is selected, which includes an arrow from the label
point to the coordinates.
If you do not want the label oriented horizontally in the Plot Renderer tab, then specify the
number of degrees of rotation in the Rotation angle field.
Click OK to add the label to the plot. You can also move a label by clicking and dragging it.
The default anchor arrow is added to indicate the point that belongs to the label.
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Moving Plot Labels
Drag and drop labels anywhere on the plot. The anchor arrow points to the point of origin.

Close up of a plot label before being moved (top) and after being moved (bottom). The arrow in the
lower image points to the label's original location on the plot.
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About Legend Styles
There are a variety of legend styles you can use to display detail about the phases. The same
legend styles are available for both Graphical Mode and Console Mode plots.
For Console Mode, use the command CHANGE_LEGEND.
In Graphical Mode the label styles are defined when using the Plot Renderer. You can select
a Legend style for the Stable phases or Axis quantity selected for Legend option.
When there is a legend in the diagram you can append constitution and/or ordering
descriptions to the phase name.
If constituent description is included in the legend, then for each equilibria along a line in
the diagram, the largest constituent fractions are summed until they are equal or greater
than 0.6. This is done separately for each sublattice. If the equilibria along the line gets
different sets of constituents these are all appended to the list for that sublattice.
The ordering description is only printed for partitioned phases (phases that have a
disordered contribution) that begins with at least two identical sublattices (sublattices where
the set of constituents are identical). DISORD (disordered) is shown if site fractions are
identical between identical constituents on all identical sub lattices (with an error margin)
otherwise ORD (ordered) is shown in the legend.
If ordering between equilibria in a line are different, then ORD
legend.

+ DISORD

is shown in the

Thermo-Calc User Guide: Graphical Mode ǀ 283 of 527

Thermo-Calc Documentation Set

Legend and Label Styles
Legend Styles
To show the differences between labels, the following uses the same example file that
creates Figure 6 in TCNI database extended information document (found on the ThermoCalc website).
When All is selected for this specific example the label includes the following:

Specifically:
l

l
l

There are two disordered FCC phases (matrix and carbide), one ordered FCC
(gamma prime), plus a phase NI3TA_D0A (called Delta in Ni-alloys).
ORDERING shows the different FCC phases.
CONSTITUTION shows that FCC_L12#1 is NbC, FCC_L12#2 is matrix with Ni and Cr as
major constituent, FCC_L12#3 is Ni3Al with Nb addition and NI3TA_D0A is Nb-rich
(eg. Ni3Nb).

Label Styles
These examples are for each label style choice - None, All, Constitution or Ordering. The
instructions are for when you are setting the options using the Plot Renderer. In Console
Mode, you choose the options (ALL, NONE, CONSTITUTION, or ORDERING) after the command
CHANGE_LEGEND.

None
When None is selected the legend includes the standard information about the phases.
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All
When you select All the Constitution description and the Ordering description (when
there is ordering) are included.

Constitution description
When you select Constitution description, this is added to the standard description.

Ordering description
When you select Ordering description and when there is ordering, this is added to the
standard description.
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Property Model Development Framework
In this section:
Introduction to the Property Model Development Framework

287

Property Model Installation Directory

289

Creating a Custom Property Model

290

PDF: Property Model Framework Guide

291
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Introduction to the Property Model Development
Framework
Use the standalone PDF included with this documentation set for IDE and
tutorial instructions. The PDF guide is also available in the Manuals folder,
accessible from the Help menu.

This API is like a plug in to Thermo-Calc. It is not an SDK. That is, you cannot use
this API to build other applications to work with Thermo-Calc like you would use
the TC-API or the TQ-Interface.

The Property Model Calculator in Thermo-Calc Graphical Mode has predefined models
available for immediate use and new models are being added on a regular basis. The
Property Model Development Framework enables you to create custom Property Models that
are then able to be included with the Property Model Calculator and ultimately used for
your simulations.

When you use the Property Model Development Framework API, it extends the software to
enable you to create Property Models. The models are written in the easy-to-learn
programming language Python and the API provides seamless integration into ThermoCalc. This includes access to thermodynamic and kinetic calculation routines as well as to
the Thermo-Calc plotting system.
The API is based on Jython, which is a Python implementation running in the Java Virtual
Machine. All Python libraries that are compatible to the Jython distribution can be used
within the model (but not libraries based on native C-code).
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Model development is possible without any additional installation by using a
text editor (for example Notepad++). However, it is recommended you use a
Python Integrated Development Environment (IDE), which provides you with
advanced features such as debugging and auto-completion.
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Property Model Installation Directory
All Property Models (whether these are predefined or custom models) must be
located in a subdirectory of the Property Model directory. You can go to Tools
→ Options and the Model directory field displays the default directory.

Predefined models included with the Property Model Calculator are installed in the locations
below based on your operating system. If you create your own models, this is the default
directory where these are saved. You can also use one of these as a template to create your
own Property Model.
Operating
System
Windows

Linux

Property Model Installation Directory
C:\Users\<user>\Documents\Thermo-Calc\2020b\PropertyModels

On Linux all user files are installed where the program is installed. If installed as
root the default is:
/opt/Thermo-Calc/2020b/PropertyModels

macOS

/Users/Shared/Thermo-Calc/2020b/PropertyModels
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Creating a Custom Property Model
There is a guide, including tutorials and the classes and methods of the API,
available as a separate PDF, included with your installation (Help>Manuals
Folder) and on our website. It includes details of the API classes and methods
and details about how to debug with an IDE.
Example models demonstrating the most important features can be found in the tutorial
examples included in the PDF Guide. The PDF includes the instructions and code you can
copy. Example models are also in the Property Model directory.
A new Property Model can be created and modified at any time during a Thermo-Calc
session. The model is automatically reloaded and you do not need to restart Thermo-Calc.

Property Model Tutorials
The tutorial Python files are available with your installation. These examples are also
included with the PDF guide but placed in the installation folder to make it easier to copy the
text and re-use it in your own Python files.
There is a PDF guide and tutorial examples included with your installation. In Thermo-Calc
from the menu, select Help → Manuals Folder. Then double-click to open the Property
Model Development Framework folder. This guide is also available on our website.
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CHAPTER

ONE

INTRODUCTION

1.1 Thermo-Calc Custom Property Models
The Python Property Model API extends the Thermo-Calc software to enable you to create your own property models
written in the easy-to-learn programming language Python and the API provides seamless integration of the property
models into Thermo-Calc. This includes access to thermodynamic and kinetic calculation routines as well as to the
Thermo-Calc plotting system.
The API is based on Jython, which is a Python implementation running in the Java Virtual Machine. All Python
libraries that are compatible to the Jython distribution can be used within the model (but not libraries based on native
C-code).
Model development is possible without any additional installation by using a text editor (for example Notepad++).
However, using a Python Integrated Development Environment (IDE) provides you with advanced features such as
debugging and auto-completion.

1.2 Architecture of the Python Property Model API
Every property model needs to contain a class that implements the interface PythonPropertyModel. It is the
interface to the Thermo-Calc system and calculation engine and provides the calculation results to the Thermo-Calc
plotting engine.

The basic building blocks of the property model API are:
• ResultQuantity: Defines a calculation result of a property model that will be provided by the property
model after a model evaluation
1
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classes: ResultQuantity
• ThermoCalcCalculator: Thermodynamic calculation engine of Thermo-Calc for the property models
classes: ThermoCalcCalculator
• ThermoCalcSystem: Provides all helper functionality within the property models to access the ThermoCalc / GUI functionality
classes: ThermoCalcSystem
• UIComponent: UI components available within the model panel. Different components are available (for
example checkboxes, text fields and lists)
classes:
– UIBooleanComponent
– UICompositionComponent
– UIConditionListComponent
– UIFloatComponent
– UIGeneralListComponent
– UIPhaseListComponent
– UITemperatureComponent

1.3 Call Events for the Property Model Methods
The table lists which events trigger the property model methods (defined in the interface PythonPropertyModel):
Interface method
before_evaluations()

Event triggering the method to be called
once after the Perform button is clicked, before any call
to evaluate_model()
evaluate_model()
once for each set of conditions, always after the call to
before_evaluations()
get_thermocalc_system()
before any other method call - if the system state in
Thermo-Calc has changed
provide_calculation_result_quantities() after each call to evaluate_model()
provide_model_category()
whenever the Thermo-Calc UI needs to (re-) display components containing model information (for example the
model tree)
provide_model_description()
once when the model panel is painted (this happens also
whenever a model gets checked in the model tree)
provide_model_name()
whenever the Thermo-Calc UI needs to (re-) display components containing model information (for example the
model tree)
provide_ui_panel_components()
once when the model panel is displayed (this happens
also whenever a model gets checked in the model tree)
The methods of a single property model are always executed sequentially.
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CHAPTER

TWO

INSTALLING JYTHON AND SETTING UP AN IDE

2.1 Installing Jython
This section describes the installation of Jython 2.7.0, but you should install the latest available version.
Note: The Jython installation is only required if you want to have full support of your IDE during the model development (autocompletion, debugging, and so forth). The property models will run automatically in Thermo-Calc using
the Jython installation already bundled to Thermo-Calc.
• Before installing Jython, you need to have a correctly working Java SDK installation as a prerequisite.
• Download the latest Jython distribution from www.jython.org (the current installer version is
jython-installer-2.7.0.jar)
• Execute the installer JAR-file.
• Choose the Standard installation.

2.2 Setting up the IDE
The Python property models can be developed using any text editor. For full functionality (autocompletion, debugging, etc.) it is recommended to use a Python IDE. The options described are the IDEs IntelliJ IDEA Ultimate and
PyCharm Professional developed by JetBrains. Another suitable example is the Microsoft Visual Studio Community
using the Python Tools for Visual Studio. If debugging the property models is a requirement, then it is necessary to
use commercial versions of IntelliJ or PyCharm, otherwise the Community editions are sufficient.

2.2.1 IntelliJ IDEA
The information in this section is applicable to IntelliJ IDEA 2016. It is primarily a Java IDE and requires
a plugin for full support of Python:
• Go to File -> Settings -> Plugins.
• Choose Search in repositories to search for the Python plugin.
• Install the plugin.
Installing a Python SDK:
• Go to File -> Project Structure.
• Click the + to add a new SDK under Platform Settings -> SDKs.

3
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• Choose Python SDK and Add Local.
• Select the file jython.exe within the Jython installation, typically located in C:\jython2.7.
0\bin\jython.exe
Setting the Project SDK (required for each model):
• Choose the Jython SDK within the Project tab as your Project SDK.
• Add a dependency to the Python property model API in the Modules tab:
– Choose your module and navigate to the Dependencies tab.
– Click + and choose JARs or directories . . . .
– Choose the Python property model API directory (PropertyModels/Interface/
ThermoCalcModelInterface within the property model directory).

2.2.2 PyCharm
This is required for each model:
Installing a Project Interpreter:
• Go to File -> Settings.
• Add a new Project Interpreter by navigating to your project and clicking +.
• Choose Add Local.
• Select the file jython.exe within the Jython installation,
C:\jython2.7.0\bin\jython.exe

typically located in

Adding a dependency to the Python property model API:
• Click the settings button for the selected Jython interpreter within the Project Interpreter and
choose More . . .
• Choose the Jython interpreter in the list of available Python interpreters and click Show paths
for selected interpreters.
• Click the + to add the Python property model API directory (PropertyModels/
Interface/ThermoCalcModelInterface within the property model directory).
Note: When you add the Phython property model API directory to the interpreter settings, it changes
your Jython installation. Consequently you may want to use a virtual environment.

4
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CHAPTER

THREE

CREATING A NEW PROPERTY MODEL

A new property model can be created and modified at any time during a Thermo-Calc session. The model is automatically reloaded and you do not need to restart Thermo-Calc.
Note: All property models must be located in a subdirectory of the property model directory. It is located within the
Thermo-Calc home directory, which differs for the supported platforms.

Operating system
Windows
Linux
Mac

Property model directory
C:\Users\Public\Public Documents\Thermo-Calc\ 2020b \PropertyModels
/home/user/Thermo-Calc/2020b/PropertyModels
/Users/Shared/Thermo-Calc/2020b/PropertyModels

Make sure that the Model directory path in the Thermo-Calc dialog Tools -> Options -> General points to the correct
property model directory path.
How to Create a New Model:
• Start Thermo-Calc.
• Add a Property Model Calculator to a project in Thermo-Calc.
• Create a new folder within the model directory (as per the installed location). The folder can be given any
name.
• Create a new Python model file or copy a file from another model, such as a predefined one. The file
extension is *.py. For now, ignore any error messages in the Event Log in Thermo-Calc stating that the
file does not fulfill the requirements for a property model.
• Give the model a valid file name identical to the model class name (“XYModel.py”)
• Assign the Jython interpreter and the dependency to the property model API within your IDE (see Setting
up the IDE)
• Extend the model class XYModel to fully implement the interface PythonPropertyModel
• Implement the model (see Tutorial)
Thermo-Calc automatically updates the model whenever it is changed in an editor. If UI components are
changed you need to reload the model. Do this by deselecting the check box next to the model and then selecting
it again to reload the model.
The model directories can be moved and renamed during the Thermo-Calc session without limitation. When moving
or deleting a model from a directory, it is required to move or delete the XYModel.py and the XYModel.py.
encrypted file. If the encrypted file is left in its original place, that model will only be switched from the debuggable
to the non-debuggable model (see Debugging).

5
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Example models demonstrating the most important features can be found in the chapter Tutorial and in the property
model directory.
Note: The Python file as well as the model class need to follow the syntax “XYModel”. This name needs to be
unique within all property models. You can define other classes or methods within the model file as long as these
do not interfere with the required syntax for a model.

Note: It is possible to store several models within one model directory. These are distinguished based on their model
name.
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CHAPTER

FOUR

TUTORIAL

4.1 Example 1: A Basic Property Model with Thermodynamic Properties
This tutorial demonstrates the most relevant tasks to create a property model. A basic property model is created that
provides you with the fraction of a certain phase in dependency of any defined condition.
Let’s first take a look at the complete model code. The source code must be saved in a file (e.g. Example1Model.
py) in a subdirectory of the property model directory for your operating system (see Creating a New Property Model
for details). You can copy the code below directly to your editor, but make sure to remove all line break characters.
from PythonPropertyModel import PythonPropertyModel
from ThermoCalcSystem import *
from ThermoCalcCalculator import ThermoCalcCalculator

class Example1Model(PythonPropertyModel):
"""Example 1"""
_PHASE_FRACTION_QUANTITY = "PHASE_FRACTION_QUANTITY"
_PHASE_LIST = "PHASE_LIST_COMPONENT"
def __init__(self):
"""Constructor"""
self._thermocalc_system = None

# type: ThermoCalcSystem

def get_thermocalc_system(self, thermocalc_system):
"""Called by Thermo-Calc whenever an updated state of the Thermo-Calc core
,→system needs to be injected into the model"""
self._thermocalc_system = thermocalc_system
def before_evaluations(self, calculator):
"""Called by Thermo-Calc immediately before the first model evaluation (using
,→evaluate_model). Use this method for any required preparations."""
pass
def provide_model_category(self):
"""Called by Thermo-Calc when the model should provide its category (shown in
,→the Thermo-Calc model tree)."""
return ["Examples"]
def provide_model_name(self):
"""Called by Thermo-Calc when the model should provide its name (shown in the
,→Thermo-Calc model tree)."""
return "Example 1"
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def provide_model_description(self, locale):
"""Called by Thermo-Calc when the model should provide its detailed
,→description."""
description = "This is an example model."
return description
def provide_calculation_result_quantities(self):
"""Called by Thermo-Calc when the model should provide its result quantity
,→objects."""
result_quantities = [create_general_quantity(Example1Model._PHASE_FRACTION_
,→QUANTITY, "Phase fraction")]
return result_quantities
def provide_ui_panel_components(self):
"""Called by Thermo-Calc when the model should provide its UI components for
,→the model panel to be plotted."""
ui_components = [create_phase_list_ui_component(Example1Model._PHASE_LIST,
,→"Phase: ", "Phase list", default_phase="FCC_A1")]
return ui_components
def evaluate_model(self, calculator):
"""
Called by Thermo-Calc when the model should be actually calculated.
:param calculator:
Calculation engine
:type calculator:
ThermoCalcCalculator
"""
chosen_phase = self._thermocalc_system.get_ui_list_value(Example1Model._PHASE_
,→

LIST)

calculator.compute_equilibrium(True)
phase_frac = calculator.get_single_value("NPM(" + chosen_phase + ")")
self._thermocalc_system.set_result_quantity_value(Example1Model._PHASE_
,→FRACTION_QUANTITY, phase_frac)

Every property model is a Python model containing the model class. This class needs to be derived from
PythonPropertyModel, which is the interface for all property models. You need to implement all of its abstract methods. Generally, when executing a property model, Thermo-Calc is calling these methods to either obtain
information from the model or to transfer data to the model.
Note: The Python file as well as the model class must follow the syntax “XYModel”. This name must be unique
within all property models. You can define other classes or methods within the model file as long as these do not
interfere with the required syntax for a model.

4.1.1 Access to the Thermo-Calc System
At any time you can access all data from the Thermo-Calc system and especially from the predecessor activity nodes (for example from the System Definer) via a ThermoCalcSystem object. That
object is updated when, for example, the configuration in the System Definer changes. If that happens, a new object is provided by Thermo-Calc to the model by calling PythonPropertyModel.
PythonPropertyModel.get_thermocalc_system(). It is recommended that you define an
instance variable, which gives access to the up-to-date object at all times:
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def __init__(self):
"""Constructor"""
self._thermocalc_system = None

# type: ThermoCalcSystem

def get_thermocalc_system(self, thermocalc_system):
"""Called by Thermo-Calc whenever an updated state of the Thermo-Calc
,→core system needs to be injected into the model"""
self._thermocalc_system = thermocalc_system

Note: Any method within the API provides a docstring, that can be used by the IDE to provide you
autocompletion and autodocumentation. But as Python is using duck-typing, the API cannot always
derive the correct variable types automatically. The constructor above shows an example on how to give
a type hint to the IDE (PyCharm / IntelliJ IDEA) to provide autocompletion (in the example for self.
_thermocalc_system).

4.1.2 Basic Information About the Model
These methods provide the model category, name and description and are used by Thermo-Calc to present
the models within a tree component in the Property Model Calculator:
def provide_model_category(self):
"""Called by Thermo-Calc when the model should provide its category
,→(shown in the Thermo-Calc model tree)."""
return ["Examples"]
def provide_model_name(self):
"""Called by Thermo-Calc when the model should provide its name (shown
,→in the Thermo-Calc model tree)."""
return "Example 1"
def provide_model_description(self, locale):
"""Called by Thermo-Calc when the model should provide its detailed
,→description."""
description = "This is an example model."
return description

A property model can be included in multiple categories. The description should contain helpful information to the user regarding the scientific background of the model as well a short description about how to
use it. You can use usual string formatting (“\n”, . . . )

4.1.3 Defining Input and Output Parameters
All required input parameters are defined by creating components for the User Interface (UI). Every output
parameter is defined as a ResultQuantity.
def provide_calculation_result_quantities(self):
"""Called by Thermo-Calc when the model should provide its result
,→quantity objects."""
result_quantities = [create_general_quantity(Example1Model._PHASE_
,→FRACTION_QUANTITY, "Phase fraction")]
return result_quantities

4.1. Example 1: A Basic Property Model with Thermodynamic Properties
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The result quantities need to be provided within a list. Several result quantity types are available that
provide different predefined properties, for example for a temperature.
Caution: Every result quantity is expected to be provided in SI units.
The purpose of the result quantity objects is to provide a container for transfering calculation results from
the model to Thermo-Calc for plotting and other tasks. You will later assign values to the result quantities
in the PythonPropertyModel.PythonPropertyModel.evaluate_model() method.
def provide_ui_panel_components(self):
"""Called by Thermo-Calc when the model should provide its UI components
,→for the model panel to be plotted."""
ui_components = [create_phase_list_ui_component(Example1Model._PHASE_
,→LIST, "Phase: ", "Phase list", selected_phase="FCC_A1")]
return ui_components

Each input parameter is represented by a UI-component. The property model API provides the
most common ones. The order in the list defines the order of appearance in the Property Model
Calculator window. You can later read the values set by the user in PythonPropertyModel.
PythonPropertyModel.evaluate_model().
Example of a more complex property model UI:

4.1.4 Performing the Calculations
Any setup that is required before the calculations needs to be provided in the method
PythonPropertyModel.PythonPropertyModel.before_evaluations():
10
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def before_evaluations(self, calculator):
"""Called by Thermo-Calc immediately before the first model evaluation
,→(using evaluate_model). Use this method for any required preparations."""
pass

The model is evaluated separately for every set of conditions. This means that in case of varying, for
example two component concentrations, the PythonPropertyModel.PythonPropertyModel.
evaluate_model() method is called separately for each composition:
def evaluate_model(self, calculator):
"""
Called by Thermo-Calc when the model should be actually calculated.
:param calculator:
Calculation engine
:type calculator:
ThermoCalcCalculator
"""
chosen_phase = self._thermocalc_system.get_ui_list_value(Example1Model._
,→PHASE_LIST)
calculator.compute_equilibrium(True)
phase_frac = calculator.get_single_value("NPM(" + chosen_phase + ")")
self._thermocalc_system.set_result_quantity_value(Example1Model._PHASE_
,→FRACTION_QUANTITY, phase_frac)

Note how type hinting for providing autocompletion is implemented in the example.
Tip: If sophisticated Thermo-Calc functionality is required that is not directly available within the Python
API, Thermo-Calc Console Mode commands can be used: You have access to the full set of ThermoCalc Console Mode commands available in Poly3 by using the methods ThermoCalcCalculator.
ThermoCalcCalculator.send_command_to_poly3() and ThermoCalcCalculator.
ThermoCalcCalculator.get_single_value().

Caution: The lifetime of the ThermoCalcCalculator object is restricted to the subsequent
calls to PythonPropertyModel.PythonPropertyModel.evaluate_model() and the
initial PythonPropertyModel.PythonPropertyModel.before_evaluations() call
while performing a model calculation. Consequently you must not store that object within an instance
variable.
The screenshot shows an example calculation with the property model for the Fe - 10 Ni - x Cr system using the
FEDEMO database, illustrating the functionality of the model:

4.1. Example 1: A Basic Property Model with Thermodynamic Properties
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4.2 Example 2: Property Model Using Apache Math
This example describes how to perform mathematical calculations using the Java Apache Math library.
To keep it simple the sine of the temperature is calculated. This has limited practical application and is
intended only as a demonstration.
Note: The Python property models in Thermo-Calc are executed as Jython code within the Java Virtual
Machine of Thermo-Calc. It means that any Java library can be imported and used directly within the
models. This includes the Apache Math library for numerical calculations.

Caution: Within Jython it is not possible to use any Python library based on native code (typically
C-code). Consequently the property models cannot use the numerical Python libraries NumPy and
SciPy. Instead use the Java Apache Math library.
The Apache Math library is automatically added to the classpath when executing the property model within Thermo-Calc.
However, you will need to add a reference to the file
commons-math3-version.jar in your IDE if you want to have autocompletion support. This file
is located in the Thermo-Calc installation directory. For example IntelliJ IDEA supports referencing that
Java-JAR, while this is not possible using PyCharm. However, this does not prevent you from running the
property model in Thermo-Calc.
This is the code for the property model. Remember that it needs to be stored in the file
Example2Model.py in a subdirectory of the property model directory:
# Python libraries
from PythonPropertyModel import PythonPropertyModel
from ThermoCalcCalculator import ThermoCalcCalculator
from ThermoCalcSystem import *

12
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# Java libraries
from org.apache.commons.math3.analysis.function import Sqrt

class Example2Model(PythonPropertyModel):
"""Example 2"""
_SQUARE_ROOT = "SQUARE_ROOT"
_INVERT_RESULT_CHECKBOX = "INVERT_RESULT_CHECKBOX"
def __init__(self):
"""Constructor"""
self._thermocalc_system = None
self._sqrt_provider = Sqrt()

# type: ThermoCalcSystem

def get_thermocalc_system(self, thermocalc_system):
"""Called by Thermo-Calc whenever an updated state of the Thermo,→Calc core system needs to be injected
into the model"""
self._thermocalc_system = thermocalc_system
def before_evaluations(self, calculator):
"""Called by Thermo-Calc immediately before the first model
,→evaluation (using evaluate_model). Use this
method for any required preparations."""
pass
def provide_model_category(self):
"""Called by Thermo-Calc when the model should provide its category
,→(shown in the Thermo-Calc model tree)."""
return ["Examples"]
def provide_model_name(self):
"""Called by Thermo-Calc when the model should provide its name
,→(shown in the Thermo-Calc model tree)."""
return "Example 2"
def provide_model_description(self, locale):
"""Called by Thermo-Calc when the model should provide its detailed
,→description."""
description = "This is an example model."
return description
def provide_calculation_result_quantities(self):
"""Called by Thermo-Calc when the model should provide its result
,→quantity objects."""
result_quantities = [create_general_quantity(Example2Model._SQUARE_
,→ROOT, "Square root")]
return result_quantities
def provide_ui_panel_components(self):
"""Called by Thermo-Calc when the model should provide its UI
,→components for the model panel to be plotted."""
ui_components = [create_boolean_ui_component(Example2Model._INVERT_
,→RESULT_CHECKBOX, "Invert result: ",
"Determines if the result
,→will be inverted ...", True)]
return ui_components

4.2. Example 2: Property Model Using Apache Math
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def evaluate_model(self, calculator):
"""
Called by Thermo-Calc when the model should be actually calculated.
:param calculator:
Calculation engine
:type calculator:
ThermoCalcCalculator
"""
temp = calculator.get_temperature()
square_root = self._sqrt_provider.value(temp)
if self._thermocalc_system.get_ui_boolean_value(Example2Model._
,→INVERT_RESULT_CHECKBOX):
square_root = -square_root
self._thermocalc_system.set_result_quantity_value(Example2Model._
SQUARE_ROOT, square_root)

,→

In more practical examples, the numerical calculations would be coupled to thermodynamic calculations.
The screenshot shows an example of a calculation with the dummy property model:
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CHAPTER

FIVE

DEBUGGING

All property models that are available as Python source code can be debugged from an IDE using a Python remote
debugger.
Note: Most built-in Thermo-Calc property models are only available as encrypted files and cannot be debugged.
A property model is in the debuggable state, if its Python-file (XYModel.py) is available in the model directory in
Thermo-Calc. If only the encrypted file (XYModel.py.encrypted) is present, it is in the non-debuggable state
and can be executed but not debugged.
Remote debugging should be possible with any remote debugging library for Python that works with Jython. ThermoCalc has tested IntelliJ IDE Ultimate / PyCharm Professional to work with the Thermo-Calc property models. You
can use any editor or the Community edition of IntelliJ IDEA / PyCharm, however debugging of the models is not
available.

5.1 Setting up IntelliJ IDEA / PyCharm for Debugging Models
It is expected that the IDE is set up completely according to Setting up the IDE.
The Thermo-Calc application is running in a Java Virtual Machine and is invoking the Python code of the model via
Jython. The following steps are required to prepare remote debugging in IntelliJ IDEA Ultimate (note that the IntelliJ
Community Edition does not provide remote debugging functionality):
• Place the following lines in the Python model in front of the part you want to debug:
– Typically these are placed at the beginning of the
PythonPropertyModel.evaluate_model() method:

PythonPropertyModel.

import sys
sys.path.insert(0, "C:\\Users\\UserName\\.IntelliJIdea2016.
,→3\\config\\plugins\\python\\pycharm-debug.egg")
import pydevd
self._thermocalc_system.log_warning("Attach now to the process to proceed ...
,→")
# optional to inform the user that the model waits for the debug server
pydevd.settrace('localhost', port=5678, stdoutToServer=True,
,→stderrToServer=True, suspend=True)

Warning:
• Currently you must not use the pydevd-library available via pip on PyPy. It is outdated and does not work
as expected. Use the version bundled to IntelliJ IDEA as shown above.
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• You may use any port; the only requirement is that it is unused by other programs.
• Create a remote debugger configuration in IntelliJ:
– Go to the menu “Run”, choose “Edit configurations” and add a configuration by clicking “+”.
– Choose “Python Remote Debug”.
– Give that configuration a good name, for example “Remote Debug Server”.
– Set the host name to “localhost” and the port to that defined in your Python source code (5678 in our
example).
• Start debugging:
– Choose the remote debugging configuration defined above and start it in debug mode (Crtl + F9). It
should give now a wait message in the output window.
– Start your desired user-defined property model calculation in Thermo-Calc by clicking Perform
tree. The model should now connect to the debug server and the IDE should stop directly after
the settrace() call in the Python model.
– Now you can inspect your variables and step through the code. You can also use the “Debug Command
Line” in the menu “Tools” for interactive testing.
– You can safely ignore warnings that are occurring.
Note: Thermo-Calc executes the model in a temporary subprocess. This means that the model opens a new connection
to the debug server during each execution. This is intended behavior and implies that the connection does not need to
be closed manually.

5.2 Editing Your Model during a Thermo-Calc Session
You can edit your model at any time, once it is saved. It is automatically reloaded by Thermo-Calc and can immediately be used without restarting Thermo-Calc. You can also debug the edited model.
Note: If IntelliJ IDEA misses a source file during remote debugging, it opens an empty file <string> or emits
error messages similar to “Error in file “<string>”, line unknown” if the source file where the error occurred cannot
be found. In that case you can still proceed debugging by using “Resume Program” (using the F9 key).

Warning: Thermo-Calc does not trigger reloading the model if another imported module than the model itself
has been edited.
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CHAPTER

SIX

PROVIDING TRANSLATIONS

The Property Model Framework supports multi-language property models based on Java Properties-files. All property
models released by Thermo-Calc are using that mechanismn to provide a user interface in all languages supported by
Thermo-Calc. This functionality can be as well applied by any user in their own property models.

6.1 Example
The following code snippet shows how to implement localized property models using the class
JavaPropertyManager (the model needs to have the source file name MyModel.py):
from JavaPropertyManager import JavaPropertyManager
# further imports to come here
def __init__(self):
"""Constructor"""
self._properties = JavaPropertyManager("MyModel")
# all other methods to come here
def provide_model_name(self):
"""Called by Thermo-Calc when the model should provide its name (shown in the
,→Thermo-Calc model tree)."""
return self._properties.get("modelName.text")

The corresponding snippet of the Properties-file MyModel.properties could look like that:
modelName.text=MyModel
modelCategory.text=General Models

For example a Properties-file MyModel_de.properties that is translated to German looks like:
modelName.text=Mein Modell
modelCategory.text=Allgemein

6.2 Java Properties-files
The class JavaPropertyManager automatically chooses the language that is currently set in Thermo-Calc. When
using localization, you need to provide at least the default Properties-file (syntax: XYModel.properties). In that
file the English translations should be provided. Further translations can be provided in Properties-files with the syntax
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XYModel_sv.properties (or equivalent for other languages). If the required Properties-file or a certain key is
missing, Thermo-Calc uses automatically the key in the default Properties-file.
The Properties-files must either be placed in the property model resources directory jythonModelsResources
that is located in the program file directory of your installation (for example C:\Program Files\Thermo-Calc\ 2020b
\jythonModelsResources on Windows) or you can pass a user-defined location to the JavaPropertyManager
constructor.
Please obtain more general information on Java Properties-files from the Java documentation if required.
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CHAPTER

SEVEN

API REFERENCE

7.1 PythonPropertyModel Interface
class PythonPropertyModel.PythonPropertyModel
Bases: org.python.proxies.PythonPropertyModel$PythonPropertyModel$14
Customer-available Python property model API interface. The model object is created once ahead of each
calculation (in its own subprocess) after the user clicks “Perform”.
before_evaluations(calculator)
Called by Thermo-Calc immediately before the first model evaluation (using evaluate_model). Use this
method for any required preparations.
Parameters calculator (ThermoCalcCalculator) – calculation engine, this object exists only during this method call and the following evaluate_model() call and will be destroyed afterwards. Therefore do not store this object outside of the method.
evaluate_model(calculator)
Called by Thermo-Calc when the model should be actually calculated.
Parameters calculator (ThermoCalcCalculator) – calculation engine, this object exists only during this method call and the previous before_evaluations() call and will be destroyed afterwards. Therefore do not store this object outside of the method. The object
contains all required information from the Thermo-Calc core for the calculation.
get_thermocalc_system(thermocalc_system)
Called by Thermo-Calc whenever an updated state of the Thermo-Calc core system needs to be injected
into the model. Thread-safetey is guaranteed, i.e. the method will only be called directly before but never
during other API method calls.
Parameters thermocalc_system (ThermoCalcSystem) – Thermo-Calc core system
providing access to all information on the thermodynamic system currently defined by the
user. This object is guaranteed to live until it is replaced. It can and should be stored in an
instance variable within the model class.
provide_calculation_result_quantities()
Called by Thermo-Calc when the model should provide its result quantity objects.
Returns result quantity objects of the model (to be filled later with results in evaluate_model())
Return type list of ResultQuantity
provide_model_category()
Called by Thermo-Calc when the model should provide its category (shown in the Thermo-Calc model
tree).
Returns category of the model, it may be present in serveral categories
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Return type list of str
provide_model_description(locale)
Called by Thermo-Calc when the model should provide its detailed description.
Parameters locale (java.util.Locale) – locale of the model provided for a localized
(language-dependent) description
Returns description text for the model
Return type str
Raises RuntimeException – if the model requires a locale, it should throw if the locale is
not provided
provide_model_name()
Called by Thermo-Calc when the model should provide its name (shown in the Thermo-Calc model tree).
Returns name of the model
Return type str
provide_model_parameters()
Called by Thermo-Calc when the model should provide all model parameters and their current values.
Optional.
Note: These are internal variables of the property model that are intended to be modified from the outside.
Typically this is used to adjust their values in a optimizer during the development of the model.

Returns the model parameter ids and their current values
Return type dict(str, float) [unit according to the parameter meaning]
provide_ui_panel_components()
Called by Thermo-Calc when the model should provide its UI components for the model panel to be
plotted.
Returns model UI panel components in the order to be presented in the model panel
Return type list of UIComponent
set_model_parameter(model_parameter_id, value)
Called by Thermo-Calc when a model parameter should be reset. Optional.
Note: These are internal variables of the property model that are intended to be modified from the outside.
Typically this is used to adjust their values in a optimizer during the development of the model.

Parameters
• model_parameter_id – The parameter id
• value – The value [unit according to the parameter meaning]

7.2 ResultQuantity
class ResultQuantity.ResultQuantity(quantity_id, description, quantity_type)
Defines a calculation result quantity of a property model that is identified by a unique ID
20
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Constructor.
Parameters
• quantity_id (str) – unique ID of the quantity
• description (str) – description of the quantity (shown in the Thermo-Calc UI)
• quantity_type ("enum" defined in ResultQuantity) – type of the quantity
(defines the unit)
ENERGY_QUANTITY = 2
GENERAL_QUANTITY = 0
STRENGTH_QUANTITY = 3
TEMPERATURE_QUANTITY = 1
TIME_QUANTITY = 4
get_description()
Obtains the description of the quantity.
Returns description of the quantity
Return type str
get_id()
Obtains the ID of the quantity.
Returns unique ID of the quantity
Return type str
get_type()
Obtains the type of quantity.
Returns type of the quantity
Return type “enum” defined in ResultQuantity

7.3 ThermoCalcCalculator
class ThermoCalcCalculator.PhaseStatus
Bases: object
Defines the status of a phase
DORMANT = 2
ENTERED = 0
FIXED = 1
SUSPENDED = 3
class ThermoCalcCalculator.SearchDirection
Bases: object
Defines the search direction in the compute_transition() method
NEGATIVE = 0
POSITIVE = 1

7.3. ThermoCalcCalculator
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class ThermoCalcCalculator.ThermoCalcCalculator(model_engine)
Bases: object
Thermodynamic calculation engine of Thermo-Calc for the property models
Constructor. Note: This class should never be instantiated by the model, it will always be provided by ThermoCalc with the correct and updated data.
Parameters model_engine
(se.thermocalc.externalapi.propertymodel.
ModelEngine) – Thermo-Calc internal property model engine
compute_chemical_diffusion_cofficient(phase,
diffusing_constituent,
ent_constituent, reference_constituent)
Computes a chemical diffusion coefficient.

gradi-

Parameters
• phase (str) – name of the phase of interest
• diffusing_constituent (str) – name of the diffusing constituent
• gradient_constituent (str) – name of the gradient constituent
• reference_constituent (str) – name of the reference constituent
Returns the chemical diffusion coefficient (in m/s**2)
Return type float
compute_equilibrium(use_global)
Performs a thermodynamic equilibrium calculation using the current settings of the calculator
Parameters use_global (bool) – flag defining if global minimization is used: true for using
it, false for not using it
compute_intrinsic_diffusion_coefficient(phase,
diffusing_constituent,
gradient_constituent, reference_constituent)
Computes an intrinsic diffusion coefficient.
Parameters
• phase (str) – name of the phase of interest
• diffusing_constituent (str) – name of the diffusing constituent
• gradient_constituent (str) – name of the gradient constituent
• reference_constituent (str) – name of the reference constituent
Returns the intrinsic diffusion coefficient (in m/s**2)
Return type float
compute_tracer_diffusion_coefficient(phase, constituent)
Computes a tracer diffusion coefficient.
Parameters
• phase (str) – name of the phase of interest
• constituent (str) – name of the diffusing constituent
Returns the chemical diffusion coefficient (in m/s**2)
Return type float
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compute_transition(phase_to_form, condition_to_relax, step_length, direction, use_global)
Compute transition command identical to that of the Thermo-Calc console. Determines the ocurrence of
a phase transition when varying a certain condition. Example: solvus temperature of a phase. Note: After
finishing, this command has adjusted the equilibrium present in the calculator to the requested transition.
The requested properties such as the transition temperature can be read using the appropriate methods.
Parameters
• phase_to_form (str) – name of the phase to be formed
• condition_to_relax (str) – condition to be relaxed in Thermo-Calc console syntax (e.g. “T” or “W(CR)”)
• step_length (float) – step length of the relaxed condition, the minimum possible
value is 1.0, the unit is that of the condition
• direction (SearchDirection) – direction of search for the relaxed condition (positive or negative)
• use_global (bool) – flag defining if global optimization is used
delete_condition(condition_in_classic_syntax)
Deletes a condition from the calculator.
Parameters condition_in_classic_syntax (str) – condition to be deleted in
Thermo-Calc console syntax
get_conditions()
Obtains the currently defined conditions in the calculator.
Returns list of conditions currently defined in the calculator in Thermo-Calc console syntax
Return type list of str
get_degrees_of_freedom()
Obtains the degrees of freedom in current calculator.
Returns degrees of freedom in the current calculator
Return type int
get_molar_volume(phase_name)
Obtains the molar volume of a phase.
Parameters phase_name (str) – name of the phase
Returns the molar volume of that phase
Return type float
get_phase_status(phase_name)
Obtains the current status of a phase.
Parameters phase_name (str) – name of the phase
Returns status of that phase
Return type PhaseStatus
get_single_value(command_in_classic_syntax)
Obtains any single value from the calculator using the Thermo-Calc console syntax. Can be used as a
workaround for commands not existing in the property model API.
Parameters command_in_classic_syntax (str) – Thermo-Calc console syntax command specifying the value

7.3. ThermoCalcCalculator
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Returns the requested value in the same unit as it would be in the Thermo-Calc console mode
Return type float
get_stable_phases_in_equilibrium()
Obtains all phases thare are stable in the current equilibrium.
Returns all phases stable in the current equilibrium
Return type list of str
get_temperature()
Obtains the currently set temperature in the calculator.
Returns the currently set temperature (in K)
Return type float
send_command_to_poly3(command_in_classic_syntax)
Sends a console syntax command directly to the Poly3 model. This command accepts all console commands available in POLY3 and can be used as a workaround for commands not existing in the property
model API.
Parameters command_in_classic_syntax (str) – Thermo-Calc console syntax command
set_component_entered(component)
Sets a component to status ENTERED in the calculator.
Parameters component (str) – name of the component
set_component_special(component)
Sets a component to status SPECIAL in the calculator.
Parameters component (str) – name of the component
set_component_suspended(component)
Sets a component to status SUSPENDED in the calculator.
Parameters component (str) – name of the component
set_condition(condition_in_classic_syntax)
Sets a new condition in the calculator.
Parameters condition_in_classic_syntax (str) – new condition in Thermo-Calc
console syntax
set_phase_dormant(phase)
Sets a phase to the status DORMANT.
Parameters phase (str) – name of the phase to be set to the status dormant
set_phase_entered(phase, amount)
Sets a phase to the status ENTERED.
Parameters
• phase (str) – name of the phase to be set to the status entered
• amount (float) – phase fraction amount of that phase (0.0 < amount < 1.0)
set_phase_fixed(phase, amount)
Sets a phase to the status FIXED.
Parameters
• phase (str) – name of the phase to be set to the status FIXED
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• amount (float) – phase fraction amount of that phase (0.0 < amount < 1.0)
set_phase_suspended(phase)
Sets a phase to the status SUSPENDED.
Parameters phase (str) – name of the phase to be set to the status SUSPENDED
set_temperature(temp)
Sets the temperature in the calculator.
Parameters temp (float) – new temperature (in K)
suspend_all_phases()
Sets all phases in the present calculator to the status SUSPENDED.

7.4 ThermoCalcSystem
class ThermoCalcSystem.SpecialListMarkers
Bases: object
Placeholders for special list elements that are locale-dependent. They will be provided by UI list components if
a special marker has been selected.
ANY_LIST_MARKER = u'ANY'
NONE_LIST_MARKER = u'NONE'
class ThermoCalcSystem.ThermoCalcSystem(model_utils)
Provides all helper functionality required within the property models to access the Thermo-Calc / GUI functionality
Constructor. Note: This class should never be instantiated by the model, it will always be provided by ThermoCalc with the correct and updated data.
Parameters model_utils
(se.thermocalc.externalapi.propertymodel.
ModelUtils) – Internal model utils object from the Thermo-Calc property model core
get_components()
Obtains all components currently set in the system.
Returns all defined components :rtype: list of str
get_dependent_component()
Obtains the currently set dependent component of the system, i.e. that component that is typically the main
element of an alloy, for example Fe or Ni.
Returns the dependent component
Return type str
get_non_dependent_components()
Obtains the curently set non-dependent components of the system, i.e. all components except the dependent “main” component.
Returns the non-dependent components
Return type list of str
get_object_from_previous_evaluation(key)
Retrieves a stored object from a previous evalulation.
Parameters key (str) – key of the object

7.4. ThermoCalcSystem
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Returns the stored object
Return type object
get_selected_phases()
Obtains all currently selected phases in the system.
Returns the names of all selected phases
Return type list of str
get_ui_boolean_value(component_id)
Obtains the value from the specified checkbox.
Parameters component_id (str) – ID of the checkbox
Returns setting of the checkbox
Return type bool
get_ui_composition_value(component_id)
Obtains the composition from the specified composition UI component.
Parameters component_id (str) – ID of the composition UI component
Returns composition (in mole or mass fraction), note that the input unit of the UI is specified in
the model panel. If required, the composition is automatically converted to fractions.
Return type float
get_ui_double_value(component_id)
Obtains the value from the specified UI component.
Parameters component_id (str) – ID of the UI component
Returns value
Return type float
get_ui_list_value(component_id)
Obtains the selected entry from a UI component list. If a special element (such as ANY, NONE, . . . ) is
selected, the corresponding locale-independent placeholder is provided.
Parameters component_id (str) – ID of the list UI component
Returns selected entry
Return type str
get_ui_temperature_value(component_id)
Obtains the temperature from the specified temperature UI component.
Parameters component_id (str) – ID of the temperature UI component
Returns temperature (in K), note that input unit of the UI is specified in the model panel. If
required, the temperature is automatically converted to K.
Return type float
is_object_saved(key)
Determines if an object is stored for the specified key.
Parameters key (str) – object key
Returns true if an object has been saved for the specified key, false otherwise.
Return type bool
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is_phase_gas(phase_name)
Determines if a phase is a gas phase.
Parameters phase_name (str) – name of the phase
Returns true if the phase is a gas phase, false otherwise
Return type bool
is_phase_liquid(phase_name)
Determines if a phase is a liquid phase.
Parameters phase_name (str) – name of the phase
Returns true if the phase is a liquid phase, false otherwise
Return type bool
log_debug(s, *arg)
Logs a debug level message to the Thermo-Calc log message
self._thermocalc_system.log_debug(“Phase {} is invalid”, phase_name)

window.

Example:

window.

Example:

window.

Example:

window.

Example:

Parameters
• s (str) – log message
• arg (any) – string arguments, can be omitted
log_error(s, *arg)
Logs an error level message to the Thermo-Calc log message
self._thermocalc_system.log_error(“Phase {} is invalid”, phase_name)
Parameters
• s (str) – log message
• arg (any) – string arguments, can be omitted
log_info(s, *arg)
Logs an info level message to the Thermo-Calc log message
self._thermocalc_system.log_info(“Phase {} is invalid”, phase_name)
Parameters
• s (str) – log message
• arg (any) – string arguments, can be omitted
log_trace(s, *arg)
Logs a trace level message to the Thermo-Calc log message
self._thermocalc_system.log_trace(“Phase {} is invalid”, phase_name)
Parameters
• s (str) – log message
• arg (any) – string arguments, can be omitted
log_warning(s, *arg)
Logs a warning level message to the Thermo-Calc log message window.
self._thermocalc_system.log_debug(“Phase {} is invalid”, phase_name)

Example:

Parameters
• s (str) – log message
• arg (any) – string arguments, can be omitted

7.4. ThermoCalcSystem
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num_saved_objects()
Determines the number of objects stored between evalulations.
Returns number of objects stored
Return type int
save_object_for_next_evaluation(key, object_to_be_saved)
Stores any object between evaluations and make it available for the next evalulation. This allows to overcome the limited lifetime of the ThermoCalcCalculator object.
Parameters
• key (str) – key of the object for later access
• object_to_be_saved (object) – object to be stored
set_result_quantity_value(quantity_id, value)
Sets the value of a previously defined result quantity for further usage in the Thermo-Calc property model
core for plotting, . . .
Parameters
• quantity_id (str) – unique ID of the result quantity
• value (float) – value to be set (use float(‘NaN’) in case of an invalid result)
ThermoCalcSystem.create_boolean_ui_component(component_id, name, description, initial_setting)
Creates a UI checkbox component for a boolean value. The value of that component can later be accessed during
the model evaluation.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• initial_setting (bool) – initial setting of the checkbox
Returns the created component
Return type UIBooleanComponent
ThermoCalcSystem.create_composition_ui_component(component_id, name, description,
initial_composition)
Creates a UI text field component for a composition value. The value of that component can later be accessed
during the model evaluation.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• initial_composition (float) – initial composition to be set in the text field (unit
defined by the user in the Thermo-Calc system)
Returns the created component
Return type UICompositionComponent
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ThermoCalcSystem.create_condition_list_ui_component(component_id, name, description)
Creates a UI list component for all conditions defined in the system. The value of that component can later be
accessed during the model evaluation.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
Returns the created component
Return type UIConditionListComponent
ThermoCalcSystem.create_energy_quantity(quantity_id, description)
Creates a energy result quantity (in J). When the model is evaluated, a value can be added to the quantity and it
will be used to transfer the result to the Thermo-Calc plot engine.
Parameters
• quantity_id (str) – unique ID of the result quantity
• description (str) – additional description of the result quantity
Returns the created result quantity
Return type ResultQuantity
ThermoCalcSystem.create_float_ui_component(component_id, name, description, value)
Creates a UI text field component for a real number. The value of that component can later be accessed during
the model evaluation.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• value (float) – initial setting of the text field
Returns the created component
Return type UIFloatComponent
ThermoCalcSystem.create_general_quantity(quantity_id, description)
Creates a general result quantity that can contain any type of result (without a unit). When the model is evaluated,
a value can be added to the quantity and it will be used to transfer the result to the Thermo-Calc plot engine.
Parameters
• quantity_id (str) – unique ID of the result quantity
• description (str) – additional description of the result quantity
Returns the created result quantity
Return type ResultQuantity
ThermoCalcSystem.create_list_ui_component(component_id, name, description, entry_list, selected_entry=”)
Creates a UI list component for string entries. The value of that component can later be accessed during the
model evaluation.

7.4. ThermoCalcSystem
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Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• entry_list (list of str) – entries of the list
• selected_entry (str) – entry to be initially selected. If omitted, by default the first
element is selected.
Returns the created component
Return type UIGeneralListComponent
ThermoCalcSystem.create_phase_list_ui_component(component_id, name, description, default_phase=”, any_marker=False)
Creates a UI list component for all phases defined in the system. It is possible to select a default phase that is
supposed to be the expected phase selection for that list. The value of that component can later be accessed
during the model evaluation.
A default phase is the phase that is initially selected and re-selected as soon as a currently selected phase is
removed. If the default phase is not available, a NONE-marker will be created and used instead of the default
phase. A typical use case for the default phase setting is a phase list that expects to contain the LIQUID-phase
of a system.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• default_phase (str) – default phase, if omitted no default phase is chosen and only
initially the first element of the list is selected. If an ANY-marker is added, this is chosen as
the default element.
• any_marker (bool) – defines if an entry “ANY PHASE” should be added to the phase
list, if set to true this overrides any default phase setting
Returns the created component
Return type UIPhaseListComponent
ThermoCalcSystem.create_strength_quantity(quantity_id, description)
Creates a strength result quantity (in MPa). When the model is evaluated, a value can be added to the quantity
and it will be used to transfer the result to the Thermo-Calc plot engine.
Parameters
• quantity_id (str) – unique ID of the result quantity
• description (str) – additional description of the result quantity
Returns the created result quantity
Return type ResultQuantity
ThermoCalcSystem.create_temperature_quantity(quantity_id, description)
Creates a temperature result quantity (in K). When the model is evaluated, a value can be added to the quantity
and it will be used to transfer the result to the Thermo-Calc plot engine.
Parameters
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• quantity_id (str) – unique ID of the result quantity
• description (str) – additional description of the result quantity
Returns the created result quantity
Return type ResultQuantity
ThermoCalcSystem.create_temperature_ui_component(component_id, name, description,
initial_temp)
Creates a UI text field component for a temperature value. The value of that component can later be accessed
during the model evaluation.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• initial_temp (float) – initial temperature to be set in the text field (unit defined by
the user in the Thermo-Calc system)
Returns the created component
Return type UITemperatureComponent
ThermoCalcSystem.create_time_quantity(quantity_id, description)
Creates a time result quantity (in s). When the model is evaluated, a value can be added to the quantity and it
will be used to transfer the result to the Thermo-Calc plot engine.
Parameters
• quantity_id (str) – unique ID of the result quantity
• description (str) – additional description of the result quantity
Returns the created result quantity
Return type ResultQuantity

7.5 UIBooleanComponent
class UIBooleanComponent.UIBooleanComponent(component_id, name, description, setting)
Bases: UIComponent.UIComponent
Checkbox UI component of the model panel
Constructor.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• setting (bool) – initial setting of the checkbox
connect_component_visibility(dependent_component_id)
Connects the visibility of any other UI component of the model panel to the value of the check box.

7.5. UIBooleanComponent
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Parameters dependent_component_id (str) – ID of the UI element to be dependent on
the chosen element
get_dependent_components()
Obtains a list containing all UI elements currently connected regarding their visibility.
Returns a list of all all UI elements currently connected
get_setting()
Obtains the initial setting of the checkbox.
Returns initial setting of the checkbox
Return type bool
remove_component_visibility(dependent_component_id)
Removes the visiblity connection to a UI component that has been previously connected.
Parameters dependent_component_id (str) – ID of the previously connection UI element

7.6 UIComponent
class UIComponent.UIComponent(component_id, name, description)
Bases: object
Base class for all UI components of the model panel
Constructor.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
get_description()
Obtains the additional description of the component.
Type additional description of the component
Return type str
get_id()
Obtains the unique ID of the component.
Returns unique ID of the component
Return type str
get_name()
Obtains the name of the component.
Type name of the component, will be presented in the model panel
Return type str
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7.7 UICompositionComponent
class UICompositionComponent.UICompositionComponent(component_id, name, description, composition)
Bases: UIComponent.UIComponent
Composition text field UI component of the model panel
Constructor.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• composition (float) – initial composition to be set in the text field (unit defined by the
user in the Thermo-Calc system)
get_composition()
Obtains the initial composition set in the text field in the UI.
Returns initial composition to be set in the text field (unit defined by the user in the Thermo-Calc
system)
Return type float

7.8 UIConditionListComponent
class UIConditionListComponent.UIConditionListComponent(component_id, name, description)
Bases: UIComponent.UIComponent
System condition list UI component of the model panel
Constructor. All conditions are set automatically.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component

7.9 UIFloatComponent
class UIFloatComponent.UIFloatComponent(component_id, name, description, value)
Bases: UIComponent.UIComponent
General real value text field UI component of the model panel
Constructor.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
7.7. UICompositionComponent
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• description (str) – additional description of the component
• value (float) – initial setting of the text field
get_value()
Obtains the initial setting of the text field.
Returns initial setting of the text field

7.10 UIGeneralListComponent
class UIGeneralListComponent.UIGeneralListComponent(component_id, name, description, content, selected_entry=”)
Bases: UIComponent.UIComponent
General list UI component of the model panel that can contain any strings
Constructor.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• content (list of tuple of str) – entries of the list, they need to contain a localeindependent ID and a localized content string, for example: [(“ENTRY_1_ID”, “entry 1”),
(ENTRY_2_ID”, “entry 2”)]
• selected_entry (str) – entry to be initially selected. If omitted, by default the first
element is selected.
connect_component_visibility(dependent_component_id, selected_item_to_set_visible)
Connects the visibility of any other UI component of the model panel to the selection of a certain entry of
the list.
Parameters
• dependent_component_id (str) – ID of the UI element to be dependent on the
chosen element
• selected_item_to_set_visible (str) – entry (locale independent ID) of the
list to be chosen to set the dependent component visible
get_content()
Obtains the entries of the list.
Returns entries of the list, they need to contain a locale-independent ID and a localized content
string, for example: [(“ENTRY_1_ID”, “entry 1”), (ENTRY_2_ID”, “entry 2”)]
Return type list of tuple of str
get_dependent_components()
Obtains a dictionary containing all UI elements currently connected regarding their visibility.
Returns all UI elements currently connected (key: dependent component ID, value: required
list entry to set it visible)
Return type dict(str, str)
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get_selected_entry()
Obtains the initially selected entry.
Returns initially selected entry. If empty, the first element is selected.
Return type str
remove_component_visibility(dependent_component_id)
Removes the visiblity connection to a UI component that has been previously connected.
Parameters dependent_component_id (str) – ID of the previously connection UI element

7.11 UIPhaseListComponent
class UIPhaseListComponent.UIPhaseListComponent(component_id,
name,
description,
default_phase=”,
any_marker_setting=False)
Bases: UIComponent.UIComponent
Phase list UI component of the model panel
Constructor.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• default_phase (str) – default phase, if omitted no default phase is chosen and only
initially the first element of the list is selected. If an ANY-marker is added, this is chosen as
the default element.
• any_marker_setting (bool) – defines if an entry “ANY PHASE” should be added to
the phase list, if set to true this overrides any default phase setting
get_any_marker_setting()
Obtains the setting if any entry “ANY PHASE” is added to the phase list.
Returns if an entry “ANY PHASE” is added to the phase list, if set to true this overrides any
default phase setting
Return type bool
get_default_phase()
Obtains the default phase.
Returns default phase, if omitted no default phase is chosen and only initially the first element
of the list is selected. If an ANY-marker is added, this is chosen as the default element.
Return type str

7.12 UITemperatureComponent
class UITemperatureComponent.UITemperatureComponent(component_id, name, description, temp)
Bases: UIComponent.UIComponent

7.11. UIPhaseListComponent
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Temperature value text field UI component of the model panel
Constructor.
Parameters
• component_id (str) – unique ID of the component
• name (str) – name of the component, will be presented in the model panel
• description (str) – additional description of the component
• temp (float) – initial temperature to be set in the text field (unit defined by the user in
the Thermo-Calc system)
get_temp()
Obtains the initial temperature set in the text field.
Returns initial temperature to be set in the text field (unit defined by the user in the Thermo-Calc
system)
Return type float

7.13 JavaPropertyManager
class JavaPropertyManager.JavaPropertyManager(class_name, resource_dir_path=None)
Bases: object
Providing localized strings based on Java property file bundles.
Constructor. It is expected that Java *.properties files of the format “class_name_sv.properties” are provided. A
default file with the name “class_name.properties” containing the english strings is required.
Parameters
• class_name (str) – name of the Python class for which the properties need to be provided
• resource_dir_path (str) – path to directory containing the resource file, if omitted the resources are expected to be loacted in the subdirectory RESOURCES_DIR of the
Thermo-Calc program directory
JAVA_PROPERTY_EXTENSION = '.properties'
RESOURCES_DIR = 'jythonModelsResources'
get(property_key)
Obtains a property for the class specified in the constructor.
Parameters property_key (str) – property key (for example “label.text”, . . . )
Returns localized string
Return type str
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Graphical Mode Examples
About the Examples
This guide includes descriptions of the following examples.
Category

Example number

Thermo-Calc Graphical Mode Examples Collection includes binary and
ternary system examples, Scheil, the Equilibrium Calculator, plus more

T_01 to T_12

Thermo-Calc Property Model Examples Collection: General Model Library
and Steel Model Library

General Models: PM_G_01
to PM_G_06
Steel Models: PM_Fe_01
to PM_Fe_03

Process Metallurgy Module Examples Collection

PMET_01 to PMET_06

Diffusion Module (DICTRA) Graphical Mode Examples

D_01, D_02, D_03 (the
Quick Start Guide
Examples)
D_04 to D_07

Precipitation Module (TC-PRISMA) Graphical Mode Examples

P_01 to P_13
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Thermo-Calc Graphical Mode Examples
Collection
In this section:
T_01: Calculating a Single-Point Equilibrium

333

T_02: Stepping in Temperature in the Fe-C System

335

T_03: Fe-C Phase Diagrams

337

T_04: Fe-Cr-C Ternary Phase Diagram at 1000 K

339

T_05: Stable and the Metastable Fe-C Phase Diagrams

341

T_06: Serially Coupled Equilibrium Calculators

343

T_07: User-Defined Functions

348

T_08: Scheil and Equilibrium Solidification

350

T_09: Carbide Driving Force Heat Map

353

T_10: Scheil Solidification with Back Diffusion

354

T_11: Surface Tension in Cu-Zr

356

T_12: Viscosity in Cr-Ni

358
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T_01: Calculating a Single-Point Equilibrium
This example shows the result from a single-point equilibrium calculation in the Fe-C system.
It demonstrates the use of the Equilibrium Calculator and generates a Table Renderer in the
Results window. The number of equilibrium conditions is C+2 where C is the number of
components, meaning that four conditions are needed in this example:
l

Temperature is 1000 K

l

Pressure is 100000 Pa

l

System size is 1 mole

l

Mass percent carbon is 0.1%

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_01_Single-point_equilibrium.tcu
This example is included as a tutorial on our website and our YouTube channel.

Table Result
The displayed results of the calculation show that the BCC_A2 (ferrite) and GRAPHITE phases
are stable for this set of equilibrium conditions.
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T_02: Stepping in Temperature in the Fe-C System
This example shows how the fractions of stable phases vary for an Fe-0.1 mass-% C alloy
when the temperature is varied between 500 and 2000 K. It demonstrates the use of the
Equilibrium Calculator. To allow temperature to vary, the corresponding Axis Definition
check box is selected.

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_02_Step_in_temperature_in_Fe-C.tcu
This example is included in the tutorial on our website and YouTube channel.

Plot Result
In this example, results are displayed graphically using a Plot Renderer activity.
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If you want, you can use a Table Renderer to generate text results instead, as shown in this
example after adding a Table Renderer to the Equilibrium Calculator and clicking Perform.
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T_03: Fe-C Phase Diagrams
This example shows the stable Fe-C phase diagram (stable meaning that the graphite phase
is entered in the calculation). The same diagram is calculated using the Binary Calculator
activity and then using a System Definer and Equilibrium Calculator.
In both cases, a Plot Renderer is used to display results. The purpose of the Binary Calculator
is to simplify common calculations for binary systems. In the Equilibrium Calculator two axes
are defined: Mass percent C and Temperature. An axis variable must also be an equilibrium
condition.

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_03_Fe-C_phase_diagram.tcu
This example is included as a tutorial on our website and our YouTube channel.

Plot ResultS
Equilibrium Calculator Results

This shows the plot result of the System Definer and Equilibrium Calculator system.
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Binary Calculator Results
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T_04: Fe-Cr-C Ternary Phase Diagram at 1000 K
This example shows a ternary phase diagram in the Fe-Cr-C system at 1000 K. Similar to
example T_03: Fe-C Phase Diagrams, the same diagram is calculated using a Ternary
Calculator and then using a System Definer and Equilibrium Calculator. Two Plot Renderer
activities are added to create two plots.

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_04_Fe-Cr-C_ternary_phase_diagram.tcu
This example is included as a tutorial on our website and our YouTube channel.

Plot Results
Ternary Calculator
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Equilibrium Calculator

Try practicing with two features on the Plot Renderer Configuration window. To
toggle between a triangular and a rectangular diagram, click the Show
Triangular button then click Perform to see what happens. To toggle the X and
Y axis variables, click the Switch Axes button and then click Perform.
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T_05: Stable and the Metastable Fe-C Phase Diagrams
This example shows how to overlay results from two calculations in the same plot using the
Equilibrium Calculator.
1. The Plot Renderer activity is first created as a successor to Equilibrium Calculator 1.
2. Then right-click the Plot Renderer node and select Add predecessor and the results
from both equilibrium calculators are in the same plot. In Equilibrium Calculator 1
the stable phase diagram is calculated and in Equilibrium Calculator 2 the
metastable phase.
3. The metastable diagram is obtained by deselecting the graphite phase on System
Definer2 → Phases and phase constitution tab.

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_05_Fe-C_stable_and_metastable_phase_diagram.tcu
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Many of our Graphical Mode examples have video tutorials, which you can
access in a variety of ways. When in Thermo-Calc, from the menu select Help →
Video Tutorials, or you can go to the website or our YouTube channel.

Plot Result
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T_06: Serially Coupled Equilibrium Calculators
Sometimes there are multiple solutions for a given set of equilibrium conditions. In other
cases the equilibrium calculation does not converge. You can then aid the final calculation
by, in effect, telling the software where it should start the search for the equilibrium.
This example shows how to serially couple two Equilibrium Calculator nodes together for
more complex equilibrium conditions. For each calculation, the output is to a Table
Renderer.

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_06_Serial_equilibrium_calculators.tcu
Many of our Graphical Mode examples have video tutorials, which you can
access in a variety of ways. When in Thermo-Calc, from the menu select Help →
Video Tutorials, or you can go to the website or our YouTube channel.

Table Renderer Results
Equilibrium Calculator 1
In the first example, the objective is to calculate the equilibrium at 850° C where the mole
fractions of the FCC A1 and BCC A2 phases are 0.5 each for an Fe-Cr-C steel with 10%
chromium. In Equilibrium Calculator 1 a simple set of equilibrium conditions (temperature,
pressure, system size and composition) are used to find a carbon content where only the FCC
A1 and BCC A2 phases are stable. The results from this preliminary calculation are displayed
in Table Renderer 1.
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Equilibrium Calculator 2
In Equilibrium Calculator 2 the carbon content equilibrium condition is replaced by the
condition that the numbers of moles of the BCC A2 phase should be 0.5. The final result is
displayed in Table Renderer 2. In this case, the final objective is to calculate the solidus
temperature of an Fe-Cr-C steel with 10% Cr and 0.01% C.
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Equilibrium Calculator 3
In Equilibrium Calculator 3 the state at 2000 K is calculated and the result is displayed in
Table Renderer 3.
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Equilibrium Calculator 4
In Equilibrium Calculator 4 the temperature equilibrium condition is replaced by the
condition Fix phase / liquid / 0.0, meaning that liquid should be stable in an amount of zero
moles, i.e. the solidus temperature. The final result is displayed in Table Renderer 4.
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T_07: User-Defined Functions
This example shows how to implement user-defined functions.
A series of equilibria for an Fe-Cr-C alloy are calculated by varying temperature between
500 and 3000 K. In the configuration window of the Equilibrium Calculator under the
Functions tab, two identically meaning functions are defined, fraction solid and f solid, the
values of which are plotted against temperature in two Plot Renderer activities. Functions
can be entered in terms of QuantitiesQ1, Q2, Q3 and so forth, or by using the Thermo-Calc
syntax.

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_07_User_defined_functions.tcu
Many of our Graphical Mode examples have video tutorials, which you can
access in a variety of ways. When in Thermo-Calc, from the menu select Help →
Video Tutorials, or you can go to the website or our YouTube channel.

Plot Result
This plot example shows the result of the fraction solid function.
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T_08: Scheil and Equilibrium Solidification
This example shows a comparison for an Al-Si alloy solidified under full local equilibrium and
under the Scheil assumptions, i.e. zero diffusion in the solidified material and infinitely fast
diffusion in the liquid. The example uses the Scheil Calculator and adds a Plot and Table
Renderer.
T_10: Scheil Solidification with Back Diffusion

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_08_Scheil_and_equilibrium_solidification.tcu.
For video tutorial examples using Scheil, see our website and YouTube channel.

Table and Plot Results
The plot compares the mole fraction of a solid vs temperature. The table provides the data,
which you can also export.
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To Save the Table
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There are two ways to save the table.

Method 1
In the Results window, right click the table and select Save As...

Method 2
1. In the Project window, click the Table Renderer.
2. In the Configuration window, click Save table.
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T_09: Carbide Driving Force Heat Map
This is an example of using Grid calculations to plot the driving force for a carbide as a
function of two composition variables. With the Grid calculation type, a 2D grid is generated
from the two calculation axes. After the calculation is done, an equilibrium is calculated in
each grid point. A Plot Renderer connected to a grid calculation plots the z-axis property for
each equilibrium as a function of the two calculation axes. The final plot can be either a heat
map or a contour plot.

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_09_Heat_map_of_carbide_driving_force.tcu
Many of our Graphical Mode examples have video tutorials, which you can
access in a variety of ways. When in Thermo-Calc, from the menu select Help →
Video Tutorials, or you can go to the website or our YouTube channel.

Plot Result
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T_10: Scheil Solidification with Back Diffusion
See Scheil Calculator for an overview of the different Scheil simulation models
available.
The Scheil with back diffusion feature is only available for systems with diffusion
data, i.e. it requires the use of a mobility database.
This is an example of a Scheil solidification simulation of a Al-2.1Cu-1Si alloy including back
diffusion in the primary phase.
The example uses two of the Scheil Calculator activity nodes with different cooling rates, 10
K/s and 0.005 K/s. The lower cooling rate produces a solidification curve that is closer to the
equilibrium curve as shown in the plot result. Both a thermodynamic ALDEMO (aluminum
demo) and mobility MALDEMO (Al-alloys mobility) database are used for this calculation.
T_08: Scheil and Equilibrium Solidification

Project File and Video Tutorial Information
l

Folder: Thermo-Calc

l

File name: T_10_Scheil_with_back_diffusion.tcu.
For video tutorial examples using Scheil, see our website and YouTube channel.

Plot Result
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Scheil Solidification Plot
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T_11: Surface Tension in Cu-Zr
This is an example of including surface tension in the calculations. This property, and others,
are progressively being added to the Thermo-Calc databases starting with Thermo-Calc
software version 2020a.
Using the ALDEMO database, which is the free demonstration version of the TCS Al-based
Alloy Database (TCAL), the surface tension of liquid metallic is plotted at 1373 K for Cu-Zr
and compared to experimental data from Krasovskyy (2005).
Not all databases have this property although it is being added to databases as
these are updated over time. Currently it is available with the latest versions of
TCNI and TCAL.

Reference
[2005, Krasovskyy] V. P. Krasovskyy, Y. V. Naidich, N. A. Krasovskaya, "Surface tension and
density of copper–Zirconium alloys in contact with fluoride refractories," J. Mater. Sci.
40, 2367–2369 (2005).

You can learn more about the surface tension model by searching the help
(press F1 when in Thermo-Calc).

The same example is also provided in Console Mode as tcex56.
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Project File Information
l

Folder: Thermo-Calc

l

File name: T_11_Surface_tension_in_Cu-Zr.tcu.

Plot Result
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T_12: Viscosity in Cr-Ni
This is an example of including viscosity in the calculations. This property, and others, are
progressively being added to the Thermo-Calc databases starting with Thermo-Calc software
version 2020a.
Using the FEDEMO database, which is the free demonstration version of the TCS Steel and
Fe-alloys Database (TCFE), the viscosity of metallic liquids is plotted at 1873 K for Cu-Ni and
compared to experimental data from Sato (2005).
Not all databases have this property although it is being added to databases as
these are updated over time. Currently it is available with the latest versions of
TCFE, TCHEA, TCNI and TCAL.

Reference
[2005, Sato] Y. Sato, K. Sugisawa, D. Aoki, T. Yamamura, "Viscosities of Fe–Ni, Fe–Co and Ni–
Co binary melts," Meas. Sci. Technol. 16, 363–371 (2005).

You can learn more about the viscosity model by searching the help (press F1
when in Thermo-Calc).

The same example is also provided in Console Mode as tcex55.

Project File Information
l

Folder: Thermo-Calc

l

File name: T_12_Viscosity_in_Cr-Ni.tcu.

Plot Result

Thermo-Calc User Guide: Graphical Mode ǀ 358 of 527

Thermo-Calc Documentation Set

Thermo-Calc User Guide: Graphical Mode ǀ 359 of 527

Thermo-Calc Documentation Set

Thermo-Calc Property Model Examples
Collection
The General models are available to all users. To run calculations with the
Steel models (Martensite and Pearlite) requires a valid maintenance license
plus licenses for both the TCFE (version 9 and higher) and MOBFE (version 4 and
higher) databases.

These examples use the Property Model Calculator, an activity available with Thermo-Calc.
About the Examples
In this section:
PM_G_01: Phase Transition

361

PM_G_02: Coarsening and Interfacial Energy

364

PM_G_03: Driving Force and Interfacial Energy

368

PM_G_04_Yield_Strength

370

PM_G_05_Yield_Strength_NiAlCr

373

PM_G_06_Yield_Strength_HEA

375

PM_Fe_01: Fe-Cr-C Martensite with Intercritical Annealing

377

PM_Fe_02: Fe-Mn Martensite Morphologies

380

PM_Fe_03: Fe-C-Mn Pearlite

382
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PM_G_01: Phase Transition
The example uses the Property Model Calculator to predict the transition temperature to
the unwanted brittle Sigma phase. The example shows how the temperature is influenced by
changes to a steel alloy’s composition using the uncertainty calculation type and how to
create either a histogram or probability plot.
Phase Transition Model in the Thermo-Calc User Guide.

Project File and Video Tutorial Information
l

Folder: Property models>General

l

File name: PM_G_01_Phase_Transition.tcu
This example is included as a tutorial on our website and our YouTube channel.
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Plot Results
Histogram plot

Probability plot
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Experienced users can also create custom Property Models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.
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PM_G_02: Coarsening and Interfacial Energy
The example uses the Property Model Calculator and both thermodynamic (FEDEMO) and
kinetic (MFEDEMO) demonstration steel databases. Using a Grid calculation type it produces
these plots: a heat map, a contour plot and a cross plot with contour (where both the
interfacial energy and coarsening rate is shown). It also creates a diagram to show the
phase fractions vs time and a 3D plot comparing the coarsening rate coefficient.
Coarsening Model and Interfacial Energy Model

Project File and Video Tutorial Information
l

Folder: Property models>General

l

File name: PM_G_02_Coarsening_and_Interfacial_energy.tcu
This example is included as a tutorial on our website and our YouTube channel.

Plot Results
Coarsening rate coefficient (heat map)

Coarsening rate coefficient (3D plot)
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Two different rotation angles. When viewing in Thermo-Calc you can rotate the plot.

Coarsening rate coefficient (contour plot)
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Coarsening rate coefficient

Coarsening rate coefficient and Interfacial energy (overlayed plots)

Phase fractions vs T (One axis)
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Experienced users can also create custom Property Models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.
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PM_G_03: Driving Force and Interfacial Energy
The example uses the Property Model Calculator and a thermodynamic demonstration steel
database (FEDEMO). Using a grid calculation type it produces a contour plot comparing the
driving force and interfacial energy.
Driving Force Model and Interfacial Energy Model in the Thermo-Calc User Guide.

Project File and Video Tutorial Information
l

Folder: Property models>General

l

File name: PM_G_03_Driving_force_and_Interfacial_energy.tcu
This example is included as a tutorial on our website and our YouTube channel.

Plot Result
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A contour plot

Phase Fraction

Experienced users can also create custom Property Models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.
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PM_G_04_Yield_Strength
Yield Strength Model and About the Yield Strength Model in the Thermo-Calc User
Guide.
The example uses the Property Model Calculator and the Yield strength Property Model
with a thermodynamic demonstration aluminum database (ALDEMO).
This example compares the Simplified and Seidman models yield strength versus
precipitate radius to experimental data for an Al-0.3wt%Sc alloy homogenized at 648 °C for
24 hours and subsequently aged at 350 °C. Although the experimental set up is designed to
eliminate grain boundary and solid solution strengthening, these are also included by
optimizing the model parameters.

Project File and Video Tutorial Information
l

Folder: Property models>General

l

File name: PM_G_04_Yield_Strength.tcu
Also see our website and YouTube channel for tutorial videos related to the
Property Model Calculator.

Plot Result
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Strength vs Radius - Simplified

Strength vs Radius - Seidman

Experienced users can also create custom Property Models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.

Thermo-Calc User Guide: Graphical Mode ǀ 372 of 527

Thermo-Calc Documentation Set

PM_G_05_Yield_Strength_NiAlCr
Yield Strength Model and About the Yield Strength Model in the Thermo-Calc
Graphical Mode User Guide.
The example uses the Property Model Calculator and the Yield strength Property Model
with a thermodynamic demonstration nickel database (NIDEMO).
The Reppich model is developed for calculation of precipitation strengthening in Ni-based
super alloys consisting mainly of gammaprime precipitates in a gamma matrix. The
example shows a calculation of the precipitation strengthening vs precipitate radius in a Ni10at%Al-10at%Cr alloy.

Project File and Video Tutorial Information
l

Folder: Property models>General

l

File name: PM_G_05_Yield_Strength_NiAlCr.tcu
Also see our website and YouTube channel for tutorial videos related to the
Property Model Calculator.

Plot Result
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Reppich model plotted with results and experimental data for PE16, all data is normalized with the
square root of the volume fraction of precipitate.

Experienced users can also create custom Property Models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.
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PM_G_06_Yield_Strength_HEA
Yield Strength Model and About the Yield Strength Model in the Thermo-Calc
Graphical Mode User Guide.
This example requires the use of the TCS High Entropy Alloy (TCHEA) database.
A license is required to run the example.
The example uses the Property Model Calculator and the Yield strength Property Model
with a thermodynamic high entropy alloy database (TCHEA). This is an example of solid
solution strengthening, which is the contribution to total strength due to the elastic strains in
the crystal lattice caused by alloying elements of a lattice parameter differing from the
main constituent. The example shows the solid solution strengthening over the full solubility
range for the Mo-Ta system as compared to experimental data.

Project File and Video Tutorial Information
l

Folder: Property models>General

l

File name: PM_G_06_Yield_Strength_HEA.tcu
Also see our website and YouTube channel for tutorial videos related to the
Property Model Calculator.

Plot Result
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Strength vs at% Ta

Experienced users can also create custom Property Models for use with the
Property Model Calculator.

Search for Property Model Calculator and Development Framework in the help.
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PM_Fe_01: Fe-Cr-C Martensite with Intercritical
Annealing
To run calculations with the Steel models (Martensite and Pearlite) requires a
valid maintenance license plus licenses for both the TCFE (version 9 and higher)
and MOBFE (version 4 and higher) databases.

The example uses the Property Model Calculator with the Martensite Fractions and
Martensite Temperatures Models.
The example shows how to calculate martensite fractions and martensite temperatures
(martensite start, Ms, and 90% transformation temperature M90). The alloy is first
intercritically annealed and then quenched. Austenite composition is determined by an
equilibrium calculation at the annealing temperature. Martensite fraction is calculated as a
function of temperature which the alloy is quenched to. The example also shows how Cr
content in the alloy influences Ms and M90 after intercritical annealing.

Reference
Harris, William J, and Morris Cohen. 1949. “Stabilization Of The Austenite-Martensite
Transformation.” Transactions of the American Society for Metals, AIME 180: 447–70.

Project File and Video Tutorial Information
l

Folder: Property models >Steel

l

File name: PM_Fe_01_Fe-Cr-C_martensite_intercritical_annealing.tcu
Also see our website and YouTube channel for tutorial videos related to the
Property Model Calculator.

Plot Results
Transformation curves
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The transformation curves plot showing Fe-Cr-C martensite with intercritical annealing.
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Ms-Mf
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PM_Fe_02: Fe-Mn Martensite Morphologies
To run calculations with the Steel models (Martensite and Pearlite) requires a
valid maintenance license plus licenses for both the TCFE (version 9 and higher)
and MOBFE (version 4 and higher) databases.

The example uses the Property Model Calculator with the Martensite Temperatures Model.
It shows the Ms temperatures of different types of martensites: lath, plate, and ε (hcp),
compared with experimental ε Ms values.

Project File and Video Tutorial Information
l

Folder: Property Models>Steel

l

File name: PM_Fe_02_Fe-Mn_martensite_morphologies.tcu
Also see our website and YouTube channel for tutorial videos related to the
Property Model Calculator.

Plot Result
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All morphologies

A diagram showing all the Ms temperatures of different types of martensite morphologies (lath,
plate and epsilon (hcp) compared with experimental epsilon Ms values.

Thermo-Calc User Guide: Graphical Mode ǀ 381 of 527

Thermo-Calc Documentation Set

PM_Fe_03: Fe-C-Mn Pearlite
To run calculations with the Steel models (Martensite and Pearlite) requires a
valid maintenance license plus licenses for both the TCFE (version 9 and higher)
and MOBFE (version 4 and higher) databases.

The example uses the Property Model Calculator with the Pearlite model.
The example shows how to calculate pearlite growth rate, lamellar spacing, and times of
start (2% transformation) and finish (98% transformation) as functions of isothermal heat
treating temperature in an Fe-0.69C-1.80Mn alloy (mass %). With maximize growth rate set
as the criterion, the model gives maximal growth rate and minimal lamellar spacing. With
optimal pearlite as the pearlite mode, the model optimizes partitioning of substitutional
alloying element(s) (Mn in this example) according to the criterion, which realizes a smooth
transition between ortho-pearlite at high temperature and para-pearlite at low
temperature.

Reference
Razik, N.A, G.W. Lorimer, and N Ridley. 1974. “An Investigation of Manganese Partitioning
during the Austenite-Pearlite Transformation Using Analytical Electron Microscopy.” Acta
Metallurgica 22 (10): 1249–58. doi:10.1016/0001-6160(74)90138-2.

Project File and Video Tutorial Information
l

Folder: Property Models>Steel

l

File name: PM_Fe_03_Fe-C-Mn_Pearlite.tcu
Also see our website and YouTube channel for tutorial videos related to the
Property Model Calculator.

Plot Results
Growth Rate
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Lamellar Spacing
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TTT

The TTT (time-temperature-transformation) diagram showing times of start (2% transformation)
and finish (98% transformation) as functions of isothermal heat treating temperature in an Fe0.69C-1.80Mn alloy (mass %).
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Process Metallurgy Module Examples Collection
The Process Metallurgy Module requires both a valid Maintenance and Support
Subscription (M&SS) and a license for the TCS Metal Oxide Solutions Database
(TCOX8 or newer).

All users can test the Process Metallurgy Module with the included OXDEMO
database, which is limited to these elements: Al, C, Ca, Fe, O, S, and Si. For
more information about this and other products visit our website.

The Process Metallurgy Module
About the Examples
In this section:
PMET_01: Basic Oxygen Furnace (BOF)

386

PMET_02: Ladle Furnace (LF)

393

PMET_03: Argon Oxygen Decarburization (AOD)

401

PMET_04: Basic Oxygen Furnace (BOF) Kinetics

408

PMET_05: Lab Scale Ladle Furnace (LF) Kinetics

416

PMET_06: Ladle Furnace (LF) Kinetics

422

Thermo-Calc User Guide: Graphical Mode ǀ 385 of 527

Thermo-Calc Documentation Set

PMET_01: Basic Oxygen Furnace (BOF)
This example does not require a license to run the simulation. It works with both
the TCS Metal Oxide Solutions Database (TCOX versions 8 and newer) as well as
the free OXDEMO database.
The example uses the Process Metallurgy Calculator to demonstrate a simplified
steelmaking process in a Basic Oxygen Furnace (BOF).
The real-world BOF process is highly exothermic and needs adiabatic
calculations.

Open the Project File
It is recommended you open the example project file and watch the companion video. The
video walks you through setting up the material groups as well as analyzing the results.

Open the example project file from Thermo-Calc Help → Example Files →
Process Metallurgy → PMET_01_Basic_Oxygen_Furnace.tcu.

This example is included as a tutorial on our website and our YouTube channel.
In general, the steps to set up this simulation are described in Defining the Equilibrium
Simulation. After setting up the steel, slag and gas system, you can generate various plots to
analyze the results. Below is a brief summary of this analysis.
See Phase Groups for details about how the Process Metallurgy Module plot labels are
grouped into the liquid metal, solid metal, solid oxides, liquid oxides and gas phases.
For this example, a One axis calculation type is used for all plots. The Grid Definition settings
for these plots are also set on the Process Metallurgy Calculator:
l

Quantity: Amount of Oxygen (GAS)

l

Stepping 0 min to 10 max with 40 steps
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Amount of Phase Groups

After the plot is generated, by default you can see the Amount of phase group is plotted on
the Y-axis as a function of the quantity plotted on the X-axis, in this case the Amount of
Oxygen (GAS).
Zooming into the low gas amount (see below), it can be seen that the evolution of the gas
phase is retarded. The reason is that the oxygen gas first oxidizes some of the silicon
dissolved in the steel to form silicon dioxide (SiO2). Only when the silicon content in the steel
has dropped below a certain level can the oxygen gas burn away the carbon dissolved in the
steel to form a carbon monoxide (CO)-rich gas phase.
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These reactions can be investigated in more detail with different plots, so we will do that.

Composition of Liquid Metal
For the next plot, you define the following on a Plot Renderer, which you add to the Process
Metallurgy Calculator. Keep the X-axis setting. For the Y-axis, choose Composition of a
phase group, Liquid Metal, All elements.
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In the plot (that uses a linear axis) the reduction of the carbon content can be clearly seen.
This reduction of the carbon content is what is termed “steelmaking”. The hot metal coming
from the blast furnace has a very high carbon content of typically 4.5 wt%. If it is left to
solidify without lowering the carbon content, it will be extremely brittle and be unfit for
rolling or forging.
Other changes in steel chemistry occurring in the BOF can be made visible by changing the
Y-axis type from linear to logarithmic.
In the example project file only the logarithmic 10 version of the plot is
included.
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Now you can see the removal of the elements from the liquid steel in the following order:
first calcium, then aluminium, then silicon and finally carbon (Ca, Al, Si and C) according to
their position on the Ellingham diagram.

Composition of Liquid Slag
Add another Plot Renderer and define the following. Keep the X-axis setting. For the Y-axis,
choose Composition of a phase group, Liquid Oxides, All components.
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This plot shows how the liquid slag composition changes as a function of the amount of
oxygen added to the BOF.
At first, the SiO2 content of the slag rises sharply. This is due to the initial oxidation of the
silicon dissolve in the hot metal. The SiO2 that is formed combines with the slag and
increases its SiO2 content.
This increased SiO2 content reduces the liquidus temperature of the slag and, as you can see
in the first plot, thereby increases the amount of liquid slag and reduces the amount of solid
oxides. This is also exactly what happens in reality.
On further addition of oxygen to the liquid steel, the silicon dioxide (SiO2) content in the slag
increases further and further as more silicon is oxidized and combines with the slag. At the
same time the oxygen partial pressure in the steel slowly increases. After about 6 tonnes of
oxygen have been added to the system, the oxygen pressure is high enough to start oxidizing
the steel itself.
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The slag quickly becomes rich in iron oxide (FeO). When this starts happening, the
steelmaking process is complete and the steel is ready to be tapped into a ladle for further
steel refining.
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PMET_02: Ladle Furnace (LF)
This example does not require a license to run the simulation. It works with both
the TCS Metal Oxide Solutions Database (TCOX versions 8 and newer) as well as
the free OXDEMO database.
The example uses the Process Metallurgy Calculator to represent a simplified steel refining
process in a ladle furnace (LF). It introduces you to the workflow of the Process Metallurgy
Module. It is recommended you open the example project file and watch the companion
video. The video walks you through setting up the material groups as well as analyzing the
results.

Open the Project File
You can open the example project file from Thermo-Calc Help → Example Files
→ Process Metallurgy → PMET_02_Ladle_Furnace.tcu.

This example is included as a tutorial on our website and our YouTube channel.
In general, the steps to set up this simulation are described in Defining the Equilibrium
Simulation. After setting up the steel, slag and gas system, you can generate various plots to
analyze the results. Below is a brief summary of this analysis.
See Phase Groups for details about how the Process Metallurgy Module plot labels are
grouped into the liquid metal, solid metal, solid oxides, liquid oxides and gas phases.
The material saved for this example, Steel_LF, could be a typical, but simplified composition
of a fully killed SAE 1040 grade steel. The sulfur content, however, is too high for most final
applications and must be reduced. Sulfur is usually removed from liquid steel in a ladle
furnace using a calcium oxide-rich slag.
In this example, we want to find a slag composition that efficiently desulphurizes the steel.
For this particular calculation we choose not to define a constant amount of slag but instead
use absolute amounts of components. To do this, we set the Input type for the Slag material
group to use Absolute amount. After saving this composition, it becomes the slag material
for this example, Slag_LF.
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For this example, the gas phase is not considered, which is why the Gas material
group has been removed in the example project. This does not mean that no gas
phase is allowed to form; it simply means that no gas phase is used to set the
calculation conditions.
For this example, a Grid calculation type is used for all plots. The Grid Definition settings for
these plots are also set on the Process Metallurgy Calculator:

Leave the number of calculation steps at 10 for both axes in order to shorten
the calculation time. With this setting, the calculation should be completed in
just under one minute. The number of steps could be increased to maybe 30 x
30 for higher resolution of the results, but this increases the calculation time
significantly.

Fraction of Liquid Slag
In the example project file only the Ratio of liquid slag and sulfur in liquid steel
contour plot is included.

Thermo-Calc User Guide: Graphical Mode ǀ 394 of 527

Thermo-Calc Documentation Set

We want to understand whether our slag phase is liquid or not. To create the plot below, add
a Plot Renderer node with a Contour plot and choose Fraction of liquid slag as the Z-axis
variable. Set the interpolation as 50 x 50 and click Perform.

The plot shows that for low amounts of aluminium oxide (Al2O3) and silicon dioxide (SiO2),
almost no liquid slag is present. Process metallurgists refer to this as a hard slag.
Such a hard slag is in fact just solid oxide phases that passively float on the liquid steel. It
does not react with the liquid steel for kinetic reasons and therefore does not desulfurize the
steel.
Practical slag compositions are limited to the top, right field above the “fraction liquid slag =
0.9” contour line. Only here a liquid slag phase is present that can flow and can mix and
react with the steel.
Next we are interested in the ability of the slag phase to remove sulfur (s) from the liquid
steel.
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Sulfur in Liquid Steel

Refer to the Sulfur in liquid steel 3D plot included with the example. The red colors in the
upper right-hand corner at high SiO2 and Al2O3 content show that the steel contains high
amounts of sulfur.
This means that only a little of the sulfur in the liquid steel partitioned into the slag phase
and the slag phase has a poor capacity to take up sulfur.
The blue colors in the lower left-hand corner indicate that the liquid steel contains only very
low amounts of sulfur, so this indicates a slag composition that is effective at removing
sulfur, or in other words, has a high sulfur capacity.
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The performed calculations assume thermodynamic equilibrium. As shown in
the previous plot, there is almost no liquid slag phase present in the lower left
corner at low SiO2 and Al2O3 content. This means that thermodynamic
equilibrium would not be achieved due to the very slow kinetics of the reaction
between the liquid steel and the solid oxides.

Ratio of Liquid Slag and Sulfur in Liquid Steel
Refer to the Ratio of liquid slag and sulfur in liquid steel contour plot included with your
example. This is two plots combined into one contour plot. If you created the above Fraction
of Liquid Slag contour plot, this plot is created simply by adding another set of axes and then
defining the Z-axis.

Combining the information contained in the two plots results in an optimum slag
composition in a narrow composition band. To smooth the contours, Set the interpolation as
50 x 50.
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To map this optimal composition field one more plot can be generated by superimposing
contour plots of sulfur content in the liquid steel and fraction of liquid slag.
Since we want to have at least 95% liquid slag, in the set of axis variables for Fraction of
liquid slag, click to select the check box next to Use custom contour values and enter 0.95
in the field.
We also want to have less than 0.005% sulfur in the liquid metal, so also select the same
check box for the other Z-axes and set the value of sulfur to 0.005 . Click Perform.
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The optimal slag has a composition delimited by these two contour lines, so below the
contour line for sulfur content in the liquid steel and above the contour line for fraction of
liquid slag will be both fully liquid and effectively desulfurizes the steel.
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PMET_03: Argon Oxygen Decarburization (AOD)
This example does not require a license to run the simulation. It works with both
the TCS Metal Oxide Solutions Database (TCOX versions 8 and newer) as well as
the free OXDEMO database.
The example uses the Process Metallurgy Calculator.

Open the Project File
You can open the example project file from Thermo-Calc Help → Example Files
→ Process Metallurgy → PMET_03_Argon_Oxygen_Decarburization.tcu.

A variety of video tutorials are available for many of our products and features
on our website and our YouTube channel. The library keeps growing so be sure
to check back on a regular basis.
The example takes several minutes to run.
The Argon Oxygen Decarburization (AOD) process is a converter process applied in stainless
steel making. In this process the oxidation of chromium in the steel melt needs to be
prevented while carbon is oxidized. This is achieved by reducing the oxygen partial pressure
by having a high Ar-content in the blowing gas. It is a highly exothermic process that
requires adiabatic modeling. In this example the conversion of carbon-rich steel scrap is
modeled together with additions of Ferronickel and Ferrochrome to a stainless steel.
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The AOD-process is characterized by an initially high O2-content of the blowing gas, which is
gradually replaced by Ar. The maximum temperature of the process is typically around 1720
°C. A grid plot of an adiabatic calculation is well suited to model the required simultaneous
change of amount of gas and its composition during this process. The black line in the plot
above indicates a possible process control path that finally leads to suitable alloy
composition close to a X5CrNi 18-10 stainless steel.
In principle, this plot could be used to control the blowing gas flow in a plant process.
However, note that the simulation only considers a global gas phase, i.e. additional gas is
added but never removed. This means that the given gas phase composition is an average
one and not identical to the composition of the gas flowing in at each point in time.
Additionally there is a certain impact on the resulting equilibria from the fact that all gas
remains in the system and is not removed.
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Results
Slag Basicity
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The Slag Basicity plot shows the basicity of the slag (which is a measure for the sulphur capacity of
the slag). The process achieves a final basicity of 1.74 which is typical for an AOD-process. The black
line in the plot indicates a possible process control path that finally leads to suitable alloy
composition close to a X5CrNi 18-10 stainless steel.

S Content in Steel
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In the S Content in Steel plot, the sulphur content in the steel melt is slightly reduced during the
process from 0.056% in the initial steel scrap to finally ca. 0.035%. The black line in the plot
indicates a possible process control path that finally leads to suitable alloy composition close to a
X5CrNi 18-10 stainless steel.

Cr Content in Slag
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In the Cr Content in Slag plot, the Cr2O3-content in the slag reaches at the end of the process ca. 26
wt-%. This is typical for the AOD-process and requires an additional Cr-recovery step after the
conversion to reduce the loss of chromium. The black line in the plot indicates a possible process
control path that finally leads to suitable alloy composition close to a X5CrNi 18-10 stainless steel.

Amount of Slag
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In the Amount of Slag plot, you can see that the process generates about 15 tons of slag in the
total. The black line in the plot indicates a possible process control path that finally leads to suitable
alloy composition close to a X5CrNi 18-10 stainless steel.

Liquid Slag Fraction

In the Liquid Slag Fraction plot, you can see that towards the end of the process the slag is
calculated to be mostly liquid. The black line in the plot indicates a possible process control path that
finally leads to suitable alloy composition close to a X5CrNi 18-10 stainless steel.

Thermo-Calc User Guide: Graphical Mode ǀ 407 of 527

Thermo-Calc Documentation Set

PMET_04: Basic Oxygen Furnace (BOF) Kinetics
This example requires a license to run the simulation. It works with TCS Metal
Oxide Solutions Database (TCOX) versions 8 and newer.
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Open the Project File
One way to learn how to work with the Process Metallurgy Calculator is to use
the project files as templates to help you set up your own simulation. For
example, you can examine the settings available on the Configuration window
and that are described in Process Simulation: Conditions Tab and the Options
Tab.

To open this project file, from the Thermo-Calc menu, go to Help → Example Files →
Process Metallurgy → PMET_04_Basic_Oxygen_Furnace_Kinetics.tcu.
Once you open the project file, click Perform Tree at the bottom center of the
Configuration window. It takes a few minutes to run the simulation.

Visit our Website for More Information
Due to the complexity of these simulations, it is recommended that you visit our
website for access to more detailed instructions related to this and the other
Process Metallurgy Module examples since the details are not included in the
technical help documentation.

You can find several other learning resources on the Process Metallurgy page of
our website (or in Thermo-Calc, go to Help → Thermo-Calc website). You can
also subscribe to the Thermo-Calc newsletter to be kept up-to-date about
upcoming releases, training, examples, videos and much more.

Setting Up the BOF Process Simulation
Using the Process Metallurgy Calculator and the Process simulation branch, this example
sets up a kinetic simulation of a simplified basic oxygen furnace (BOF) process applying the
effective equilibrium reaction zone (EERZ) to simulate the kinetics of the process.
What follows is a general overview of the three basic steps required to set up a kinetic
simulation.
Setting Up a Process Metallurgy Simulation
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Defining the Process Simulation

The Process Metallurgy Calculator for this example is renamed BOF - Calculator in the Project
window. To the right is the Configuration window where you choose to define a Process simulation.

The settings you need to access are on the Process Metallurgy Calculator Configuration window.
From here, you perform three steps to set up a kinetic simulation. (1) Edit the Process Model, (2)
Define the Materials, and then (3) Define the Process Schedule.

Step 1: Edit the Process Model
Click Edit Process Model to open the settings window. This is where general kinetic
parameters are defined that depend on the type of process to be simulated as well as the
equipment size and shape to be used. The reaction zone area is the area of the interface
between the steel and the slag in the crucible. This is where the steel and slag react with
each other. The kinetics of the reaction is limited by the mass transfer to and from the
interface.
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The Edit Process Model window for a Process Metallurgy Calculator using the Process simulation
branch.

Step 2: Define Materials
On the Materials tab all the compositions of the materials that are to be used during the
process are defined. Also, the temperature at which they are added and the zone to which
they are added is defined.

The Materials tab for a Process Metallurgy Calculator where you can define the composition,
temperature and zone.

Step 3: Define the Process Schedule
On the Process schedule tab the steelmaking recipe is entered, which defines at what times
how much of which materials is added. The process schedule in this example is not meant to
closely represent a real process; it is intended only to show the general principles.
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The Process schedule tab for a Process Metallurgy Calculator where you enter your steelmaking
recipe.

Plot Results
Many different aspects of the reactions taking place in the BOF can be plotted and analyzed.
After you run the project file and obtain the plots, you can experiment by adjusting the
settings on each Plot Renderer to see what happens in each case. There is more analysis
about this and other examples available at the links to our website.
A variety of video tutorials are available for many of our products and features
on our website and our YouTube channel. The library keeps growing so be sure
to check back on a regular basis.
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This plot shows the temperatures of the steel and slag bulk zones.
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This plot shows the steel composition in the bulk zone.

This plot shows the slag composition in the bulk zone.
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PMET_05: Lab Scale Ladle Furnace (LF) Kinetics
This example requires a license to run the simulation. It works with TCS Metal
Oxide Solutions Database (TCOX) versions 8 and newer.

Open the Project File
One way to learn how to work with the Process Metallurgy Calculator is to use
the project files as templates to help you set up your own simulation. For
example, you can examine the settings available on the Configuration window
and that are described in Process Simulation: Conditions Tab and the Options
Tab.

To open this project file, from the Thermo-Calc menu, go to Help → Example Files →
Process Metallurgy → PMET_05_Lab_Scale_Ladle_Furnace_Kinetics.tcu.
Once you open the project file, click Perform Tree at the bottom center of the
Configuration window.

About the Plot Results
Many different aspects of the reactions taking place in the LF can be plotted and analyzed.
After you run the project file and obtain the plots, you can experiment by adjusting the
settings on each Plot Renderer to see what happens in each case. There is more analysis
about this and other examples available at the links to our website.

Visit our Website for More Information
Due to the complexity of these simulations, it is recommended that you visit our
website for access to more detailed instructions related to this and the other
Process Metallurgy Module examples since the details are not included in the
technical help documentation.
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You can find several other learning resources on the Process Metallurgy page of
our website (or in Thermo-Calc, go to Help → Thermo-Calc website). You can
also subscribe to the Thermo-Calc newsletter to be kept up-to-date about
upcoming releases, training, examples, videos and much more.

Setting Up the LF Process Simulation
Using the Process Metallurgy Calculator and the Process simulation branch, this example
is based on the publication by Piva et al [2017, Piva] where a lab scale sample of pure iron is
first deoxidized with Si-Mn and then a synthetic top slag is added to the steel. Generally, by
using the project file and the information below, you can get an idea about how to set up a
ladle furnace simulation using the Process Metallurgy Module.
Setting Up a Process Metallurgy Simulation
Defining the Process Simulation
In the paper by Piva et al. [2017], it is experimentally investigated how the steel and
inclusion composition changes in function of time as the Si-Mn killed steel reacts with the
slag. This experiment can serve as a model for the production of SiMn killed steel with
subsequent top-slag deoxidation.

Diagram of the experiment performed by Piva et al. [2017]. The sequence as described in the text is:
(1) liquid Fe with dissolved oxygen; (2) FeMn and SiMn added to deoxidize Fe; (3) top slag added
after 360s; and (4) gradual reaction between steel, slag and inclusions.

According to the publication the following reaction sequence is expected as shown in the
diagram:
1. The deoxidizing agents dissolve and react with the oxygen in the steel forming oxide
inclusions, thereby reducing the amount of dissolved oxygen (“killing” the steel). The
kinetics are fast, and it can be assumed that the reaction proceeds to thermodynamic
equilibrium.
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2. The inclusions formed in (1) slowly start to float upwards and are removed out of the
liquid steel.
3. After adding the slag (360 s after killing the steel in (1) the liquid steel starts reacting
with the slag.
4. The inclusions continue to float up out of the liquid steel and combine with the slag.
According to the authors the most important reaction that takes place is the
dissolution of Al out of the slag and its transferal into the liquid steel, where it reacts
with the inclusions and changes the chemistry.
In this example only the last reaction is simulated after adding the slag. The
kinetic parameters, compositions of all materials and process schedule are all
taken from the publication.

Results and Experimental Analysis
The plots below compare the Al content in the liquid steel with the experimentally
determined amount. The bottom plot shows how the Al2O3 from the slag phase is gradually
reduced to metallic Al that dissolves in the liquid steel.

In this example, only part of the Al in the liquid steel is dissolved as metallic Al.
With the Process Metallurgy Module, it is possible to plot both dissolved Al and
also total Al.

In the steel industry this fraction of Al in the liquid steel is often termed dissolved Al. The
rest of the Al reacts with the oxygen in the liquid steel and forms oxide inclusions. The
amount of dissolved Al plus the Al bound up in oxide inclusions is often termed total Al. The
difference between total Al minus dissolved Al is an important measure for the steel
cleanness.
Total Al is what was measured by Piva et al. [2017] and their experimental data are
compared to the calculated values below.
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Total Al in the steel compared with experimental data (blue/top curve). If only the fraction of
dissolved Al is to be plotted (red/bottom curve), this is done by selecting “Composition of phase
group” and “Liquid metal”. The bottom figure is available with the example.

Immediately after killing the steel with SiMn and FeMn, the liquid steel contains liquid
Si-Mn-oxide inclusions only. As the liquid steel picks up Al from the slag phase in function of
time, the inclusions get richer and richer in Al. This experimentally verified change in
inclusion chemistry is well reproduced by this simulation.

Calculated composition of non-metallic inclusions in function of processing time compared to
experimental data [2017, Piva].

It is also possible to calculate the amount and type of inclusions present in the liquid steel. At
the beginning of the process all the inclusions are liquid oxides. After about 20 minutes
processing time, the first solid corundum (Al2O3) inclusions start appearing. After 25
minutes almost no liquid inclusions remain. The total amount of inclusions decreases in
function of time as they float up out of the liquid steel and combine with the slag floating on
top of the steel.
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Amount of inclusions in the liquid steel in function of processing time. The total amount of
inclusions (red line) and liquid oxide inclusions (blue line) are plotted. Up to about 20 min all
inclusions are liquid oxide type, then they are replaced by solid corundum (Al2O3) inclusions.
Experimental data from Piva et al. [2017].

Reference
[2017, Piva] Piva, S. P. T., Kumar, D. & Pistorius, P. C. "Modeling Manganese Silicate
Inclusion Composition Changes during Ladle Treatment Using FactSage Macros," Metall.
Mater. Trans. B 48, 37–45 (2017).
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PMET_06: Ladle Furnace (LF) Kinetics
This example requires a license to run the simulation. It works with TCS Metal
Oxide Solutions Database (TCOX) versions 8 and newer.

Open the Project File
One way to learn how to work with the Process Metallurgy Calculator is to use
the project files as templates to help you set up your own simulation. For
example, you can examine the settings available on the Configuration window
and that are described in Process Simulation: Conditions Tab and the Options
Tab.

To open this project file, from the Thermo-Calc menu, go to Help → Example Files →
Process Metallurgy → PMET_06_Ladle_Furnace_Kinetics.tcu.
Once you open the project file, click Perform Tree at the bottom center of the
Configuration window. It takes several minutes to run the simulation.
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The nodes in the Project window for this example. The Process Metallurgy Calculator is renamed to
EERZ model. If you click this node the Configuration window opens, which is where all the settings
for the process simulation are located. This advanced example also uses three Experimental Data
Reader nodes to read the experimental data that is included in the simulation results. After setting
up the system and accessing the experimental data, you then add Plot Renderers to the calculator
to generate the output in the Results window.

Due to the complexity of these simulations, it is recommended that you visit our
website for access to more detailed instructions related to this and the other
Process Metallurgy Module examples since the details are not included in the
technical help documentation.

About the Plot Results
Many different aspects of the reactions taking place in the LF can be plotted and analyzed.
After you run the project file and obtain the plots, you can experiment by adjusting the
settings on each Plot Renderer to see what happens in each case. There is more analysis
about this and other examples available at the links to our website.
A variety of video tutorials are available for many of our products and features
on our website and our YouTube channel. The library keeps growing so be sure
to check back on a regular basis.

Setting Up the LF Process Simulation Kinetics
The example uses the Process Metallurgy Calculator and the Process simulation branch to
show how a full kinetic simulation of the LF refining process is set up as shown in the
diagram below. The simulation is based on an LF process described in an article by Graham
and Irons [2009, Graham] and the results of the simulation are compared to their
experimentally determined steel, slag, and inclusion composition in function of processing
time. Only some plotting results and analysis are presented, discussed and compared to the
experimental data from Graham and Irons [2009].
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Overview of the LF process to be simulated.

Process Schedule
The process schedule shows how this LF process is implemented in the Process Metallurgy
Module.
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The Process schedule set up for this example. If you have the project open in Thermo-Calc , click the
Process schedule tab to view this. You can then click the check boxes in the Plot column to include or
exclude materials to better visualize the process schedule on this tab. This is based on the LF steel
refining process schedule as published by Graham and Irons [2009, Graham].

Temperature
The experimentally determined temperature of the steel can easily be reproduced to within
experimental uncertainty. In addition many more details of the temperature evolution in the
different zones of the ladle furnace can be resolved by the simulation. For example, the
addition of Al to the liquid steel results in a temperature increase due to the exothermal
oxidation of the Al by the dissolved oxygen. The addition of CaO to the slag phase on the
other hand results in a significant cooling of the slag due to the heat required to heat up and
melt the added CaO. It can also be seen that the heat added to the reaction zone during
electric arc heating results in a strong temperature increase of this zone. In reality the local
temperature is even much higher, but this is not resolved by this model.
A finer point to observe is that the temperature of the reaction zone is always slightly higher
than both the steel zone and the slag zone. The reason for this is that the reaction between
the steel and the slag is exothermic.
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Temperature evolution of the steel zone, slag zone and reaction zone during the LF treatment. The
temperature of the reaction zone has been added to illustrate how its temperature is increased by
the heat input by the electric arc that is added to this zone (top). The bottom plot is included with
the example in Thermo-Calc and shows another way you can visualize the results.

Liquid Metal Composition and Amount
Already this simple model captures the evolution of the steel chemistry in function of
processing time very well. The experimentally determined S, Mn and Ti contents are
reproduced to within experimental accuracy.
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Evolution of the steel chemistry in function of time during ladle furnace treatment. Most of the
experimentally measured datapoints are very well reproduced by this very simple model set-up
demonstrating that the underlying processes are well captured. This plot is not included with the
example but you can try to reproduce it yourself or go to our website to see the detailed example
available there.

Slag Composition and Amount
Also the evolution of the slag chemistry is well reproduced. Some of the important changes
in chemistry, such as the gradual decrease of FeO and MnO and uptake of S in function of
time can only be seen after zooming into the plot somewhat
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Evolution of the slag chemistry in function of time during ladle furnace treatment.

Inclusion Composition
Finally, also the evolution of the inclusion compositions can be calculated. Up to about 25
min into ladle furnace processing the inclusions are almost pure solid corundum (Al2O3),
then a second population of MgO rich spinel inclusions start forming. This result captures
the essence of what is experimentally observed.

Evolution of the inclusion chemistry in function of time.

Visit our Website for More Information
You can find several other learning resources on the Process Metallurgy page of
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our website (or in Thermo-Calc, go to Help → Thermo-Calc website). You can
also subscribe to the Thermo-Calc newsletter to be kept up-to-date about
upcoming releases, training, examples, videos and much more.

References
[2009, Graham] K. J. Graham, G. A. Irons, Toward integrated ladle metallurgy control. Iron
Steel Technol. 6, 164–173 (2009).
[2020, Mason] P. Mason, A. N. Grundy, R. Rettig, L. Kjellqvist, J. Jeppsson, J. Bratberg, “The
Application of an Effective Equilibrium Reaction Zone Model Based on CALPHAD
Thermodynamics to Steel Making” in 11th International Symposium on HighTemperature Metallurgical Processing (2020; DOI: 10.1007/978-3-030-36540-0_10), pp.
101–113.
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Diffusion Module (DICTRA) Graphical Mode
Examples
Examples using up to three elements are available to all users. The other
examples require a Diffusion Module (DICTRA) license to calculate and plot
results.

These examples use the Diffusion Calculator. All examples use demonstration database
packages included with your installation no matter what licenses you have.
About the Examples
In this section:
D_01 Homogenization of a Binary Fe-Ni Alloy

432

D_02 Ferrite(bcc)/Austenite(fcc) Transformation in a Binary Fe-C Alloy

434

D_03 Evolution of an Fe-Cr-Ni Diffusion Couple

437

D_04 Fe-C Moving Boundary: Austenite to Ferrite

440

D_05 γ/α/γ Diffusion couple of Fe-Ni-Cr alloys

443

D_06 Diffusion Through a Tube Wall

450

D_07 Multiphase Carburization of a Ni-25Cr-0.0001C alloy

452
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D_01 Homogenization of a Binary Fe-Ni Alloy
The single phase example simulates the diffusion of Fe and Ni at a temperature of 1400 K in
a planar domain. At this temperature the material is fully austenitic, i.e. the only phase
present is the so-called fcc (face centered cubic) phase. Initially, there is a linear variation in
Ni going from 10 mass-% on the left-hand side to 50 mass-% on the right-hand side.
This example is available as a video tutorial on our website and YouTube
channel. In previous versions of the software (prior to 2017b) it is example 19.
Composition of Ni vs Distance

Project File Name
l

Folder: Diffusion Module - DICTRA

l

File name: D_01_Diffusion_Single_Phase.tcu
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This example is part of the Diffusion Module (DICTRA) Quick Start Guide
available to all users. A version of the example is also available for Console
Mode.
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D_02 Ferrite(bcc)/Austenite(fcc) Transformation in a
Binary Fe-C Alloy
The moving phase boundary example simulates the growth of ferrite (bcc) into austenite
(fcc). The austenite is assumed to be initially homogeneous with the composition Fe-0.15
mass-% C. The transformation temperature is 1050 K. The initial thickness of the austenite is
2 mm and an initially very thin ferrite (1 nm) is also present at the start of the simulation.
This example is available as a video tutorial on our website and YouTube
channel.
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Position of interface vs time
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Composition profile C

Project File Name
l

Folder: Diffusion Module - DICTRA

l

File name: D_02_Diffusion_Moving_Boundary.tcu
This example is part of the Diffusion Module (DICTRA) Quick Start Guide
available to all users. A version of the example is also available for Console
Mode.
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D_03 Evolution of an Fe-Cr-Ni Diffusion Couple
The multiphase example simulates the evolution of an Fe-Cr-Ni diffusion couple during a 100
hour heat treatment at 1100° C (1373.15 K). Both end members of the diffusion couple are
duplex ferrite plus austenite, but the majority phase is ferrite on the left-hand side and
austenite on the right.
With this type of simulation it is assumed that the material is fully equilibrated at each grid
point, i.e. the local phase fractions, phase compositions and so forth are obtained from an
equilibrium calculation with the local overall composition as a condition.
More details about the homogenization model for multiphase simulations can be found in
Larsson and Engström [2006] and Larsson and Höglund [2009]. Experimental data is from
Engström [1995] .
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Phase fraction of FCC

Project File Name
l

Folder: Diffusion Module - DICTRA

l

File name: D_03_Diffusion_Multiphase.tcu
This example is part of the Diffusion Module (DICTRA) Quick Start Guide
available to all users. A version of the example is also available for Console
Mode.

References
[1995, Engström] A. Engström, Interdiffusion in multiphase, Fe-Cr-Ni diffusion couples.
Scand. J. Metall. 24, 12–20 (1995).
[2006, Larsson] H. Larsson, A. Engström, A homogenization approach to diffusion simulations
applied to α+γ Fe–Cr–Ni diffusion couples. Acta Mater. 54, 2431–2439 (2006).
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[2009, Larsson] H. Larsson, L. Höglund, Multiphase diffusion simulations in 1D using the
DICTRA homogenization model. Calphad. 33, 495–501 (2009).
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D_04 Fe-C Moving Boundary: Austenite to Ferrite
This example simulates the austenite to ferrite transformation in a Fe-0.01 mass% C steel
during continuous cooling. The simulation starts at a temperature where only austenite is
stable, ferrite nucleates and grows into the austenite during cooling in the two phase region.
Plots of thermal and carbon composition profiles are generated.
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Thermal profile
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Carbon composition profile

Project File Name
l

Folder: Diffusion Module - DICTRA

l

File name: D_04_Diffusion_Fe-C_Moving_Boundary_Austenite_to_Ferrite.tcu
This example is available to all users.
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D_05 γ/α/γ Diffusion couple of Fe-Ni-Cr alloys
This example demonstrates the evolution of a ternary Fe-Cr-Ni diffusion couple. A thin slice
of ferrite (α phase) (38%Cr,0%Ni) is clamped between two thicker slices of austenite (γ
phase) (27%Cr, 20%Ni). The assembly is subsequently heat treated at 1373 K.
This set up corresponds to diffusion couple in Kajihara et al. [1993a] and Kajihara and
Kikuchi [1993b].
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Interface Position
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Concentration profiles at 3600 s
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Concentration profiles at 36 000 s
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Concentration profiles at 360 000 s

Thermo-Calc User Guide: Graphical Mode ǀ 447 of 527

Thermo-Calc Documentation Set

Concentration profiles at 3 600 000 s
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Diffusion paths

Project File Name
l

Folder: Diffusion Module - DICTRA

l

File name: D_05_Diffusion_Fe_Ni_Cr_Moving_Boundary_Diffusion_Couple.tcu

References
[1993a, Kajihara] M. Kajihara, C.-B. Lim, M. Kikuchi, Experimental Study on Dissolution of
ALPHA Phase in GAMMA/ALPHA/GAMMA Diffusion Couples of the Fe-Cr-Ni System. ISIJ
Int. 33, 498–507 (1993).
[1993b, Kajihara] M. Kajihara, M. Kikuchi, Numerical analysis of dissolution of α phase in
γ/α/γ diffusion couples of the Fe-Cr-Ni system. Acta Metall. Mater. 41, 2045–2059
(1993).
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D_06 Diffusion Through a Tube Wall
This is a simple example of diffusion through a tube wall. The tube material is an Fe0.06Mn-0.05C alloy. Two plots comparing distance to the U-fraction of manganese and
composition of carbon are generated to visualize the austenite region. A cylindrical
geometry is used with mixed zero flux and activity boundary conditions.
On the inside wall a carbon activity of 0.9 is maintained whereas on the outside the carbon
activity is very low. This example demonstrates the use of boundary conditions, advanced
plotting and tables.
This example is based on Console Mode exab6. When in Console Mode, you can
open the example from Thermo-Calc (File → Examples Files → Diffusion
Module).
Plot: Composition of C vs Distance
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U-fraction of Mn vs Distance

Table: Composition C vs Distance

Project File Name
l

Folder: Diffusion Module - DICTRA

l

File name: D_06_Diffusion_Carburization_Tube.tcu
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D_07 Multiphase Carburization of a Ni-25Cr-0.0001C
alloy
This example is based on Engström et al. [1994] and is about carburization of a Ni-25Cr0.0001C alloy. In this case the M7C3 and M3C2 carbides are entered as spheroid phases in
an FCC_A1 matrix. It is similar to Graphical Mode example D_06 except the default
simulation condition is automatically set to use the homogenization model.
The isothermal calculation is run for 1000 hours at a temperature of 1123 K using the mixed
zero flux and activity left boundary condition. Results are plotted using two Plot Renderers
and a Table Renderer.
This example is based on Console Mode exd1b. When in Console Mode, you can
open the example from Thermo-Calc (File → Examples Files → Diffusion
Module).
This example is available as a video tutorial on our website and YouTube
channel.
Phase fraction vs distance
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Table of Composition profiles
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Composition of C vs Distance

Project File Name
l

Folder: Diffusion Module - DICTRA

l

File name: D_07_Diffusion_Carburization_Multiphase.tcu

Reference
[1994, Engström] A. Engström, L. Höglund, J. Ågren, Computer simulation of diffusion in
multiphase systems. Metall. Mater. Trans. A. 25, 1127–1134 (1994).
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Precipitation Module (TC-PRISMA) Graphical
Mode Examples
Examples that use up to three elements are available to all users. The other
examples require a Precipitation Module (TC-PRISMA) license to calculate and
plot results.

All examples use demonstration database packages included with your
installation. You can open the examples from the main menu: File → or Help →
Examples Files.
Unless specified in tables for each example, all the numerical parameters are
assumed default values.
In this section:
P_01: Isothermal Precipitation of Al3Sc

457

P_02: Stable and Metastable Carbides - Isothermal

467

P_03: Stable and Metastable Carbides - TTT Diagram

470

P_04: Precipitation of Iron Carbon Cementite

473

P_05: Precipitation of γ’ in Ni Superalloys - Isothermal

476

P_06: Precipitation of γ’ in Ni Superalloys - Non-isothermal

480

P_07: Continuous Cooling Transformation (CCT) Diagram of Ni-Al-Cr γ-γ’

485

P_08: Precipitation of Cu-Ti CU4TI with Assumptions of Sphere and Needle
Morphologies

493

P_09: Precipitation of Al-Sc AL3SC with Assumption of Sphere and Cuboid
Morphologies

500

P_10: Initial Particle Size Distribution of Fe-Cr-C

515

P_11: Interfacial Energy Function

520

P_12: Comparing Growth Rate Models for an Al-Zr System

522
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P_13: Paraequilibrium Precipitation of Cementite Fe-C-Cr

525
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P_01: Isothermal Precipitation of Al3Sc
This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase.
The simulation results can be compared with experimental data collected from Marquis and
Seidman [2001, Marquis] and Novotny and Ardell [2001, Novotny].
This example also includes a plot using the Yield strength Property Model. This
demonstrates how you can use the results from a Precipitation Module (TC-PRISMA)
simulation as input to the Yield Strength Model, i.e. the calculated precipitate radius/radii
for each time step is used to calculate the precipitation strengthening, and similarly, the
matrix composition for each time step is used to calculate the solid solution strengthening
when this is selected in the Configuration on the Plot Renderer. The experimental data for
the Yield Strength Model is from Seidman et al. [2002, Seidman].

Project File, Step-By Step Instructions and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_01_Precipitation_Al-Sc_AL3SC.tcu
This example is available as a video tutorial on our website and YouTube
channel.
You can also use the step-by-step instructions included in a PDF to follow the
video or compare to the project file in Thermo-Calc.
At this time, the Yield Strength Model shown with this example is not included in
the step-by-step instructions.

Example Settings
System (System Definer)
Database package

Demo: Aluminum-based
alloys (ALDEMO,
MALDEMO)
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Elements

Al, Sc

Conditions (Precipitation Calculator)
Composition

Al-0.18Sc Mole percent

Matrix phase

FCC_A1

Precipitate phase

AL3SC

Precipitate Phase Data Parameters (Precipitation Calculator)
Nucleation sites

Bulk

Interfacial energy

Calculated

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

350° C

Simulation time

1.0E7 seconds

Experimental File Reader 1 and 2
There are two Experimental File Reader nodes used. One for the mean
radius plot and one to demonstrate the Yield Strength Property Model.

Plot Results
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This plot shows the mean radius of the AL3SC precipitate as a function of time.

This plot shows the total yield strength of the AL3SC precipitate as a function of time compared to
experimental data from Sieldmen et al. [2002, Seidman].

References
[2001, Marquis] E. A. Marquis, D. N. Seidman, Nanoscale structural evolution of Al3Sc
precipitates in Al(Sc) alloys. Acta Mater. 49, 1909–1919 (2001).
[2001, Novotny] G. M. Novotny, A. J. Ardell, Precipitation of Al3Sc in binary Al–Sc alloys.
Mater. Sci. Eng. A Struct. Mater. Prop. Microstruct. Process. 318, 144–154 (2001).
[2002, Seidman] D. N. Seidman, E. A. Marquis, D. C. Dunand, Precipitation strengthening at
ambient and elevated temperatures of heat-treatable Al(Sc) alloys. Acta Mater. 50,
4021–4035 (2002).
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Isothermal Precipitation Calculation
Example P_01 – Precipitation Al-Sc AL3SC

Isothermal Precipitation Calculation: Example P_01 –
Precipitation Al-Sc AL3SC
This example shows you how to set up an isothermal precipitation calculation for the formation of
AL3SC in an aluminium-scandium alloy at 350° using the Precipitation Module (TC-PRISMA).
This is one of the most basic calculations using the Precipitation Module (TC-PRISMA), so it is a good
place to start if you are new to this simulation type.

HELPFUL INFORMATION
•
•
•

All users can run this calculation, even those who do not have a license for the Precipitation
Module (TC-PRISMA).
A companion video is available for this example , which can be watched here:
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
This calculation is based on Precipitation Module example P_01 – Precipitation Al-Sc AL3SC,
which is included in your installation. To run the example file, open Thermo-Calc and select Help
> Examples Files. Open the Precipitation Module (TC-PRISMA) folder. Double-click the example
file and click Perform at the bottom center of the Configuration window in Thermo-Calc.

ABOUT THE EXAMPLE
This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase.

SETTING UP THE SYSTEM
1. Open Thermo-Calc in Graphical Mode.
2. Under Templates, click Precipitation Simulation.
3. All the nodes for a precipitation calculation are added to the Project window:
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Isothermal Precipitation Calculation
Example P_01 – Precipitation Al-Sc AL3SC

4. In the Project window, click the System Definer 1 node.
5. Set the database Package to Demo: Aluminium-based alloys (ALDEMO, MALDEMO), which
loads both thermodynamic and kinetic demonstration aluminium databases.
6. From the Periodic Table, select the elements as follows. Select Al first so that it is the
dependant element:
a. Al (aluminium)
b. Sc (scandium).
7. From the Amount list (to the right of the Periodic Table), select Mole percent.
8. Enter 0.18 for Sc. This automatically sets Al to 99.82.

The system is now defined. However, before starting the precipitation calculation, it is recommended
to run a one axis calculation to find the phases present around 350° C.
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ONE AXIS CALCULATION
Why We Do This
In order to set up an isothermal precipitation calculation, you need to know which phases are
present at 350 °C. A one axis calculation provides this information.

Setting up a One Axis Calculation
1. In the Project window, right-click the System Definer 1 node, and from the Create New
Successor menu select Equilibrium Calculator.
2. In the Configuration window, select a Temperature in Celsius and enter 300.
3. Under Calculation Type, select One axis.
You now want to find the phases present around 350 °C.
4. Under Axis Definitions enter the Temperature range from Min 300 to Max 700.
Keep the default values for everything else. The system is now defined.
5. Right-click the Equilibrium Calculator node and select Create New Successor>Plot Renderer.
6. In the Project window, right-click the Plot Renderer 2 node you just created and select
Perform Now. Or click Perform at the bottom of the Configuration window.

Interpreting the Results of the One Axis Calculation
Once the calculation is complete, a plot is displayed in the Results window. This plot shows you
which phases are present at each temperature between 300° and 700° and the amount of that phase
at each temperature.
If you hover your cursor over any of the lines on the plot, a label gives you the name of the phase,
the temperature and the amount of the phase at that temperature.
We can see that there are two phases present at 350°. FCC_A1 is at the very top of the plot and
makes up more than 99% of the system. The remainder of the system is made up of Al3SC, which is
near the very bottom of the plot and is the precipitate phase in the alloy we are considering.
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Remember these two phases because these are used in the precipitation calculation.

PRECIPITATION CALCULATION
Setting up the Precipitation Calculation
1. In the Project window, click the Precipitation Calculator 1 node.
2. Notice that the Composition set in the System Definer auto-populated here.
3. Under Matrix Phase, the Phase defaults to FCC_A1, which is the primary phase present in the
one axis calculation.
NOTE: If you do not see any phases listed here it is probably because you do not have a kinetic
database selected. If so, go back to the System Definer and add a kinetic (mobility) database. In this
example it should be the MALDEMO database.
4. Under Precipitate Phase select AL3SC from the Phase list because that is the other phase
present around 350 °C, as shown in the one axis calculation.
Accept the default settings in the Precipitate Phase section. You could choose to define your
own interfacial energy settings if you have them.
5. Under Calculation Type, make sure Isothermal is selected.
6. Enter:
a. 350 as the Temperature and select Celsius.
b. 1.0E7 as the Simulation time and select Seconds, which is ten million seconds.
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7. In the Project window, click the Plot Renderer 1 node.
8. Under Y-axes, from the Axis type menu select Logarithmic 10 for a better view of the plot.
9. Click Perform at the bottom, center of the Configuration window.

Interpreting the Results of the Precipitation Calculation
Once the calculation is complete, your plot is shown in the Results window.
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This plot shows the
Mean radius of the
AL3SC precipitate as a
function of time.

At the beginning, which is the left-most side of the plot, the mean radius is quite small and then
grows rapidly over time, which is represented by moving rightward on the plot.

Setting Other Variables in the Precipitation module (TC-PRISMA)
The Precipitation Module (TC-PRISMA) offers many variables that you can plot for the same
calculation.
1. Click the Plot Renderer 1 node.
2. In the Y-axes section, click the Axis variable menu to see what other options are available.
3. Once you have made your selection, click Perform at the bottom, center of the Configuration
window to create a new plot.
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P_02: Stable and Metastable Carbides - Isothermal
This example simulates the kinetics of precipitation of both stable and metastable carbides
from ferrite phase. It demonstrates that metastable carbides (cementite, M7C3) may first
emerge and then disappear and the stable phase (M23C6) prevails.
This example uses the Equilibrium Calculator and a one axis calculation to determine how
the phases change with temperature. We are interested in the carbide precipitation at
1053K where only the carbide M23C6 is stable according to the equilibrium calculation. The
Precipitation Calculator is used to do an isothermal calculation of the three phases
(cementite, M23C6 and M7C3) where cementite and M7C3 are metastable phases.

Project File and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_02_Precipitation_Fe-C-Cr_Cementite-M7C3-M23C6.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
System (System Definer)
Database package

Demo: Steels and Fe-alloys (FEDEMO,MFEDEMO)

Elements

Fe, C, Cr

Conditions (Precipitation Calculator)
Composition

Fe-0.1C-12Cr Mass percent

Matrix phase

BCC_A2
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Precipitate phases

Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)
Grain size (click Show details to display this
setting)

1.0E-4 m

Precipitate Phase Data Parameters (Precipitation Calculator)
Nucleation sites

Grain boundaries

Interfacial energy

Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282
J/m2

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

1053 K

Simulation time

400 000 seconds

Plot Results
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The Equilibrium Calculator and a One axis calculation is used to determine how the phases change
with temperature.

The Precipitation Calculator is used to do an isothermal calculation of the three phases (cementite,
M23C6 and M7C3) where cementite and M7C3 are metastable phases.
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P_03: Stable and Metastable Carbides - TTT Diagram
In this example, the kinetics of precipitation of both stable and metastable carbides is
calculated from the ferrite phase. It demonstrates that metastable carbides may first
emerge and then disappear and the stable phase prevails.
This example uses the Equilibrium Calculator and a one axis calculation type to determine
how the phases change with temperature. Using this result, the Precipitation Calculator is
used to do a TTT (Time-Temperature-Transformation) diagram calculation of the three
phases (cementite, M23C6 and M7C3) at the grain boundaries.
For a TTT diagram calculation, select TTT diagram in Calculation Type, then enter Min,
Max, and Step of Tempeature, as well as Max annealing time. In Stop criterion, choose
Volume fraction of phase and enter the value.

Project File and Video tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_03_Precipitation_Fe-C-Cr_TTT_Cementite-M7C3-M23C6.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
System (System Definer)
Database package

Demo: Steels and Fe-alloys (FEDEMO and
MFEDEMO)

Elements

Fe, C, Cr

Conditions (Precipitation Calculator)
Composition

Fe-0.1C-12Cr Mass percent

Matrix phase

BCC_A2
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Precipitate phases

Cementite, M23C6 and M7C3

Matrix Phase Data Parameters (Precipitation Calculator)
Grain size (click Show details to display this setting)

1.0E-4 m

Precipitate Phase Data Parameters
Nucleation sites

Grain boundaries

Interfacial energy

Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3
0.282 J/m2

Calculation Type (Precipitation Calculator)
Calculation type

TTT diagram

Temperature

500° to 800° C with 25° C steps

Max. annealing time

1.0E8 seconds

Stop criteria

Volume fraction of phase is set to 0.0001

Options > Numerical Parameters
No. of grid points over one order of magnitude in
radius

150

Max no. of grid points over one order of magnitude
in radius

200

Min no. of grid points over one order of magnitude
in radius

100

Plot Results
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The Equilibrium Calculator is used to show how the phases change with temperature.

The Precipitation Calculator is used to do a TTT (Time-Temperature-Transformation) diagram
calculation of the three phases (cementite, M23C6 and M7C3) at the grain boundaries.
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P_04: Precipitation of Iron Carbon Cementite
Simulate the kinetics of precipitation of carbides from a BCC Fe solution phase. This example
is based on Wert [1949].
This example uses two Experimental File Reader activities with the Precipitation Calculator
and an isothermal calculation, to plot the volume fraction of the cementite phase.

Project File and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_04_Precipitation_Fe-C_Cemetite.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
System (System Definer)
Database package

Demo: Steels and Fe-alloys (FEDEMO and
MFEDEMO)

Elements

Fe, C

Conditions (Precipitation Calculator)
Composition

Fe-0.016C mass percent

Matrix phase

BCC_A2

Precipitate phase

Cementite

Matrix Phase Data Parameters (Precipitation Calculator)
Grain aspect ratio (click Show details to display this
setting)

1.0
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Dislocation density (click Show details to display this
setting)

1.5e11m-3

Precipitate Phase Parameters (Precipitation Calculator)
Nucleation sites

Dislocations

Interfacial energy

0.24 J/m2

Growth rate model (click Show details)

Advanced

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

102° C

Simulation time

600 000 seconds

Plot Results

Volume fraction of the cementite phase.

Reference
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[1949,Wert] C. A. Wert, Precipitation from Solid Solutions of C and N in α-Iron. J. Appl. Phys.
20, 943 (1949).
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P_05: Precipitation of γ’ in Ni Superalloys Isothermal
This example simulates the kinetics of precipitation of γ’ phase from γ phase. The simulation
results can be compared with experimental data collected from Sudbrack et al. [2008].
This example uses three Experimental File Reader activities with the Precipitation
Calculator. It does an isothermal calculation to plot the volume fraction, mean radius and
number density of the cementite phase.
DIS_FCC_A1 needs to be selected on the System Definer.

Project File and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_05_Precipitation_Ni-Al-Cr_Isothermal_Gamma-Gamma_prime.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
System (System Definer)
Database package

Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements

Ni, Al Cr

Conditions (Precipitation Calculator)
Composition

Ni-9.8Al-8.3Cr Mole percent

Matrix phase

DIS-FCC_A1 (see note above about how to select this phase)

Precipitate phase

FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)
Nucleation sites

Bulk
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Interfacial energy

0.012 J/m2

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

800° C

Simulation time

1 000 000 seconds

Plot Results
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The results of an isothermal calculation to plot the volume fraction of the cementite phase.

The results of an isothermal calculation to plot the number density of the cementite phase.

The results of an isothermal calculation to plot the mean radius of the cementite phase.

Reference
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[2008, Sudbrack] C. K. Sudbrack, T. D. Ziebell, R. D. Noebe, D. N. Seidman, Effects of a
tungsten addition on the morphological evolution, spatial correlations and temporal
evolution of a model Ni–Al–Cr superalloy. Acta Mater. 56, 448–463 (2008).
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P_06: Precipitation of γ’ in Ni Superalloys - Nonisothermal
This example simulates the kinetics of precipitation of γ’ phase from γ phase in Ni-8Al-8Cr
and Ni-10Al-10Cr at.% alloys during continuous cooling. The simulation results can be
compared with experimental results from Rojhirunsakool et al. [2013].
When you run (Perform) this example, it takes about 10 minutes for the
calculations to complete.
DIS_FCC_A1 needs to be selected on the System Definer.

Project File and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_06_Precipitation_Ni-Al-Cr_Non-isothermal_Gamma-Gamma_prime.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
In these examples a linear, continuously cooling condition is set up. This is done on the
Precipitation Calculator settings window in the Calculation Type section:
1. Select a Non-Isothermal.
2. Select a Temperature Unit and Time Unit from the lists.
3. Click Thermal Profile, where Time-Temperature profile points are entered to
describe the stepwise heat treatment schedule with linear segments. Up to 999 rows
of data points can be entered.
In these examples two rows of data points are needed for starting time 0s and
temperature 1150° C, as well as end time 3300s and temperature 380° C.
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4. Click the Plot Renderer node to select the Separate multimodal PSD check box.
Plotting the size distribution from the final simulation time of 3300 seconds, you can
see there are several peaks, although these are not completely separated. As above,
select the Separate multimodal PSD check box to separate the peaks.
5. Adjust the Valley depth ratio setting to 0.05 to separate into two peaks as shown in
the Ni-10Al-10Cr plot example. You can experiment with this setting to see how the
size distribution evolves with time, for example, try entering several values as plot
times 400 600 3300.
System (System Definer)
Database package

Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements

Ni, Al, Cr

Conditions (Precipitation Calculator)
Composition (Ni-8Al-8Cr)

Ni-8Al-8Cr Mole percent

Composition (Ni-10Al-10Cr)

Ni-10Al-10Cr Mole percent

Matrix phase

DIS_FCC_A1 (see note above about how to select this phase)

Precipitate phase

FCC_L12#2

Matrix Phase Data Parameters (Precipitation Calculator)
Mobility enhancement prefactor (click
Show details to display this setting)

5.0

Precipitate Phase Data Parameters (Precipitation Calculator)
Nucleation sites

Bulk

Interfacial energy

0.023 J/m2

Calculation Type (Precipitation Calculator)
Calculation type

Non-isothermal

Temperature unit

Celsius

Time unit

Seconds
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1150 - 380 °C

Temperature

Simulation time (Ni-8Al-8Cr)

3300 s

Simulation time (Ni-10Al-10Cr)

3300 s

Multimodal PSD (Plot Renderer)
Separate multimodal PSD for 8Al-8Cr

The Valley depth ratio is set to 0.05 for both plots. The number
of Points is increased to 200 for an average radius plot.

Separate multimodal PSD for 10Al10Cr

The Valley depth ratio is set to 0.18 for both plots.

Plot Results
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Mean Radius Ni-8Al-8Cr

Mean Radius Ni-10Al-10CR
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Size Distribution (PSD) Ni-8Al-8Cr

Size Distribution (PSD) Ni-10Al-10Cr

Reference
[2013, Rojhirunsakool] T. Rojhirunsakool, S. Meher, J. Y. Hwang, S. Nag, J. Tiley, R. Banerjee,
Influence of composition on monomodal versus multimodal γ′ precipitation in Ni–Al–Cr
alloys. J. Mater. Sci. 48, 825–831 (2013).
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P_07: Continuous Cooling Transformation
(CCT) Diagram of Ni-Al-Cr γ-γ’
In this example, a Continuous Cooling Transformation (CCT) diagram for a Ni-10Al-10Cr γ-γ’
alloy is calculated and plotted with superimposition of the cooling rate values.

Project File, Step-By Step Instructions and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_07_Precipitation_Ni-Al-Cr_CCT_Gamma-Gamma_prime.tcu
This example is available as a video tutorial on our website and YouTube
channel.
You can also use the step-by-step instructions included in a PDF to follow the
video or compare to the project file in Thermo-Calc.

Example Settings
System (System Definer)
Database package

Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements

Ni, Al, Cr

Conditions (Precipitation Calculator)
Composition

Ni-10Al-10Cr Mole percent

Matrix phase

DIS_FCC_A1

Precipitate phase

FCC_L12#2

Precipitate Phase Data Parameters (Precipitation Calculator)
Nucleation sites

Bulk
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Interfacial energy

0.023 J/m2

Calculation Type (Precipitation Calculator)
Calculation type

CCT Diagram

Temperature Min to Max

500 to 1200 Kelvin

Cooling rate(s)

.01 .1 1 10 100 K/s

Stop criteria

Volume fraction of phase 1.0E-4

Plot and Table Results
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In this plot, the blue line shows the time it takes for γ’ to transform at each of the cooling rates
according to the stop criteria, which we set as 1e-4 volume fraction. The cooling rates are
represented by the multi-coloured curved lines.

An example of the table shown in the Results window, which shows the same information as in the
plot - for each cooling rate the temperature and the time it takes for γ’ to transform according to
the stop criteria, which is a volume fraction of 1e-4.
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Continuous Cooling Transformation (CCT) Diagram of
Ni-Al-Cr γ-γ’: Precipitation Example P_07
HELPFUL INFORMATION
•
•
•

All users can run this calculation, even those who do not have a license for the Precipitation
Module (TC-PRISMA).
A companion video is available for this example , which can be watched here:
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
This calculation is based on Precipitation Module example P_07 – Precipitation NI-AlCr_CCT_Gamma-Gamma_prime, which is included in your installation. To run the example file,
open Thermo-Calc and select Help > Examples Files. Open the Precipitation Module (TC-PRISMA)
folder. Double-click the example file and click Perform at the bottom center of the Configuration
window in Thermo-Calc.

ABOUT THE EXAMPLE
This example shows you how to simulate a CCT diagram for gamma prime (γ’) precipitation in a Ni-CrAl alloy using the Precipitation Module known as TC-PRISMA.
CCT stands for Continuous Cooling Transformation and is a calculation that maintains the same
cooling rate the entire time.
The system is a Ni-10Al-10Cr γ - γ’ alloy and it is calculated and plotted with superimposition of the
cooling rate values using the Precipitation Module (TC-PRISMA).

SETTING UP THE SYSTEM
1. Open Thermo-Calc in Graphical Mode.
2. Under Templates, click Precipitation Simulation.
3. All the nodes for a precipitation calculation are added to the Project window:
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4. In the Project window, click the System Definer 1 node.
5. Set the database Package to Demo: Nickel-based alloys (NIDEMO, MNIDEMO), which loads
both thermodynamic and kinetic demonstration nickel databases.
6. From the Periodic Table, select the elements as follows. Select Ni first so that it is the
dependant element.
a. Ni (nickel)
b. Al (aluminium) then
c. Cr (chromium).
7. From the Amount list (to the right of the Periodic Table), select Mole percent.
8. Enter 10 for Al and 10 for Cr, which automatically sets Ni to 80 mole percent.
9. Click the Phases and Phase Constitution tab.
10. Click to select both check boxes next to the disordered FCC phase, DIS_FCC_A1.

11.
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The system is now defined. Now set up the precipitation calculations.

SETTING UP THE PRECIPITATION CALCULATION
1. In the Project window, click the Precipitation Calculator 1 node.
2. Notice that the composition set in the System Definer auto-populated here.
3. Under Matrix Phase, from the Phase list select Dis_FCC_A1, which is the disordered FCC
phase.
4. Under Precipitate Phase from the Phase list select FCC_L12#2.
5. Change the Interfacial energy to User-defined then enter 0.023 in the field.
6. Under Calculation Type, click CCT Diagram, which stands for Continuous-CoolingTransformation and means that the same cooling rate is maintained throughout the
calculation.
7. In the fields set:
a. Min (minimum) Temperature to 500.
b. Max (maximum) Temperature to 1200.
c. Choose Kelvin as the temperature unit.
d. Enter several cooling rates for the calculation. The rates are separated by a space.
Enter these values as shown: .01 .1 1 10 100.
e. Keep the default Stop criteria of 1E-4 volume fraction of the γ’ phase.
8. The calculation is now set. Click Perform CCT Diagram Simulation at the bottom, center of
the Configuration window.
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INTERPRETING THE RESULTS OF THE PRECIPITATION CALCULATION
In this plot, the blue,
horizontal line shows the
time it takes for gamma
prime to transform at
each of the cooling rates
according to the stop
criteria, which we set as
1e-4 volume fraction.
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Precipitation Example P_07

In this plot, the blue line shows the time it takes for γ’ to transform at each of the cooling rates
according to the stop criteria, which is set as 1e-4 volume fraction. The cooling rates are represented
by the multi-coloured curved lines.
If you hover your mouse over the intersection of the blue line and any of the vertical lines, a yellow
box shows the approximate time it takes for γ’ to transform according to the stop criteria, which is a
volume fraction of 1e-4, followed by the approximate temperature. In the image above, you can see
a time of 0.54147 seconds and a temperature of 1147.60 Kelvin for the cooling rate of 100.0 K/s,
which is represented by the yellow line.

SHOWING THE RESULTS AS A TABLE
You can also view these results in the form of a table, which gives you more precise results.
1. In the Project window, right-click the Precipitation Calculator 1 node and select Create New
Successor>Table Renderer.
2. Right-click the Table Renderer 1 node and select Perform Now.

The table is shown in the Results window and shows the same information as in the plot - for each
cooling rate the temperature and the time it takes for γ’ to transform according to the stop criteria,
which is a volume fraction of 1e-4.
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P_08: Precipitation of Cu-Ti CU4TI with Assumptions
of Sphere and Needle Morphologies
In this isothermal calculation example, the precipitation of Cu4Ti phase in a Cu-Ti binary
alloy is calculated. To make a comparison, two separate simulations are performed, one
assuming spherical morphology without elastic strain energy, and the other assuming needle
morphology whose shape, determined by competition between interfacial energy and elastic
strain energy, is changed during the simulation. The transformation strain is obtained from
Borchers [1999]. The results are compared with experiment results from Kampmann et al.
[1987].
This example takes a few minutes to run.

Project File and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_08_Precipitation_Cu-Ti_CU4TI1_Sphere_Needle.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
To ensure that the settings are done on the correct Precipitation Calculators, the
Sphere and Needle nodes are renamed from Precipitation Calculator to match
their morphology. The morphology is set in the Precipitate Phase section when
you click Show details.
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System (System Definer)
Database package

Demo: Copper-based alloys (CUDEMO and MCUDEMO)

Elements

Cu, Ti

Sphere and Needle Conditions (Precipitation Calculator)
Composition

Cu-1.9Ti Mole percent

Matrix phase

FCC_L12

Precipitate phase

CU4TI1

Matrix Phase Data Parameters (Precipitation Calculator)
Mobility enhancement
prefactor (click Show details
to display this setting)

100

Precipitate Phase Data Parameters (Precipitation Calculator)
Nucleation sites

Bulk

Interfacial energy

The default

Morphology (click Show
details to display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the
default.
For the Needle node (renamed from Precipitation Calculator), Needle is
selected.
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For the Sphere node (renamed from Precipitation Calculator), keep the
default.
Transformation strain (click
Show details to display this
setting)

For the Needlenode (renamed from Precipitation Calculator), User
defined is selected. In this example, the following settings are defined:
l

ε11 and ε22 are set to 0.022

l

ε33 is set to 0.003

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

350° C

Simulation time

10,000 seconds

Datasets (Experimental File Reader)
Borchers Mean radius vs Time
and Borchers Number density
vs Time

Data sets included with this example and imported to two Experimental
File Readers. These data sets are used for the Mean Radius and Number
Density plots, respectively.

Plot Results
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Mean Aspect Ratio
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Number Density
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PSD and ASD

Mean Radius

References
[1987, Kampmann] R. Kampmann, H. Eckerlebe, R. Wagner, 1987. "Precipitation Kinetics in
Metastab le Solid Solutions - Theoretical Considerations and Application to Cu-Ti Alloys."
Mat. Res. Soc. Symp. Proc. 57: 525-542.
[1999, Borchers] C. Borchers, Catastrophic nucleation during decomposition of Cu-0.9at.%
Ti. Philos. Mag. A. 79, 537–547 (1999).
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P_09: Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
In this isothermal calculation example, the precipitation of Al3Sc phase from FCC_A1 matrix
phase in an Al-Sc binary alloy is simulated. To make a comparison, two separate calculations
are performed, one assuming spherical morphology without elastic strain energy, and the
other assuming cuboid morphology whose shape is determined by competition between
interfacial energy and elastic strain energy. The simulation results are compared with
experimental data collected from Marquis and Seidman [2001] and Novotny and Ardell
[2001]. In addition, mean cubic factor and cubic factor distribution are also plotted for
cuboid shape to illustrate the spherical-cuboidal transition during precipitation.

Project File, Step-By Step Instructions and Video tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_09_Precipitation_Al-Sc_AL3SC_Sphere_Cuboid.tcu
This example is available as a video tutorial on our website and YouTube
channel.
You can also use the step-by-step instructions included in a PDF to follow the
video or compare to the project file in Thermo-Calc.

Example Settings
To ensure that the settings are done on the correct Precipitation Calculators, the
Sphere and Cuboid nodes are renamed from Precipitation Calculator to match
their morphology. The morphology is set in the Precipitate Phase section when
you click Show details. See P_08 for an example of this.
System (System Definer)
Database package

Demo: Aluminum-based alloys (ALDEMO, MALDEMO)

Elements

Al, Sc

Sphere and Cuboid Conditions (Precipitation Calculator)
Composition

Al-0.18Sc Mole percent
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Matrix phase

FCC_A1

Precipitate phase

AL3SC

Matrix Phase Data Parameters (Precipitation Calculator)
For the Sphere node (renamed from Precipitation Calculator), the default,
Disregard is kept.
Elastic properties
(click Show details to
display this setting)

For the Cuboid node (renamed from Precipitation Calculator), choose Cubic. Then
enter the elastic constants accordingly. Default elastic constants are given based
on the major element of the alloy system. In this example that is
l

c11 is 108.2 GPa

l

c12 is 61.3 GPa

l

c44 is 28.5 GPa

Precipitate Phase Data Parameters (Precipitation Calculator)
Nucleation sites

Bulk

Interfacial energy

The default

Morphology (click
Show details to
display this setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default.

Transformation
strain (click Show
details to display this
setting)

For the Sphere node (renamed from Precipitation Calculator), keep the default.

For the Cuboid node (renamed from Precipitation Calculator), Cuboid is selected.

For the Cuboid node (renamed from Precipitation Calculator), Calculate from
molar volume is selected to obtain a purely dilatational strain.

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

350° C

Simulation time

1.0E9 seconds

Datasets (Experimental File Reader)
Dataset 1 and
Dataset 2

Data sets included with this example and imported to one Experimental File
Reader. It is used for the Mean Radius plot.

Plot Results
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Mean Radius
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Particle size distribution (PSD).
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Mean Radius and Cubic Factor

Particle size distribution (PSD) and cubic factor.

References
[2001, Marquis] E. A. Marquis, D. N. Seidman, Nanoscale structural evolution of Al3Sc
precipitates in Al(Sc) alloys. Acta Mater. 49, 1909–1919 (2001).
[2001, Novotny] G. M. Novotny, A. J. Ardell, Precipitation of Al3Sc in binary Al–Sc alloys.
Mater. Sci. Eng. A Struct. Mater. Prop. Microstruct. Process. 318, 144–154 (2001).
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Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
Precipitation Example P_09

Precipitation of Al-Sc AL3SC with Assumption of
Sphere and Cuboid Morphologies: Precipitation
Example P_09
HELPFUL INFORMATION
•
•
•

All users can run this calculation, even those who do not have a license for the Precipitation
Module (TC-PRISMA).
A companion video is available for this example , which can be watched here:
https://www.youtube.com/playlist?list=PLfv6McToaTGSpqvuLoY3b_UV-8xpgLUkJ
This calculation is based on Precipitation Module example P_09 – Precipitation_AlSc_AL3SC_Sphere_Cuboid, which is included in your installation. To run the example file, open
Thermo-Calc and select Help > Examples Files. Open the Precipitation Module (TC-PRISMA)
folder. Double-click the example file and click Perform at the bottom center of the Configuration
window in Thermo-Calc.

ABOUT THE EXAMPLE
This example shows you how to calculate the precipitation of Al3Sc phase from FCC_A1 matrix phase
in an Al-Sc binary alloy using the Precipitation Module (TC-PRISMA).
Two separate calculations are performed so you can make a comparison of the results, one assuming
spherical morphology without elastic strain energy, and the other assuming cuboid morphology
whose shape is determined by competition between interfacial energy and elastic strain energy.
In addition, mean cubic factor and cubic factor distribution are plotted for cuboid shape to illustrate
the spherical-cuboidal transition during precipitation.
If you run the example file included in your software, the simulation results are compared with
experimental data collected from Marquis and Seidman (2001) and Novotny and Ardell (2001).
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Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
Precipitation Example P_09

SETTING UP THE SYSTEM
1. Open Thermo-Calc in Graphical Mode.
2. Under Templates, click Precipitation Simulation.
3. All the nodes for a precipitation calculation are added to the Project window:

4. In the Project window, click the System Definer 1 node.
5. Set the database Package to Demo: Aluminium-based alloys (ALDEMO, MALDEMO), which
loads both thermodynamic and kinetic demonstration aluminium databases.
6. From the Periodic Table, select the elements as follows. Select Al first so that it is the
dependant element:
a. Al (aluminium)
b. Sc (scandium).
7. From the Amount list (to the right of the Periodic Table), select Mole percent.
8. Enter 0.18 for Sc. This automatically sets Al to 99.82.
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Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
Precipitation Example P_09

Our system is now defined. Now set up the precipitation calculations.

SETTING UP THE PRECIPITATION CALCULATIONS
There are two precipitation calculations in this example, one assuming spherical morphology without
elastic strain energy, and the other assuming cuboid morphology whose shape is determined by
competition between interfacial energy and elastic strain energy. The results are then compared for
both calculations.

Setting up the Precipitation Calculation with Spherical Morphology
1. In the Project window, right-click the Precipitation Calculator 1 node and select Rename.
Enter Sphere, then press Enter or click OK.

2. Notice that the composition set in the System Definer auto-populated on the Precipitation
Calculator.
3. Under Matrix Phase from the Phase list it defaults to FCC_A1.
4. Under Precipitate Phase from the Phase list select AL3SC.
5. Under Calculation Type, make sure Isothermal is selected, which means that the same
temperature is maintained throughout the calculation.
6. Enter
a. 350 as the Temperature and select Celsius.
b. 1.0E9 as the Simulation time and select Seconds.
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Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
Precipitation Example P_09

Our first calculation is set, so next configure the plot.

Configuring the Plot
1. In the Project window, right-click Plot Renderer 1 and select Rename. Name the plot Mean
radius then press Enter or click OK.
2. Under Y-axes change the units to Nanometer (nm).
3. From the Axis type list select Logarithmic 10.

The plot is now set, but before running the simulation you set up another calculation and link it to
the same Plot Renderer.
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Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
Precipitation Example P_09

Setting up the Precipitation Calculation with Cuboid Morphology
1. In the Project window, right-click the Sphere node and select Clone.
a. Right-click the Sphere 1 node and select Rename.
b. Name the node Cuboid and press Enter or click OK.
2. On the Configuration window to the right of Matrix Phase click Show Details.
3. From the Elastic Properties list select Cubic. Keep the suggested default values. Click Hide
details.

4. To the right of Precipitate Phase, click Show details.
5. From the Morphology list select Cuboid.
6. From the Transformation strain list select Calculate from molar volume.

The second calculation is now set up, so now link it to the Plot Renderer node.

Linking the Plot to the Calculation with Cuboid Morphology
1. In the Project window, right-click the Mean radius node and select Add Predecessor
>Cuboid.
2. Notice that in the Configuration window there are two tabs associated with this plot, one for
Sphere and one for Cuboid. The Sphere settings are already configured, so you just need to
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Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
Precipitation Example P_09
set up the Cuboid tab.

3.
4.
5.
6.

Click the Cuboid tab.
Under Y-axes change the units to Nanometer (nm).
From the Axis type list select Logarithmic 10.
The calculation is now ready to run. Right-click the Mean radius node and select Perform
Now or click Perform on the Configuration window.

INTERPRETING THE RESULTS OF THE PRECIPITATION CALCULATIONS
In this plot, the blue
line represents the
sphere calculation
and the red line
represents the cuboid
calculation. You can
see that, in this
instance, they are
almost identical.

In this plot, the blue line represents the sphere calculation and the red line represents the cuboid
calculation. You can see that, in this instance, these are almost identical.
By ‘radius for non-spherical particles’ it means the radius of equivalent spheres with the same
volume.
If you run the example file that is included in your software, the plot also contains an experimental
file, which you can see closely matches the calculations.
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Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
Precipitation Example P_09

PLOTTING ADDITIONAL VARIABLES
Now you use the same calculation to set up additional plots using the many available variables. The
examples below include two Y-axes each.

Plotting Mean Radius and Cuboid Factor
This plot has two Y-axes: Mean radius and Cuboid factor.
Right-click the Cuboid node and add a Plot Renderer.
Right-click the new node and rename it Mean radius and Cuboid factor.
Under Y-axes click the green plus sign to add another axis.
Keep Mean radius as the first axis variablebut change the units to Nanometers (nm) and set
the axis type to Logarithmic 10.
5. Set the second Axis variable to Mean cubic factor.
6. Click to clear the Automatic scaling check box. In the fields, enter the Limits from 1 to 1.41
and the step to 0.1.
7. The plot is now set. Click Perform.
1.
2.
3.
4.
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Interpreting the Results of Mean Radius and Cuboid Factor

In this plot, the blue
line represents the
evolution of the
average radius of the
cubic particles as a
function of time. The
red line shows the
average cubic factor
as a function of time.

The blue line represents the evolution of the average radius of the cubic particles as a function of
time. Again, for non-spherical precipitates this means the radius of equivalent spheres with the same
volume.
The red line shows the average cubic factor as a function of time. A value of one represents a
spherical shape. A square root of two represents a cubic shape.
The evolution of the shape when the particles grows is determined by competition between
interfacial energy and elastic strain energy. In general, the shape is close to spherical at small particle
sizes because the interfacial energy term dominates.
At large sizes the elastic energy dominates and it is therefore more favourable with a non-spherical
shape. You can see that the particles get a more cubic form at later times when they grow to larger
sizes.

Plotting Particle Size and Cubic Factor Distribution
This final plot shows the particle size distribution (PSD) and cubic factor distribution at the end of the
simulation.
This plot also has two Y-axes, so you can clone the previous plot.
1. Right-click the Mean radius and Cuboid factor node and select Clone.
2. Right-click the new node and rename it PSD and Cuboid factor.
3. Under the Y-axes
a. Select Size distribution as the first Axis variable.
b. Change the Axis type to Linear.
4. Set the second Y-axis to Cubic factor distribution and enter a Time of 1e9 Seconds.
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5. Keep the Automatic Scaling check box cleared. Enter the Limits from 1 to 1.45 and the step
to 0.1.
6. Under Size X-axis, change the unit to Nanometer (nm).
7. Click Perform at the bottom center of the Configuration window.

Interpreting the Results of Particle Size Distribution and Cuboid Factor

In this plot, the blue
curve shows the
particle size
distribution and the
red line shows the
cubic factor
distribution.
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Precipitation of Al-Sc AL3SC with Assumption
of Sphere and Cuboid Morphologies
Precipitation Example P_09
The blue curve, which shows the particle size distribution, is close to the regular LSW size distribution
that is expected for spherical particles.
The cubic factor distribution shows that the smallest particles are closer to spherical and that the
larger ones get more and more cubic.

References
1. Marquis, E.A, and D.N Seidman. 2001. “Nanoscale Structural Evolution of Al3Sc Precipitates
in Al(Sc) Alloys.” Acta Materialia 49 (11): 1909–19.
2. Novotny, Gabriel M., and Alan J. Ardell. 2001. “Precipitation of Al3Sc in Binary Al–Sc Alloys.”
Materials Science & Engineering, A: Structural Materials: Properties, Microstructure and
Processing 318 (1–2): 144–54.
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P_10: Initial Particle Size Distribution of Fe-Cr-C
This example demonstrates the effect of initial particle size distribution of the precipitate
phases on the overall precipitation kinetics. It uses two Precipitation Calculators to simulate
and compare carbide precipitations from a ferritic BCC_A2 matrix in a Fe-0.1C-12Cr alloy.
Three carbides, CEMENTITE, M23C6 and M7C3, are included in the calculations for
competitive precipitations, and the precipitation kinetics are compared with or without
initial particle size distribution.
The example illustrates the use of the particle size distribution setting. You can import data
from a spreadsheet or text file (.xls, .xlsx, .csv or .txt formats are acceptable). The
Preexisting Particle Size Distribution window shown below, provides a graphical
representation of the radius versus corresponding frequencies.

The Preexisting Particle Size Distribution (PSD) settings window for example P_10.

Project File and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_10_Precipitation_Initial_PSD_FeCrC.tcu
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Also see our website and YouTube channel for other examples of the
Precipitation Module.
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Example Settings
System (System Definer)
Database package

Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements

Fe, C, Cr

Conditions (Precipitation Calculator)
Composition

Matrix phase

Precipitate phases

Fe-0.1C-12Cr Mass percent
BCC_A2
All other defaults are kept.
CEMENTITE, M23C6 and M7C3

Precipitate Phase Data Parameters (Precipitation Calculator)
Nucleation sites

Grain boundaries (all calculations): Calculated from the matrix settings with a
wetting angle of 90°
User-defined function f(r,T) (all calculations):

Interfacial energy

l
l
l

Preexisting size
distribution (click Show
details to display this
setting)

CEMENTITE: 0.167 J/m2
M23C6 0.252 J/m2
M7C3 0.282 J/m2

For the Precipitation Calculator including particle size distribution, and for all
precipitate phases, this check box is selected.
For each precipitate phase (CEMENTITE, M23C6 and M7C3), click Edit particle
size distribution to make changes to the parameters. A window opens with a
graphical representation of the radius vs number density.

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

1053 K

Simulation time

400 000 seconds

Plot Results
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Volume fraction with initial particle size distribution (PSD).

Volume fraction with no initial particle size distribution (PSD).
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P_11: Interfacial Energy Function
In some cases, interfacial energy may be a function of temperature and/or particle radius.
This example uses four Precipitation Calculators at four temperature points in 30 K
increments: 673 K, 703 K, 733 K, and 763 K. It is an isothermal calculation to examine the
mean radius of an Al-0.12Sc system. It uses an FCC_A1 matrix phase and AL3SC precipitate
phase with bulk nucleation sites and user-defined interfacial energy function. The user
defined interfacial energy function uses an error function to set a smooth transition of the
interfacial energy from 0.065 J/m2 to 0.085 J/m2 for particle radii below and above 1e-8m
and 5e-8m, respectively.
A dataset based on Iwamura and Miura (1. ) data is compared with the calculated results.

Project File and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_11_Interfacial_energy_function.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
System (System Definer)
Database package

Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

Elements

Al, Sc

Conditions (Precipitation Calculator)
Composition

Matrix phase

Al-0.12Sc Mole percent
FCC_A1
All other defaults are kept.
AL3SC

Precipitate phase

Nucleation sites (all calculations): Bulk (6.025E28 m-3)

1. Iwamura, S, and Y Miura. 2004. “Loss in Coherency and Coarsening Behavior of Al3Sc Precipitates.” Acta Materialia 52

(3): 591–600.
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Interfacial energy (all calculations): User-defined function f(r,T): 0.075+0.011*erf
((r-3e-8)/1e-8 J/m2)

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal (all calculations)

Temperature

Four temperature points in 30 K increments: 673 K, 703 K, 733 K, and 763 K.

Simulation time

1 000 000 seconds (all calculations)

Datasets (Experimental File Reader)
Wamura 2004
(Dataset 1)

Data set included with this example and imported to one Experimental File
Reader.

Plot Results

The results of an isothermal calculation to examine the mean radius of an Al-0.12Sc system.
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P_12: Comparing Growth Rate Models for an Al-Zr
System
This example compares the Simplified, General and Advanced growth rate models for an
Al-Zr system. The resulting plot compares the mean radius of the spheres for each AL3ZR_
D023 precipitate phase calculated for each type of growth rate model.
The example takes several minutes to run.
All models treat a spherical particle (precipitate) of stoichiometric composition or with
negligible atomic diffusivity. Local equilibrium at the precipitate-matrix interface is
assumed.
When you use the Advanced model, the velocity of a moving phase interface and the
operating tie-line are solved together from flux-balance equations. This model can treat
both high supersaturation and cross diffusion rigorously. It can also capture the transition
between NPLE (non-partitioning local equilibrium) and PLE (partitioning local equilibrium)
without any ad hoc treatment.
The Simplified model is based on the quasi-steady state diffusion approximation, and
estimates solute partitioning with matrix composition and nuclei composition instead of
time-consuming stepwise tie-line calculations. It also neglects cross diffusion for simplicity.
The General model can be considered the same theoretical approximation as, but an
improvement over, the Simplified model, with cross-diffusion terms taken into account, as
well as adjustment of Gibbs-Thomson effect and effective diffusivity implemented.
A dataset based on Knipling et al. [2008] data is compared with the calculated results.

Project File and Video Tutorial Information
l

Folder: Precipitation Module - TC-PRISMA

l

File name: P_12_Precipitation_Al-Zr_GrowthRateModel_comparison.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
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System (System Definer)
Database
package

Demo: Aluminum-based Alloys (ALDEMO, MALDEMO)

Elements

Al, Zr

Conditions (Precipitation Calculator)
Composition

Matrix phase

Precipitate
phase

Al-0.2Zr Mole percent
FCC_A1
All other defaults are kept.
AL3ZR_D023
Click Show details to select the Growth rate model (Simplified, Advanced and
General). All other defaults are kept.

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

425 Celsius

Simulation time

400 hours

Datasets (Experimental File Reader)
2008 Knipling

Data set included with this example and imported to one Experimental File Reader.

Plot Results
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Result comparing the mean radius of the spheres for each AL3ZR_D023 precipitate phase
calculated for each type of growth rate model.

Reference
[2008, Knipling] K. E. Knipling, D. C. Dunand, D. N. Seidman, Precipitation evolution in Al–Zr
and Al–Zr–Ti alloys during isothermal aging at 375–425°C. Acta Mater. 56, 114–127
(2008).
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P_13: Paraequilibrium Precipitation of Cementite FeC-Cr
In this example, the precipitation of cementite during tempering of a Fe-Cr-C steel is
simulated considering two interface conditions: one is the usual ortho-equilibrium condition;
the other is the para-equilibrium condition. The simulation results are compared with the
experimental data from Sakuma et al. [1980].
The example may take over two hours to run.
This example demonstrates that the early stage of the cementite precipitation can only be
accounted for by a simulation applying the para-equilibrium condition, under which the
precipitation kinetics are controlled by the diffusion of C. The comparison also shows a later
stage gradual transition from the para-equilibrium condition to the ortho-equilibrium
condition, and if the tempering time is long enough the diffusion of Cr has a dominating
effect on the coarsening of cementite.

Project File and Video Tutorial Information
l
l

Folder: Precipitation Module - TC-PRISMA
File name: P_13_Precipitation_Fe-C-Cr_Paraequilibrium_Precipitation_of_
Cementite.tcu
Also see our website and YouTube channel for other examples of the
Precipitation Module.

Example Settings
System (System Definer)
Database package

Demo: Steels and Fe-alloys (FEDEMO, MFEDEMO)

Elements

Fe, Cr, C

Conditions (Precipitation Calculator)
Composition

Fe-0.95Cr-1.065C Mass percent

Matrix phase

BCC_A2
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All other defaults are kept.
CEMENTITE
Precipitate phase

Click Show details to select the Growth rate model (Simplified and Para-eq). All
other defaults are kept.

Calculation Type (Precipitation Calculator)
Calculation type

Isothermal

Temperature

773 Kelvin

Simulation time

20 hours for the paraequilibrium model and 600 hours for the simplified model.

Datasets (Experimental File Reader)
1980 Sakuma

Data set included with this example and imported to one Experimental File Reader.

Plot Results
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Comparing results from Para-eq (PE) and Simplified (OE) growth models.

Reference
[1980, Sakuma] T. Sakuma, N. Watanabe, T. Nishizawa, The Effect of Alloying Element on the
Coarsening Behavior of Cementite Particles in Ferrite. Trans. Japan Inst. Met. 21, 159–
168 (1980).
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Working in Console Mode
In this section:
The Console Mode Layout

3

Console Window

5

Console Mode Results Window

6

Event Log Window

7

Keyboard Shortcuts to Navigate Between Tabs

8
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The Console Mode Layout
By default the first time you launch Thermo-Calc it opens in Graphical Mode. After this, the
mode defaults to the most recent one. You can switch back and forth between modes. To
open the Console Mode interface, click Switch to Console Mode on the toolbar.
Keyboard Shortcuts to Navigate Between Tabs

The Console Mode User Interface

The currently selected window is called the active window. This has a darker title bar than
the other windows. The windows are:
1. Console, with a Console 1 tab.
2. Console Results, with a Results Console 1 tab as well as a sub-tab (Plot 1), which is
what is displayed in the window in the figure.
3. Event Log, which is the active window in this example.

Console Tabs
By default, the tabs are side-by-side:
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You can toggle to view the tabs top-to-bottom/stacked (click the
by-side (click the
button) or the button.

button) and back to side-

How to Open Console Windows
Open a specific window from the Window main menu, or select Reset Windows to return
to the default window layout.
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Console Window
By default the Console window is on the left-hand side of the console. This is where you
enter commands. The window can have several Console tabs.
To open and close Console tabs:
l

l

l

l

To open (or add), click the button, press <Ctrl+T> when the Console window is
active, or right-click a tab header and select New Console.
To close, click the button, press <Ctrl+W> or <Ctrl+F4>, or right-click the tab
header and select Close.
To close all tabs except one, right-click the header of the tab you want to keep and
select Close Other.
To close all tabs and open a new one, right-click the header of any tab and select
Close All.

You can change the tab name, font and colors for an individual Console tab by right-clicking
its header and selecting Properties.
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Console Mode Results Window
By default, the Console Results window is on the right-hand side of the screen. This is where
plotted diagrams display. Each Console has its own Results tab in the Results window. All the
plots and tables generated are presented in the Results tab.
l
l

To open new Plot tabs press <Ctrl+Shift+T> or click the add

button.

To open a new Plot tab for the currently active Console tab, press <Ctrl+Shift+T>. To
close the Plot tab, press <Ctrl+Shift+W> or <Ctrl+Shift+F4>.
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Event Log Window
By default the Event Log window is collapsed (closed). It includes important information
about the commands that run and are completed, including error messages. Click once to
toggle it open and closed.
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Keyboard Shortcuts to Navigate Between Tabs
Use keyboard shortcuts to move between the tabs available in the Console and Results
windows.

Windows
l

l

l

Press CTRL + TAB to move forward sequentially through each open tab. When you
are focused on the Console window, you move forward simultaneously through the
Console Results tabs, e.g. If you are on Console 1 and press CTRL + TAB, you move
forward to Console 2 and Results Console 2 and so forth.

Press CTRL + SHIFT + TAB to move back through the open tabs. This is useful if you
have multiple tabs open, otherwise you can use the CTRL + TAB to cycle through the
windows.
Press CTRL + [tab number 1 to 9] to move directly to the numbered tab. For example,
if you are focused on Console 1 and want to move to Console 3, press CTRL+3 and the
focus jumps to that tab.
The tab number corresponds to the order of the tabs, not necessarily the
name. That is, if Console 4 is first, then it is what is highlighted when
CTRL + 1 is used.
For EXAMPLE, press CTRL + 3 on the keyboard to move focus from Console 1 to
Console 3.

When you are focused on the Console Results window and use any of the
shortcuts this only moves you through the open tabs on this window.

Linux and macOS
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The same Windows keyboard shortcuts are used but must be pressed twice to move forward
and backward.
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Modules and Commands
In this section:
Console Mode Workflow

11

Defining a System in Console Mode

13

Console Mode Modules

15

Moving Between Modules and Submodules

20

Entering Command Names or Abbreviations

21

Using the Command Line Prompt

23

Main Menu Commands

24

Command History

25

Wild Card Characters

26

Thermo-Calc User Guide: Console Mode ǀ 10 of 643

Thermo-Calc Documentation Set

Console Mode Workflow
Working with Thermo-Calc involves moving between different modules. The workflow
differs depending on the type of calculation:
l

l

l

If you want to perform a calculation using the POLY module, you typically first
retrieve thermodynamic data in the DATA module, perform the calculation in POLY,
and visualize the results in the POST module. It is possible to define a system directly
in POLY using the DEFINE_MATERIAL and DEFINE_DIAGRAM commands.
If you want to calculate and plot a diagram using a response-driven module, such as
POTENTIAL or SCHEIL, then you can go directly to that module. Response-driven
modules prompt you to go through the steps to do the calculation and the required
post-processing. These modules include BIN, TERN, POTENTIAL, POURBAIX, and
SCHEIL. You typically end up in the POST module after having used a response-driven
module. In the POST module you can modify the plots and save the diagram.
If you want to tabulate a chemical substance, phase, or reaction, go directly to the
TAB module.

The basic workflow is:
1. You are in the SYS module when you start Thermo-Calc in Console Mode.
2. In the DATA module define the system. Before performing a calculation, you must
define the system and retrieve thermodynamic data. The data is retrieved from a
database file (*.TDB or *.TDC).
3. The data needed to describe a system is then sent to the GIBBS module. This data is
accessed by the POLY module when you instruct it to perform calculations.
4. In the POLY module, perform the calculations.
l In POLY, the conditions are set for an equilibrium calculation (temperature,
pressure, system composition, etc.), then an equilibrium calculation is done.
l

l

If you want to make a property or phase diagram, you set the conditions for a
stepping or mapping operation and perform that operation.
This generates data that can be used to plot a property diagram (if a stepping
operation is performed) or a phase diagram (if a mapping operation is
performed).
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5. In the POST module plot and visualize your data.
l If a stepping or mapping operation is performed, then you can go to the POST
module and plot a property or phase diagram.
l

l

The diagram can be plotted quickly using default settings, but you can also
modify which variables to plot of the diagram axes and change the
appearance of the diagram.
You can save the diagram either as a plain text file with data about all the
coordinates or as an image file.
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Defining a System in Console Mode
Defining a system means to select the chemical components and to retrieve thermodynamic
data about those components from an appropriate database in order to do the calculations.
You use database(s) with thermodynamic data and then define what system elements as
components. Once the system is defined, you retrieve the system’s thermodynamic data
from the database(s).
l

l

If you use a response-driven module to perform your calculation, such as BIN or
POURBAIX, then the module prompts you to select database(s) and define the
system.
When doing calculations in the POLY module, you typically have to manually select
databases and define the system in the DATA module. However, it is also possible to
define the system directly in POLY using the DEFINE_MATERIAL and DEFINE_DIAGRAM
commands.
Database (TDB) Module Commands

How to Define a System in Console Mode
1. Go to the DATA (TDB) module. At the SYS prompt, use GOTO_MODULE and enter Data.
2. Change the default database unless you directly specify the name of the database as
a parameter to the command. Type SWITCH_DATABASE and follow the prompts.
The second part of the command prompt indicates the current default database. For
example, if the prompt is TDB_TCFE10, then the current database is TCFE10.
3. Use DEFINE_ELEMENTS followed by a list of the elements that you want in your system.
(To list the elements that are available in your current database, use LIST_DATABASE
and choose Elements). For example, if you want to have Fe and C in your system,
type:
DEFINE_ELEMENTS Fe C

4. Use REJECT and choose Phases if you want to avoid retrieving any phases from the
database. (To list the phases that are available in your current database, use LIST_
DATABASE and choose Phases. To list the phases that can form in the defined system,
use LIST_SYSTEM and choose Constituent.) For example, if you do not want the
graphite phase to be retrieved, you type:
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REJECT PHASES GRAPHITE

If the number of phases to include is much lower than the total number of phases,
then it can be convenient to first Reject Phases * and then restore the phases to
include using Restore Phases.
5. Use GET_DATA to search the database and send the thermodynamic data about your
system to the GIBBS workspace.
At this point you can proceed to the POLY module (with GOTO_MODULE POLY).
However, you may want to add elements, phases and species to the GIBBS workspace
from other databases. If so, then proceed to the next step.
6. Use APPEND_DATABASE to select the (additional) database from which you want to
retrieve data. This command works exactly in the same way as the SWITCH_DATABASE
command, with the exception that it does not reinitialize the DATA module and the
GIBBS workspace, but instead appends or replaces the data that has already been
retrieved with new data from the additional database.
7. Define your elements and specify whether to reject and restore any phases. Do this
in exactly the same way when using the SWITCH_DATABASE command (see steps 2
and 3).
8. Use GET_DATA to search the database and add the thermodynamic data to the data
that already exists in the GIBBS workspace.
9. Use APPEND_DATABASE again if you want to add data from yet another database.
When you have retrieved all the data you need, you can proceed to the POLY
module.
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Console Mode Modules
Graphical Mode Activities vs Console Mode Modules
Below are each of the available modules you access in Console Mode. Most of the modules
have commands, some are the same no matter what module you are in (e.g. general
commands like BACK . GO TO MODULE, EXIT, HELP and so forth). Other commands have
different prompts based on the module you are in how you define the system and so forth.

Most modules have several commands available. The exceptions are the
BINARY, TERNARY, SCHEIL, POURBAIX and POTENTIAL modules which do not
have any additional commands once you access the modules. These are
response-driven modules that prompt you with a series of questions and then
build the diagram automatically based on your responses.

System Utilities (SYS)
This is the module where you start. It also has several commands. Throughout the other
modules there are some general commands, both of which are listed together.
System Utilities (SYS) Commands

Gibbs Energy System (GES)
The Gibbs Energy System (GES) module is an important Thermo-Calc Console Mode module
and consists of a comprehensive subroutine package for various thermochemical
calculations. The module is interactively connected with all basic and advanced modules in
Thermo-Calc and the add-on Diffusion Module (DICTRA). Most users will not directly use the
GES module and commands unless you perform assessments.
The GES module is in essence the Thermo-Calc calculation engine, sometimes
referred to as the calculation core. When working in Graphical Mode you are
using the GES calculation engine behind the scenes, whereas in Console Mode,
and if you are performing assessments, you are directly interacting with the
module. This is also applicable if you are working with any of the software
development kits (SDKs).
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About the Gibbs Energy System (GES) Module
Gibbs Energy System (GES) Commands

POLY3 (POLY) (Equilibrium)
With the equilibrium calculation module, POLY3, it is possible to calculate many different
kinds of equilibria and diagrams, in particular multicomponent phase diagrams.
The Equilibrium Calculation Module (POLY3)
POLY Module Commands

Database (TDB)
The Database module (full name is Database Retrieval) is where you select and retrieve
various types of thermodynamic and kinetic information from the selected databases you
are going to use for your system. Once you enter the module the short name is TDB.
Database (TDB) Module Commands
Defining a System in Console Mode
Also see the Database Manager User Guide and the available information for the
specific databases.

POST - A POLY3 Submodule
The POST module (post-processor) is a submodule to the POLY module and has its own set of
commands. The TAB, BIN, TERN, POT, SCHEIL and POURBAIX modules use the POST module
features as part of the automatic generation of the plots.
Using the POST Module
POST Module Commands

Scheil (SCHEIL) Simulations
The variants of the Scheil-Gulliver solidification simulation (classic Scheil simulation, Scheil
with a fast diffuser element, and Scheil with back diffusion) are set up in either the SCHEIL
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module in Console Mode or the Scheil Calculator in Graphical Mode.
The Scheil with back diffusion feature is only available for systems with diffusion
data, i.e. it requires the use of a mobility database.
The Scheil calculation allows the calculation of:
l

The solidification range of an alloy.

l

Depression of the solidus temperature due to segregation.

l

Composition of the last liquid to disappear in segregation pockets.

l

Phases formed on final solidification in segregation pockets.

l

The composition gradient in the primary solid phase(s) (segregation profile).
About the Scheil-Gulliver Solidification Simulations
SCHEIL Module Commands

Pourbaix Diagram (POURBAIX)
The POURBAIX module lets you construct Pourbaix diagrams and other types of property
diagrams for heterogeneous interaction systems with aqueous solution phases. Once you
have calculated the Pourbaix diagram, you can also use the saved results of the calculation
(the POLY3-file), and make a property diagram based on stepping calculation. You can also
plot additional diagrams based on the results of the same calculation, but with different axis
variables than Ph and Eh.
About Aqueous Solutions and the Pourbaix Diagram

Potential Diagram (POT)
The POTENTIAL_DIAGRAM module (short name, the POTENTIAL module) is a potential phase
diagram calculation module. A potential diagram uses the activities of two major species in
the gaseous mixture phase as mapping variables.
About Potential Diagrams

Binary Diagram (BIN)
The BINARY_DIAGRAM module (short name, the BIN module) enables you to quickly
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calculate a simple binary phase diagram. Binary phase diagrams are by far the most
common found in the literature and calculated by computers. However, most real systems
have more than two components and thus binary diagrams are more a kind of exercise in
order to calculate more realistic phase diagrams.
About Binary Phase Diagrams

Ternary Diagram (TERN)
The TERNARY_DIAGRAM module (short name, the TERN module) enables you to quickly
calculate a simple ternary phase diagram. There are many types of ternary phase diagrams
but perhaps the most common is the isothermal section. In this case, the temperature is
constant, which means that the tie-lines are in the plane of the calculation.
About Ternary Phase Diagrams

PARROT (Optimization)
The PARROT module makes use of the GES module to handle the models of the various
phases that might form in a multicomponent system, as well as of the POLY module to store
and calculate complex heterogeneous equilibria.
PARROT Module Commands
Also see the Data Optimization User Guide

Tabulation Reaction (TAB)
The TABULATION_REACTION (TAB) module can be used to tabulate thermodynamic
functions of any type of substance, stoichiometric phase or solution phase, or reaction. The
module can tabulate thermodynamic functions of pure stoichiometric phases or solution
phases at fixed composition, as well as various kinds of partial derivatives for a pure
stoichiometric phase or solution phase at a given composition.
About the Tabulation Reaction Module
Tabulation Reaction (TAB) Commands

Reactor Simulator (REACTOR)
Simulate chemical reaction processes in several feed-forward steady-state stages or in
several dynamic stages.
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REACTOR (REACTOR_SIMULATOR) Commands

DICTRA Monitor (DICTRA)
DICTRA Monitor (DICTRA) and DIC Parrot (optimization for DICTRA): These are available
with the add-on Diffusion Module.
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Moving Between Modules and Submodules
To go to a specific module, you typically use GOTO_MODULE (or just GOTO) followed by the
name of the module. For example, to go to the DATA module, type GOTO DATA.
The exceptions are the submodules POST and ED-EXP:
l

l

To go to the POST module, you must enter the POST command from within the POLY
module or DICTRA module (if you have the add-on license).
To go to the Edit Experiments module you must enter the ED-EXP command from
within the PARROT module.

To go back to the previous module type Back. For example, if you are in the DATA module
and entered it from the SYS module, when you type Back, you return to the SYS prompt. This
command is also available to exit from the submodules POST and ED-EXP.
Without a valid Thermo-Calc license, you cannot leave the SYS module. To enter
the DICTRA and DIC_PARROT modules, you also need a valid Diffusion Module
(DICTRA) license key.
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Entering Command Names or Abbreviations
The name of a command typically consists of terms linked with underscores, for example,
LIST_EQUILIBRIUM. Note the following:
l

UPPER or lower case letters are OK.

l

Hyphens (-) instead of underscores (_) are OK, e.g. LIST-EQUILIBRIUM.

l

l

You can abbreviate commands as long as it is unambiguous, e.g. when more than
one command begins with LIST_, you need to type the next letter or word to
distinguish between the commands.
Each word can be abbreviated e.g., L_E for LIST_EQUILIBRIUM.

Examples
Examples of how to abbreviate commands at the command line prompt in Console Mode.
Command Name

Abbreviation

CALCULATE_EQUILIBRIUM

C-E

CALCULATE_ALL_EQUILIBRIA

C-A

LIST_EQUILIBRIUM

L-E

LIST_INITIAL_EQUILBRIUM

LI-I-E

LOAD_INITIAL_EQUILBRIUM

LO-I-E

LIST_PHASE_DATA CBCC

L-P-D CBC

LIST_PHASE_DATA CEMENTITE

L-P-D CEM

SET_ALL_START_VALUES

S-A-SS-AL

SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025

S-A-V 1 X(F,FE) 0 .89 .025

SET_START_CONSTITUENT

S-S-C

SET_START_VALUE

S-S-V
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Command Name

Abbreviation

SET_AXIS_PLOT_STATUS

S-A-P

SET_AXIS_TEXT_STATUS

S-A-T-SS-A-TE

SET_AXIS_TYPE

S-A-TY

SET_OPTIMIZING_CONDITION

S-O-C

SET_OPTIMIZING_VARIABLE

S-O-V

SET_OUTPUT_LEVEL

S-O-LS-OU
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Using the Command Line Prompt
The command line prompt in the Console window tells you which module you are currently
in. When Thermo-Calc is first opened in Console Mode, you are in the SYS module, which is
indicated with the command line prompt SYS.
To use Console Mode, you type in commands at the command line prompt. The available
commands depend on which module you are in. You can list the commands by typing ? at
the prompt and then press <Enter>.
l

Moving Between Modules and Submodules

l

Entering Command Names or Abbreviations

l

Specifying Parameters

l

Wild Card Characters

l

Command History

l

Keyboard Shortcuts to Navigate Between Tabs

l

Working with the Console Mode Output
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Main Menu Commands
In Console Mode you use commands to access these menu options. If there is an
equivalent command, it is listed below.
The File menu and toolbar are reserved for Graphical Mode. The Tools,
Window and Help menus are described in Menu, Toolbar and Keyboard
Shortcuts.

How to Open Files
l

In the SYS module: MACRO_FILE_OPEN

l

In the SYS module: OPEN_FILE
Opening Console Mode Macro Files

Drag and drop files into the Console window to open or run a macro, for
example. File types that can be opened this way are macro files (*.TCM and
*.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5,*.PAR,
and *.DIC). Note that *.DCM and *.DIC file extensions are applicable to the
Diffusion Module (DICTRA).

Save (Workspace)
This command depends on the module you are in. Type ? at the prompt to look for a
command such as SAVE_GES_WORKSPACE (GIBBS module).

Exit
In any module: EXIT

Close
In the SYS module: CLOSE_FILE

Display License Info
In the SYS module: DISPLAY_LICENSE_INFO
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Command History
l

l

l

l

To scroll through the last twenty commands used, type two exclamation marks (!!)
and press <Enter>.
To repeat the last n commands, type ! followed by the number of previous
commands to be executed again.
To scroll through previous performed commands, use the Up (↑) or Down arrow (↓)
keys.
To read more information about the command history functionality in Thermo-Calc,
type ! ? at the command line prompt.
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Wild Card Characters
You can sometimes use the asterisk (*) as a wild card character to, for example, refer to all
components, phases, or species, when showing calculated properties in the POLY module, or
when you set axis variables for plotting diagrams in the POST module.
When showing calculated properties in the POLY module, you can also use the dollar sign ($)
to refer to all stable phases.

For activity and/or chemical potential properties, the *and $ normally do not
work properly as wild card characters.

Examples
These are examples of the wild card characters you can use to search commands at the
command line prompt.
Command

Action

SHOW_VALUE B(*)

Lists mass (gram) of all components in the system.

SET_AXIS_VAR Y B(*) *

Sets mass (gram) of all components in the system as Y-axis variable.

SHOW_VALUE MUR(*)

Lists chemical potentials of all components in the system.

SET_AXIS_VAR Y ACR(*) *

Sets activities of all components in the system as Y-axis variable.

SHOW_VALUE HM(*).T

Lists heat capacities of all phases.

SET_AXIS_VAR Y GM(*) *

Sets molar Gibbs free energies of all phases as Y-axis variable.

SHOW_VALUE TC($)

Lists curie temperature of all stable phases.

SHOW_VALUE W(*,*)

Lists mass fractions of all components in all phases.

SHOW_VALUE W($,*)

Lists mass fractions of all components in all stable phases.
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Command

Action

SHOW_VALUE W(FCC,*)

Lists mass fractions of all components in the FCC phase.

SHOW_VALUE W(*,FE)

Lists mass fractions of the Fe component in all phases.

SHOW_VALUE W($,FE)

Lists mass fractions of the Fe component in all stable phases.

SHOW_VALUE Y(*,*)

Lists site fractions of all species in all sublattices of all phases.

SHOW_VALUE Y($,*)

Lists site fractions of all species in all sublattices of all stable phases.

SHOW_VALUE Y(*,*)

Lists site fractions of all species in all sublattices of all phases.
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File Types
In this section:
Working with the Console Mode File Types

29

Opening Console Mode Macro Files

30

Log Files

34

Macro Files

35

Workspace Files

38

Editing the Default Console Directory

41

Experimental Data Files (*.POP, *.DOP)

44
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Working with the Console Mode File Types
For DICTRA Console Mode see File Formats in the Diffusion Module
(DICTRA) User Guide
In Console Mode, Thermo-Calc uses different types of files, including:
l

l

l

Macro Files and Log Files both with the file extension *.TCM. Log files are created
using the SET_LOG_FILE command.
Workspace Files in POLY (*.POLY3), GIBBS module (*.GES5), and the PARROT module
(*.PAR). (For the GIBBS module, this cannot currently be done with GES6).
Experimental Data Files (*.POP, *.DOP) are a type of workspace file available with
the PARROT module and have the file extension of *.POP. In the Diffusion Module
(DICTRA), you work with .DOP files instead of .POP. These .POP and .DOP files are
referred to as experimental data files.
Another type of experimental data file with the *.EXP file extension are also
generated when working with DATAPLOT. See About the DATAPLOT Graphical
Language.
A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.

Drag and drop files into the Console window to open or run a macro, for
example. File types that can be opened this way are macro files (*.TCM and
*.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5,*.PAR,
and *.DIC). Note that *.DCM and *.DIC file extensions are applicable to the
Diffusion Module (DICTRA).
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Opening Console Mode Macro Files
The macro files (with the extension *.TCM) include comments, which you can
either run in Thermo-Calc or open and read in a text editor.
You can open the macro files (*.TCM or *.DCM files) in different ways.
l

From the main menu,

l

Using a command,

l

By dragging and dropping the file into the Console window, or

l

l

Navigate to the file location on your computer and double-click to open it. If you
already have Thermo-Calc open, this opens a new instance of the software.
You can also read the commands listed in the macro file using a text editor.

If you only open and read the macro file in a text editor, you do not see the
output that Thermo-Calc gives in response to the commands stored in the
macro file.

Opening a Macro from the Main Menu
To open an example macro file for Thermo-Calc:
1. Open Thermo-Calc.
2. Confirm you are in Console Mode. If not, click the Switch to Console Mode button.
3. From the main menu, select File → or Help → Examples Files. The Console Mode
folder opens.
4. Open the Thermo-Calc folder to see the available examples contained in separate
folders.
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For the Diffusion Module (DICTRA) examples (*.DCM macro files), open the
Diffusion Module - DICTRA folder.
5. In the folder, double-click the *.TCM file or click Open.
6. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the
macro and produce a plot in the Console Results window.

Opening a Macro Using a Command
At the SYS prompt, type MACRO_FILE_OPEN and press <Enter>. In the file dialogue window
that opens, navigate to and select the macro file to open.

Drag and Drop a Macro File into the Console Window
For example, on your computer, navigate to the examples folder. Drag the file from its
location into the Thermo-Calc Console window. When you release (drop) the file, the macro
starts running. Follow the prompts in the Console window i.e. keep pressing <Enter> to run
the macro and produce a plot in the Console Results window.
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Drag and drop files into the Console window to open or run a macro, for
example. File types that can be opened this way are macro files (*.TCM and
*.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5,*.PAR,
and *.DIC). Note that *.DCM and *.DIC file extensions are applicable to the
Diffusion Module (DICTRA).
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Log Files
Log files with the file extension *.TCM are plain text files used to save a sequence of
commands. Log files can be edited in a text editor.
l

l

To start saving your input into such a file, use SET_LOG_FILE in the SYS module,
followed by the name of the file that you want to save your command sequence to.
If you want to save the output in the log file as well, use SET_ECHO before the SET_
LOG_FILE command. Doing this is useful if you want use the log file later as a macro
file.
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Macro Files
Macro files (with the file extension of either *.TCM or *.LOG) are plain text files used to save
a sequence of commands that can be loaded and executed. Macro files can be edited in a
text editor. When creating a command sequence, you add comments to the file by starting a
line with @@.
Macro files include comments, which you can either run in Thermo-Calc or open and read in
a text editor.

If you only open and read the macro file in a text editor, you do not see the
output that Thermo-Calc gives in response to the commands stored in the
macro file. It is recommended you run the macro to view all the details.

How to Open a Console Mode Example Macro File
To open an example macro file for Thermo-Calc:
1. Open Thermo-Calc.
2. Confirm you are in Console Mode. If not, click the Switch to Console Mode button.
3. From the main menu, select File → or Help → Examples Files. The Console Mode
folder opens.
4. Open the Thermo-Calc folder to see the available examples contained in separate
folders.

For the Diffusion Module (DICTRA) examples (*.DCM macro files), open the
Diffusion Module - DICTRA folder.
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5. In the folder, double-click the *.TCM file or click Open.
6. Follow the prompts in the Console window i.e. keep pressing <Enter> to run the
macro and produce a plot in the Console Results window.

Macro File Commands
Action

Command

Description and Comments

To load a macro file

In the SYS module,
MACRO_FILE_OPEN
followed by the name of
the macro file.

Thermo-Calc starts the command sequence that the
file contains.

Regain control of
the console

SET_INTERACTIVE

End a macro file with this command to have control
of the Console returned to you.

Add comments to a
macro file

Start a line with @@, or
enclose it between an @
(-line and a @)-line.

When lines are enclosed the software ignores them
when running the macro.

Open a macro file

MACRO_FILE_OPEN

When creating the log file, you can make a macro
file load up to five other macro files.

Nest macro files
inside of each other

MACRO_FILE_OPEN
SET_INTERACTIVE

If a nested macro file ends with SET_INTERACTIVE,
then Thermo-Calc resumes with the higher-level
macro file at the command immediately following
the MACRO_FILE_OPEN command that loaded and
executed macro file that has just been terminated.
If a nested macro file doesn’t end with SET_
INTERACTIVE (but with an end-of-file character),
then the console shuts down and the macro is
stopped.

Macro File Control Characters
The @? character allows you to make a macro interactive by allowing input. At the @?
character, which is placed where a parameter value or argument is normally put, ThermoCalc prompts to input the value of a parameter or argument. You can enter a string
immediately following the @? character. This string is presented to the user when prompted
to enter the parameter value or argument. The entered value is used by Thermo-Calc as
input to the command in question. For example, you can request the user to specify the
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temperature range of a stepping calculation by entering the following in a macro file:
SET_AXIS_VARIABLE 1 T @?Low-temperature-limit: @?High-temperaturelimit:

You can also use up to nine variables in your macro file and prompt the user to enter values
that can be assigned to these variables. Use the @#n character when you want to prompt the
user to provide a value to the variable, where the n is a digit between 1 and 9. You can then
use this value by with the ##n character. For example, you can request the user to provide
the first element of a system by entering the following in the macro file:
@#3First-element?

You can then use this variable with the entering the character ##3 later in the macro file.
For example, you can write:
SET_AXIS_VARIABLE 1 x(##3) 0 1,,,

Finally, there is the @& pause character. Thermo-Calc pauses and waits for input from the
user when this pause character is read from a macro file. Inserting pause characters is
useful if you want to allow the user to monitor what is happening when Thermo-Calc is
running the macro.

Response-Driven Modules and Macros
Macro files that are created while you use a response-driven module begin with the moduleentering command (for example, Goto_Module Scheil) followed by a number of lines with
responses to the module’s questions and requests. The file terminates with the commands
POST or SET_INTERACTIVE (this command gives you back control of the Console). An empty
line cannot be edited with any input rather than the default answer (to a specific question).
Comment lines, commands to open other macro files, pause characters or input-controlling
characters cannot be inserted between these empty lines (otherwise the response-driven
module cannot be executed properly).
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Workspace Files
For DICTRA Console Mode see File Formats in the Diffusion Module
(DICTRA) User Guide
Workspaces files allow you to save all the data in your current workspace. A workspace
contains all the data, specified settings and the result of any calculations performed. The
saved data includes original and modified thermodynamic data, the last set of conditions
and options, and the results of any simulations. You use the command SAVE_WORKSPACES to
create this file type, which is available in the POLY, GIBBS and PARROT modules.
When in Thermo-Calc Console Mode these are the workspace file extensions:
l

POLY module (*.POLY3)

l

GIBBS (GES) module (*.GES5) (This cannot currently be done with GES6)

l

PARROT module (*.PAR and *.POP)
For DICTRA in Console Mode, the PARROT module file extension is *.DOP.

The workspace has all the settings specified and the result of any stepping or mapping
operations performed after using SAVE_WORKSPACES. Consequently, the command opens a
workspace in which all data is saved which is generated after the SAVE_WORKSPACE
command is executed. The saved data includes original and modified thermodynamic data,
the last set of conditions and options, and calculation results.
To load the data and calculation results of a workspace file, use the READ_WORKSPACES
command available in the POLY module. The file can be used for calculation in POLY,
visualization in POST, or data manipulation in GES. You are also given the option in the
POURBAIX and SCHEIL modules to open a previously saved workspace file. This allows you to
make new POURBAIX or SCHEIL calculations on the same chemical system as before but
with different temperature, pressure, and composition conditions, or to plot new property
diagrams based on the previous calculations.
A reminder that Linux and macOS are case sensitive; when applicable ensure
you enter file extensions with capital letters.
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Drag and drop files into the Console window to open or run a macro, for
example. File types that can be opened this way are macro files (*.TCM and
*.DCM), database files (*.TDB), and workspace files (*.POLY3, *.GES5,*.PAR,
and *.DIC). Note that *.DCM and *.DIC file extensions are applicable to the
Diffusion Module (DICTRA).

Links to Workspace Commands
POLY module
l

READ_WORKSPACES

l

SAVE_WORKSPACES

Gibbs (GES) module
l

READ_GES_WORKSPACE

l

READ_WORKSPACES

l

SAVE_GES_WORKSPACE

l

SAVE_WORKSPACES

PARROT module
l

READ_PARROT_WORKSPACES

l

SAVE_PARROT_WORKSPACES

ED-EXP module (submodule to PARROT)
l

READ_WORKSPACES

l

SAVE_WORKSPACES

Reactor module
l

READ_WORKSPACE
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l

SAVE_WORKSPACES

Important Information About Map and Step Commands and the Save_
Workspaces Command
A STEP or MAP command automatically saves the workspace with the most
recently specified name. Do not use the SAVE_WORKSPACES command after a
MAP or STEP command.

The results from the STEP or MAP commands are destroyed by the SAVE_WORKSPACE
command. You can append several results obtained by sequential STEP or MAP calculations
without destroying the previous results, whilst SAVE_WORKSPACE erases them all. Keeping this
in mind is important and useful particularly for calculating various isothermal (or isoplethal)
sections and plotting them on the same diagram in a single Thermo-Calc run.
To suspend some of the STEP or MAP results, use the AMEND_STORED_EQUILIBRIA command.
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Editing the Default Console Directory
You can add a startup parameter to a shortcut when launching Thermo-Calc on any of the
platforms. When you launch the revised shortcut, the file path is set to a user-defined
default directory. An example of why you might want to have a custom directory path is if
you use batch projects or if you have macro files for batch jobs. The custom directory file
path can also be viewed from within Console Mode.

The shortcut is only valid throughout the existing session; it is not saved as a
default. Each time you want to use this file path you must launch Thermo-Calc
from the customized shortcut.

The following uses Windows for the example.

How to Set up the Default Console Directory
1. Right-click a shortcut to Thermo-Calc and click Properties.

2. In the Thermo-Calc 2020b Properties dialog, Target field, add the following to the
end of the string: –r plus the “path to the default directory”. Include a space between
the –r and path, and use quotation marks around the full file path. A simple example:
-r “C:\Thermo-Calc_Macro_Files”
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3. Click Apply and OK.
4. Launch Thermo-Calc from the shortcut where you added the parameter. You can
confirm that it is set correctly from within Thermo-Calc.

How to View the File Path in Thermo-Calc
1. Launch Thermo-Calc from the short cut where you added the parameter.
2. In Console Mode, right click the Console window and choose Properties.

3. In the Console Properties window the Default directory section displays the custom
file path.
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Experimental Data Files (*.POP, *.DOP)
There is also another type of experimental data file (*.EXP) generated when
working with DATAPLOT. See About the DATAPLOT Graphical Language.
In order to conduct an assessment for a system, the experimental data is described with a
syntax, which is similar to the way that one calculates an equilibrium in the POLY module or
you edit an experimental point in the ED_EXP module. Similar to a Thermo-Calc macro file
(*.TCM), an experimental data file (i.e. the *.POP or *.DOP file) is a basic text file and can
be opened and edited by any text editor. For this reason, a *.POP or *.DOP file is not
hardware dependent.
A POP or DOP file consists of various commands from the POLY and ED_EXP modules, as
well some special commands which can only be used in such experimental data files.
Various experimental information can be inputted in an *.POP or *.DOP file as different
tables; the same type of experimental data are usually documented in the same table (see
below).
A *.POP or *.DOP file is used in the PARROT module to provide experimental information
for the optimization process, and is checked by a syntax checker when the PARROT
command COMPILE_EXPERIMENTS is proceeded.
The special commenting identifier, i.e. a dollar sign $ which starts a line, is used to
document comment lines at any position in a *.POP or *.DOP file. You may remember that
this feature is universally the same as in almost all kinds of text files in Thermo-Calc
software, e.g. in *.TDB, *.DAT, *.TCM, *.POP/*.DOP and *.EXP files. Such a sign and all
information afterwards in the same comment line is skipped and ignored by the syntax
checker.
Many POLY and ED_EXP commands can be directly used in a POP or DOP file. But there are
some differences with the set of POLY or ED_EXP commands, and some specially designed
commands as described in this topic can only be used in the *.POP or *.DOP files.

Frequently Used POLY Commands
Most of the commands in the experimental data file are the same as in the POLY module.
The most frequently used are listed below:

Thermo-Calc User Guide: Console Mode ǀ 44 of 643

Thermo-Calc Documentation Set

The last command in an *.POP or *.DOP file must always be the SAVE
command.

l

CREATE_NEW_EQUILIBRIUM

l

CHANGE_STATUS

l

SET_CONDITION

l

SET_REFERENCE_STATE

l

ENTER_SYMBOL

l

SAVE_WORKSPACES

Less Often Used POLY Commands
Other legal commands from the POLY module that are used less often are:

The DEFINE-COMPONENTS command must be always used as the first
command in an *.POP or *.DOP file, as it automatically reinitiates the whole
workspace.

l

DEFINE_COMPONENTS

l

EVALUATE_FUNCTIONS

l

SET_ALL_START_VALUES

l

SET_NUMERICAL_LIMITS

l

SET_START_VALUE

l

ADVANCED_OPTIONS

Frequently Used Edit Experiments (ED_EXP) Commands
Most of the special commands for the ED_EXP module are also often used in an *.POP or
*.DOP file. For example:
l

EXPERIMENT

l

EXPORT
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l

IMPORT

l

LABEL_DATA

l

SET_ALTERNATE_CONDITION

l

SET_WEIGHT

Do not use these Edit Experiment (ED_EXP) Commands
The following special ED_EXP commands are illegal and should not be used in
any *.POP or *.DOP file:

l

COMPUTE-ALL-EQUILIBRIA

l

MAKE-POP-FILE

l

READ (READ-BLOCK OR READ-WORKSPACE)

l

TRANSFER-START-VALUES
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Calculations
Graphical Mode vs Console Mode: Calculation Types
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About the Gibbs Energy System (GES) Module
The Gibbs Energy System (GES) module is an important Thermo-Calc Console Mode module
and consists of a comprehensive subroutine package for various thermochemical
calculations. The module is interactively connected with all basic and advanced modules in
Thermo-Calc and the add-on Diffusion Module (DICTRA). Most users will not directly use the
GES module and commands unless you perform assessments.
The GES module is in essence the Thermo-Calc calculation engine, sometimes referred to as
the calculation core. When working in Graphical Mode you are using the GES calculation
engine behind the scenes, whereas in Console Mode, and if you are performing assessments,
you are directly interacting with the module. This is also applicable if you are working with
any of the software development kits (SDKs).
The objective of the GES module is to provide a unified set of subroutines to be used in any
application program that needs thermochemical data. All kinds of thermodynamic models
for various types of substances are implemented. However, most model-dependent features
are hidden inside the module, and the application programmer can use a standardized set of
subroutines, i.e. using the Thermo-Calc SDKs such as TC-Python, TQ-Interface, TC-API and
TC-Toolbox for MATLAB® to calculate the integral Gibbs energy or any partial derivative
thereof for each phase at any composition, temperature and pressure.
There are subroutines to analytically calculate the first and second partial derivatives of
integral Gibbs energy with respect to any variable. You can enter and modify phase
descriptions, model connections, basic thermodynamic parameters, and so on.
POLY and all other basic and special modules, as well as the add-on Diffusion Module
(DICTRA), interactively call the subroutines within the GES module to calculate any
thermodynamic quantities.

Calculation Engine: GES5 vs GES6
GES6 is a re-write and new implementation of the Gibbs Energy System module
of Thermo-Calc and it is the default engine. The previous version, GES5, is still
available and will continue to work in the background of the program where
necessary. The main purpose of GES6 is to support faster development of new
features. However, not all GES5 functionality is implemented in GES6. In such
cases (except for the POURBAIX module), GES6 falls back silently and uses
functionality from GES5 in the background.
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To globally set the default from GES6 back to GES5, go to the Tools → Options
→ General tab and click Version 5 for the Preferred Gibbs Energy System
setting. This is useful if you are using the POURBAIX module (aqueous solutions),
or if you have a custom database that is not compatible with GES6. The SET_
GES_VERSION Console Mode command can also be used to change GES versions
for a single Thermo-Calc session.

Contact Thermo-Calc Software AB at info@thermocalc.com for more
information about the changes or if you encounter any issues you think are
related to the new version of the calculation engine.
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The Equilibrium Calculation Module (POLY3)
An equilibrium describes what the composition of the end state of a system is, given a full
specification of state variables such as temperature, pressure, initial composition, system
size, etc. An equilibrium calculation is normally done in POLY-3 according to the Global
Minimization Technique, which ensures that the most stable minimum under the specified
conditions is computed.
For an equilibrium calculation to be performed, the state variables must all be set as
conditions for the calculations. Such conditions include, for example, temperature, pressure,
and system composition. When you calculate an equilibrium in the POLY module, you have
to set these conditions manually.
Knowledge of the thermodynamic equilibrium is an important factor for understanding
properties of materials and processes. With a database of thermodynamic model
parameters, it is possible to predict such properties and also to obtain driving forces for
diffusion-controlled phase transformations and other dynamic processes.
With the equilibrium calculation module, POLY3, it is possible to calculate many different
kinds of equilibria and diagrams, in particular multicomponent phase diagrams.
Different types of databases can be used with the POLY module, and it can be used for alloys
or ceramic systems, as well as gaseous equilibria, aqueous solution involved heterogeneous
interaction systems. Up to 40 elements and 1000 species can be defined into a single system
for equilibrium calculations.
All normal thermodynamic state variables can be used to set as conditions in calculating
equilibria, and as axes in plotting diagrams. You can set the composition or any property of
an individual phase as a condition. Any state variable can be varied along an axis in order to
generate a diagram. During calculations of a diagram, complete descriptions of all
calculated equilibria are stored, and in the diagram any state variable can be used as an
axis.
The Global Minimization Technique is used to ensure that the present minimum in an
equilibrium calculation is the most stable minima for the specified conditions. This is based
on the traditional GEM (Gibbs Energy Minimization) technique.
A direct global minimization can be performed on conditions: N, n(comp), B, b(comp), w
(comp), x(comp), T, and P, but not when combined conditions as e.g. w(a)-3*w(b)=1 are used
or when an activity or potential condition is used. For all other types of conditions where
regular minimization converges, Indirect Global Minimization, i.e. global test and
corrections, if necessary, are performed until the lowest minimum is found.
l

Direct Global Minimization: From the mesh of Gibbs energy, find the set of grid
points that gives the lowest energy solution under the specified conditions. This set of
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grid points provides starting combination of phases and their constitutions for regular
minimization to find the exact equilibrium solution. This solution is then subject to a
global test as described below.
l

Indirect Global Minimization: Under certain conditions, a direct approach is
impossible. In this case, regular minimization is performed first and then a check is
performed in order to see if the found local minimum is a global one by checking if
all grid points are above the equilibrium Gibbs energy plane. If not, then recalculate
by including these grid points until no grid point is above the equilibrium Gibbs
energy plane from the previous step.

The full-scale and full-scope usage of the Global Minimization Technique has been extended
from for only single-point calculations for all types of calculations (of single-points, property
diagram stepping and phase diagram mapping)in Thermo-Calc.
The use of Global Minimization Technique may increase the computation time. The main
cost in time comes from the calculation of Gibbs energy at each grid point generated by
properly meshing the composition space for each entered phase. An additional (but much
smaller) cost in time comes from finding the set of grid points in the above mesh that give
the lowest energy solution. This solution is where POLY starts its ordinary minimization.
When POLY has found an equilibrium, the equilibrium Gibbs energy surface is compared to
the mesh to assure that no grid point is below the surface, i.e. a global minimization has
been reached.
Global minimization is performed by default in single-point or stepping or mapping
equilibrium calculations.
Together with the PARROT module, the POLY module is also used for critical assessment of
experimental data in order to develop thermodynamic databases. The POLY module uses the
Gibbs Energy System (GES) for modeling and data manipulations of the thermodynamic
properties of each phase.

Setting Conditions for Equilibrium Calculations
Setting a condition normally involves giving a single state variable a specific value. For
example, you can set the temperature to 1273.5 Kelvin (T=1273.5). Alternatively, setting a
condition can involve giving a linear expression with more than one state variable a specific
value. For example, you can set the mole fraction of the S component to be the same in the
liquid and the pyrrohotite phases (X(LIQ,S)-X(PYRR,S)=0).
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The number of state variables that need to set is determined by the Gibbs Phase Rule.
Typically, the state variables to give values to are:
l

temperature (in K)

l

pressure (in Pascal)

l

system size in number of moles (in mole) or mass (in grams)

l

the fraction of each component (in number of moles or mass)

If you fix the phase of the equilibrium and all but one of the state variables, you can discover
the value of the other state variable at equilibrium.
It is possible to specify a set of conditions that does not have any equilibrium and the
program detects this by failing to reach equilibrium during the calculation.

State VariableS
The following table lists some of the available state variables you can use to set conditions:
State Variable

SET_CONDITION Parameter

temperature in the system (in K)

T
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State Variable

SET_CONDITION Parameter

pressure in the system (in Pascal)

P

system size (mole number in moles)

N

system size (mass in grams)

B

number of moles of a component in the system

N(<component>)

mole fraction of a component in the system

X(<component>)

mass fraction of a component in the system

W(<component>)

activity of a component in the system

ACR(<component>)

chemical potential of a component in the system

MUR(<component>)

mole fraction of a component in a phase

X(<phase>,<component>)

mass fraction of a component in a phase

W(<phase>,<component>)

activity of a species referred to a phase at ambient temperature
and pressure

ACR(<species>,<phase>)

chemical potential of a species referred to a phase at ambient
temperature and pressure

MUR(<species>,<phase>)

enthalpy in the system (in J)

H

enthalpy of a phase (in J/mol)

HM(<phase>)
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Calculating an Equilibrium
This topic explains how to calculate an equilibrium in POLY. To calculate an equilibrium
means to calculate the equilibrium composition of your system, given a full specification of
conditions that reduce the degrees of freedom of the calculation to zero.
If you are running a network client installation of Thermo-Calc and cannot enter
the POLY module, this may be because all the license instances on that the
license server makes available have been checked out.
POLY Module Commands
1. Define your system.
Defining a System in Console Mode
2. Go to the POLY module. At the SYS prompt, type GOTO_MODULE and enter POLY.
3. Use SET_CONDITION followed by conditions and value assignments to set the
conditions of your calculation. For example, to set temperature, pressure, initial
composition and system size for a Fe-Cr-C system, you might enter the following:
SET_CONDITION T=1200 P=1E5 W(CR)=0.18 W(C)=0.0013 N=1

This sets the temperature (T) to 1200 K, the pressure to 1 bar (100,000 Pascal), the
mass fraction of Cr to 18 mole percent, the mass fraction of C to 0.13 weight percent,
and the total amount of material to 1 mole. The fraction of Fe in the system is
calculated from the fractions of Cr and C. You have to set the fraction of all the
components in your system except one.
4. Use COMPUTE_EQUILIBRIUM to run the calculation.
5. Use LIST_EQUILIBRIUM to see the results of the calculation.
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Calculating an Equilibrium with a Fixed Phase
There are many ways to calculate equilibriums in Thermo-Calc. The following is one
example.
You can calculate an equilibrium that has a certain amount of a certain stable phase. Use
CHANGE_STATUS and choose Phase to specify the phase and the amount of that phase (in
normalized mole number) that you want to set as fixed. For example, if you want to find out
at what temperature a system starts to melt, enter the following:
CHANGE_STATUS PHASE LIQUID=FIX 0

You must leave the state variable whose equilibrium value you are interested in unspecified.
However, if you have already specified that state variable, you can make it unspecified again
by using SET_CONDITION and set that state variable to NONE. For example, if you have given
temperature a value, you can type:
SET_CONDITION T=NONE

The calculated equilibrium includes the value of the unspecified variable at which the
equilibrium enters the phase that is fixed.
For an example where an equilibrium is calculated with a fixed phase, see
Console Mode example tcex07.
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Calculating an Equilibrium with Suspended or Dormant
Phases
You can calculate an equilibrium under the assumption that one or several phases are
SUSPENDED or DORMANT using CHANGE_STATUS and choose Phase. For example, to specify that
all phases except one should be suspended, you can first suspend all phases and then enter a
single phase in the following way:
CHANGE_STATUS PHASE *=SUSPENDED
CHANGE_STATUS PHASE FE_LIQUID=ENTERED

For an example where this is done, as well as where the status of phases is set
to be dormant, see the Single Equilibrium Calculation Examples.
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About Property Diagrams
When you calculate and plot a property diagram, there is only one independent state
variable. Many different properties can be plotted as a function of this independent variable.
For example, if the independent state variable is temperature, then the mole fractions of all
phases can be plotted as a function of temperature. Or the composition of a specific phase
may be plotted relative to temperature, or the activity of a component in the system as a
whole or in a specific phase may be plotted relative to it.
A property diagram is plotted based on a series of equilibria that is computed while the
value of one state variable is varied between a minimum and a maximum value. This
variable is referred to as the stepping axis variable. In Thermo-Calc, first calculate one
initial equilibrium, and then new equilibria are calculated at incremental steps in both
directions on the stepping axis from the initial equilibrium. This continues until the stepping
operation has covered the length of the axis between a minimum and a maximum value that
is specified.
For an example of the calculation of a property diagram, see tcex08.
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Calculating and Plotting a Property Diagram
This topic explains how to calculate a property diagram in POLY. To calculate a property
diagram means to calculate a series of equilibria while the value of the stepping axis
variable varies between a minimum and a maximum value. With the exception of the
stepping axis variable, all the state variables that you set when you calculate the initial
equilibrium retain the values when the new equilibria are calculated.
POLY Module Commands
1. Calculate an initial equilibrium in the POLY module.
2. Use SET_AXIS_VARIABLE to set the axis variable, the minimum and the maximum
stepping variable values and the step length. The first parameter of SET_AXIS_
VARIABLE is the axis number. Since a property diagram only has one axis variable, this
is set to 1. For example, if you want to set the axis variable to temperature, and
calculate an equilibrium at every 50 K between a minimum temperature of 100 K
and a maximum temperature of 2000 K, enter
SET_AXIS_VARIABLE 1 T 100 2000 50

An axis variable must be a state variable that is set when you calculated
the initial equilibrium. For example, if you set the fraction of a
component in number of moles, then you cannot set the mass fraction of
this component as an axis variable. Also, the minimum stepping variable
value must be smaller than, and the maximum value larger than, the
value that you set the state variable to when calculating the initial
equilibrium.
3. Use STEP_WITH_OPTIONS and choose Normal to perform the stepping operation.
The phase regions are listed along the stepping axis, the phases contained in each
region, and the number of equilibria calculated in that region. Each region is defined
by the phases it contains.
The number of equilibria calculated is not just the number of steps that
are performed according to the step length and the minimum and
maximum values on the axis variable. This is because Thermo-Calc
calculates extra equilibria when a new phase is discovered in order to
determine the phase region boundary more precisely.
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4. To plot the diagram, open the POST module and then use PLOT_DIAGRAM. By default,
the X-axis represents the stepping axis variable and Y-axis represents the sum of the
mole fractions of all phases (NP(*)).
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Calculating a Property Diagram One Phase at a Time
There are many ways to calculate property diagrams in Thermo-Calc. One example is where
you can calculate a property diagram with a separate stepping operation being performed
for each phase at a time in its default most stable composition (the major constitution). This
is useful if you want to create a property diagram for a heterogeneous system with both
ordered phases and their disordered pairs.
To calculate a property diagram one phase at a time, use STEP_WITH_OPTIONS and when
prompted choose One_phase_at_time to perform the stepping operation.
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Calculating Several Properties in the Same Diagram
There are many ways to calculate property diagrams in Thermo-Calc. The following is
another example. If you perform several stepping calculations after each other, the results
of these calculations are all saved in your workspace file. This allows you to the following:
l

l

l

Calculate (and then plot) missing parts of a specific property inside the first property
diagram. These parts are calculated inside the range of the stepping variable with a
different control condition.
Calculate (and then plot) two or more sets of a specific property on the same
property diagram for the same system. These can be calculated under different
control conditions with stepping operations being performed across the same
stepping axis variable range.
Calculate phase boundary lines and then plot them in a corresponding phase diagram
for the same system. This can be especially useful for some defined secondary phasetransformations. For example, if you want to find the phase boundary between BCC_
A1 and BCC_B2, or the equal-Gm for two specific phases, or the equal-fraction or
equal-activity for two specific phases of a certain species, then this can be useful.

Unless you have opened a new workspace file previously using SAVE_WORKSPACES , the
results of the stepping calculations are saved in a RESULT.POLY3 file. To save the results of
several stepping calculations in a file different from the workspace file that your results are
currently saved to, then use SAVE_WORKSPACES before you perform the first stepping
calculation.
SAVE_WORKSPACES overwrites and deletes the results of all previous stepping
calculations.
A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.
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Phase Diagrams
In this section:
About Phase Diagrams

65

About Binary Phase Diagrams

67

About Ternary Phase Diagrams

68

About Quasi-Binary and Quasi-Ternary Phase Diagrams

70
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About Phase Diagrams
Phase diagrams have two or more independent axis variables. Any state variable that has
already been set can be used as the mapping variable for a mapping calculation and then as
the axis variable for a phase diagram. From a mapping calculation, many types of phase
diagrams can be plotted, with one of the mapped variables as one axis variable, and with
other mapped variables or any varied property (state or derived variables) or entered
symbol (variables, functions or table values) as the other axis variables.
All phase diagrams consist of zero phase fraction lines. There are two distinct types of phase
diagrams: those with the tie-lines in the plane of the diagram and those where the tie-lines
are not in the plane. The former includes binary phase diagrams and ternary isotherms. The
latter includes more general isopleth diagrams with one or more fixed extensive variables
(normally, this is a composition).
l
l

The BIN and TERN modules calculate binary and ternary phase diagrams.
The POTENTIAL and POURABIX modules calculate the more general isopleth
diagrams and other related diagrams.

The following topics describe how to calculate the types of phase diagrams in the POLY_3
module. In POLY, you can calculate phase diagram for systems with up to 40 components
and with thousands of phases. You can combine activity conditions and fixed phase status
and fraction conditions in any way. Thermo-Calc can calculate any arbitrary 2D section
through composition space.
There is no guarantee that the conditions set will result in a calculation that
reaches an equilibrium.
Binary Phase Diagram Examples
Ternary Phase Diagram Examples
Potential Diagram Example
Pourbaix Diagram Examples
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Calculating and Plotting a Phase Diagram
This topic describes how to calculate a phase diagram in the POLY module. The commands
are described in POLY Module Commands and POST Module Commands.
1. Calculate an initial equilibrium in the POLY module.
2. Use SET_AXIS_VARIABLE to set the first axis variable, its minimum and maximum
mapping value and the length of each incremental step on this axis. The first
parameter of SET_AXIS_VARIABLE is the axis number and is set to 1. For example,
suppose you want the mass fraction of C as your first axis variable. You want it to
vary between 0 and 0.1, with the length of each incremental step being no more than
0.002. Then enter:
SET_AXIS_VARIABLE 1 W(C) 0 .1 0.002

An axis variable must be a state variable that is set when you calculated
the initial equilibrium. For example, if you set the fraction of a
component in number of moles, then you cannot set the mass fraction of
this component as an axis variable.
3. Use SET_AXIS_VARIABLE to set the second axis variable and specify its minimum,
maximum, and step length values. The axis number is set to 2. For example, suppose
you want temperature as your second axis variable and you want it to vary between
900 K and 1900 K, with an incremental step of 25 K. Then enter:
SET_AXIS_VARIABLE 2 T 900 1900 25

4. If you want more than two axis variables, then use SET_AXIS_VARIABLE until you have
set all the axis variables. You can set up to five axis variables. Axis variables 3, 4 and
5 must be set temperature, pressure or to the chemical potentials of components.
You may want to save your workspace with SAVE_WORKSPACES before you perform
the mapping calculation. This saves the axis variables you have set. However, it
overwrites the results of any previous stepping or mapping calculations done.
5. Use MAP to perform the mapping calculation. The console lists the phase region
boundaries and the phases contained on one side of each boundary.
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6. To plot the diagram, use POST to open the POST module and then use PLOT_DIAGRAM.
By default, the X-axis represents mapping axis variable 1 and the Y-axis represents
mapping axis variable 2.

About Binary Phase Diagrams
Binary phase diagrams are by far the most common found in the literature and calculated
by computers. However, most real systems have more than two components and thus binary
diagrams are more a kind of exercise in order to calculate more realistic phase diagrams.
You can calculate many types of binary phase diagrams with POLY, but the traditional one
has one composition axis and the temperature on the other axis. This is calculated by first
specifying a single equilibrium by setting conditions such as
SET_CONDITION T=1200, P=1E5, W(C)=.02, N=1

This means that the temperature should be 1200 K, pressure 1 bar, mass fraction of C is 0.02
(i.e., 2 weight percent) and the system contains one mole of atoms. Note that one does not
set a condition on the amount of the second component. This is simply taken to be the rest of
the system.
After setting these conditions one can calculate the equilibrium by giving the command:
CALCULATE_EQUILIBRIUM

When the calculation has converged, one continues by setting the axes for the diagram
calculation. In most cases, one is interested in the complete composition range but the
temperature range may vary.
SET_AXIS_VARIABLE 1 W(C) 0 .1 0.002
SET_AXIS_VARIABLE 2 T 900 1900 25
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This means that the axis number 1 is taken to be the mass fraction of C which may vary
between 0 and 0.1 with a maximum increment of 0.002. The axis number 2 is the
temperature varied between a minimum 900 and maximum 1900 K with a maximum
increment of 25.
Before starting the mapping, it is a good rule to SAVE the workspaces. If this is done just
before the MAP command, and the MAP command fails for some reason, the user can
restart from the situation just before mapping and try to find a better start point.
SAVE
MAP

The diagram is plotted in the post-processor. The post-processor will automatically set the
same axes for plotting as used for mapping.
POST
PLOT

BINARY_DIAGRAM
The BINARY_DIAGRAM module (short name, the BIN module) enables you to quickly
calculate a simple binary phase diagram. Access to specific databases designed for BIN, such
as TCBIN, is required.
To enter the module, at the SYS prompt type GOTO_MODULE BINARY. There are no other
commands for this module. Follow the prompts to plot a diagram.
Syntax

BINARY_DIAGRAM

Prompts Database: /TCBIN/
First element
Second element
Phase diagram, Phase fraction (FE), G- OR A-curves (G/A): /Phase_Diagram/

About Ternary Phase Diagrams
There are many types of ternary phase diagrams but perhaps the most common is the
isothermal section. In this case, the temperature is constant, which means that the tie-lines
are in the plane of the calculation. Isothermal sections and monovariant lines on the liquidus
surface can be calculated in traditional way. They can also be calculated in the TERN
module, but this requires a special database (such as PTERN).
In order to set up calculation of a ternary isothermal section in the system Al-Mg-Si, do the
following (after retrieving the data from the database (TDB) module):
SET_CONDITION T=823,P=1E5,N=1,X(MG)=.01,X(SI)=.01
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C_E

Note that there is no condition on the amount of Al as that is the "rest". N=1 specifies that
the system is closed. This calculation gives one point inside the system. Now define the axis:
S-A-V 1 X(MG) 0 1 0.01
S-A-V 2 X(SI) 0 1 0.01

Of course, you might not be interested in the whole section, and in such cases specify
different lower and upper limits for the axes. Then give a SAVE command before the MAP
command:
SAVE almgsi-823
MAP

The result can be plotted in the POST module. Ternary isopleths are equally simple to
calculate. Use the same conditions as above if you are interested in a section of Al-Si at 1
mole percent of Mg, just define a different set of axis:
S-A-V 1 X(SI) 0 1 .01
S-A-V 2 T 500 2000 25
SAVE almgsi-1mg
MAP

In the resulting diagrams, the tie-lines are not in the plane of the diagram, thus the lever
rule etc. cannot be applied. But you can calculate more elaborate sections. An interesting
diagram is the section from pure Al to Mg2Si, which is almost a quasi-binary section. In
order to calculate this, set up the conditions differently:
SET-CONDITION T=823, P=1e5, N=1, X(MG)-2*X(SI)=0, W(MG)=.01
C-E

Note that there is no condition on the amount of Si as this is given by the relation X(MG)-2*X
(SI)=0. Also note that you can mix conditions in X and in W. Then set the axis, save the
workspace and map.
S-A-V 1 W(MG) 0 .1 .01
S-A-V 2 T 500 1500 10
SAVE al-mg2si
MAP

A special type of ternary phase diagrams is liquidus surfaces. This is still not simple to
calculate as a separate start point is needed for each separate line at each temperature.
However, you can easily calculate the monovariant lines where the liquid is stable together
with two condensed phases:
SET-CONDITION T=800, P=1e5, N=1, X(MG)=0.01, X(SI)=.01
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C-E
C-S P LIQ=FIX 0.3
S-C T=NONE
C-E

Now there should be an equilibrium where liquid is just stable. Set the axis to be the
compositions.
S-A-V 1 X(MG) 0 1 .01
S-A-V 2 X(SI) 0 1 .01
SAVE almgsi-luni
MAP

TERNARY_DIAGRAM
The TERNARY_DIAGRAM module (short name, the TERN module) enables you to quickly
calculate a simple ternary phase diagram.
To enter the module, at the SYS prompt type GOTO_MODULE TERNARY. There are no other
commands for this module. Follow the prompts to plot a diagram.
Syntax

TERNARY_DIAGRAM

Prompts Database: /FEDEMO/
First element:
Second element:
Third element:
Phase diagram, Monovariants, or Liquidus Surface: /Phase_Diagram/
Temperture (C) /1000/
Global minimization on: /Y/

About Quasi-Binary and Quasi-Ternary Phase Diagrams
Quasi-binary diagrams, as well as quasi-ternary diagrams and so forth, have often been
misunderstood and misused. A real quasi-binary phase diagram is for a ternary system
where one component has a fixed activity or chemical potential, and a real quasi-ternary
phase diagram is for a quaternary system where one component has a fixed activity or
chemical potential.
A typical example of quasi-ternary system is a quaternary system Fe-Cr-Ni-C calculated at
fixed carbon activity. The condition can be set as follows:
SET-REF-STATE C GRAPH ,,,,
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SET-CONDITION T=1273, P=1e5, N=1, X(CR)=.1, X(NI)=.1, ACR(C)=.002

In some cases, the activity may vary in a quasi-binary section if one has a phase fixed instead
(and where the phase may vary in composition). The advantage with the quasi-binary section
is that the tie-lines will be in the plane of the diagram and thus the lever rule etc is obeyed.
A quasi-binary section in Ca-Fe-O when the liquid oxide is in equilibrium with liquid Fe can
be specified as follows:
DEFINE-COMPONENTS CAO FE FEO
SET-CONDITION T=1850, P=1e5, N=1, X(CAO)=.1
CHANGE-STATUS PHASE FE-LIQ=FIX 0

and the mapping can be done with the following axis
S-A-V 1 X(CAO) 0 1 .01
S-A-V 2 T 1500 2000 25

However, it is a problem as FE-LIQ is not the stable phase for pure iron below 1811. One will
have to calculate separate sections depending on the stable modification of Fe.
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Calculating a Quasi-Binary Phase Diagram
There are many ways to calculate phase diagrams in Thermo-Calc. The following is an
example where a quasi-binary phase diagram is used for calculations on a ternary system in
which one component has an activity or chemical potential that is fixed (although if you have
fixed a phase and the phase composition varies, then the activity or chemical potential may
also vary). The tie-lines in a quasi-binary diagram are in the diagram’s plane of the diagram.
This means that the calculation follows the lever rule as well as other rules.
When calculating a quasi-binary phase diagram it is necessary to set a condition on either
activity or chemical potential of the third component. To specify a meaningful value it is
recommended that you first change the component’s reference state using SET_REFERENCE_
STATE. For example, to calculate a phase diagram for a quasi-binary Fe-Cr-O system with
fixed oxygen activity, you can enter the following:
SET_REFERENCE_STATE O GAS ,,

You must also use SET_CONDITION to set the activity of the component whose activity or
chemical potential you have fixed. Do this by assigning a value to the ACR state variable. For
example, if the component is oxygen, you might enter
SET_CONDITION ACR(O)=0.2

Alternative Way to Set the Component Activity
As an alternative to set the activity of the component, you can Use CHANGE_STATUS to set a
phase to fixed. For example, suppose you want to compute the iron-saturated section in
"FeO"-SiO2. You then enter:
CHANGE-STATUS FCC=FIX 0
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Calculating a Quasi-Ternary Phase Diagram
There are many ways to calculate phase diagrams in Thermo-Calc. The following is an
example of a quasi-ternary phase diagram used for calculations on a quaternary system
where one component has a fixed activity or fixed chemical potential.
When calculating a quasi-ternary phase diagram it is necessary to set a condition on either
activity or chemical potential of the fourth component. To specify a meaningful value it is
recommended that you first change the component’s reference state using SET_REFERENCE_
STATE. For example, to calculate a phase diagram for a quasi-ternary Fe-Cr-Ni-C system with
fixed carbon activity, you can enter the following:
SET_REFERENCE_STATE C GRAPH ,,

You must also use SET_CONDITION to set the activity of the component whose activity or
chemical potential you have fixed. Do this by assigning a value to the ACR state variable. For
example, if the component is carbon, you might enter
SET_CONDITION ACR(C)=0.002
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T0 Temperature Simulations
In this section:
About T0 Temperature Simulations

75

Making a T0 Temperature Simulation

76
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About T0 Temperature Simulations
The T0-temperature is the temperature at which two phases have the same Gibbs energy for
a certain composition in a multicomponent system. The T0-temperature is located within the
two-phase field between the phases and it is the theoretical limit for a transformation
without diffusion. T0 temperatures are often of interest if you want to understand how
diffusionless transformations work. The T0 temperature in a multicomponent system with a
fixed composition is temperature at which the tangent lines of the Gibbs energies of the two
target phases are the same.
If the composition of one or two components varies, the common Gibbs energy for the two
phases in partial equilibrium of a diffusionless transformation becomes a plane or surface,
and the T0 temperature becomes a line or plane.
See Console Mode examples tcex 23 and tcex41.
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Making a T0 Temperature Simulation
This describes how to perform a T0 temperature simulation and apply a stepping calculation
to its initial result.
Before you perform a T0 temperature calculation, you must have defined your initial system
and be in POLY. The initial overall composition must have appropriate settings for the
desired T0 temperature calculation for the two target phases.
POLY Module Commands
1. Use SET_CONDITION to set the conditions of your calculation in the same way as when
you calculate an ordinary equilibrium.
2. Use COMPUTE_EQUILIBRIUM to run the calculation. The calculation does not need to
reach an equilibrium in which any of the target phases is stable.
3. When you have calculated your initial equilibrium, use ADVANCED_OPTIONS and
choose T-zero.
4. When prompted, specify the names of the two target phases for which the T0
temperature (where the phases’ Gibbs energies are equal) is to be calculated.
5. If the T0 temperature between the two target phases is calculated, this temperature
(in Kelvin) is shown in the Console window.
6. If you want to do a stepping calculation based on this initial T0 temperature
calculation, then use SET_AXIS_VARIABLE to specify which state variable to use as the
stepping variable. This is done the same way as when you calculate a normal
property diagram.
When a T0 temperature simulation is run, you cannot set temperature as the
stepping variable.
7. Use STEP_WITH_OPTIONS and choose T-zero to initiate the stepping calculation. You
are prompted to specify the names of the target phases for which the T0
temperature is calculated.
During the STEP T-ZERO calculation procedure, the calculated T0 values are
presented next to the stepping variable.
For example, part of the output might look like this:
Phase Region from

1.000000E-01 for:

BCC_A2
FCC_A1
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1.000000E-01

940.24

9.250000E-02

941.20

2.500000E-03

977.61

7.500000E-09

979.34

When the stepping calculation has finished, you can move to the POST module and
plot the T0 line against the stepping composition variable or another varying axis
value. Or you can impose the calculated T0 line onto a normal phase diagram.
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Paraequilibrium
In this section:
About Paraequilibrium

79

Calculating a Paraequilibrium

80
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About Paraequilibrium
A paraequilibrium is a partial equilibrium where one interstitial component (such as carbon
C and nitrogen N) in a multicomponent alloy can diffuse much faster than the other
components (the substitutional elements, including the matrix element and alloying
elements). The chemical potential for the interstitial component in two partially equilibrated
phases is equal in such a case, but this is not true for the other components. In such a
paraequilibrium state, it is possible to have a transformation that is partly without partitions,
where a new phase of the mobile component can form with different content but where the
slowly diffusing components retain their compositions.
A paraequilibrium calculation is useful when, for example, you want to study phase
transformations in systems with large differences in the diffusivities of different elements.
Transformations occurring under paraequilibrium states can be much more rapid than if full
local equilibrium holds at the phase interface.
Calculating a Paraequilibrium
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Calculating a Paraequilibrium
This topic describes both how to calculate an initial paraequilibrium with two target phases,
and how to base a stepping calculation on this initial calculation.
Before you do any paraequilibrium calculations, you must have defined your initial alloy
system and be in POLY. The initial overall composition must have appropriate settings for
the desired paraequilibrium calculation for the two target phases.
1. Use SET_CONDITION to set the conditions of your calculation just like when you
calculate an ordinary equilibrium.
2. Use CHANGE_STATUS to set the status of the chosen interstitial components to
SPECIAL. For example, if C is an interstitial component, enter:
CHANGE_STATUS COMPONENTS C=SPECIAL

This gives you a clear picture on u-fractions of the substitutional and interstitial
components, which are different from the overall composition in the system. The
SPECIAL status means that the specified components are not included in summations
for mole or mass fractions. Therefore, all the composition variables plotted from
paraequilibrium calculations are u-fraction related quantities.
3. Use COMPUTE_EQUILIBRIUM to run the calculation.
4. When you have calculated your initial equilibrium, use ADVANCED_OPTIONS
Paraequilibrium to perform the paraequilibrium calculation.
5. Specify the names of the target phases of the paraequilibrium state. For example,
FCC#1 BCC and FCC#2 M23C6.
Both phases must have similar interstitial/vacancy sublattices that the
fast-diffusion interstitial components occupy. Both target phases should
have phase constitution definitions that cover all the defined
substitutional and interstitial components of the current alloy system.
6. Specify the names of one or more fast-diffusing components. These components
must be located on the interstitial/vacancy sublattices in both of the chosen phases.
Interstitial components (for instance C and N combined) may have
significantly different behaviours depending on how they are partitioned
in different structured phases.
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If the paraequilibrium between the two specified phases is successfully calculated,
then a message is displayed, for example:
NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02 N =
4.1548129E-03
NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04 N =
2.3781027E-04
All other compositions are the same in both phases

The first two lines show the phase amounts expressed in mole-percent [NP(phase)]
and the contents of the interstitial components C and N in each phase. These
contents are expressed in u-fractions. The third line states that the compositions of
the matrix component and all the remaining compositions (regarding substitutional
components) are equal in the two target phases at the paraequilibrium state.
7. If you want to do a stepping calculation based on this initial paraequilibrium, then
use SET_AXIS_VARIABLE to specify which state variable to use as the stepping
variable. This is done exactly in the same way as when you calculate a normal
property diagram.
8. Use STEP_WITH_OPTIONS → Paraequilibrium to initiate the stepping calculation.
You are prompted to specify the names of the target phases of the paraequilibrium
states as well as the fast-diffusing components.
The stepping calculation is performed, and the different phase regions are listed with
columns for the value of the stepping variable, the amounts of the two target phases,
the u-fractions of interstitial(s) in each of the two phases, and the LNACR value(s) of
the interstitial component(s).
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It is possible to now move to the POST module and plot some of the
results of the calculation. For an example of a paraequilibrium
calculation and how it can be plotted, see Console Mode example
tcex23.
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Potential Diagrams
In this section:
About Potential Diagrams

84

POTENTIAL_DIAGRAM

84

Calculating a Potential Diagram

86

Calculating a Potential Diagram with Different Pressure

88
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About Potential Diagrams
If you have a metal-oxide/sulphide-gas interaction system, you might want to calculate a socalled potential phase diagram given certain temperature and pressure. A potential diagram
uses the activities of two major species in the gaseous mixture phase as mapping variables.
The activities (that is, the fugacities at 1 bar) of these two species are typically set as the Xand Y-axis when the diagram is plotted. The phase relations between the gaseous mixture
and various metal forms, metal-oxides, metal-sulphides, or other metal-bearing solids, are
represented by different fields controlled by these two potential quantities.
This topic describes how to calculate such potential diagrams with the POTENTIAL module,
and how to later modify the pressure of such a calculation in POLY. The calculation done by
the POTENTIAL module always assumes a pressure of 1 bar.

POTENTIAL_DIAGRAM
The POTENTIAL_DIAGRAM (POT or POTENTIAL) module is a potential phase diagram
calculation module.
If you have a metal-oxide/sulphide-gas interaction system, you might want to calculate a socalled potential phase diagram given certain temperature and pressure. A potential diagram
uses the activities of two major species in the gaseous mixture phase as mapping variables.
The activities (that is, the fugacities at 1 bar) of these two species are typically set as the Xand Y-axis when the diagram is plotted. The phase relations between the gaseous mixture
and various metal forms, metal-oxides, metal-sulphides, or other metal-bearing solids, are
represented by different fields controlled by these two potential quantities.
To enter the module, at the SYS prompt type GOTO_MODULE

POTENTIAL.

There are no commands for this module. Follow the prompts and see About
Potential Diagrams for details about how to calculate using potential diagrams.

Syntax

POTENTIAL_DIAGRAM
Database: /POT/

Prompts Press <Enter> and the program lists the available databases. Type one of the database names and
press <Enter> to select. The following default elements are then based on the chosen database.
Matrix element: /Fe/
First potential species: /S1O2/
Second potential species: /O2/
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Syntax

POTENTIAL_DIAGRAM
Temperature: /1000/
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Calculating a Potential Diagram
You need access to a substance or solution database that contains a gaseous mixture phase,
metals (or alloys), and solids such as metal-oxides, sulphides, sulphates, carbonates,
silicates, nitrides or nitrates (stoichiometric or solution phases).
1. Use GOTO_MODULE and enter POTENTIAL.
2. Specify which substance or solution database to use. Any substance or solution
database can be used that has a gaseous mixture phase, metals (or alloys), and solids
such as metalxides, sulphides, sulphates, carbonates, silicates, nitrides, and nitrates
(stoichiometric or solution phases).
3. Specify the matrix element (a metal) and the two gaseous species that define you
metal-gas interaction system. The names of these components must be available in
the database you are using.
4. Set the temperature (in Kelvin). (The pressure is always 1 bar.)
A potential diagram with the activities of the two gaseous species as mapping
variables is calculated. These mapping variables are also set as the axis variables in
the plotted diagram.
An example diagram (Console Mode example 35).
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A POLY3 file is also automatically saved in the current working directory with the
default name POT.POLY3.
5. When the diagram is plotted, it opens the POST module where you can modify the
plotted diagram in any way you like.
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Calculating a Potential Diagram with Different Pressure
It is possible to modify both the calculation and the plotted diagram that the POTENTIAL
module generates in the POLY and POST modules. You can do this by opening a POLY3-file
with the results from a POTENTIAL module calculation in either POLY or POST. You can
modify the calculation in the same way that you can modify any ordinary mapping
calculation or phase diagram. For example, this is useful for calculating a potential diagram
at a pressure other than 1 bar.
POLY Module Commands
You must have calculated a potential diagram already, and have the saved POLY3-file
available.
1. Use GOTO_MODULE and enter POLY.
2. Use READ followed by the name of the POLY3 file that contains the results of the
potential diagram calculation that you want to modify.
A reminder that Linux and Mac are case sensitive; when applicable
ensure you enter file extensions with capital letters.
3. This opens the workspace file and loads the previous settings and results. The
activities of the two gaseous species is now part of the conditions, and these
conditions are set as the mapping variables.
4. Use SET_CONDITION to specify the pressure under which you want the potential
diagram to be calculated. For example, to set the pressure to 1000 bar, enter:
SET_CONDITION P=1e8

5. Use COMPUTE_EQUILIBRIUM to compute the initial equilibrium.
You may also want to use ADD_INITIAL_EQUILIBRIUM to calculate some
additional equilibria that the mapping calculations are based on.
6. Use MAP to perform the mapping calculations.
7. Use GOTO_MODULE and enter POST to set conditions for visualization and to plot the
diagram.
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About the Scheil-Gulliver Solidification Simulations
Thermo-Calc is often used to perform equilibrium calculations, but some non-equilibrium
transformations or partial-equilibrium transformations can also be simulated.
A well known example of a non-equilibrium calculation is the Scheil-Gulliver solidification
simulation.

Classic Scheil Simulation
For the Scheil-Gulliver solidification simulation, generally referred to in Thermo-Calc as a
classic Scheil simulation, the following assumptions are made.
l
l

l

Diffusion in the liquid phase is assumed to be very fast, that is, infinitely fast.
Diffusion in the solid phases is so slow that it can be ignored, that is, diffusion is
assumed to be zero.
The liquid/solid interface is in thermodynamic equilibrium.

In this Scheil simulation the temperature is decreased step-by-step. When the temperature
drops below the liquidus temperature the equilibrium amount and composition of solid and
liquid phase is calculated. The solid phase is removed from the system and only the amount
and composition of the liquid phase is used for the next calculation step at a lower
temperature. Again, the equilibrium amount and composition of solid and liquid phase is
calculated and again the solid phase is removed from the system for the next step. This
procedure is repeated until the last liquid disappears.
This calculation procedure is equivalent to assuming that there is no diffusion in the solid
phase and infinitely fast diffusion of all elements in the liquid phase. It has been shown to be
a good approximation of the solidification of most alloys such as Ni-superalloys, Cu alloys, Al
alloys, Mg alloys, and others. However, for steels it fails badly. The reason is that carbon is
one of the most important alloying elements in steels and it dissolves interstitially. Carbon
therefore has very fast diffusion rates. The assumption of no diffusion in the solid phase
during solidification is thus not correct for carbon at most industrial or lab-scale
solidification rates.
For this reason a variant of the Scheil simulation was developed and implemented in
Thermo-Calc, where one or more elements can be defined as fast diffusers.

Scheil Simulation with a Fast Diffuser Element
The Scheil simulation with fast diffuser model in Thermo-Calc takes into account the concept
of the fast diffuser. Typically, C is defined as a fast diffuser, but also other elements such as
N, O, or others can also be defined.
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Fast diffuser does not quite define this since diffusion is not actually simulated.
It is simply assumed that the “fast diffusers” distribute throughout the solid and
liquid phase according to thermodynamic equilibrium. This corresponds to
infinitely fast diffusion.

For the Scheil simulation with fast diffuser the following assumptions are made.
l
l

l

l

Diffusion of all elements in the liquid phase is infinitely fast.
Diffusion of all elements in the solid phases, except the ones defined as “fast
diffusers”, is zero.
Diffusion of the elements defined as “fast diffusers” is infinitely fast in the solid
phase.
The liquid/solid interface is in thermodynamic equilibrium.

The classic Scheil simulation and Scheil simulation with fast diffuser models can be
considered thermodynamic models. There are clear limitations as a certain amount of back
diffusion always takes place in the solid phase at real solidification. For this reason, a more
sophisticated kinetic model, the Scheil simulation with back diffusion is also available.

Scheil Simulation with Back Diffusion
The Scheil simulation with back diffusion kinetic model quantitatively takes into account the
real back diffusion of all elements in the primary solid phase (typically the FCC or BCC
phase). This model requires the use of both a thermodynamic and mobility database. The
calculation also requires the cooling rate to be specified; a fast cooling rate allows for less
time for back diffusion and the simulation result is similar to the classic Scheil-Gulliver
solidification simulation. A very slow cooling rate allows for almost complete back diffusion,
the solidification simulation is then close to an equilibrium calculation. It also requires that
the size of the solidification domain is specified. In most cases this domain size corresponds
to the secondary arm spacing, as this is where typically the liquid is trapped during
solidification.
The secondary arm spacing also depends on the cooling rate. For this reason a
simple empirical relation between cooling rate and secondary arm spacing is
predefined in Thermo-Calc.
For the Scheil simulation with back diffusion the following assumptions are made.
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l
l

l

Diffusion of all elements in the liquid phase is infinitely fast.
Diffusion of all elements in the primary solid phase are quantitatively calculated
using mobility data, a cooling rate and a domain size (typically this is the secondary
arm spacing).
The liquid/solid interface is in thermodynamic equilibrium.

Summary
The variants of the Scheil-Gulliver solidification simulation (classic Scheil simulation, Scheil
with a fast diffuser element, and Scheil with back diffusion) are set up in either the SCHEIL
module in Console Mode or the Scheil Calculator in Graphical Mode.
The Scheil with back diffusion feature is only available for systems with diffusion
data, i.e. it requires the use of a mobility database.
The Scheil calculation allows the calculation of:
l

The solidification range of an alloy.

l

Depression of the solidus temperature due to segregation.

l

Composition of the last liquid to disappear in segregation pockets.

l

Phases formed on final solidification in segregation pockets.

l

The composition gradient in the primary solid phase(s) (segregation profile).

After you enter the module and use the START_WIZARD command, you are prompted to
answer a series of questions about which database to use, what the major element is, and
the amount of alloying elements. Thermo-Calc then displays a property diagram showing
how the fraction of solid phase varies with temperature (in Celsius). You can then plot
diagrams using other variables you are interested in. To plot diagrams, you add a new
simulation or open a file with the results of a previous simulation. For example, you might
be interested in plotting the fraction of remaining liquid against temperature, the fraction of
each solid phase or the total of solid phases against temperature, the microsegregation in
each solid phase, or the latent heat evolution against temperature.

Scheil Module Examples
See the following Thermo-Calc Console Mode examples:
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tcex15 and tcex30 to simulate non-equilibrium transformations without
considering fast-diffusion elements.
tcex48 to simulate partial-equilibrium transformation with fast-diffusion
elements taken into consideration. This example also shows how you can
perform lever-rule calculations (full-equilibrium transformations).
tcex54 for a solidification simulation of a Al-2.1Cu-1Si alloy where back diffusion
in the primary phase is included.

Scheil and the Diffusion Module (DICTRA)
If you also have a license for the Diffusion Module (DICTRA), you can import a
previously calculated Scheil segregation profile into the software using the
command INPUT_SCHEIL_PROFILE. Press F1 to search the online help.

Simulating a Scheil Solidification Process
SCHEIL Module Commands
About the Scheil-Gulliver Solidification Simulations
Simulating a Scheil-Gulliver solidification process involves calculating the liquid composition
of a higher-order multicomponent system at each step of a cooling process, and resetting
the liquid composition as the composition of the entire system (after having removed all
amount of solid phase).
The step-by-step instructions below are intended as a simple example of setting
up a calculation using the wizard. You can also use the macros available and
briefly described in Examples of Scheil-Gulliver Calculations.
The following does not include any prompts related to using back diffusion. See
START_WIZARD for additional details about when this is enabled with the USE_
BACK_DIFFUSION command.
1. At the prompt type

GOTO_MODULE SCHEIL.

2. Type START-WIZARD and press <Enter>.
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3. Specify which Database to use. Type ? for a list of available databases based on your
license.
l Type FEDEMO for this example.
4. Specify the Major element or alloy in your system. For example, enter Fe
(steel/Fe-alloy), Al (Al-based alloy), or Ni (Ni-based super alloy).
l Type Fe for this example.
5. Set whether to specify the Composition input in mass (weight) percent (the
default) or in Mole percent. Press <Enter> to keep the default for mass percent or
type N to use mole percent.
l Keep the default for this example (press <Enter>).
6. Specify the name of the 1st alloying element. You can directly specify mass or
mole percent after the name. If this is not specified, then you are prompted to enter
it separately.
l Type Cr 5 for this example.
7. Specify the other alloying elements in the same way as you specify the first.
l Type c 1 for this example.
8. After you have specified your last alloying element, press <Enter>. This ends the
process of defining the bulk composition of the alloy system.

You can also specify all the alloying elements and their corresponding
compositions on the same line when you are prompted to specify your
first alloying element. As a general example, you can enter Cr 5 Ni 1
Mo 0.5 C 0.01 N 0.02.

l

Press <Enter> for this example.

9. Specify the starting Temperature

(C)

in Celsius. The default is 2000.

This value should be sufficiently high so that the solidification simulation starts with
the alloy system in the liquid single-phase region.
l

Keep the default for this example (press <Enter>).

10. At the Reject phase(s) prompt enter the name of the phases to reject or press
<Enter> for the default NONE.
l Keep the default s for this example (press <Enter>).
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11. At the Restore phase(s) prompt you may want to restore a phase that you rejected
when you ran the simulation earlier, or you may want to restore a phase that is
rejected by default in your database. Enter the name of the phases to restore or
press <Enter> for the default NONE.
l Keep the default for this example (press <Enter>).
12. When prompted OK? type N to go back to reconsider which phases to reject or
restore. Type Y to continue. The thermodynamic data about the alloy system you
defined is retrieved from the database.
l Keep the default for this example (press <Enter>).
13. At the Should any phase have a miscibility gap check prompt, press <Enter>
for the default N or type Y then specify the Phase with miscibility gap.
l For this example, type Y then enter FCC as the phase with miscibility gap.
14. If you answer Y to the miscibility gap check, then next enter the following for Major
constituent(s) for sublattice 1 and Major constituent(s) for
sublattice 2.
l Enter Cr for sublattice 1 and C for sublattice 2 in this example. Then at the
Phase with miscibility gap prompt press <Enter>. The system responds
with LIQUID PHASE NAME: LIQUID.
15. Specify the names of any Fast-diffusing components. Press <Enter> for NONE or
type all the names on the same line then press <Enter>.
l Keep the default for this example (press <Enter>).
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After the Scheil-Gulliver solidification simulation runs, the diagram Temperature versus Mole
Fraction of Solid is plotted in the Console Results window.

Scheil Module State Variables
Post processing is done the same way as POLY-3: specific variables for plotting in the Scheil
Module are listed.
POLY Module Commands
The variables can be plotted along the X- and Y-axes. In the table, ph is an abbreviation of
phase, and el is an abbreviation of element. Use the abbreviations of the variables when you
specify what the X- and Y-axes represent in a diagram.
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Abbreviation

State variable

T

Temperature in Celsius

NL/BL

Mole/mass fraction of liquid

NS/BS

Mole/mass fraction of all solid phases

NS(ph)/BS(ph)

Mole/mass fraction of a solid phase

W(ph,el)

Weight fraction of an element in a phase

X(ph,el)

Mole fraction of an element in a phase

Y(ph,el)

Site fraction of an element in a phase

NN(ph,el)

Distribution of an element in a phases

NH/BH

Heat release and Latent heat per mole/gram

CP/BCP

Apparent heat capacity per mole/gram

NV/NV(ph)

Molar volume of the system or a phase

DS/DS(ph)

Average density of the system or a phase

BT

Apparent volumetric CTE of the system

Scheil Module Frequently Asked Questions
How can I plot the latent heat evolution after a Scheil simulation?
The total or apparent heat release during the solidification process consists of two parts: one
is the so-called latent heat, i.e. heat due to the liquid -> solid phase transformation, and the
other is the heat related to the specific heat of liquid and solid phases. To examine the heat
evolution after a Scheil simulation, one can in Console Mode choose either NH or BH from
the list of available plotting quantities to plot both (total or apparent) heat release and
latent heat evolution against T, the temperature. This will result in a diagram with two
curves, where the upper curve represents the latent heat evolution, whereas the lower curve
represents the (total or apparent) heat release. By choosing NH the result is displayed as
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J/mol, whereas BH gives the result as J/gram. If one wants to plot just a single curve, one
has to save the results to an .EXP file and re-plot after editing it.

What is the difference between heat release and latent heat evolution
for a Scheil solidification simulation?
The total or apparent heat release during the solidification process consists of two parts: one
is the so-called latent heat, i.e. heat due to the liquid -> solid phase transformation, and the
other is the heat related to the specific heat of liquid and solid phases. To examine the heat
evolution after a Scheil simulation, one can in Console Mode choose either NH or BH from
the list of available plotting quantities to plot both (total or apparent) heat release and
latent heat evolution against T, the temperature. This will result in a diagram with two
curves, where the upper curve represents the latent heat evolution, whereas the lower curve
represents the (total or apparent) heat release. By choosing NH the result is displayed as
J/mol, whereas BH gives the result as J/gram. If one wants to plot just a single curve, one
has to save the results to an .EXP file and re-plot after editing it.

Why are there two curves when plotting heat evolution after a Scheil
simulation?
The total or apparent heat release during the solidification process consists of two parts: one
is the so-called latent heat, i.e. heat due to the liquid -> solid phase transformation, and the
other is the heat related to the specific heat of liquid and solid phases. To examine the heat
evolution after a Scheil simulation, one can in Console Mode choose either NH or BH from
the list of available plotting quantities to plot both (total or apparent) heat release and
latent heat evolution against T, the temperature. This will result in a diagram with two
curves, where the upper curve represents the latent heat evolution, whereas the lower curve
represents the (total or apparent) heat release. By choosing NH the result is displayed as
J/mol, whereas BH gives the result as J/gram. If one wants to plot just a single curve, one
has to save the results to an .EXP file and re-plot after editing it.
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About Aqueous Solutions and the Pourbaix Diagram
This command or module is not available with GES6.

GES6 is a re-write and new implementation of the Gibbs Energy System module
of Thermo-Calc and it is the default engine. The previous version, GES5, is still
available and will continue to work in the background of the program where
necessary. The main purpose of GES6 is to support faster development of new
features. However, not all GES5 functionality is implemented in GES6. In such
cases (except for the POURBAIX module), GES6 falls back silently and uses
functionality from GES5 in the background.

Heterogeneous equilibrium calculations involving aqueous solutions are not different from
other equilibrium calculations, but the setup of the equilibrium conditions and the reference
states of the system is more complex. For example, the pH and Eh values of the aqueous
solution phase are normally complex functions of bulk composition, temperature and
pressure conditions.
For some simple systems, thermodynamic approximations of pH-Eh calculations can be used.
But Thermo-Calc also has comprehensive thermodynamic models and databases for various
non-ideal solution phases. These let you accurately calculate pH and Eh property diagrams
(and many other types of property diagrams) in complex aqueous solutions in a variety of
conditions.
A Pourbaix diagram is a kind of phase diagram that shows the stability boundaries for a
metal-aqueous interaction system. The phase boundaries are shown as a function of pH
(acidity) and Eh (standard hydrogen electronic potential). An aqueous solution phase is
always present in such a system. At a given pH and Eh, a metal may lose its stability to a
soluble or corrosive aqueous solution, or be in equilibrium with either the aqueous solution
(insoluble/immune) or with a secondary-phase file that has formed (consisting of oxides,
hydroxides, sulphides or other solids). In the latter case, further dissolution of the passive or
protective metal is prevented.
A Pourbaix diagram is a pH-Eh phase diagram where the tie-lines are not in the plane. The
chemical potentials or activities of two system components (H+ and EA) are used as mapping
variables and the pH and Eh quantities are normally plotted on the X- and Y-axes of the
diagram. You can use many other properties as axis variables in various property diagrams
for the interaction system at a specific temperature and pressure. The phase relations
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between the aqueous solution and various metal forms, oxides, hydroxides, sulphides,
sulphates, nitrates, silicates, carbonates and other solids, or gaseous mixtures, are
represented as different fields defined by acidity and electric potential.
The POURBAIX module lets you construct Pourbaix diagrams and other types of property
diagrams for heterogeneous interaction systems with aqueous solution phases. The
compositional definition and variations and the basic solvent and electron components H2O,
H+1 and ZE are automatically determined by the aqueous solution phase in the Pourbaix
module.
See Console Mode examples tcex40 and tcex53.

Key Components
These key components are defined as follows:
Component

Component status

Reference state

Ref-T(K)

Ref-P(Pa)

H2O

ENTERED

AQUEOUS

*

100000

H+1

ENTERED

SER

ZE

ENTERED

REFERENCE_ELECTRODE

*

100000

Besides the aqueous solution phase, your system may also contain a gaseous mixture phase.
Other neutral and charged gaseous species may also be constituents. For multicomponent
systems there are normally also some interacting solid phases (stoichiometric or solution) as
the so-called secondary phases. These are typically the matrix and/or precipitate phases in
the alloys of interest.
Some databases have been specially developed for the Pourbaix module’s diagram
calculations. Such a database contains all necessary phases, i.e., an aqueous solution phase,
a gaseous mixture phase, some alloy solid solution phases and some secondary solid phases.
Databases developed for the Pourbaix module include PAQ (TCS Public Aqueous Solution
Database) or PAQS (TGG Public Aqueous Solution Database).
If such a dedicated Pourbaix module is not used, then an aqueous solution
database such as TCAQ (TC Aqueous Solution Database), AQS (TGG Aqueous
Solution Database), or any user-specified aqueous databases can be used.
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This database contains at least the AQUEOUS and REFERENCE_ELECTRODE phases. The
aqueous solution database needs to be appended with additional required data and phases,
such as interacting alloy (solid) solution phases and secondary (solid and liquid) phases.
Additional data is from one or more databases, such as SSUB/SSOL/TCFE or other
substances/solutions databases.
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Calculating a Pourbaix Diagram
The POURBAIX module lets you construct Pourbaix diagrams and other types of property
diagrams for heterogeneous interaction systems with aqueous solution phases.
When calculating a Pourbaix diagram, you need to have a database with an aqueous solution
phase (that is, a phase with water as the dissolving solvent and with aqueous cation/anion
and complex species as the dissolved solutes). Due to restrictions of aqueous solution models
(SIT, HKF, Pitzer) used in the Thermo-Calc software, the aqueous solution database must be
designed in the same Thermo-Calc database format as that used in the PAQ, PAQS, TCAQ
and AQS databases for the aqueous solution phase.
Pourbaix diagram calculations are done in the advanced Pourbaix module.

How to Calcuate a Pourbaix Diagram
1. At the SYS prompt, enter GOTO_MODULE POURBAIX.
2. At the Need any instruction on
to skip or enter Y to learn more.

the POURBAIX module?

3. Press <Enter> at the prompt Enforce
MACRO?.

prompt, press <Enter>

a PAUSE after plotting when running a

4. Press <Enter> to accept the default 1 to Start
diagram calculation or enter 3 to Open an
POURBAIX calculation.

a completely new POURBAIX
old file and make another

To choose 3, you must have already done a Pourbaix calculation and have it saved in
a POLY3 file. The new calculation uses the same system definition as the previous
calculation, but the other conditions, such as the bulk composition, temperature and
pressure, can be modified in the next step.
5. Type Y or N to set whether to Consider
the calculation.

the GAS phase

(gaseous mixture phase) in

The gaseous mixture phase should at least contain H2O, O2 and H2. If a GAS phase is
not considered, then only the interactions between the aqueous solution phase and
various solid phases (alloy phases and secondary phases) are calculated. Such a
calculation may not accurately present all the heterogeneous interactions. Some
secondary phases are therefore usually needed. Such phases exist in the PAQ or
PAQS Public Aqueous Solution Databases. They can also be appended from the
SSUB/SSOL/TCFE or other appropriate substances/solutions databases.
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6. Type Y or N to set whether to Use

single database (Y)

or a multiple database (N).

If you choose to use a single database, at the Combined Database: /PAQ2/ prompt
specify a database that is specially developed for the Pourbaix module’s diagram
calculations.
If you choose to use a multiple database, then you are prompted to specify an
aqueous solution database and to append any additional required data and select
necessary phases, such as various interacting alloy (solid) solution phases, and
secondary (solid and liquid) phases, for example.
7. Specify all your solutes and the molality of each solute when prompted to do so. This
can be done in terms of elements (such as Fe, Ni, Na, Cl, C or S) or arbitrary complex
species (such as NaCl, CO2, CoCl3, Fe0.93S, NaSO4-1, or H2SO4). You can enter the
element/species and the molarity on one line (for an example, NaCl 2.5).
The definition of your system and its initial bulk composition is now presented.

The first letter of the element abbreviation must always be upper case.
Any second letters must be lower case. When you have finished your
specification, press <Enter> when asked to specify Next solute.

8. Type Y to confirm the defined system and its bulk composition.
The thermodynamic data for your system is now retrieved from the database(s)
chosen.
9. Answer the questions that you are prompted regarding various parameters of your
calculation. You are asked to do any of the following:
l Rejectphase(s) or Restore phases(s)
l

Check for miscibility gaps on any phase (Should
miscibility gap check?)

any phase have a

l

Enforce the Global Minimization Technique in calculations?

l

Save all functions, variables and tables in POLY3 file?

l

Set numerical limits

l

Confirm defined conditions?

l

Accept the default settings for two mapping variables

on the calculation
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10. The Pourbaix calculation starts. Answer the question Any missing phase boundary
you could possibly think of? Type Y or N to set whether you want to add
starting points to the calculation. If you suspect that the calculation has missed some
phase boundaries, this may help the program to detect them.
11. Answer questions about how the diagram is plotted and how to save the results of
your calculation. You are asked to do any of the following:
l Change the pH/Eh steps for smoother curves?
on a specific region of the diagram

l

Zoom in

l

Change the curve-label option for the diagram

l

Add label-texts onto the Pourbaix diagram

l

Change the subtitle of the diagram

l

Change the axis-texts

l

Further refine the diagram in the POST Module

l

Print the diagram (save a Hard

l

Save the X-Y coordinates of curve on a text file

l

Modify the diagram

l

Calculate and plot another Pourbaix diagram (Any

copy of the diagram)

more diagram?)
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Plotting More Pourbaix Diagrams
When you have calculated a Pourbaix diagram, you can plot additional diagrams based on
the results of the same calculation, but with different axis variables than Ph and Eh.
The variables can be plotted along the X- and Y-axes. Use the abbreviations of the variables
when you specify what the X- and Y-axes represent in a diagram. In the table, AQsp refers to
the name of a specific aqueous species. The asterisk (*) can be used as a wild card character
for all such species. If neither AQsp nor * is entered in parenthesis, then all species are
searched.
You must have plotted a Pourbaix diagram to plot a diagram with other variables than Ph
and Eh on the Y-axis and the X-axis. You can either plot such additional diagrams directly
after having finished the plotting and saving/printing of a Poubaix Ph-Eh diagram or by
choosing option 2 (Open an old file and plot other property diagrams) when you enter the
POURBAIX module and opening a POLY3 workspace file.

Abbreviations for Aqueous Solution Variables
Abbreviation

Variable

pH

Acidity

Eh

Electronic Potential (V)

Ah

Electronic Affinity (kJ)

Pe

Electronic Activity (log10ACRe)

IS

Ionic Strength

TM

Total Concentration

Aw

Activity of Water

Oc

Osmotic Coefficient

MF(AQsp)

Mole Fractions of Aqueous Species

ML(AQsp)

Molalities of Aqueous Species
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Abbreviation

Variable

AI(AQsp)

Activities of Aqueous Species

RC(AQsp)

Activity Coefficients of Aqueous Species

How to Plot an Aqueous Solution Diagram
1. Type Y when prompted whether to plot any more diagrams, or select option 2 when
you enter the POURBAIX module.
2. Specify which variable you want the X-axis to represent. Use the abbreviation
specified in the preceding table. When you specify the name of an aqueous species,
you can use the asterisk (*) to select all species.
3. Specify which variable you want the Y-axis to represent. The diagram is then
automatically plotted.
4. Answer questions about how the diagram is plotted and how to save it. You are asked
to do any of the following:
a. change the axis-type (linear, logarithmic or inverse) on the X-axis or Y-axis
b. zoom in on a specific region of the diagram
c. change the curve-label option for the diagram
d. add label-texts onto the Pourbaix diagram
e. change the subtitle of the diagram
f. change the axis-texts
g. refine the diagram in the POST Module
h. print the diagram (save a hard copy)
i. save the X-Y coordinates of curve on a text file
j. modify the plotted diagram
k. calculate and plot another aqueous solution diagram
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Stepping Calculations in an Aqueous Solution
Performing the stepping calculation overwrites all the previous settings and
stepping results on the POLY3-file. To avoid this, use SAVE_WORKSPACES to
create a new workspace.

When you have calculated a Pourbaix diagram, you can use the saved results of the
calculation (the POLY3 file), and make a property diagram based on stepping calculation.
Since the program normally sets the calculated initial equilibrium point as the starting point,
the minimum value for the stepping variable must be specified as smaller or equal to the
specific initial condition, and the maximum value as larger or equal to that condition. If pH is
set as the stepping variable, the program automatically calculates the equilibrium constant
in logarithmic (log10Ka) of the electrolysis reaction H2O (water) = H+ + OH- for the real
aqueous solution under the current temperature-pressure-composition conditions, and thus
this constant log10Ka value is considered as the highest pH in specifying the maximum value
along stepping. Subsequently, confirm or modify an increment factor with a default value;
for pressure and mole of a component, specify the step in logarithmic (log10P or log10N).

State Variable Abbreviations
You can use any of these state variables as a stepping variable.
State Variable

Abbreviation

Temperature (K)

T

Pressure (bar)

P

Acidity

pH

Electronic potential (V)

Eh

Mole number of a dissolving component (such as Fe,
Na, Cl, or NaCl) in 1 kg of water.

N(Comp)
(for example, N(Fe))

How to Do a Stepping Calculation
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You must have plotted a Pourbaix diagram before making a stepping calculation on an
aqueous solution.
1. Use GOTO_MODULE POURBAIX to enter the POURBAIX module.
2. Type 4 to open an old file and make another STEPPING calculation.
3. Choose which POLY3 file to load.
4. Specify the conditions of the calculation by answering the questions that follows.
The system definition is the same as in the previous Pourbaix calculation, but you can
modify conditions such as bulk composition, temperature and pressure, and change
some component definitions if necessary.
5. Specify which variable to use as the stepping variable (see the preceding table), its
minimum and maximum value, and the length of each incremental step.
The settings and stepping results are written to the opened POLY3 file, and a first
default property diagram is plotted.

POURBAIX_DIAGRAM Module
This command or module is not available with GES6.

GES6 is a re-write and new implementation of the Gibbs Energy System module
of Thermo-Calc and it is the default engine. The previous version, GES5, is still
available and will continue to work in the background of the program where
necessary. The main purpose of GES6 is to support faster development of new
features. However, not all GES5 functionality is implemented in GES6. In such
cases (except for the POURBAIX module), GES6 falls back silently and uses
functionality from GES5 in the background.

Getting started with the Pourbaix module
After you enter the POURBAIX_DIAGRAM module, you are asked if you want to have step-bystep instuctions to help walk you through the module.
Need any instruction on the Pourbaix module? /N/: Y

If you answer Y a series of notes are displayed. The following is a more comprehensive
summary of these same notes.
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WHAT IS A POURBAIX DIAGRAM?
The Pourbaix diagram is a calculated equilibrium phase diagram mapped and plotted with
the independently-varied electropotential (Eh, as defined with regard to the standard
hydrogen electrode as its reference) and acidity (pH), that represents all the equilibrated
phase boundaries among aqueous solution, gaseous mixture, and various primary and
secondary solids (modeled as either complex solution or simple stoichiometric phases) in a
certain multicomponent heterogeneous interaction system, under a defined T-P condition
and a specific initial bulk composition (which is, by default, always set as 1 kg of water
dissolving a specified amount of metals/alloys and other acids/alkalines/salts).

WHAT DATABASE SHOULD I USE?
At least one database is required that contains an aqueous solution phase (with
thermodynamic data for water and various aqueous solutes), that shall be selected from
TCAQ (PAQ) or AQS (PAQS) [which use the SIT Model or the Complete Revised HKF Model,
respectively] within the Thermo-Calc databases.

CHOOSING A CUSTOM AQUEOUS SOLUTION DATABASE
You can also use a custom database but it must be in the Thermo-Calc TDB format. Due to
the restrictions of aqueous solution models used within Thermo-Calc, such a database must
be designed in the same format as in the default TCAQ (PAQ2) for aqueous solution phases.
Among other things, keep the following requirements in mind:
The ELECTRON is defined as an special element (ZE) and as the only constituent in its
reference phase REFERENCE_ELECTRODE (for determining the electro-potential that is
defined as Eh with the standard hydrogen electrode as the reference), but it is not defined as
an aqueous species;
The vacancy (VA) is unnecessary for AQUEOUS solution phase and it should be avoided in the
definition of phase-constituents in the AQUEOUS phase;
The AQUEOUS solution phase should always be defined as a constitutional solution phase,
implying that all the aqueous solution species must be included in a single site, rather than
in two or multiple sublattices.
Beside the AQUEOUS solution phase, there shall exist a GAS mixture phase containing at
least H2O1, O2 and H2; and for multicomponent systems, normally there shall also contain
some solid (stoichiometric or solution) phases. Of course, if desired, you could also choose to
calculate and generate a Pourbaix diagram without considering the GAS mixture phase
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entirely; however, such a plot is not really a complete Pourbaix diagram, due to the fact that
thermodynamically-stable phase boundaries between the AQUEOUS solution phase and GAS
mixture phase will then not be calculated at all!
All the required thermodynamic data for calculations of Pourbaix diagrams or other
diagrams must be retrieved either from one (Single) database which consists of an
AQUEOUS solution phase, a GASeous mixture phase, a REF_ELECTRODE phase, and some
SOLID phases (being solutions and/or stoichiometric compounds; for primary metals/alloys
and for secondary products formed from heterogeneous chemical/electrochemical
interactions, or from several (Multiple) databases that respectively contain various
solutions/compounds (as listed above).
Such databases suitable for calculations of aqueous-bearing heterogeneous interaction
systems can be those default-prompted ones [i.e., in the Single-Database case, the PAQ or
PAQS; and in the Multiple-Database case, the PAQ2 or as primarily-switched database, plus
the SSUBx as firstly-appended one and the SSOLx as secondly-appended one if it is necessary;
even more databases can be appended). Of course, you could also choose to append
required data from other appropriate databases (such as TCFE, TCSLD, TCNI/TTNi,
TCAL/TTAl, TCMG/TTMg, TTZr, TCMP, SLAG, etc.) for GASeous mixture phase and for varous
solid solution and stoichiometric compound phases. Furthermore, an experienced user can
also utilize his/her own USER-specified databases in various cases.
The advanced POURBAIX module is designed so that it requires you to just answer some
necessary questions, rather than to go through the other Console Mode modules (i.e., TDB,
GES5, POLY3 and POST) although you still enter commands at the prompts. Beside the
default plotted Pourbaix diagram, it also allows the user to easily and quickly plot many
different properties of the system, stable phases and aqueous species, varied along the
calculated phase boundaries for the same defined heterogeneous interaction system.
Moreover, it permits the user to directly change some plotting settings and manipulate all
kinds of plotted diagrams.
The current advanced POURBAIX-Module has been extended so that it is additionally able to
directly perform a normal STEPPING calculation (varied with a specified independent
variable) and to easily generate various types of property diagrams, for the same
heterogeneous interaction system that has been defined in a previous POURBAIX or TDBGES5-POLY3-POST calculation.

COPY AND RENAME THE POLY3 FILE
At the end of a Pourbaix module calculation, a new POLY3 file is automatically saved.
A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.
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If you are using a POLY3 file more than once (as is done in the extended
examples), it is recommended that you copy and rename the previouslygenerated POLY3 file. This is so that the required POLY3 file structure and
Pourbaix results are not lost. Do this outside of Thermo-Calc i.e. do not save
from within Thermo-Calc.

The reason you do not save from within Thermo-Calc is because of how the file
is saved. When the command sequence (GO POLY3>SAVE <FILE NAME>.POLY3>Y) is
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3
module monitor and all the initial equilibrium points and the mapping/stepping
calculation results are lost as well as parts of the POLY3 file structure (e.g.,
some definitions of the previously defined POURBAIX-type calculation system).

ENFORCE A PAUSE
After the initial set of information is displayed, you are asked:
Enforce a PAUSE after plotting when running a MACRO? /N/
l
l

If you choose Y a pause is always enforced after each diagram is plotted;
If you choose N, all the command-lines (answers) for the session continue without
stopping or until the SET_INTERACTIVE_MODE line in the macro file is reached.

Whenever running a Thermo-Calc macro (TCM) file, you may want to pause after a specific
diagram is plotted on screen. This gives you the flexibility to:
l

Print it (of EMF/PS format) to a printer

l

Convert it (of EMF format) to (PDF) graphical files;

l

Save it as an EMF graphical file;

l

Dump it as a PNG or BMP graphical file;

l

Set background colour for the current diagram

l

You can also set the default font/size and change plot layers for sequential plots.

Pourbaix Main Options
If you answer Y to the Pause prompt above, these options are displayed:
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1. Start a completely new Pourbaix diagram calculation.
2. Open an old file and plot other property diagrams.
3. Open an old file and make another Pourbaix calculation.
4. Open an old file and make another stepping calculation.
POURBAIX_DIAGRAM Commands for Options 1 to 4
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Tabulation Reactions
In this section:
About the Tabulation Reaction Module

115

Tabulating a Reaction

117

Tabulating a Substance or Solution Phase at Fixed Composition

118
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About the Tabulation Reaction Module
The TABULATION_REACTION (TAB) module can be used to tabulate thermodynamic
functions of any type of substance, stoichiometric phase or solution phase, or reaction. The
module can tabulate thermodynamic functions of pure stoichiometric phases or solution
phases at fixed composition, as well as various kinds of partial derivatives for a pure
stoichiometric phase or solution phase at a given composition.
The TAB module begins by evaluating the most stable species of a substance in either a
homogeneous state or in a reaction. Results are presented in a table or plotted as a graph.
Tabulating a Reaction
A reaction tabulation presents you with the following properties, on rows representing
different temperature levels:
l

Heat capacity change / Delta-Cp (Joule/K) in column 2.

l

Enthalpy change / Delta-H (Joule) in column 3.

l

Entropy change / Delta-S (Joule/K) in column 4.

l

Gibbs energy change / Delta-G (Joule) in column 5.

In the case of a tabulation of a substance or solution phase at a fixed composition, the
properties presented are the heat capacity, enthalpy, entropy and Gibbs energy, rather than
the degree of change in those properties.
Tabulating a Substance or Solution Phase at Fixed Composition
You can add a 6th column to the table that shows the values of a property or user-defined
function of your choice.
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Tabulating a Reaction
A tabulation of a given chemical reaction provides you with data about the rate of change of
the standard tabulation properties at various levels of temperature. You can also add a
column for a property of your choice to the table.
1. Use GOTO_MODULE TAB to enter the TAB module.
2. If you want to add one thermodynamic functions to the tabulation calculation, which
is present in a sixth column in the table, use ENTER_FUNCTION.
You are prompted to enter the name of the column that is given at its head, and the
function itself. The following state variables can be used to define the function: G, H,
S, T, P, V and H298.
3. Use TABULATE_REACTION followed by a formula that specifies of the reacting species
and products to perform the tabulation calculation. The name of the elements must
be entered in upper case letters only. Terminate the chemical reaction with a semicolon. For example, you can enter:
TABULATE_REACTION 3H2+N2=2N1H3;

Elements that are designated with a single letter must be followed by a
stoichiometry factor, even if this factor is 1. CO hence be interpreted as Cobalt rather
than as carbon monoxide. Carbon monoxide is entered as C1O1 or O1C1.
4. Set the pressure, the range of temperature that you want the tabulation to cover,
and change in temperature between each row in the table. You can also specify if
you want to output the calculation results to an EXP-file and whether you want any
graphical output, and if so, which column you want to be plotted against
temperature.
The tabulation calculation is performed and you are given a table that shows the
various properties at each temperature level within the range defined.
If you have chosen to receive graphical output, then the Console Results window
presents a graph that plots the column of you chose (on the Y-axis) against
temperature (on the X-axis). When this graph is plotted, you are now in the POST
module, where you can modify the graph in various ways.
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Tabulating a Substance or Solution Phase at Fixed
Composition
A tabulation of a substance or solution phase at fixed composition provides you with data
about the standard tabulation properties at various levels of temperature for a given
chemical reaction. You can also add one extra property column of your choice to the table.

It is important to have already defined the system and retrieved
thermodynamic data from a database before using the TAB command.

1. Use GOTO_MODULE TAB to enter the TAB module.
2. Use SWITCH_DATABASE to switch to a database that contains solution-based data, such
as TCFE for example.
You cannot use the default SSUB database when tabulating solution
phases at a fixed composition.
3. If you want to add one thermodynamic function to the tabulation calculation, which is
present in a sixth column in the table, use ENTER_FUNCTION.
You are prompted to specify the column header and the function itself. The following
state variables can be used to define the function: G, H, S, T, P, V and H298.
4. Use TABULATE_SUBSTANCE followed by the name of the substance or solution phase to
perform the tabulation calculation.
5. Set the pressure, the range of temperature that you want the tabulation to cover,
and change in temperature between each row in the table. You can also specify if
you want to output the calculation results to an EXP-file and whether you want any
graphical output, and if so, which column you want to be plotted against
temperature.
The tabulation calculation is performed and a table shows the various properties at each
temperature level within the defined range.
If you have chosen to receive graphical output, then the Console Results window presents a
graph that plots the column you chose (on the Y-axis) against temperature (on the X-axis). ).
When this graph is plotted, you end up in the POST module, where you can modify the graph
in other ways.
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Results
In this section:
Console Mode Results

120

Using the POST Module

121

Plotting Diagrams

122

Saving and Printing the Output in Console Mode

123

Modifying Diagrams

126

Loading Saved Diagrams

128

Working with the Console Mode Output

129
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Console Mode Results
The results of a calculation in Thermo-Calc can be plotted by the post-processor module,
also called the POST module. The diagram is displayed in the Console Results window.
In the POST module, you can define and plot various kinds of diagrams based on a
calculation. You can modify diagram type, which variables to plot on each axis and between
which minimum and maximum values, append experimental data from an EXP-file, change
labels and symbols in the diagram, zoom in on (and out from) a certain region in a diagram,
etc.
If you calculate a property or phase diagram in POLY, then you have to open the POST
module yourself. If your calculation was performed by a response-driven module such as
SCHEIL or POURBAIX, then the plotting of a diagram based your calculation is part of the
dialogue of questions and answers you have in that module (but under the hood, the
response-driven module is actually utilizing the POST module to get the plotting done).

Example of output to the Console Results window.
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Using the POST Module
Use the POST module after a STEP_WITH_OPTIONS or MAP calculation to generate
graphical or tabulated presentations on screen or into files.
The graphical files are available in different formats (e.g. PS, EMF, PNG, BMP, PDF, JPG, TIF)
or data forms (e.g. EXP, TAB and WRL). The graphical output can be phase diagrams,
property diagrams, diffusion profiles and other types of plots. The tabulated presentation is
into a basic text file (TXT) or a spreadsheet (e.g. an MS Excel file with an extension of .XLS).

The POST module (post-processor) is a submodule to the POLY module and has
its own set of commands. The TAB, BIN, TERN, POT, SCHEIL and POURBAIX
modules use the POST module features as part of the automatic generation of
the plots.

Within the POST module, you can choose any state variable, any derived variable, or any
entered symbol (functions or variable) as the X/Y-axis.
When a diagram is plotted, appearance parameters for defining a high-standard graph can
be further specified, e.g. curve labelling options, diagram titles and subtitles, plot size, axis
length, axis types, axis-tic type, tie-line status, automatic or manual scaling and zooming,
semi-automatic or manual labelling on phase boundaries and phase regions, graphic
formats, text fonts, colours, raster plot, etc.
You can append experimental data onto a plotted diagram. You can also save the
coordinates onto a textual file, which can be edited and used as an experimental data file to
be merged onto another diagram or as a part of a setup file for PARROT-module
assessment.
Phases can be suspended or restored in a plotted diagram. The reference states for
components can also be modified for the resulted diagrams. Moreover, you can translate a
plotted property diagram (after a stepping calculation) into a tabulated form, such as a
simple list on screen or a textual file, and a spreadsheet .
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Plotting Diagrams
Plotting a diagram is to graphically represent how several variables (typically two variables)
co-vary. Each axis in a property diagram or a phase diagram represents the value of one
variable. The default variables represented by the X- and Y-axes are the following:
l

l

If you plot a diagram based on the results of a mapping operation (a phase diagram),
then by default the X- and Y-axes represent the mapping axis variables 1 and 2 (set
using SET_AXIS_VARIABLE in POLY).
If you plot a diagram based on the results of a stepping operation (a property
diagram), then by default, the X-axis represents the stepping variable (set using SET_
AXIS_VARIABLE) and the Y-axis represents the sum of the mole fractions of all phases
(that is, NP(*)).
POLY Module Commands

How to Plot a Diagram
To plot a diagram, you must have already made a stepping or mapping operation in POLY
(or in some cases, made a calculation as part of some opening a response-driven module),
and you must have entered the POST module.
The POST command is available inside POLY. Use POST to enter the POST module
1. If you want to directly plot your diagram with the default variables represented by
the X- and Y-axes, type Plot and press <Enter>. This plots a property or phase
diagram with the default variables represented at each axis. If you do not want to
plot your diagram with these default variables, go to the next step.
2. Use SET_DIAGRAM_AXIS to set which variables to plot on the X-axis and the Y-axis. For
example, if you want to plot a phase diagram with pressure on the Y-axis and
temperature on the X-axis, type:
SET_DIAGRAM_AXIS X T
SET_DIAGRAM_AXIS Y P

3. Use PLOT_DIAGRAM to plot your diagram.
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Saving and Printing the Output in Console Mode
Global Settings: Graphical and Console Mode Plotting

Output can refer to results in the form of tabulated data in a table or a
diagram.

The terms diagram and plot are interchangeable. The commands in Console
Mode generally use the term diagram and in Graphical Mode it is also called a
plot (e.g. the Plot Renderer).

Commands to Save and Print Diagrams
Use the following commands to create diagrams, which then display in the Console Results
window. From this window, you can right-click the diagram and choose Save as or Print. You
can also use the following commands for these actions.

PLOT_DIAGRAM
After you use the SET_PLOT_FORMAT command to define the default graphic device (the
printer) you can use a PLOT_DIAGRAM command to either save the calculation output to a
file or display the output in the Console Results window.

DUMP_DIAGRAM
DUMP_DIAGRAM is an alternative command used to create output. After a diagram is
displayed to the Console Results window with the PLOT_DIAGRAM command, you can save
(dump) it to a file using this command.

MAKE_EXPERIMENTAL_DATAFILE
Use MAKE_EXPERIMENTAL_DATAFILE to save all the data about the plotted diagram in an
EXP-file. An EXP-file is a plain text file that describes the diagram in the DATAPLOT graphical
language. Note that information about the underlying calculations that the diagram is based
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on is not saved in an EXP-file.
DATAPLOT User Guide included with this documentation set.

PRINT_DIAGRAM
First use PLOT_DIAGRAM to create output that displays in the Console Results window. Then
after entering the PRINT_DIAGRAM command, the Print window opens where you can
choose additional settings for a hard copy of the diagram.

Commands to Save Tables
Tables or tabulated data can be listed in the Console window. You then use commands to
save the text to different file formats (txt, html, or xls) where you can then print the
information.
l

LIST_DATA_TABLE: Use this command to output to the screen or to file.

l

TABULATE

Saving Diagrams
You can save the output in a variety of file formats. For JPG and PNG images you can also
adjust the image quality.
In Console Mode, the diagram is output to the Console Results window after
using the PLOT_DIAGRAM command.
In Graphical Mode, the diagram is output to the Results window after
performing a tree that includes a Plot Renderer.
1. In the Results window, right-click the diagram and select Save as.
In the Graphical Mode Configuration window you can also click the Save
Diagram (or Save table) buttons to open the Save window.
2. In the Save window:
a. Navigate to where you want to save the diagram.
b. Enter a File name.
c. From the Files of type list choose png(the default), jpg, ps, pdf, gif, svg, or
emf.
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d. For PNG and JPG files only, under the Image Quality section, choose to
improve the resolution of the image. For JPG files you can also adjust the file
size.
l

l

To change the resolution of a PNG or JPG image, click to clear the Use
screen resolution check box. Then enter a numerical value in the Dots
per inch (DPI) field.
For JPEG files, you can also use the slider to choose a number between
0 and 1 for the JPG quality. The default is 0.9. The lower the number,
the smaller the file.

e. When you are ready, click Save.

Printing Diagrams
In the Console Results window, right-click the diagram and choose Print. Select additional
settings as required on the Print window.
Use the LIST_DATA_TABLE command to save to file and then print the file.
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Modifying Diagrams
Modifying a diagram amounts to changing the settings that determine how the POST
module presents the calculated results and plots a new diagram. Suppose that you have
already plotted a binary phase diagram with the mapping axis variables temperature and
mole fraction of one of your components (the Fe component, say) on the X- and Y-axes. If
you then want to modify your diagram so that the Y-axis instead represents, say, the mass
fraction of Fe rather than the mole fraction, then you use SET_DIAGRAM_AXIS to set
diagram axis Y to w(Fe), and then use PLOT_DIAGRAM.
There are many ways in which you can modify your diagram and how it is presented. Any
modification made in the plot settings is taken into account the next time you use PLOT.

Example Commands
The following are some of the modifications you can make. Use:
l

l

l
l

l

SET_TITLE to set add a title or to change an already existing title. The title is
displayed above the plotted diagram in the Console Results window.
ADD_LABEL_TEXT to add a label text that starts at a certain X- and Y-coordinate. If
you have plotted a phase diagram, then you can let Thermo-Calc set the label text
that specifies the names of the stable phases at that coordinate.
SET_AXIS_TYPE to set whether the scale of an axis is linear, logarithmic or inverse.
SET_DIAGRAM_TYPE to plot a triangular diagram with the X-axis on the triangle’s
base and the Y-axis on the triangle’s left side. Such a diagram is often useful if you
want to plot the fractions of two components in a ternary diagram.
SET_SCALING_STATUS to modify the range of values that are displayed on an axis. In
effect, you can use it to zoom in or out of the diagram. For example, to set the scale
of the X-axis to range from 0 to 0 .3, type:
SET_SCALING_STATUS X N 0 0.3

The X specifies which axis to change the scaling on, the N turns off Thermo-Calc’s
automatic scaling, and 0 and 0.3 specifies the minimum and maximum values on the
scale. You can turn on automatic scaling again by setting the second parameter to Y.
l

SET_LABEL_CURVE_OPTION to label each set of curves that have the same stable
phases with a certain digit. A legend is also added, where you specify which phases
each digit designates.
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LTEXT vs LaTeX Commands for Labels
As of Thermo-Calc 2015a the LTEXT text formatting is replaced by LaTeX. For
existing users who may have plots and files that use the LTEXT format, and
especially when using Console Mode, the following examples show the
command changes from LTEXT and its LaTeX equivalent:
Symbol or Text
Format

LTEXT

LaTeX

Subscripts in an axis text

S-A-TEXT Y N Mole-fraction
Al^DO2$O^DO3$

S-A-TEXT Y N \latex Mole-fraction
Al_2O_3

Label with subscript

add .13 .15 n c-ZrO^DO2$

add .13 .15 n \latex c-ZrO_2

Greek symbol

ADD .05 .50 N ^GRd$

ADD .05 .50 N \latex \delta
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Loading Saved Diagrams
If you have previously saved a diagram in an EXP-file, then you can load and superimpose
the diagram on another diagram. Both the following command requires you to specify which
prologue and dataset(s) that are loaded from an experimental data file.
Use APPEND_EXPERIMENTAL_DATA to plot selected data from an experimental data file
(EXP-file). If you have set the axes of the diagram already, the labels on the diagram are not
changed when you plot the additional data from the EXP-file, irrespectively of the data in
that file.
Use QUICK_EXPERIMENTAL_PLOT to plot selected data from an experimental data file (EXPfile). If you have set the axes of the diagram already, these settings are overwritten with the
axes settings from the EXP-file.
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Working with the Console Mode Output
Pause, Resume or Stop Output to the Console Window
In response to a command or a lengthy calculation, Thermo-Calc may display a lot of text in
the Console window. Use these keyboard shortcuts to pause, resume or stop a process.
l

To pause the text on printing press <Ctrl+S>.

l

To resume the printing on screen, press <Ctrl+Q>.

l

When Thermo-Calc is performing a stepping or mapping operation, the results are
continuously printed in the Console window. To stop the calculation of the current
region of the mapping and stop the output, press <Ctrl-A> (Windows) or <Ctrl-C>
(Linux).

Controlling Console Output
In response to a command or a lengthy calculation, Thermo-Calc may display a lot of text in
the Console window. Use these keyboard shortcuts to pause, resume or stop a process.
l

To pause the text on printing press <Ctrl+S>.

l

To resume the printing on screen, press <Ctrl+Q>.

l

When Thermo-Calc is performing a stepping or mapping operation, the results are
continuously printed in the Console window. To terminate the calculation of the
current region of the mapping and stop the output, press <Ctrl-A> (Windows) or
<Ctrl-C> (Linux).

In Console Mode, sometimes the output overflows the window text buffer. This is how to
increase the buffer size.
1. Right-click the Console tab header in the Console window (if this is the first Console tab,
it is labeled Console 1).
2. Click Properties, and increase the Buffer size in the Console Properties window.
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Commands by Module
In this section:
System Utilities (SYS) Commands

132

Database (TDB) Module Commands

156

POLY Module Commands

171

Gibbs Energy System (GES) Commands

273

SCHEIL Module Commands

330

PARROT Module Commands

344

EDIT_EXPERIMENTS (ED_EXP) Submodule Commands

390

Tabulation Reaction (TAB) Commands

446

REACTOR (REACTOR_SIMULATOR) Commands

473

POST Module Commands

484
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System Utilities (SYS) Commands
In this section:
ABOUT

133

BACK

134

CLOSE_FILE

135

DISPLAY_LICENSE_INFO

136

EXIT

137

GOTO_MODULE

138

HELP (? and ??)

139

HELP

140

HP_CALCULATOR

141

INFORMATION

142

MACRO_FILE_OPEN

143

OPEN_FILE

146

SET_COMMAND_UNITS

147

SET_ECHO

148

SET_GES_VERSION

149

SET_INTERACTIVE

150

SET_INTERACTIVE_MODE

151

SET_LOG_FILE

152

SET_PLOT_ENVIRONMENT

153

SET_TC_OPTIONS

154

STOP_ON_ERROR

155
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ABOUT
The ABOUT command lists basic information about the development history and ownership of
the Thermo-Calc software as well as version information.
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BACK
GOTO_MODULE.
Use the BACK command to switch control back to the most recent module. Going from the
POST module, BACK goes only to the TAB or POLY module (from where the POST module is
entered).
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CLOSE_FILE
Close an opened text file.
Syntax

CLOSE_FILE
Unit number: <Unit number>

Prompt

A unit number given in an OPEN_FILE command must be specified.
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DISPLAY_LICENSE_INFO
You can also access this same information from the top menu. Choose Help →
Show License Info.

Use this command to launch a license diagnostics program implemented in the SYS module.
It detects the license information for the Thermo-Calc installations on the current client
computer (and on the connected license server), and lists the details, including the current
status of available license file and all its included license features for the current installation
(s), as well as the Safenet Environment Variables and detailed Local (Client) Information, on
screen or into a textual file (*.TXT).
This is useful for a list of license details, and to obtain basic technical support by sending the
*.TXT file to support@thermocalc.com. If you are running a network client installation of
Thermo-Calc, you can see how many of the client example licenses that are currently
checked out and how many of them are left. You can also see which clients computers it is
that have checked these client example licenses out.
Syntax

DISPLAY_LICENSE_INFO
Output to screen or file /Screen/: <Mylicenseinfo.txt>

Prompt Press <Enter> to display a list of license information or into a *.TXT file under a specific file name
which can later on be opened and edited by any basic text editor.
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EXIT
Use the EXIT command to leave the program and return to the operating system. Use a SAVE
command before exiting otherwise all data and results are lost (in either the GIBBS, POLY,
PARROT or REACTOR module).
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GOTO_MODULE
Switch between modules. The name of the module must be typed. To get a list of available
modules, press the <Enter> key.
Syntax

GOTO_MODULE

Prompt Module name: <Module name>
If the <Enter> key is pressed without typing a unique module name (or typing a ? mark) it prompts
for the MODULE NAME and lists the available modules.
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HELP (? and ??)
Enter ? or ?? to get text help about the current prompt (whether this is the prompt of a
module, or a prompt that requests you to specify the value of some parameter).
For some commands and prompts, more detailed help is given when two ?? are
entered.
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HELP
Lists the available commands or explains a specified command. Specifying a unique
command displays an explanation on screen. Typing a command abbreviation that is not
unique lists all matching commands. Get the command information by typing a unique
abbreviation or the complete command name.
Syntax

HELP
Command: <Command name>

Prompt

Command name is the name of the command (one of the-module commands) to get help.
If the <Enter> key is pressed without typing a command name, then all the available commands
are listed.
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HP_CALCULATOR
The HP-CALCULATOR commend is the QBA simple interactive calculator using reverse Polish
notations.
Available OPCODEs (HPC codes) are listed by entering the command HELP.
Use the BACK command to quit and go back to the SYS module.
Input are numbers, + - * / and ^ and OPCODEs. Several numbers an operations can be given
on one line. The content of the X register is displayed after each operation.
For example, to compute 2*EXP(1.5**3-30000/(8*1273)), you should input the following:
30000 8/1273/chs 1.5 3 ^ + exp 2 *
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INFORMATION
Get basic information about topics related to the module you are in.
Syntax

INFORMATION
Which subject /Purpose/: <Topic name>

Prompt Specify a subject (or its abbreviation as long as it is unique). Enter a question mark ? for a list of
topics.
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MACRO_FILE_OPEN
Some of the information in this topic is related to the add-on Diffusion Module
(DICTRA).
The macro file functionality is a way to predefine sequences of Thermo-Calc commands
stored in a macro file (a basic text file usually with the default extension *.TCM or*.DCM for
DICTRA) and then executing all of the sequences using this command (preceded by the
macro file name). This command can be used within various modules (i.e. SYS, POLY,
PARROT, TAB and DICTRA_Monitor).
Syntax MACRO_FILE_OPEN
<Name of a macro file *.tcm>

An Open window displays to specify the filename of the macro file (*.TCM) with the macro
command, so that the path (in the Look in field) and File name can be specified.
The Files of type *.TCM for Thermo-Calc (Console Mode) calculations and *.DCM for DICTRA
simulations, cannot be changed. Click Open or Cancel to continue.
A window such as Save, Open, or Print opens if the macro file contains commands to:
l

set log files (these have a file extension .TCM)

l

save or read GIBBS, POLY or PARROT workspaces

l

switch user databases

l

compile experiments (from existing *.POP files)

l

create new *.PAR files

l

append *.EXP files

l

plot diagrams, etc.

If required, opening these windows can be avoided by issuing the file names (preferably with filetype extensions; if the files are not in the current working area where the macro is located, the
appropriate and complete paths of the files should also be specified) and sometimes with the
required options after the corresponding commands or parameters/options.
For details, see the related commands and modules.
When using a macro file that intended to plot graphs on screen, but the command SET_PLOT_
FORMAT is used to alter the plotting environment from the default value, it is important to first use
the command SET_PLOT_FORMAT again to change back to the default value.

This is useful when the same or similar calculations are made frequently with small changes
[in terms of system definitions, data manipulations, conditions (for single points, stepping or
mapping calculations), plotting settings, etc.). For example, use this feature when calculating
phase/property diagrams during an assessment of thermodynamic data.

Thermo-Calc User Guide: Console Mode ǀ 143 of 643

Thermo-Calc Documentation Set

A macro file can be automatically generated in Console Mode if in the SYS module the SET_
LOG_FILE command is used and a log file name (with a file extension *.TCM) is given before
any other SYS, DATA, TAB, GIBBS, POLY, POST, PARROT, or ED-EXP command or any specialmodule command (e.g. BIN, TERN, POTENTIAL, SCHEIL, POURBAIX, or REACTION). Such a log
file generated in Console Mode is a text file. You can use a text editor (such as Notepad++)
to remove unnecessary command lines, modify some commands, settings and definitions,
add some pause points, add comment lines that start with @@, and so forth. Then save it as a
macro file with the standard file extension TCM.
Experienced users can also write/edit an appropriate macro file for calculations/simulations,
using any basic textual editor outside the Thermo-Calc program.
All commands can be used in a macro file.
The file can be terminated with EXIT or interrupted with SET_INTERACTIVE.
Within a macro file you can use comment-lines (for describing the problems and for
explaining commands and inputs/outputs), which should always start with the @@ signs in
the beginning of each comment-line. Such comment-lines help to document the macro file,
while these are not considered as command lines and thus do not affect the proceeding of
all the normal commands in modules when the file is called by Thermo-Calc.
You can put multiple-line comment-blocks in a macro file between the @ (” and “@)” signs.
The former sign indicates where the comment begins and the latter sign indicates where the
comment ends. A comment-block begins from a line started with the begin comment sign @
(and ends with the finish comment sign @); all the lines written in between are ignored, and
the line started with @) is also ignored.
Another use for a macro file is to allow you to interact at some specific points, using the
“@?” sign starting a text line (note that the text describing the expected userspecification/input should be written as a continuous string without any empty space), for
user’s on-time specifications of arguments/parameters or inputs of parameter-values that
are requested by a certain command. The macro temporally stops at the “@?” sign, prompt
on screen the text given after “@?”, and waits for the specified argument/parameter/value.
Thermo-Calc then uses specified argument/parameter/value as the input(s) for the
associated command. For example, you can input the values of lower and higher
temperature limits for the second axis-variable as follows:
GO POLY-3
SET-AXIS-VAR 2 T

@?Low-temperature-limit:

@?High-temperature-limit:
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You can have macro-variables denoted by the signs of @#n (for definition) and ##n (for
usage); and up to nine variables inside a single macro file. Such a macro-variable can be
assigned with its desired value, as for example:
@#3First-element?

This writes the text (note that the text describing the expected user specification/input is
written as a continuous string without any empty spaces) after the “@#3” sign as prompted
on screen and then wait for a specification. The input is assigned to the macro-variable ##3,
which is directly called in different parts within the current macro file.
For example, the content of the macro-variable ##3 is inserted in the command:
DEFINE-SYSTEM ##3

It is also useful in more complicated commands, such as:
SET AXIS VAR 1 x(##3) 0 1,,,

This command sets the mole fraction of macro variable 3 as axis 1.
A macro file can have any number of pauses at the @& signs, for the purpose of checking the
details/results of executing certain commands when running the macro file. However, you
can also prevent the software from temporarily stopping at any pause by typing any
character (except for the Y character for confirming a Yes answer to a command prompt)
after specifying the name of a macro file.
A macro file can have a maximum of five nested levels, i.e. a macro file can call another
macro file, and if one sub-level macro is terminated by the command it resumes at the next
command in the previous macro. If it is terminated by end-of-file, the Thermo-Calc
(Console Mode) software stops.
This feature is especially useful for alloy design that requires many (hundreds) of
calculations/simulations on similar material system/processes (specified in many different
but appropriately-documented macro files that are organized in up to five levels) during a
certain period of time (e.g. in an evening), you can run the main macro (on the top level) at
a certain time (e.g. before leaving the office) and afterwards (e.g. next morning) you can
systematically and efficiently check/compare/analyse the results (saved as graphical files,
and/or EXP, TXT, XLS… files).
By adding the SYS command SET_ECHO at the beginning of a macro file (or in the primary
macro file on the top level if any sub-level(s) of macro files are used), it is useful to
automatically display the complete/detailed meaning of various commands in all the
sequential operations in the software, all enforced according to the macro file(s).
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OPEN_FILE
A text file is opened for use in other commands where a unit number is necessary. The
program automatically assigns a unit number.
Syntax

OPEN_FILE
File name: <File name>

Prompt

A legal file name must be specified.
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SET_COMMAND_UNITS
This command is useful for reading inputs already prepared by a textual editor on a file.
Such inputs can be a table of values or a large number of parameters. The file must be
opened with OPEN_FILE.
The first two lines of an input file are skipped before any input is read.
Syntax

SET_COMMAND_UNIT
Input unit number /5/: <Input unit number>

Specify the input unit number returned from an OPEN_FILE command. The next command is taken
Prompt from the file connected to this unit number. The last command on such a file must be EXIT or SET_
INTERACTIVE when you are in POLY, POST or SYS module, in order to go back to read input from the
keyboard. The default value is the current input unit.
Output unit number /6/: <Output unit name>

Specify the output unit number returned from an OPEN_FILE command.
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SET_ECHO
This command is not applicable if macro files are not used.
Add the SET_ECHO command at the beginning of a macro *.TCM file (or to the primary
macro file on the top level if any sub-level(s) of macro files are used).
Automatically displays on screen the complete details of various commands in all the
sequential operations in the software, that are enforced according to the macro file(s).
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SET_GES_VERSION
This command enables switching between the two versions of the Gibbs Energy System (GES)
calculation engine. As of Thermo-Calc version 2019b, GES6 is the default. Also see About the
Gibbs Energy System (GES) Module.

GES6 is a re-write and new implementation of the Gibbs Energy System module
of Thermo-Calc and it is the default engine. The previous version, GES5, is still
available and will continue to work in the background of the program where
necessary. The main purpose of GES6 is to support faster development of new
features. However, not all GES5 functionality is implemented in GES6. In such
cases (except for the POURBAIX module), GES6 falls back silently and uses
functionality from GES5 in the background.

Syntax

SET_GES_VERSION
USE GES VERSION 5 OR 6 /6/:

Prompt The default is version 6. If you change the version to GES5, it is set for the current session of
Thermo-Calc only. If you launch a new Console window, the version resets to GES6.

To globally set the default from GES6 back to GES5, go to the Tools → Options →
General tab and click Version 5 for the Preferred Gibbs Energy System setting. This is
useful if you are using the PARROT module (optimization) or if you have a custom
database that is not compatible with GES6.

Contact Thermo-Calc Software AB at info@thermocalc.com for more
information about the changes or if you encounter any issues you think are
related to the new version of the calculation engine.
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SET_INTERACTIVE
Use the SET_INTERACTIVE command to reset the input and output units to the initial values,
i.e. keyboard and screen. Add this as the last command to the macro files.
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SET_INTERACTIVE_MODE
Use the SET_INTERACTIVE_MODE command to reset the input and output units to the initial
values, i.e. keyboard and screen.
Remember to add this as the last command to your macro files, in order to stop
execution of the command file in the POST module. It has no meaning in
interactive mode.
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SET_LOG_FILE
Use it to save, in a basic text file, everything typed into Thermo-Calc. When having problems
executing a command sequence, this command can be used to save the command typed
onto a log file with the file extension *.TCM.
This command also makes the system echo the full command for all commands typed. This
feature is useful when demonstrating the system since the abbreviated commands are often
difficult.
The saved log file can then be edited as a macro file by using a basic text editor. This is
useful to run the macro file(s) for similar calculations (the same system but slightly varied
temperature-pressure-composition conditions), or run the example macro files.
Macro Files
Syntax

SET_LOG_FILE

A Save window opens to specify a file name for the *.TCM file, so that the path (in the Save in field)
and File name can be specified. If a log file with the same name exists in the current working
Prompt
directory, it is overwritten. The Files of type (i.e. TCM) cannot be changed. Click Save or Cancel as
applicable.
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SET_PLOT_ENVIRONMENT
Use this command to set the plot devices to save or print plots to, which varies for by
installation type.

This command must be terminated with an empty line or two commas.

Syntax

SET_PLOT_ENVIRONMENT
Default plot device number /Default number/: <Device number>

Prompts The number given is unique for each type of graphical device. The default graphical device
number should normally be selected. A question mark ? gives you a list of all available graphical
devices used.
Pseudo file name: <Pseudo-file name>

The name given here is a symbol which can be used to refer to a physical graphics device when
asked for graphical output file.
Plot device number /1/: <Device number>

The number that specifies the type of graphical device.
Plot file name: <File name or printer name>

The name of the graphical device on system level (name of file or printer).

Example
SET_PLOT_ENVIRONMENT 1 lasp 5 a0tr,,

This example sets the default plot device number to 1, and defines an alias named lasp with plot
device 5 and connected to a printer named a0tr.
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SET_TC_OPTIONS
Predefine the default values of three general options for performing all the sequential
single-points, stepping and mapping calculations.
Syntax

SET_TC_OPTIONS
Use_global_minimization /Y/:

By default it global minimization is used where possible (depending on the conditions setting). A
Prompts global minimization test is performed when an equilibrium is reached. This costs more computer
time but the calculations are more robust. Enter N to prevent global minimization being used to
reach the equilibrium.
Global_test_interval /0/: <An integer value>

The integer number determines how often the global minimization should be used during
calculations with STEP_WITH_OPTIONS and MAP. If it is set to 0 (zero), the recommended global test
interval is used: i.e. every tenth step and at each phase change during step calculations, and only
at node points during map calculations. Any other positive integer number, n, suggests it performs
global minimization tests at every nth step during step and map calculations. Of course, the Global
Minimization test is always carried out at a phase change or a node point. The software is initially
configured with 0 (zero) as the default value, but such a configuration for the default value can be
changed by this option.
Automatically_add_initial_equilibria /Y/:

When ADD_INITIAL_EQUILIBRIUM is not used before a map calculation, a mesh of INITIAL_
EQUILIBRIUM is automatically added before the mapping procedure itself takes place. This mesh is
only available when the two independent axis-variables have already been defined by the POLY
command.
Set_axis_variable

If Y is entered, the POLY module always enforces the automatic procedures for adding initial
equilibrium points during mapping. For N, no initial equilibrium points are then added during
mapping.
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STOP_ON_ERROR
Useful for batch jobs in order to prevent that an erroneous sequence of commands to the
program causes waste of computer activity.
Syntax STOP_ON_ERROR
Give the preferred argument (ON or OFF) after the STOP command. If the default argument ON is
given, the program terminates after an illegal or ambiguous command. It is possible to reset the
effect of this command by giving the argument OFF.
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Database (TDB) Module Commands
These commands are related to the DATABASE_RETRIEVAL module, which is
also known as the TDB module.
Search the online help for step-by-step instructions to define a system.
In this section:
AMEND_SELECTION

157

APPEND_DATABASE

158

DATABASE_INFORMATION

159

DEFINE_ELEMENTS

160

DEFINE_SPECIES

161

DEFINE_SYSTEM

162

GET_DATA

163

LIST_DATABASE

164

LIST_SYSTEM

165

REJECT

166

RESTORE

168

SET_AUTO_APPEND_DATABASE

169

SWITCH_DATABASE

170
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AMEND_SELECTION
This command is for the DATABASE_RETRIEVAL (TDB) module.
Use this command after defining the elements, species or the system (with the commands
DEFINE_ELEMENTS, DEFINE_SPECIES, or DEFINE_SYSTEM). The prompts allow changes to the
predefined system. By answering Y or N, each of the selected elements, species or phases
can be accepted or rejected (although this is not the case for the constituents or the entire
system).
Syntax
Prompt

AMEND_SELECTION
Keep <Name1> No/Quit/Yes/
Keep <Name2> No/Quit/Yes/
Keyword-- Elements/Species/Phases name&

Options

Names of the pre-defined or pre-selected elements/species/phases
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APPEND_DATABASE
This command is for the DATABASE_RETRIEVAL (TDB) module.
Appends data to the current set of data already read from another database. The syntax is
the same as for the SWITCH_DATABASE command.
This command enters all additional functions and parameters to already existing phases, e.g
atomic mobilities, phase constituents, excess models, G0 and interaction parameters.
This command is most commonly used to read mobility data from stand-alone mobility
databases.
This command should be used with some caution if thermodynamic data is appended and
the application is run with Gibbs Energy System version 5 (see SET_GES_VERSION in the SYS
module). It can change calculated values in an unexpected way. This can happen e.g. if the
appended database has the same function name as a function in the data retrieved from a
database opened with SWITCH_DATABASE.
Syntax

APPEND_DATABASE
New database name /XYZ/:

Prompt

The name of either an existing database (e.g. FEDEMO) or USER.
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DATABASE_INFORMATION
This command is for the DATABASE_RETRIEVAL (TDB) module.
Use the DATABASE_INFORMATION command to obtain a short description of the current
database. This can include information on covered systems, used models, valid ranges for
parameters in temperature and composition, major applications, and so on.
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DEFINE_ELEMENTS
This command is for the DATABASE_RETRIEVAL (TDB) module.
Define the system in terms of elements. All possible species that can be formed by the given
elements are retrieved from the database. The names of elements must be separated with a
space or comma. It is possible to use a wildcard * after a common part of element names so
that all the elements, which start with that common part and are available in the currently
switched or appending database, are defined in the system. Up to 40 elements can be
defined into a single system.
Also see Defining a System in Console Mode for step-by-step instructions to
define a system with this command.
Syntax

DEFINE_ELEMENTS
Element& <Element1, Element2, …>

Prompt

A list of elements to be defined into the system.
When appending database(s), this command, or DEFINE_SPECIES or DEFINE_SYSTEM
must be repeated with the same or similar elements as defined in the first switched
database.
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DEFINE_SPECIES
This command is for the DATABASE_RETRIEVAL (TDB) module.
Define the system in terms of species. Only those species given are retrieved. The different
names of species must be separated with a space or comma. It is possible to use a wildcard
* after a common part of species names so that all the species, which start with that
common part and are available in the currently switched or appending database, are
defined in the system. Up to 1000 species can be defined in a single system.
Defining a System in Console Mode
Syntax

DEFINE_SPECIES
Species& <Species1, Species2, …>

Prompt

A list of species to be defined in the system.
When appending database(s), this command, DEFINE_ELEMENTS or DEFINE_SYSTEM
must be repeated with the same or similar elements as defined in the first switched
database.
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DEFINE_SYSTEM
This command is for the DATABASE_RETRIEVAL (TDB) module.
Define the system in terms of either elements (equivalent to DEFINE_ELEMENTS) or species
(equivalent to DEFINE_SPECIES). Certain databases have a default value of the keyword (as
either ELEMENTS or SPECIES) reflecting what is most appropriate when defining a system.
The different names of elements or species must be separated with a space or comma. It is
possible to use a wildcard * after a common part of elements or species names so that all
the elements or species, which start with that common part and are available in the
currently switched or appending database, are defined in the system.
When appending database(s), this command (or DEFINE_ELEMENTS or DEFINE_SPECIES) must
be repeated with the same or similar elements as defined in the first switched database.
Different databases might contain different elements and have different species definitions:
avoid defining elements/species that are missing in the appending database(s). Otherwise,
the program indicates these missing elements/species, and ignores them in subsequent
steps. But additional elements/species, and additional phases not available in the first
switched database can be defined and retrieved from the appending database(s). Up to 40
elements and 1000 species can be defined in a single system.
Also see Defining a System in Console Mode for step-by-step instructions to
define a system with this command.
Syntax
Prompt

DEFINE_SYSTEM
Elements: <Element1, Element2, …>, or
Species: <Species1, Species2, …>

Options

Description

Species or Elements

Default keyword.

Element&

Specify a list of elements for the defining system.

Species&

Specify a list of species for the defining system.
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GET_DATA
This command is for the DATABASE_RETRIEVAL (TDB) module.
Enter the defined system’s elements, species, phases, and the connected parameters
obtained from either the primary switched or additionally appending database(s) to the
GIBBS and/or DICTRA workspace. Then use the GET_DATA command to get all information
concerning a defined system from the databank.
Only after executing this command can you go to any of the application
programs such as GES, POLY or DICTRA and use the retrieved data. When
appending database(s), this command must be repeated in order to obtain the
additional system definitions, parameters and functions.
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LIST_DATABASE
This command is for the DATABASE_RETRIEVAL (TDB) module.
List all elements, species, phases or phase constituents in the database.
Syntax

LIST_DATABASE

Options

Description

Keyword

One of the keywords Elements, Species, Phases or Constituent must be used to indicate what
to list

Elements

All available elements, the reference state, atomic mass, H298-H0 and S298. Some elements
have spaces in the column for the reference state. This implies that there are no parameters
stored for this element.

Species

All available species together with the stoichiometric factors.

Phases

All available phases together with the number of sublattices and the number of sites in each
sublattice.

All available phases, the number of sublattices, the number of sites in each sublattice and the
species dissolved in each phase. Species in different sublattices are separated with a colon (:).
It is important to realize, for example, a phase can consist of Fe, Mo, V, and Cr, and its
thermodynamic parameters can come from the binary systems Fe-Mo, Fe-V, Fe-Cr, and MoConstituent
Cr. These data can give a relatively good description of the corners of the Fe-Cr-Mo system,
but would most certainly give a bad one for the system Mo-Cr-V, due to the fact that the
interaction parameters are, by default, set to zero, which originates from binary systems not
included in the database.
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LIST_SYSTEM
This command is for the DATABASE_RETRIEVAL (TDB) module.
List all elements, species, phases or phase constituents in the defined system. It works only
after a system is defined.
Syntax

Keyword

LIST_SYSTEM

One of the keywords Elements, Species, Phases or Constituent must be used to indicate what to
list.
LIST_DATABASE
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REJECT
This command is for the DATABASE_RETRIEVAL (TDB) module.
Reject elements, species, phases or phase constituents that can form from the defined
elements and species. Phases/species/constituents that are possible to form in the defined
system are removed from the list of system phases/species/constituents (shown by the
command LIST_SYSTEM). Phases/species/constituents that are not included in the list cannot
be entered without first being restored. The different names must be separated with a space
or comma. You can use a wildcard * after a common part of names so that all the
elements/species/phases/constituents that start with that common part and are available in
the currently switched or appending database, are rejected from the defined system.
This command can also reject a defined system, and thus reinitiate the entire DATA module
memory and GES workspace.
Syntax
Prompt 1

REJECT

(Keyword = Elements or Species or Phases)
If keyword: <Name1, Name2, …>

(if keyword = Constituent)
Prompt 2

Phase: <Phase name>
Sublattice number: <Sublattice number in the phase>
Constituent: <Constituent(s) in the sublattice of the phase>

Prompt 3

If keyword = SYSTEM the DATA module is reset to its initial state; GIBBS is reinitiated and data
already entered to GES is lost.

Options

Description and additional information

Keyword

One of the keywords Elements, Species, Phases, Constituent or System must be used to
indicate what is rejected.

Name&

Names of the pre-defined elements/species/phases/constituents/system

Elements

The given elements are rejected.

Species

The given species are rejected, making it impossible to form them from the defined elements.

Phases

The given phases are rejected, making it impossible to form them from the defined elements
or species.
The given constituent in one phase are rejected. Add the following when prompted:

Constituent

Phase:

The name of the phase containing the constituent to be rejected.

Sublattice number:

The sublattice where the constituent enters (the first sublattice is 1). The
question is omitted if there exists only one possible sublattice.
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Syntax

REJECT
Constituent:

The name(s) of the constituent(s) to be rejected.
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RESTORE
This command is for the DATABASE_RETRIEVAL (TDB) module.
Restore already explicitly rejected elements, species, phases or constituents; it is the
opposite of the command REJECT although it does not restore a completely rejected system.
Phases/species/constituents that are possible to form from the defined elements or species
are entered to the list of system phases/species/constituents (shown by the command LIST_
SYSTEM). Phases/species/constituents that are not included on the list can now be added to
the list. The different names must be separated with a space or comma. It is possible to use
a wildcard * after a common part of names so that all the
elements/species/phases/constituents, which start with that common part and are available
in the currently switched or appending database, are restored in the defined system.
Syntax
Prompt1

RESTORE

(if keyword = ELEMENTS or SPECIES or PHASES)
Keyword: <Name1, Name2, …>

(if keyword = CONSTITUENT)
Prompt2

Phase: <Phase name>
Sublattice number: <Sublattice number in the phase>
Constituent: <Constituent(s) in the sublattice of the phase>

Options

Description and Information

Keyword

One of the keywords Elements, Species, Phases or Constituent must be used to indicate what
is rejected.

Name&

Names of the pre-defined elements, species, phases, and constituents

Elements

The given elements are restored.

Species

The given species are restored and thus possible to form from the defined elements.

Phases

The given phases are restored and thus possible to form from the defined elements or
species.
The given constituent in one phase are restored.
Add the following when prompted:

Constituent

Phase:

The name of the phase containing the constituent to be restored.

Sublattice number:
Constituent:

The sublattice where the constituent enters (the first sublattice is 1).

The name(s) of the constituent(s) to be restored.
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SET_AUTO_APPEND_DATABASE
This command is for the DATABASE_RETRIEVAL (TDB) module.
Enforce an automatic action that appends thermodynamic data from a chosen database
regarding the system to the data you already have about the system from the current
database (that is, the default database or the database last chosen with SWITCH_DATABASE or
APPEND_DATABASE).
This is useful to simultaneously retrieve both thermodynamic and mobility data
for a defined system when performing a DICTRA module simulation.
This command should be used before defining a system (with the commands DEFINE_
ELEMENTS, DEFINE_SPECIES, or DEFINE_SYSTEM) and retrieving the data with the GET_DATA
command from the primary switched database.
Syntax

SET_AUTO_APPEND_DATABASE

Prompt

Database name /XYZ/: <Additional database name>
Additional database name

Option

The name of an existing database or a User database that corresponds to the
automatically-appending database.

It works in a way that is similar to the APPEND_DATABASE<DATABASE-NAME> command
sequence, but only the phases that are also available in the primary switched database are
appended. There is no possibility to manually list, reject and/or restore any phase that is
available in the appending database. When retrieving data with GET_DATA afterwards, all the
phases that exist in the appending database but not in the primary switched database are
automatically rejected. The prompt is kept as for the primary switched database, TDB_XYZ:
(where XYZ stands for the name of the primary switched database) until the execution of
GET_DATA.
Therefore, to selectively append more phases from a secondary database to a system that is
defined and retrieved from a primary switched database, then APPEND_DATABASE and
sequential commands (such as DATABASE_INFORMATION, DEFINE_SYSTEM, DEFINE_ELEMENT,
DEFINE_SPECIES, LIST_SYSTEM, REJECT, RESTORE and GET_DATA) should be used instead, before
this command.
Although it is impossible to manually list, reject and restore any phase from the appending
database, the DATA module automatically ignores all the phases that do not exist in both the
primary switched database and the appending database, and append the data for the phases
(that are also available in the primary switched database) from the appending database, as
informed on screen when executing GET_DATA afterwards.
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SWITCH_DATABASE
This command is for the DATABASE_RETRIEVAL (TDB) module.
Switch (or change) from the current database to a new one. It also reinitializes the entire
module.
The database can be either a standard database (the ones in tc_initd.tdb) or a so-called
user database. To open your own (user) database, type USER followed by the path to the
user .TDB file or press <Enter> and select it in the window that opens.
Syntax

SWITCH_DATABASE
New database name /XYZ/:

Prompt

The name of either an existing database (e.g. FEDEMO) or USER.
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POLY Module Commands
In this section:
ADD_INITIAL_EQUILIBRIUM

175

ADVANCED_OPTIONS

178

AMEND_STORED_EQUILIBRIA

179

CHANGE_STATUS

181

COMPUTE_EQUILIBRIUM

186

COMPUTE_TRANSITION

188

CREATE_NEW_EQUILIBRIUM

190

DEFINE_COMPONENTS

191

DEFINE_DIAGRAM

192

DEFINE_MATERIAL

195

DELETE_INITIAL_EQUILIBRIUM

199

DELETE_SYMBOL

200

ENTER_SYMBOL

201

EQUILIBRIUM_CALCUL

204

EVALUATE_FUNCTIONS

206

GLOBAL_MINIMIZATION

207

KEEP_COMP_SET_NUMBERS

209

LIST_AXIS_VARIABLE

210

LIST_CONDITIONS

211

LIST_EQUILIBRIUM

212

LIST_INITIAL_EQUILIBRIA

213

LIST_PHASE_ADDITION

214

LIST_STATUS

215
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LIST_SYMBOLS

216

LOAD_INITIAL_EQUILIBRIUM

217

MAKE_COMPONENT_ENTERED

218

MAKE_COMPONENT_SUSPENDED

219

MAJOR_CONSTITUENTS

220

MAP

221

NEW_COMPOSITION_SET

223

OUTPUT_FILE_FOR_SHOW

225

PARAEQUILIBRIUM

226

PHASE_ADDITION

229

POST

230

PRESENT_PHASE

231

READ_WORKSPACES

232

REINITIATE_MODULE

233

SAVE_WORKSPACES

234

SELECT_EQUILIBRIUM

236

SET_ALL_START_VALUES

237

SET_AXIS_VARIABLE

239

SET_CONDITION

241

SET_INPUT_AMOUNTS

244

SET_INTERACTIVE

245

SET_NUMERICAL_LIMITS

246

SET_REFERENCE_STATE

248

SET_START_CONSTITUTION

250

SET_START_VALUE

251

SHOW_FOR_T=

252
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SHOW_VALUE

253

STABILITY_CHECK

254

STEP_AND_MAP

255

STEP_WITH_OPTIONS

257

TABULATE

270

TOGGLE_ALTERNATE_MODE

271

T-ZERO_TEMPERATURE

272
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ADD_INITIAL_EQUILIBRIUM
This command is for the POLY module.
Add initial equilibrium points from which a phase diagram is calculated (through the MAP
command).
For each initial equilibrium the first stage of the mapping varies the value of the given axis
variable condition, changing it in the given direction. When a phase change is found it is
saved as a start equilibrium, and if the symbol ">" was used, it continues the search until the
end of the axis variable.

If no axis variable conditions differ between initial equilibria then the map
results in several overlaid diagrams, in accordance with the selected conditions
and the values.

The ADD_INITIAL_EQUILIBRIUM default command implicitly makes the MAP command search
for phase changes according to settings set by ADVANCED_OPTIONS STEP_AND_MAP
command. Default for STEP_AND_MAP are three initial equilibrium equidistantly along each
axis variable, along the edge of the axis variable rectangle.
By default these default start points are used in MAP. If any ADD_INITIAL_EQUILIBRIUM is used
these default start points are not used. They are again used if the command ADD default is
used together with another ADD_INITIAL_EQUILIBRIUM command.
The ADD command with the default direction scans along the axis variables and generates
start points each time the scan procedure crosses a phase boundary. In addition, it generates
four start points, scanning cross the middle of each axis, if there is any solubility line that
does not reach the axes. At the MAP command, a search for lines in the diagram is made
along each direction of the axis variables in the diagram.
In this way, it should guarantee that all possible phase boundary lines in a phase diagram
are found. It may take a little longer to execute than using the minimum number of start
points, as some lines may be calculated more than once. But the POLY module remembers
all node points and subsequently stops calculations along a line when it finds a known node
point.
It is also possible to create a sequence of start points from one initial equilibria by
appending a > after the direction at the ADD command. For example:
Direction /Default/: 2>
Direction /Default/: -2>

Thermo-Calc User Guide: Console Mode ǀ 175 of 643

Thermo-Calc Documentation Set

This generates one start point for each set of phase change in the positive direction of the
axis 2 (or negative direction of the axis 2); this ensures finding all possible phase boundary
lines (not just the first one) along such an axis direction.
This is particularly useful when you have a phase diagram with several lines with no
intersection. It is thus possible to calculate e.g. an isopleth for a much more limited
composition range. It is also useful for calculating CVD diagrams and Pourbaix diagrams.
Syntax

ADD_INITIAL_EQUILIBRIUM
Direction /Default/: <Direction code>

Direction code(s):

Prompt

l

1 or 2 for positive direction of axis 1 or 2, respectively.

l

-1 or -2 for negative direction of axis 1 or 2, respectively.

l

Default for MAP to start looking for phase changes from each corner of the axis variable

rectangle.

The direction is important when the initial equilibrium point is in a single-phase region or when the
diagram is an isopleth (tie-lines not in the plane of calculation). In such cases, the program will
search for a line in the diagram (i.e., a line where the amount of a phase is zero) in the given
direction.

Normally, this command is not needed to calculate a property diagram (with the STEP_WITH_
OPTIONS → NORMAL command-sequence), as the STEP procedure starts from the current
equilibrium state already calculated. In many cases, the ADD_INITIAL_EQUILIBRIUM command
is not required for MAP commands either.
In order to calculate a simple property diagram, set the equilibrium conditions and the
stepping axis variable, and then give a STEP command. But if a phase diagram has
disconnected lines, ADD_INITIAL_EQUILIBRIUM may still be needed to add two or more initial
equilibria so that the MAP calculation starts from such initial equilibria at the specified
directions to find all phase boundary lines.
This command becomes unnecessary in most cases, as the MAP routines that by default use
the Global Minimization Technique handles all the initial equilibrium points in a robust and
automatic way. Therefore, you do not need to have a good guess of the starting point and to
add any initial equilibrium point prior to the calculations of various types of phase diagrams.
However, if preferred, use this command to add any initial equilibrium points in certain
directions, the POLY module uses the specified starting point(s) and corresponding useradded initial equilibrium point(s) for a mapping calculation; in such a case, the automatic
procedure in the rewritten MAP routines are not enforced while the Global Minimization
Technique can still be applied. Similar situations occur when a specific database, in which
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there are some definitions of initial-equilibrium adding direction(s) for accessed binary
and/or ternary subsystems in its ACCESSED_SYSTEM section, is used in the BINARY or
TERNARY module for calculating a binary or ternary phase diagram.
All the initial equilibrium points generated by ADD_INITIAL_EQUILIBRIUM (previously and
presently; saved in the current POLY workspace) can be easily listed on screen with LIST_
INITIAL_EQUILIBRIA. A certain initial equilibrium point (including its conditions and
equilibrium results) can be loaded into the current equilibrium, if needed, with LOAD_
INITIAL_EQUILIBRIUM. Any specific or all of the initial equilibrium points can be deleted from
current POLY workspace, if desired, with DELETE_INITIAL_EQUILIBRIUM.
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ADVANCED_OPTIONS
This command is available with the POLY and ED-EXP modules.
Syntax

ADVANCED_OPTIONS

Prompt Which option? /Step_and_Map/: <Option>

Several options are available after you enter this command at the prompt. The default is
STEP_AND_MAP.

l

EQUILIBRIUM_CALCUL

l

GLOBAL_MINIMIZATION

l

KEEP_COMP_SET_NUMBERS

l

LIST_PHASE_ADDITION

l

MAJOR_CONSTITUENTS

l

NEW_COMPOSITION_SET

l

OUTPUT_FILE_FOR_SHOW

l

PARAEQUILIBRIUM

l

PHASE_ADDITION

l

PRESENT_PHASE

l

SHOW_FOR_T=

l

STABILITY_CHECK

l

STEP_AND_MAP

l

TOGGLE_ALTERNATE_MODE

l

T-ZERO_TEMPERATURE
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AMEND_STORED_EQUILIBRIA
This command is for the POLY module.
This command gives information about the calculated blocks (and phase regions included in
blocks) after the STEP or MAP calculation(s). It allows you to list all or part of the calculation
results, to suspend all or parts of the calculation results that are redundant or where
metastable equilibria are calculated, and to restore all or parts of the calculation results (if
having been suspended by another AMEND_STORED_EQUILIBRIA command).
The workspace for storing equilibria may overflow during stepping or mapping, and is then
written to a file as blocks. Each block usually contains one or more ranges of equilibrium
regions.
Use one these options:
l

L

to list the calculated equilibria (all or a specified block)

l

S

to suspend everything (all blocks and their regions)

l

Q

to suspend each set of equilibria individually (specified blocks and/or regions)

l

R

to restore everything (all blocks and their regions)

Syntax

AMEND_STORED_EQUILIBRIA
Name: <Name of a defined table>

Prompts List (L) the calculated equilibria, suspend everything (S) or suspend each set of equilibria
individually (Q), or restore everything (R).
Block /*/: <Block number>

Specify a block number in the option L, S, Q or R. Or include all the blocks in the amending option,
by accepting the wildcard * (press <Enter>).
For L, a block (if a block number is specified) or all the blocks (if the wildcard * is accepted/used),
with the regions and the equilibrium details, that are calculated during stepping or mapping is
listed on screen or in a textual file.
For Q, each ranger in a block (if a block number is specified) or in all blocks (if the wildcard * is
accepted/used) then choose:
S(uspend) K(eep) /K/: <S or K>

For S or R, if a block is specified, you are asked what region in the block should be suspended or
restored. However, if the wildcard * is accepted/used, you are asked the following:
Really suspend all /N/:
Really restore all /N/:

In both cases the default is N and you are prompted for which block(s) and which region(s) in a
certain block to execute the S or R action.
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Syntax

AMEND_STORED_EQUILIBRIA
Really suspend all /N/:

Y suspends everything.
Really restore all /N/:

Y restores everything.
Range: <Range(s) of region>

Specify one or more ranges to be suspended (the S option) or restored (the R option). The
wildcard * suspends or restores all ranges in the specified block.
In order to know the ranges the LIST command must first be used.
S(uspend) K(eep) /K/: <S or K>

The Query suspend option (Q) asks for each region in a certain block if it should be suspended or
kept. Suspended regions are not included on sequentially generated plots.
Output file: /Screen/: <File name>

This prompt is only for listing (the L option), and after it the command is terminated. The file name
must be given here; or accept the default Screen (terminal) by pressing <Enter>. A list of stored
equilibria as various blocks (with all their ranges) are shown out on screen or the file.
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CHANGE_STATUS
This command is available with the POLY and ED-EXP modules.
In the POLY module, set the status for components, species and phases in the defined system
for all the sequential calculations (single-point, stepping, and mapping) in equilibrium or
local/partial equilibrium state. Each component, species and phase has a status. The default
status is ENTERED.
The most important use is to calculate metastable equilibria and metastable phase diagrams
by setting some phases (that would otherwise be stable) to the SUSPENDED or DORMANT
phase-status. Another important applications is to calculate paraequilibria by setting some
components to the SPECIAL component-status.
For a component and for a species, the status can be one of the following:
l

ENTERED: the

component(s) or species are included in the calculation. This is the
default status.

l

SUSPENDED: the

l

SPECIAL: the

component(s) or species are not considered in the calculation.

specified component(s) are not included in summations for mole or
mass fractions. It only works for component(s).
Only component(s) can have the status SPECIAL, which implies that these are
not included in summations for mole or mass fractions.

For example, for the u-fractions or other normalized fractions, when one or more of the
components are excluded from the summation, you must specify which component(s) should
be excluded from the calculation of mole or mass fraction. This component status is
particularly useful when calculating paraequilibrium states. Such component(s) are normally
interstitial component, and must have the status SPECIAL. This is assigned by the CHANGE_
STATUS command.
Syntax

CHANGE_STATUS
For phases, species or components? /Phases/: <Keyword>

Prompts

Keyword = phase or species or components
Phase name(s): <Name(s) of the phase(s)>

For phase as the keyword, the names of the phases that have their status changed must be given
(all on one line). A comma or space must be used as separator. The status to be assigned to the
phases can also be given on the same line if preceded with an equal sign (=).
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Syntax

CHANGE_STATUS

An asterisk, *, can be used to denote all phases. The special notations *S, i.e. a
wildcard * directly followed by an S, sign, means all suspended phases. In the same
way, *D means all dormant phases, and *E means all entered phases.
Name(s): <Name(s) of the Species or Component(s)>

For species or components as the keyword, the names of the species or components that have
their status changed must be given (all on one line). A comma or space must be used as separator.
Similarly to the case of phase as the keyword, the status to be assigned to the species or
components can also be given on the same line if preceded with an equal sign =.
An asterisk, *, can be used to denote all species or components. The special
notations *S, i.e. a wildcard * directly followed by an S, sign, means all suspended
species or components. In the same way, *E means all entered species or
components.
Status /Entered/: <New status>

The new status to be assigned must be given.
For species, the values ENTERED or SUSPENDED can be used.
For the POLY module, using the Entered or Suspended status here has the same
result as using the commands MAKE_COMPONENT_ENTERED and MAKE_
COMPONENT_SUSPENDED. The exception is that any existing conditions that
depend on a suspended component are removed when using the MAKE_
COMPONENT_SUSPENDED command.
For components, the status ENTERED, SUSPENDED or SPECIAL can be given. SPECIAL means that this
component is excluded from sums for mole fractions and mass fractions, which is useful when
calculating the ufractions or other normalized fractions of system components.
For phases, the status ENTERED, SUSPENDED, DORMANT or FIXED can be given. DORMANT means the
same as suspended but the driving force is calculated. FIXED means that it is a condition that the
phase is stable at a certain amount.
For example, for the ufractions, when one or more of the components are excluded from the
summation, you must specify which component should be excluded from the calculation of the
mole fraction. This component must have the status SPECIAL. This is assigned by the CHANGE_
STATUS command: Change_Status comp C=special.
Start value, number of mole formula units /0/: <Initial amount>

For ENTERED phases, an initial amount of the phase can be given. Normally, 0 is given if the
phase is not likely to be stable, and 0.5 or 1 or any positive number if the phase could be stable,
but such an initial amount is only used as the rough starting estimation in the equilibrium
calculations.
Number of mole formula units /0/: <Equilibrium amount>

For FIXED phases, the equilibrium amount of the phase [always using an initial estimation being
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Syntax

CHANGE_STATUS

the NPF(phase) value which it is the normalized mole number of components (per mole formula
unit) of the specific status-fixed phase] must be given. If the equilibrium amount is zero, then the
phase is at its stability limit.

Note when specifying a FIXED phase status
Special attention should be paid when specifying a FIXED phase status in equilibrium calculations
(for single points, stepping or mapping calculations), as described below.
The phase amount variables, NP(phase), BP(phase) and VP(phase), as well as all their M/W/Vsuffixed quantities, should not be used as conditions. Instead, use the CHANGE_STATUS command
to set a relevant condition, e.g. CHANGE_STATUS phase <phase>=fix <amount> where the fixed
<amount> is roughly the same as the F-suffixed quantity NPF(phase).
The NPF(phase) quantity is the normalized mole number of components (per mole formula unit)
of the specific phase in the defined system, which unlike other F-suffixed state variables [e.g. GF
(phase), HF(phase) and DGF(phase)] cannot be directly applied in any POLY command, implying
that it cannot be directly evaluated or listed/shown. If intended to shown such a normalized phase
amount value in an equilibrium state, you should use a properly-entered symbol (function or
variable), for example: NPFabc = NP(abc)/NA or NPFabc = NPM(abc)/NA*N. N is the total system size
(in mole). The NA value is a quantity that is phase-dependent (and sometimes also equilibriumdependent for ionic solution phases), and is the total atomic number in a mole-formula-unit of the
specific phase abc (excluding interstitial component and, of course, vacancy). For example, the
SIGMA, FCC, BCC and LIQUID phases (among others) in a defined Fe-Cr-Ni-C-N-O system (retrieved
from a specific database) may be modeled by certain models, and their NA values must be
evaluated in different ways, as described below:
LIQUID (C,Cr,CrO3/2,Fe,FeO,FEO3/2,N,Ni,NiO)1 NA = 1
FCC_A1 (Cr,Fe,Ni)1(Va,C,N,O)1 NA = 1
BCC_A2 (Cr,Fe,Ni)1(Va,C,N,O)3 NA = 1
SIGMA (Fe,Ni)8(Cr)4(Cr,Fe,Ni)18 NA = 30

If in the same Fe-Cr-Ni-C-N-O system the liquid solution phase is modeled by the Two-Sublattice
Ionic Liquid Model, i.e.:
IONIC_LIQ

(Cr+3,Fe+2,Ni+2)p(VA,C,N,O-2,FEO3/2)q,7

then the evaluation of its NA value becomes even more complicated:
NA = p + q*yC2 + q*yN2 + q*yO22 + q*yFeO2 3/ 2

where the stoichiometric coefficients p and q are also dependent upon the real equilibrium state
(rather than having fixed values in the system). Similar situations occur for other (solid) phases
which are described by a multiple sublattice model with ionic constituents, such as SPINEL and
HALITE phases in some databases.
There is no strange thing when using a zero value [i.e. 0] in a FIXED phase-status, since it means
the specified phase is stable in equilibrium state but has a zero-amount of mass in the equilibrium
calculations; in other words, on a phase diagram, the specific phase is on a zero-fraction line (ZFL),
i.e. it starts becoming stable on one side of a corresponding phase-boundary line or unstable on
the other side of the same boundary. It is often and efficient to do so when calculating e.g. solidus
equilibrium states.
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Syntax

CHANGE_STATUS

However, when a non-zero value [it must always be positive; e.g. 1 or 0.5 or 0.3 or 1.5] is to be
specified in a FIXED phase-status, it is unnecessarily the exactly same stable amount of the specific
FIXED-status phase in a calculated equilibrium state any longer; instead, the <equilibrium amount>
value is the NPF(phase) value that is only roughly used as the estimated starting-value of the
FIXED-status phase in the equilibrium calculations.
Therefore, a FIXED-status for a liquid phase being unity does not necessarily imply that it is a
liquidus equilibrium state (where the liquid phase is in equilibrium with some solid phases but the
liquid phase takes all the mass in the defined system). A unity value for setting the liquid phase
status in calculating liquidus equilibrium state can only be used when the liquid mixture phase is
predefined as a single-sublattice solution phase (such as metallic liquid phase in multicomponent
alloy systems) and the total system size as one mole (i.e. N=1).
When a phase is described by a solution model in which two or more sublattices are considered
and these sublattice sites may also have different stoichiometric coefficients [meaning that the
mixture phase could have more than one atom in formula [NA>1; see some examples above], the
unity value should not be used when setting the FIXED status for the phase; instead, you should
use an appropriate value that ranges from 0 to a NPF(phase) value that equals to or is smaller than
1/NA (if the total system size N=1) or 1/NA*N (if N differs from unity). For this reason, if a
multicomponent system bears an IONIC_LIQUID phase that is described by the Two-Sublattice
Ionic Liquid Model (or any other multiple-sublattice ionic solution phases), it is difficult to use a
proper NPF(ION_LIQ) value in setting its FIXED phase-status, because that should be less than (or
equal to) the complex value of
N/[p + q*yC2 + q*yN2 + q*yO22 + q*yFeO2 3/ 2 ].

Examples
For example, to obtain the metallic fraction in a system with carbon as an interstitial
component, you can set the component status for carbon as SPECIAL:
Change_Status comp C=special

The SUSPENDED status for components and species does not always work as
expected.
For a phase, it may have one of these statues:
l

ENTERED: the

phase(s) are included in the equilibrium calculations and these are
stable if that minimizes the total Gibbs energy in the defined system. This is the
default status for all phases already retrieved from the chosen database(s). An
ENTERED phase-status is always associated with an initially-estimated amount [in
mole number; normally, as 0 if the phase is not likely to be stable, and as 0.5 or 1 or
any positive number if the phase could be stable] but it is only used as the rough
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starting value in the equilibrium calculations.
l

SUSPENDED: the

phase(s) are not considered in the equilibrium calculations.

l

DORMANT: the

l

FIXED: it is an equilibrium

phase(s) are not considered in the equilibrium calculations but their
driving forces for precipitation are calculated.
condition that the status-fixed phase must be stable, and
be in equilibrium at a specified amount [always using an initial estimation being the
NPF(phase) value which it is the normalized mole number of components (per mole
formula unit) of the specific status-fixed phase]. See more descriptions at the end of
this command.
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COMPUTE_EQUILIBRIUM
This command is for the POLY module.
The full equilibrium state is calculated for the given set of conditions. The Global
Minimization Technique is by default enforced in this command (C_E), while it can be
disabled temporarily (for the current single-point equilibrium calculation) if using C_E – or
C_E * command-combination, or permanently (for all the sub sequential single-point
calculations or stepping/mapping calculations within the current TCC run) if having
decisively switched it off by a user (or possibly in some special modules) through changing
the minimization option using the ADVANCED_OPTIONS → MINIMIZATION_OPTION commandsequence.
Syntax

COMPUTE_EQUILIBRIUM

The C_E command can be used, in order to enforce the ordinary POLY minimization routines in an
equilibrium calculation; this is because of that the ordinary C_E command is now associated with
the Global Minimization Technique, and only after the Global Minimization
If technique is permanently switched off the C_E command makes no difference from the C_E –
command-combination.
Only certain types of equilibrium conditions [e.g. T, P, N, N(<component>), X(<component>), B, B
(<component>), and W(<component>)] are fully supported in the Global Minimization mode (called
Direct Global Minimization); and when other types of equilibrium conditions are used, after the
initial POLY, a Global Minimization test and corrections are performed until the lowest minimum is
found (called Indirect Global Minimization).
If there is any problem with convergence, you may try the C_E * command-combination. The
character * enforces the command to use an advanced technique to obtain a complex equilibrium.
Prompt However, after a successful C_E *calculation, you may repeat the C_E command and can check the
status of phases, species or components (with LIST_STATUS → CPS command-sequence) and
equilibrium conditions (with LIST_CONDITIONS) and list out the calculation results (with LIST_
EQUILIBRIUM), because such actions may tell you how to further modify various settings for your
current calculation. This command-combination is not that useful anymore, because the Global
Minimization Technique that is always associated with the C_E command is even more powerful
and more precise in finding the most-stable equilibrium state in a complex heterogeneous
interaction system; therefore, the C_E * command-combination is functional and can be used only
after the Global Minimization mode has already been disabled temporarily or permanently.
Some phases that are not stable in the current equilibrium state may not have their most favorable
composition after this command, and thus their driving forces may not be correct. You can force
the program to correctly calculate the driving forces of metastable phases, by giving repeated C_E
commands until the number of iterations (that is shown on screen after this command) is reduced
to 2.
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Syntax

COMPUTE_EQUILIBRIUM

Also see the POLY command SET_NUMERICAL_LIMITS which can set the approximate
driving force for metastable phases option on or off in all the subsequent POLY
calculations within the current TCC run.

If an equilibrium state for the defined system is not found, an error message is
given.
You can try repeating this command a few times, or change some of settings for the numerical
limits, for starting variables and starting values, for starting constitutions of certain phases and for
reference states of certain components, or to verify some of the defined conditions.
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COMPUTE_TRANSITION
This command is for the POLY module.
This command is a combination of the CHANGE_STATUS, SET_CONDITION and COMPUTE_
EQUILIBRIUM commands. It allows a direct calculation when a new phase may form by
varying one of the already-set conditions. It can be used only after at least one equilibrium is
calculated successfully; otherwise, you are informed on the necessity of first making an
equilibrium calculation to find out the stable phases under the current conditions.
When this command is used, the program calls the command CHANGE_STATUS to temporarily
change the phase status of a specified phase as FIXED at the zero amount, and at the same
time to temporarily release one of the existing equilibrium conditions (which is chosen by
you). The program calculates a new equilibrium in which that specific phase is stable but its
equilibrium amount in the system is zero. The released condition is then assigned with a
calculated value that ensures the calculated equilibrium. After wards, the program
automatically changes the phase status of that specific phase back to ENTERED, and resets
the temporarily released condition as one of the conditions and assigns it with the value that
is calculated to ensure the zero-amount formation of that specific phase.
This command is useful to find melting temperature, boiling temperature, or solubility
limits, and generally when you want to set the most optimal conditions for calculating an
equilibrium where a specific phase becomes stable. It can also be used when you want to
know exactly how far away the defined conditions are from the value that can ensure a zeroamount of a specific phase in the system when other conditions remain the same.
After a successful calculation, you can issue a COMPUTE_EQUILIBRIUM calculation to assure the
calculated transitional equilibrium is a really stable one, and can also use LIST_EQUILIBRIUM
to see the details of transitional equilibrium state.
Syntax

COMPUTE_TRANSITION
Phase to form: <Phase name>

A new phase name, e.g. BCC that is expected to form, is specified here. This changes the status of
this new phase to be FIXED as 0 amount, and the program shows the information such as:
You must remove one of the these conditions
P=100000, T=800, N=1, X(FE)=.5

DEGREE OF FREEDOM 0

Prompts If the key word ANY is used when prompted for Phase to form (instead of a specific phase name),
it is possible to find out any new phase to be formed, in a given varying direction sign and at an
estimated change of the released condition: a negative sign means at a lower value of the
released condition any new phase is to be found, and a positive sign at a higher value; an
estimated change of the released condition implies where any new phase is expected (but it is
only estimated value, so any value within its reasonable scale would be enough). Such calculations
can be repeated if required. This feature is useful to find out all possible phase transformations

Thermo-Calc User Guide: Console Mode ǀ 188 of 643

Thermo-Calc Documentation Set

Syntax

COMPUTE_TRANSITION

along a certain released condition.
Give the state variable to be removed /T/: <One condition>
One condition must be

removed, in order to calculate the transition equilibrium where the
specified (or any) new phase to be formed at a calculated value of this released variable.
Therefore, the message may display (after a successful calculation) if, for example, X(Fe)is
entered:
To form BCC the condition is set to X(FE)=.48605791769

This calculated value is assigned as the parameter of that removed condition, in this case, the X
(FE) variable. If the LIST_CONDITIONS command is typed this message displays:
P=100000, T=800, N=1, X(FE)=4.86057918E-1
DEGREES OF FREEDOM 0

If the key word ANY (instead of a specific phase) is given as the phase name when it is prompted
for Phase to form, the line is prompted for a given varying direction sign and an estimated change
of the released condition before the calculation of transition equilibrium:
Estimated change (with sign) /1/: <+/-#>

A given varying direction sign and an estimated change of the released condition, in this case as X
(FE), must be given here: a negative sign means at a lower value of the released condition any
new phase is to be found, and a positive sign at a higher value; an estimated change of the
released condition implies where any new phase is expected (but it is only estimated value, so
any value within its reasonable scale would be enough). For example, if a combination of -0.02 is
input, this message may display (after a successful calculation):
To form BCC_A2#1 the condition is set to X(FE)=.493708756187

This calculated value is then assigned as the parameter of that removed condition, in this case, the
X(FE) variable. The message is shown if the LIST_CONDITIONS command is typed:
P=100000, T=800, N=1, X(FE)=4.93708756E-1
DEGREES OF FREEDOM 0
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CREATE_NEW_EQUILIBRIUM
This command is available with the POLY and ED-EXP modules.
During data-assessments using the ED_EXP module (a submodule of PARROT), you can, in
the POLY module, create several equilibria with different sets of conditions and phases (but
normally with the same set of components). By default, there is one equilibrium. To keep the
set of conditions and phase for this equilibrium, create another one using this command, and
use another set of conditions for that. Two equilibria may be useful to calculate easily the
enthalpy difference between two states. In the PARROT module, the experimental
information is stored as a sequence of equilibria.
Syntax

CREATE_NEW_EQUILIBRIUM
Equilibrium number /2/: <A new equilibrium number>

Prompts Each equilibrium in the POLY workspace is identified by a unique integer number. Such an
equilibrium number can be recalled with SELECT_EQUILIBRIUM.
Initiation code /2/:

When an equilibrium is created, you can choose to ENTER all components and phases (initiation
code 2), ENTER the components only (initiation code 1) or SUSPEND everything (initiation code 0).
No other values are legal.
The entered components and phases can later be changed with CHANGE_STATUS.
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DEFINE_COMPONENTS
This command is available with the POLY and ED-EXP modules.
Change the set of components. By default, the elements are used as components. The set of
components can be important because some conditions are set using components, for
example, the amounts, activities or chemical potentials.
For example, in the system Fe-Si-O, you can define FEO, FE2O3 and SIO2 as components,
thus replacing the default FE, SI and O.
This implies a command REINITIATE_MODULE and it should be given as the first
command in the POLY module.
Syntax

DEFINE_COMPONENTS
Give all new components / existing components/: <New components>

The new components must be specified all on one line. These replace the existing component
definitions.
Prompt
The number of components cannot be changed with this command. Use CHANGE_
STATUS instead.
To keep some existing components, it is recommended that you also enter these on the line.
Otherwise, the added new components may not be defined correctly. This is especially important
if some components are built out of several elements.
The new components do not have to be present as species.
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DEFINE_DIAGRAM
This allows automatic calculation and plotting of a diagram with a single command. It is the
same as the DEFINE_MATERIAL command up to when the first equilibrium is calculated. The
alloy OPTION feature is also available in this command to specify alloying compositions for a
special alloy predefined by the OPTION keyword in a selected database (e.g. the TCNI Nibased Superalloys Database).
Use this command to calculate all types of phase diagrams after specifying all composition
value and an initial temperature (if temperature is used as an axis). However, for binary and
ternary diagrams, the special BIN and TERN modules may be preferred.
It then lists all the independent variables for the defined system (i.e. temperature and the
components) and asks for a variable as the X-axis. You must also specify a maximum and
minimum for the X-axis. The second axis (Y-axis) can be another composition (or the
temperature if that is not on the X-axis) from the independent variable list. The program
then calculates and plots a phase diagram, as there are two independent quantities on the
axes.
Alternatively, select a dependent quantity as the Y-axis variable from the second list on
screen (e.g. the amount of all phases, composition of a specific phase, or fractions of a
component in all phases), and the program calculates and plots how this quantity depends
on the condition on the X-axis. This is a property diagram.
This command ends up within the POST module monitor. You can refine the calculated
phase diagram or property diagram.
Moreover, many more property diagrams with axes other than compositions can also be
plotted (after the calculation), using SET_AXIS_VARIABLE in the sequent POST monitor.
Syntax

DEFINE_DIAGRAM

These prompts are given:
Same elements as before /Y/?
Mole percent of <Element> /##/: <Value>

or
Mass percent of <Element> /##/: <Value>

Prompts Database /ABCDE/: <Database name>
Major element or alloy: <Element name>
Composition in mass (weight) percent? /Y/:
1st alloying element:

<Element name>

Mass (weight) percent: <Amount of the above specified element>
2nd alloying element: <Element name>
Next alloying element: <Element name>
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Syntax

DEFINE_DIAGRAM
Mass (weight) percent: <Amount of the above specified element>
Temperature (c) /1000/: <Temperature of interest in oc>
Reject phase(s) /none/: <List of phase(s) to be rejected>
Restore phase(s) /none/: <List of phase(s) to be restored>
OK? /Y/: <Y or N>
Should any phase have a miscibility gap check? /N/:
Phase with miscibility gap: <phase name>
Major constituent(s) for sublattice #: /aa/: <Constituent(s)>
Phase with miscibility gap: <Phase name>

The first equilibrium is calculated, as with DEFINE_MATERIAL. Then a list of all independent
conditions suitable to be chosen as X/Y-axis variables is given by the program.
Quit? /Y/: <Y or N>

This question is asked only when the axis variables are already defined, or if DEFINE_DIAGRAM is
used. It then offers an opportunity to quit (Y) the calculation or to continue (N) the calculation but
by defining other axes.
Give the number of the condition to vary /1/: <A condition index>

Select one of the independent conditions by giving its index on the condition list as the X-axis
variable.
Minimum value /XXX/: <minimum value for X-axis>

Specify the minimum value of the chosen X-axis variable. A default value is shown automatically
by the program; press <Enter> to accept it or input another value.
Maximum value /YYY/: <maximum value for X-axis>

Specify the maximum value of the chosen X-axis variable. A default value is shown automatically
by the program; press <Enter> to accept it or input another value. Then another list with some
dependent quantities is given by the program, which can be selected as the Y-axis variable.
Give the number of the quantity on the second axis /#/: <##>

Select one of the independent conditions or dependent quantities as the Y-axis variable, by giving
its corresponding index given on the condition lists.

It must be different from the X-axis variable already selected.

If selecting one of dependent quantities (by giving the corresponding number from the second
list) as the Y-axis, then a property diagram is to be automatically calculated (through a normal
stepping procedure) and generated. For composition of a phase the phase name is asked for
further specification subsequently.
If selecting any of the other independent variables (conditions) on the first list as the Y-axis, then a
phase diagram is automatically calculated (through a mapping procedure) and plotted.
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DEFINE_DIAGRAM
Name of phase: /ABC/: <phase name>

This is prompted only in case of that the composition of a phase is selected as the Y-axis variable.
The phase name for which the composition varied along with X-axis variable should be specified.
Multiple start points? /Y/:

By default, the program automatically generates and uses multiple start points for mapping the
defined phase diagram.
Save file /Result/: <File name>

The file name where the calculations are stored (saved as a *.POLY3 file) should be specified; the
default file name is RESULT.POLY3.
Linux and Mac are case sensitive so ensure you enter .POLY3.
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DEFINE_MATERIAL
This command is for the POLY module.
Read data for a system from a database in the POLY module. It is convenient to use for
alloys when there is a major component and the amount of the other elements is known in
mass (weight) fraction. The command reads the system from the specified database, sets
the composition and temperature (and pressure equal to 1 bar) and calculates the
equilibrium state before the prompting for a new command. You can list the results with
LIST_EQUILIBRIUM or set a new composition or set axis for a STEP or MAP command.
You cannot append data from different databases in this way. Use this command
with data from a USER database.
Syntax

DEFINE_MATERIAL
Same elements as before /Y/?

This question is asked only if some data is already read from the database, or if the command
DEFINE_MATERIAL or DEFINE_DIAGRAM is used. It then offers a convenient way to change the
Prompts composition and temperature with one command.
This command only works properly in cases where the composition of the material
system is already defined as in the mole-percent or mass-percent unit.
Mole percent of <Element> /##/: <Value>

or
Mass percent of <Element> /##/: <Value>

If you have decided to use the same materials system (available in the current POLY3 workspace)
by accepting the default (Y) to the previous prompt Same elements as before /Y/?, one of the
alternative prompts display for each of the components in the defined system, depending on how
the composition is defined (either in mole-percent, or in mass-percent).
Prompts are repeated until all the defined components are completed. Then, the program
prompts to specify the temperature condition.
Database /ABCDE/: <Database name>

The database with the description for the material must be given, or press <Enter> if using the
current database. It is possible to give a USER database.
Major element or alloy: <Element name>

The material must have a major element, usually the element which is present in the largest
amount. The fraction of this element is not set but is the rest.
In some databases there are the alloys predefined. An alloy has a default major element and have
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Syntax

DEFINE_MATERIAL

limits of the amounts of the alloying elements. If you stay within these limits the calculation gives
reasonable results.
Composition in mass (weight) percent? /Y/:

By default the input is taken as mass percent. Choose N to change to mole percent.

Composition should be given in PERCENT not FRACTION, as it is required for the W
and X state variables in the SET_CONDITION command.

1st alloying element: <Element name>

The first alloying element must be given.
All alloying elements are asked for in a sequence. These can be given in any order. You must know
if you are present as assessed systems in the database. There is no error or warning messages if
data are missing. Check the documentation of the database selected.
If an alloy is selected, a list of legal alloying elements and their maximum percent is listed on-line.
Mass (weight) percent: <Amount of the above specified element>

The amount of the alloying element in mass (weight) percent. Using DEFINE_MATERIAL you cannot
use the normal flexibility for conditions, but all must be given in mass percent. However, you can
after wards change the conditions using SET_CONDITION.
2nd alloying element: <Element name>

The second alloying element must be given. If only one, press <Enter>. If an element name is
given then the program asks for its mass fraction.
Mass (weight) percent: <Amount of the above specified element>

The amount of the above specified alloying element in mass (weight) percent.
Next alloying element: <Element name>

Continue giving elements and mass (weight) fractions until all elements specified. When all
alloying elements and their compositions (as in the above prompt) are specified, press <Enter> as
answer to this question to finish the materials definition.
Temperature (C) /1000/: <Temperature of interest in oC>

POLY makes the first calculation after retrieving the data for this temperature. By pressing
<Enter> to accept the default temperature. The value should be given in Celsius (°C).
The pressure is set to 1 bar.
Reject phase(s) /None/: <List of phase(s) to be rejected>

This is a question generated by the database allowing you to select the phases. Normally, all
phases should be included when you press <Enter>. If a phase is to be rejected, the name of the
phase must be supplied. Several phase names can be specified in one line. It is possible to reject
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DEFINE_MATERIAL

all phase by giving an asterisk *. If the number of phases to be included is much smaller than the
total number of phases, it may be convenient to first reject all phases and then restore those that
should be included. The question is repeated until you press <Enter> after rejecting all unwanted
phases or an asterisk *.
Restore phase(s) /None/: <List of phase(s) to be restored>

You can restore phases that are accidentally or deliberately rejected. It may also be possible to
restore some hidden phases.
If phases are to be restored the name of the phases must be supplied. Several phase names can
be specified in one line. It is possible to restore all phase by giving an asterisk *. The question is
repeated until you press <Enter> after restoring all desired phases.
OK? /Y/:

By default, all phases to be selected from the database have the thermodynamic data retrieved
and the references from the chosen database are listed. Enter N if there are any errors or you
want to amend the selection then you are returned to the prompt about rejecting phase(s).
Should any phase have a miscibility gap check? /N/:

The database usually creates two or more composition sets for phases that can have miscibility
gaps. However, for some phases this is not done automatically, for example the miscibility gap in
the bcc phase in Fe-Cr is usually ignored. But if it is important to include a Cr-rich bcc phase,
specify this here. It costs some computation time and may make the subsequent MAP or STEP
more difficult to converge.
If you do not want to have any phase with a miscibility gap in the calculation, press <Enter>. Then,
DEFINE_MATERIAL starts calculating the equilibrium, and is terminated.
To set such a phase with miscibility gaps in the calculation, answer Y. Then the software asks
questions about the phase names and their constitutions, such as:
Phase with miscibility gap: <Phase name>

You must supply the phase name, which has a miscibility gap under the specified system and
conditions.
Major constituent(s) for sublattice #: /AA/: <Constituent(s)>

The software shows a default constituent in the sublattice #(1,2,3,…), according to the existing
phase definition in the chosen database. You can specify one or more major constituents for the
sublattice # in the phase.
This question is repeated until all sublattices are specified.
Phase with miscibility gap: <Phase name>

You can supply another phase name with a miscibility gap under the specified system and
conditions, and answer the questions concerning the major constituent(s) in associated sublattice
(s).
By pressing <Enter>, the command starts calculating the equilibrium, and then terminates.
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It is also possible to use this command to select an alloy from a specific database
(e.g. the TCNI Ni-based superalloys database). Such alloys are predefined by the
OPTION keyword inside the database, and have their default major elements and
composition limits of their alloy elements.
Such alloys available in the selected database (at the prompt Database /ABCDE/ can be listed on
the screen if typing a ? mark on the prompt Major element or alloy. When a specific predefined
alloy (instead of a major element) is selected, the major element is staked from the alloy
definition and shown on the screen (with a message like Alloy found with major element NI).
You can only specify alloying elements and the compositions (weight percent or mole percent).
Typing a ? at any of the prompts for the alloying element names, e.g. 1st alloying element, 2nd
alloying element, lists all the alloying elements and the composition limits in the alloy. If the
composition of an alloying element is outside of its limit, there is a message (such as Amount above
limit: 30.0000) and a prompt Override limit ? /N/. If you decide to enforce the override by
answering Y on this prompt (i.e. accepting the over-limit alloying composition), another warning
message (such as Amount of major element below limit: 70.0000) and prompt Override limit ?
/N/. Then further decide if enforcing the overriding: if Y then accepting the major element’s
composition below the limit; if N then using the predefined major element composition limit.
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DELETE_INITIAL_EQUILIBRIUM
This command is for the POLY module.
Delete ONE specific initial equilibrium point or ALL of the initial equilibria. The initial
equilibria are used as starting points for all the sub-sequential MAP and STEP calculations.
ADD_INITIAL_EQUILIBRIUM.
Syntax

DELETE_INITIAL_EQUILIBRIUM

Prompt Number /All/: <Number of an initial equilibrium>
Specify the number of an initial equilibrium (as a specific numerical value e.g. 3, or ALL) to be
deleted from the POLY3 workspaces. It is recommended to use LIST_INITIAL_EQUILIBRIA to figure
out the numbers for all the existing initial equilibrium points that have already been added
(manually through ADD_INITIAL_EQUILIBRIUM, or automatically by some other POLY commands)
and stored in the current POLY3 workspace. By default, ALL the initial equilibrium points are
deleted.
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DELETE_SYMBOL
This command is available with the POLY and ED-EXP modules.
Use the DELETE_SYMBOL command to remove symbols i.e. constants, variables, functions or
tables.
Syntax

DELETE_SYMBOL
Name: <Name of a symbol>

Prompt

Specify the name of the symbol to be deleted. Only one symbol can be deleted each time.
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ENTER_SYMBOL
This command is for the POLY module.
There also GES and POST module commands with the same name.
Symbols are a useful feature of the POLY and POST modules to define quantities that are
convenient. Symbols can be constants, variables, functions or tables.
Functions or tables (with defined functions as values) can be entered in the POST module
after a stepping or mapping calculation, for purposes of plotting such entered functions or
tables as axis variables.
Within the POLY module, symbols are normally defined prior to an equilibrium calculation
(enforced by a C_E command), stepping calculation (enforced by the command STEP_WITH_
OPTIONS) or mapping calculation (enforced by MAP). These can be entered after an
equilibrium calculation; however, for defined functions, variable or tables, it requires using
EVALUATE_FUNCTIONS before showing the corresponding values in the calculated equilibrium
state.
The symbols entered in the POST module are not saved in the currently-loaded POLY3
workspaces. Therefore, if you want to apply such symbols in other similar calculations for
the same defined system, you must use the ENTER_SYMBOL command prior to the
STEPPING or MAPPING calculation in the POLY module.
See example 44 for an example of using variables and functions.
Symbols are a useful feature modules to define quantities that are convenient. Symbols can
be constants, variables, functions or tables.
Syntax

ENTER_SYMBOL
Constant, Variable, Function or Table? /Function/: <Keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION or TABLE.
l

Prompt
l

l

CONSTANTS can only be entered once and is a means of using a name for a numeric value. For
example, the value of 1 atmosphere in Pascal can be denoted by P0 after the command
ENTER_CONSTANT P0=101325. Defined constants can be used as values in condition
assignments, for example, SET-COND P=P0.
FUNCTIONS are expressions of state variables or other functions. These expressions are saved,
and whenever a function value is requested all functions are evaluated. The reason for this is
that they may depend on each other.
VARIABLES are similar to functions because they can also be expressions of state variables.
However, contrary to functions, they are only evaluated when they are entered or if they are
explicitly named in an EVALUATE_FUNCTIONS command. It is possible to enter a variable with a
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new expression any time. This expression is evaluated directly and its value stored as the
value of the variable. Defined variables can be used as values in the SET-CONDITION
command.
l

TABLES are used for listing results from the STEP or MAP commands. A table consists of a list
of any number of state variables, functions or variables. Defined tables can also be used in
the post-processor POST.

There is a special connection between tables and variables. If a variable is used in a
table, it is evaluated for each line of the table in the TABULATE command or when the
table is used in a plot.
Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 8 characters.
Legal characters include letters (either UPPER or lower case), digits and underscore _. Any other
special character, such as parentheses ( and ), plus +, minus -, slash / or \, full stop (.), are illegal for
symbol names.
You can enter the symbol name and the value or function on the same line, these must be
separated with an equal sign =, for example, TC=T-273.15 or T_C=T273.15 which stands for a
definition of temperature in Celsius. Otherwise, these questions are asked.
For different types of symbol (constant, function, variable or table), the questions
have different prompts.
Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or other functions,
constants or variables. The expression is a FORTRAN-like expression and operators +, -, *, = and **
can be used (** only with integer powers).
Unary functions like LOG, LOG10, EXP, SIN, COS and ERF can also be used. An expression can be
continued on more than one line. An expression should be terminated by a semicolon (;) or an
empty line (by pressing <Enter> at the next prompt).
Examples of function expressions:
l

GM(LIQUID): The Gibbs energy of liquid per mole component

l

H.T/4.184: The heat capacity of the system in calories

l

ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

l

T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the new line if one line is
not enough for the function. If you finish the function press <Enter> again.
Value: <Value for a constant>
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Syntax

ENTER_SYMBOL

A constant can only be assigned a numeric value once.
Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is evaluated
immediately and discarded. Only the numeric value is kept. This gives a possibility to save a value
between calculations with different conditions because all state variables and functions are
evaluated for the new conditions.
Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain results from a STEP
command is through a table.
Example:
ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the temperature, the mole
fractions of C and Cr in the LIQUID phase, and the activity of C.
To show the temperature in Celsius in a table, give the command ENTER_FUNCTION TC=T-273; and
then use the symbol TC in the table.
& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new line if one line is not
enough for the table. If you finish the table press <Enter> again.
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EQUILIBRIUM_CALCUL
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
Use this command to decide how to perform the POLY minimization (i.e. the traditional
Gibbs energy minimization). The Global Minimization Technique is used by default for
various single point equilibrium calculations and for stepping or mapping calculations.
To permanently turn off the Global Minimization Technique (for all sequential calculations
throughout the current run), use the GLOBAL_MINIMIZATION command and set the options to
use only the local POLY minimization. You can also make other adjustments to control the
steps in reaching Gibbs energy minima in an equilibrium state, for example.
When enforcing the Global Minimization Technique in the equilibrium calculations, you can
further adjust how to assign grid points and to handle compositional set(s) for solution
phases during stepping/mapping. In order to improve convergence, and because the Global
Minimization Technique uses the normal POLY optimization routine for some calculations,
you can also change how to control the steps in reaching Gibbs energy minima in an
equilibrium state.

Settings for the Minimization of an Equilibria
The following prompts show how the POLY optimization does the local POLY minimization to
reach the minimum of an equilibrium state.
Force positive definite phase Hessian /Y/:

Choose Y or N to determine how to reach the minimum of an equilibrium state in a normal
POLY optimization procedure. This is related to the special quantity, the phase stability
function QF (phase), for all kinds of phases in an equilibrium state [a phase stability
function for a phase is negative when the phase composition is inside a spinodal, and
positive everywhere else].
If the composition of a solution phase is inside its spinodal, the enforcement of positive
definite eigenvalues of a Hessian matrix (i.e. when Y is selected) makes the step be taken
towards the minima rather than the local maxima. Furthermore, if an eigenvalue (for a
phase) of the Hessian matrix is near 0.0, the step size is large this sets a lower limit to this
eigenvalue, reducing the step-size and improving the convergence.
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The POLY command sequence SHOW_VALUE QF(phase) shows the size of the
lowest eigenvalue of a phase in an equilibrium state.

If you answer:
, it helps the local POLY minimization to converge (if there is a problem),
especially if QF(phase)=0 for phases.

l

Y

l

N

the local POLY minimization routine is applied.

For each phase in a defined system, the molar Gibbs energy of the phase is a function of the
temperature-pressure condition and its composition:

Compute a Hessian matrix, which describes the curvature of the Gibbs energy curve of this
phase at the defined composition X:

Diagonalize this matrix and call the Eigenvalues as e1,e2,...,en . The QF(phase) quantity
for this phase is the lowest of these eigenvalues divided by the same values for a
corresponding ideal phase:

Here, se1,se2,...,sen are the Eigenvalues for the ideal phase. Therefore, for an ideal
phase, the QF(phase) should always be 1.0.
Control stepsize during minimization /Y/:

Choose Y or N to determine whether to introduce a control of step size while reaching the
minimum of an equilibrium state in a normal POLY optimization procedure. If you choose Y
it might help the POLY optimization to converge, especially if some site fractions are less
than 1E-4.
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EVALUATE_FUNCTIONS
This command is available with the POLY and ED-EXP modules.
The value of one or more or all entered functions or variables are evaluated and listed.
Syntax

EVALUATE_FUNCTIONS
Name(s): <Name(s) of defined function(s)>

The names of one or more entered functions or variables must be specified. By typing a wildcard
Prompt *, all functions and variables are evaluated.
Variables are evaluated only if these are explicitly named.
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GLOBAL_MINIMIZATION
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
Designed to decide how to perform the so-called Global Minimization in the POLY module.
By default, the POLY module uses the Global Minimization technique for various single-point
equilibrium calculations and for stepping or mapping calculations. You can use this to
permanently (for all sequential calculations throughout the current software run) turn off
the Global Minimization technique and consequently use only the Ordinary POLY
Minimization, and additionally adjust the ways to proceed the normal minimization (mainly
in terms of how to control the steps in reaching Gibbs energy minima in an equilibrium
state). When enforcing the Global Minimization technique in the equilibrium calculations,
you can adjust the manners for assigning grid-points and for handling new possible
compositional set(s) for solution phases during stepping/mapping; since the Global
Minimization technique also uses the normal POLY optimization routine for some
calculations, it is also possible to change the ways on how to control the steps in reach Gibbs
energy minima in an equilibrium state, in order to improve convergence.
The following prompts affect how the Global Minimization is done. Settings for global
minimization:
Use global minimization as much as possible /Y/:
Use global minimization for test only? /N/:
Maximum number of gridpoints per phase /2000/: <Integer number>
Use global minimization as much as possible /Y/:

Choose Y or N to decide if using the Global Minimization Technique from start of calculation
or not. The default value on start-up may be changed by SET_TC_OPTIONS in the SYS module.
If Y the calculation is done when possible (depending on the condition settings), and a Global
Minimization test is always performed when an equilibrium is reached. This costs more
computer time but the calculations are more accurate.
If N the calculation is not used to reach the equilibrium state. Use global minimization
for test only? determines if the Global Minimization test is made against the calculated
equilibrium states obtained by the Ordinary POLY Minimization calculation.
Use global minimization for test only? /N/:
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If Y a calculated equilibrium state obtained by the Ordinary POLY Minimization calculation is
tested against the Global Minimization Technique after it is reached; and if found it as
unstable, there is an error message.
If N the Global Minimization Technique is never tested for or done for all sequential
calculations throughout the current TCC run. This implies that Global Minimization
Technique is permanently turned off, and that consequently only the Ordinary POLY
Minimization routine is used.
Maximum number of gridpoints per phase /2000/: <Integer number>

Specify the maximum number of grid points that are computed for each of the phases in the
currently defined system, during the calculations enforced by the global minimization. More
grid points give a higher robustness and take more computation time. The total number of
computed grid points in all phases is limited to 2E6.
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KEEP_COMP_SET_NUMBERS
This is available with the ADVANCED_OPTIONS command in the POLY module.
ADVANCED_OPTIONS
COMPUTE_EQUILIBRIUM
This setting affects the COMPUTE_EQUILIBRIUM command and turns on/off the functionality to
keep the composition set numbers from the previous equilibrium calculation. The setting is
on by default.
To turn the setting on or off enter the ADVANCED_OPTIONS command in POLY, then enter this
option and either press <Enter> to keep the default Y or enter N at the prompt:
Keep composition set numbers /Y/:

If this setting is on, performing the COMPUTE_EQUILIBRIUM command keeps the composition
set number for any phases that were also present in the last result from COMPUTE_
EQUILIBRIUM.
The composition set numbers are kept when the constitution of a phase in the
new equilibrium result is similar to the constitution of one of the composition
sets of that phase in the previous result. Making major changes to the conditions
between calculations makes it therefore less likely that the composition set
numbers are kept. The major constituents, given in the thermodynamic
database, are used if no previous result exists.
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LIST_AXIS_VARIABLE
This command is for the POLY module.
Syntax LIST_AXIS_VARIABLE
Lists all the axis variables for a stepping or mapping calculation that have already been set by SET_
AXIS_VARIABLE.

Thermo-Calc User Guide: Console Mode ǀ 210 of 643

Thermo-Calc Documentation Set

LIST_CONDITIONS
This command is available with the POLY and ED-EXP modules.
All the conditions that are set by the SET_CONDITION command and the command-sequence
CHANGE_STATUS PHASE =FIXED <0 or 1 or alike>, are listed. The current conditions are
also listed by the LIST_EQUILIBRIUM command. The degree of freedom in the defined system
is also shown.
l
l

l

If this is zero, you can perform a COMPUTE_EQUILIBRIUM command.
If it is larger than zero, some more conditions are required, and you must further set
additional ones, using SET_CONDITION or CHANGE_STATUS.
If it is negative, then too many conditions are defined and the unnecessary ones
conditions need to be removed using the SET_CONDITION command (with a value of
NONE for the to-be-deleted condition) or the CHANGE_STATUS command (i.e.
changing a FIXED status of a phase to another type of phase status, ENTERED or
DORMANT or SUSPENDED).

Syntax

LIST_CONDITIONS
P=100000, T=800, N(NI)=1E-1, N=1

Example

FIXED PHASES
FCC_A1=1 LIQUID=0
FREEDO 0

DEGREE OF
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LIST_EQUILIBRIUM
This command is available with the POLY and ED-EXP modules.
The result (always in SI units) from the last calculated equilibrium is listed on screen or in a
text file.
You can also execute this command if no calculation is made or if the
calculation fails. Make sure to interpret the results accordingly.
Syntax

LIST_EQUILIBRIUM
Output to screen or file /Screen/: <File name>

Prompt

The name of the text file where the list of the calculation results shall be written.
Options /VWCS/: <Option(s)>

Select the output units and formats by optionally specifying a combination of these letters.
l

Fraction order: V means VALUE ORDER; A means ALPHABETICAL ORDER.

l

Fraction type: W means MASS FRACTION; X means MOLE FRACTION.

l

Composition: C means only COMPOSITION; N means CONSTITUTION and COMPOSITION.

l

Phase: S means including only STABLE PHASES; P means including ALL NON-SUSPENDED
PHASES.

Default options are VWCS. If the output fraction type should be in mole fraction (rather than mass
fraction), then give VXCS or type X (implying that in this case the options V, C and S are accepted as
the listing manners for fraction order, composition and phase).
If accepting all the default options, or if accepting all the altered options that had already changed
when using this command previously, you can type L_E,,, or LIST_EQUILIBRIUM ,,,
LIST_EQUILIBRIUM displays ORD (ordered) or

DISORD (disordered) (when available).

See CHANGE_LEGEND for details.
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LIST_INITIAL_EQUILIBRIA
This command is for the POLY module.
List all the equilibria added with ADD_INITIAL_EQUILIBRIUM.
Syntax

LIST_INITIAL EQUILIBRIA

All the initial equilibria are used for the MAP (and STEP) calculations.
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LIST_PHASE_ADDITION
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
The values set as additional contributions (given by PHASE_ADDITION) to Gibbs energy Gm
(J/mol formula unit) to all the phases (stoichiometric or solution) are listed at the current
calculated equilibrium.
LIST_PHASE_ADDITION has no additional prompt.
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LIST_STATUS
This command is for the POLY module.
There is also an ED-EXP module command with the same name.
List the status of components, species or phases.
Syntax

LIST_STATUS

Specify what to list:
Option /CPS/:<keyword(s)>

keyword = C or P or S, or any combination
Prompt

l

C: list component status

l

P: list phase status

l

S: list species status

l

CS: list both components and species

Default is CPS.
The results depend on the key word specified in the options for CHANGE_STATUS, a table with the
current status of phases or species or components, or the combinations, is shown:
l

For components, the statuses and reference states are listed.

l

For species, only the status is listed.

l

For ENTERED and FIXED phases, the status, driving forces and equilibrium amounts are listed.

The metastable phases are listed in descending order of stability. To avoid long
outputs only 10 metastable phases (in ENTERED status) are listed by lines, while all
other less stable phases are merged onto one line. For DORMANT phases, their
phase names and driving forces are listed. For SUSPENDED phases, only the phase
names are listed.
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LIST_SYMBOLS
This command is for the POLY module.
There are also POST and ED-EXP module commands with the same name.
Use this command to list the definitions for all constants, functions, variables and tables. In
order to find the value of a function or variable, use SHOW_VALUE or EVALUATE_FUNCTIONS. A
table is tabulated with the TABULATE command.
Syntax LIST_SYMBOLS
The defined variables are listed up together with the defined functions, but variable names are
followed by a percentage sign %.
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LOAD_INITIAL_EQUILIBRIUM
This command is for the POLY module.
Copies all conditions and calculated results from a specific added initial equilibrium to the
current equilibrium. The current conditions and calculation results are lost, and the newly
loaded initial equilibrium point gets into the POLY workspace.
Syntax

LOAD_INITIAL_EQUILIBRIUM
Number: <Number of an initial equilibrium>

Prompt Specify the number of an initial equilibrium to be loaded as current. The number can be found
with LIST_INITIAL_EQUILIBRIA.
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MAKE_COMPONENT_ENTERED
This command is for the POLY module.
The MAKE_COMPONENT_ENTERED command sets the status for the components to be ENTERED
in the defined system for all the sequential calculations (single-point, stepping, and
mapping) in equilibrium or local/partial equilibrium states. ENTERED means that the
component(s) are included in the calculation and these are stable if that minimizes the total
energy.
This command has the same results as when using CHANGE_STATUS Entered
option.
Syntax

MAKE_COMPONENT_ENTERED
Name(s) <Name(s) of the components>

Prompts The names of the components to set to ENTERED (all on one line). A comma or space must be used
as separator. An asterisk, "*", can be used to denote all components.
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MAKE_COMPONENT_SUSPENDED
This command is for the POLY module.
The MAKE_COMPONENT_SUSPENDED command sets the status for the components to
SUSPENDED in the defined system for all the sequential calculations (single-point, stepping,
and mapping) in equilibrium or local/partial equilibrium states. SUSPENDED means that the
component(s) are not considered in the calculation. Any conditions that depend on the
suspended components are automatically removed.
Removing relevant conditions is unique to this command and does not occur
when suspending components with the CHANGE_STATUS command and
Suspended option.
Syntax

MAKE_COMPONENT_SUSPENDED
Name(s) <Name(s) of the components>

Prompts The names of the components to set to SUSPENDED (all on one line). A comma or space must be
used as separator. An asterisk, "*", can be used to denote all components.
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MAJOR_CONSTITUENTS
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
Use this to set the major constituent(s) of a composition sets in a miscibility gap of a solution
phase. Normally, the major constituents are specified when a new composition set is created
by the NEW_COMPOSITION_SET option; but for the first composition set, this option may be
needed before using NEW_COMPOSITION_SET.
The following prompts are to specify the major constituent(s) on each of the sublattice sites
for a composition set of a certain solution phase:
Phase name: <name of a phase>

Specify the name of the solution phase with a new set of major constituents.
Composition set number /1/: <#>

The default value for the composition set number (#) is usually /1/ as the other composition
sets are given major constituents when creating them. Each phase has initially one
composition set.
Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) on each sublattice of a solution phase can be given. This may
simplify giving start values when calculating the equilibrium as phases with miscibility gaps
should have different major constituents for each composition set.
This question is repeated for each sublattice in the phase.
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MAP
This command is for the POLY module.
This command starts the mapping procedure for making a calculation of phase diagrams in
a defined multicomponent heterogeneous system, from one or more initial equilibria. A
phase diagram is usually mapped within a specific space that is constructed by two (or
more) defined independent mapping axis-variables.
Syntax MAP
A phase diagram consists of mapped phase boundary lines/curves; on one side of each such phaseboundary line/curve, the amount of one specific stable phase is zero (i.e. the zero-fraction lines).
From a single MAP calculation, many different types of phase diagrams in the defined
multicomponent heterogeneous system can be plotted, with some desired properties (that vary
along the calculated phase-region boundaries) plotted as X/Y-axis variables. All different types of
phase diagrams are generated by the mapping calculations through this command.

Normally, you need to have calculated at least one initial equilibrium point and have also
defined at least two independent varying variables (i.e. the controlling conditions in the
system) that are set with SET_AXIS_VARIABLE. You can also have three, or four or maximum
five independent varying variables that are defined by the SET_AXIS_VARIABLE command).
This lists the current values of each of the independent axis variables for each of the
calculated equilibrium points along each of the mapped phase boundaries, and also lists the
corresponding information when the set of stable phases changes.
The Global Minimization Technique is by default enforced in this command while it can be
disabled if having decisively switched it off (or possibly in some special modules) through
changing the minimization option using the ADVANCED_OPTIONS → MINIMIZATION_OPTION
command-sequence. You can choose how often to do a Global Minimization test (via the
Global Test Interval option) in the ADVANCED_OPTIONS STEP_AND_MAP commandsequence.
During a MAP calculation, the values of mapped axis-variables for presenting each phase
boundary (lines/points) of the calculated phase-regions are listed, and the corresponding
stable-phase sets are shown up.

You can terminate the mapping of a line by pressing a single <Ctrl-A>
(Windows) or <Ctrl-C> (Linux). This can be useful in order to stop a longish
calculation without losing what is already calculated.
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If there is any convergence problem in finding a stable solution at a certain stage during a
calculation procedure enforced by this command, these messages display on screen:
Convergence problems, increasing smallest site-fraction from
1.00E-30 to hardware precision 2.00E-14. You can restore using
SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY3 workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run,
you can use SET_NUMERICAL_LIMITS to restore or reset the smallest site fraction to the
previous or another preferred value, as well as to reset other numerical limits.
In particular, for phase diagrams with tie-lines in the plane (i.e. most binary systems and
ternary isotherms), there is a MAP procedure which checks for the best phase to use as axis
variables in order to ensure reasonable increments between the tie-lines. This produces
smoother curves and also gives a better stability in finding adjacent phase-regions.
Complex miscibility gaps of various solution phases are automatically detected during a
mapping calculation, and two or more composition sets for each of such solution phases are
automatically generated as well, through an automatic Global Minimization Test procedure
(by specifying a Global Test Interval value and confirming the Automatically add initial
equilibria in the ADVANCED_OPTION STEP_AND_MAP command-sequence). As a
particular case, such an automatic Global Minimization Test ensures that you can start
calculating from high temperatures in an austenitic steel (metallic FCC_A1 solution phase)
where the MC carbides/nitrides/carbonitrides (i.e. the C-/N-rich sides of the FCC_A1
miscibility-gap, often (while not always) being referred to as FCC_A1#2, FCC_A1#3, etc.)
are not stable, and during the MAP command the MC carbides/nitrides/carbonitrides may
first become metastable with a composition different from the metallic FCC_A1 phase and
later also stable. The advanced mapping procedure (enforced by the Global Minimization
Technique) inside the Thermo-Calc software (both the Console Mode and Graphical Mode)
can efficiently and effectively handle complex miscibility gaps in multicomponent
heterogeneous systems.
To get a complete phase diagram, sometimes it may be necessary to have multiple starting
equilibrium-points, and/or to have added multiple initial-equilibrium points (through ADD_
INITIAL_EQUILIBRIUM) inside various phase-region boundaries under certain direction(s).
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NEW_COMPOSITION_SET
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
A solution phase that can exist with two (or more) different compositions simultaneously
must have two (or more) composition sets in its phase descriptions. Normally the database
creates as many composition sets as is necessary but use this command to add or delete
more composition sets. A complex solution phase in a defined multicomponent system can
have up to 9 different composition sets for the purpose of appropriately handling its possible
miscibility gap(s) under various temperature-pressure-composition conditions.
This option is unnecessary if the Global Minimization Technique is in use, as it can
automatically detect all possible miscibility gap(s) for complex solution phases (normal or
disordered/ordered phases) and then automatically add required composition sets for such
phases in the defined system.
This option can automatically create composition sets also for disordered phase when it is
executed for the ordered phase.
If you have your own data file, this option must be used to indicate that a solution phase can
have a miscibility gap (or may exhibit some complex phase separations as to more than two
composition sets), unless that the possibly-additional composition set(s) for the solution
phase must have already been added inside the TDB file (through a TYPE_DEFINITION
command to amend composition-set) or been manipulated through the GIBBS module (using
the AMEND_PHASE_DESCRIPTION COMPOSITION_SET command-sequence). This option asks for
default major constituents for the new sets and it is important that this is set correctly,
otherwise the test for miscibility gaps may fail.
The following prompts are to specify the additional composition set(s) to handle possible
miscibility gap(s) of a certain solution phase:
Phase with miscibility gap: <Name of a phase>

Specify the name of the phase with miscibility gap.
New highest composition set number /2/: <#>

The default value is usually one higher than the current value. Each phase has initially one
composition set. If a lower value is given, composition sets are deleted. You cannot take
away the first composition set.
A message displays to show that you need to specify the composition for the composition set
# (2,3,…).
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Major constituent(s) for sublattice 1: /XX/: <YY>

The major constituents (YY) in each sublattice can be given. This may simplify giving start
values when calculating the equilibrium as phases with miscibility gaps should have different
major constituents for each composition set.
This prompt is repeated for each sublattice in the phase, sometimes even for all sublattices
in the first composition set if such major constituents have not been specified.
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OUTPUT_FILE_FOR_SHOW
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
The name of a text file is asked for and all the results output from the command SHOW_
VALUE is written to this file.
When you use this command, a window opens with a default name for the file tc_show.dat.
Choose a location to save the file and click Open.
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PARAEQUILIBRIUM
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
This calculates a paraequilibrium between two specific phases in an alloy system with one or
more interstitial component(s) as fast diffusion species. Under the paraequilibrium state,
two partially-equilibrated phases have the same chemical potential (but different contents)
for one or more interstitial components (such as C, N, O, S, etc., as individual or combined)],
along varied temperature or along a composition variable (of the matrix or one
substitutional component) which has already set as the stepping variable with SET_AXIS_
VARIABLE.
To ensure a successful point calculation of paraequilibrium state between two specific
phases in a defined alloy system, it is important that you first have made a single-point
equilibrium calculation with an initial overall composition in the current system before
performing this advanced-option calculation; however, it is unnecessary to obtain an
equilibrium in which either one or both of the target phases is stable. The initial overall
composition must have a reasonable setting for the desired paraequilibrium calculation for
the two target phases. This is especially true for cases where there are more than one
interstitial components to be considered in the paraequilibrium state, because different
interstitial components (for example C and N combined) may have significant different
behaviors as partitioning into different structured phases; otherwise, for one chosen
interstitial component the initial overall composition is OK for the paraequilibrium
calculation between the specified two phases, but for other chosen interstitial component(s)
it might be impossible to calculate the paraequilibrium state.
Note the following:
l

l

l

Always check if the chosen phases A and B have the exactly same definition of
elements and if the chosen interstitial components are all in the vacancy sublattice
sites of the two phases; otherwise the program cannot find the paraequilibrium state
(as it is impossible to correctly calculate u-fractions).
Always have a comprehensive understanding of the normal phase diagram for the
currently investigated system, so that you make the appropriate choice of the phase
pair and staring bulk composition for the system.
Always set the status of the chosen interstitial components as SPECIAL using the POLY
command: CHANGE_STATUSComponent <interstitial component> = SPECIAL. By
doing this, you get a clear picture of u-fractions of various substitutional and
interstitial components, which are different from the overall composition in the

Thermo-Calc User Guide: Console Mode ǀ 226 of 643

Thermo-Calc Documentation Set

system. The SPECIAL status means that specified component(s) are not included in
summations for mole or mass fractions. Therefore, all the composition variables
plotted from paraequilibrium calculations are u-fraction related quantities.

Settings
Name of first phase:

<Phase A>

Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium state is to
be calculated, must be entered subsequently or on the same (first) line at once then
separated by an empty space, e.g. FCC#1 BCC or FCC#2 M23C6.
You need to understand what you are dealing with in terms of calculating a
paraequilibrium state between the two specified phases.
Specifically, there are four distinguished cases to understand: (1) both chosen phases must
have similar interstitial/vacancy sublattices where the fast-diffusion interstitial component
(s) occupy; (2) the choice on the target phase pair must be reasonable for the defined
system and specified initial overall composition; (3) both target phases should have phase
constitution definitions that cover all the defined substitutional and interstitial components
of the current alloy system; or (4) it is impossible to calculate the paraequilibrium state
between the target phase pairs with given interstitial component(s) in the currently defined
system.
Fast diffusing component: /c/: <interstitial component(s)>
Fast diffusing component: /none/: <interstitial component(s)>

The name(s) of the fast-diffusing component(s) (C as the default single component) must be
given at the above prompts subsequently or at the same (first) prompt. It is possible to
specify more than one interstitial component as fast diffusion species.
Note the following:
Such specified interstitial component(s) must be appropriately defined according to the
phase constitution definitions of the two selected phases: these must be located on the
interstitial/vacancy sublattices in both chosen phases;
If there is only one fast-diffusing component which is carbon, press the <Enter> key to accept
the default input at the first prompt; if the single fast-diffusing component is another
element (e.g. N), type its name at the first prompt;
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If there are two or more fast-diffusing components (e.g. C and N), type their names at the
above prompts subsequently or at the same (first) prompt (separated by an empty space,
such as C N);
To finish the input of fast-diffusing elements, accept NONE at a repeated prompt, i.e. by
pressing <Enter> key to start the paraequilibrium point calculation;
If NONE or a non-existing component name is typed at the first prompt, it means no back
diffusion is to be considered, and the para-equilibrium calculation is thus canceled entirely.
If the paraequilibrium state between the two specified phases is successfully calculated, the
messages displays e.g.
NP(FCC) = 0.3586 with U-fractions C = 2.71821E-02

N = 4.1548129E-03

NP(BCC) = 0.6414 with U-fractions C = 7.10061E-04

N = 2.3781027E-04

All other compositions the same in both phases
Note: LIST-EQUILIBRIUM is not relevant

The first and second lines list the phase amounts expressed in mole-percent [NP(phase)] and
the contents of the interstitial components C and N in a specific phase expressed in the socalled u-fractions [u-f(phase,C) and u-f(phase,N)], for the phase A (in this case as FCC) and
phase B (in this case as BCC), respectively. The third line states that the compositions of the
matrix component and all the remaining compositions (regarding substitutional
components) in both the target phase A and target phase B are the same at the current
paraequilibrium state, while these are not shown on screen. The last line indicates that after
this advanced-option calculation the LIST_EQUILIBRIUM command is irrelevant and does not
list the paraequilibrium state for the system at the current condition.
However, if the single-point calculation of the paraequilibrium state between the two
specified phases has failed, these messages display:
*** Error 4 in ns01ad
*** Numerical error

This implies that the chosen target phase pair may be unreasonable for the defined alloy
system or for the defined initial overall composition, or one or both phases may have
inappropriate phase constitution definitions regarding the specified interstitial component
(s). Then, you must either modify the settings of initial overall composition or specify the
reasonable target phase pair with an appropriate choice of the fast diffusion interstitials in
the defined alloy system.
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PHASE_ADDITION
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
Sometimes it is interesting to add a constant contribution to the Gibbs energy of a phase
(stoichiometric or solution). This can be done in the Database Module (DATA) or Gibbs
Energy Module (GIBBS), for a stoichiometric phase, or for a pure end-member in a solution
phase. However, if the addition is related to the equilibrium state, for example, strain
energies or surface energies, interfacial energies or deformation energies, it may be more
convenient to have this quantity related to the equilibrium state rather than the
thermodynamic data.
Give a value of an addition to the Gibbs energy of a phase. The value should always be
constant (implying that the addition is not a function of phase composition or temperaturepressure conditions in the equilibrium state) and always be given in the unit of J/mol
formula unit of the phase.
The following prompts are to specify the additional energy term (always being a constant) of
a given phase.
Phase name: <Name of a phase>

Specify the name of the (stoichiometric or solution) phase with the addition.
Addition to G per mole formula unit: <xxxxx>

The value (xxxxx) given is added to the Gibbs energy of the (stoichiometric or solution)
phase. It can represent a nucleation barrier, surface tension, elastic energy or whatsoever.
It is not composition-, temperature- or pressure-dependent.
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POST
The POST module (post-processor) is a submodule to the POLY module and has
its own set of commands. The TAB, BIN, TERN, POT, SCHEIL and POURBAIX
modules use the POST module features as part of the automatic generation of
the plots.

POST Module Commands
Using the POST Module
Syntax POST
Switches to the POST module, which has its own command set.
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PRESENT_PHASE
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
Specify the name of the present phase a the name of the phase that should be present at all
calculated equilibria:
Present phase:
Phase name: <Name of a phase>
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READ_WORKSPACES
This command is used in both the POLY and GES (GIBBS) modules.
Workspace Files
The POLY3 and GIBBS workspaces and the calculated results from the MAP and STEP
commands can be READ from a file where they are saved with SAVE_WORKSPACES. Such a
*.POLY3 file is not printable.
Syntax

READ_WORKSPACES
File name is the

name of a saved POLY3-file where the POLY3 and GIBBS workspaces shall be read
from must be specified. You do not need to type the extension if it is the default *.POLY3,
otherwise type the whole POLY-file name.
Options

A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.
A window opens so that the path (in the Look in field) and File name can be specified. The Files of
type (i.e. POLY3) cannot be changed. Click Open to open the POLY3 and GIBBS workspaces from
the saved *.POLY3 file.
When reading back an original POLY3 workspace that has already been saved as an *.POLY3 file in
the current Thermo-Calc (Console Mode) run or had been read from an existing POLY3 file under
the current work area, while some additional changes in the settings may be made but do not
need to be kept in further steps in the current Thermo-Calc (Console Mode) run or any diagram is
plotted in the POST module, you can type READ,, or READ_WORKSPACE ,,
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REINITIATE_MODULE
This command is for the POLY module.
This command makes sure that the whole POLY module (and thus the entire POLY
workspace) is reinitiated to the state as it was when first entered.
Syntax REINITIATE_MODULE
All the defined components, defined conditions, changed status, entered symbols, defined
independent axis-variables, calculated starting equilibrium-points, added initial equilibrium points,
stepped/mapped equilibrium data, and so forth, are removed completely. The saved file name is
restored to the default.

Thermo-Calc User Guide: Console Mode ǀ 233 of 643

Thermo-Calc Documentation Set

SAVE_WORKSPACES
This command is available for both the POLY and GES (GIBBS) modules.
Workspace Files
You can save the current status and workspaces, including thermodynamic data, conditions,
options and results from a single, stepping or mapping calculation on a *.POLY3 file. The
workspaces are saved to a file with this command. This is useful so you have access to the
workspace for later use or when you need to terminate the current Console Mode session.
l
l

l

In the Gibbs (GES) module workspace, all thermochemical data are stored.
In the POLY module workspace, all the last set of conditions and equilibrium state,
changed status, entered symbols, advanced options, defined stepping/mapping
variables, added initial equilibria, stepped/mapped results, etc., are stored, so it also
contain the GES workspace.
When you are in a response-driven module such as POTENTIAL or SCHEIL for
example, a workspace file is automatically opened. In the workspace file, system
definitions, conditions for the calculation, calculation results, and plot settings are
saved. The file is saved in the current working directory, and is named after the
name of the module that created it. For example, the POTENTIAL module saves a
workspace file called POT.POLY3 ; the POURBAIX module saves a file called
POURBAIX.POLY3 and so forth.

After a SAVE_WORKSPACES command, you can always come back to exactly the
state you had when you issued the command by giving a READ_WORKSPACE
command. For example, after saving the POLY and GIBBS workspaces to a file,
you can leave the program and at a later time READ the file and continue from
the saved state.

Important Information About Map and Step Commands
A STEP or MAP command automatically saves the workspace with the most
recently specified name. Do not use the SAVE_WORKSPACES command after a
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MAP or STEP command.

The results from the STEP or MAP commands are destroyed by the SAVE_WORKSPACE
command. You can append several results obtained by sequential STEP or MAP calculations
without destroying the previous results, whilst SAVE_WORKSPACE erases them all. Keeping this
in mind is important and useful particularly for calculating various isothermal (or isoplethal)
sections and plotting them on the same diagram in a single Thermo-Calc run.
To suspend some of the STEP or MAP results, use the AMEND_STORED_EQUILIBRIA command.
Syntax

SAVE_WORKSPACES

A file name must be specified. The default extension of the POLY workspace file is *.POLY3 but
you can have any other file extension.
Linux and Mac are case sensitive so ensure you enter .POLY3.
A Save window displays if a file name is not given after the command, so that the path (in the Save
in field) and File name can be specified. The Files of type cannot be changed.
If there is already a file with the same file name under the directory a warning message displays.
Click OK to overwrite the current POLY or GIBBS workspace onto the existing file. Click Cancel to
Options return to the module. You can use the SAVE command with an unspecified name (i.e. through SAVE
,,, command-sequence) to save the POLY or GIBBS workspace.
When saving a POLY3 workspace under a name that already exists under the
current work area, which is saved by default (after running a special module, e.g.
BIN, TERN, POT, SCHEIL and POURBAIX) or in an earlier stage of the current Console
Mode session or in a previous run (which is READ into the current POLY3
workspace), you can type SAVE,,Y or SAVE_WORKSPACE ,,y. However, this must also
be avoided if some results from previous MAP or STEP calculations shall not be
destroyed.
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SELECT_EQUILIBRIUM
This command is available with the POLY and ED-EXP modules.
If you create more than one initial equilibrium (during data-assessments using the
PARROT/ED_EXP modules), you can switch between them using this command.
Syntax

SELECT_EQUILIBRIUM
Number /Next/: <Choice on equilibrium>

Prompt

Options: FIRST, LAST, NEXT, PREVIOUS or PRESENT.
Most commands affect only the PRESENT equilibrium. However, the REINITIATE_MODULE and DEFINE_
COMPONENTS commands remove all the stored equilibria.
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SET_ALL_START_VALUES
This command is available for the POLY and ED-EXP modules.
Set start values, e.g. if the calculation fails or if you have a miscibility gap or ordering. If
temperature and pressure are not conditions, you are asked for values of them. Then for
each phase prompt on if it should be stable and on its constitution.
Syntax

SET_ALL_START_VALUES
T /XXXX/: <Temperature in K>

If the temperature is not a condition, supply a guess of its final value (in K).
P /100000/: <Pressure in Pa>

If the pressure is not a condition supply a guess of its final value (in Pa).
Automatic start values for phase constitutions? /N/: <Y, N or F>
l

l

Prompts
l

For N, enter an initial amount of each entered phase and the major constituents or site
fraction of each constituent.
For Y, the program automatically sets the start values for phase constitutions in all possible
phases.
F is for force. In some cases the calculation fails because impossible conditions are set, e.g. W
(C)=1.5 [W(C) is mass fraction and must thus be less than unity. The program tries to fulfill

this condition by putting maximum amount of carbon in all phases, but can fail anyway.
When you detect the error and set W(C) to 0.015, the calculation may still fail because it
could start from the previous values. To get back to ‘fresh’ start values, choose F.
Should <phase> be stable /N/: <Y/1 or N/2>

A guess if this phase should be stable or not is requested. All entered phases are prompted for
this question and next two.

You cannot have more phases stable than you have components, but at least one
(which dissolves all constituents) must be set as stable. For backward compatibility,
this question can be answered by 1 (for Yes) or 0 (for No).

The phase name may have a hash sign # followed by a digit, e.g. BCC_A2#2. For phases with
miscibility gaps, there should be two phases with the same name but with different numbers after
the hash sign.
Major constituent(s): <Name of major constituent(s) in the phase>

The constituent with the largest fraction in the phase should be specified. If there are more than
one constituent with a large fraction, give them all on the same line. If the default major
constituents should be used answer with an asterisk (*). By giving $ the constitution is not
changed. If there should be no major constituent give NONE and or if the major constituent(s) are
improperly specified, you are asked for individual fractions in the phase.

Thermo-Calc User Guide: Console Mode ǀ 237 of 643

Thermo-Calc Documentation Set

Syntax

SET_ALL_START_VALUES
Y(<phase>,<constituent>) /.XXXXXXXXXX/: <.YYYYY>

The current value (.XXXXXXXXXX) is default. You can accept the default by pressing <Enter> or give
a new value (.YYYYY).
The phase name or constituent name may have a hash sign # followed by a digit, e.g. Y(BCC_
A2#2,FE), Y(BCC_A2#2,C#2). For phases with miscibility gaps, there should be two phases with the
same name but with different numbers after the hash sign. For phases with sublattices, the
constituents in sublattice 2 or higher is also be suffixed with a hash sign # followed by a digit.
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SET_AXIS_VARIABLE
In order to calculate a diagram, set at least one axis variable in a stepping calculation, or at
least two axis variables in a mapping calculation. For property diagrams, one axis is enough;
for phase diagrams two or more are necessary. Any condition that can be set to calculate an
equilibrium can be used as an axis variable (with its lower and upper limits and step length)
by using SET_AXIS_VARIABLE, and the POLY program does, after a STEP or MAP command,
vary the value of the condition between the limits set on its related axis variable. As an
extraordinarily unique and powerful feature of the Thermo-Calc software, up to five
independent axis variables can possibly be used in a mapping calculation of a
multicomponent heterogeneous system; however, the axis numbers 3, 4 and 5 must have
chemical potentials of components (or temperature or pressure) as conditions.
Syntax

SET_AXIS_VARIABLE
Axis number /#/: <An axis number>

Specify a number between 1 and 5. The axis numbers 3, 4 and 5 must have chemical potentials of
components (or temperature or pressure) as conditions.
Condition /None/: <One condition>

Prompts Here the condition that should be varied along the axis must be given. The condition is specified as
in SET_CONDITION, for example W(C) for mass fraction of carbon. By accepting NONE, the axis is
removed.
Min value /0/: <Min value>

Specify the minimum value of the axis condition.
Max value /1/: <Max value>

Specify the maximum value of the axis condition.
Increment /.025/: <Step length>

Specify the maximum step length. By default, this is 1/40 of the total axis length.

You can give SET_AXIS_VARIABLE without having set a condition on the axis variable. Under
such circumstances, the relevant condition is automatically created and the value set
between the minimum and maximum axis limits; however, as a side effect, the POLY
module creates two conditions, P=1e5 and N=1 (these have not been defined as a condition
yet), in case you set an axis variable which is not already a condition.
You can use a logarithmic axis during calculations. This is useful for low fractions like in a
gas phase where 1e-7 to 1e-2 might be an interesting range. The pressure is also suitable
for logarithmic step. You specify the logarithmic axis by giving an asterisk * after the
increment value.
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The increment in this case is treated as a factor.
For example,
S-A-V 1 P 1E5 1E25 5*

This makes axis 1 a logarithmic axis where the difference between two calculated values
makes a factor 5.
The factor must be larger than 1.0.
In some cases, such as when the DEFINE_DIAGRAM command is used or a special advanced
module (e.g. BIN, TERN, POT, SCHEIL or POURBAIX) is called, some axis variables are
automatically set by the program, not necessarily by this command.
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SET_CONDITION
This command is available with the POLY and ED-EXP modules.
Specify the equilibrium conditions for the calculation. All kinds of state variables, as well as
most of the M/W/V/F-suffixed state variables (for normalization) and R-suffixed state
variables (with respect to chosen reference states), can be used as conditions. In addition to
temperature and pressure conditions, a multicomponent system can have mixed types of
conditions. You should repeat this command for a multicomponent system until the degree
of freedom in the defined system becomes zero. When a FIXED phase status is used on a
specific phase (use CHANGE_STATUS), it is equivalent to one condition (implying that
particular phase is stable in the defined system).
Syntax

SET_CONDITION

Each condition must be given explicitly, but can be given on the same line (separated by a comma
(,) or an empty space) or on separate lines with each one started with the command.

Example
SET_COND T=1273, P=1E5, W(C)=.0015, X(LIQ,CR)=.22, ACR(N)=.2

or
SET_COND T=1273, P=1E5
SET_COND W(C)=.0015, X(LIQ,CR)=.22 ACR(N)=.2

In this example, the temperature is set to 1273 K, the pressure to 1 bar (1E5 Pascal), the mass
(weight) fraction of C to 0.0015 and the mole fraction of Cr to 0.22 and the activity of N to 0.2.
State variable expression: <State variable name or linear expression> or a linear
expression of state variables.

Some of the state variables that can be used in conditions are:
l

T: temperature in the system (in K)

l

P: pressure in the system (in Pascal)

l

N: system size (mole number in moles)

l

B: system size (mass in grams)

l

N(<component>): mole number of a component in the system

l

X(<component>): mole fraction of a component in the system

l

W(<component>): weight fraction of a component in the system

Prompt

l

l

For the SET_CONDITION command this is ACR(<component>): activity of a component in the
system. For the SET-ALTERNATIVE_CONDITION command, this is ACR(<phase>,<component>)
(activity of a component in a phase)
For the SET_CONDITION command this is MUR(<component>): chemical potential of a
component in the system. For the SET-ALTERNATIVE_CONDITION command, this is MUR
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Syntax

SET_CONDITION

(<phase>,<component>) (chemical potential of a component in a phase)
l

X(<phase>,<component>): mole fraction of a component in a phase

l

W(<phase>,<component>): weight fraction of a component in a phase

l

ACR(<species>,<phase>): activity of a species referred to a phase

l

MUR(<species>,<phase>): chemical potential of a species referred to a phase

l

H: enthalpy in the system (in J)

l

HM(<phase>): enthalpy of a phase (in J/mol)

There are many state variables that can be used in conditions. For more information, enter an INFO
STATE_VARIABLES command. A condition is normally a value of a single state variable with its value.

Example
T=1273.15

P=1E5

X(C)=.002
W(CR)=0.5
ACR(CR)=0.85
X(FCC,C)=.001
H=-250000
HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than one state variable. For
example,
X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S component should be the same in the
LIQUID and PYRRHOTITE phases. In practice, that should be the congruent melting point.
After the equal sign only a numeric value is allowed in the expression.
Factor: <A factor for the state variable, or a continuation>

This question means you did not answer the previous question. The program is then expecting a
single state variable or a complete state variable expression, or the numeric factor in an expression
with only one state variable. In a state variable expression a state variable may be preceded by a
constant factor. An example of this is:
2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical potential of FE plus three
times the chemical potential of O should be -35000 J/mol.
State variable: <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either the prompt State
variable expression or Factor, or a state variable expression is given but the expression is
incomplete, for example, T- or 2*MUR(FE)+, for which the program is then expecting a continuation
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Syntax

SET_CONDITION

of the unfinished expression. You need to specify a state variable or a complete state variable
expression, or complete the unfinished state variable expression. If a numeric factor is given
before this prompt, only one state variable can be specified; otherwise, the program only takes the
first state variable to complete the expression (i.e. the factor times the state variable).
Value /X/: <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is
given as the default value. The special value NONE means that the condition is removed; for
example T=NONE takes away the temperature condition.
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SET_INPUT_AMOUNTS
Specify how a system is made up from mixing of various substances. It is useful with a
substance database. In the C-H-O-N system, you can, for example, give:
S-I-A N(H2)=10, N(H2O)=25, N(C1O2)=5, N(N2)=100

The POLY module automatically converts this into conditions for the current set of
components. In the case when the elements are defined as the components, the command
above is equivalent to
SET-CONDITION N(H)=70, N(O)=35, N(C)=5, N(N)=200

Syntax

SET_INPUT_AMOUNTS
Quantity: <N(<specie>) or B(<specie>)>

Prompts You can give the amount also preceded with an equal sign = [e.g. N(H2)=10 or B(H2O)=1000], or
press <Enter> for the next prompt on the amount of the quantity.
Amount: <Value of the quantity>

Specify the numerical value of the quantity.
You can give negative amounts in the SET-INPUT-AMOUNTS command.
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SET_INTERACTIVE
In the POST module this is called SET_INTERACTIVE_MODE.
Use the SET_INTERACTIVE command to use it in demonstration or macro files to stop the
execution of the command file and pass over input focus to the keyboard.
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SET_NUMERICAL_LIMITS
This command is available for the POLY, Scheil and ED-EXP modules.
Change the criteria for convergence. This is to speed up a calculation in a complex system.
If there is any convergence problem in finding a stable solution at any stage during a
calculation procedure enforced by COMPUTE_EQUILIBRIUM, STEP_WITH_OPTIONS, MAP or
ADVANCED_OPTION S), this message displays:
Convergence problems, increasing smallest site-fraction from
1.00E-30 to hardware precision 2.00E-14. You can restore using
SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY module calculations, you can use this
command to restore or reset the smallest site fraction to the previous or another preferred
value, as well as to reset other numerical limits.
Syntax

SET_NUMERICAL_LIMITS
Maximum number of iterations /500/:

Prompt By default, the program tries 500 iterations before it gives up. As some models give computation
times of more than 1 CPU second/iteration, this number is also used to check the CPU time and
the calculation stops if 500 CPU seconds/iterations are used.
Required accuracy /1E-6/:

This is a relative accuracy, and the program requires that the relative difference in each variable
must be lower than this value before it has converged. A larger value normally means fewer
iterations but less accurate solutions. The value should be at least one order of magnitude larger
than the machine precision.
Smallest fraction /1E-12/:

This is the value assigned to constituents that are unstable. It is normally only in the gas phase you
can find such low fractions.
The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with
one sublattice site (such as the GAS mixture phase in many databases) for which the default value
is always as 1E-30 (unless you have used the SET_NUMERICAL_LIMITS command to reset an evenlower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).
Approximate driving force calculation for metastable phases /Y/:

Normally the POLY module only requires that the set of stable phases is in equilibrium in order to
terminate the iterations. By default, the metastable phases are included in all iterations but these
may not have reached their most favourable composition and thus their driving forces may be only
approximate.
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Syntax

SET_NUMERICAL_LIMITS

If it is important that these driving forces are correct, choose N to force the
calculation to converge for the metastable phases. This may require more iterations,
and the STEP and MAP command may also terminate due to bad convergence in a
metastable phase.

Thermo-Calc User Guide: Console Mode ǀ 247 of 643

Thermo-Calc Documentation Set

SET_REFERENCE_STATE
This command is available for the POLY, ED-EXP and POST modules.
The reference state for a component is important when calculating activities, chemical
potentials and enthalpies and is determined by the database being used. For each
component the data must be referred to a selected phase, temperature and pressure, i.e.
the reference state.

All data in all phases where this component dissolves must use the same
reference state. However, different databases can use different reference
states for the same element/component. It is important to be careful when
combining data obtained from different databases.

By default, activities, chemical potentials and so forth are computed relative to the
reference state used by the database. If the reference state in the database is not suitable
for your purposes, use this command to set the reference state for a component using SER,
i.e. the Stable Element Reference (which is usually set as default for a major component in
alloys dominated by the component). In such cases, the temperature and pressure for the
reference state is not needed.
In order to specify conditions in the specific reference state, you can append an R to the
state variables. Thus, AC is the activity (of a system component or of a species in a phase)
with respect to the default reference state, and ACR is the activity with respect to the
selected reference state; MU is the chemical potential of a system component with respect
to the default reference state, and MUR stands for the chemical potential with respect to the
selected reference state. The AC and ACR variables, for both components in a system and
species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC
(O2,GAS), LNACR(O2,GAS).
For the POST module, and after calculating with the STEP_WITH_OPTIONS or MAP commands,
the reference state for a component can also be changed to plot various properties of the
component in the entire system or in a specific phase. Then you can set the diagram axes as
the chemical potential or activity quantities with the R suffix, i.e. MUR(comp), MUR
(comp,ph), ACR(comp), ACR(comp,ph) or the common logarithms [e.g. LNACR(comp,ph)].
Syntax

SET_REFERENCE_STATE
Component: <Name of the component>

Prompts

The name of the component must be given.
Reference phase: <Name of a phase used as the new reference state>
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Syntax

SET_REFERENCE_STATE

Enter the Name of a phase for the system.
For a phase to be usable as a reference for a component, the component needs to
have the same composition as an end member of the phase. The reference state is
an end member of a phase. The selection of the end member associated with the
reference state is only performed once this command is executed.
If a component has the same composition as several end members of the chosen reference
phase, then the end member that is selected at the specified temperature and pressure will have
the lowest Gibbs energy.
The following are example using temperature. Pressure is used in the same way:
l

l

l

In the Fe-C system, BCC can be a reference state for Fe but not for C since BCC can exist as
pure Fe but cannot exist as pure C.
If GAS is chosen as the reference phase of component O at such a high temperature that O1
has the lowest energy, then O1 remains the reference state even at calculations performed at
lower temperatures where O2 has a lower energy than O1.
Setting the reference state for component O as gas (one sublattice) with constituents O1, O2
and O3 results in O2 being the reference state if, at the present temperature, pure O2 has the
lowest energy of O1, O2 and O3. If the reference state is set above a critical higher
temperature, then O1 has the lowest energy and consequently becomes the reference state.

Temperature /*/: <Temperature for the reference state>

Select the Temperature (in K) for the reference state. The wildcard value * means the current
temperature is used at the time of evaluation of the reference energy for the calculation.
The temperature set with this command does not affect the temperature used
when evaluating the energy of the reference state during the end member
selection process.
Pressure /1E5/: <Pressure for the reference state>

Select the Pressure (in Pa) for the reference state. The wildcard value * means the current
pressure is used for evaluating the reference energy at the time of calculation.

Examples
S-R-S Fe SER
S-R-S Cr FCC * 100000
S-R-S H2O AQUEOUS * 100000
S-R-S ZE REF_ELECTRODE * 100000
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SET_START_CONSTITUTION
This command is available with the POLY and ED-EXP modules.
This command is similar to SET_ALL_START_VALUES, but is used for an individual phase that
may have a wrong constitution.
Syntax

SET_START_CONSTITUTION
Phase name: <Name of a phase, and possible major constituent(s)>

Specify the name of a phase for which the constitution shall be set.
Prompts

If there is a major constituent of the phase, you must specify this on the same line
as the phase name. By giving an*, select the default major constituents. A $ means
keeping the same constitution, and NONE means to give individual site-fractions.
Y(<Phase>#<Composition_set>,<Constituent>#<Sublattice>) /xxx/: <SF>

The site fraction (SF) of the constituent shall be given. The default value xxx is the
last calculated one.
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SET_START_VALUE
This command is available with the POLY and ED-EXP modules.

This command is not often required as the automatic start values can be
handled for most problems.

Set a start value of an individual variable.
Syntax

SET_START_VALUE
State variable: <Name of a state variable>

Prompts

The state variable must be given.
Value

Specify the value to be assigned the state variable as start value.
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SHOW_FOR_T=
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
Display various thermodynamic properties (state variables, derived/partial variables or
entered symbols) of the currently calculated (stable/meta-stable) equilibrium state but
under a different temperature condition. This is useful for knowing, for example, a volumerelated property of a frozen (stable/meta-stable) equilibrium state at a certain temperature,
where the equilibrated phase assemblage and all the phase compositions are not adjusted
while only the temperature condition is changed.
Use this option carefully. You must have successfully calculated a real equilibrium state
under one temperature condition (normally the temperature for the last heat treatment).
This can then be used to obtain the value(s) of any specified state variable(s) or
derived/partial variable(s) or defined symbol(s) for thermodynamic properties of the entire
system, of components, or of phases for the currently-defined system (being in a frozen
state) under another temperature (normally at room temperature). No real equilibrium is
re-calculated through this option, and thus the phase amounts and compositions in the
system are the same as at the last real equilibrium calculation.

Settings
Temperature (K) /298.15/: <temperature_in_K>

Specify the new temperature condition (in K) under which the values of some specific state
variable(s) or derived/partial variable(s) or defined symbol(s) for various thermodynamic
properties of the entire system, of components, or of phases) in the currently-defined system
(being in a frozen state) is shown on screen.
State Variable or symbol /VM/: <State variable or symbol name(s)>

Specify the name(s) of the desired state variable(s) or derived/partial variable(s) or defined
symbol(s) for various thermodynamic properties of the entire system, of components, or of
phases) in the currently-defined system. More than one state variable or symbol of interest
can be simultaneously specified on the same line. For example, you can choose to show the
values of VM or GM (i.e. molar volume or molar Gibbs energy of the entire system), or of
VM(*) or HM(*).T (i.e. molar volumes or isobaric heat capacity of all phases), or of ACR(*),
DGM(*) and LNACR(*,FCC) [i.e. activities of all system components, driving forces for all
phases, and activities (in logarithm) of all system components in the FCC solution phase],
under the new temperature condition (being in a frozen state).
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SHOW_VALUE
This command is available for the POLY and ED-EXP modules.
Show the current value of any state variable, function or variable.
Syntax

SHOW_VALUE
State variable or symbol: <Name(s) of state variable(s) or symbol(s)>

Prompt

A single or several state variables or symbols (entered functions or variables) can be specified.
The wildcard * can be used to denote all phases or all components.
You can use the dollar-sign $ to denote all stable phases. Thus, the command SHOW W(*,*)lists the
mass fraction of all phases, whereas SHOW W($,*)lists the mass fraction of all stable phases.
If you SHOW a function, all functions are evaluated using the current values of the
state variables. But if you SHOW a variable, it retains its value from the time it was
ENTERED or last EVALUATED.
Therefore to save a value from one calculation to another, ENTER it to a variable. This is frequently
done in the PARROT module to transfer values between equilibria.
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STABILITY_CHECK
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
In some composition ranges of a multicomponent system, it often happens that an unstable
solution phase region locates inside a miscibility gap, and the stability limit (the spinodal
curve or spinodal) may be not easy to find. A system inside a spinodal is thermodynamically
unstable with respect to compositional fluctuations, and the system may experience the
spinodal decomposition (i.e. decomposing to a mixture of regions with the two stable
compositions, one on each side of the miscibility gap).
This option makes it possible to automatically check internal stability of both stable and
unstable phases in all subsequent single-point equilibrium and MAP/STEP calculations. It can
find out if any phase is subject to spinodal decomposition during the subsequent calculations.
If there is an unstable phase located inside a miscibility gap in a calculation, it gives a
warning so that you suspend the unstable phase, or use FORCED automatic start values for
phase constituents (i.e. SET_ALL_START_VALUES → FORCE command-sequence), or create
other composition sets; you can also ignore the warning message if you know that the
unstable phase is not formed in the current calculations.

Settings
Stability check on? /Y/:
Check also for unstable phases? /Y/:

If the automatic stability-check option is switched on choose to also check the stability for
unstable phases. The default is Y and if an unstable phase is found to be located in a
miscibility gas during a subsequent single-point equilibrium or MAP/STEP calculation, a
warning message informs you to selectively make adjustments in the calculation settings
[e.g. suspending the unstable phase, or using FORCED automatic start values for phase
constituents by the S_A_S_V F command-sequence, or creating other composition sets, etc.].
By answering N the stability check is enforced only to stable phases in the system.
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STEP_AND_MAP
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
STEP_AND_MAP is the default ADVANCED_OPTIONS choice and is used to determine how to
perform Global Minimization test and how to handle initial equilibrium points.
Settings for MAP and STEP:
Global test interval /0/: <Integer number>

Settings for MAP:
Automatically add initial equilibria /Y/:
Number of mesh along an axis /3/: <Integer number>
Use inside meshing points /N/:
Global test interval /0/: <Integer number>

The integer number determines how often the Global Minimization should be used during
STEP_WITH_OPTIONS and MAP calculations. If it is set to 0 (zero), the recommended global
test interval is used: i.e. every tenth step and at each phase change during STEP calculations,
and only at node points during MAP calculations. Any other positive integer number, n,
suggests it performs a Global Minimization test at every -th step during STEP and MAP
calculations. Of course, the Global Minimization test is always carried out at a phase change
or a node point. The Thermo-Calc software is installed with 0 (zero) as the default value, but
such a configuration for the default value can be changed by using SET_TC_OPTIONS in the
SYS module.
Automatically add initial equilibria /Y/:

When ADD_INITIAL_EQUILIBRIUM is not used before MAP, a mesh of initial equilibrium
points are added before the mapping itself takes place. This mesh is only available when two
(2) axes are already defined. The default on start-up may be changed by SET_TC_OPTIONS in
the SYS monitor.
Number of mesh along an axis /3/: <Integer number>

An integer for how many intervals of initial equilibrium points to be added along an edge in
the diagram. For example, if set to 2 (two), initial equilibrium points are added at the
beginning, center, and end of each axis-variable forming 2 intervals.
Use inside meshing points /N/:

Thermo-Calc User Guide: Console Mode ǀ 255 of 643

Thermo-Calc Documentation Set

If N the INITIAL_EQUILIBRIUM mesh consists of initial equilibrium points added only along
the edge/border of the diagram defined by the axis-variables. If Y, the initial equilibrium
points added are also added to the inside edge.
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STEP_WITH_OPTIONS
This command is for the POLY module.
The STEP_WITH_OPTIONS (short name, STEP) command initiates the stepping procedure to
make a calculation of property diagrams in a multicomponent heterogeneous system. A
property diagram is usually stepped under one defined independent stepping axis-variable,
and is often constructed by the defined independent mapping axis-variable against a chosen
property (for the system, or for a specific phase, or for a certain species).
In the POLY module, it is possible to compute a series of equilibria with one condition as the
stepping axis variable. This is achieved by first calculating a single equilibrium, and then
selecting one of the conditions as the axis variable. The minimum and maximum value and
the incremental step along the axis must also be given. By default, the global minimization
technique is used .
A property diagram consists of property lines that change (normally) along with
the stepping axis-variable. From a single STEP calculation, many different types
of property diagrams in the defined multicomponent heterogeneous systems
can be plotted. Various types of property diagrams are generated by the
stepping calculations.
About Property Diagrams
Normally, before the command can be invoked, you need to have already calculated an
initial equilibrium point and set one independent variable (i.e. the controlling condition in
the system) . This is done using SET_AXIS_VARIABLE. You then list the current values of the
axis variable for each calculated equilibrium, as well as the corresponding information when
the set of stable phases changes.
By default, the global minimization technique is enabled, You can turn this off by using the
command-sequence ADVANCED_OPTIONS → GLOBAL_MINIMIZATION.
You can choose how often to do a global minimization test using the commandsequence ADVANCED_OPTIONS → STEP_AND_MAP → GLOBAL TEST INTERVAL.
Syntax

STEP_WITH_OPTIONS
Option? /Normal/: <A chosen option, N, I, S, O, E, M, T, or P>

Prompt N = Normal, I = Initial equilibria, S = Separate phases, O = One phase at a time, E = Evaluate, M =
Mixed Scheil, T= T0, and P Paraequilibrium
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Normal (N)
When you accept the default, Normal (N), it allows a stepping calculation with the chosen
independently-varying equilibrium condition (axis-variable). Only the step axis value is
changed between each step.
When you repeat the STEP → NORMAL command-sequence, you can make several stepping
calculations while still keep all the stepping-calculation results in the current POLY3
workspaces.
The calculation results are saved in the default RESULT.POLY3 file or you can
specify to save it in the <MyName>.POLY3 file. This is as long as there is no SAVE_
WORKSPACES command before the second set of command sequences (STEP →
NORMAL). Repeated stepped results can be restored into the same current
POLY3 workspaces/file.
Linux and Mac are case sensitive so ensure you enter .POLY3.
The addition of several steps enables you to generate special types of property diagrams and
to calculate and plot special phase boundary lines on phase diagrams, such as:
l

l

l

The missing part(s) of a specific property [that are calculated under another
controlling condition inside the range of the stepping-variable] on the same property
diagram.
Two or more sets of a specific property [that are calculated under different
controlling conditions and stepped over the same stepping-variable range] on the
same property diagram for the same system.
Calculate some special phase-boundary lines [especially for some defined secondary
phase transformations or alike, e.g. the BCC_A1 <--> BCC_B2 phase-boundary, or
equal-Gm for two specific phases, or equal-fraction or equal-activity for a certain
species in two specific phases, that shall be calculated under different controllingconditions and also be stepped over different stepping variable(s)], and then plot (or
impose) them onto a corresponding phase diagram (which can be resulted from
several such STEP → NORMAL calculations or even from a separate MAP
calculation) for the same system.

Initial_Equilibria (I)
An initial equilibria is added at each calculated point. This can be useful, for instance, to
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generate a set of isothermal calculations.
When you choose I, an initial equilibrium is stored at each calculated equilibria. It is
intended to generate a matrix of calculated initial equilibria, first stepped under a STEP
INITIAL_EQUILIBRIA command-sequence and then repeated by another STEP NORMAL
command-sequence (or even continued by a MAP command).
For example, you can first use the temperature condition as the stepping axis-variable with
this option, which calculates a number of initial equilibrium points and automatically adds
each one as an initial equilibria for another STEP → NORMAL command-sequence (or even
for a MAP command). Before the second STEP command (i.e. the STEP → NORMAL
command-sequence), you can chose a compositional condition as the new stepping axisvariable; then the STEP → NORMAL command-sequence uses those created starting
equilibrium points (at different temperatures) and steps in such a new compositional
variable. As a result, these two STEP commands together give a matrix of values.

Separate_Phases (S)
In this way, you can calculate how the Gibbs energy for a number of phases varies for
different compositions. This is particularly useful to calculate Gibbs energies for complex
phases with miscibility gaps and for an ordered phase that is never disordered (e.g.
SIMGMA-phase, G-phase, MU-phase, etc.).

One_Phase_at_Time (O)
This option is recommended for STEPPING heterogeneous systems with both ordered phases
and the disordered pairs.
When you choose O, the stepping calculation is conducted individually for one phase at a
time. That is, it is stepped over the whole stepping variable range, but the stepping is
repeated for all the entered phases in the defined system. This is particularly useful to
properly step in composition for an equilibrium heterogeneous system with both ordered
phases and the disordered pairs. Thus, instead of calculating for the same composition for
each of the phases at each composition step, it starts the stepping in each of the phases in
the default most-stable compositions (the major constitutions).

Evaluate (E)
For Scheil-Gulliver simulations it is recommended you use the SCHEIL module.
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Evaluate E is an advanced option and is useful when additional conditions (instead of the
stepping variable) require changing during a stepping calculation. It allows a stepping
calculation in a single axis with simultaneous evaluation of one or more variables after each
step. As variables can be used as conditions, it means that you can change the conditions
during the stepping. After a successful EVALUATE calculation, you can go to the POST
module to manually define and plot property diagrams.
The variables given are evaluated after each step, which may change other
conditions. This can be useful to perform the Ordinary ScheilGulliver Approach
(non-equilibrium transformations) for simulating alloy solidification without
back diffusion of fast-diffusing interstitial components in solid phases. However,
it is recommended you use the SCHEIL module.
Specify the prompt:
Variable name(s): <Variable name>

The names of the variables that shall be evaluated after each step must be typed here.
The miscibility gap test is automatically used during stepping (see ADVANCED_
OPTIONS) if a phase has two or more composition sets.
The miscibility gap test means that you can start calculating from high temperatures in a
steel where the MC carbide is not stable. During the calculation, the MC carbide first
becomes metastable with a composition different from the metallic FCC phase and later
also becomes stable.
See Console Mode example tcex30A.

Mixed_Scheil (M)
For Scheil-Gulliver simulations it is recommended you use the SCHEIL module.

This is an advanced stepping calculation designed for the Extended Scheil-Gulliver Approach
(partial-equilibrium transformations) to simulate alloy solidifications with back diffusion of
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one or more fast-diffusing interstitial components (such as C, N, O, S, etc.) in solid phases is
performed. It also will consider BCC-->FCC phase transformation (practically for steels)
along the alloy solidification process.
To ensure a successful stepping calculation of mixed Scheil-Gulliver simulation of
solidification process of a defined alloy system with a certain initial overall composition, it is
important to note the following:
l

l

l

l

l

For solution phases with possibility of miscibility gap existence, you have
appropriately added the necessary composition set(s);
You have already set the temperature condition as the stepping SET_AXIS_VARIABLE
command, with minimum and maximum temperature points as well as an
appropriate s temperature step for the cooling process).
There must be a composition condition for each of the back diffusion components
(i.e. fast-diffusing interstitial components, such as C, N and/or other elements) that
are already defined in terms of mole-fraction or mass-fraction, e.g. X(C) and W(N).
Otherwise, a stepping calculation with this option can fail.
An initial equilibrium in which the LIQUID mixture phase is the only stable must be
calculated. This is why it is good to start with a relatively high temperature condition
for the initial equilibrium calculation. It is always necessary to reject or suspend the
GAS mixture phase (if it exists) before the C-E and STEP commands, to avoid its
formation along with LIQUID.
In cases where fast-diffusing interstitial components are specified as back diffusion
components, you can choose to allow BCC>FCC phase transformation (practically for
steels) during the alloy solidification process.

These are the prompts for this option:
Fast diffusing components: <Fast diffusion interstitial(s)>

Specify one or more interstitial component(s) as the back diffusion component(s).
l
l

l

If there is only one fast-diffusing interstitial component (e.g. C or N), type its name;
If there are two or more fast-diffusing interstitial components (e.g. C, N and S),
always type the names on the same line at once (separated by an empty space in
between, e.g. C N S);
If there is no fast-diffusing interstitial component to be considered, type NONE to
ignore back diffusion entirely, meaning a normal Scheil-Gulliver simulation is
performed.

Thermo-Calc User Guide: Console Mode ǀ 261 of 643

Thermo-Calc Documentation Set

Such specified back diffusion interstitial component(s) must be appropriately
defined according to the phase constitution definitions of some major alloy
solution phases (e.g. FCC, BCC, HCP, etc.). These are located on the
interstitial/vacancy sublattices in such alloy solution phases; otherwise, such a
Scheil-Gulliver simulation may not make sense at all.
Allow BCC -> FCC ? /Y/:

By default the BCC-->FCC phase transformation is allowed. This is usually a typical
phenomenon along the cooling processes of steels/Fe-alloys.
During the calculation the simulated solidification path, including the locally-equilibrated
phase assemblage (region), captured temperature condition (T in K), remaining liquid phase
(NL, mole fraction), overall formed solid phases (NS, mole fraction) and latent heat
formation (NH, J/mol) along the cooling process are shown after the information on starting
temperature point of the alloy solidification process, e.g.
Solidification starts at

1743.15 K

Phase Region from

1.744150E+03 for:

Phase Region from

1.742525E+03 for:

LIQUID

LIQUID
FCC_A1#1
1742.5250

0.9960

0.0040

-1.1824

1742.4000

0.9795

0.0205

-202.1585

Phase Region from

. . . . . .

1.733150E+03 for:

LIQUID
BCC_A2
FCC_A1#1
1733.1500

0.3294

0.6707

-8032.6240

1733.0250

0.3237

0.6763

-8095.1490

. . . . . .

After a successful calculation, you can go to the POST module to manually define and plot
property diagrams for the alloy solidification process according to the chosen Scheil-Gulliver
model, or to impose existing relevant experimental information or other types of calculated
solidification results [e.g. Scheil-Gulliver simulation with or without considering fast-diffusing
interstitial component(s), full-equilibrium approach, or Diffusion Module (DICTRA)-type
simulation with moving-boundary conditions] onto the same plotted property diagrams.
Normally, the solidus temperature (T in Celsius) is set as one of the axis variables (usually as
Y-axis in most cases), while the other plotted quantity on the other axis can be the amount of
overall formed solid alloy phases (NS in mole-fraction or BS in mass-fraction), the amount of
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remaining liquid phase (NL in mole-fraction or BL in mass fraction), the heat of latent along
the solidification process (NH in J/mol or BH in J/gram), among many other properties in the
solidified alloy phases or in the whole alloy system.

T-zero (T)
See Console Mode example 41.
This advanced option allows a stepping calculation of the so-called T0 (T-zero) line in a
diffusionless transformation (where two specific partially-equilibrated phases have the same
Gibbs energy) along a composition variable which has already set as the stepping variable
with SET_AXIS_VARIABLE.

The temperature condition cannot be set as the stepping variable if you want to
make a STEP T-ZERO calculation.

Prior to performing the step T0 command sequence, and to ensure a successful
calculation of T0 line between two specific phases after an initial equilibrium
calculation in the current system, it is sometimes recommended to make a
single T0 point calculation using ADVANCED_OPTIONS → T-ZERO.
Specify these prompts:
Name of first phase:

<Phase A>

Name of second phase: <Phase B>

The names of the target phases, for which the Gibbs energies equal to each other at each
point on the T0 line, must be entered.
During the calculation, the T0 values are shown after the corresponding scanned conditions
(of the stepping composition variable), e.g.
Phase Region from

1.000000E-01 for:

BCC_A2
FCC_A1
1.000000E-01

940.24

9.250000E-02

941.20

. . . . . .
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2.500000E-03

977.61

7.500000E-09

979.34

Phase Region from

1.000000E-01 for:

BCC_A2
FCC_A1
1.000000E-01

940.24

1.075000E-01

939.62

. . . . . .
2.950000E-01
3.000000E-01

1084.87
1080.99

After a successful calculation, you can go to the POST module to plot the T0 line against the
stepping composition variable or another varying axis, or to impose the calculated T0 line
onto a normal phase diagram [normally plotted as a T-X isopleth].

Paraequilibrium (P)
See Console Mode examples 42 and 43.
This is an advanced option. Select P to calculate the paraequilibrium state between two
specific phases (the paraequilibrium lines). It allows a stepping calculation of
paraequilibrium lines where the chemical potential for one or more interstitial components
(that are considered as back diffusion elements, such as C and N) but not for the other (s) in
two partially equilibrated phases are equal.
More than one interstitial component can be treated as fast-diffusion species (such as C, N,
O, S, etc., as individual or combined) in a paraequilibrium stepping calculation.
The composition condition for the interstitial components cannot be set as the
stepping variable if you want to make this calculation.
To ensure a successful stepping calculation of paraequilibrium states between two specific
phases in a defined alloy system, it is important to first make a starting-point equilibrium
calculation with an initial overall composition in the current system. However, it is
unnecessary to obtain an equilibrium in which either one or both of the target phases is
stable.
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The initial overall composition must have a reasonable setting for the desired
paraequilibrium calculation for the two target phases. This is especially true where there is
more than one interstitial component to be considered in the paraequilibrium state, because
different interstitial components (for example C and N combined) may have significant
different behaviours as partitioning into different structured phases; otherwise, for one
chosen interstitial component the initial overall composition is OK for the paraequilibrium
calculation between the specified two phases, but for other chosen interstitial component(s)
it might be impossible to calculate the paraequilibrium state.
Always check if the chosen phaseA and phaseB have the exact same definition of elements
and if the chosen interstitial components are all in the vacancy sublattice sites of the two
phases; otherwise the program cannot find the paraequilibrium state (as it is impossible to
correctly calculate u-fractions).
Always have a comprehensive understanding of the normal phase diagram for the currently
investigated system, so that you make the appropriate choice of the phase pair and staring
bulk composition for the system.
Always set the status of the chosen interstitial components as SPECIAL using the command:
CHANGE_STATUS COMPONENT <interstitial component> = SPECIAL

By doing this, you get a clear picture on u-fractions of various substitutional and interstitial
components, which are different from the overall composition in the system. The SPECIAL
status means that specified component(s) are not included in summations for mole or mass
fractions. Therefore, all the composition variables plotted from the paraequilibrium
calculations are u-fraction related quantities.
Always make a single-point paraequilibrium calculation by the command-sequence of
ADVANCED_OPTIONS → PARAEQUILIBRIUM, prior to performing this STEP →
PARAEQUILIBRIUM command-sequence, although this might not be always necessary for
some systems.
With this stepping calculation specify the following:
Name of first phase:

<Phase A>

Name of second phase: <Phase B>

The names of the two target phases A and B, between which the paraequilibrium states
establish, must be typed at the above two prompts subsequently or on the same (first) line at
once (separated by an empty space, e.g. FCC BCC, FCC#2 M23C6).
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It is important to understand that this is the calculation of a paraequilibrium
state between the two specified phases.

Particularly, there are these issues to consider:
1. Both chosen phases must have similar interstitial/vacancy sublattices where the fastdiffusion interstitial component(s) occupy.
2. The choice on the target phase pair must be reasonable for the defined system and
specified initial overall composition.
3. Both target phases should have phase constitution definitions that cover all the
defined substitutional and interstitial components of the current alloy system; or
4. It is impossible to calculate the paraequilibrium state between the target phase pairs
with given interstitial component(s) in the currently defined system.
Fast diffusing component: /C/: <Interstitial component(s)>
Fast diffusing component: /None/: <Interstitial component(s)>

The name(s) of the fast-diffusing interstitial component(s) (C as the default single
component) must be given either one by one at each of the above prompts subsequently or
in a combination (separated by an empty space in between, e.g. C N S) at the same (first)
prompt; otherwise, press <Enter> key to start the paraequilibrium line stepping-calculation.
Note the following:
Such specified fast-diffusing interstitial component(s) must be appropriately defined
according to the phase constitution definitions of the two selected phases: These must be
located on the interstitial/vacancy sublattices in both chosen phases.
If there is only one fast-diffusing component which is carbon, press <Enter> to accept the
default value (C) at the first prompt; if the single fast-diffusing interstitial component is
another element (e.g. N), appropriately type interstitial component the name at the first
prompt;
If there are two or more fast-diffusing components (e.g. C and N), type their names at the
above prompts subsequently or at the same (first) prompt (separated by an empty space,
such as C N);
To finish the input of fast-diffusing elements, accept NONE at a repeated prompt;
If NONE or a non-existing component name is typed at the first prompt, it means no back
diffusion is to be considered, and the para-equilibrium calculation is thus cancelled entirely.
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During the STEP → PARAEQUILIBRIUM calculation procedure, the calculated
paraequilibrium states include the:
l

corresponding stepping conditions (e.g. temperature in K, or the stepping
composition variable of the matrix component or of one of substitutional
components) which has already set as the stepping variable by the SET_AXIS_VAR
command);

l

amounts of the phase A in mole number [i.e. NP(phaseA)];

l

amounts of the phase B in mole number [i.e. NP(phaseB)];

l

l

l

contents of the interstitial component(s) in the phase A expressed in u-fractions [i.e.
u-f(phaseA,component(s))];
contents of the interstitial component(s) in the phase B expressed in u-fractions [i.e.
u-f(phaseB,component(s))];
LNACR(component)

value(s) for the interstitial(s).

After a successful STEP → PARAEQUILIBRIUM calculation, you can go to the POST module to
plot a paraequilibrium phase diagram, or to impose the calculated paraequilibrium states
onto a normal phase diagram [normally plotted as a T-X isopleth with one of the considered
interstitial component(s) as the x-axis variable].
However, the stepping calculation procedure for the currently specified paraequilibrium
states between the two specified phases may find difficulties at some steps due to some
possible numerical problems (normally regarding to the u-fractions of the interstitial
components under some composition ranges), or it may completely fails. In the latter case,
it implies that the chosen target phase pair may be unreasonable for the defined alloy
system or for the defined initial overall composition, or one or both phases may have
inappropriate phase constitution definitions regarding the specified interstitial component(s)
and substitutional components. Then, you must either modify the settings of initial overall
composition or specify the reasonable target phase pair with an appropriate choice of the
fast diffusion interstitials in the defined alloy system.
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The figure shows the plot of a paraequilibrium calculation of isopleths: Formation of para-pearlite
in two Fe-based alloys, with equilibrium results appended.

The calculated paraequilibrium phase boundaries (black lines) are shown with
tie-lines (in green-colour). In the Fe-2.5Mn-C alloy system, C is considered as
fast diffusing interstitial component in the BCC+FCC and FCC+Cementite
paraequilibrium stepping calculations; while in the Fe-3Cr-N alloy system, N is
treated as fast diffusing interstitial components in the BCC+FCC and FCC+FCC_
M1N (i.e. FCC#1+FCC#2) paraequilibrium stepping calculations.

During a STEP calculation, the value of the stepping axis variable for each
calculated equilibrium is listed and also the set of stable phases.

You can terminate the mapping of a line by pressing a single <Ctrl-A>
(Windows) or <Ctrl-C> (Linux). This can be useful in order to stop a longish
calculation without losing what is already calculated.

If there is any convergence problem in finding a stable solution at any stage during a
calculation procedure enforced by a STEP_WITH_OPTIONS command-sequence, this message
displays:
Convergence problems, increasing smallest site-fraction from 1.00E-30
precision 2.00E-14. You can restore using SET-NUMERICAL-LIMITS

to hardware

This implies that smallest site fraction in the current POLY3 workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY-module calculation in the current TC run,
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you can use the POLY command SET_NUMERICAL_LIMITS to restore or reset the smallest site
fraction to the previous or another preferred value, as well as to reset other numerical
limits.
Complex miscibility gaps of various solution phases are automatically detected during a
stepping calculation, and two or more composition sets for each of such solution phases are
automatically generated as well, through an automatic Global Minimization Test procedure
(by specifying a Global Test Interval value and confirming the Automatically add
initial equilibria in the ADVANCED_OPTION STEP_AND_MAP command-sequence). As a
particular case, such an automatic Global Minimization Test ensures that you can now start
calculating from high temperatures in an austenitic steel (metallic FCC_A1 solution phase)
where the MC carbides/nitrides/carbonitrides (i.e. the C-/N-rich sides of the FCC_A1
miscibility-gap, often (while not always) being referred to as FCC_A1#2, FCC_A1#3, etc.) are
not stable, and during the MAP command the MC carbides/nitrides/carbonitrides may first
become metastable with a composition different from the metallic FCC_A1 phase and later
also stable.
Occasionally, it may be necessary to have a specified increment other than the default value
for the defined stepping axis-variable, in order to calculate/plot a smoother property
diagram.
To get a complete property diagram, sometimes (especially in some earlier Thermo-Calc
versions) it may also be required to have more than one starting equilibrium-points (under
another starting equilibrium condition), and repeat the stepping calculation over the same
stepping axis-variable range (while without over-writing the same POLY3 workspaces via a
SAVE_WORKSPACE command). However, using the current STEP procedure such a
requirement become less necessary.
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TABULATE
This command is available for a table entered in either the POLY or POST
module.
For any entered table, this command gives a table of values from equilibria calculated with
a STEP command.
Unlike the TAB module's command (also called TABULATE) it is not possible to
plot columns from the tabulated tables. For this use normal POST commands.
Syntax

TABULATE
Name: <Name of a table entered in either POLY or POST>

Prompts

Specify a table name that is entered in either the POLY or POST module.
Output on screen or file /Screen/:

Specify a file name if you want to save on a file the table values along the defined STEP calculation,
or press <Enter> if want to see the table values displayed.
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TOGGLE_ALTERNATE_MODE
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
Toggle the ALTERNATE mode for experimental equilibrium calculation between DEFAULT,
ALWAYS and NEVER, during data-assessments using the PARROT optimization.
Set alternate toggle to DEFAULT, ALWAYS, or NEVER?
Set global toggle to DEFAULT, ALWAYS, or NEVER?
l

DEFAULT: the

experiment points are calculated according to the Alternate Technique
depending on the SET_ALTERNATE command.

l

ALWAYS: the

l

NEVER: the

experiment points are always calculated according to the Alternate
Technique even if the Alternate Mode is switched off in the PARROT module.
experiment points are calculated as normal equilibria even if you SET_
ALTERNATE in the PARROT module.
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T-ZERO_TEMPERATURE
This is an option that is available with the ADVANCED_OPTIONS command with
the POLY and ED-EXP modules.
ADVANCED_OPTIONS
This calculates the temperature when two specific phases have the same Gibbs energy, i.e.
the so-called T0 temperature. You must calculate an equilibrium state at an estimated
temperature before performing this advanced-option calculation; however, it is unnecessary
to obtain an equilibrium state in which either one or both of the target phases is stable.
The following prompts are shown.
Name of first phase:

<Phase A>

Name of second phase: <Phase B>

The names of phases A and B must be given, for which the T0 temperature (where the Gibbs
energies are equal) is to be calculated.
If the T0 temperature between the two specified phases is successfully calculated, a
message displays, e.g.
The T0 temperature is 840.82 K. Note: LIST-EQUILIBRIUM is not relevant

The first message shows the calculated T0 temperature between the two specified phases.
The second message indicates that after this option calculation with LIST_EQUILIBRIUM is
irrelevant and does not list the equilibrium for the system at the T0-temperature.
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REINITIATE

325

SAVE_GES_WORKSPACE

326

SAVE_WORKSPACES

327

SET_R_AND_P_NORM

329
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Solution Models in the GIBBS (GES) Module
AMEND_PHASE_DESCRIPTION
The AMEND_PHASE_DESCRIPTION command is used to specify/amend phase descriptions if a
phase has a miscibility gap, uses a special excess energy model, or has a specific additional
contribution to its Gibbs energy, for example.
This topic outlines the application of each option and includes important information about
each command.
There are many solution models implemented in the GIBBS module (type INFO MODELS to
see details about various thermodynamic models). However, these are switched on and
handled differently via various GIBBS routines/commands:
l

l

l

The first models the non-ideality as excess parts, i.e. by amending the phase’s
EXCESS_MODEL and/or TERNARY_EXTRAPOLAT models.
The second models the non-ideality as ADDITIONAL parts, i.e. by amending the
phase’s other subjects in this command, e.g. MAGNETIC_ORDERING for the Magnetic
Ordering Model, DISORDERED_PART for the CVM Approach in modelling chemical
ordering/disordering phenomenon, QUASICHEM_IONIC for using a quasi-chemical
entropy term for an ionic two-sublattice liquid solution phase, QUASICHEM_FACT00
or QUASICHEM_IRSID for describing a substitutional liquid solution phase, DEBYE_
HUCKEL for the DHLL/SIT Model in describing a dilute aqueous solution phase, etc.
The third implements the model entirely or partially into the GIBBS module and
related database(s), such as for the electrostatic contribution in an AQUEOUS
solution phase by the Complete Revised_HKF Model, the Murngham Model, BirchMurngham Model or Generalized PVT Model for high-pressure/temperature volume
contribution in a solid or liquid phase, the SUPERFLUID Model for the non-ideal EOS
and non-ideal mixing in a gaseous mixture.
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NEW_CONSTITUENT
Use this if you want to add a new constituent to a phase. It is illegal to add new constituents
to an ionic two-sublattice liquid phase.

RENAME_PHASE
Use this to change the names of some specific phases. For example, a phase called FE3O4_S
may be better named Magnetite to help identify it during the calculations and
postprocessing. This is also a way to delete a phase by hiding it under a new name.

SITE_RATIOS
Use this to change the number of sites (i.e. the stoichiometric coefficients of various
sublattices) in a sublattice phase.

COMPOSITION_SETS
Use this for solution phases that may have miscibility gap(s). However, this is less important
today and often unnecessary to define additional composition set(s), since the implemented
Global Minimization Technique can usually detect and add such composition set(s) in an
automatic manner where it is really necessary during equilibrium calculations (of singlepoints, stepping or mapping).

MAJOR_CONSTITUENT
Use this to set major constituent(s) on each sublattice in each composition set for a solution
phase. This is useful to make calculations converge faster because it may simplify giving
start values when calculating the equilibrium as those phases with miscibility gaps should
have different major constituents for each composition set. The databases often set major
constituents for several phases automatically when data are retrieved.

FRACTION_LIMITS
Use this to limit the application range (in terms of mole-fractions of all the involved
elements) of a particular solution phase. This is useful to avoid automatic creations
(enforced by the Global Minimization Technique) of additional composition sets for some
solution phases (such as AQUEOUS solutions or dilute Fe-based liquid mixtures) of which the
used models [e.g. the SIT Model or the Complete Revised_HKF Model for AQUEOUS
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solution, or the modified dilute solution parameters (plus a quadratic term, according to
Hillert (1986) based on the SigworthElliot Model (Sigworth and Elliot, 1974) for Fe-rich liquid
mixture] cannot be appropriately applied on a full scale.
Globally set the composition limits (in terms of mole fractions of various elements) in a
specific solution phase, so that whenever the program finds a potential phase composition or
a new composition set of possible miscibility gap(s) but that is out of this globally-set
composition range, the program automatically ignores such a phase composition in an
equilibrium calculation. This can be done either permanently inside a database (by enforcing
this option for amending the phase-description of the solution phase) or temporarily within
the GIBBS module (by using this phase-description amendment option).
This is important for solution phases for which the thermodynamic models and assessed data
for the phases are for specific composition ranges, for example, the FE_LIQUID phase in the
SLAG database is only applicable for Fe-rich liquid mixture, and the AQUEOUS phase in the
TCAQ/PAQ and AQS/PAQS databases is only applicable for H2O-dominant aqueous solution
phase.
Specify the low and high mole-fraction limits for each of the elements possibly available
within the considered phase (in the currently defined system, or in a certain database). Do
this for all the possible elements (defined in the phase) in a single AMEND_PHASE_
DESCRIPTION FRACTION_LIMITS command-sequence, for example:
TYPE_DEFINITION R GES AM_PH_DES FE_LIQUID FRACTION_LIMITS Fe 0 0.6

U

Ag 0 0.01

Al 0 0.05

Ca 0 0.05

Co 0 0.01

Cr 0 0.01

Cu 0 0.02

Mg 0 0.05

Mn 0 0.05

Mo 0 0.05

Nb 0 0.05

Ni 0 0.05

Pb 0 0.05

Si 0 0.10

Sn 0 0.02

Ti 0 0.05

0 0.01
B

P

V

0 0.02

0 0.01

0 0.01

S

C

W

0 0.02

0 0.01

0 0.01

H

Zr 0 0.03

0 0.01

N

0 0.01

O

0 0.01

!

DISORDERED_PART
This command is needed for the special treatment of chemically-ordered phases where the
contributions from the disordered state are described by a phase without ordering
sublattices (the disordered phase name must be specified).
Several checks are made that the ordered and disordered phases are compatible
(sublattices, sites and constituents). A link is then created between the phases, and the
disordered phase is hidden from application programs. The Gibbs energy for the ordered
phase also includes the Gibbs energy for the disordered phase.
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Phases which can have an order/disorder transformation have parameters split on two
phases and are referred to as the two phase description in the GIBBS module. One of them
has sublattices for chemical ordering, the other one represents the disordered state.
Normally, the ordered BCC and FCC or HCP phases may have either 2 or 4 substitutional
sublattice (plus one additional interstitial site), that are handled by the Two SubstitutionalSublattice Ordering Model or Four Substitutional-Sublattice Ordering Model, respectively.
Two phase means that the ordered phase has parameters that describe the ordering. The
disordered phase has all parameters for the reference state and those for describing the
disordered phase. The ordered phase may occur only is some systems whereas the
disordered phase may occur frequently, typical examples are the disordered FCC and BCC
which may become ordered as L12 or B2 in certain systems. In order to treat
multicomponent systems where some subsystems have ordering it would be necessary to
transform all parameters of BCC into a B2 model.
The parameters describing the disordered phase are not changed but the Gibbs Energy
system is informed that the Gibbs Energy for the two phases should be added.
The method used calculates the Gibbs Energy of a two phase model with two or four
substitutional sublattices for ordering.

The mole fractions xi are calculated from the site fractions yi. The last term
means that the contribution from Gmord in a disordered state (same site
fraction, equal to the mole fraction, on both sublattices) is subtracted. The
effect of this is that the parameters in the ordered phase have no contribution
to the disordered state.

MAGNETIC_ORDERING
Change the magnetic ordering parameter for a certain phase with magnetic ordering
contribution, in terms of its anti-ferromagnetic factor. By default this is –1 for BCC phase
and –3 for all other phases (FCC, HCP, etc.). The fraction value of the total enthalpy (due to
short-range ordering above the magnetic transition temperature) is by default 0.40 for BCC
phase and 0.28 for all other phases (FCC, HCP, etc.).

EXCESS_MODEL
See example tcex52.
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Use this to change the default Excess Model (for interaction energies) from the default
(REDLICH-KISTER_MUGGIANU). The model handles the excess interaction energies in a
solution phase is chosen from:
l

REDLICH-KISTER_MUGGIANU: for binary (R-K) & ternary (R-K-M) interactions

l

REDLICH-KISTER_KOHLER: for binary (R-K) & ternary (R-K-K) interactions

l

l

FLORY-HUGGINS POLYMER MODEL: for interactions in a polymer mixture phase (FH)
MIXED-EXCESS-MODELS: (R-K default) for mixed binary excess model (R-K, Legendre
& Polynom) of a substitutional solution phase

l

HKF: for interaction in an AQUEOUS solution phase (HKF)

l

PITZER: for interaction in an AQUEOUS solution phase (PIT)

l

CENTRAL_ATOM_MODEL: for interaction in a liquid slag solution phase (C-A-M)

For extrapolations of excess energies from related binary systems to ternary or higher-order
systems, the Redlich-Kister binary excess interaction parameters may be extrapolated with
either a Muggianu extension (i.e. the default REDLICH-KISTER_MUGGIANU model) and a
Kohler extension (i.e. the alternative REDLICH-KISTER_KOHLER model), where there is no
ternary, quaternary or higher-order interaction parameter.
The REDLICHKISTER_KOHLER model is implemented only for ternary systems.
The MIXED-EXCESS-MODELS option works only for a substitutional phase with no sublattice
(such as the metallic LIQUID phase) and it can be used to invoke asymmetrical simple or
Legendre polynomial as binary excess energy models in addition to the default symmetrical
Redlich-Kister model for the chosen pair of constituents in a substitutional phase with no
sublattice. Asymmetrical here means that the power series depend only on one of the
constituents, for example with expansions based on the [1-2*X(B)] term rather than [X(A)X
(B)].
Binary interaction parameters for such a pair of constituents must be entered
prior to turning on the non-default Legendre or Polynom models.

TERNARY_EXTRAPOLAT
See example tcex52.
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Use this to change the extrapolation method from the default REDLICH-KISTER_MUGGIANU to
another extrapolation model. This method extrapolates from binary to ternary (and higherorder) excess interaction parameters in a solution phase and is chosen from:
l

MUGGIANU for Muggianu Extrapolation from R-K parameters

l

TOOP-KOHLER for Toop-Kohler Extrapolation Model

l

KOHLER-ALL for Kohler Extrapolation Model

l

MUGGIANU_RESTOR for Muggianu-Restor Extrapolation Model
Only when all the relevant binary excess energies in the current solution phase
are treated by the default Redlich-Kister Model (i.e. the Mixed-Excess-Model
should have not been used), the MUGGIANU_RESTOR method for ternary
extrapolations is equivalent to the Redlich-Kister_Muggianu Model, or the
KOHLER-ALL method to the RedlichKister_Kohler Model.

The default ternary extrapolation method MUGGIANU_RESTOR applies to a solution phase as a
whole, whatever the binary excess model(s) enforced to each of individual binary pairs in
the phase. In case that all the binary pairs in the phase use the default binary excess model
REDLICH-KISTER, then the ternary extrapolation method becomes the so-called RedlichKister_Muggianu Model (in short as R-K-M), for extrapolations from binary parameters to
ternary (and higher-order) excess energy terms; when no ternary L parameter is entered for
that, such a default R-K-M Model is always used.
The KOHLER-ALL ternary extrapolation method can be turned on also for a solution phase as
a whole, whatever the binary excess model(s) enforced to each of individual binary pairs in
the phase. In case that all the binary pairs in the phase use the default binary excess model.
REDLICH-KISTER, then the ternary extrapolation method becomes the so-called RedlichKister_Kohler Model (in short as R-K-K), for extrapolations from binary parameters to
ternary (and higher-order) excess energy terms; when no ternary L parameter is entered for
that, such an R-K-K Model is used.
The TOOP-KOHLER ternary extrapolation method is applied in a special way: for a specific
ternary system (e.g. A-B-C) in a solution phase, specify which two constituents as the socalled Kohler constituents and the remaining constituent as the so-called Toop constituent on
a given sublattice. If for the A-B-C ternary system you have specified A and B, or B and A, as
the Kohler constituents (entered as the basis constituent and first interacting constituent)
and C as the Toop constituent, only the A-B binary interaction parameters are used in
accordance with the Kohler ternary extrapolation formula for A-B-C ternary interaction,
while any other binary interaction parameters involving the Toop species C (i.e. of A-C and
B-C binaries) are used in line with the Toop-Kohler ternary extrapolation formula (for the AC-B and B-C-A ternary interactions).
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DEBYE_HUCKEL
To use the DHLL (Debye-Hückel Limiting Law) model and SIT (Specific Ionic Interaction
Theory) model for a dilute AQUEOUS solution phase, switch the DEBYE_HUCKEL part on, and
it removes previously set (if any) ADDITIONAL part on the non-ideality for the chosen
AQUEOUS phase.

HKF_ELECTROSTATIC
To use the hypothetical electrostatic contribution for the chosen phase (it must be an
aqueous solution phase using the Complete Revised_HKF Model). It removes previously set
(if any) ADDITIONAL part on the non-ideality for the chosen AQUEOUS solution phase.

QUASICHEM_IONIC
To use the Quasichemical-Ionic model for the chosen liquid phase, you must have already
entered/retrieved a liquid phase as an ionic two-sublattice liquid solution phase (normally,
that is the IONIC_LIQ phase), and then use this amending option to switch QUASICHEM_
IONIC on. It creates a completely new liquid solution phase [namely the QUAS_IONIC phase
which uses the Quasichemical Model for the entropy, according to Mats Hillert (2001: J of
Alloys and Compounds, 320, 161-176)], while the original IONIC_LIQ phase remains in the
system and is not changed by this option.

QUASICHEM_FACT00
See example tcex49.
To use the Quasichemical Model developed by Kongoli et al. [1998, Kongoli], you must have
entered/retrieved a liquid phase using a normal substitutional liquid model with specified
associates or species (on a single lattice site), and then turn on the option QUASICHEM_
FACT00. This removes the previously-set (if any) ADDITIONAL part on the non-ideality for the
chosen liquid phase.

Reference
[1998, Kongoli] F. Kongoli, A. D. Pelton, Y. Dessureault, Thermodynamic modeling of liquid
Fe-Ni-Cu-Co-S mattes. Metall. Mater. Trans. B. 29, 591–601 (1998).

QUASICHEM_IRSID
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To use the Kapoor-Frohberg-Gaye Quasichemical Cell Model (i.e. the Quasichemical Model
developed by ISRID, France) for a liquid SLAG solution phase, you can use a normal liquid
model with specified associates or species.

GLASS_TRANSITION
To use the special model for glass transition of a liquid phase. It removes previously set (if
any) ADDITIONAL part on the non-ideality for the chosen liquid phase.

REMOVE_ADDITION
To remove all the selected ADDITIONAL part from the Gibbs energy description for the
chosen phase. If preferred, set a specific phase-status bit for a phase, use the PHASE_BITS
option as long you know the restrict meaning of each part of a phase- status bits.

DEFAULT_STABLE
Set phases as default-stable, which helps you to have a better guess of which phases that
should be stable at the first calculation.
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About the ENTER_PHASE Command
ENTER_PHASE
With the command ENTER_PHASE, the phase name, phase-type, sublattice number, and
constituents or constituent array(s) for the phase are entered into the GIBBS workspaces.

About Phase Names
A thermochemical system must have at least one phase (which is a homogeneous part of the
system with a uniform composition and structure). In the GIBBS module, any number of
phases can be entered for a system and for each phase there must be a description of how
its Gibbs energy varies with temperature, pressure and composition. A phase has a large
amount of data connected to it, e.g. it starts with a phase name:
l

It may be treated as a special phase-type;

l

It may have structural information about sublattice(s), etc.,

l

l

l

l

There must be a list of constituents (for a substitutional phase with no sublattice) or
of constituent arrays (for a sublattice phase);
There may be basic information on what kind of EXCESS_MODEL (polynomial
expression) is used to describe the binary, ternary and/or higher-order interactions
between constituents;
There may be so-called Additional contributions to the Gibbs energy of the phase
from special physical phenomena, e.g. magnetic ordering, hypothetical electrostatic
interaction, and so forth;
There must exist all the parameters required for the descriptions of thermochemical
properties (i.e. G terms for standard Gibbs energies, and L terms for binary, ternary
or higher-order interaction excess energies) and of some special physical properties
(e.g. the Curie temperature TC and Bohr magneton number BMAGN (or BM) for
magnetic ordering, V0-VA-VC-VK parameters for volume contributions, Born functions
for hypothetical electrostatic interaction in an aqueous solution phase) stored in
connection with the phase.

About Phase Type Code
A G phase (gaseous mixture) or an A phase (aqueous solution) is usually treated as a
substitutional phase without sublattice, and that an L phase (ordinary liquid solution) is
normally (but not always) modelled as a substitutional phase without sublattice, too.
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The F and B phase-types are useful for ordered FCC (or HCP) and BCC solution phases
handled by the so-called Four Substitutional-Sublattice Ordering Model, which always
requires that the solution phase must have four sublattices for substitutional ordering and
can additionally have an interstitial sublattice.
For ordered FCC or HCP phases, these four substitutional sublattices represent four corners
of the regular tetrahedron on these lattices all of which are the nearest neighbours. A
Normal 4-Sublattice Model requires that all the G parameters for each of end-members with
the same elements but distributed on different sites be given separately. However, as these
corners are identical lattice points, the phase-type option F means that the G parameters
need be given only once. The possible permutations are handled automatically. To be more
clarified: An A-B binary solution phase (with the element A locates on one sublattice site and
B on three sublattice sites) treated by the Normal 4-Sublattice Model has to have 4 G
parameters for 4 end-members, i.e. G(phase,A:B:B:B), G(phase,B:A:B:B), G(phase,B:B:A:B)
and G(phase,B:B:B:A), because of that in the general case these G parameters can be
different from each other. But for the FCC and HCP orderings, these are identical and thus
all G parameters of such end-members need be given only once, and the possible
permutations are then automatically handled by the GIBBS module. This significantly
simplifies the usage of this model (Four Substitutional-Sublattice Ordering Model) in
multicomponent alloys.
There are restrictions on the excess parameters allowed with the phase-type option F. You
can only have excess parameters of these types:
L(phase,A,B:*:*:*;0…9)
L(phase,A,B:C,D:*:*;0…9)

The asterisk * means that the interaction parameter is independent on the constituents on
its corresponding sublattice. No ternary interaction parameters (i.e. with three elements on
one sublattice site) are allowed. The reason for this restriction is that it would be too
complicated to handle all possible permutations. In the current Four Substitutional Sublattice
Ordering Model, the binary interaction between A and B atoms is thus independent of the
constituents on the other sublattices, where there are many other parameters to model the
composition-dependence of the Gibbs energy (both in the ordered and disordered parts of
the phase). The model for these ordered phases are always partitioned in a disordered part
(with a single substitutional sublattice) and an ordered part (with four substitutional
sublattices for ordering).
For ordered BCC phases, the phase-type option B means the same thing but the situation is
more complicated, as the 4-sublattice ordering phase represents an irregular tetrahedron
with two pairs of sites that are next nearest neighbours. Thus, for an A-B binary solution
phase (with the element A locates on two sublattice site and B on other two sublattice sites)
treated by the Normal 4-Sublattice Model, the end-member described by the G
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(phase,A:A:B:B) term has four nearest neighbour bonds between A and B atoms, whereas the
end-member described by the G(phase,A:B:A:B) term has two nearest neighbour bonds
between A and B atoms and two next nearest neighbour bonds
For detailed reference visit the Crystal Lattice Structure web page
https://www.nrl.navy.mil/mstd/6390.
The first end-member (described by the G(phase,A:A:B:B) term) represents B2- ordering and
the second (described by the G(phase,A:B:A:B) term) stands for B32-ordering. There are two
permutations of the G(phase,A:A:B:B) term and four permutations of the G(phase,A:B:A:B)
term, automatically conducted in the Four Substitutional-Sublattice Ordering Model. And
there are also two kinds of reciprocal interaction parameters, i.e.
L(phase,A,B:C,D:*:*;0…9) L(phase,A,B:*:C,D:*;0…9)

An advanced feature with the phase-type options F and B is that a composition set that
represents the solution phase has a suffix (indicating that it is really as an ordered or
disordered phase) that is automatically added to its phase name in some listings of
equilibrium calculations (when performing either single-point or stepping or mapping
calculations, and when plotting the calculated property diagrams or phase diagrams). Such
suffix indications can be:
or _L10 for ordered FCC

l

_L12

l

_A1

l

_B2, _B32, _D03

l

_A2

l

_D019

l

_A3

for disordered FCC
or _L21 for ordered BCC

for disordered BCC
and _B19 for ordered HCP

for disordered HCP

Solution Phase

Suffix for Disordered Phase

FCC PHASE

PHASE_A1

Suffix for Ordered Phase
PHASE_L12
PHASE_L10
PHASE_B2
PHASE_B32

BCC PHASE

PHASE_A2
PHASE_D03
PHASE_L21
PHASE_D019

HCP PHASE

PHASE_A3
PHASE_B19
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ADD_COMMENT
This command is for the Gibbs Energy System (GES) module.
Use the ADD_COMMENT command to add a comment or make notes about parameters.
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AMEND_ELEMENT_DATA
This command is for the Gibbs Energy System (GES) module.
The data for an element (in the SER, the Stable Element Reference, state) can be changed by
this command. It should only be used for the elements that do not have any data in the
database because the element data available in the database is set by the databasedeveloper for the purpose of internal consistency. Except for the mass, the other values have
no influence on the calculations.
Syntax

AMEND_ELEMENT_DATA
Element name: <Element name>

Prompts

Specify the name of the element for which you want to change the data.
New stable element reference /ABCD/: <Name of ser>

Press <Enter> to accept the default SER or specify a new SER for the element. Important: The
default name should not be changed if this data is retrieved from a database. This name is used
when parameters for a phase are listed and the database assumes that the stable element
reference is the same as in the database. Only if the element's data have not been fetched from a
database, e.g. entered manually, can you enter a new SER.
New atomic mass /xx.xxxx/: <yyyyyy>

Press <Enter> to accept the default atomic mass or specify a new value for the element. The
atomic mass of the element is given in g/mol.
New h(298.15)-h(0) /xxx.xxx/: <yyyyy>

Press <Enter> to accept the default H(298.15)-H(0) or specify a new value for the element. H
(298.15)-H(0) is the enthalpy difference between 298.15 K and 0 K for the element in its SER
state.
New s(298.15) /xx.xxxx/: <yyyyy>

Press <Enter> to accept the default S(298.15) or specify a new value for the element. S(298.15) is
the absolute value of the entropy at 298.15 K for the element in its SER state.
Default element reference state symbol index /#/: <index>

The index only changes the symbol, not any value. Normally the index is set
correctly by the database. Only when manually entering data, you must set the
index to get the correct symbol.

Specify an index for the default listing parameters (symbol), or press <Enter> to accept the preset index. 0 is for G, 1 is for H298 and 2 is for H0.
The index is to define the symbol printed in parameter listings. The symbol can be:
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Syntax

AMEND_ELEMENT_DATA

lattice stability).

l

G the data are referred to Gibbs energy at a variable temperature (also called

l

H298 the data are referred to the enthalpy of the element at 298.15 K and 1 bar.

l

H0 is the same as H298 but at the temperature 0 K.
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AMEND_PARAMETER
This command is for the Gibbs Energy System (GES) module.
There is also a PARROT module command with the same name.
Use this command to interactively change/amend the temperature-pressure function of a
parameter. This is useful to correct typing errors because the old function is made available
on the terminal for interactive editing.
About the ENTER_PARAMETER Command
Syntax

AMEND_PARAMETER
Parameter: <Parameter name>

Specify a correct parameter name. If a parameter name is not acceptable or you only press
Prompts <Enter>, the error message displays:
Error, please re-enter each part separately

The program prompts for separate input for each part for a parameter name.
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Specify one of these legal identifiers as described for ENTER_PARAMETER.
Phase name (/ABCD/): <Phase name>

Specify the phase name.
Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name.
Interacting constituent (in sublattice # /xyz/): <Species name>

Specify the interacting constituent name: If there is no interacting constituent, press <Enter>.
Interacting constituent (in sublattice # /xyz/): <Species name>

If there are more than one interacting constituents, specify them; otherwise press <Enter>.
Degree /#/: <Degree>

Specify a numerical number as the degree of the phase parameter.
After the parameter name is specified correctly, the program lists its current definition (either
present in the database or defined by the ENTER_PARAMETER command), such as:
L(PHASE2,AL,MG;1)=
298.15<T<2000.00: +5000
2000.00<T<4500.00: +4500
4500.00<T<6000.00: +4000
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Syntax

AMEND_PARAMETER

Then you are prompted to change the parameter definition, as shown below:
Do you want to change the number of ranges /No/:

Enter Y if you want to change the number of ranges for the chosen function, or change some of
the temperature limits in the definition. Then retype both the low/high temperature limits and
functions.
If you do not want to change the number of ranges but want to change the function(s) in one or
more ranges, press <Enter> to accept the default N, then the whole definition of the chosen
parameter in all ranges (if any) is listed on screen, such as:
DIFFERENT FUNCTIONS IN THESE RANGES
298.15<T<2000.00
2000.00<T<4500.00
4500.00<T<6000.00

The prompt is given:
Do you want to change range limits /No/:

If there is more than one range, this question is prompted press <Enter>.
Range number (0 to exit) /0/: <Range number>

If the function of a parameter is different in two or more temperature ranges, you must specify
the range of the function of which you want to amend. Or press <Enter> or type 0 to exit this
command without making any changes.
Function:

The previous function is available for editing. The editing is performed within the general
subroutine FOOLED, as described in AMEND_SYMBOL. This routine prompts as follows:
1:+:>

The prompt consists of the current position in the string and the character at that position
between colons, (::).

Commands
These commands can be given:
l

Help: ?

l

Move CP to last or first character: <+/-> A

l

Delete characters from CP: <+-#characters> D

l

Exit: E

l

Find: <#occurrences> F<string>@

l

Insert: I<string>@

l

Move: <+-#positions> M

l

Restore string: R

Thermo-Calc User Guide: Console Mode ǀ 291 of 643

Thermo-Calc Documentation Set

Syntax

AMEND_PARAMETER
l

Substitute: S<OLD>@<NEW>@

l

Type string: T

Where CP denotes the current position in a string, # means number of, @ is a terminator of an
input or search string.
When the string is typed the character at the current position is replaced by an
underscore _.
To finish the editing of the current function, type E at the prompt.
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AMEND_PHASE_DESCRIPTION
This command is for the Gibbs Energy System (GES) module.
Also see Solution Models in the GIBBS (GES) Module for detailed information
about this command and its options.
Specify/amend phase descriptions if a phase has a miscibility gap, uses a special excess
energy model, or has a specific additional contribution to its Gibbs energy, for example.
Syntax

AMEND_PHASE_DESCRIPTION
Phase name: <Phase name>

Specify the name of the phase.
Amend what /Composition_Set/: <Subject>

Several subjects for the phase can be amended but most often this command is used to
enter two or more composition sets for a phase. If a phase has a miscibility gap it is
necessary to have two composition sets, one for each possible composition that can be
stable simultaneously.

Prompts

Enter a question mark at the prompt to get a list of all possibly amended subjects for a
phase.
There are no additional prompts for DEBYE_HUCKEL, HKF_ELECTROSTATIC, GLASS_
TRANSITION, QUASICHEM_FACT00, QUASICHEM_ISRID, REMOVE_ADDITION, and DEFAULT_
STABLE.
New phase name /ABCD/: <Phase name>
RENAME_PHASE

Give a new phase name for the chosen phase, or press <Enter> to keep the default shown.
Sites in first sublattice /XX/ : <YY> Sites in second sublattice /XX/ : <YY>
Site_ratios

Specify the site numbers for each of the prompted sublattices for the current phase. Press
<Enter> to accept the previous definitions.
Sublattice /#/: <Sublattice number>

New_
constituent

Specify the sublattice where the new constituents are located.
Species: <Species name>

Give a valid species name.
New highest set number /#/: <Set number n>
Composition_
sets

The default value (#) is usually one higher than the current value. All phases have initially
one composition set. If a lower value (i.e. lower than the default one) is given, that specific
composition sets are deleted.
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AMEND_PHASE_DESCRIPTION

You cannot take away the first composition set.
Major constituent(s) for sublattice #: /AB/: <Major constituent(s)>

Specify the new major constituent(s) for the sublattice #, or press <Enter> to accept the
default which was automatically set according to the specified composition set of the phase.
This prompt is repeated for all available sublattices in the chosen phase. The major
constituents in each sublattice can be given. This may simplify giving start values when
calculating the equilibrium as phases with miscibility gaps should have different major
constituents for each composition set.
Composition set /1/: <Composition set number>

Give the composition set (digit number) for the chosen phase, or press <Enter> if you want
to set major constituents for the specified composition set.
Major constituent(s) for sublattice #: /AB/: <Major constituent(s)>

Major_
constituent

Specify the new major constituent(s) for the sublattice #, or press <Enter> to accept the
default which is automatically set according to the specified composition set of the phase.
This prompt is repeated for all available sublattices in the chosen phase for the specified
composition set.
The major constituents in each sublattice can be specified. This is useful in order to make
calculations converge faster and more easily (because it may simplify giving start values
when calculating the equilibrium as those phases with miscibility gaps should have different
major constituents for each composition set). The databases often set major constituents for
several phases automatically when data are retrieved.
Element : <el1>
Low fraction limit /0/ :

<Appropriate low limit>

High fraction limit /1/ : <Appropriate high limit >
Element : <el2>
Fraction_
limits

Low fraction limit /0/ :

<Appropriate low limit>

High fraction limit /1/ : <Appropriate high limit>
Element : <eln>
Low fraction limit /0/ :

<Appropriate low limit>

High fraction limit /1/ : <Appropriate high limit >
The antiferromagnetic factor /XX/: <YY>

Specify the anti-ferromagnetic factor for the chosen phase. This should be –1 for BCC phase
and –3 for all other phases (FCC, HCP, etc.).
Magnetic_
ordering

Short range order fraction of the enthalpy /XX/: <YY>

The magnetic ordering is a second-order transformation and part of the enthalpy due to this
transformation is due to short-range order. This value is the fraction of the total enthalpy
that is due to short-range ordering above the magnetic transition temperature.
The default value (xx) is 0.40 for BCC phase, and 0.28 for all other phases (FCC, HCP, etc.).
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Syntax
Disordered_
part

AMEND_PHASE_DESCRIPTION
Disordered phase name: <Phase name>

Give the disordered phase name for which there is no ordering sublattice.
Model name /ABCDEFG/: <Model name>

The default model is the pre-set model for the solution phase, normally the REDLICHKISTER_MUGGIANU model, or choose another model for the phase to be amended:
l

REDLICH-KISTER_MUGGIANU

l

REDLICH-KISTER_KOHLER

l

FLORY-HUGGINS POLYMER MODEL

l

MIXED-EXCESS-MODELS (R-K default)

l

HKF

l

PITZER

l

CENTRAL_ATOM_MODEL

The MIXED-EXCESS-MODELS option has sub-options:
First (the independent) constituent: <Constituent name>
Excess_model

Second (the dependent) constituent: <Constituent name>

Specify the binary pair of constituents in the current substitutional solution phase (the first
one as the so-called independent constituent, and the second one as the dependent
constituent), for which you wish to change the binary excess model from the default
REDLICH-KISTER model to another model (LEGENDRE or POLYNOM).
You are prompted with the first sub-option (i.e. First (the independent) constituent after
you have specified the desired binary Excess model type. To make further changes of binary
excess model for other specific binary pairs in the current substitutional solution phase,
press <Enter> (implying that there are no more changes of binary excess model for all other
possibly-remaining binary pairs that shall still use the default REDLICH-KISTER model).
Excess model type: /Legendre/: <Desired binary excess model type>

For the currently-specified binary pair, choose one the legal binary excess models:
LEGENDRE, POLYNOM or REDLICH-KISTER. If the default binary excess model REDLICHKISTER is used for a certain binary pair, you can either specify the model name (or in short as
R-K) or press <Enter>. After this sub-option, it returns to the first sub-option First (the
independent) constituent: either for further change(s) of binary excess model of any other
binary pair(s) or for termination (by pressing <Enter>) in the MIXED-EXCESS-MODELS option.
Extrapolation method: /Toop-Kohler/: <Ternary model>

Choose a ternary extrapolation model for the current solution phase:
Ternary_
extrapolat

l

TOOP-KOHLER for Toop-Kohler Extrapolation Model

l

KOHLER-ALL for Kohler Extrapolation Model

l

MUGGIANU_RESTOR for Muggianu-Restor Extrapolation Model

The TOOP-KOHLER option further prompts:

Thermo-Calc User Guide: Console Mode ǀ 295 of 643

Thermo-Calc Documentation Set

Syntax

AMEND_PHASE_DESCRIPTION
Constituent in sublattice #: <Basis constituent name>
First interaction constituent: <Interacting constituent name>
Toop constituent: <Toop constituent name>

Specify the so-called Kohler constituents (entered as the basis constituent and first
interacting constituent) and Toop constituent on a given sublattice in the current solution
phase.

Quasichem_
ionic

To use the Quasichemical Model for the chosen liquid phase, you must first enter it as an
ionic liquid phase, and then use this amending option. It creates a completely new phase,
the original IONIC_LIQUID phase remains in the system and is not changed.
Number of bonds/atom /2/: <Number of bonds per atom>

Specify the Z value (number of bonds per atom).
Correct the phase status bits. It is important to fully understand this command before using
it:
New status word (in hexadecimal) /04204000/: <New status bits>

LIST_STATUS
Status_bits

Normally, these should never be changed in this way, because such phase status bits are
automatically set on when all the phase descriptions (predefined in databases and amended
in the GIBBS module) are defined properly. The only exceptions are for the KapoorFrohberg-Gaye cell model for liquid SLAG solution phase, which can be set only as
04208000; and for the complete Revised HKF AQUEOUS solution model, which can be set
as 02084000.
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AMEND_SYMBOL
This command is for the Gibbs Energy System (GES) module.
The same command is also available for the PARROT module.
Interactively calculate the current values of a function or table (predefined by the switched
database or previously entered with ENTER_SYMBOL) at the current temperature and pressure
condition, and also possible to modify the definitions of variables or functions.
The current values of the temperature and pressure used to calculate the
functions or tables are the ones listed with LIST_STATUS. There is no way to
change the current temperature and pressure values interactively.
To modify the definitions of entered symbols (variable, functions or parameters), the
performance of this command is slightly different one from another, as described below:
l
l

l

Syntax

For variables, the values can be changed.
For functions the low and high temperature limits in various ranges (if any), as well
the expressions, can be changed.
For parameters the low and high temperature limits in various ranges (if any), as
well the expressions, can be changed.
AMEND_SYMBOL
Name: <Symbol name>

Specify the name of an entered symbol.
For tables and functions (or parameters which are treated as functions after these are entered by
the ENTER_SYMBOL command with the Parameter keyword, but not by the ENTER_PARAMETER
command), after the symbol name is specified here, the program automatically calculates the
Prompts values under the current temperature and pressure conditions, and lists the current values, such
as:
FUNCTION VALUE
TABLE VALUE

2.52500000E+01

1.56000000E+02

For variables and functions (or parameters), there are additional prompts and depend on the
symbol type.
For a variable, its current value is displayed, and you can change it to a new value:
Value /Current value/: <New value>

For a function (or a parameter entered as a symbol):
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AMEND_SYMBOL
Do you want to change the number of ranges /No/:

Enter Y to change the number of ranges for the function, or change some of the temperature
limits in the definition, then retype both the low/high temperature limits and functions (see all the
remaining details in the ENTER_SYMBOL command.
If you do not want to change it, press <Enter>. The definition of the chosen function in all ranges
(if any) is listed, for example:
DIFFERENT FUNCTIONS IN THESE RANGES
298.15<T<2000.00
2000.00<T<4500.00
4500.00<T<6000.00

and this message displays:
Do you want to change range limits /No/:

If a function is different in two or more temperature ranges, you must specify the range of the
function of which you want to amend. Or press <Enter> or type 0 to exit this command without
making any change.
Range number (0 to exit) /0/: <Range number>
Function:

The previous function is available for editing. The editing is performed within the general
subroutine FOOLED. This routine prompts as follows:
1:+:>

The prompt consists of the current position in the string and the character at that position
between colons (::).

Commands
These commands can be given:
l

Help: ?

l

Move CP to last or first character: <+/-> A

l

Delete characters from CP: <+-#characters> D

l

Exit: E

l

Find: <#occurrences> F<string>@

l

Insert: I<string>@

l

Move: <+-#positions> M

l

Restore string: R

l

Substitute: S<OLD>@<NEW>@

l

Type string: T

Where CP denotes the current position in a string, # means number of, @ is a terminator of an
input or search string.
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Syntax

AMEND_SYMBOL

When the string is typed the character at the current position is replaced by an
underscore _.
To finish the editing of the current function, type E at the prompt.
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CHANGE_STATUS
This command is for the Gibbs Energy System (GES) module.
The status of an element or species or phase can be either ENTERED or SUSPENDED. The
suspended status can be either implicit or explicit. The implicitly suspended status can be set
e.g. for a species if any of the elements in its chemical formula is explicitly suspended. A
species that is implicitly suspended becomes entered automatically if all its elements are set
entered. After this command, a message shows which elements/species/phases are
suspended or restored (entered). Consequently, the status bits for the specified elements or
species or phases are changed, as listed with LIST_STATUS.
Syntax

CHANGE_STATUS
For Element, Species or Phase /Species/: <Keyword>

Prompts

Specify the keyword (element, species or phase).
Suspend /Y/:

By default the status is changed from ENTERED to SUSPENDED.
If an element is suspended all species with this element become implicitly SUSPENDED too. A
phase may become implicitly suspended if all its constituents or all constituents in a sublattice are
suspended.
List of elements/species/phases: <Name of elements or species or phases>

Specify the names or indices of those elements or species or phases that shall become suspended
or active. For names, these should be separated by a space and terminated with a semicolon (;) or
an empty line. For indices it is possible to give a range by separating two numbers by a hyphen (-).
The list should be terminated by a semicolon (;). Example: 5 1 7-12 FE;
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ENTER_ELEMENT
Specify a system interactively. The program searches the currently switched or preset
database for data for the given elements. The data for the elements in the database are the:
l
l

mass in g/mol
name of the Selected Element Reference State (SER) which normally is the stable
phase for the element at 298.15 K

l

enthalpy difference for the element in the SER state at 298.15 K and zero K

l

absolute entropy for the element in the SER state at 298.15 K.

The two predefined elements, i.e. electrons and vacancies, have the chemical symbols /and VA, respectively. Initially, these are suspended but can be entered either by this
command or CHANGE_STATUS.
If an aqueous solution phase is involved, in the GIBBS module you enter a special aqueous
electron called, ZE. This is specially designed for appropriately calculating the standard
electric potential in the aqueous solution system.
Syntax

ENTER_ELEMENT
Element name: <Element name>

Prompt Specify several elements on one line. The name of an element is its chemical symbol. The chemical
symbols must be separated by spaces. Fictitious element names are legal but naturally no data are
found in the database for them.
An element name (maximum 2 characters) can either have its first letter in upper
and the second (if any) in lower case (i.e. Lower Case Mode) or both letters can be
in upper or lower case (i.e. Upper Case Mode). The Upper or Lower Case Mode is
selected by the command REINITIATE, which removes all data, and should be
executed before any other command.
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ENTER_FUNCTION
This command is available with the GES and TAB modules.
Used to define a new thermodynamic function to be included in the sixth column of tabular
output. The last entered function is listed in the 6th column of all tables, and can be plotted
(if choosing the Plot Column value 6) in all graphs, for all subsequently tabulated substances
or reactions.
Syntax
Prompt

ENTER_FUNCTION
Name: <Name>
Function: <Definition>

A limited number of state variables, G, H, S, T, P, V and H298 can be used in the function definition.
For example, -(G-H)/T can be defined as a function which is identical to S for a substance or ΔS for
a reaction, G+T*S-P*V can be defined as a function which is U (internal energy) for a substance or
ΔU (internal energy change) for a reaction.
Options

Nameof the

function (maximum 8 characters) and Definition of the function. A long function can
be typed over several lines. A function should be terminated by a semicolon (;) or an empty line.

Example
For the pure substance Fe (using the SSUB database), by entering a function as G+T*S-P*V,
the following table is obtained by typing <Enter> in the prompt Output file /Screen/:,
and the figure by typing 6 in the prompt Plot column /2/:
TAB: ENTER-FUNCTION
Name: InEnergy
Function: G+T*S-P*V;
TAB: TABULATE_SUBSTANCE
Substance (phase): Fe
Pressure /100000/: <Enter>
Low temperature limit /298.15/: <Enter>
High temperature limit /2000/: <Enter>
Step in temperature /100/: <Enter>
Output file /try1/: try2
Graphical output? /Y/: <Enter>
Plot column? /2/: 6

This gives the following output:
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O U T P U T

F R O M

T H E R M O - C A L C

Column 6: InEnergy G+T*S-P*V
Phase : FE_S

Pressure :

100000.00

Specie: FE
***************************************************************
T
(K)

Cp
(Joule/K)

H
(Joule)

S

G

(Joule/K)

InEnergy

(Joule)

***************************************************************
298.15

2.48446E+01

2.17972E-06

2.72800E+01

-8.13353E+03

2.17972E-06

300.00

2.48905E+01

4.60049E+01

2.74338E+01

-8.18414E+03

4.60049E+01

400.00

2.71299E+01

2.64957E+03

3.49085E+01

-1.13138E+04

2.64957E+03

500.00

2.93561E+01

5.47211E+03

4.11976E+01

-1.51267E+04

5.47211E+03

600.00

3.19293E+01

8.53245E+03

4.67701E+01

-1.95296E+04

8.53245E+03

700.00

3.50985E+01

1.18777E+04

5.19207E+01

-2.44667E+04

1.18777E+04

800.00

3.92042E+01

1.55830E+04

5.68623E+01

-2.99068E+04

1.55830E+04

900.00

4.49645E+01

1.97726E+04

6.17903E+01

-3.58387E+04

1.97726E+04

1000.00

5.42147E+01

2.46891E+04

6.69619E+01

-4.22728E+04

2.46891E+04

1100.00
4.55851E+01
Stable phase is FE_S2

2.99025E+04

7.19412E+01

-4.92328E+04

2.99025E+04 $

1200.00

3.40840E+01

3.51037E+04

7.64466E+01

-5.66322E+04

3.51037E+04

1300.00
1400.00

3.49398E+01
3.57994E+01

3.85549E+04
4.20918E+04

7.92086E+01
8.18293E+01

-6.44162E+04
-7.24692E+04

3.85549E+04
4.20918E+04

1500.00

3.66636E+01

4.57149E+04

8.43287E+01

-8.07780E+04

4.57149E+04

1600.00
3.75330E+01
Stable phase is FE_S3

4.94247E+04

8.67226E+01

-8.93314E+04

4.94247E+04 $

1700.00

4.05217E+01

5.41173E+04

8.95609E+01

-9.81363E+04

5.41173E+04

1800.00
4.12595E+01
Stable phase is FE_L

5.82055E+04

9.18975E+01

-1.07210E+05

5.82055E+04 $

1900.00
2000.00

7.74165E+04
8.20165E+04

1.02377E+02
1.04736E+02

-1.17099E+05
-1.27456E+05

7.74165E+04
8.20165E+04

4.60000E+01
4.60000E+01
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ENTER_PARAMETER
This command is for the Gibbs Energy System (GES) module.
There is also a PARROT module command with the same name.
About the ENTER_PARAMETER Command
Use this command to enter TP-function(s) for a specific parameter for a phase interactively
with this command. If there is already a parameter expression defined (for this parameter),
that is deleted and replaced with newly entered one.
The entered TP-Function(s) for the parameter can be changed later with the command
AMEND_PARAMETER.
Syntax

ENTER_PARAMETER
Parameter: <Parameter name>

As explained in About the ENTER_PARAMETER Command, specify a correct and complete
Parameter Name, which should contain all the necessary parts of the general form:
Prompts

<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter>, is pressed, a message displays:
*** Error, please re-enter each part separately

and you are prompted for input for each required part for a parameter name.

Options

Description or Information
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Identifier

If this command is used one or more times, the previous value on this prompt is set as default.
Press <Enter> for the same type identifier or specify a new type.
Phase name (/ABCD/): <Phase name>

Phase name

Each parameter is valid for a specific phase only. The name of that phase must be supplied
(maximum 24 characters). The name can be abbreviated.
Constituent (in sublattice # /ABC/): <Species name>

A parameter is identified by the constituents on a specified sublattice site of the given phase,
the stoichiometric coefficients of which are multiplied with the parameter. The name of the
constituent can be abbreviated.
Constituent

It is the species name, not the stoichiometric formula required here.
If this command is used one or more times, the previous value on this prompt is set as default.
Accept it by pressing <Enter> if the constituent is the same, or specify a new species name.
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Syntax

ENTER_PARAMETER

For phases with several sublattices, the program asks for one constituent in each sublattice.
Interacting constituent (in sublattice # /XYZ/): <Species name>

If this command is used one or more times, the previous value on this prompt is set as default.
Press <Enter> to accept it if the constituent is the same, or specify a new species name.
Interacting
constituent

To cancel the default value of the interacting constituent type NONE or the name
of another constituent.
This question is repeated until all the interested interacting constituent(s) on a specific
sublattice in the phase are specified, and finally an <Enter> is enforced.
Degree /#/: <Degree>

Degree

Degree is model-dependent. Specify an integer number (a value from 0 through 9) as the
degree of composition-dependent interaction contribution for the phase parameter. This is
valid for excess energy (L), Curie temperature (TC) and Bohr magneton number (BMAGN), as
well as for volume-related parameters (V0, VA, VC or VK).
For binary interaction parameters, the degree is usually the power in the Redlich-Kister
expression. For ternary interaction parameters, it is usually the Hillert ternary index.
For a standard G parameter for a pure component (end-member) its degree should be always
0 and this prompt should not display.
After this prompt, the program echoes on the screen the full TP-Function of the phase
parameter.
Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but
entered as a negative number), for the current TP-Function.
Function: <Definition for a function>
Phase
parameter

A TP-Function consists of terms in T and P.
& <Continuation of the definition for the current function>

Continuation of a TP-Function definition.
High temperature limit /6000/: <High temperature limit in K>

Specify the high temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the
lowest limit is entered as a negative number) for the current TP-Function.
Any more ranges? /N/:

Enter Y for more function(s) or N to end this command.
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ENTER_PHASE
See About the ENTER_PHASE Command for details about the phase-type and
other prompts.
With this command, the phase name, phase-type, sublattice number, and constituents or
constituent array(s) for the phase are entered into the GIBBS workspaces. However, for the
remaining parts of thermodynamic descriptions (i.e. thermochemical and physical
parameters, excess model, and possibly additional contribution term) for the phase, the
GIBBS commands ENTER_PARAMETER and AMEND_PHASE_DESCRIPTION, should be used
sequentially.
Normally, data for a system are retrieved from the preset database after the elements and
species are specified. This is automatically done through GET_DATA. In some cases, specify a
phase interactively.
Syntax

ENTER_PHASE

Options

Description and Information
Name of phase: <Phase name>

The phase name is any string starting with a letter and containing only letters, digits or the
underscore character. The phase name must be unique.
Phase name
Type code: <Phase-type code>

The Phase-type code must be specified for the phase if it is not an ordinary solution phase.
Press <Enter> if the phase is ordinary.
Phase-type

Gaseous mixture phase.
G

There may only exist one gas phase in a system.
A

Aqueous solution phase.

L

Liquid solution phase but not A (aqueous) or Y (ionic liquid)

Y

Ionic liquid solution phase (that is specially treated by the Ionic Two Sublattice Liquid Model).

I

A phase with charged species but not G (gaseous), A (aqueous) or Y (ionic liquid).

F

An ordered FCC or HCP solution phase with four substitutional sublattices (additionally, such a
phase can also have an interstitial sublattice).

B

An ordered BCC solution phase with four substitutional sublattices (additionally, such a phase
can also have an interstitial sublattice).
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Syntax

ENTER_PHASE
Number of sublattices /1/: <Sublattice number>

Phases with stoichiometric constraints usually have two or more sublattices. On each
sublattice one or more species can be entered as constituents. The number of sublattices
must not exceed 10. Substitutional phases with no sublattices are treated as phases with one
sublattice.
Sublattice
number

Number of sites on sublattice

# /1/: <Site number>

For phases with sublattices, the ratio of the sites on each sublattice (donated with #) must be
given. The program asks for values for all sublattices (by repeating this question for each
sublattice), but these may have a common factor extracted. It is recommended to use
integer numbers as sites if possible. For substitutional phases with no sublattices, this
question does not show up.
Name of constituent: <Constituent name(s)>

For each sublattice specify at least one species as constituent. Several constituents can be
given consequently (on the repeated prompt) or on the same line separated by a space. This
question is repeated till pressing <Enter> or giving a semi-colon (;), meaning that the list of
constituents is terminated by (;) or an empty line.
Will you add constituents later /N/:
Constituents

For Y add other constituents to the phase by specifying new components in e.g. an ENTER_
PARAMETER command.
If illegal constituents are used, you get a message e.g. when parameters are entered.
Do you want a list of possible parameters /N/:

Enter Y for a list of all possible parameters up to the fifth interaction order for the entered
phase.
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ENTER_SPECIES
Specify a species from the already entered elements. The stoichiometry of the species is the
chemical formula of the species. For each species, its name and chemical formula must be
given.

All elements are automatically entered simultaneously as species. The
constituents of a phase must be species, but there is no thermochemical data
associated with the species except as constituents of a phase.

Syntax

ENTER_SPECIES
Species name: <Species name>

Enter a unique species name. This is usually its chemical formula but it can be any string which
starts with a letter and contains only letters or digits. Parenthesis () and an underscore _ are
permitted. The combination /- or /+ used to denote charge.
Prompt

Species Names Examples
NACL2, FE2O3, FEO3/2, FE1O1.5, CA.5MG.5SI1O3,
AL1H1O1_Al(OH) , AL1H1O1_HAlO, C2H4O3_124TRIOXOLANE, NA+, SIO4-4, H1/+1, H1O1/-1,
AGC2N2-1.

The species name can be used to separate isomers with the same stoichiometry, e.g. C2H2Cl2,
(CHCl)2_cis, (CHCl)2_trans, CH2_CCl2.
Stoichiometry /Species name/: <Chemical formula>

The elements in the chemical formula are normally separated by stoichiometric numbers. Neither
parenthesis () nor an underscore _ is allowed in the chemical formula, while the special
combination /- or /+ can be used.
In upper case mode (see REINITIATE), the stoichiometric number unity can be excluded only if the
element symbol consists of two letters. In lower case mode, the element must be typed with the
first letter in UPPER case and the second in lower, and it is thus possible to distinguish CO (carbon
monoxide) from Co (cobalt) without any stoichiometry number.

All elements in a species must be entered prior to entering the species.
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ENTER_SYMBOL
This command is for the Gibbs Energy System (GES) module.

There are also a POLY and POST module commands with the same name.
However, symbols entered in the GIBBS module are not the same symbols as
defined in the POLY and POST modules.

In the GIBBS module, a symbol can be used to represent a numeric quantity (e.g. a variable),
a function, or a table. The entered symbol (with a symbol name of maximum eight
characters) can be used later when parameters are entered, and this is a flexible way to
manipulate thermodynamic functions. Symbols are especially useful if the same function or
table is used in several thermochemical parameters. A parameter symbol is used to assign
the values of phase parameters (which are defined with the command ENTER_PARAMETER) to
specific characterized symbols. If you want to define a constant quantity, enter it as a simple
function with a constant value in all (temperature) ranges.
The symbols entered in the GIBBS module can also be listed and used in the PARROT module
(for data optimization) where you can use the GIBBS-entered symbols (variables, functions
or parameters) to define parameters that shall be optimized.
See example 44 for an example of using variables and functions.
Syntax

ENTER_SYMBOL
Variable, function, table or parameter? /Function/: <Keyword>

The keyword can be a variable, function, table or parameter.
l

Variables are similar to functions because these can also be expressions of state variables.

It is possible to enter a variable with a new expression anytime.
l

Functions are expressions of state variables or other functions.

l

Tables are used for listing results. A table consists of a list of any number of state variables,

functions or variables.

Prompt
l

Parameter symbols are used to assign the values of phase parameters (which are defined

by the command ENTER_PARAMETER) to specific characterized symbols. If the phase
parameter is not defined yet, the parameter symbol is assigned zero or a symbol which is
valued as zero. In this way it is easy to refer to entered phase parameters in further defining
other phase parameters.
Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 8
characters.
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Syntax

ENTER_SYMBOL

The following prompts are based on the type of symbol.
Variable

symbol

Value: <Numeric value of a variable>

Only a constant numeric value, not an expression, is accepted.
Enter the lower-temperature limit, the expression, an upper-temperature limit and if there is
another expression above this upper limit:
Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest-temperature limit, below which its (first) expression is not applicable. The
default lowest limit of all kinds of data is 298.15 K.
If a negative number is given as the lowest-temperature limit, it is assumed that there are
breakpoints in pressure for this function; in such a case, it is interpreted as the lowest-pressure
limit (in Pascal), and the other limits in the current function are also taken as pressure limit
values (in Pascal).
The temperature/pressure limits for the functions are checked during calculations. An indicator
is set if the actual temperature/pressure condition is below the lowest temperature/pressure
limit or above the highest temperature/pressure limit; and in such a case, an extrapolation is
conducted using the TP-FUNCTIONS valid in the nearest temperature/pressure range.
Function: <Definition for a TP-function>

Function

symbol

A TP-Function consists of terms in T and P. The expression is a FORTRAN-like expression and
operators +, -, *, = and ** can be used (** only with integer powers). Unary-functions LN or
LOG (both for natural logarithm) and EXP (for exponential) can also be used. An expression can
be continued on more than one line. A PT-function must be terminated by a semicolon (;) or an
empty line. No more than 78 characters can be written on a line. If this is not sufficient space on
one line, press <Enter> and continue on the next line. The program prompts with an ampersand
& when a continuation is expected.
A function can have several temperature ranges, and a different expression (i.e. a
TP-Function) for each region; if required, a single function can have up to ten
different temperature ranges (and thus have up to ten different TP-Functions).
This question is repeated if the current function has more than one expression (TPFunction) in
various temperature ranges [or pressure ranges; only if the lowest limit is entered as a negative
number)].
& <Continuation of the definition for the current TP-Function>

This is for a continuation of the definition for the current TP-Function. The ampersand & means
that you can continue to write the function on the new line if one line is not enough for the
current TP-Function. If you are finished the current TP-Function, press <Enter> again.
High temperature limit /6000/: <High temperature limit in K>

For a TP-Function, specify the high-temperature limit, above which its current expression is not
applicable. The default high-temperature limit for all kinds of data is always 6000 K.
This question is repeated if the function has more than one expression (TPFunction) in various
temperature ranges.
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Syntax

ENTER_SYMBOL

All the temperature limits for the presently-be-entered TP-Function MUST be in
an increasing order; otherwise the whole function is given a single value of zero.
If a negative number is given as the lowest-temperature limit, it is interpreted as the lowpressure limit (in Pascal), and the high-temperature limit is also taken as the high-pressure limit
(in Pascal) for the current TP-Function.
The high-temperature/pressure limit for the current applicable expression (TPFunction) is the
low temperature/pressure limit for the next range if several ranges are needed to describe the
temperature/pressure-dependence of this function.
The temperature/pressure limits for the functions are checked during calculations. An indicator
is set if the actual temperature/pressure condition is below the lowest temperature/pressure
limit or above the highest temperature/pressure limit; and in such a case, an extrapolation is
conducted using the TP-Function valid in the nearest temperature/pressure range.
Any more ranges /N/: <Y or N>

Answer N to finish the definition of the current function. If Y the program asks for a new function
valid above the last high temperature limit and below a new high temperature limit. The
maximum number of temperature ranges is 10.
Important note: Make sure that the function and its first derivatives are continuous across break
points.
Specify the low and high temperature limits, temperature step and tabled value at each
specified temperature:
Low temperature limit /298.15/: <Low temperature limit in K>

The lowest temperature where the table has a value.
High temperature limit /6000/: <High temperature limit in K>

The highest temperature where the table has a value.
Table

symbol

Step in temperature /100/: <Temperature step>

The step in temperature between each value in the table. This step must be constant for the
whole table. If a table cannot be described with a single step it must be divided into several
tables for different temperature ranges. The upper and lower limits are truncated to give
reasonable values where the table values must be specified.
Table value at

XX /YY/: <Table value>

The value of the table at the specified temperature (xx) must be given. The default value (yy) is
the last value.
Input the correct name of a phase parameter (including its identifier, phase name, constituent
and interacting constituent(s) in various sublattices (if exist), and degree of the parameter. Most
of the settings are the same as in the ENTER_PARAMETER command or the Function symbol
Parameter
prompts above.
symbol
Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the necessary parts of
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Syntax

ENTER_SYMBOL

the general form:
<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter> is pressed, this error message displays:
*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a parameter name.
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Specify one of these types of legal identifiers.
Phase name (/abcd/): <Phase name>

Specify the phase name.
Constituent (in sublattice

# /abc/): <Species name>

Specify the constituent name on the specified sublattice site of the given phase.
Interacting constituent (in sublattice

# /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of the given phase; if
there is no interacting constituent, press <Enter>.
Interacting constituent (in sublattice

# /XYZ/): <Species name>

If there is more than one interacting constituent on the specified sublattice site of the given
phase, specify them; otherwise press <Enter>.
Degree /#/: <Degree>

Specify an integer number (a value from 0 through 9) as the degree for the phase parameter.
Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest-temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but
entered as a negative number), for the current TP-Function.
Function: <Definition for a function>

Specify the desired TP-Function for the current temperature range (or current pressure range;
only if the lowest limit is entered as a negative number).
& <Continuation of the definition for the current TP-function>

Specify the desired TP-Function continuation for the current temperature range (or current
pressure range; only if the lowest limit is entered as a negative number).
High temperature limit /6000/: <High temperature limit in K>

Specify the high-temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the
lowest limit is entered as a negative number) for the current TP Function.
Any more ranges /N/:
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LIST_CONSTITUTION
This command is for the Gibbs Energy System (GES) module.
Syntax LIST_CONSTITUTION
List all the constitutions (as site-fractions) for all the phases in the defined system.
This is mainly for software managers. There are no commands in the GIBBS monitor
to set the constitution.
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LIST_DATA
This command is for the Gibbs Energy System (GES) module.
All data for the current system that is defined (retrieved from database in the DATA module,
or directly entered in the GIBBS module) within the current GIBBS workspace is written in a
readable manner on the output file. If no output file is specified, the data display on screen.
The output data consists of a list of all elements and their data followed by a list of all
phases and the data associated with each phase. The thermochemical parameters listed for
each phase are always in SI units.
For encrypted commercial databases you may not be able to use this command
to list any retrieved data. However, it can be used to list some basic definitions
(such as phase models and phase-constituents) retrieved from an encrypted
database, as well as all the references related to original assessments (but not
thermodynamic parameters) for the currently-defined system.
Syntax

LIST_DATA
Output to screen or file /Screen/: <File name>

Prompts Specify the name of a file in which the data shall be written in a readable manner. The default
value is the screen (by pressing <Enter>).
Options?: <Option(s)>

Choose one or several of these options for output:
l

N the output is written as a user database format.

l

P the output is written as a macro file for future input. This is useful for creating *SETUP files

for data assessments.
l

S the symbols are suppressed.

l

R the references for the parameters are listed (only for some databases in which references

are available)
l

L the output is written suitable for a LaTeX preprocessor.
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LIST_PARAMETER
This command is for the Gibbs Energy System (GES) module.
There is also a PARROT module command with the same name.
List the TP-function(s) of a specific parameter for a phase. You must supply the name of the
phase parameter:
The parameter name: <Identifier>(<Phase>,<Constituent array>;<Digit>)

For encrypted commercial databases, you may not be able to use this command
to list any retrieved parameter.
Syntax

LIST_PARAMETER
Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the necessary parts of
the general form: <identifier>(<phase>,<constituent array>;<digit>)
Prompts

See About the ENTER_PARAMETER Command to learn how to define the
parameter name.
If a parameter name is not acceptable or <Enter> is pressed, an error message displays:
*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a parameter name.
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Specify one of these types of legal identifiers.
Phase name (/ABCD/): <Phase name>

Specify the phase name.
Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name on the specified sublattice site of the given phase.
Interacting constituent (in sublattice

# /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of the given phase; if
there is no interacting constituent, press <Enter>.
Interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent on the specified sublattice site of the given
phase, specify them; otherwise press <Enter>.
Degree /#/: <Degree>
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Syntax

LIST_PARAMETER

Specify a numerical number as the degree for the phase parameter.
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LIST_PHASE_DATA
This command is for the Gibbs Energy System (GES) module.
All data for a specific phase are written in a readable manner on screen. The
thermochemical parameters listed for the phase are always in SI units.
For encrypted commercial databases you may not be able to use this command
to list any phase data. However, this command can be used for listing some
basic definitions (such as phase model and phase-constituents) for the specified
phase, as well as all the references related to original assessments (but not
thermodynamic parameters) for the currently-defined system.
Syntax

LIST_PHASE_DATA
Phase name: <Phase name>

Prompt

Specify a phase name (if abbreviated, it should be unique).
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LIST_STATUS
This command is for the Gibbs Energy System (GES) module.
Syntax LIST_STATUS
List the entered elements, phases and species with the status word. The command is included for
system managers.
Each element, species, phase and symbol has a set of status bits. The values of these
bits are listed with this command.
The bits are listed as hexadecimal, i.e. four bits are written as a hexadecimal number. Two
hexadecimal numbers make a byte. In hexadecimal, 0 to 9 mean normal digits. A to F means values
10 to 15. The number E4000000 has thus bit 1, 2, 3 and 6 equal to one. The bits are numbered
starting with 1 for the most significant (leftmost) bit.

Element Status Word
Set the element status word (Bit. Meaning) if:
1. Element cannot be deleted (only vacancy and electron)
2. Suspended (inclusive OR of bit 3 and 4)
3. Explicitly suspended
4. Implicitly suspended (cannot occur for an element)

Species Status Word
Set species status word (Bit. Meaning) if:
1. Species record for an element (each element has a species record)
2. Suspended (inclusive OR of bit 3 and 4)
3. Explicitly suspended
4. Implicitly suspended (e.g. if a species element is suspended)
5. Charged (inclusive OR of bit 6 and 7)
6. Negative charge
7. Positive charge
8. Vacancy
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9. Component (by default the elements are the components)

Phase Status Word
Set phase status word (Bit. Meaning) if:
1. Ideal (no sublattices and no excess parameters)
2. Suspended (inclusive OR of bit 3 and 4)
3. Explicitly suspended
4. Implicitly suspended (e.g. if all constituents suspended)
5. Gas phase
6. Liquid phase
7. Solution phase
8. Only one constituent (in each sublattice)
9. Ions (inclusive OR of bit 10 and 12)
10. New ionic liquid model (charge balance handled internally)
11. Constituents cannot be added
12. External charge balance needed
13. Aqueous model
14. Charged species (ions)
15. Dilute entropy
16. Last calculation exceeded temperature range for any parameter
17. Kapoor-Frohberg-Gaye cell model
18. Turbo calculation used
19. Turbo calculation impossible
20. Turbo calculation illegal
21. Phase is not ideal
22. Current site fractions saved
23. This phase is the ordered part
24. This phase is the disordered part (bit 2 and 3 also set)
25. Shadow phase with diffusion data
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26. Error in ionic model
27. Sometimes
28. CVM-SRO (short-range ordering) entropy expression
29. CVM initialization is made
30. Used to test quasi-chemical ordering model
31. Major constituents check even if no miscibility gap (ordering)
32. Hoch-Arpshofen model

Symbol Status Word
Set symbol status word (Bit meaning) if:
1. Constant
2. Variable
3. Function
4. Table
5. Value must not be amended
6. Undefined
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LIST_SYMBOL
This command is for the Gibbs Energy System (GES) module.
List the symbols available in the current GIBBS workspace, which are defined (retrieved
from database in the DATA module, or directly entered in the GIBBS module) and used in TPfunctions for the entered model parameters for various phases in the defined system.
For encrypted commercial databases you may not be able to use this command
to list any retrieved symbol.
Syntax

LIST_SYMBOL
Name: <Symbol name>

Specify a symbol name (either as the full name of a defined symbol, or as the first
few common characters of several symbols which have names starting with such
common characters).
Prompts
Only those symbols that match this name are listed.
Or press <Enter> for a list of all the symbols defined (retrieved from database in the
DATA module, or directly entered in the GIBBS module) for the current system,
which are available in the current GIBBS workspace.
Output to screen or file /Screen/: <File name>

Specify the name of a simple-textual file in which the entered symbols shall be
written in a readable manner (such a basic textual file can later on be opened and
edited by any text editor). The default value is the screen (by pressing <Enter>).
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READ_GES_WORKSPACE
This command is for the Gibbs Energy System (GES) module.
This command or module is not available with GES6.
Workspace Files
The data saved into a *.GES5 file with SAVE_GES_WORKSPACE can be read back into the GIBBS
workspace.
Syntax READ_GES_WORKSPACE
Enter a File name and specify the working directory where to save the file in the Look in field.
Normally the default file-type in the Files of type field is the correct one for the GES workspace
format (i.e. *.GES5 file).
The saved *.GES5 files are unique for each CPU type, and therefore a *.GES5 file
saved on one CPU type cannot be read and used on another CPU type.
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READ_WORKSPACES
This command is used in both the POLY and GES (GIBBS) modules.
Workspace Files
The POLY3 and GIBBS workspaces and the calculated results from the MAP and STEP
commands can be READ from a file where they are saved with SAVE_WORKSPACES. Such a
*.POLY3 file is not printable.
Syntax

READ_WORKSPACES
File name is the

name of a saved POLY3-file where the POLY3 and GIBBS workspaces shall be read
from must be specified. You do not need to type the extension if it is the default *.POLY3,
otherwise type the whole POLY-file name.
Options

A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.
A window opens so that the path (in the Look in field) and File name can be specified. The Files of
type (i.e. POLY3) cannot be changed. Click Open to open the POLY3 and GIBBS workspaces from
the saved *.POLY3 file.
When reading back an original POLY3 workspace that has already been saved as an *.POLY3 file in
the current Thermo-Calc (Console Mode) run or had been read from an existing POLY3 file under
the current work area, while some additional changes in the settings may be made but do not
need to be kept in further steps in the current Thermo-Calc (Console Mode) run or any diagram is
plotted in the POST module, you can type READ,, or READ_WORKSPACE ,,
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RECOVER_START_VALUES
Syntax RECOVER_START_VALUES
Recovers the start values in equilibrium calculations.
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REINITIATE
This command is for the Gibbs Energy System (GES) module.
All data in the stored GIBBS workspace are erased, and all variables are initiated to their
default values.
Syntax

REINITIATE
Upper case only /Y/:

Press <Enter> to keep the default where the name of elements and species is in only UPPER case.
Or choose N to have the elements with two letter names with the first letter in Upper case and
Prompts the second in lower case.
In upper case mode all input in lower case is automatically converted to upper
case.
Lower temperature limit /298.15/: <Lowest T in K>

This value is used as the lower temperature limit when data are entered interactively.
Upper temperature limit /6000/: <Highest T in K>

This value is used as the upper temperature limit when data are entered interactively.
Default element reference state symbol index /1/: <1 or 2 or 3>

Specify a proper index for the default listing parameters (symbol), or press <Enter> to accept the
preset index 1.
The index is for defining the symbol printed in listings of parameters. The symbol can be:
l

G: the data are referred to Gibbs energy at a variable temperature (also called

Lattice

Stability).
l

H298: the data are referred to the enthalpy of the element at 298.15 K and 1 bar.

l

H0 is the same as H298 but at the temperature 0 K.

The index only changes the symbol, not any value. Normally the index is set
correctly by the database. Only when manually entering data must you set the
index to get the correct symbol. Set the index value to 0 to get the symbol G, to 1 to
get the symbol H298 and to 2 to get H0.
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SAVE_GES_WORKSPACE
This command is for the Gibbs Energy System (GES) module.
This command or module is not available with GES6.
Workspace Files
The data used by the GES workspace can be saved in a file (with a default extension GES5
under MS-Windows, or ges5 under Linux). The default file name is RESULT.GES5 or equal to
the one used in a previous READ_GES_WORKSPACE command.
Syntax SAVE_GES_WORKSPACE
Enter a File name and specify the working directory where to save the file in the Save in field.
Normally the default file-type in the Files of type field is the correct one for the GIBBS workspace
format (i.e. *.GES5 file).
The output is unformatted and cannot be printed.
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SAVE_WORKSPACES
This command is available for both the POLY and GES (GIBBS) modules.
Workspace Files
You can save the current status and workspaces, including thermodynamic data, conditions,
options and results from a single, stepping or mapping calculation on a *.POLY3 file. The
workspaces are saved to a file with this command. This is useful so you have access to the
workspace for later use or when you need to terminate the current Console Mode session.
l
l

l

In the Gibbs (GES) module workspace, all thermochemical data are stored.
In the POLY module workspace, all the last set of conditions and equilibrium state,
changed status, entered symbols, advanced options, defined stepping/mapping
variables, added initial equilibria, stepped/mapped results, etc., are stored, so it also
contain the GES workspace.
When you are in a response-driven module such as POTENTIAL or SCHEIL for
example, a workspace file is automatically opened. In the workspace file, system
definitions, conditions for the calculation, calculation results, and plot settings are
saved. The file is saved in the current working directory, and is named after the
name of the module that created it. For example, the POTENTIAL module saves a
workspace file called POT.POLY3 ; the POURBAIX module saves a file called
POURBAIX.POLY3 and so forth.

After a SAVE_WORKSPACES command, you can always come back to exactly the
state you had when you issued the command by giving a READ_WORKSPACE
command. For example, after saving the POLY and GIBBS workspaces to a file,
you can leave the program and at a later time READ the file and continue from
the saved state.

Important Information About Map and Step Commands
A STEP or MAP command automatically saves the workspace with the most
recently specified name. Do not use the SAVE_WORKSPACES command after a

Thermo-Calc User Guide: Console Mode ǀ 327 of 643

Thermo-Calc Documentation Set

MAP or STEP command.

The results from the STEP or MAP commands are destroyed by the SAVE_WORKSPACE
command. You can append several results obtained by sequential STEP or MAP calculations
without destroying the previous results, whilst SAVE_WORKSPACE erases them all. Keeping this
in mind is important and useful particularly for calculating various isothermal (or isoplethal)
sections and plotting them on the same diagram in a single Thermo-Calc run.
To suspend some of the STEP or MAP results, use the AMEND_STORED_EQUILIBRIA command.
Syntax

SAVE_WORKSPACES

A file name must be specified. The default extension of the POLY workspace file is *.POLY3 but
you can have any other file extension.
Linux and Mac are case sensitive so ensure you enter .POLY3.
A Save window displays if a file name is not given after the command, so that the path (in the Save
in field) and File name can be specified. The Files of type cannot be changed.
If there is already a file with the same file name under the directory a warning message displays.
Click OK to overwrite the current POLY or GIBBS workspace onto the existing file. Click Cancel to
Options return to the module. You can use the SAVE command with an unspecified name (i.e. through SAVE
,,, command-sequence) to save the POLY or GIBBS workspace.
When saving a POLY3 workspace under a name that already exists under the
current work area, which is saved by default (after running a special module, e.g.
BIN, TERN, POT, SCHEIL and POURBAIX) or in an earlier stage of the current Console
Mode session or in a previous run (which is READ into the current POLY3
workspace), you can type SAVE,,Y or SAVE_WORKSPACE ,,y. However, this must also
be avoided if some results from previous MAP or STEP calculations shall not be
destroyed.
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SET_R_AND_P_NORM
The value of the gas constant (R) is used to define the energy units that are used for input of
data. On output, all data are in SI units. The value of the pressure 1 atm is used to interpret
values of the pressure given by application programs.
Syntax

SET_R_AND_P_NORM
Value of gas constant in your energy units /8.31451/: <New value>

Prompts The default value of the gas constant is in SI units (i.e. 8.31451). If you change this value, it only
affects the interpretation of energy data given interactively from the terminal, e.g. if the value is
set to 1.98717 you can give values in Calories.
Value of one bar in your presure units /100000/: <New value>

The value of the pressure given in application programs is divided by this value and then
multiplied with the value of one bar expressed in Pascal before it is used inside the GIBBS module.
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SCHEIL Module Commands
In this section:
BCC_TO_FCC_TRANSFORMATION

331

EVALUATE_SEGREGATION_PROFILE

332

GLOBAL_MINIMIZATION

333

LIQUID_PHASE_NAME

334

SAVE_FILE_NAME

335

SET_NUMERICAL_LIMITS

336

START_WIZARD

338

TEMPERATURE_STEP

341

TERMINATION_CRITERIA

342

USE_BACK_DIFFUSION

343
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BCC_TO_FCC_TRANSFORMATION
This command is for the SCHEIL module.
Use this command to allow transformations in the solidified part of the alloy caused by each
of the components specified to be fast diffuser.

It is recommended that you only select this for steels.

Syntax

BCC_TO_FCC_TRANSFORMATION
Allow bcc → fcc ? /N/

Prompt

Enter Y to allow transformations.
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EVALUATE_SEGREGATION_PROFILE
This command is for the SCHEIL module.
Use this command in order to evaluate a segregation profile while performing the Scheil
calculation. The Scheil calculation itself does not contain a spatial dimension. However, if it
is assumed that the molar volume is constant and equal for all elements, and if a length is
provided over which solidification occurs (for example the secondary dendrite arm spacing)
then the generated profile corresponds to the segregation that would be obtained under the
assumptions of a Scheil calculation. The grid is then equidistant and can be used as input for
a DICTRAsimulation.
The generated text file contains, on each line, the mole fractions of all elements in
alphabetical order at a certain grid point. If the composition is the same on several
consecutive lines it means that the composition of the then remaining liquid has reached a
state in which there are no degrees of freedom.
Syntax

EVALUATE_SEGRATION_PROFILE
Evaluate segregation profile? /N/

Prompt

If the answer is Y, a segregation profile will be evaluated and saved to disc. Note that
this feature is not supported with back diffusion; if back diffusion is enabled no
segregation profile will be generated.
Number of grid points /100/

Enter the number of grid points for the segregation profile. A file dialogue window opens and
allows you to specify the name of the file in which the segregation profile is written.
In a macro file it is possible to enter all arguments on a single line, e.g. EVALUATE_SEGREGATION_
PROFILE Y 100 XF.TXT, meaning that the segregation profile is evaluated over 100 grid points and
saved to a file (XF.TXT) in the current working directory.
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GLOBAL_MINIMIZATION
This command is for the SCHEIL module.
ADVANCED_OPTIONS for information about that GLOBAL_MINIMIZATION
command.
Syntax

GLOBAL_MINIMIZATION
Use global minimization? /N/

The default (N) does not use global minimization. If you choose Y, the global minimization is done
Prompt when possible (depending on the conditions setting), and a global minimization test is performed
when an equilibrium is reached. This costs more computer time but the calculations are more
robust.
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LIQUID_PHASE_NAME
This command is for the SCHEIL module.
Use this command to use the liquid phase name from the database definitions or enter
another phase name.
Syntax

LIQUID_PHASE_NAME
Liquid phase name /Default/

Prompt

Default selects the liquid phase from the database definitions, otherwise enter a phase name.
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SAVE_FILE_NAME
This command is for the SCHEIL module.
Use this command to save the file. The files get the console number added to this name, e.g.
005.->Scheil_006.POLY3 and Scheil_segregation_profile.txt).
Syntax

SAVE_FILE_NAME

Name of files to be saved, POLY and segregation profiles.
Prompt

Linux and Mac are case sensitive so ensure you enter .POLY3.
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SET_NUMERICAL_LIMITS
This command is available for the POLY, Scheil and ED-EXP modules.
Change the criteria for convergence. This is to speed up a calculation in a complex system.
If there is any convergence problem in finding a stable solution at any stage during a
calculation procedure enforced by COMPUTE_EQUILIBRIUM, STEP_WITH_OPTIONS, MAP or
ADVANCED_OPTION S), this message displays:
Convergence problems, increasing smallest site-fraction from
1.00E-30 to hardware precision 2.00E-14. You can restore using
SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY module calculations, you can use this
command to restore or reset the smallest site fraction to the previous or another preferred
value, as well as to reset other numerical limits.
Syntax

SET_NUMERICAL_LIMITS
Maximum number of iterations /500/:

Prompt By default, the program tries 500 iterations before it gives up. As some models give computation
times of more than 1 CPU second/iteration, this number is also used to check the CPU time and
the calculation stops if 500 CPU seconds/iterations are used.
Required accuracy /1E-6/:

This is a relative accuracy, and the program requires that the relative difference in each variable
must be lower than this value before it has converged. A larger value normally means fewer
iterations but less accurate solutions. The value should be at least one order of magnitude larger
than the machine precision.
Smallest fraction /1E-12/:

This is the value assigned to constituents that are unstable. It is normally only in the gas phase you
can find such low fractions.
The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with
one sublattice site (such as the GAS mixture phase in many databases) for which the default value
is always as 1E-30 (unless you have used the SET_NUMERICAL_LIMITS command to reset an evenlower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).
Approximate driving force calculation for metastable phases /Y/:

Normally the POLY module only requires that the set of stable phases is in equilibrium in order to
terminate the iterations. By default, the metastable phases are included in all iterations but these
may not have reached their most favourable composition and thus their driving forces may be only
approximate.
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Syntax

SET_NUMERICAL_LIMITS

If it is important that these driving forces are correct, choose N to force the
calculation to converge for the metastable phases. This may require more iterations,
and the STEP and MAP command may also terminate due to bad convergence in a
metastable phase.
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START_WIZARD
This command is for the SCHEIL module.
About the Scheil-Gulliver Solidification Simulations
Use this command to use the START_WIZARD with step-by-step prompts to create a basic
Scheil simulation.
You are prompted for settings including the major element or alloy, composition input in
mass (weight) percent, the alloying elements, the temperature, fast diffusing components,
and whether any phase should have a miscibility gap check. If back diffusion is enabled using
the USE BACK DIFFUSION command, there are additional prompts included in the Start Wizard
and described below.
The Scheil with back diffusion feature is only available for systems with diffusion
data, i.e. it requires the use of a mobility database.
Use the other commands to make changes to settings that are not included in this wizard.
l

BCC_TO_FCC_TRANSFORMATION

l

EVALUATE_SEGREGATION_PROFILE

l

GLOBAL_MINIMIZATION

l

LIQUID_PHASE_NAME

l

SAVE_FILE_NAME

l

STORED_COMPOSITION_TYPE

l

TEMPERATURE_STEP

l

TERMINATION_CRITERIA

Syntax

START_WIZARD

The following is a list of the prompts. Press <Enter> to accept the defaults that are shown
between the forward slashes (/default/).
Database /<Default>/:

Prompt

The available thermodynamic database and its version are available to enter (based on license).
Enter ? for a list.
Major element or alloy:

The major element in the system, e.g. Fe for a steel.
Composition input in mass (weight) percent? /Y/:
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Syntax

START_WIZARD

Set whether to specify the Composition input in mass (weight) percent (the default) or in Mole
percent. Enter Y for mass percent and N for mole percent.
1st alloying element:

You can specify all the alloying elements and their corresponding compositions on
the same line when you are prompted to specify your first alloying element. For
example, you can enter Cr 5 Ni 1 Mo 0.5 C 0.01 N 0.02.

You can directly specify mass or mole percent after the name (for example, enter Cr 5). If this is
not specified, then you are prompted to enter it separately.
Mass (weight) percent /1/
2nd alloying element:

Specify the other alloying elements in the same way as you specify the first (for example, c 1).
Mass (weight) percent /1/
Next alloying element:

After you have specified your last alloying element, press <Enter> when requested to specify the
next element. This ends the process of defining the bulk composition of the alloy system.
Temperature (C) /2000/:

Enter a value for the temperature in degrees C (Celsius) . This value should be sufficiently high so
that the solidification simulation starts with the alloy system in the liquid single-phase region.
Decide which phases (if any) to reject at the Reject phase(s) prompt. Enter the name of the
phases to reject or press <Enter> for NONE.
Decide whether to Restore phase(s). You may want to restore a phase that you rejected when
you ran the simulation earlier, or you may want to restore a phase that is rejected by default in
your database. Enter the name of the phases to restore or press <Enter> for NONE.
Then you are asked to confirm whether these phases should be retained in this system:
OK? /Y/:

Press <Enter> to accept the default Y or type N and press <Enter>. Thermodynamic data about the
alloy system you defined is retrieved from the database.
Should any phase have a miscibility gap check? /N/:

If you answer Y, you are prompted to specify the Phase with miscibility gap. Answer with a
solution phase name(s) (e.g. FCC) as well as the Major constituents for sublattice (for each
sublattice site) (for this example, Cr is entered for sublattice 1 and C for sublattice 2).
Press Enter to specify another phase.
Fast diffusing components: /None/:

Enter the elements that diffuse fast in solid phases and can assume to be in equilibrium in the
whole phase. E.g. C in a steel.
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Syntax

START_WIZARD

If the USE_BACK_DIFFUSION command is set to Y to enable back diffusion, the following prompts
are included with the Start Wizard at various points in the set up:
Mobility Database /<Default>/:

The available mobility database and its version are available to enter (based on license). Enter ?
for a list.
You then are shown a list of what phases are available for the database and the defined system
and have the opportunity to reject or restore phases at the next prompts.
Reject phase(s) /NONE/:
Restore phase(s): /NONE/:

Then you are asked to confirm whether these phases should be retained in this system:
OK? /Y/:

Press <Enter> to accept the default Y or type N and press <Enter>.
Temperature time dependence /LINEAR/:

Specify the type of temperature time dependence. Press <Enter> to accept this default.
An increased value moves the result from equilibrium toward a Scheil-Gulliver calculation.
Back
Diffusion
settings

LINEAR is currently the only available option and it corresponds to a constant
cooling rate.
Cooling rate (K/s) /.1/:

Specify the cooling rate in Kelvin per second (K/s). An increased value moves the result from
equilibrium toward a Scheil-Gulliver calculation.
Expression for secondary dendrite arm spacing /CONSTANT/:

Secondary dendrite arm spacing is the distance in meters (m) between two secondary dendrite
arms. Specify the type of secondary dendrite arm spacing by entering CONSTANT (the default) or
POWER_LAW.
An increased value moves the result from equilibrium toward a Scheil-Gulliver calculation. Use
l

l

CONSTANT for a constant dendrite arm spacing. If you choose this, then enter a value for the
Secondary dendrite arm spacing (m) /5E-05/: prompt.
POWER_LAW in the form c*(cooling rate)^-n where c and n are entered in the next
prompts. If you choose this, then enter a value for the Exponent n /.33/: and Scaling
factor c /5E-05/:

Primary phase /AUTOMATIC/:

Specify the phase name or Automatic (default) for the primary phase. The primary phase is the
phase where the back diffusion takes place. If Automatic is selected, the program tries to find the
phase which will give the most back diffusion. That behavior can be overridden by selecting a
specific primary phase.
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TEMPERATURE_STEP
This command is for the SCHEIL module.
Use this command to define a temperature step.
Syntax

TEMPERATURE_STEP

Prompt Set temperature step (C) /1/
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TERMINATION_CRITERIA
This command is for the SCHEIL module.
Use this command to define the termination criteria for the fraction of liquid or
temperature.
Syntax

TERMINATION_CRITERIA

Prompts Fraction of liquid or Temperature (F or T)? /F/
Fraction of liquid /.01/
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USE_BACK_DIFFUSION
This command is for the SCHEIL module.
The Scheil with back diffusion feature is only available for systems with diffusion
data, i.e. it requires the use of a mobility database.
About the Scheil-Gulliver Solidification Simulations
The USE_BACK_DIFFUSION command enables back diffusion in the solid primary phase. Once
enabled, there are additional prompts and settings that are included and described with the
START_WIZARD command.
Syntax

USE_BACK_DIFFUSION
Use back diffusion? /N/

Prompt

The default (N) does not use back diffusion. If you choose Y, then back diffusion is used.
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PARROT Module Commands
The PARROT Module in the Data Optimization User Guide.
In this section:
About the ENTER_PARAMETER Command

347

AMEND_PARAMETER

351

AMEND_SYMBOL

354

COMPILE_EXPERIMENTS

357

CONTINUE_OPTIMIZATION

358

CREATE_NEW_STORE_FILE

359

EDIT_EXPERIMENTS

360

ENTER_PARAMETER

361

LIST_ALL_VARIABLES

363

LIST_CONDITIONS

364

LIST_PARAMETER

365

LIST_PHASE_DATA

367

LIST_RESULT

368

LIST_STORE_FILE

373

LIST_SYMBOL_IN_GES

374

OPTIMIZE_VARIABLES

375

READ_PARROT_WORKSPACES

376

RECOVER_VARIABLES

377

REINITIATE

378

RESCALE_VARIABLES

379

SAVE_PARROT_WORKSPACES

380

SET_ALTERNATE_MODE

381
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SET_EXTERNAL_PARAMETER

382

SET_FIX_VARIABLE

383

SET_OPTIMIZING_CONDITION

384

SET_OPTIMIZING_VARIABLE

386

SET_OUTPUT_LEVELS

387

SET_SCALED_VARIABLE

388

SET_STORE_FILE

389
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About the ENTER_PARAMETER Command
For the PARROT Module, this command is the same and is described here. See
ENTER_PARAMETER for the command details.
In the descriptions of the standard thermochemical properties and special physical
properties for a phase, there are a number of parameters which may depend on the
temperature and pressure. The expressions for these parameters can be given in a free
form as a sum of terms with powers of T and P and may also include the natural logarithm
and exponential function. This type of expression is called TP-functions. Identical parameters
(in terms of parameter-names) are stored only once in the GIBBS workspaces.
The composition-dependence of the Gibbs energy is described in the GIBBS module by the
internal data structure, which is created when the phase is entered (see Gibbs Energy
System (GES) Commands). The Gibbs energy of a phase is always referred to one formula
unit of the phase, i.e. the amount derived from the number of sites (i.e. the stoichiometric
coefficient) for each sublattice. If vacancy is a constituent of a sublattice, the amount of
matter per formula unit of the phase may vary with composition.

How to Define a Parameter
A valid parameter should have the general form of:
<identifier>(<phase>, <constituent array>; <digit>) <xxx> <expression> <yyy>
<keyword Y or N> <zzz> !

The identifier must be followed by an opening parenthesis, a phase name, a comma and a
constituent array. Optionally, the constituent array can be followed by a semicolon and a
digit. The parameter name is terminated by a closing parenthesis. The parameter form is
defined as:
is the parameter type;

l

<identifier>

l

<phase>

l

<constituent array>

l

<digit>

l

<expression>

is the phase name (maximum 24 characters);
is the specific constituent array in the phase;

is the degree of composition-dependent interaction contribution (an integer
number from 0 through 9), that is only for excess energy (L), Curie temperature (TC)
and Bohr magneton number (BMAGN), as well as for volume-related parameters (V0
or VA or VC or VK); if it is valued as zero, or if it is for the standard Gibbs energy (G)
for which the degree is always zero, it can be omitted;
is the mathematical relation to describe the parameter;

Thermo-Calc User Guide: Console Mode ǀ 347 of 643

Thermo-Calc Documentation Set

and <yyy> are the low and high temperature limits respectively for the
applicable temperature range of the parameter expression;

l

<xxx>

l

<keyword Y or N>

is the indicator on if there is continuation for the parameter

expression or not;
l
l

<zzz>

is the reference index/number for the assessment of this parameter;

The exclamation point ! is used to indicate that the current parameter definition is
ended.

Parameter Name
The GES parameter name has a general form of:
<identifier>(<phase>,<constituent array>;<digit>)

Examples of parameter names:
l

G(GAS,C1O2): The

Gibbs energy of formation of a CO2 molecule in gas.

l

G(FCC,FE:VA): The

l

L(LIQ,Fe,Cr;0: The

l

L(LIQ,Fe,Cr;1): The

l

TC(BCC,Fe:Va): The

l

BMAGN(BCC,Fe:Va): The

Gibbs energy of formation of fcc Fe with interstitials.
regular solution parameter for Fe and Cr in liquid.
sub-regular solution parameter.

Curie temperature of bcc Fe.
Bohr magneton number parameter of bcc Fe.

The parameter name consists of several parts. The first is a type-identifier and these can be
used:
l

G: Standard energy parameter

(Gibbs energy of formation) or for interaction

parameters;
l

L: Excess energy parameter

(Gibbs energy of interaction) always used for interaction

parameters;
l

TC: Curie

temperature for magnetic ordering;

l

BMAGN

l

VO: Molar

l

VA: Integrated thermal

l

VC: High-pressure

or BM: Bohr magneton number for magnetic ordering (or Born function ωPr,Tr
for aqueous solute species).
volume at 298.15 K and 1 bar (a numeric value only);
expansivity;

fitting parameter;
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l

VK: Isothermal

compressibility.

For more information about the high pressure volume,see X.-G. Lu, M. Selleby,
B. Sundman, ÄImplementation of a new model for pressure dependence of
condensed phases in Thermo-Calc,Ä Calphad. 29, 49–55 (2005).
When necessary quantities as H (enthalpy), S (entropy), V (Volume), F
(Helmholtz energy), etc., can be calculated from the Gibbs energy.

Phase Name
Specifying the PHASE NAME in uppercase is recommended; however, if you prefer to write it
as a mixture of uppercase and lowercase, it automatically converts all lowercase to
uppercase, as the GIBBS module only recognises uppercase phase names. It is important that
if a phase bears a legal phase-type (among G, A, Y, L, I, F and B) in its phase definition
(already by the PHASE keyword; such as GAS:G, LIQUID:L,SLAG:L, IONIC-LIQ:Y, SPINEL:I, FCC_
L12:F, HCP_D021:F, BCC_B2:B, AQUEOUS:A), such a valid phase-type code should not be
attached to the phase name when ENTER_PARAMETER is executed.

Constituent Array
The constituent array consists of a list of constituent names. Interaction parameters have
two or more constituents from the same sublattice separated by a comma. If the phase has
sublattices, at least one constituent in each sublattice must be specified. The constituents in
different sublattices must be given in sublattice order and are separated by a colon.
After the component array, a sub-index digit can be specified after a semicolon. This digit
must be in the range 0 to 9. The interpretation of the sub-index depends on the excess
energy model used for the phase. If no semicolon and digit are given, the sub-index value is
assumed to be as zero.
The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary
parameters, are multiplied with two or more fractions of the constituents from the same
sublattice of the solution phase. These additional constituents must be given as interacting
constituents (as the following prompt).
Solution phases with sublattices can have interacting constituents in each
sublattice.

Interaction Parameter
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An interaction parameter, which is used to describe the excess term of a quantity, must have
two or more constituents that interact with each other on a specified sublattice site of the
given phase. It is arbitrary which of these constituents is given as the first constituent and
what is given as the interacting constituents. The software always sorts the constituents (in
each sublattice) in alphabetical order when the parameter name is written as a prompt (for
entering its parameter value) and when the parameter is listed (using the GIBBS commands
LIST_PARAMETER or LIST_PHASE_DATA). This is important for all asymmetric interaction
parameters where the sign of the interaction parameter must depend on the appearance
order.
Use an asterisk* to denote that the excess interaction parameter is independent of the
constituents of a specific sublattice. For example, L(FCC_L12,AL,NI:*) means that the
interaction parameter is for the binary interaction between constituents AL and NI on the
first sublattice in the FCC_L12 solution phase, while it is independent of all constituents on
the second sublattice. An interaction parameter in the list of constituents is always added to
the Gibbs energy and the asterisk * is calculated with the term of [1∑y(specified
constituents)], which implies that in an A-B binary system these L parameters are identical
(but in higher-order systems, these are different):
l

L(phase,A,B)

is multiplied with X(A)*X(B)

l

L(phase,A,*)

is multiplied with X(A)*(1-X(A))

l

L(phase,B,*)

is multiplied with X(B)*(1-X(B))

If you press <Enter> when you are asked for a parameter name or if you have improperly
input the entire parameter name, you are asked for each of these items in the name.

Thermo-Calc User Guide: Console Mode ǀ 350 of 643

Thermo-Calc Documentation Set

AMEND_PARAMETER
This command is for the PARROT module.
There is also a Gibbs (GES) module command with the same name.
Interactively modify the TP-function(s) for a specific parameter for a phase with this
command. This is useful in order to correct typing errors because the old function is made
available for interactive editing on the terminal.
Syntax

AMEND_PARAMETER
Parameter: <Parameter name>

Specify a correct parameter name. If a parameter name is not acceptable or <Enter> is pressed,
Prompts the error message displays:
*** Error, please re-enter each part separately

The program prompts for separate input for each part for a parameter name.
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Specify one of these types of legal identifiers
ENTER_PARAMETER
Phase name (ABCD/): <Phase name>

Specify the phase name.
Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name.
Interacting constituent (In sublattice # /XYZ/): <Species name>

Specify the interacting constituent name; if there is no interacting constituent, press <Enter>.
Interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent, specify these; otherwise press <Enter>.
Degree /#/: <Degree>

Specify a numerical number as the degree of the phase parameter.
After the parameter name is specified correctly, the program lists its current definition (either
preset in database or defined by the ENTER_PARAMETER command), such as:
L(PHASE2,AL,MG;1)=
298.15<T<2000.00: +5000
2000.00<T<4500.00: +4500
4500.00<T<6000.00: +4000
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Syntax

AMEND_PARAMETER

You are prompted to change the parameter definition:
Do you want to change the number of ranges /No/:

Enter Y to change the number of ranges for the chosen function, or change some of the
temperature limits in the definition, then retype both the low/high temperature limits and
functions
If you do not want to change the number of ranges but want to change the function(s) in one or
more ranges, press <Enter> and the whole definition of the chosen parameter in all ranges (if
any) is listed such as:
DIFFERENT FUNCTIONS IN THESE RANGES
298.15<T<2000.00
2000.00<T<4500.00
4500.00<T<6000.00

This message prompts:
Do you want to change range limits /No/:

If there is more than one range, this question is prompted. Press <Enter>.
Range number (0 to exit) /0/: <Range number>

If the function of a parameter is different in two or more temperature ranges, you must specify
the range of the function of which you want to amend. Or press <Enter> or type 0 to exit this
command without making any change.
Function

The previous function is available for editing. The editing is performed within the general
subroutine FOOLED, as described in AMEND_SYMBOL. This routine prompts as follows:
1:+:>

The prompt consists of the current position in the string and the character at that position
between colons, (::).

Commands
These commands can be given:
l

Help: ?

l

Move CP to last or first character: <+/-> A

l

Delete characters from CP: <+-#characters> D

l

Exit: E

l

Find: <#occurrences> F<string>@

l

Insert: I<string>@

l

Move: <+-#positions> M

l

Restore string: R
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Syntax

AMEND_PARAMETER
l

Substitute: S<OLD>@<NEW>@

l

Type string: T

Where CP denotes the current position in a string, # means number of, @ is a terminator of an
input or search string.
When the string is typed the character at the current position is replaced by an
underscore _.
To finish the editing of the current function, type E at the prompt.
Range number (0 to exit) /0/: <Range number>

Give a range number to edit that function, or press <Enter> or type 0 to exit this command.
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AMEND_SYMBOL
This command is for the PARROT module.
The same command is also available for the Gibbs (GES) module.
Interactively calculate the current values of a function or table (predefined by the switched
database or previously entered with ENTER_SYMBOL) at the current temperature and pressure
condition, and also possible to modify the definitions of variables or functions.
The current values of the temperature and pressure used to calculate the
functions or tables are the ones listed with LIST_STATUS. There is no way to
change the current temperature and pressure values interactively.
To modify the definitions of entered symbols (variable, functions or parameters), the
performance of this command is slightly different one from another, as described below:
l
l

l

Syntax

For variables, the values can be changed.
For functions the low and high temperature limits in various ranges (if any), as well
the expressions, can be changed.
For parameters the low and high temperature limits in various ranges (if any), as
well the expressions, can be changed.
AMEND_SYMBOL
Name: <Symbol name>

Specify the name of an entered symbol.
For tables and functions (or parameters which are treated as functions after these are entered by
the ENTER_SYMBOL command with the Parameter keyword, but not by the ENTER_PARAMETER
command), after the symbol name is specified here, the program automatically calculates the
Prompts values under the current temperature and pressure conditions, and lists the current values, such
as:
FUNCTION VALUE
TABLE VALUE

2.52500000E+01

1.56000000E+02

For variables and functions (or parameters), there are additional prompts and depend on the
symbol type.
For a variable, its current value is displayed, and you can change it to a new value:
Value /Current value/: <New value>

For a function (or a parameter entered as a symbol):

Thermo-Calc User Guide: Console Mode ǀ 354 of 643

Thermo-Calc Documentation Set

Syntax

AMEND_SYMBOL
Do you want to change the number of ranges /No/:

Enter Y to change the number of ranges for the function, or change some of the temperature
limits in the definition, then retype both the low/high temperature limits and functions (see all the
remaining details in the ENTER_SYMBOL command.
If you do not want to change it, press <Enter>. The definition of the chosen function in all ranges
(if any) is listed, for example:
DIFFERENT FUNCTIONS IN THESE RANGES
298.15<T<2000.00
2000.00<T<4500.00
4500.00<T<6000.00

and this message displays:
Do you want to change range limits /No/:

If a function is different in two or more temperature ranges, you must specify the range of the
function of which you want to amend. Or press <Enter> or type 0 to exit this command without
making any change.
Range number (0 to exit) /0/: <Range number>
Function:

The previous function is available for editing. The editing is performed within the general
subroutine FOOLED. This routine prompts as follows:
1:+:>

The prompt consists of the current position in the string and the character at that position
between colons (::).

Commands
These commands can be given:
l

Help: ?

l

Move CP to last or first character: <+/-> A

l

Delete characters from CP: <+-#characters> D

l

Exit: E

l

Find: <#occurrences> F<string>@

l

Insert: I<string>@

l

Move: <+-#positions> M

l

Restore string: R

l

Substitute: S<OLD>@<NEW>@

l

Type string: T

Where CP denotes the current position in a string, # means number of, @ is a terminator of an
input or search string.
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Syntax

AMEND_SYMBOL

When the string is typed the character at the current position is replaced by an
underscore _.
To finish the editing of the current function, type E at the prompt.
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COMPILE_EXPERIMENTS
The descriptions of the experimental equilibria saved on a textual *.POP file, given as
commands in the POLY and ED_EXP syntax, is compiled by this command into the PARROT
structured data, i.e. stored into the current work *.PAR file which is created with CREATE_
NEW_STORE_FILE, set by SET_STORE_FILE , or opened with READ_PARROT_WORKSPACES,
all done before COMPILE_EXPERIMENTS.
This command also lists the compilation details on screen or onto a listing file (*.TXT).
If a syntax error in the commands is detected, the compilation is terminated.
You need to correct the error in the *.POP file (using a textual editor) and
recompile it with the *.PAR work (store) file.
After a successful compilation, the program translates all the experimental data points in
the *.POP file into a graphical experimental data file (*.EXP) in the DATAPLOT syntax, which
can be further edited and used as a graphical experimental data file (*.EXP) for the purposes
of imposing onto calculated/plotted phase diagrams and/or property diagrams for
comparisons during the assessment process.
DATAPLOT User Guide included with this documentation set.
Syntax

COMPILE_EXPERIMENTS

A window displays to open the original experimental data file (*.POP). Enter a *.POP File name
box, and specify the working directory in the Look in box. Normally the default file-type in the
Files of type field is the correct one for the experimental data format (i.e. *.POP file). Click Open
or Cancel button as applicable.
Output to screen or file /Screen/: <*.pop file name>

Prompts A list of the source code in the *.POP file and error messages during compilation is written on
screen (by pressing <Enter>) or on a list *.TXT file under a specific file name which can later on be
opened and edited by any basic textual editor.
Initiate store file /Y/:

After a successful compilation, the data in the POLY workspace is stored as a new block of
equilibria on the current work (store) file. By default the store file is initiated before compilation
and only the compiled block is stored on the current work file (consequently, the *.PAR file is
updated).
A window displays to generate/store the graphical experimental data file (*.EXP) in the DATAPLOT
syntax. Enter a *.EXP file name in the File name field and specify the working directory when
opening the *.EXP file in the Look in field. Normally the default file type in the Files of type field is
the correct one for the graphical experimental data format (i.e. *.EXP file). Click Open or Cancel
as applicable.
To keep the current work file, enter N.
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CONTINUE_OPTIMIZATION
This command is for the PARROT module.
This command continues the optimization using the same Hessian matrix.
In some cases it is not possible to attempt continuation. For example, if the
optimization has already converged or if the optimizing parameters or the set of
experimental equilibria used in the current optimization runs are changed. The
program gives a warning message if you try to continue when you make these
changes.
Syntax

CONTINUE_OPTIMIZATION
Are you sure? /N/: <N or Y>

Prior to this question, a message displays to confirm if it is OK to continue:
Prompts

It is safe to CONTINUE only after TOO MANY ITERATIONS
experiments ...

and no change in variables and

You can accept the default (N) in order to cancel this special attempt.
Number of iterations /N/: <Integral number of iteration>

Specify an integral number for the optimization iteration. The specified iteration number is shown
as the default number. The PARROT program tries this exact number of different sets of values of
the optimizing variables without stopping the optimization even it would have converged earlier
or should give up earlier.
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CREATE_NEW_STORE_FILE
This file is hardware dependent and cannot be read by any text editor.
Create a binary file to be used as a work file (also called store file) before any optimization
can be done. The workspace used by the GIBBS, POLY and PARROT modules is stored
automatically on the work file but not any experimental information. The binary work file
has a default extension of PAR under MS-Windows or par under Linux/UNIX.
A work file that is created at a previous run can be used in the PARROT module with the
other command SET-STORE-FILE.
Syntax

CREATE_NEW_STORE_FILE

<*.par file name>
Prompt A Save window displays. Enter a File name and specify the working directory in the Save in field.
Normally the default file-type in the Files of type field is the correct one for the PARROT
workspace format (i.e. PAR file). Click Save or Cancel as applicable.
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EDIT_EXPERIMENTS
Initialize and make available the sub-module for editing experimental equilibria, i.e. the ED_
EXP module. All experimental equilibria compiled from the *.POP file can be accessed in the
ED_EXP module.
The ED_EXP module is similar to the normal POLY module, but some commands are special
and some POLY commands are not available. In the ED_EXP module, you can calculate each
equilibrium separately or together, provide start values for equilibria which failed to
converge, set weights, and modify the values of experiments or conditions.
Syntax EDIT_EXPERIMENTS
You are now in this submodule and can start using the commands.
l

l

l

The first required command after entering the ED_EXP module for the first time
(from the PARROT module GOTO MODULE ED-EXP) should always be READ_BLOCK in
order to load the experimental data block from the current work *PAR-file for
editing.
The READ_BLOCK command must also be used prior to any other ED_EXP command if
the module is reinitiated, or if no experimental data block is not previously read from
a work file compiled with a proper experimental data .POP file, or if you want to
change to another data block for editing.
If any change is made in the ED_EXP module remember to use the command SAVE_
WORKSPACE before going BACK to the PARROT module.
Although the TABLE_HEAD, COMMENT and FLUSH_BUFFER commands are visible in
the ED_EXP module, these cannot be used here as these only work in a *.POP
file (or *.DOP file for DICTRA).
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ENTER_PARAMETER
This command is for the PARROT module.
There is also a Gibbs (GES) module command with the same name.
About the ENTER_PARAMETER Command
Use this command to enter TP-function(s) for a specific parameter for a phase interactively
with this command. If there is already a parameter expression defined (for this parameter),
that is deleted and replaced with newly entered one.
The entered TP-Function(s) for the parameter can be changed later with the command
AMEND_PARAMETER.
Syntax

ENTER_PARAMETER
Parameter: <Parameter name>

As explained in About the ENTER_PARAMETER Command, specify a correct and complete
Parameter Name, which should contain all the necessary parts of the general form:
Prompts

<Identifier>(<Phase>,<Constituent array>;<Digit>)

If a parameter name is not acceptable or <Enter>, is pressed, a message displays:
*** Error, please re-enter each part separately

and you are prompted for input for each required part for a parameter name.

Options

Description or Information
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Identifier

If this command is used one or more times, the previous value on this prompt is set as default.
Press <Enter> for the same type identifier or specify a new type.
Phase name (/ABCD/): <Phase name>

Phase name

Each parameter is valid for a specific phase only. The name of that phase must be supplied
(maximum 24 characters). The name can be abbreviated.
Constituent (in sublattice # /ABC/): <Species name>

A parameter is identified by the constituents on a specified sublattice site of the given phase,
the stoichiometric coefficients of which are multiplied with the parameter. The name of the
constituent can be abbreviated.
Constituent

It is the species name, not the stoichiometric formula required here.
If this command is used one or more times, the previous value on this prompt is set as default.
Accept it by pressing <Enter> if the constituent is the same, or specify a new species name.
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Syntax

ENTER_PARAMETER

For phases with several sublattices, the program asks for one constituent in each sublattice.
Interacting constituent (in sublattice # /XYZ/): <Species name>

If this command is used one or more times, the previous value on this prompt is set as default.
Press <Enter> to accept it if the constituent is the same, or specify a new species name.
Interacting
constituent

To cancel the default value of the interacting constituent type NONE or the name
of another constituent.
This question is repeated until all the interested interacting constituent(s) on a specific
sublattice in the phase are specified, and finally an <Enter> is enforced.
Degree /#/: <Degree>

Degree

Degree is model-dependent. Specify an integer number (a value from 0 through 9) as the
degree of composition-dependent interaction contribution for the phase parameter. This is
valid for excess energy (L), Curie temperature (TC) and Bohr magneton number (BMAGN), as
well as for volume-related parameters (V0, VA, VC or VK).
For binary interaction parameters, the degree is usually the power in the Redlich-Kister
expression. For ternary interaction parameters, it is usually the Hillert ternary index.
For a standard G parameter for a pure component (end-member) its degree should be always
0 and this prompt should not display.
After this prompt, the program echoes on the screen the full TP-Function of the phase
parameter.
Low temperature limit /298.15/: <Lowest temperature limit in K>

Specify the lowest temperature limit (in Kelvin), or the lowest-pressure limit (in Pascal but
entered as a negative number), for the current TP-Function.
Function: <Definition for a function>
Phase
parameter

A TP-Function consists of terms in T and P.
& <Continuation of the definition for the current function>

Continuation of a TP-Function definition.
High temperature limit /6000/: <High temperature limit in K>

Specify the high temperature limit (in Kelvin), or the high-pressure limit (in Pascal; only if the
lowest limit is entered as a negative number) for the current TP-Function.
Any more ranges? /N/:

Enter Y for more function(s) or N to end this command.
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LIST_ALL_VARIABLES
This command is for the PARROT module.
Create a list of the values and status of all variables in the PARROT workspace on screen or
in a text file. After an optimization some statistical information is also written. The
correlation matrix is written if that option is chosen.
SET_OUTPUT_LEVELS.
Syntax

LIST_ALL_VARIABLES
Output to screen or file /Screen/: <File name>

Prompt A list of the current values and status, as well statistical information (if after optimization) and the
correlation matrix (optionally), for all variables is written on screen (by pressing <Enter>) or on the
list file under a specific file name which can later on be opened and edited by basic text editor.

Example
The following is the listed variables for the example TCEX36, after the first optimization when
having set all variables available for optimization.
== OPTIMIZING VARIABLES ==
AVAILABLE VARIABLES ARE V1
VAR.

VALUE

TO V00

START VALUE

SCALING FACTOR

REL.STAND.DEV

V1

2.03729090E+04

2.03688352E+04

2.03688352E+04

3.41524152E+00

V2

-2.94286372E+01

-2.94286372E+01

-2.94286372E+01

2.37944771E+00

V11

-2.17373936E+04

-2.18095983E+04

-2.18095983E+04

3.97086303E-02

V12

1.52107184E+01

1.51660547E+01

1.51660547E+01

5.84552327E-02

V15

2.42082351E+04

2.45139169E+04

2.45139169E+04

5.00914471E+00

V16

-8.38723972E+00

-8.83460472E+00

-8.83460472E+00

1.60961318E+01

V17

3.08916533E+03

3.15802558E+03

3.15802558E+03

9.63738108E+00

V19
2.20292586E+04
2.21385673E+04
2.21385673E+04
4.14274011E+01
7.04217974E+00
-7.22424882E+00
-7.22424882E+00
1.00561540E+02
NUMBER OF OPTIMIZING VARIABLES :

V20

-

9

ALL OTHER VARIABLES ARE FIX WITH THE VALUE ZERO
THE SUM OF SQUARES HAS CHANGED FROM
DEGREES OF FREEDOM

45.

8.00002729E+04 TO

REDUCED SUM OF SQUARES

8.00002719E+04

1.77778382E+03
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LIST_CONDITIONS
This command is for the PARROT module.
Use this command to generate a list of the current values of optimization conditions, as well
the current status of listing, either on screen or in a basic text file which can be opened and
edited by a text editor.
Syntax

LIST_CONDITIONS
Output to screen or file /Screen/: <File name>

Prompt

Press <Enter> to output to screen or on the list file under a specific file name.
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LIST_PARAMETER
This command is for the PARROT module.
There is also a Gibbs (GES) module command with the same name.
List the TP-function(s) of a specific parameter for a phase. You must supply the name of the
phase parameter:
The parameter name: <Identifier>(<Phase>,<Constituent array>;<Digit>)

For encrypted commercial databases, you may not be able to use this command
to list any retrieved parameter.
Syntax

LIST_PARAMETER
Parameter: <Parameter name>

Specify a correct and complete parameter name, which should contain all the necessary parts of
the general form: <identifier>(<phase>,<constituent array>;<digit>)
Prompts

See About the ENTER_PARAMETER Command to learn how to define the
parameter name.
If a parameter name is not acceptable or <Enter> is pressed, an error message displays:
*** Error, please re-enter each part separately

The program prompts for separate input for each required part for a parameter name.
Identifier (/X/): <G or L, or TC, or BM, or V0 or VA or VC or VK>

Specify one of these types of legal identifiers.
Phase name (/ABCD/): <Phase name>

Specify the phase name.
Constituent (in sublattice # /ABC/): <Species name>

Specify the constituent name on the specified sublattice site of the given phase.
Interacting constituent (in sublattice

# /XYZ/): <Species name>

Specify the interacting constituent name on the specified sublattice site of the given phase; if
there is no interacting constituent, press <Enter>.
Interacting constituent (in sublattice # /XYZ/): <Species name>

If there is more than one interacting constituent on the specified sublattice site of the given
phase, specify them; otherwise press <Enter>.
Degree /#/: <Degree>
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Syntax

LIST_PARAMETER

Specify a numerical number as the degree for the phase parameter.
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LIST_PHASE_DATA
This command is for the PARROT module.
List all the phase from the Gibbs (GES) module for a specific phase. These are displayed on
screen. The thermochemical parameters listed for each phase are always in SI units.
Syntax

LIST_PHASE_DATA
Phase name: <Phase name>

Prompt

Specify a phase name.
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LIST_RESULT
This command is for the PARROT module.
List the result of the current optimization run on screen or in a specified file. The level of
detail listed can be prescribed by the command SET_OUTPUT_LEVELS.
The LIST_RESULT command has an option G for creation of an experimental data file with
two columns, one for the experimental value and the other for the calculated value. It allows
plotting a diagram and visualizing the fitting results. The plot is automatically plotted and
you can scale it giving commands in the POST module. The option D lists all experiments,
including those with fulfilled inequalities which are suppressed with the default option C.
Syntax

LIST_RESULT

Prompt Full, Condensed, Detailed or Graphic format: /C/: <C or D or F or G>
Choose a format.
l

The F (full) format is obsolete but retained for backward compatibility.

l

C (condensed) is the default.

l

D (detailed) lists all experiments, including those with fulfilled inequalities (not included with

the default condensed file).
l

The G (graphical) format creates an experimental data file containing two columns, one with
the experimental value and the other with the calculated value. This allows plotting of a
diagram where all symbols should be on the diagonal if the fit is perfect. The plot is
automatically plotted and you can scale it giving commands in the POST module.

Output to screen or file /Screen/: <File name>

A list of the current optimization results are written on screen (by pressing <Enter>) or on the list
file under a specific file name which can later on be opened and edited by basic text editor.
The output normally consists of these parts:
l

A title showing the data of the action;

l

A message on successful optimization with the iteration number in the last optimization;

l

A paragraph describing the optimization condition;

l

A list of the latest set of optimized and fixed variables;

l

A paragraph describing the optimization quality (some statistical information);

l

l

l

A correlation matrix for all optimizing variables (optionally shown, pre-set by the SET_
OUTPUT_LEVELS command);
A list of all parameters (including their symbol names, status and current values or function
expressions), and all phase descriptions (including phase name, model names, constituents,
and phase’s G/L/TC/BM expressions) predefined for each phase in the system (optionally
shown, pre-set by the SET_OUTPUT_LEVELS command);
A paragraph describing the alternate equilibria (and possible error during optimization);
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Syntax

LIST_RESULT
l

A detailed list on all the equilibrium points used in the current optimization. If the alternatemode is used in the optimization, only an error value is shown. For normal-mode calculations,
a list is shown for the experimental equilibrium numbers (first column) and corresponding
original experimental data (second column, in the form quantity = value) which are used in
optimization (i.e. non-zero weighted points). Such experimental data are by each point
compared by the calculated value (third column) after the last optimization. Also listed are the
experimental error (column 4), the difference between the calculated value and original
experimental data (column 5), and the contribution to the sum of least square (column 6).

Example
The following is the listed result after the first optimization based on the prescribed
definitions in the TCEX36a.TCM and TCEX36b.TCM, but having set all variables available for
optimization.
=====================================================
OUTPUT FROM P A R R O T.
*** SUCCESSFUL OPTIMIZATION. ***

NUMBER OF ITERATIONS:

10

== OPTIMIZING CONDITIONS ==
RELATIVE STANDARD DEVIATIONS FOR EXPERIMENTS: N
MINIMUM SAVE ON FILE: Y
ERROR FOR INEQUALITIES =

1.00000000E+00

RELATIVE STEP FOR CALCULATION OF DERIVATIVES =

1.00000000E-04

ARGUMENTS FOR SUBROUTINE VA05AD (HSL)
MAXFUN =
1
DMAX = 1.00000000E+02
SUM OF SQUARES) * 1.00000000E-03

H =

1.00000000E-04

ACC = (INITIAL

== OPTIMIZING VARIABLES ==
AVAILABLE VARIABLES ARE V1
VAR.

VALUE

TO V00

START VALUE

SCALING FACTOR

REL.STAND.DEV

V1

2.03749463E+04

2.03729090E+04

2.03729090E+04

3.41455863E+00

V2

-2.94286372E+01

-2.94286372E+01

-2.94286372E+01

2.37944774E+00

V11

-2.17395673E+04

-2.17373936E+04

-2.17373936E+04

3.98405298E-02

V12

1.52107184E+01

1.52107184E+01

1.52107184E+01

5.82861832E-02

V15

2.42106560E+04

2.42082351E+04

2.42082351E+04

5.07239609E+00

V16

-8.38723972E+00

-8.38723972E+00

-8.38723972E+00

1.69546796E+01

V17

3.08947424E+03

3.08916533E+03

3.08916533E+03

9.85220694E+00

V19
2.20314615E+04
2.20292586E+04
2.20292586E+04
4.16329629E+01
-7.04217974E+00
-7.04217974E+00
-7.04217974E+00
1.03161466E+02

V20
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NUMBER OF OPTIMIZING VARIABLES :

9

ALL OTHER VARIABLES ARE FIX WITH THE VALUE ZERO
THE SUM OF SQUARES HAS CHANGED FROM
DEGREES OF FREEDOM

45.

8.00002719E+04 TO

REDUCED SUM OF SQUARES

Number of alternate equilibria
SYMBOL

STATUS

1.77778380E+03

14

VALUE/FUNCTION

R

80000000

RTLNP

20000000 +R*T*LN(1E-05*P)

V1

48000000

V2

48000000 -2.9428637E+01

V11

48000000 -2.1739567E+04

V12

48000000

1.5210718E+01

V15

48000000

2.4210656E+04

V16

48000000 -8.3872397E+00

V17

48000000

21 V19

8.00002709E+04

8.3145100E+00

2.0374946E+04

3.0894742E+03

48000000

2.2031462E+04

22 V20

48000000 -7.0421797E+00

LIQUID
EXCESS MODEL IS REDLICH-KISTER_MUGGIANU
A,B

CONSTITUENTS:

G(LIQUID,A;0)-G(BCC,A;0) =

500.00<T< 2000.00: +14000-10*T

G(LIQUID,B;0)-G(BCC,B;0) =

500.00<T< 2000.00: +18000-12*T

L(LIQUID,A,B;0) =
500.00<T< 2000.00: +V11+V12*T
500.00<T< 2000.00: +V13+V14*T

L(LIQUID,A,B;1) =

A2B
2 SUBLATTICES, SITES

2:

1

CONSTITUENTS: A : B

G(A2B,A:B;0)- 2 G(BCC,A;0)-G(BCC,B;0) =
500.00<T< 2000.00: +V1+V2*T+V3*T*LN(T)
BCC
EXCESS MODEL IS REDLICH-KISTER_MUGGIANU
A,B

CONSTITUENTS:

G(BCC,A;0)-G(BCC,A;0) =

500.00<T< 2000.00: 0.0

G(BCC,B;0)-G(BCC,B;0) =

500.00<T< 2000.00: 0.0

L(BCC,A,B;0) =

500.00<T< 2000.00: +V15+V16*T

L(BCC,A,B;1) =

500.00<T< 2000.00: +V17+V18*T

FCC
EXCESS MODEL IS REDLICH-KISTER_MUGGIANU
A,B

CONSTITUENTS:
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G(FCC,A;0)-G(BCC,A;0) =

500.00<T< 2000.00: 408

G(FCC,B;0)-G(BCC,B;0) =

500.00<T< 2000.00: +3300-3*T

L(FCC,A,B;0) =

500.00<T< 2000.00: +V19+V20*T

L(FCC,A,B;1) =

500.00<T< 2000.00: +V21+V22*T

======

BLOCK NUMBER

1

DEFINED CONSTANTS
DX=2E-2, P0=101325, DH=500, DT=10
DEFINED FUNCTIONS AND VARIABLES%
HTR=HM(LIQUID)-HM(A2B)
Alternate equilibrium calculation

0.4183

Alternate equilibrium calculation

0.1932

Alternate equilibrium calculation

0.1016

Alternate equilibrium calculation

1.4354E-03

Alternate equilibrium calculation

2.5063E-02

Alternate equilibrium calculation

8.3929E-03

Alternate equilibrium calculation

141.4

Alternate equilibrium calculation

141.4

Alternate equilibrium calculation

141.4

Alternate equilibrium calculation

141.4

Alternate equilibrium calculation

1.2532E-03

Alternate equilibrium calculation

5.4781E-04

Alternate equilibrium calculation

1.5404E-03

Alternate equilibrium calculation

1.2702E-03

ACR(B)=9.4E-1

0.9397

2.85E-02 -2.7745E-04 -9.7472E-03

ACR(B)=8.4E-1

0.8395

2.82E-02 -4.9038E-04 -1.7396E-02

ACR(B)=7.4E-1

0.7407

2.81E-02

7.3804E-04

2.6305E-02

ACR(B)=6.4E-1

0.6424

2.81E-02

2.3935E-03

8.5272E-02

ACR(B)=5.4E-1

0.5434

2.82E-02

3.4449E-03

0.1220

ACR(B)=4.4E-1

0.4428

2.85E-02

2.8265E-03

9.9024E-02

ACR(B)=3.4E-1

0.3394

2.90E-02 -5.8174E-04 -2.0040E-02

ACR(B)=2.3E-1

0.2320

2.97E-02

ACR(B)=1.2E-1

0.1194

3.06E-02 -6.4192E-04 -2.0981E-02

HMR(LIQUID)=-1964

-1957.

5.00E+02

7.439

1.4878E-02

HMR(LIQUID)=-3500

-3478.

5.00E+02

21.67

4.3338E-02

HMR(LIQUID)=-4588

-4565.

5.00E+02

22.69

4.5382E-02

HMR(LIQUID)=-5239

-5217.

5.00E+02

21.50

4.3008E-02

2.0260E-03

6.8208E-02
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HMR(LIQUID)=-5454

-5435.

5.00E+02

19.11

3.8216E-02

HMR(LIQUID)=-5233

-5217.

5.00E+02

15.50

3.1008E-02

HMR(LIQUID)=-4575

-4565.

5.00E+02

9.691

1.9382E-02

HMR(LIQUID)=-3481
(LIQUID)=-1950

-3478.
-1957.

5.00E+02
2.669
5.00E+02 -6.561

5.3385E-03
-1.3122E-02

118 HMR
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LIST_STORE_FILE
This command is for the PARROT module.
Use the LIST_STORE_FILE command to display the name of the store file and its full path.
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LIST_SYMBOL_IN_GES
This command is for the PARROT module.
Lists TP-function(s) for the entered model parameters for phases in the system on screen. In
many cases, the optimizing variables are parts of the TP-functions which in turn are entered
in model parameters for various phases in the GIBBS workspace.
This command is a way to find out how the functions depend on the optimizing variables. In
the PARROT module the list is only shown on screen, not written to any file (which the LIST_
SYMBOL command in the GIBBS module does).
Syntax

LIST_SYMBOL_IN_GES
Name: <Symbol name>

Specify a symbol name.
Prompt
Only those symbols that match this name are listed. Or press <Enter> for a list of all
available symbols entered in the system.
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OPTIMIZE_VARIABLES
This command is for the PARROT module.
Perform variable optimization. All system-definition data needed for the optimization is read
from the current work file (*.PAR). The result of the optimization is automatically stored in
the current work file.
Syntax

OPTIMIZE_VARIABLES
Number of iteration /N/: <Integral number of iteration>

Prompt Specify an integral number for the optimization iteration. The specified iteration number is shown
as the default number. The PARROT module tries this number of different sets of values of the
optimizing variables unless it has converged earlier, or has given up earlier.
It initially takes a small step in each variable to find the steepest slope. You can give
zero iteration to calculate the error in all selected experiments, and then use LIST_
RESULT to check how good (bad) the current fit is.
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READ_PARROT_WORKSPACES
This command is for the PARROT module.
Workspace Files
Read the previous PARROT/GIBBS/POLY workspaces back to replace the current
PARROT/GIBBS/POLY workspaces. It is useful if late changes made through various
PARROT/GIBBS/POLY commands are not satisfactory.
Syntax READ_PARROT_WORKSPACES
The previous PARROT/GIBBS/POLY workspaces are always associated with the latest action to either
open a work file by SET_STORE_FILE, or to create a work file by CREATE_NEW_STORE_FILE (either
interactively in the PARROT module or through a MACRO_FILE_OPEN of an *SETUP.TCM file), or to
update the work file by SAVE_PARROT_WORKSPACES.
Unlike the READ commands in other modules (e.g. GIBBS or PLOY), this command in the PARROT
module does not ask for the file name where to read a previously opened/created/updated
PARROT/GIBBS/POLY workspaces, for the reason described above.
You cannot use this command if there is no work file opened or created already.
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RECOVER_VARIABLES
The RECOVER_VARIABLES command is used to set back the values of all variable to the start
values.
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REINITIATE
This command should not be used unless you want to destroy the current
PARROT workspace. However, this PARROT command does not reinitiate the
GIBBS/POLY3 workspaces.

This command is for the PARROT module.
The REINITIATE command is used to reinitiate the workspace used by PARROT. All output and
optimizing conditions are given their default values. All variables are set fixed with their
value equal to zero.
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RESCALE_VARIABLES
When using the RESCALE_VARIABLES command, the current values of all the parameters are
copied to their start values and the scaling factors for further optimization. Thus it should be
done now and again, in particular if you think the optimization results are improved after
the previous run(s), or if any variable changes more than a factor of 10.
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SAVE_PARROT_WORKSPACES
This command is for the PARROT module.
If the latest changes made through various PARROT/GIBBS/POLY commands are as required,
use this command to save the current workspace (i.e. data area) used by the PARROT
program (also including the current GIBBS and POLY workspaces), onto the present work
*.PAR file which has already been opened by SET_STORE_FILE or been created by CREATE_
NEW_STORE_FILE (either interactively in the PARROT module or through a MACRO_FILE_OPEN
of an *SETUP.TCM file).
The PARROT/GIBBS/POLY workspaces are updated after each
PARROT/GIBBS/POLY command. This means the current PARROT/GIBBS/POLY
workspaces are always updated onto the latest work *.PAR file that is associated
with the latest SET_STORE_FILE or CREATE_NEW_STORE_FILE command.
Workspace Files
Syntax SAVE_PARROT_WORKSPACE
Unlike the SAVE commands in other modules (e.g. GIBBS or PLOY), this command in
the PARROT module does not ask for the file name where to save the current
PARROT/GIBBS/POLY workspaces, for the reason described above. You cannot use
this command if there is no work *.PAR file opened or created already.
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SET_ALTERNATE_MODE
Turn the alternate mode on or off.
With the ALTERNATE mode is possible to include functions to be evaluated together with an
alternate calculation and to select ALTERNATE mode for each experimental equilibrium.
The alternate mode is described in About Alternate Mode. It should be used only
to optimize start values of the model parameters in the beginning of the
assessment.
Syntax

SET_ALTERNATE_MODE
On /Y/:

Prompt

By default alternate mode is ON.
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SET_EXTERNAL_PARAMETER
This command is for the PARROT module.
Optimize model parameters of the so-called external models, which may not be as fullyimplemented/integrated parts inside the GIBBS system and thus are independently defined
within user-specified/written source codes. This command makes links between the PARROT
optimizing variables and external model parameters.

In order to be able to build the specified external model and to use this SET_
EXTERNAL_PARAMETER command, it requires you to first write codes for a
preferred external model (as it is not within the standard GIBBS system of the
Thermo-Calc software) and then provide it to a consultant at Thermo-Calc
Software AB for the purpose of including the external model in a separate DLL
that is interactively connected to the software. For more information about our
consultancy services, see our Consultancy page on our website.

Syntax

SET_EXTERNAL_PARAMETER
External name: <Parameter name in the external model>

Prompt

Correctly specify the parameter name defined within a specified/written external model.
As optimizing variable number: <n>

Give the number of the PARROT optimizing variable, which should have a unique link to the
specified parameter name of the external model.
For example, @@ Link PARROT variables to CAM parameters:
SET-EXTER-PAR GT(SLAG_A,O-2,SI+4,CA+2) 1
SET-EXTER-PAR ET(SLAG_A,O-2,SI+4,CA+2) 2
SET-EXTER-PAR EXT(SLAG_A,O-2,SI+4,CA+2) 3
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SET_FIX_VARIABLE
Prescribe a fixed value to a variable. The variable is considered as a constant at the
optimization, usually after successful optimization runs for some specific variables (for some
of the phases in the system). Such fixed variables can also be set back for further
optimization run by using SET_OPTIMIZING_VARIABLE.
Syntax

SET_FIX_VARIABLE
Variable number: <Variable number(s)>

Prompts Specify the number of the variable. It is possible to give a range by giving two numbers with a
hyphen in between (no spaces allowed), e.g. l. The parameters within the limits are set fixed to
their current values (no question of values).
Start value /xxxx.xxxxx/: <A value to be fixed>

Specify a numerical value to be fixed for the selected variable (only when one variable number is
specified at the previous prompt). The current value for the selected variable is shown as default.
If a range of variable numbers is specified at the previous prompt, this question is not prompted,
and the current values are used as fixed values.
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SET_OPTIMIZING_CONDITION
This command is for the PARROT module.
Specify the conditions for the optimization. The default values are chosen automatically by
the PARROT program, and in most cases these should not be changed.
The optimization stops when the sum of errors decreases by this value, even
though it might be possible to increase it further with a new OPTIMIZE command.
Syntax

SET_OPTIMIZING_CONDITION
Relative standard deviation for experiments? /N/:

By default the standard deviation of the experimental determinations are absolute values. Enter
Y if these are used as relative weighting factors.
The estimated standard deviations of the optimized variables might be different for
the two cases.
Min save on file? /Y/:

Specify whether the program should minimize the transfer of data to and from the current work
file during the optimization:
Prompt

l

l

If the default (N) is kept, the workspaces are stored on the current work file after every
iteration in the optimization procedure.
Enter Y to speed up the optimization. After optimization use the SAVE_PARROT_WORKSPACES
command to update the progress onto the current work file.

Relative step for calculation of derivatives: /1e-04/: <xxx>

In the calculation of the correlation matrix for equilibria with inaccuracy in the independent state
variables, some numerical derivatives might have to be calculated.
Specify the relative step (xxx) for the calculation of these derivatives.
Maxfun (va05ad): /100/: <n>

The maximum number of iterations in the optimization. The same value set by the OPTIMIZE
command.
Dmax (va05ad): /100/: <n>

An estimate of the maximum distance between the start and the final values of the variables. A
smaller value makes the program vary the parameters with smaller factors.
H (va05ad): /1e-04/: <xxx>

The step used in the scaled variables for calculating numerical derivatives during the optimization.
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Syntax

SET_OPTIMIZING_CONDITION
Acc/(initial sum of squares) (va05ad): /.001/: <xxx>

The break condition for the optimization. The accepted value is the difference between the true
minimum and the calculated one.
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SET_OPTIMIZING_VARIABLE
This command is for the PARROT module.
Specify which variable value should be estimated at the optimization. Such a variable can
have a value of zero or another start value, or is fixed by SET_FIX_VARIABLE prior to the
previous optimization run.
For a good reference prior to this command, a list of all variables (which are used to define
various parameters for phases in the optimizing system, as pre-entered in the *SETUP.TCM
file or interactively entered in the GIBBS module) are obtained by using LIST_ALL_VARIABLES.
Syntax

SET_OPTIMIZING_VARIABLE
Variable number: <Variable number(s)>

Specify the number(s) for the variable(s) to be set. Any non-zero parameter within the range is
allowed to be optimized. A parameter with a current value equal to zero must be specified
Prompts explicitly here in order to be optimized.
Specify a range by giving two numbers connected by a hyphen (no space allowed!), e.g. 2-8.
Under this circumstance, no question of start values are asked.
Start value /xxxx.xxxxx/: <A guess value>

Specify a start guess of the optimum value (only when one variable number is specified at the
previous prompt). The current numerical value for the selected variable is shown as default.

This guess is critical as the initial guess of all parameters must make it possible to
calculate the selected equilibria. If a range of variable numbers is specified at the
previous prompt, this question is not prompted, and the current values (as start
values) are not changed.
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SET_OUTPUT_LEVELS
This command is for the PARROT module.
Choose the type of information the PARROT module gives during the optimization procedure
and when listing results.
Syntax

SET_OUTPUT_LEVELS
List increment /1/: <Increment in iteration number>

Prompts Specify the increment in iteration number for which information is listed on screen during the
optimization. By giving a larger number it shortens the list.
List sum of squares: /Y/:

Choose whether the sum of squares is listed on screen during the optimization procedure.
List scaled variables: /Y/:

Choose whether the scaled variable values are listed on the terminal during the optimization
procedure.
List weighted residuals: /N/:

Choose whether the weighted residuals are listed on the terminal during the optimization
procedure.
List all parameters: /N/:

Choose whether all parameters in the models are listed in LIST_RESULT.
List correlation matrix: /N/:

Choose whether the correlation matrix of the variables are listed with the commands LIST_RESULT
and LIST_ALL_VARIABLES.
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SET_SCALED_VARIABLE
This command is similar to SET_OPTIMIZING_VARIABLE in that it specifies start values for
optimizing variables. The difference being it is functional for only one optimizing variable at
one time. It also prescribes a minimum and maximum value for the variable. During the
optimization runs, the variable value is limited within this min-max range.
Such a variable may have a value of zero or another start value, or may be fixed by SET_FIX_
VARIABLE prior to the previous optimization run. For a good reference prior to using this
command, a list of all variables (which are used to define various parameters for phases in
the optimizing system, as entered in the *SETUP.TCM file or interactively entered in the
GIBBS module) is obtained by using LIST_ALL_VARIABLES.
Syntax

SET_SCALED_VARIABLE
Variable number: <Variable number(s)>

Prompts Specify the number for an optimizing variable to be set. Any non-zero parameter is allowed to be
optimized, and a parameter with a current value equal to zero must be specified explicitly here in
order to be optimized.
Start value /xxxx.xxxxx/: <A guess value>

Specify a start guess of the optimum value. The current numerical value for the selected variable
is shown as default.

This guess is critical as the initial guess of all parameters must make it possible to
calculate the selected equilibria.

Min value /xxxx.xxxxx/: <A guess value>

Specify a minimum guess of the optimum value. It should be smaller than, at least equal to, the
current start value for the selected variable.
Max value /xxxx.xxxxx/: <A guess value>

Specify a maximum guess of the optimum value. It should be larger than, at least equal to, the
current start value for the selected variable.
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SET_STORE_FILE
This command is for the PARROT module.
Specify a store file (work file) to be used for compilation and optimization. The *.PAR work
file must be created (CREATE_NEW_STORE_FILE) as a store file. The GIBBS, POLY and PARROT
workspaces are read from the specified store file (with a default extension of PAR).
Syntax

SET_STORE_FILE

Enter a *.PAR file name in the File name field and specify the working directory in the Look in
Prompt field. Normally the default file-type in the Files of type field is the correct one for the PARROT
workspace format (i.e. *.PAR file). Click Open or Cancel as applicable.
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EDIT_EXPERIMENTS (ED_EXP) Submodule Commands
EDIT_EXPERIMENTS (ED-EXP) is a submodule of PARROT.
In this section:
ADVANCED_OPTIONS

393

CHANGE_STATUS

394

COMMENT

399

COMPUTE_ALL_EQUILIBRIA

400

CREATE_NEW_EQUILIBRIUM

401

DEFINE_COMPONENTS

402

DELETE_SYMBOL

403

ENTER_SYMBOL

404

EVALUATE_FUNCTIONS

406

EXPERIMENT

407

EXPORT

409

FLUSH_BUFFER

410

GRAPHICS_PLOT

411

IMPORT

412

LABEL_DATA

413

LIST_ALL_EQUILIBRIA

414

LIST_CONDITIONS

415

LIST_EQUILIBRIUM

416

LIST_STATUS

417

LIST_SYMBOLS

418

MAKE_POP_FILE

419

READ_WORKSPACES

420
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REINITIATE_MODULE

421

RESTORE_ALL_WEIGHTS

422

SAVE_WORKSPACES

423

SELECT_EQUILIBRIUM

424

SET_ALL_START_VALUES

425

SET_ALTERNATE_CONDITION

427

SET_CONDITION

430

SET_NUMERICAL_LIMITS

433

SET_REFERENCE_STATE

435

SET_START_CONSTITUTION

437

SET_START_VALUE

438

SET_WEIGHT

439

SHOW_VALUE

441

STORE_ALL_WEIGHTS

442

TABLE_HEAD, TABLE_VALUES and TABLE_END

443

TRANSFER_START_VALUES

445
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ADVANCED_OPTIONS
This command is available with the POLY and ED-EXP modules.
ADVANCED_OPTIONS described for the POLY module.
Syntax

ADVANCED_OPTIONS

Prompt Which option? /Step_and_Map/: <Option>
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CHANGE_STATUS
This command is available with the POLY and ED-EXP modules.
In the POLY module, set the status for components, species and phases in the defined system
for all the sequential calculations (single-point, stepping, and mapping) in equilibrium or
local/partial equilibrium state. Each component, species and phase has a status. The default
status is ENTERED.
The most important use is to calculate metastable equilibria and metastable phase diagrams
by setting some phases (that would otherwise be stable) to the SUSPENDED or DORMANT
phase-status. Another important applications is to calculate paraequilibria by setting some
components to the SPECIAL component-status.
For a component and for a species, the status can be one of the following:
l

ENTERED: the

component(s) or species are included in the calculation. This is the
default status.

l

SUSPENDED: the

l

SPECIAL: the

component(s) or species are not considered in the calculation.

specified component(s) are not included in summations for mole or
mass fractions. It only works for component(s).
Only component(s) can have the status SPECIAL, which implies that these are
not included in summations for mole or mass fractions.

For example, for the u-fractions or other normalized fractions, when one or more of the
components are excluded from the summation, you must specify which component(s) should
be excluded from the calculation of mole or mass fraction. This component status is
particularly useful when calculating paraequilibrium states. Such component(s) are normally
interstitial component, and must have the status SPECIAL. This is assigned by the CHANGE_
STATUS command.
Syntax

CHANGE_STATUS
For phases, species or components? /Phases/: <Keyword>

Prompts

Keyword = phase or species or components
Phase name(s): <Name(s) of the phase(s)>

For phase as the keyword, the names of the phases that have their status changed must be given
(all on one line). A comma or space must be used as separator. The status to be assigned to the
phases can also be given on the same line if preceded with an equal sign (=).
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Syntax

CHANGE_STATUS

An asterisk, *, can be used to denote all phases. The special notations *S, i.e. a
wildcard * directly followed by an S, sign, means all suspended phases. In the same
way, *D means all dormant phases, and *E means all entered phases.
Name(s): <Name(s) of the Species or Component(s)>

For species or components as the keyword, the names of the species or components that have
their status changed must be given (all on one line). A comma or space must be used as separator.
Similarly to the case of phase as the keyword, the status to be assigned to the species or
components can also be given on the same line if preceded with an equal sign =.
An asterisk, *, can be used to denote all species or components. The special
notations *S, i.e. a wildcard * directly followed by an S, sign, means all suspended
species or components. In the same way, *E means all entered species or
components.
Status /Entered/: <New status>

The new status to be assigned must be given.
For species, the values ENTERED or SUSPENDED can be used.
For the POLY module, using the Entered or Suspended status here has the same
result as using the commands MAKE_COMPONENT_ENTERED and MAKE_
COMPONENT_SUSPENDED. The exception is that any existing conditions that
depend on a suspended component are removed when using the MAKE_
COMPONENT_SUSPENDED command.
For components, the status ENTERED, SUSPENDED or SPECIAL can be given. SPECIAL means that this
component is excluded from sums for mole fractions and mass fractions, which is useful when
calculating the ufractions or other normalized fractions of system components.
For phases, the status ENTERED, SUSPENDED, DORMANT or FIXED can be given. DORMANT means the
same as suspended but the driving force is calculated. FIXED means that it is a condition that the
phase is stable at a certain amount.
For example, for the ufractions, when one or more of the components are excluded from the
summation, you must specify which component should be excluded from the calculation of the
mole fraction. This component must have the status SPECIAL. This is assigned by the CHANGE_
STATUS command: Change_Status comp C=special.
Start value, number of mole formula units /0/: <Initial amount>

For ENTERED phases, an initial amount of the phase can be given. Normally, 0 is given if the
phase is not likely to be stable, and 0.5 or 1 or any positive number if the phase could be stable,
but such an initial amount is only used as the rough starting estimation in the equilibrium
calculations.
Number of mole formula units /0/: <Equilibrium amount>

For FIXED phases, the equilibrium amount of the phase [always using an initial estimation being
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Syntax

CHANGE_STATUS

the NPF(phase) value which it is the normalized mole number of components (per mole formula
unit) of the specific status-fixed phase] must be given. If the equilibrium amount is zero, then the
phase is at its stability limit.

Note when specifying a FIXED phase status
Special attention should be paid when specifying a FIXED phase status in equilibrium calculations
(for single points, stepping or mapping calculations), as described below.
The phase amount variables, NP(phase), BP(phase) and VP(phase), as well as all their M/W/Vsuffixed quantities, should not be used as conditions. Instead, use the CHANGE_STATUS command
to set a relevant condition, e.g. CHANGE_STATUS phase <phase>=fix <amount> where the fixed
<amount> is roughly the same as the F-suffixed quantity NPF(phase).
The NPF(phase) quantity is the normalized mole number of components (per mole formula unit)
of the specific phase in the defined system, which unlike other F-suffixed state variables [e.g. GF
(phase), HF(phase) and DGF(phase)] cannot be directly applied in any POLY command, implying
that it cannot be directly evaluated or listed/shown. If intended to shown such a normalized phase
amount value in an equilibrium state, you should use a properly-entered symbol (function or
variable), for example: NPFabc = NP(abc)/NA or NPFabc = NPM(abc)/NA*N. N is the total system size
(in mole). The NA value is a quantity that is phase-dependent (and sometimes also equilibriumdependent for ionic solution phases), and is the total atomic number in a mole-formula-unit of the
specific phase abc (excluding interstitial component and, of course, vacancy). For example, the
SIGMA, FCC, BCC and LIQUID phases (among others) in a defined Fe-Cr-Ni-C-N-O system (retrieved
from a specific database) may be modeled by certain models, and their NA values must be
evaluated in different ways, as described below:
LIQUID (C,Cr,CrO3/2,Fe,FeO,FEO3/2,N,Ni,NiO)1 NA = 1
FCC_A1 (Cr,Fe,Ni)1(Va,C,N,O)1 NA = 1
BCC_A2 (Cr,Fe,Ni)1(Va,C,N,O)3 NA = 1
SIGMA (Fe,Ni)8(Cr)4(Cr,Fe,Ni)18 NA = 30

If in the same Fe-Cr-Ni-C-N-O system the liquid solution phase is modeled by the Two-Sublattice
Ionic Liquid Model, i.e.:
IONIC_LIQ

(Cr+3,Fe+2,Ni+2)p(VA,C,N,O-2,FEO3/2)q,7

then the evaluation of its NA value becomes even more complicated:
NA = p + q*yC2 + q*yN2 + q*yO22 + q*yFeO2 3/ 2

where the stoichiometric coefficients p and q are also dependent upon the real equilibrium state
(rather than having fixed values in the system). Similar situations occur for other (solid) phases
which are described by a multiple sublattice model with ionic constituents, such as SPINEL and
HALITE phases in some databases.
There is no strange thing when using a zero value [i.e. 0] in a FIXED phase-status, since it means
the specified phase is stable in equilibrium state but has a zero-amount of mass in the equilibrium
calculations; in other words, on a phase diagram, the specific phase is on a zero-fraction line (ZFL),
i.e. it starts becoming stable on one side of a corresponding phase-boundary line or unstable on
the other side of the same boundary. It is often and efficient to do so when calculating e.g. solidus
equilibrium states.
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Syntax

CHANGE_STATUS

However, when a non-zero value [it must always be positive; e.g. 1 or 0.5 or 0.3 or 1.5] is to be
specified in a FIXED phase-status, it is unnecessarily the exactly same stable amount of the specific
FIXED-status phase in a calculated equilibrium state any longer; instead, the <equilibrium amount>
value is the NPF(phase) value that is only roughly used as the estimated starting-value of the
FIXED-status phase in the equilibrium calculations.
Therefore, a FIXED-status for a liquid phase being unity does not necessarily imply that it is a
liquidus equilibrium state (where the liquid phase is in equilibrium with some solid phases but the
liquid phase takes all the mass in the defined system). A unity value for setting the liquid phase
status in calculating liquidus equilibrium state can only be used when the liquid mixture phase is
predefined as a single-sublattice solution phase (such as metallic liquid phase in multicomponent
alloy systems) and the total system size as one mole (i.e. N=1).
When a phase is described by a solution model in which two or more sublattices are considered
and these sublattice sites may also have different stoichiometric coefficients [meaning that the
mixture phase could have more than one atom in formula [NA>1; see some examples above], the
unity value should not be used when setting the FIXED status for the phase; instead, you should
use an appropriate value that ranges from 0 to a NPF(phase) value that equals to or is smaller than
1/NA (if the total system size N=1) or 1/NA*N (if N differs from unity). For this reason, if a
multicomponent system bears an IONIC_LIQUID phase that is described by the Two-Sublattice
Ionic Liquid Model (or any other multiple-sublattice ionic solution phases), it is difficult to use a
proper NPF(ION_LIQ) value in setting its FIXED phase-status, because that should be less than (or
equal to) the complex value of
N/[p + q*yC2 + q*yN2 + q*yO22 + q*yFeO2 3/ 2 ].

Examples
For example, to obtain the metallic fraction in a system with carbon as an interstitial
component, you can set the component status for carbon as SPECIAL:
Change_Status comp C=special

The SUSPENDED status for components and species does not always work as
expected.
For a phase, it may have one of these statues:
l

ENTERED: the

phase(s) are included in the equilibrium calculations and these are
stable if that minimizes the total Gibbs energy in the defined system. This is the
default status for all phases already retrieved from the chosen database(s). An
ENTERED phase-status is always associated with an initially-estimated amount [in
mole number; normally, as 0 if the phase is not likely to be stable, and as 0.5 or 1 or
any positive number if the phase could be stable] but it is only used as the rough
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starting value in the equilibrium calculations.
l

SUSPENDED: the

phase(s) are not considered in the equilibrium calculations.

l

DORMANT: the

l

FIXED: it is an equilibrium

phase(s) are not considered in the equilibrium calculations but their
driving forces for precipitation are calculated.
condition that the status-fixed phase must be stable, and
be in equilibrium at a specified amount [always using an initial estimation being the
NPF(phase) value which it is the normalized mole number of components (per mole
formula unit) of the specific status-fixed phase]. See more descriptions at the end of
this command.
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COMMENT
This command is for the ED-EXP module.
The COMMENT command is only used in the *.POP/*.DOP files (so can be included with
experimental data files) to write brief comments or descriptive information on a newly
created equilibrium (experimental) data point or a set of points given in a table.
A comment can have a maximum of about 60 characters written on the same line.
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COMPUTE_ALL_EQUILIBRIA
This command is for the ED-EXP module.
In ED_EXP and PARROT modules, each experiment is treated as an individual equilibrium
with some measured values. These are created with CREATE_NEW_EQUILIBRIUM, and stored in
an experimental data *.POP file and then compiled and saved in the POLY workspace of a
PARROT work *.PAR file.
In the DICTRA module, you work with a .DOP file instead of a .POP file.
With COMPUTE-ALL-EQUILIBRIA, all equilibria from the current to the last experimental
points are calculated. If an equilibrium calculation fails, the calculation is stopped at that
equilibrium. Equilibria with weight zero is skipped.
A current or present experimental point means the latest selected or calculated
one. Once used the current point turns to the last point in the data block; in such
a case you first use SELECT_EQUILIBRIUM so that the current point is switched to a
desired one.
For this command there is always a list output on screen, which consists of six columns for
all experimental points available in the current data block:
l

The first column is the equilibrium identifier (a number) assigned by this command,

l

the second the data label assigned with LABEL_DATA,

l

the third the number of iterations,

l

the fourth the current weight, and

l

the fifth the current temperature.

l

In the sixth column the fixed stable phases are listed together with any comment text
given after a COMMENT in the *.POP or *.DOP file.

If the weight is zero for an equilibrium columns 3-5 are replaced by the text <unused>. If the
alternate mode is used for some experimental points, the listing is slightly different for such
points. The 3-4 columns are displayed with *alt*, instead. If an alternate calculation is failed
at one experimental point, the point is automatically assigned with a zero weight, and a
warning message is shown above the data line (with all six columns).
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CREATE_NEW_EQUILIBRIUM
This command is available with the POLY and ED-EXP modules.
During data-assessments using the ED_EXP module (a submodule of PARROT), you can, in
the POLY module, create several equilibria with different sets of conditions and phases (but
normally with the same set of components). By default, there is one equilibrium. To keep the
set of conditions and phase for this equilibrium, create another one using this command, and
use another set of conditions for that. Two equilibria may be useful to calculate easily the
enthalpy difference between two states. In the PARROT module, the experimental
information is stored as a sequence of equilibria.
Syntax

CREATE_NEW_EQUILIBRIUM
Equilibrium number /2/: <A new equilibrium number>

Prompts Each equilibrium in the POLY workspace is identified by a unique integer number. Such an
equilibrium number can be recalled with SELECT_EQUILIBRIUM.
Initiation code /2/:

When an equilibrium is created, you can choose to ENTER all components and phases (initiation
code 2), ENTER the components only (initiation code 1) or SUSPEND everything (initiation code 0).
No other values are legal.
The entered components and phases can later be changed with CHANGE_STATUS.
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DEFINE_COMPONENTS
This command is available with the POLY and ED-EXP modules.
Change the set of components. By default, the elements are used as components. The set of
components can be important because some conditions are set using components, for
example, the amounts, activities or chemical potentials.
For example, in the system Fe-Si-O, you can define FEO, FE2O3 and SIO2 as components,
thus replacing the default FE, SI and O.
This implies a command REINITIATE_MODULE and it should be given as the first
command in the POLY module.
Syntax

DEFINE_COMPONENTS
Give all new components / existing components/: <New components>

The new components must be specified all on one line. These replace the existing component
definitions.
Prompt
The number of components cannot be changed with this command. Use CHANGE_
STATUS instead.
To keep some existing components, it is recommended that you also enter these on the line.
Otherwise, the added new components may not be defined correctly. This is especially important
if some components are built out of several elements.
The new components do not have to be present as species.
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DELETE_SYMBOL
This command is available with the POLY and ED-EXP modules.
Use the DELETE_SYMBOL command to remove symbols i.e. constants, variables, functions or
tables.
Syntax

DELETE_SYMBOL
Name: <Name of a symbol>

Prompt

Specify the name of the symbol to be deleted. Only one symbol can be deleted each time.
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ENTER_SYMBOL
This command is for the ED-EXP module.
The GES, POLY and POST modules also have a command with the same name.
Symbols are a useful feature modules to define quantities that are convenient. Symbols can
be constants, variables, functions or tables.
Syntax

ENTER_SYMBOL
Constant, Variable, Function or Table? /Function/: <Keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION or TABLE.
l

l

l

Prompt

l

CONSTANTS can only be entered once and is a means of using a name for a numeric value. For
example, the value of 1 atmosphere in Pascal can be denoted by P0 after the command
ENTER_CONSTANT P0=101325. Defined constants can be used as values in condition
assignments, for example, SET-COND P=P0.
FUNCTIONS are expressions of state variables or other functions. These expressions are saved,
and whenever a function value is requested all functions are evaluated. The reason for this is
that they may depend on each other.
VARIABLES are similar to functions because they can also be expressions of state variables.
However, contrary to functions, they are only evaluated when they are entered or if they are
explicitly named in an EVALUATE_FUNCTIONS command. It is possible to enter a variable with a
new expression any time. This expression is evaluated directly and its value stored as the
value of the variable. Defined variables can be used as values in the SET-CONDITION
command.
TABLES are used for listing results from the STEP or MAP commands. A table consists of a list
of any number of state variables, functions or variables. Defined tables can also be used in
the post-processor POST.

There is a special connection between tables and variables. If a variable is used in a
table, it is evaluated for each line of the table in the TABULATE command or when the
table is used in a plot.
Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 8 characters.
Legal characters include letters (either UPPER or lower case), digits and underscore _. Any other
special character, such as parentheses ( and ), plus +, minus -, slash / or \, full stop (.), are illegal for
symbol names.
You can enter the symbol name and the value or function on the same line, these must be
separated with an equal sign =, for example, TC=T-273.15 or T_C=T273.15 which stands for a
definition of temperature in Celsius. Otherwise, these questions are asked.
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For different types of symbol (constant, function, variable or table), the questions
have different prompts.
Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or other functions,
constants or variables. The expression is a FORTRAN-like expression and operators +, -, *, = and **
can be used (** only with integer powers).
Unary functions like LOG, LOG10, EXP, SIN, COS and ERF can also be used. An expression can be
continued on more than one line. An expression should be terminated by a semicolon (;) or an
empty line (by pressing <Enter> at the next prompt).
Examples of function expressions:
l

GM(LIQUID): The Gibbs energy of liquid per mole component

l

H.T/4.184: The heat capacity of the system in calories

l

ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

l

T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the new line if one line is
not enough for the function. If you finish the function press <Enter> again.
Value: <Value for a constant>

A constant can only be assigned a numeric value once.
Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is evaluated
immediately and discarded. Only the numeric value is kept. This gives a possibility to save a value
between calculations with different conditions because all state variables and functions are
evaluated for the new conditions.
Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain results from a STEP
command is through a table.
Example:
ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the temperature, the mole
fractions of C and Cr in the LIQUID phase, and the activity of C.
To show the temperature in Celsius in a table, give the command ENTER_FUNCTION TC=T-273; and
then use the symbol TC in the table.
& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new line if one line is not
enough for the table. If you finish the table press <Enter> again.

Thermo-Calc User Guide: Console Mode ǀ 405 of 643

Thermo-Calc Documentation Set

EVALUATE_FUNCTIONS
This command is available with the POLY and ED-EXP modules.
The value of one or more or all entered functions or variables are evaluated and listed.
Syntax

EVALUATE_FUNCTIONS
Name(s): <Name(s) of defined function(s)>

The names of one or more entered functions or variables must be specified. By typing a wildcard
Prompt *, all functions and variables are evaluated.
Variables are evaluated only if these are explicitly named.
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EXPERIMENT
This command is for the ED-EXP module.

This command is used in original experimental data files (*.POP or *.DOP), but
can also be given interactively inside the ED-EXP module, to change the value or
uncertainty of an experiment or to add more experimental information.

In the DICTRA module, you work with a .DOP file instead of a .POP file.
An experiment usually consists of two parts with a colon (:) separating them:
l

as a quantity relation, and

l

as the uncertainty of the value for the quantity,

The quantity relation can be a normal POLY module condition or an inequality (which is
similar to condition but the relation between the quantity and given value is not in equality,
i.e. < or >). The uncertainty can be expressed as an absolute value or relative to the value
(x%).
An experiment that uses an inequality gives zero contribution to the sum of
errors in the optimization procedure of PARROT if the value is on the right side.
If the value is on the wrong side, the value after the colon determines how
steeply the error increases with the value.
Syntax EXPERIMENT
The experiment must be typed after the command. Several experiments can be given on the same
line.
The syntax of EXPERIMENT is similar to a CONDITION. Usually, a state variable set equal to a value
with a given uncertainty is specified after the colon (:). For example, T=1273.15:5.
An inequality, < or >, can also be used. For example:
ACR(C)<-0.01:0.001, W(BCC,AG)>0.05:10%

Additional Information About the Experment Command
A typical experiment added interactively specifies that a phase should not be stable in a
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certain experiment, because a phase may appear in a range of composition or of
temperature where it has never been observed during the optimization. A phase is unstable
if its driving force is negative, and you can add experimental information to enforce that.
For example, you can suppress the HCP phase in an existing experimental point:
CHANGE-STATUS HCP=DORMANT
EXPERIMENT DGM(HCP)<-.001:.0001

DGM is the POLY variable for the driving force that is already divided by RT, and
it is dimensionless. Only dormant phases can have driving forces larger than
zero, as this indicates that these would be stable if allowed to form. The
experiment in the above case tries to modify the model parameters to make the
HCP phase unstable.
More general examples of experiment definitions:
EXPERIMENT X(LIQ,PB)=.10:.01 X(FCC,PB)=0.02:.01
EXPERIMENT ACR(PB)=0.8:5%
EXPERIMENT T=700:5

The first experiment above describes a tie-line where the experimentally measured mole
fraction of Pb is 0.1 in the liquid phase and 0.02 in the FCC phase, and its uncertainty is 0.01
for both measurements. The second experiment is that the activity of Pb should be 0.8 with
an uncertainty of 5 percent.
The reference state of the component Pb must be set with the command SET_
REFERENCE_STATE. The final one is that the temperature should be 700 K with an
uncertainty of 5 degrees.
Experiments that are functions of states variable(s) must be described as the defined
functions. For example:
ENTER_FUNCTION HTR=HM(LIQUID)-HM(FCC);
EXPERIMENT HTR=7000:1000
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EXPORT
This command is for the ED-EXP module.
Transfer/export a calculated value from an equilibrium to an optimizing variable in the
PARROT workspace. Thus the value can be used, for example, in the Gibbs energy
description of a phase. This variable should not be optimized (i.e. it should be set as a fixed
variable in PARROT).
Syntax

EXPORT
Function name: <Function name>#<n>

Specify the name of the function, the value of which should be transferred to a V variable. The
number (n) of the V variable must be given after the function name, separated by hash character #.
Prompt
The function name is UPPER/lowercase sensitive, and it should normally be given in
UPPER case.

Example
Enter_function strngy=gm(fcc).x(cu);
Export strngy#6

This transfers the value of the partial derivative of the Gibbs energy of the FCC phase with respect
to the mole fraction of Cu to the optimizing variable 6 (i.e. V6).
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FLUSH_BUFFER
This command is for the ED-EXP module.
This command is only used in the *.POP file (i.e. it can also be used in the experimental data
files). It is needed if the number of experiments require more space than can be fitted into
one buffer.
In the DICTRA module, you work with a .DOP file instead of a .POP file.
When the PARROT program compiles experiments, it informs if any FLUSH commands are
needed. FLUSH_BUFFER terminates the current block, saves it to the work file and starts a
new block. With the READ command in the EDIT-EXP module, you can select the block to edit.
Syntax FLUSH_BUFFER
After a FLUSH_BUFFER command, the workspace is reinitiated and all functions or constants must be
entered again in the *.POP file. You can take advantage of this; for example, you can use the FLUSH
command to have blocks with different components in one *.POP file.
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GRAPHICS_PLOT
This command is for the ED-EXP module.
This command can help create a experimental data file from the *.POP file. Several data
sets and different symbols are allowed.
In the DICTRA module, you work with a .DOP file instead of a .POP file.
Syntax GRAPHICS_PLOT
<Dataset#> <X value> <Y value> <Symbol index>
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IMPORT
This command is for the ED-EXP module.
Transfer/import the value of one of the optimizing variables to a constant. Normally, it is
directly used inside an experimental data (*.POP) file. It is the opposite of the EXPORT
command.
In the DICTRA module, you work with a .DOP file instead of a .POP file.
The IMPORT command is useful if several experiments are done at the same activity of a
component, but this activity is not known. The activity should then be optimized and all
equilibria with the same activity should use the same value. In this case the variable must be
set as an optimizing variable, and an initial guess of the activity should be given. During the
optimization, the PARROT program tries to find the activity that gives the best fit.
If an approximate value of the activity is known, it can be supplied as an
experiment.
Syntax

IMPORT
Constant name: <Constant name>#<n>

The value of the V variable must be assigned a symbolic constant. The number (n) of the V variable
must be given after the constant name, separated by hash character #.
Prompt
The constant name is UPPER/lowercase sensitive, and it should normally be given in
UPPER case.

Example
Enter_constant acu=0.1
Import acu#2

This transfers the value of the optimizing variable 2 (i.e. V2) to the constant ACU.
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LABEL_DATA
This command is for the ED-EXP module.
Add a label to the experimental equilibrium point, either as a single point or several points
given individually or in a table. The label is maximum four characters and must start with
the letter A. Normally, it is directly used inside an experimental data file (*.POP).
In the DICTRA module, you work with a .DOP file instead of a .POP file.
Several experimental equilibria can be given the same label, and the label can be used with
SET_WEIGHT to assign the same weight to all equilibria with the same label.
Syntax

LABEL_DATA
Label? /A1/: a<bcd>

Prompt Specify a textual label (as maximum characters and must start with the letter A) for the current
experimental equilibrium point(s).
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LIST_ALL_EQUILIBRIA
This command is for the ED-EXP module.
Syntax LIST_ALL_EQUILIBRIA
List all the details (including equilibrium indicators, labels, iteration numbers, weight, and fixed
phases or comments) of all equilibrium points from the current one to the last one on screen. You
can always use SELECT_EQUILIBRIUM to select a specific point as the current equilibrium point for
such a list.
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LIST_CONDITIONS
This command is available with the POLY and ED-EXP modules.
All the conditions that are set by the SET_CONDITION command and the command-sequence
CHANGE_STATUS PHASE =FIXED <0 or 1 or alike>, are listed. The current conditions are
also listed by the LIST_EQUILIBRIUM command. The degree of freedom in the defined system
is also shown.
l
l

l

If this is zero, you can perform a COMPUTE_EQUILIBRIUM command.
If it is larger than zero, some more conditions are required, and you must further set
additional ones, using SET_CONDITION or CHANGE_STATUS.
If it is negative, then too many conditions are defined and the unnecessary ones
conditions need to be removed using the SET_CONDITION command (with a value of
NONE for the to-be-deleted condition) or the CHANGE_STATUS command (i.e.
changing a FIXED status of a phase to another type of phase status, ENTERED or
DORMANT or SUSPENDED).

Syntax

LIST_CONDITIONS
P=100000, T=800, N(NI)=1E-1, N=1

Example

FIXED PHASES
FCC_A1=1 LIQUID=0
FREEDO 0

DEGREE OF
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LIST_EQUILIBRIUM
This command is available with the POLY and ED-EXP modules.
The result (always in SI units) from the last calculated equilibrium is listed on screen or in a
text file.
You can also execute this command if no calculation is made or if the
calculation fails. Make sure to interpret the results accordingly.
Syntax

LIST_EQUILIBRIUM
Output to screen or file /Screen/: <File name>

Prompt

The name of the text file where the list of the calculation results shall be written.
Options /VWCS/: <Option(s)>

Select the output units and formats by optionally specifying a combination of these letters.
l

Fraction order: V means VALUE ORDER; A means ALPHABETICAL ORDER.

l

Fraction type: W means MASS FRACTION; X means MOLE FRACTION.

l

Composition: C means only COMPOSITION; N means CONSTITUTION and COMPOSITION.

l

Phase: S means including only STABLE PHASES; P means including ALL NON-SUSPENDED
PHASES.

Default options are VWCS. If the output fraction type should be in mole fraction (rather than mass
fraction), then give VXCS or type X (implying that in this case the options V, C and S are accepted as
the listing manners for fraction order, composition and phase).
If accepting all the default options, or if accepting all the altered options that had already changed
when using this command previously, you can type L_E,,, or LIST_EQUILIBRIUM ,,,
LIST_EQUILIBRIUM displays ORD (ordered) or

DISORD (disordered) (when available).

See CHANGE_LEGEND for details.
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LIST_STATUS
This command is for the ED-EXP module.
There is also a POLY module command with the same name.
List the status of components, species or phases.
Syntax

LIST_STATUS

Specify what to list:
Option /CPS/:<keyword(s)>

keyword = C or P or S, or any combination
Prompt

l

C: list component status

l

P: list phase status

l

S: list species status

l

CS: list both components and species

Default is CPS.
The results depend on the key word specified in the options for CHANGE_STATUS, a table with the
current status of phases or species or components, or the combinations, is shown:
l

For components, the statuses and reference states are listed.

l

For species, only the status is listed.

l

For ENTERED and FIXED phases, the status, driving forces and equilibrium amounts are listed.

The metastable phases are listed in descending order of stability. To avoid long
outputs only 10 metastable phases (in ENTERED status) are listed by lines, while all
other less stable phases are merged onto one line. For DORMANT phases, their
phase names and driving forces are listed. For SUSPENDED phases, only the phase
names are listed.
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LIST_SYMBOLS
This command is for the ED-EXP module.
There are also POLY and POST module commands with the same name.
Use this command to list the definitions for all constants, functions, variables and tables. In
order to find the value of a function or variable, use SHOW_VALUE or EVALUATE_FUNCTIONS. A
table is tabulated with the TABULATE command.
Syntax LIST_SYMBOLS
The defined variables are listed up together with the defined functions, but variable names are
followed by a percentage sign %.
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MAKE_POP_FILE
This command is for the ED-EXP module.
In the DICTRA module, you work with a .DOP file instead of a .POP file.
Use this command to make interactive changes and additions to the original experimental
data file (the *.POP or *.DOP file). For example, to document or transfer the current or final
experimental data to a *.POP file, this command will write it to a new *.POP file or
overwrite previous versions.

Check the output carefully for errors. Tables in original *.POP files are written
as individual experimental points. The output can be shown on screen or be
saved as a new *.POP file where to write or overwrite the edited experimental
information in a simple text format.

Syntax

MAKE_POP_FILE
Output to screen or file /Screen/: <POP/DOP-file name>

Prompt Specify a name of the new *.POP file where to write or overwrite the edited experimental
information in a simple text format. If an existing *.POP file name is specified, it is overwritten.
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READ_WORKSPACES
This command must be given each time the ED_EXP module is entered, unless it
is already given once in ED_EXP and does not use LIST_RESULT or OPTIMIZE_
VARIABLES in PARROT in between.

Syntax

READ_WORKSPACES
Block number /#/: <n>

Prompt The number of a data block that should be edited must be given. If there is no FLUSH_BUFFER
command in the original POP file, then there is only one data block with the number 1.
READ_WORKSPACE = READ
This command is equivalent to READ_WORKSPACES in the POLY module, but it only reads the POLY
workspace from the work file set by SET_STORE_FILE in the PARROT module.

Thermo-Calc User Guide: Console Mode ǀ 420 of 643

Thermo-Calc Documentation Set

REINITIATE_MODULE
This command is for the ED-EXP module.
The REINITIATE_MODULE command makes sure that the entire ED-EXP module is reinitiated to
the original state.
Syntax REINITIATE_MODULE
All the defined components, defined conditions, changed status, entered symbols, defined
independent axis-variables, calculated starting equilibrium-points, added initial equilibrium points,
stepped/mapped equilibrium data, and so forth, are removed completely. The saved file name is
restored to the default.
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RESTORE_ALL_WEIGHTS
This command is for the ED-EXP module.
Restore a specific weight-set (previously saved by STORE_ALL_WEIGHTS) and assign all the
different experimental points in the current data block with the previously-set weights in the
sequential assessments.
Syntax

RESTORE_ALL_WEIGHTS
Set number (0 for list) /0/: <weight-set number>

Prompt

The default value 0 is for a list on screen.
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SAVE_WORKSPACES
This command is for the ED-EXP module.
In the PARROT workspace this command saves the current status of the ED_EXP submodule
before you switch back to the PARROT module. This is required when you want to save
equilibria changes, including changes to conditions, experimental data, and/or computed
equilibria results, as well as any newly added equilibria.
With this command all the changes made in the ED_EXP submodule are saved in the
PARROT workspace. This means you do not need to execute SAVE_PARROT_WORKSPACES in
the PARROT module.
However, when in the PARROT module, additional changes can only be saved with the SAVE_
PARROT_WORKSPACES command even if they have been made prior to executing SAVE_
WORKSPACES in ED_EXP.
When you exit the ED_EXP (or Thermo-Calc), the next time the file is opened it is in the
same state as when you executed the SAVE_WORKSPACES command. However, if you use
OPTIMIZE_VARIABLES the computed results are automatically updated.
Syntax

SAVE_WORKSPACES
<File name>

Prompt

Sometimes good starting values (SET_START_VALUE) are required to successfully get
or compute an equilibrium correctly. In this case, it is important to save the
computed equilibrium in the PARROT workspace. It is important to remember that
the computed results can be ruined by improper optimizations. For this reason, it is
suggested you save the .PAR file with a different name to back up the PARROT
workspace.
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SELECT_EQUILIBRIUM
This command is available with the POLY and ED-EXP modules.
If you create more than one initial equilibrium (during data-assessments using the
PARROT/ED_EXP modules), you can switch between them using this command.
Syntax

SELECT_EQUILIBRIUM
Number /Next/: <Choice on equilibrium>

Prompt

Options: FIRST, LAST, NEXT, PREVIOUS or PRESENT.
Most commands affect only the PRESENT equilibrium. However, the REINITIATE_MODULE and DEFINE_
COMPONENTS commands remove all the stored equilibria.
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SET_ALL_START_VALUES
This command is available for the POLY and ED-EXP modules.
Set start values, e.g. if the calculation fails or if you have a miscibility gap or ordering. If
temperature and pressure are not conditions, you are asked for values of them. Then for
each phase prompt on if it should be stable and on its constitution.
Syntax

SET_ALL_START_VALUES
T /XXXX/: <Temperature in K>

If the temperature is not a condition, supply a guess of its final value (in K).
P /100000/: <Pressure in Pa>

If the pressure is not a condition supply a guess of its final value (in Pa).
Automatic start values for phase constitutions? /N/: <Y, N or F>
l

l

Prompts
l

For N, enter an initial amount of each entered phase and the major constituents or site
fraction of each constituent.
For Y, the program automatically sets the start values for phase constitutions in all possible
phases.
F is for force. In some cases the calculation fails because impossible conditions are set, e.g. W
(C)=1.5 [W(C) is mass fraction and must thus be less than unity. The program tries to fulfill

this condition by putting maximum amount of carbon in all phases, but can fail anyway.
When you detect the error and set W(C) to 0.015, the calculation may still fail because it
could start from the previous values. To get back to ‘fresh’ start values, choose F.
Should <phase> be stable /N/: <Y/1 or N/2>

A guess if this phase should be stable or not is requested. All entered phases are prompted for
this question and next two.

You cannot have more phases stable than you have components, but at least one
(which dissolves all constituents) must be set as stable. For backward compatibility,
this question can be answered by 1 (for Yes) or 0 (for No).

The phase name may have a hash sign # followed by a digit, e.g. BCC_A2#2. For phases with
miscibility gaps, there should be two phases with the same name but with different numbers after
the hash sign.
Major constituent(s): <Name of major constituent(s) in the phase>

The constituent with the largest fraction in the phase should be specified. If there are more than
one constituent with a large fraction, give them all on the same line. If the default major
constituents should be used answer with an asterisk (*). By giving $ the constitution is not
changed. If there should be no major constituent give NONE and or if the major constituent(s) are
improperly specified, you are asked for individual fractions in the phase.
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Syntax

SET_ALL_START_VALUES
Y(<phase>,<constituent>) /.XXXXXXXXXX/: <.YYYYY>

The current value (.XXXXXXXXXX) is default. You can accept the default by pressing <Enter> or give
a new value (.YYYYY).
The phase name or constituent name may have a hash sign # followed by a digit, e.g. Y(BCC_
A2#2,FE), Y(BCC_A2#2,C#2). For phases with miscibility gaps, there should be two phases with the
same name but with different numbers after the hash sign. For phases with sublattices, the
constituents in sublattice 2 or higher is also be suffixed with a hash sign # followed by a digit.
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SET_ALTERNATE_CONDITION
This command is for the ED-EXP module.

A special command used in the experimental data *.POP file but also possible in
the ED_EXP module. It is used only when you have specified that the alternate
mode is set in the PARROT module.

In the DICTRA module, you work with a .DOP file instead of a .POP file.
The command syntax is almost the same as for the POLY command SET_CONDITION while the
uncertainty should also be specified.
The alternate condition (including the normally POLY module condition plus
uncertainly; see below) must be given explicitly, but can be given on the same
line or on separate lines with each one started with the command.
Syntax

SET_ALTERNATE_CONDITION
State variable expression: <State variable name or linear expression>

Prompt

Give either a state variable or a linear expression of state variables.

Options Description and Information
Some of the state variables that can be used in conditions are:

State
variables

l

T: temperature in the system (in K)

l

P: pressure in the system (in Pascal)

l

N: system size (mole number in moles)

l

B: system size (mass in grams)

l

N(<component>): mole number of a component in the system

l

X(<component>): mole fraction of a component in the system

l

W(<component>): weight fraction of a component in the system

l

l

l

For the SET_CONDITION command this is ACR(<component>): activity of a component in the
system. For the SET-ALTERNATIVE_CONDITION command, this is ACR(<phase>,<component>)
(activity of a component in a phase)
For the SET_CONDITION command this is MUR(<component>): chemical potential of a
component in the system. For the SET-ALTERNATIVE_CONDITION command, this is MUR
(<phase>,<component>) (chemical potential of a component in a phase)
X(<phase>,<component>): mole fraction of a component in a phase
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Syntax

SET_ALTERNATE_CONDITION
l

W(<phase>,<component>): weight fraction of a component in a phase

l

ACR(<species>,<phase>): activity of a species referred to a phase

l

MUR(<species>,<phase>): chemical potential of a species referred to a phase

l

H: enthalpy in the system (in J)

l

HM(<phase>): enthalpy of a phase (in J/mol)

Factor: <A factor for the state variable, or a continuation>

This question means that the previous question was not answered. The program is then
expecting a single state variable or a complete state variable expression, or the numeric factor
Additional in an expression with only one state variable. In a state variable expression a state variable may
be preceded by a constant factor. An example of this is:
prompts
2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical potential of FE plus three
times the chemical potential of O should be -35000 J/mol.
State variable: <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either the prompt
State variable expression or Factor, or a state variable expression is given but the expression
is incomplete, for example, T- or 2*MUR(FE)+, for which the program is then expecting a
continuation of the unfinished expression. You need to specify a state variable or a complete
state variable expression, or complete the unfinished state variable expression. If a numeric
factor is given before this prompt, only one state variable can be specified; otherwise, the
program only takes the first state variable to complete the expression (i.e. the factor times the
state variable).
Value /X/:

<A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is
given as the default value. The special value NONE means that the condition is removed.
Uncertainty /None/:

<Uncertainty of the condition>

The uncertainty of the condition. This can be a numeric value, a constant or a variable. The
default value NONE means that the uncertainty for the value specified above is zero. The
uncertainty can either be expressed as an absolute value or relative to the value of the condition
in percent (x%).
There are more state variables that can be used in conditions. For more information, type an
INFO STATE_VARIABLES command in the POLY module. A condition is normally a value of a
single state variable with its value.
Notes

Example
T=1273.15

P=1E5

X(C)=.002
W(CR)=1.5
ACR(CR)=0.85
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Syntax

SET_ALTERNATE_CONDITION
X(FCC,C)=.001
H=-250000
HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than one state variable.

Example
X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S should be the same in the LIQUID and
PYRRHOTITE phases. In practice that should be the congruent melting point.
After the equal sign only a numeric value is allowed.
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SET_CONDITION
This command is available with the POLY and ED-EXP modules.
Specify the equilibrium conditions for the calculation. All kinds of state variables, as well as
most of the M/W/V/F-suffixed state variables (for normalization) and R-suffixed state
variables (with respect to chosen reference states), can be used as conditions. In addition to
temperature and pressure conditions, a multicomponent system can have mixed types of
conditions. You should repeat this command for a multicomponent system until the degree
of freedom in the defined system becomes zero. When a FIXED phase status is used on a
specific phase (use CHANGE_STATUS), it is equivalent to one condition (implying that
particular phase is stable in the defined system).
Syntax

SET_CONDITION

Each condition must be given explicitly, but can be given on the same line (separated by a comma
(,) or an empty space) or on separate lines with each one started with the command.

Example
SET_COND T=1273, P=1E5, W(C)=.0015, X(LIQ,CR)=.22, ACR(N)=.2

or
SET_COND T=1273, P=1E5
SET_COND W(C)=.0015, X(LIQ,CR)=.22 ACR(N)=.2

In this example, the temperature is set to 1273 K, the pressure to 1 bar (1E5 Pascal), the mass
(weight) fraction of C to 0.0015 and the mole fraction of Cr to 0.22 and the activity of N to 0.2.
State variable expression: <State variable name or linear expression> or a linear
expression of state variables.

Some of the state variables that can be used in conditions are:
l

T: temperature in the system (in K)

l

P: pressure in the system (in Pascal)

l

N: system size (mole number in moles)

l

B: system size (mass in grams)

l

N(<component>): mole number of a component in the system

l

X(<component>): mole fraction of a component in the system

l

W(<component>): weight fraction of a component in the system

Prompt

l

l

For the SET_CONDITION command this is ACR(<component>): activity of a component in the
system. For the SET-ALTERNATIVE_CONDITION command, this is ACR(<phase>,<component>)
(activity of a component in a phase)
For the SET_CONDITION command this is MUR(<component>): chemical potential of a
component in the system. For the SET-ALTERNATIVE_CONDITION command, this is MUR
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Syntax

SET_CONDITION

(<phase>,<component>) (chemical potential of a component in a phase)
l

X(<phase>,<component>): mole fraction of a component in a phase

l

W(<phase>,<component>): weight fraction of a component in a phase

l

ACR(<species>,<phase>): activity of a species referred to a phase

l

MUR(<species>,<phase>): chemical potential of a species referred to a phase

l

H: enthalpy in the system (in J)

l

HM(<phase>): enthalpy of a phase (in J/mol)

There are many state variables that can be used in conditions. For more information, enter an INFO
STATE_VARIABLES command. A condition is normally a value of a single state variable with its value.

Example
T=1273.15

P=1E5

X(C)=.002
W(CR)=0.5
ACR(CR)=0.85
X(FCC,C)=.001
H=-250000
HM(BCC)=-225000

A condition can also be a value of a linear expression involving more than one state variable. For
example,
X(LIQ,S)-X(PYRR,S)=0

This means that it is a condition that the mole fraction of S component should be the same in the
LIQUID and PYRRHOTITE phases. In practice, that should be the congruent melting point.
After the equal sign only a numeric value is allowed in the expression.
Factor: <A factor for the state variable, or a continuation>

This question means you did not answer the previous question. The program is then expecting a
single state variable or a complete state variable expression, or the numeric factor in an expression
with only one state variable. In a state variable expression a state variable may be preceded by a
constant factor. An example of this is:
2*MUR(FE)+3*MUR(O)=-35000

This means that it should be a condition that two times the chemical potential of FE plus three
times the chemical potential of O should be -35000 J/mol.
State variable: <A specified state variable, or a continuation>

This question is prompted if a single state variable name has not given in either the prompt State
variable expression or Factor, or a state variable expression is given but the expression is
incomplete, for example, T- or 2*MUR(FE)+, for which the program is then expecting a continuation
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Syntax

SET_CONDITION

of the unfinished expression. You need to specify a state variable or a complete state variable
expression, or complete the unfinished state variable expression. If a numeric factor is given
before this prompt, only one state variable can be specified; otherwise, the program only takes the
first state variable to complete the expression (i.e. the factor times the state variable).
Value /X/: <A numeric value, a constant or a variable>

The value of the condition. This can be a numeric value, a constant or a variable. A suggestion is
given as the default value. The special value NONE means that the condition is removed; for
example T=NONE takes away the temperature condition.
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SET_NUMERICAL_LIMITS
This command is available for the POLY, Scheil and ED-EXP modules.
Change the criteria for convergence. This is to speed up a calculation in a complex system.
If there is any convergence problem in finding a stable solution at any stage during a
calculation procedure enforced by COMPUTE_EQUILIBRIUM, STEP_WITH_OPTIONS, MAP or
ADVANCED_OPTION S), this message displays:
Convergence problems, increasing smallest site-fraction from
1.00E-30 to hardware precision 2.00E-14. You can restore using
SET-NUMERICAL-LIMITS

This implies that smallest site fraction in the current POLY workspace is automatically
increased from the default value 1.00E-30 to the hardware-dependent precision (under
Linux, as 2.00E-14). For other subsequent POLY module calculations, you can use this
command to restore or reset the smallest site fraction to the previous or another preferred
value, as well as to reset other numerical limits.
Syntax

SET_NUMERICAL_LIMITS
Maximum number of iterations /500/:

Prompt By default, the program tries 500 iterations before it gives up. As some models give computation
times of more than 1 CPU second/iteration, this number is also used to check the CPU time and
the calculation stops if 500 CPU seconds/iterations are used.
Required accuracy /1E-6/:

This is a relative accuracy, and the program requires that the relative difference in each variable
must be lower than this value before it has converged. A larger value normally means fewer
iterations but less accurate solutions. The value should be at least one order of magnitude larger
than the machine precision.
Smallest fraction /1E-12/:

This is the value assigned to constituents that are unstable. It is normally only in the gas phase you
can find such low fractions.
The default value for the smallest site-fractions is 1E-12 for all phases, except for IDEAL phase with
one sublattice site (such as the GAS mixture phase in many databases) for which the default value
is always as 1E-30 (unless you have used the SET_NUMERICAL_LIMITS command to reset an evenlower value (e.g. 1E-45, that is naturally enforced to all the phases in the system).
Approximate driving force calculation for metastable phases /Y/:

Normally the POLY module only requires that the set of stable phases is in equilibrium in order to
terminate the iterations. By default, the metastable phases are included in all iterations but these
may not have reached their most favourable composition and thus their driving forces may be only
approximate.
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Syntax

SET_NUMERICAL_LIMITS

If it is important that these driving forces are correct, choose N to force the
calculation to converge for the metastable phases. This may require more iterations,
and the STEP and MAP command may also terminate due to bad convergence in a
metastable phase.
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SET_REFERENCE_STATE
This command is available for the POLY, ED-EXP and POST modules.
The reference state for a component is important when calculating activities, chemical
potentials and enthalpies and is determined by the database being used. For each
component the data must be referred to a selected phase, temperature and pressure, i.e.
the reference state.

All data in all phases where this component dissolves must use the same
reference state. However, different databases can use different reference
states for the same element/component. It is important to be careful when
combining data obtained from different databases.

By default, activities, chemical potentials and so forth are computed relative to the
reference state used by the database. If the reference state in the database is not suitable
for your purposes, use this command to set the reference state for a component using SER,
i.e. the Stable Element Reference (which is usually set as default for a major component in
alloys dominated by the component). In such cases, the temperature and pressure for the
reference state is not needed.
In order to specify conditions in the specific reference state, you can append an R to the
state variables. Thus, AC is the activity (of a system component or of a species in a phase)
with respect to the default reference state, and ACR is the activity with respect to the
selected reference state; MU is the chemical potential of a system component with respect
to the default reference state, and MUR stands for the chemical potential with respect to the
selected reference state. The AC and ACR variables, for both components in a system and
species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC
(O2,GAS), LNACR(O2,GAS).
For the POST module, and after calculating with the STEP_WITH_OPTIONS or MAP commands,
the reference state for a component can also be changed to plot various properties of the
component in the entire system or in a specific phase. Then you can set the diagram axes as
the chemical potential or activity quantities with the R suffix, i.e. MUR(comp), MUR
(comp,ph), ACR(comp), ACR(comp,ph) or the common logarithms [e.g. LNACR(comp,ph)].
Syntax

SET_REFERENCE_STATE
Component: <Name of the component>

Prompts

The name of the component must be given.
Reference phase: <Name of a phase used as the new reference state>
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Syntax

SET_REFERENCE_STATE

Enter the Name of a phase for the system.
For a phase to be usable as a reference for a component, the component needs to
have the same composition as an end member of the phase. The reference state is
an end member of a phase. The selection of the end member associated with the
reference state is only performed once this command is executed.
If a component has the same composition as several end members of the chosen reference
phase, then the end member that is selected at the specified temperature and pressure will have
the lowest Gibbs energy.
The following are example using temperature. Pressure is used in the same way:
l

l

l

In the Fe-C system, BCC can be a reference state for Fe but not for C since BCC can exist as
pure Fe but cannot exist as pure C.
If GAS is chosen as the reference phase of component O at such a high temperature that O1
has the lowest energy, then O1 remains the reference state even at calculations performed at
lower temperatures where O2 has a lower energy than O1.
Setting the reference state for component O as gas (one sublattice) with constituents O1, O2
and O3 results in O2 being the reference state if, at the present temperature, pure O2 has the
lowest energy of O1, O2 and O3. If the reference state is set above a critical higher
temperature, then O1 has the lowest energy and consequently becomes the reference state.

Temperature /*/: <Temperature for the reference state>

Select the Temperature (in K) for the reference state. The wildcard value * means the current
temperature is used at the time of evaluation of the reference energy for the calculation.
The temperature set with this command does not affect the temperature used
when evaluating the energy of the reference state during the end member
selection process.
Pressure /1E5/: <Pressure for the reference state>

Select the Pressure (in Pa) for the reference state. The wildcard value * means the current
pressure is used for evaluating the reference energy at the time of calculation.

Examples
S-R-S Fe SER
S-R-S Cr FCC * 100000
S-R-S H2O AQUEOUS * 100000
S-R-S ZE REF_ELECTRODE * 100000
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SET_START_CONSTITUTION
This command is available with the POLY and ED-EXP modules.
This command is similar to SET_ALL_START_VALUES, but is used for an individual phase that
may have a wrong constitution.
Syntax

SET_START_CONSTITUTION
Phase name: <Name of a phase, and possible major constituent(s)>

Specify the name of a phase for which the constitution shall be set.
Prompts

If there is a major constituent of the phase, you must specify this on the same line
as the phase name. By giving an*, select the default major constituents. A $ means
keeping the same constitution, and NONE means to give individual site-fractions.
Y(<Phase>#<Composition_set>,<Constituent>#<Sublattice>) /xxx/: <SF>

The site fraction (SF) of the constituent shall be given. The default value xxx is the
last calculated one.
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SET_START_VALUE
This command is available with the POLY and ED-EXP modules.

This command is not often required as the automatic start values can be
handled for most problems.

Set a start value of an individual variable.
Syntax

SET_START_VALUE
State variable: <Name of a state variable>

Prompts

The state variable must be given.
Value

Specify the value to be assigned the state variable as start value.
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SET_WEIGHT
This command is for the ED-EXP module.
Each experimental value has an uncertainty associated with it, specified by the value after
the colon (:) with the command EXPERIMENT. During an optimization the absolute difference
between the experimental and calculated values gives a contribution to the sum of error.
With the SET_WEIGHT command, you can change the scale of such a contribution (the
uncertainty) for a single experimental point, or the contributions (all uncertainties) for a set
of equilibria. The default weight is always unity. A value smaller than one means that the
experiments should have less weight. A value larger than one that these should have higher
weight. The special value zero means that the set of equilibria should be ignored in editing
in ED_EXP (as is given) and in OPTIMIZE_VARIABLES in PARROT.
The weight may be needed to obtain a balance between different kinds of
experiments. For example, if there are only five experimental values of the
composition of a phase diagram but 500 experimental values of activities or
enthalpies, then the five composition points may have to be given higher weight
than unity, otherwise these are not well described by the optimizing procedure.
Syntax

SET_WEIGHT
Value /1/: <Weight value>

Specify a weight of the experiments in the specified equilibria (asked in the next prompt). The
contribution to the sum of errors of these experiments are multiplied by this weight.
Prompts
The weight is squared, thus use 0.7 to make the error half (0.49) as big, and 1.4 to
make it twice (1.96) as large.
Equilibria (range) or label(s) /Present/:<Selection>

Define the equilibria. These are available in the read data block from the current work file and are
given the above-defined weight.
The selection may be given as a range but the equilibrium numbers must then be separated only
by a minus sign.
The start and end equilibrium numbers must be available in the read data block
read from the current work file.
For example, 5-101, means that all equilibria starting from the identifier 5 until the identifier 101.
Some of numbers between these two identifiers may not exist in the data block.
The selection may also be given as one or more labels (which should be separated only by a

Thermo-Calc User Guide: Console Mode ǀ 439 of 643

Thermo-Calc Documentation Set

Syntax

SET_WEIGHT

space). All equilibria with the specified label(s) in the read data block are given the above-defined
weight.
By pressing <Enter> to accept the default value present, the above defined weight is only assigned
to the current or present experimental point (which is selected by the POLY SELECT_EQUILIBRIUM
command).
If is used but no specific equilibrium point is selected afterwards, the last point in
the read data block remains the present point.
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SHOW_VALUE
This command is available for the POLY and ED-EXP modules.
Show the current value of any state variable, function or variable.
Syntax

SHOW_VALUE
State variable or symbol: <Name(s) of state variable(s) or symbol(s)>

Prompt

A single or several state variables or symbols (entered functions or variables) can be specified.
The wildcard * can be used to denote all phases or all components.
You can use the dollar-sign $ to denote all stable phases. Thus, the command SHOW W(*,*)lists the
mass fraction of all phases, whereas SHOW W($,*)lists the mass fraction of all stable phases.
If you SHOW a function, all functions are evaluated using the current values of the
state variables. But if you SHOW a variable, it retains its value from the time it was
ENTERED or last EVALUATED.
Therefore to save a value from one calculation to another, ENTER it to a variable. This is frequently
done in the PARROT module to transfer values between equilibria.
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STORE_ALL_WEIGHTS
Store a new weight-set that is the current situation of specified weights for all the different
experimental points read from the currently-selected experimental data block in an
assessment. This is useful when you want to try various weight-settings for some
experimental points or for all the points, and then compare the assessment results from
different weight-sets. Such a saved weight-set can be recalled and restored for all
experimental data point with RESTORE_ALL_WEIGHTS sequentially.
Syntax

STORE_ALL_WEIGHTS
Command line: <Weight-set name>

Prompt

Give a weight-set name (comment line texts) for the current weight set for all experimental points.
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TABLE_HEAD, TABLE_VALUES and TABLE_END
These commands are used only in the *.POP file. It represents a convenient way to enter
many experimental measurements of the same type in a table format.
In the DICTRA module, you work with a .DOP file instead of a .POP file.

These commands should always be used together and in a sequence, meaning
that a table should always start with the TABLE-HEAD command, then TABLEVALUES, and finish with TABLE-END. Between TABLE_HEAD and TABLE-VALUES
also add definition lines (e.g. on phase status, reference states, conditions,
experiments, labels, etc.) for the experimental measurements of the current
information type.

TABLE_HEAD

Syntax

TABLE_VALUES
TABLE_END

Prompt
After the TABLE-HEAD command, there must be an equilibrium description similar to a single
experimental equilibrium but with some special notation. Then, there is always a TABLE-VALUES
command, after which the actual data is given in columns. At the end of each table, there must be
a TABLE-END command.
The TABLE-HEAD command must be followed by a numeric value. This is used to generate unique
numeric identifiers for all the equilibria in the table. The numeric identifier is incremented by one
for each experimental (equilibrium) point in the table.

Example
An example of the use of a table for enthalpy measurements in the liquid is given here. Much
more elaborate tables can be used
$ Enthalpies of mixing, Topor and Kleppa, Met Trans 1984 TABLE-HEAD 1
CREATE—NEW @@ 1
CHANGE-STATUS PHASE LIQ=FIX 1
SET-REFERENCE-STATE AU LIQ * 1E5
SET-REFERENCE-STATE CU LIQ * 1E5
SET-CONDITION P=1E5 T=1379 X(LIQ,AU)=@1
LABEL ALH
EXPER HMR=@2:5%
TABLE—VALUES
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TABLE_HEAD

Syntax

TABLE_VALUES
TABLE_END
0.0115 -322
0.0563 -1520
0.8499 -2976
0.9002 -2114
TABLE—END

The equilibrium description between TABLE-HEAD and TABLE-VALUES is similar as for a single
experiment, except for these details:
l

@@ Used to automatically generate a series of identifying numbers instead of creating only one
with the command CREATE_NEW_EQUILIBRIUM. The program automatically generates the
identifying numbers starting after the number given after the TABLE-HEAD command (in this

case it is 1).
l

@1 values in the table are specified by an @ sign followed by a column number. In the above

case, the mole fraction of Au in the liquid is in column 1 (see the line for SET_CONDITION). The
columns may have other information than values, and you can use phase names or any text.
If the text contains spaces or special characters, it must be surrounded by double quotes in
the table, e.g. “ABC DEF&ghi”.
l

l

For the syntax checker all commands describing the equilibrium must be in UPPER case after
the TABLE_HEAD command.
After the TABLE-VALUES command, there should be one line for each experimental
measurement of the same type giving the values or texts that should be copied into the
places of the condition or experiment defined by @1, t, etc. You can have columns that are not
used but there must be exactly the same number of columns of each line, otherwise the
syntax checker gives an error message in the PARROT module.
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TRANSFER_START_VALUES
This command is for the ED-EXP module.
In the ED_EXP module it is time consuming to calculate all equilibria when the optimization
is sensitive to start values of the composition of the phases. Usually in one data block there
are several experimental points with the same kind of equilibrium and each must have its
start value set. When you manage to calculate equilibriums of such experimental points, this
command is useful to transfer the site fractions from a successfully-calculated equilibria to
the present experimental point.
Syntax

TRANSFER_START_VALUES
From equilibrium /Previous/: <Equilibrium number>

Prompt The equilibrium number is the numeric identifier for the equilibrium from which the start values
should be copied to the present experimental point. Previous is the default if you press <Enter>.

Thermo-Calc User Guide: Console Mode ǀ 445 of 643

Thermo-Calc Documentation Set

Tabulation Reaction (TAB) Commands
In this section:
ENTER_FUNCTION

447

ENTER_REACTION

449

LIST_SUBSTANCES

451

SET_ENERGY_UNIT

454

SET_PLOT_FORMAT

455

SWITCH_DATABASE

456

TABULATE

458

TABULATE_DERIVATIVES

459

TABULATE_REACTION

464

TABULATE_SUBSTANCE

467
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ENTER_FUNCTION
This command is available with the GES and TAB modules.
Used to define a new thermodynamic function to be included in the sixth column of tabular
output. The last entered function is listed in the 6th column of all tables, and can be plotted
(if choosing the Plot Column value 6) in all graphs, for all subsequently tabulated substances
or reactions.
Syntax
Prompt

ENTER_FUNCTION
Name: <Name>
Function: <Definition>

A limited number of state variables, G, H, S, T, P, V and H298 can be used in the function definition.
For example, -(G-H)/T can be defined as a function which is identical to S for a substance or ΔS for
a reaction, G+T*S-P*V can be defined as a function which is U (internal energy) for a substance or
ΔU (internal energy change) for a reaction.
Options

Nameof the

function (maximum 8 characters) and Definition of the function. A long function can
be typed over several lines. A function should be terminated by a semicolon (;) or an empty line.

Example
For the pure substance Fe (using the SSUB database), by entering a function as G+T*S-P*V,
the following table is obtained by typing <Enter> in the prompt Output file /Screen/:,
and the figure by typing 6 in the prompt Plot column /2/:
TAB: ENTER-FUNCTION
Name: InEnergy
Function: G+T*S-P*V;
TAB: TABULATE_SUBSTANCE
Substance (phase): Fe
Pressure /100000/: <Enter>
Low temperature limit /298.15/: <Enter>
High temperature limit /2000/: <Enter>
Step in temperature /100/: <Enter>
Output file /try1/: try2
Graphical output? /Y/: <Enter>
Plot column? /2/: 6

This gives the following output:
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O U T P U T

F R O M

T H E R M O - C A L C

Column 6: InEnergy G+T*S-P*V
Phase : FE_S

Pressure :

100000.00

Specie: FE
***************************************************************
T
(K)

Cp
(Joule/K)

H
(Joule)

S

G

(Joule/K)

InEnergy

(Joule)

***************************************************************
298.15

2.48446E+01

2.17972E-06

2.72800E+01

-8.13353E+03

2.17972E-06

300.00

2.48905E+01

4.60049E+01

2.74338E+01

-8.18414E+03

4.60049E+01

400.00

2.71299E+01

2.64957E+03

3.49085E+01

-1.13138E+04

2.64957E+03

500.00

2.93561E+01

5.47211E+03

4.11976E+01

-1.51267E+04

5.47211E+03

600.00

3.19293E+01

8.53245E+03

4.67701E+01

-1.95296E+04

8.53245E+03

700.00

3.50985E+01

1.18777E+04

5.19207E+01

-2.44667E+04

1.18777E+04

800.00

3.92042E+01

1.55830E+04

5.68623E+01

-2.99068E+04

1.55830E+04

900.00

4.49645E+01

1.97726E+04

6.17903E+01

-3.58387E+04

1.97726E+04

1000.00

5.42147E+01

2.46891E+04

6.69619E+01

-4.22728E+04

2.46891E+04

1100.00
4.55851E+01
Stable phase is FE_S2

2.99025E+04

7.19412E+01

-4.92328E+04

2.99025E+04 $

1200.00

3.40840E+01

3.51037E+04

7.64466E+01

-5.66322E+04

3.51037E+04

1300.00
1400.00

3.49398E+01
3.57994E+01

3.85549E+04
4.20918E+04

7.92086E+01
8.18293E+01

-6.44162E+04
-7.24692E+04

3.85549E+04
4.20918E+04

1500.00

3.66636E+01

4.57149E+04

8.43287E+01

-8.07780E+04

4.57149E+04

1600.00
3.75330E+01
Stable phase is FE_S3

4.94247E+04

8.67226E+01

-8.93314E+04

4.94247E+04 $

1700.00

4.05217E+01

5.41173E+04

8.95609E+01

-9.81363E+04

5.41173E+04

1800.00
4.12595E+01
Stable phase is FE_L

5.82055E+04

9.18975E+01

-1.07210E+05

5.82055E+04 $

1900.00
2000.00

7.74165E+04
8.20165E+04

1.02377E+02
1.04736E+02

-1.17099E+05
-1.27456E+05

7.74165E+04
8.20165E+04

4.60000E+01
4.60000E+01
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ENTER_REACTION
This command is for the TABULATE_REACTION (TAB) module.
This is the same as TABULATE_REACTION in that both the chemical reaction can be specified
and the thermodynamic property changes for the reaction can be generated as a table, and
plotted as a graph or saved as an experimental file (with an extension of .EXP). The
thermodynamic data are automatically retrieved from the SSUB database (by default), or
the current database set by SWITCH_DATABASE (thus there is no need to use the TDB module
before this command). You can select any other database by using the SWITCH_DATABASE
command in the TAB module. The rules to specify a reaction are the same as TABULATE_
REACTION .
Syntax

ENTER_REACTION
Same reaction? /Y/:

Prompts This displays if there is at least one reaction already defined either by ENTER_REACTION or
TABULATE_REACTION. For Y the next prompt for defining reaction is not asked.
Reaction: <Chemical reaction equation> & <RA+RB=PC+PD>

A long reaction can be typed over several lines. A reaction should be terminated by a semicolon
(;) or an empty line. A list showing the used database, defined elements, getting-data sequence,
references, etc.:
Pressure /100000/: <Pressure of interest, in pa>
Low temperature limit /298.15/: <T-low, in K>
High temperature limit /2000/: <T-high, in K> Step in temperature /100/: <T-step>

Output file /Screen: <Return for screen, or type a file name>

If you type Return for screen a list of thermodynamic property changes for the defined/chosen
reaction is shown up as a table (which is demonstrated in the example outputs given below), and
the command is terminated.
If typing a file name, the table is displayed and saved as an *.EXP or an *.TAB file. Then prompts:
Graphical output /Y/:

For N a table is output to the screen and this table is saved as a basic text file with the default
extension .TAB under the current working directory. In this case, the graph cannot be plotted.
By default a table is created with all thermodynamic functions as normal (which is displayed on
screen) and generates a graph with temperature on the X-axis and a chosen property on a certain
column in the table on the Y-axis (which is plotted on screen and saved as an *.EXP file). You are
also prompted for the plot column.
Plot column? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus temperature as Xaxis) as a graph on the screen. Simultaneously, all tabulated properties and the Y-axis setting (i.e.
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Syntax

ENTER_REACTION

the plotted column) for the graph is written into an *.EXP file using the DATAPLOT format. The
default column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional
column 6 is a user-entered function. The table displays on the screen. The plot then displays on
the screen, followed by a POST prompt. The POST module (postprocessor) automatically opens,
and all types of the POST-module commands to refine the plotted diagram may be used.
Possibilities include scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or
EXIT at the POST prompt always takes you back to the TAB module.
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LIST_SUBSTANCES
This command is for the TABULATE_REACTION (TAB) module.
List all species in the current database with a certain set of elements. This is useful to specify
species as pure substances in the command TABULATE_SUBSTANCE.
Syntax

LIST_SUBSTANCES
With elements /*/ <* or a set of elements>

The elements building up various species must be specified. The wildcard * means all elements in
Prompts the current database.
If some elements are specified, it also prompts for how to list species with such elements.
Exclusively with those elements /Y/:

All species (not phases) in the current database are searched. Keep the default (Y) if you do not
want other elements included in the search except for those specified. Enter N to list all species
containing at least one of the specified elements.

Example
For the SSOL database, there are different lists, as shown below:
TAB: l-sub
With elements /*/: <Enter>
VA

AG

AL

AM

AS

AU

B

BA

BE BI

CA

CD

CE

CL

CO

CR

CS

CU

DY

ER

EU

F

FE

GA

GD

GE

H

HF

HG

HO

I

IN

IR

K

LA

LI

LU

MG

MN

MO

NA

NB

BR C
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ND

NI

NP

OS

P

PA

PB

PD

PR

PT

PU

RB

RE

RH

RU

S

SB

SC

SE

SI

SM

SN

SR

TA

TB

TC

TE

TH

TI

TL

TM

U

V

W

Y

YB

ZN

ZR

C1

C2

C3

C4

C5

C6

C7

N2

O2

P1

P2

P4

NA/+1

K/+1

CL/-1

H2O

H1/+

LI1/+

CS1/+

RB1/+

O1H1/-

F1/-

BR1/-

I1/-

H1/+1

H1O1/-1

SI1O2 CA1O1 TAB:

TAB: l-sub
With elements /*/: fe cr ni c n o
Exclusively with those elements? /Y/: <Enter>
C

CR

FE

N

NI

O

C

C2

C3

C
C

C5

C6
N2

O2

TAB:l-sub fe cr ni c n o
Exclusively with those elements? /Y/: n
C

CR

FE N

C1

C2

C3

C4

C5

C6

C7

N2

O2

NI O
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H2O

O1H1/-

H1O1/-1 SI1O2 CA1O1 TAB:
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SET_ENERGY_UNIT
Set the energy unit as calories or Joule, in all the subsequent outputs (tables, graphs, and
files) in the current calculation operation.
Syntax

SET_ENERGY_UNIT

Prompt Energy unit (C=Cal, J=Joule) /J/: <Unit>

Thermo-Calc User Guide: Console Mode ǀ 454 of 643

Thermo-Calc Documentation Set

SET_PLOT_FORMAT
This command is for the TABULATE_REACTION (TAB) module.
Set the plotting format while the result is plotted on screen or the file is saved as EXP file
[using DATAPLOT graphical format] and TAB file (as a basic text file and as displayed on
screen).
This command is different from SET_PLOT_FORMAT in the POST module, but is
identical to SET_PLOT_ENVIRONMENT in the SYS (system utility) monitor.
Syntax

SET_PLOT_FORMAT

The default set Unitis 1 (Windows) or 9 (Linux) for graphical presentation on screen, or all other
units for outputs as *.EXP and *.TAB files.
Options Also set the format of the graphical output to different graphical devices. The default unit 22 (1 for
legacy Windows, and 9 for legacy Linux) may be altered with SET_PLOT_ENVIRONMENT in the SYS
monitor or by the TC.INI file.
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SWITCH_DATABASE
This command is for the TABULATE_REACTION (TAB) module.
By default, the TAB module always automatically retrieves thermodynamic data for
substances or reactant/product substances in a defined reaction, or for pure phases or ideal
solution phases, from the SSUB Substances database. However, you can select
thermodynamic data for complex non-ideal solution phases from another database, which is
possible with this command.
Syntax

SWITCH_DATABASE
Database /XYZ/: <new database name>

Specify a New database name. XYZ stands for the default SSUB database or the current database
which is switched on.

Prompt

If an appropriate database name is not given and the USER option is not used, a list displays of
available databases.
Use one of these databases:
l

PURE = SGTE Pure Elements Database

l

SSUB = SGTE Substances Database

l

USER = user defined database

This command switches (or changes) from the current database to a new one, and
reinitializes the entire TAB module for defining a substance or reaction and the GIBBS
workspace for storing retrieved data. All the directly connected databases as predefined by
the original database initiation file tc_initd.tdb are listed by pressing the <Enter> key
without giving any argument. You can also supply your own database by giving the argument
USER and then the database name and, if it is not located in the current working directory,
its correct path.
This command (when required to use another database for subsequent tabulations) must be
used before executing the TAB commands TABULATE_SUBSTANCE for substances, and ENTER_
REACTION or TABULATE_REACTION for reactions.
When a predefined database or an appropriate USER database is switched on, the DATA
command GET_DATA is automatically executed.
DATABASE NAME: The new database is specified by typing the abbreviation given in the
front of one of the available predefined databases. For convenience when
switching/appending databases you can add them to the predefined database list in the
database initiation file tc_initd.tdb of your installed software.
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When this command is used in a macro (*.TCM) file, if the USER option is selected, the
database setup file name (*setup.TDB) containing the setup definitions of the user database,
and its correct path, must be provided.
If a USER database name or its path is not given on the same line of the SWITCH_DATABASE
command, or if it is incomplete or incorrect, an Open window displays to specify the
filename of the database setup file name (*setup.TDB) of the to-be-switched USER database.
Unlike in the TDB module, if a user database is chosen, the Gibbs energy system
is also reinitialized and only data from the user databases are retrieved for
tabulations.
After this command, those commands to define systems (in terms of either elements or
species), to reject/restore phases or species, retrieve data, as well as to append data from
additional database(s), can be done.
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TABULATE
This command is for the TABULATE_REACTION (TAB) module.
Gives the values of an already-defined table (with various properties varied with the
stepping axis variable) from equilibria calculated with a STEP command. You can tabulate a
table even if the table is entered after the step calculation.
Syntax

TABULATE
Name: <Name of a defined table>

Prompts

The name of the table must be given. The table must be entered.
Output to Screen or file /Screen/: <File name>

The table can be listed on the screen (by pressing <Enter>), on a file (the file name
must be specified here).
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TABULATE_DERIVATIVES
This command is for the TABULATE_REACTION (TAB) module.

This command is mainly for system debugging purposes and for experienced
users. It automatically calculates all partial derivatives for a pure phase or
solution phase at a given composition.

This is not the same as the chemical potential.
Before using this command, the system must be defined and thermodynamic data retrieved
from an appropriate solution database in the TDB module. The phase name can be given in
either upper, lower or mixed cases, and can be abbreviated until it is unique, e.g. fcc, BCC,
cem, Liq, etc. as the SSOL database is used for the tabulations, or GAS, FE-S, wustite, Fe2O3hem, etc. as the SSUB database is used. The module then optionally goes through a specific
sublattice or all the possible sublattices for the specified phase, as well as through the whole
framework of a currently defined system (including all the defined elements/species, as well
as the default defined vacancy and electron if necessary for the current database), when it
prompts for inputs of site fractions for various species possibly occupying such sublattices.
Therefore, thermodynamic properties can be tabulated for a pure phase, or for a solution
phase as a pure end-member (with a composition definition for the corresponding noninteracting species on all necessary sublattices in the end-member), or for a solution phase
as a real solution (with a composition definition for related interacting species on all
necessary sublattices in the solution).
Syntax

TABULATE_DERIVATIVES
Phase name /XXXX/: <Name of the phase>

Specify the phase name of a pure phase or a solution phase.
XXXX is the

last phase the TAB module accounted for. It automatically prompts for other options
and necessary inputs for the definition of the composition of the specified phase.
Prompts For a pure phase (such as Fe-S, Wustite, and Fe2O3-Hematite), no further composition definition is
needed. For a solution phase with one sublattice (such as AQUEOUS solution, GAS mixture and SLAG
solution), it requests n-1 site-fraction inputs for the phase constituents (if there are n species in
the defined phase within the whole framework of currently defined system, including all the
defined elements/species, as well as the default defined vacancy and electron if necessary for the
current database); the nth species is automatically assigned as the rest.
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The sum of input site fractions must not exceed unity.

Example Prompts
For example, these prompts and inputs can be seen for a LIQUID solution phase (from the SSOL
database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the unprompted Ni species
are assigned as the rest):
FRACTION OF CONSTITUENT (RETURN FOR PROMPT): <RETURN> C /1/: .05
CR /1/: .1
FE /1/: < RETURN>
SUM OF FRACTIONS EXCEED UNITY, PLEASE REENTER
FE /1/: .8
N /1/: .005

For a solution phase with two or more sublattices (such as FCC alloy solution, and ION_LIQ ionic
liquid solution), it first asks for which sublattice the site-fractions of constituents shall be specified:
the default value 0 for all possible sublattices, and a given positive number for a specific sublattice
(of course, this number must be reasonable for the currently specified phase, i.e. it must be
smaller than the total sublattice number of the phase). Then, for the given sublattice or for all
sublattices, it prompts for all the necessary inputs of site-fractions for the possible constituents on
each sublattice n-1 times if there are n species on such a sublattice in the defined phase; the nth
species on each of the sublattices is automatically assigned as the rest. For example, the following
prompts and inputs can be seen for an FCC solution phase (from the SSOL database) within the FeCr-Ni-C-N-O framework (Note that by default, the unprompted O species on its sublattice 1 and
VA on its sublattice 2 are assigned as the rest):
SPECIFY SUBLATTICE (0 FOR ALL) /0/: <RETURN>
FRACTIONS IN SUBLATTICE 1
CR /1/: .1
FE /1/: .8
NI /1/: .0995
FRACTIONS IN SUBLATTICE 2
C /1/: .05
N /1/: .05

Temperature /2000/: <Temperature of interest, in K>

Specify the temperature of interest in K.
Pressure /100000/: <Pressure of interest, in pa>

Specify the pressure of interest in Pa.

Example Output
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For the FCC phase in the Fe-Cr-Ni-C-N-O system (using the SSOL database), the following
table is obtained at a specified composition:
TAB: TAB_DER
Phase name /BCC/: FCC
SPECIFY SUBLATTICE (0 FOR ALL) /0/: <Enter>
FRACTIONS IN SUBLATTICE 1
CR /1/: .1
FE /1/: .8
NI /1/: .3
SUM OF FRACTIONS EXCEED UNITY, PLEASE REENTER
NI /0/: .0995
FRACTIONS IN SUBLATTICE 2
C /1/: .05
N /1/: .05
Temperature /1800/: <Enter>
Pressure /100000/: <Enter>
Gibbs energy: ..................... -1.27432533E+05
Helmholz energy: .................. -1.27433205E+05
Enthalpy: .........................

5.95773994E+04

Internal energy: ..................

5.95767279E+04

Entropy: ..........................

1.03894407E+02

Molar volume: .....................

6.71473258E-06

Thermal expansivity: ..............

7.63886416E-05

Isothermal compressibility: .......

6.02925387E-12

Heat capacity at constant pressure:

4.33555074E+01

First partial derivative with respect to CR in sublattice 1
of Gibbs energy:
................ -1.26034739E+05
of enthalpy: ....................
4.63000206E+04
of entropy: ..................... 9.57415334E+01
of volume:
...................... 6.87203263E-06
Second partial derivative of Gibbs energy with respect to also
CR

in

1:

FE

in

1: -1.53353158E+04

NI

in

1: -1.71750366E+04

O

in

1:

C

in

2: -1.82016870E+05

in

2: -9.36260878E+04

in

1.54392858E+05

0.00000000E+00

2: -3.73062665E+05

VA
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irst partial derivative with respect to FE in sublattice
................ -1.02869265E+05
of enthalpy: ....................
..................... 9.11350866E+01
7.53441165E-06

1

of Gibbs energy:

6.11738912E+04
of entropy:
of volume: ......................

Second partial derivative of Gibbs energy with respect to also
FE

in

1:

NI

in

1: -3.07043434E+03

in

2: -1.36027071E+05

in

2: -1.11741180E+05

in

1:

0.00000000E+00

C
in

1.82508696E+04

2: -2.13007485E+05

VA

First partial derivative with respect to NI in sublattice 1
of Gibbs energy:
................ -1.32427029E+05
of enthalpy: ....................
5.21563580E+04
of entropy: ..................... 1.02546326E+02
of volume:
...................... 0.00000000E+00
Second partial derivative of Gibbs energy with respect to also
NI
in

1:

1:

1.48390257E+05

in

2: -7.70620431E+04

0.00000000E+00

C
in

in

2: -1.61551726E+05

VA

in

2: -1.12772206E+05

First partial derivative with respect to O in sublattice 1
of Gibbs energy:
................ -2.62929308E+05
of enthalpy: ....................
5.02555370E+04
of entropy: ..................... 1.73991581E+02
of volume:
...................... 0.00000000E+00
Second partial derivative of Gibbs energy with respect to also
in

1:

2.99322360E+07

C

in

2:

0.00000000E+00

N

in

2:

0.00000000E+00

VA

in

2: -1.82377137E+05

First partial derivative with respect to C in sublattice 2
of Gibbs energy:
................ -1.59508417E+05
of enthalpy: ....................
1.21269096E+05
of entropy: ..................... 1.55987507E+02
of volume:
...................... 1.06885187E-05
Second partial derivative of Gibbs energy with respect to also
C

in

2:

2.99322360E+05

N

in

2: -1.90144000E+04

VA

in

2: -2.78465070E+04
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First partial derivative with respect to N in sublattice 2
of Gibbs energy:
................ -2.39671400E+05
of enthalpy: ....................
4.04456947E+04
of entropy: ..................... 1.55620608E+02
of volume:
...................... 0.00000000E+00
Second partial derivative of Gibbs energy with respect to also
N

in

2:

2.99322360E+05

VA

in

2: -3.30383665E+04

First partial derivative with respect to VA in sublattice 2
of Gibbs energy:
................ -9.52042686E+04
of enthalpy: ....................
5.37142294E+04
of entropy: ..................... 8.27324989E+01
of volume:
...................... 6.86700739E-06
Second partial derivative of Gibbs energy with respect to also
VA

in

2:

1.66290200E+04
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TABULATE_REACTION
This command is for the TABULATE_REACTION (TAB) module.
Tabulate thermodynamic property changes for a chemical reaction as a table, or variation
of one chosen property can be plotted against temperature as a graph, or saved as an
experimental file (with an extension of .EXP). The thermodynamic data are automatically
retrieved from the SSUB5 database (by default), or the current database set by the SWITCH_
DATABASE command (thus there is no need to use the DATA module before this command).
You can select any other database by using SWITCH_DATABASE.
It is important to remember the rules to specify a reaction:
l

l

l

l

l

Syntax

The reaction is specified, by giving the reactants and products, such as Ga+S=GaS,
5Al+2Fe=Al5Fe2.
Under Linux environments, the notation for a chemical formula treats upper and
lower cases as the same (such as ga+s=GaS, 5Al+2Fe=al5fe2); but under Windows,
the TAB module only accepts upper cases, e.g. GA+S=GAS, 5AL+2FE=AL5FE2.
Elements with a single letter symbol must be followed by a stoichiometry factor,
even if it is 1; thus, the symbol CO is taken as cobalt, carbon monoxide must be given
as C1O1 (or O1C1).
All the reactants and products must be defined as species-stoichiometries in the
currently-used database; in other words, the reaction definition only accepts alreadydefined species-stoichiometries as reactants and products. For example, if a
database does not have a species defined with a stoichiometry of Al5Fe2 {e.g. the Al
and Fe (but not Al5Fe2) may be defined as species, and the Al5Fe2 phase may be
defined as a two-sublattice stoichiometric phase [Al]5[Fe]2, rather than a single
sublattice stoichiometric phase [Al5Fe2]}, then the reaction 5Al+2Fe=Al5Fe2 cannot
be tabulated.
Make sure that the Gibbs free energy expression for a stoichiometric phase is really
corresponding to the species-stoichiometry. For example, if a database has a
definition of Function GAL5FE2 for 1/7 of the AL5FE2 formula, then the relation G
(Al5Fe2)=7*GAL5FE2 must be defined; otherwise, the tabulated thermodynamic
properties for the reaction 5Al+2Fe=Al5Fe2 is wrong.
TABULATE_REACTION
Same reaction? /Y/:

Prompts This prompt displays if there is at least one reaction already defined either with the commands
ENTER_REACTION or TABULATE_REACTION. The following prompts only display if N is entered.
Reaction: <Chemical reaction equation> & <RA+RB=PC+PD>

Thermo-Calc User Guide: Console Mode ǀ 464 of 643

Thermo-Calc Documentation Set

Syntax

TABULATE_REACTION

A long reaction can be typed over several lines. A reaction should be terminated by a semicolon
(;) or an empty line. A list showing the used database, defined elements, getting-data sequence,
references, etc.
Pressure /100000/: <pressure of interest, in pa>
Low temperature limit /298.15/: <T-low, in K> Specify the starting temperature K.
High temperature limit /298.15/: <T-high, in K> Specify the ending temperature K.
Step in temperature /100/: <T-step> Specify the temperature step for the tabulation.

Output file /Screen/: <Return for screen, or type a file name>

If you type Return for screen, a list of thermodynamic property changes for the defined/chosen
reaction is shown as a table (which is demonstrated in the example outputs given below), and the
command is terminated.
If typing a file name, the table is both displayed on screen and saved as an *.EXP or a *.TAB file,
and the program prompts:
Graphical output /Y/:
l

l

For N a table is output to the screen, and the same table is saved as a basic text file with the
default extension .TAB under the current working directory. In this case, the graph cannot be
plotted.
For Y a table is created with all thermodynamic functions as normal (which is displayed on
screen) and generates a graph with temperature on the X-axis and a chosen property on a
certain column in the table on the Y-axis (which is plotted on screen and saved as an *.EXP
file), and it also asks which column is to be plotted on the resulting graph:

Plot column? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus temperature as Xaxis) as a graph on the screen. Simultaneously, all tabulated properties and the Y-axis setting (i.e.
the plotted column) for the graph is written into an *.EXP file using the DATAPLOT format. The
default column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional
column 6 is a user-entered function. The table displays on the screen. The plot then displays on
the screen, followed by a POST: prompt. The POST module automatically opens, and all types of
the POST module commands to refine the plotted diagram may be used. Possibilities include
scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or EXIT at the POST:
prompt always takes you back to the TAB module.

Example
For the reaction Ga+S=GaS (using the SSUB database), the following table is obtained by
typing <Enter> in the prompt Output file /SCREEN/, and the figure by typing 2 in the prompt
Plot column /2/:
O U T P U T

F R O M

T H E R M O - C A L C

Reaction:

S+GA=GA1S1

stable as S_S
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GA stable as GA_S
GA1S1 stable as GA1S1_S
Delta-Cp
(K)

Delta-H

(Joule/K)

Delta-S
(Joule)

Delta-G

(Joule/K)

(Joule)

***************************************************************
298.15

-2.79489E+00

-2.09200E+05

-1.50580E+01

-2.04710E+05

300.00

-2.87516E+00

-2.09205E+05

-1.50755E+01

-2.04683E+05

302.

---- GA becomes GA_L ,delta-H =

5589.80

367.

---- S becomes S_S2 ,delta-H =

401.00

389.

---- S becomes S_L ,delta-H =

1721.00

400.00

-1.22278E+01

-2.17521E+05

-4.07488E+01

-2.01222E+05

500.00

-1.57686E+01

-2.19323E+05

-4.47280E+01

-1.96959E+05

600.00

-1.02518E+01

-2.20583E+05

-4.70410E+01

-1.92359E+05

700.00

-6.58954E+00

-2.21430E+05

-4.83534E+01

-1.87583E+05

800.00

-4.46246E+00

-2.21963E+05

-4.90686E+01

-1.82709E+05

900.00

-2.82671E+00

-2.22328E+05

-4.94995E+01

-1.77778E+05

1000.00

-1.21787E+00

-2.22530E+05

-4.97138E+01

-1.72816E+05

1100.00

3.71702E-01

-2.22572E+05

-4.97552E+01

-1.67841E+05
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TABULATE_SUBSTANCE
This command is for the TABULATE_REACTION (TAB) module.
Tabulate thermodynamic properties of a substance (with a given chemical formula but it is
not certain in which phase/state it may form) or a pure stoichiometric phase (getting data
from a specific substance database such as SSUB, or from a specific solution database such
as SSOL and TCFE), or of a solution phase with a fixed composition (getting data from a
specific solution database such as SSOL and TCFE), under a constant pressure and various
temperatures.
In case of a pure stoichiometric phase or a solution phase with a fixed composition, you must
already define the system and get thermodynamic data from an appropriate solution
database in the TDB module before using this TAB command. The phase name can be given
either upper or lower or mixed cases, and can be abbreviated until it is unique, e.g. fcc,
BCC, Liq, cem, Al5Fe2, etc. as the SSOL database is used for the tabulations, or GAS, FE-S,
wustite, Fe2O3-hem, etc. as the SSUB database is used. The module then optionally goes
through a specific sublattice or all the possible sublattices for the specified phase, as well as
through the whole framework of a currently defined system (including all the defined
elements/species, as well as the default defined vacancy and electron if necessary for the
current database), when it prompts for inputs of site fractions for various species possibly
occupying such sublattices. Therefore, you can tabulate thermodynamic properties for a
pure phase, or for a solution phase as a pure end-member (with a composition definition for
the corresponding non-interacting species on all necessary sublattices in the end-member),
or for a solution phase as a real solution (with a composition definition for related
interacting species on all necessary sublattices in the solution).
Moreover, the variation for one of the tabulated properties for a substance, a pure
stoichiometric phase, or a solution phase with a fixed composition can be plotted against
temperature as a graph or saved as an experimental file (with an extension of .EXP).
Syntax

TABULATE_SUBSTANCE
Substance (phase): <Name of the species or phase>

In case of a substance, give its chemical formula, e.g. Fe, H2, C1H6, FeC1, CaC1O3, MgSiO3, etc.
When the TABULATE_SUBSTANCE <SUBSTANCE> command sequence is used for the first time in the
TAB module, it always uses the SSUB Substances database as the default. If SSUB is not available and
Prompt a specific database has not been switched on yet, it may prompt to specify an appropriate
substance or solution database (e.g. typing SSUB<version number>; SSOL<version number>;
TCFE<version number> etc.). Prior to this command, you can also use SWITCH_DATABASE to set the
current database. If a solution database is set as the current database, only the neutral species that
are valid substance standing by themselves as phases can be tabulated.
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Before other prompts, a list of the used database, defined elements, getting-data
sequence, references, etc. is displayed on screen. From such information, you know
what the TAB module is performing.
In case of a pure stoichiometric phase or a solution phase, give its phase name, e.g. FCC,
CEMENTITE, LIQUID, SLAG, AQUEOUS, GAS, Al5Fe2, Fe-S, Wustite, Fe2O3-Hematite, etc.

REMEMBER: It is important that you have already defined the system and gotten
thermodynamic data from an appropriate solution database in the TDB module
before using this TAB_SUB command. It automatically prompts for other options and
necessary inputs for the definition of the composition of the specified phase.

For a pure stoichiometric phase defined with one single sublattice (such as Fe-S, Wustite, and
Fe2O3-Hematite), no further composition definition is needed.
For a solution phase defined with one sublattice (such as AQUEOUS solution, GAS mixture and
SLAG solution), it requests n-1 site-fraction inputs for the phase constituents (if there are n species
in the defined phase within the whole framework of currently defined system, including all the
defined elements/species, as well as the default defined vacancy and electron if necessary for the
current database); the nth species is automatically assigned as the rest.

The sum of input site fractions must not exceed unity. For example, the following
prompts and inputs can be seen for a LIQUID solution phase (from the SSOL
database) within the Fe-Cr-Ni-C-N-O framework (Note that by default, the
unprompted Ni species is assigned as the rest):

Fraction of constituent (return for prompt): <Return>
C /1/: .05
CR /1/: .1
FE /1/: <RETURN>

Sum of fractions exceed unity, please reenter
FE /1/: .8
N /1/: .005

For a pure stoichiometric phase defined with two or more sublattices (such as Al5Fe2 intermetallic stoichiometric phase) and for a solution phase defined with two or more sublattices (such
as FCC alloy solution, and ION_LIQ ionic liquid solution, Al5Fe4 inter-metallic solution phase), it first
asks for which sublattice the site-fractions of constituents shall be specified: the default value 0 for
all possible sublattices, and a given positive number for a specific sublattice (this number must be
reasonable for the currently specified phase, i.e. it must be smaller than the total sublattice
number of the phase). Then, for the given sublattice or for all sublattices, it prompts for all the
necessary inputs of site-fractions for the possible constituents on each sublattice n-1 times if there
are n species on such a sublattice in the defined phase; the nth species on each of the sublattices
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are automatically assigned as the rest. For example, these prompts and inputs can be seen for an
FCC solution phase (from the SSOL database) within the Fe-Cr-Ni-C-N-O framework (Note that by
default, the unprompted O species on its sublattice 1 and VA on its sublattice 2 is assigned as the
rest):
Specify sublattice (0 for all) /0/:
FRACTIONS IN SUBLATTICE

1

CR /1/: .1
FE /1/: .8
NI /1/: .0995
FRACTIONS IN SUBLATTICE

2

C /1/: .05
N /1/: .05

Pressure /100000/: <Pressure of interest, in pa>

Specify the constant pressure condition in Pa.
Low temperature limit /298.15/: <T-low, in K>

Specify the starting temperature K.
High temperature limit /298.15/: <T-high, in K>

Specify the ending temperature K.
Step in temperature /100/: <T-step> Specify the temperature step for the tabulation.
Output file /Screen/: <Return for screen, or type a file name>

If you type Return for screen a list of basic thermodynamic functions for the chosen substance or
for the specified pure or solution phase with the fixed composition is shown up as a table (which is
demonstrated in the example outputs given below), and the command is terminated.
If typing a file name, the table is both displayed on screen and saved as an *.EXP or a *.TAB file, and
the program further prompts:
Graphical output /Y/:
l

l

For N a table is output to the screen, and the same table is saved as a basic text file with the
default extension .TAB under the current working directory. In this case, the graph cannot be
plotted.
For Y a table is created with all the thermodynamic functions as normal (which is displayed on
screen) as well as generates a graph with temperature on the X-axis and a chosen property on
a certain column in the table on the Y-axis (which is plotted on screen and saved as an *.EXP
file), and it also ask which column is to be plotted on the resulting graph:

Plot column ? /2/: <1 or 2 or 3 or 4 or 5 or 6>

Specify which property (as column number) to be plotted as the Y-axis (versus temperature as Xaxis) as a graph on the screen. Simultaneously, all tabulated properties and the Y-axis setting (i.e.
the plotted column) for the graph is written into an *.EXP file using the DATAPLOT format. The
default column 2 is heat capacity, 3 enthalpy, 4 entropy and 5 Gibbs energy, and the additional
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column 6 is a user-entered function. The table displays on the screen. The plot then displays on the
screen, followed by a POST: prompt. The POST module (postprocessor) automatically opens, and
all types of the POST-module commands to refine the plotted diagram may be used. Possibilities
include scaling the X/Y-axis, changing the X/Y-axis texts, etc. The command BACK or EXIT at the
POST: prompt always takes you back to the TAB module.

Example 1
For the FCC alloy phase as a non-ideal solution with a fixed composition
[Fe0.80,Cr0.10,Ni0.0995,O0.005][C0.05,N0.05,VA0.90]

The following table is obtained by typing Return
/SCREEN/:
O U T P U T

F R O M

for screen

at the prompt Output

file

T H E R M O - C A L C

Phase : FCC

Pressure :

100000.00

Specie: CR1/--2
***************************************************************
T
(K)

Cp
(Joule/K)

H
(Joule)

S

G

(Joule/K)

(Joule)

***************************************************************
298.15

2.70517E+01

6.23824E+03

4.40241E+01

-6.88755E+03

300.00

2.70889E+01

6.28832E+03

4.41916E+01

-6.96915E+03

400.00

2.87304E+01

9.08420E+03

5.22235E+01

-1.18052E+04

500.00

2.99904E+01

1.20222E+04

5.87742E+01

-1.73649E+04

600.00

3.10889E+01

1.50770E+04

6.43408E+01

-2.35275E+04

700.00

3.21116E+01

1.82375E+04

6.92106E+01

-3.02100E+04

800.00

3.30994E+01

2.14982E+04

7.35633E+01

-3.73524E+04

900.00

3.40742E+01

2.48569E+04

7.75182E+01

-4.49094E+04

1000.00

3.50483E+01

2.83130E+04

8.11586E+01

-5.28456E+04

1100.00

3.60268E+01

3.18667E+04

8.45449E+01

-6.11327E+04

1200.00

3.70143E+01

3.55187E+04

8.77219E+01

-6.97476E+04

1300.00

3.80149E+01

3.92700E+04

9.07241E+01

-7.86713E+04

1400.00

3.90311E+01

4.31222E+04

9.35784E+01

-8.78875E+04

1500.00

4.00649E+01

4.70768E+04

9.63064E+01

-9.73827E+04

1600.00

4.11174E+01

5.11358E+04

9.89256E+01

-1.07145E+05

1700.00

4.21896E+01

5.53010E+04

1.01450E+02

-1.17165E+05
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1800.00

4.33555E+01

5.95774E+04

1.03894E+02

-1.27433E+05

1900.00

4.58528E+01

6.40379E+04

1.06306E+02

-1.37943E+05

2000.00

4.75402E+01

6.87138E+04

1.08704E+02

-1.48694E+05

Example 2
For a phase, as either an end-member or real solution, the listed species name
is irrelevant.
For the H2 species as a pure substance (using the SSUB5 database), the following table is
obtained by typing Return for screen at the prompt Output file /SCREEN/, whilst the
figure is generated by typing 5 at the prompt Plot column /2/:
O U T P U T F R O M T H E R M O - C A L C
Phase : GAS

Pressure :

100000.00

Specie: H2
***************************************************************
H
S
G
(K)

(Joule/K)

(Joule)

(Joule/K)

T

Cp

(Joule)

***************************************************************
2.88369E+01
3.17684E-06
1.30680E+02 -3.89622E+04
300.00

2.88473E+01

5.33580E+01

1.30858E+02

-3.92042E+04

400.00

2.91591E+01

2.95686E+03

1.39209E+02

-5.27268E+04

500.00

2.92650E+01

5.87874E+03

1.45729E+02

-6.69856E+04

600.00

2.93441E+01

8.80908E+03

1.51071E+02

-8.18336E+04

700.00

2.94579E+01

1.17488E+04

1.55602E+02

-9.71730E+04

800.00

2.96320E+01

1.47027E+04

1.59547E+02

-1.12935E+05

900.00

2.98786E+01

1.76776E+04

1.63050E+02

-1.29068E+05

1000.00

3.02043E+01

2.06810E+04

1.66214E+02

-1.45533E+05

1100.00

3.05319E+01

2.37171E+04

1.69108E+02

-1.62302E+05

1200.00

3.09281E+01

2.67897E+04

1.71781E+02

-1.79348E+05

1300.00

3.13615E+01

2.99040E+04

1.74274E+02

-1.96652E+05

1400.00

3.18115E+01

3.30625E+04

1.76614E+02

-2.14197E+05

1500.00

3.22641E+01

3.62664E+04

1.78824E+02

-2.31970E+05

1600.00

3.27094E+01

3.95151E+04

1.80921E+02

-2.49958E+05

1700.00

3.31406E+01

4.28078E+04

1.82917E+02

-2.68151E+05

1800.00

3.35526E+01

4.61426E+04

1.84823E+02

-2.86539E+05

298.15
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1900.00

3.39415E+01

4.95175E+04

1.86648E+02

-3.05113E+05

2000.00

3.43045E+01

5.29300E+04

1.88398E+02

-3.23866E+05
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REACTOR (REACTOR_SIMULATOR) Commands
In this section:
CREATE_DIVIDERS

474

CREATE_PIPES

475

CREATE_STAGE_BOXES

476

EXECUTE_POLY3_COMMAND

478

LIST_RECORDS

479

READ_WORKSPACE

480

SAVE_WORKSPACES

481

START_SIMULATION

482
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CREATE_DIVIDERS
This command is for the REACTOR_SIMULATOR (REACTOR) module.
Define the segment boundaries and the ways on how to distribute phases between various
segments and to split the feeds of heat and mass.
Syntax

CREATE_DIVIDERS
Number of dividers /4/: <The number of dividers>

Prompts Specify the number of dividers (boundaries between various segments) in the reactor. It is
normally the segment number plus one: for example, if the stage box number is defined as 4, the
divider number should be defined as 5.
Number of outputs for divider # /3/: <The number of outputs>

Specify the number of outputs for a specific divider #.
Percent of input to output 1 /100/: <Percent of input>

Define the percentage of input to the output 1 in the current divider #.
Percent of input to output ## /100/: <Percent(s) of input(s)>

Define the percentages of inputs to the outputs ## in the current divider #. It is repeated till the
last output is specified.
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CREATE_PIPES
This command is for the REACTOR_SIMULATOR (REACTOR) module.
Define the pipes between various segments and the ways on how the mass and heat
transport between the surroundings (with the record number as 0) and the reactor, among
various segments in the reactor, and along various dividers (segment boundaries in the
reactor).
Syntax

CREATE_PIPES
From record: <A record number>

Specify a record number. If there are four segments in the reactor, these records are available:
Prompts

l

0 surroundings

l

1-4 stage boxes (segments)

l

5-9 dividers (segment boundaries)

Pipe to record: <Another record number>

Specify another record number to which the mass or heat flows from the current record
(specified above). Before this prompt, a message shown on the screen indicates what kind of
mass or heat flow (according to the definitions of stage boxes and dividers, which have already
been created prior to this command) should be specified in the pipe. This is repeated for all inputs
and/or outputs for mass and/or heat in current record.
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CREATE_STAGE_BOXES
This command is for the REACTOR_SIMULATOR (REACTOR) module.
Create several reaction stages as boxes (segments), where the you define the feed in either
mass input and initial temperature or heat input from surroundings, as well as the mass out
and initial temperature in each of the segments.
Syntax

CREATE_STAGE_BOXES
Number of stage boxes /4/: <The number of stage boxes>

Prompts Specify the number of stage boxes in the reactor. Then define the feed of mass and/or energy
(from surroundings to) the rector.
Give feed to system: <Feed>

One feed (of mass or heat) to the reactor must be specified here. Two types of feeds can be used:
l
l

As input amount of heat (enthalpy): H=Value.
As input amount of specific species or element and its initial temperature: N
(SPECIES)=Value, Input temperature (in one line, or the input temperature in the next
prompt).

Input temperature /298.15/: <Input temperature>
Give feed to system: <Feed>

Specify other feeds (mass or energy) to the reactor. Press <Enter> to finish the feed inputs, and
then:
Give for stage box #

Now start to define the type of stage box (segment is specifically numbered as #), and to specify a
guess of initial temperature and an output for each phase in the segment.
Type of box/Equilibrium/: <Type of box>

Only the EQUILIBRIUM type is allowed. Press <Enter> to accept it.
Is the stage heat controlled? /Y/: <Yes or No>

Y means the current segment is heat controlled.
Initial guess of temperature? /1000/: <Initial temperature>

Give a guess of initial temperature (in K) for the current segment; press <Enter> to accept the
default.
Give initial amount: <Initial amount of mass or heat>

The initial amount of mass and/or heat in the current segment can be specified here. Two types of
initial amount can be used:
l

As initial amount of heat (enthalpy): H=Value.
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Syntax

CREATE_STAGE_BOXES
l

As initial amount of specific species or element and its initial temperature: N
(SPECIES)=Value, Input temperature (in one line, or the input temperature in the next
prompt).

Input temperature /298.15/: <Input temperature>
Give initial amount: <Initial amount of mass or heat>

Specify initial amount (mass or energy) in the current segment. Press <Enter> to finish the initial
amount inputs, and then this message displays:
Each phase may have a separate output, give these

Now start to define the output for each phase.
Phase name /Rest/: <Name of phase>

Specify a phase that has a separate output, e.g. GAS; by pressing <Enter> to accept that all REST
phases do not have separate outputs. Then the program asks for further definitions of all the other
segments (one by one), repeating some of the above questions, till the last segment in the reactor
is defined.
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EXECUTE_POLY3_COMMAND
This command is for the REACTOR_SIMULATOR (REACTOR) module.
Syntax EXECUTE_POLY3_COMMAND
To directly use all kinds of POLY commands inside the REACTOR module. Any legal POLY commands
can be entered.
POLY Module Commands
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LIST_RECORDS
This command is for the REACTOR_SIMULATOR (REACTOR) module.
Syntax LIST_RECORDS
Lists all the already-created records for the reactor (including stage boxes, dividers, pipes, etc.).
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READ_WORKSPACE
This command is for the REACTOR_SIMULATOR (REACTOR) module.
The REACTOR workspace (along with the related POLY and GIBBS workspaces) and the
simulated results from the SIMULATE command can be read by this command from a binary
file where they must be saved with SAVE_WORKSPACE. The *.RCT file is not printable.
Syntax

READ_WORKSPACE
File name:

Options

The name of a saved *.RCT file where the REACTOR and POLY/GIBBS workspaces shall
be read from must be specified. You do not need to type the extension if it is the default .RCT,
otherwise type the whole *.RCT file name.
An Open window displays if a file name is not given after the command or its path is incorrect, so
that the path (in the Look in field) and File name can be specified. The Files of type (i.e. RCT)
cannot be changed.
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SAVE_WORKSPACES
This command is for the REACTOR_SIMULATOR (REACTOR) module.
The POLY module and Gibbs (GES) module also have a command with the same
name.
The workspaces are saved to a file with this command. In the REACTOR workspace, all
definitions of multi-stage steady-state rector and its distribution coefficients are saved,
together with the GIBBS and POLY workspaces.
After using this command, you can always return to the state when you issued the command
by giving a READ command.
After saving the workspaces to a file, you can exit the software and at a later time READ the
file and continue from the saved state.

automatically saves on the work file with the most lately
specified name. To avoid destroying the simulated results, do not SAVE after a
START_SIMULATE command is enforced, similar to that you should not use SAVE
after a STEP or MAP command. You may append several results by START_
SIMULATE without destroying the previous results but SAVE erases them all.
START_SIMULATION

Syntax SAVE_WORKSPACES
File name

A file name must be specified. The default extension of the RCT file is .RCT, while or any other
extension as required.
A Save window displays if a file name is not given after the command, so that the path (in the Save
in field) and File name can be specified. The Files of type (i.e. RCT) cannot be changed. If there is
already a file with the same file name under the directory a warming message displays. Click OK to
overwrite the current REACTOR (and POLY3/GIBBS) workspaces onto the existing *.RCT file. Click
Cancel to return to the REACTOR module. You can use the SAVE command with an unspecified
name (i.e. through SAVE ,,, command-sequence) to save the REACTOR (and POLY3/GIBBS)
workspaces.
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START_SIMULATION
This command is for the REACTOR_SIMULATOR (REACTOR) module.
Start the reactor simulation, and list the results for all iterations. The output for each
iteration consists of the conditions set in each segment, and you can also select some state
variables to list. After each loop, the temperatures in all segments are listed.
Syntax

START_SIMULATION
Max number of loops /10/: <The max number of loops>

Prompts

Give the max number of loops. The reactor simulation repeats until this loop number is reached.
Output to screen or file /Screen/: <File name or return>

Decide on either listing simulation results on the screen (by pressing <Enter>) or saving them on
an experimental file (with the default extension .EXP).
The conditions in each segment are not saved in the file, only on the screen.
Output variables /T BP($)/: <Variable name(s)>

Specify the variable name(s) that is also listed on the screen together with the conditions in each
segment, or in the output experimental file.

Example
For a four-stage reactor, the output at a certain iteration may look like this:
H=-991745.1, P=100000, N(C)=2.8468936, N(N)=6.78399966E-4, N(O)=3.8171615,
N(SI)=1.77031
DEGREE OF FREEDOM 0
BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588099,
BP(QUARTZ_S3)=68.193896
1.78803E+03
BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292
2.08691E+03
BP(GAS)=71.23129, BP(SI_L)=22.471787
2.20831E+03
H=-924751,87, P=100000, N(C)=2.0594558, N(N)=5.17999978E-4, N(O)=4.0142358,
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N(SI)=2.7551438
DEGREE OF FREEDOM 0
BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588098,
BP(QUARTZ_S3)=68.193896
1.78803E+03
BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292
2.08691E+03
BP(GAS)=71.23129, BP(SI_L)=22.471787
2.20831E+03
H=-813239., P=100000, N(C)=1.6592668, N(N)=3.59999988E-4, N(O)=3.7549293,
N(SI)=2.896635
DEGREE OF FREEDOM 0
BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175981, BP(C_S)=8.1588098,
BP(QUARTZ_S3)=68.193896
1.78803E+03
BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292
2.08691E+03
BP(GAS)=71.23129, BP(SI_L)=22.471787
2.20831E+03
H=7374.6403, P=100000, N(C)=8.84911857E-1, N(N)=1.99999996E-4, N(O)=1.9379203,N
(SI)=1.853872
DEGREE OF FREEDOM 0
BP(GAS)=43.464341, BP(C1SI1_BETA)=25.175982, BP(C_S)=8.1588097,
BP(QUARTZ_S3)=68.193896
1.78803E+03
BP(GAS)=61.971213, BP(C1SI1_BETA)=38.144346, BP(QUARTZ_L)=66.230717 2.06569E+03
BP(GAS)=67.66262, BP(C1SI1_BETA)=35.480983, BP(QUARTZ_L)=58.219292
2.08691E+03
BP(GAS)=71.23129, BP(SI_L)=22.471787
2.20831E+03
10

1788.03

2065.69

2086.91

2208.31

0.00

0.00

0.00
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POST Module Commands
The POST module (post-processor) is available from the these modules: POLY, TAB, BIN,
TERN, POT, SCHEIL and POURBAIX.
Using the POST Module
In this section:
ADD_LABEL_TEXT

487

APPEND_EXPERIMENTAL_DATA

489

CHANGE_LEGEND

490

DUMP_DIAGRAM

491

ENTER_SYMBOL

492

FIND_LINE

495

LIST_DATA_TABLE

496

LIST_PLOT_SETTINGS

497

LIST_SYMBOLS

498

MAKE_EXPERIMENTAL_DATAFILE

499

MODIFY_LABEL_TEXT

500

PLOT_DIAGRAM

501

PRINT_DIAGRAM

502

QUICK_EXPERIMENTAL_PLOT

503

REINITIATE_PLOT_SETTINGS

504

RESTORE_PHASE_IN_PLOT

505

SELECT_PLOT

506

SET_AXIS_LENGTH

507

SET_AXIS_PLOT_STATUS

508

SET_AXIS_TEXT_STATUS

509

SET_AXIS_TYPE

510

Thermo-Calc User Guide: Console Mode ǀ 484 of 643

Thermo-Calc Documentation Set

SET_COLOR

511

SET_CORNER_TEXT

513

SET_DIAGRAM_AXIS

514

SET_DIAGRAM_TYPE

516

SET_FONT

517

SET_INTERACTIVE_MODE

518

SET_LABEL_CURVE_OPTION

519

SET_PLOT_FORMAT

520

SET_PLOT_OPTIONS

521

SET_PLOT_SIZE

523

SET_PREFIX_SCALING

524

SET_RASTER_STATUS

525

SET_REFERENCE_STATE

526

SET_SCALING_STATUS

528

SET_TIC_TYPE

529

SET_TIELINE_STATUS

530

SET_TITLE

531

SET_TRUE_MANUAL_SCALING

532

SUSPEND_PHASE_IN_PLOT

533

TABULATE

534
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ADD_LABEL_TEXT
Add a text to an area in a phase diagram or a property diagram. The label is written starting
from the specified coordinates. Optionally, you can also let the program automatically add
the text by first calculating an equilibrium state at the specified coordinates and then
making a label out of the stable phase names.
The label texts and coordinates, either added by this command or modified with MODIFY_
LABEL_TEXT (or manually edited in the Console Results window), are stored in the workspace,
and these may later be saved onto an *.EXP file (with MAKE_EXPERIMENTAL_DATAFILE).
In some cases such an optional calculation for automatic phase region labeling
may not work. It is not possible to automatically add labels for certain sets of
axes, like entropy, enthalpy, pH, Eh, etc.
Plot Labels
Syntax

ADD_LABEL_TEXT
Give X coordinate in axis units: <Value of the X coordinate>

Prompts

Specify the value of the X coordinate where the label is to start.
Give Y coordinate in axis units: <Value of the X coordinate>

The labels disappear if any axis is changed after wards.

Specify the value of the Y coordinate where the label is to start.
Automatic phase labels? /Y/:

By default the program automatically calculates the equilibrium at the given coordinates and
generates a label with the names of the stable phases. However, the automatic calculation works
only for phase diagrams that are mapped with two axes in the POLY module, and sometimes it
may not work correctly especially for complex heterogeneous interaction systems; in such cases,
a message displays.
Text: <Text for the label>

If you answer N enter text at the prompt. You can enter simple text, use LaTeX, rotate the text, as
well as adjust the font size.
LaTeX: You can use LaTeX commands to enter text and symbols. First enter the command
followed by the expression or string, for example to display Al2O3 as subscripts:
\latex Mole-fraction Al_2O_3
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Syntax

ADD_LABEL_TEXT

For a list of supported LaTeX commands, see
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html.

By default when using the LaTeX command, you are in math mode and ThermoCalc automatically interprets the entered text as math. The above link uses the
dollar sign ($) in all the examples but this is NOT required. For example, if you
enter $E=mc^2$ this is displayed including the $ instead of the equation.

To add a mixture of plain text and equation text, you can exit math mode using the
string \textrm followed by the text to display enclosed in curly brackets. For
example \latex \textrm{Mole-fraction }Al_2O_3 displays this label
.
Rotate the text: If you want to rotate the label, start a text string with the rotation command
(which is case sensitive and must be in lower case letters) then enter the number of degrees to
rotate the label. For example, to rotate the label 45 degrees enter:
\rotation 45
To rotate the text and use LaTeX, the rotation command must be used first. For example:
\rotation 45 \latex Mole-fraction Al_2O_3
Rotates the text 45° and includes subscripts in the title Mole-fraction Al2O3.
Text size: /.35/: <Size for the label>

A smaller size of the text may be necessary to fit the label text into the diagram. A default size is
given using the latest size in adding label texts, or .35 if the command is called for the first time. A
recommended size is e.g. 0.25.
These changes to plot labels can also be manually edited in the Console Results
window.
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APPEND_EXPERIMENTAL_DATA
Add experimental data and text onto a calculated diagram. This is done by placing the
experimental data and text on a formatted textual file (always having an extension of EXP)
that is prepared outside of Thermo-Calc software (Console Mode and Graphical Mode),
according to the syntax of the DATAPLOT Graphical Language.
The picture generated from the data is superimposed on the ordinary graphical output from
the postprocessor. Such an experimental data file (*.EXP) may be created by an ordinary
textual editor.
Another important usage of this command is to superimpose plots from several independent
calculations. For this purpose, there is a command MAKE_EXPERIMENTAL_DATAFILE, which
dumps a calculated diagram on an EXP file according to the DATAPLOT syntax. With the aid
of a normal text editor, many such files may be merged together. Remember that you can
only have one prologue section on each such EXP file.
DATAPLOT User Guide included with this documentation set.
Syntax

APPEND_EXPERIMENTAL_DATA
Use experimental data (Y or N) /N/:

Prompts By default, no experimental data are plotted. Enter Y to use the data from an experimental data
file in the next plot. An Open window displays to specify the name of the file with the
experimental data.
Prologue number: /0/: <Prologue number>

Select which prologue to use. In a prologue, you can, for example, give the scaling of an axis, the
axis texts, and so on.
By answering -1, a list of all prologues on the file is given; and by 0, no
experimental data are appended.
Dataset number(s) /-1/: <Dataset number(s)>

Select from which dataset(s) data should be read. Several datasets may be given separated with
commas or spaces. By answering -1, a list of all datasets on the file is given; and by 0, no
experimental data are appended.
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CHANGE_LEGEND
When there is a legend in the diagram you can append constitution and/or ordering
descriptions to the phase name.
LIST_EQUILIBRIUM

also displays ORD (ordered) or DISORD (disordered) (when

available).

In some cases the legend only shows the phase name for a line when SET_LABEL_
CURVE_OPTION is set to F.

Syntax

CHANGE_LEGEND
Set suffix for phase names in legend? (All, None, Constitution, Ordering)/None/:

Prompt

l

None: the legend includes the standard information about the phases.

l

All: the Constitution description and the Ordering description (when there is ordering) are

also included.
l

Constitution: it is added to the standard description.

l

Ordering (when applicable): it is added to the standard description.

Also see About Legend Styles for examples.
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DUMP_DIAGRAM
This is an alternative command used to create output. First use the PLOT_DIAGRAM
command to send output to the Results window. Then you can save it to a file either using
this command or right-click the diagram in the Results window and select Save as.
Similar to PRINT_DIAGRAM, it does not matter what graphic device/printer is
set up. The command can convert the diagram shown in the Results window to
the selected format.
Syntax

DUMP_DIAGRAM

Prompt Output format/: (jpg,ps,pdf,svg,emf,gif,png) /png/
Enter a format or press <Enter> to accept the default (png).
If you choose to enter the parameters and file name in one line (i.e. when you are
entering the command), the Save window does not open as described below. For
example, if you enter dump_diagram png test at the prompt, an image file called
test.png is output to the same folder where the macro file is stored. If a file with the
specified name already exists, you are prompted to overwrite the old file. You can
alternatively add Y or N to the command string to specify whether to overwrite the
file or not e.g. dump_diagram png test y.
A Save window opens if you have not specified a file name. Select a directory path and enter a File
name. If a file with the specified name already exists, then you are prompted whether to
overwrite the old file or not. The third argument of the command (Y) allows you to specify
whether to overwrite the old file or not (N).

After the output is done, the temporarily set graphic device for conversion and
printing is switched back to the one set by the command SET_PLOT_FORMAT, so
that you can save the graph in file(s) using PLOT_DIAGRAM.
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ENTER_SYMBOL
This command is for the POST module.
There are also a GES and POLY module commands with the same name.
Symbols are a useful feature of the POLY and POST modules to define quantities that are
convenient. Symbols can be constants, variables, functions or tables.
Functions or tables (with defined functions as values) can be entered in the POST module
after a stepping or mapping calculation, for purposes of plotting such entered functions or
tables as axis variables.
Within the POLY module, symbols are normally defined prior to an equilibrium calculation
(enforced by a C_E command), stepping calculation (enforced by the command STEP_WITH_
OPTIONS) or mapping calculation (enforced by MAP). These can be entered after an
equilibrium calculation; however, for defined functions, variable or tables, it requires using
EVALUATE_FUNCTIONS before showing the corresponding values in the calculated equilibrium
state.
The symbols entered in the POST module are not saved in the currently-loaded POLY3
workspaces. Therefore, if you want to apply such symbols in other similar calculations for
the same defined system, you must use the ENTER_SYMBOL command prior to the
STEPPING or MAPPING calculation in the POLY module.
See example 44 for an example of using variables and functions.
Symbols are a useful feature modules to define quantities that are convenient. Symbols can
be constants, variables, functions or tables.
Syntax

ENTER_SYMBOL
Constant, Variable, Function or Table? /Function/: <Keyword>

The Keyword can be specified as CONSTANT, VARIABLE, FUNCTION or TABLE.
l

Prompt
l

l

CONSTANTS can only be entered once and is a means of using a name for a numeric value. For
example, the value of 1 atmosphere in Pascal can be denoted by P0 after the command
ENTER_CONSTANT P0=101325. Defined constants can be used as values in condition
assignments, for example, SET-COND P=P0.
FUNCTIONS are expressions of state variables or other functions. These expressions are saved,
and whenever a function value is requested all functions are evaluated. The reason for this is
that they may depend on each other.
VARIABLES are similar to functions because they can also be expressions of state variables.
However, contrary to functions, they are only evaluated when they are entered or if they are
explicitly named in an EVALUATE_FUNCTIONS command. It is possible to enter a variable with a

Thermo-Calc User Guide: Console Mode ǀ 492 of 643

Thermo-Calc Documentation Set

Syntax

ENTER_SYMBOL

new expression any time. This expression is evaluated directly and its value stored as the
value of the variable. Defined variables can be used as values in the SET-CONDITION
command.
l

TABLES are used for listing results from the STEP or MAP commands. A table consists of a list
of any number of state variables, functions or variables. Defined tables can also be used in
the post-processor POST.

There is a special connection between tables and variables. If a variable is used in a
table, it is evaluated for each line of the table in the TABULATE command or when the
table is used in a plot.
Name: <Name of the symbol>

Each symbol has a unique name that must start with a letter and can have maximum 8 characters.
Legal characters include letters (either UPPER or lower case), digits and underscore _. Any other
special character, such as parentheses ( and ), plus +, minus -, slash / or \, full stop (.), are illegal for
symbol names.
You can enter the symbol name and the value or function on the same line, these must be
separated with an equal sign =, for example, TC=T-273.15 or T_C=T273.15 which stands for a
definition of temperature in Celsius. Otherwise, these questions are asked.
For different types of symbol (constant, function, variable or table), the questions
have different prompts.
Function: <Definition for a function or variable>

Functions and variables are evaluated from an expression of state variables or other functions,
constants or variables. The expression is a FORTRAN-like expression and operators +, -, *, = and **
can be used (** only with integer powers).
Unary functions like LOG, LOG10, EXP, SIN, COS and ERF can also be used. An expression can be
continued on more than one line. An expression should be terminated by a semicolon (;) or an
empty line (by pressing <Enter> at the next prompt).
Examples of function expressions:
l

GM(LIQUID): The Gibbs energy of liquid per mole component

l

H.T/4.184: The heat capacity of the system in calories

l

ACR(CR)/X(FCC,CR): The activity coefficient for Cr in FCC

l

T-273.15: The temperature in Celsius

&: <Continuation of the definition for the symbol>

The ampersand & means that you can continue to write the function on the new line if one line is
not enough for the function. If you finish the function press <Enter> again.
Value: <Value for a constant>
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Syntax

ENTER_SYMBOL

A constant can only be assigned a numeric value once.
Value or expression: <Value of expression for a variable>

A variable can be assigned a numeric value or an expression. An expression is evaluated
immediately and discarded. Only the numeric value is kept. This gives a possibility to save a value
between calculations with different conditions because all state variables and functions are
evaluated for the new conditions.
Variable(s): <Variable(s) in a table>

A table consists of a list of state variables or functions. One way to obtain results from a STEP
command is through a table.
Example:
ENTER TABLE K=T,X(LIQ,C),X(LIQ,CR),ACR(C)

Which means that the table called K contains four columns, i.e. the temperature, the mole
fractions of C and Cr in the LIQUID phase, and the activity of C.
To show the temperature in Celsius in a table, give the command ENTER_FUNCTION TC=T-273; and
then use the symbol TC in the table.
& <Continuation of the definition for the table>

The ampersand & means that you can continue to write the table on the new line if one line is not
enough for the table. If you finish the table press <Enter> again.
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FIND_LINE
Identifies various property curves on a plotted property diagram (after a stepping
calculation); it also works well in find stable phase regions on a phase diagram (after a
mapping calculation).
Syntax

FIND_LINE
X coordinate /.484623611/: <Value of the X coordinate>

Prompts Specify the value of the X coordinate where you want to find the details of property curve (or
phase region).
Y coordinate /.5153737962/: <Value of the Y coordinate>

Specify the value of the Y coordinate where you want to find the details of property curve (or
phase region).
The POST module displays the identified property (for a property curve on a property diagram), or
the identified stable phase-assemblage (for a phase region on a phase diagram).
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LIST_DATA_TABLE
This is a POST module command.
This command is used for listing various properties (i.e. the Y-axis variable on a property
diagram) that change with an independent variable (i.e. the X-axis variable on a property
diagram), which have already been defined in the POST module (and often are plotted on
the Console Results window), but only after a STEP calculation.
The listing output can be either on screen or in a spreadsheet file in the MS Excel format
(under specified file name with the default file extension of XLS), which can be further
edited or used for graphical handling by opening the file (using the MS-Excel program)
outside of the Thermo-Calc software system.
Syntax

LIST_DATA_TABLE
Output to screen or file /Screen/: <File name or return >

Specify a file name if you want to save on a spreadsheet file (in the MS Excel format, with the
default extension of XLS) on which the already-defined properties on a property diagram (after a
STEP calculation) is saved, or press <Enter> if want to see a simple textual table on screen (for the
Prompt already-defined properties that change alone with an independent variable).
This command only works for a property diagram after a stepping calculation but
not for any phase diagram after a mapping calculation.
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LIST_PLOT_SETTINGS
This is a POST module command.
Syntax LIST_PLOT_SETTINGS
Lists the present values of most parameters specifying the type of diagram to be plotted.
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LIST_SYMBOLS
This command is for the POST module.
There is also a POLY module command with the same name.
Use this command to list the definitions for all constants, functions, variables and tables. In
order to find the value of a function or variable, use SHOW_VALUE or EVALUATE_FUNCTIONS. A
table is tabulated with the TABULATE command.
Syntax LIST_SYMBOLS
The defined variables are listed up together with the defined functions, but variable names are
followed by a percentage sign %.
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MAKE_EXPERIMENTAL_DATAFILE
Write the graphical information onto screen or a formatted text file (always having an
extension of .EXP) using the DATAPLOT graphical format. In order to merge two or more
diagrams from separate calculations, you can write them out on files with this command,
and then add/edit them together with a normal text editor.
There is another type of experimental data file that is generated in Thermo-Calc
when working with the PARROT module. For more information seeExperimental
Data Files (*.POP, *.DOP).
Syntax

MAKE_EXPERIMENTAL_DATAFILE
Output to screen or file /Screen/: <Name of a file or return>

Prompt Specify the name of the desired file. Press <Enter> for a list. Otherwise enter a file name where
the graphical information is written. The default file extension is EXP (for Windows) or exp (for
Linux).
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MODIFY_LABEL_TEXT
Move a label created with the command ADD_LABEL_TEXT to another position, or replace its
text with another one.
The label texts and the coordinates, either added by ADD_LABEL_TEXT command or
modified by this command or manually edited on the Console Results window, are stored in
the workspace, and can be saved onto an *.EXP file (through MAKE_EXPERIMENTAL_DATAFILE).
Syntax

MODIFY_LABEL_TEXT
Which label to modify? /#/: <Number of the label>

Prompts Before this prompt, all the labels created by the ADD_LABEL_TEXT command is listed with an
identifying number. Specify the Number of the label you want to modify. The default one (#) is
the last added label.
New X coordinate: /xxx/: <New X position>

Specify the New X position. The previous X coordinate is displayed. Press <Enter> to accept.
New Y coordinate: /yyy/: <New Y position>

Specify the New Y position. The previous Y coordinate is displayed. Press <Enter> to accept.
New text /ABCDEFGH.../: <New labeling text>

Specify the New labeling text. The previous text is displayed. Press <Enter> to accept.

The new label text must not be longer than the previous text.

Thermo-Calc User Guide: Console Mode ǀ 500 of 643

Thermo-Calc Documentation Set

PLOT_DIAGRAM
After you use the SET_PLOT_FORMAT command to define the default graphic device (the
printer) you can use a PLOT_DIAGRAM command to either save the calculation output to a file
or display the output in the Results window.

The diagram axes must be set first.

The functionality of this command is shared in two ways:
l
l

in PLOT_DIAGRAM for normal screen display and file saving and
Windows OS: If the device is not defined, you can alternatively use PRINT_DIAGRAM
for a hard copy.

Syntax
Prompt

PLOT_DIAGRAM
Output to screen or file /Screen/: <Name of a file or return for screen>
Specify the name of the file

For Linux users, the prompt is PLOTFILE /SCREEN/).
A file with a proper extension for the selected graphic format (set by SET_PLOT_FORMAT) is saved
under the current working directory. If no extension is given in the file name, the default extension
e.g. ps for Postscript portrait/landscape modes, P7 or p7 for HPGL landscape, P8 or p8 for HPGL
portrait, etc.) is automatically given to the file name.
If the default device is set (SET_PLOT_FORMAT), press <Enter> to plot the diagram on the screen in
the Console Results window or give a file name to save it.
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PRINT_DIAGRAM
Saving and Printing the Output in Console Mode
First use PLOT_DIAGRAM to create a diagram that displays in the Console Results window.
Then after entering the PRINT_DIAGRAM command, the Print window opens where you can
choose additional settings for a hard copy of the diagram.

functions in the same way as in the Console Results window
where you can right-click a diagram and choose Print.
PRINT_DIAGRAM
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QUICK_EXPERIMENTAL_PLOT
This is similar to APPEND_EXPERIMENTAL_DATA but can be used when there is no graphical
information to be plotted in the POLY3 workspace. It defines a pair of axes, sets the axis
labels to X and Y, and scales both X- and Y-axes between 0.0 and 1.0 unless a prologue is
read from the DATAPLOT (*.EXP) data file.
Plotting Experimental Data Files in the DATPLOT User Guide included with this
documentation set.
Syntax

QUICK_EXPERIMENTAL_PLOT
Prologue number: /0/: <Prologue number>

Prompts An Open window displays. Select the prologue to use. In a prologue, you can, for example, give
the scaling of an axis, the axis texts, and so on. By answering -1, a list of all prologues on the file is
given; and with 0, no experimental data are appended.
Dataset number(s) /-1/: <Dataset number(s)>

Select from which dataset(s) data should be read. Several datasets may be given separated with
commas or spaces. By answering -1, a list of all datasets on the file is given; and with 0, no
experimental data are appended.
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REINITIATE_PLOT_SETTINGS
The REINITIATE_PLOT_SETTINGS command gives default values to all parameters describing
the diagram. All plot settings made in the POST module are deleted, and it returns to the
initial settings when the POST module is entered.
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RESTORE_PHASE_IN_PLOT
Restores a phase previously suspended from the plot with SUSPEND_PHASE_IN_PLOT. It works
only after at least one phase is suspended.
Syntax

RESTORE_PHASE_IN_PLOT
Phase name: <Name of a phase>

Prompt

Give the name of the phase to be restored.
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SELECT_PLOT
Select a plot (diagram) within the current Results tab in the Console Results window.
Syntax

SELECT_PLOT
Plot <N/New>

Where N is a positive integer. Enter the number of the plot that is selected in the Console Results
window (in the currently selected Results tab). If a plot with that number does not exist, it is
Prompt created.
The default parameter value is NEW. If this is entered, then a new plot is created. Create a new plot
can also be done by pressing <Ctrl+Shift+T>.
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SET_AXIS_LENGTH
Change the real length of an axis in inches. The default number of tic-marks on an axis is 10
when the relative length is 1. The number and units per tic-mark must be a multiple of 1, 2
or 5 to obtain a reasonable scaling of an axis.
Syntax

SET_AXIS_LENGTH
Axis (X, Y or Z): <Name of an axis>

Prompts

Specify which axis to set the length.
Axis length /11.5/: <New relative axis length>

Specify the new real axis length in inches. The relative length 1 corresponds to 10 tic-marks on
the axis.
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SET_AXIS_PLOT_STATUS
Specify whether the axis title texts and axis label texts are to be plotted or not on a diagram.
It does not work for the axis lines and tic-marks. If you want to plot a diagram without ticmarks, use SET_TIC_TYPE first.
This can be used to merge different diagrams on a pen-plotter or to obtain the diagram
faster. The default status is that all the set axes are to be plotted.
Syntax

SET_AXIS_PLOT_STATUS

Prompt Axis plot (Y or N) /Y/: (Y or N)
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SET_AXIS_TEXT_STATUS
Change the axis text from the automatic text given by the axis specification to a text.
ADD_LABEL_TEXT
Syntax

SET_AXIS_TEXT_STATUS
Axis (X, Y or Z): <Name of an axis>

Prompts

Specify which axis text status to change.
Automatic axis text (Y or N) /N/:

Specify if automatic axis text is to be used.
Axis text: <Enter axis text>

You can enter simple text, use LaTeX, rotate the text, as well as adjust the font size.
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SET_AXIS_TYPE
Change the axis type among linear, logarithmic and inverse axis.
Syntax

SET_AXIS_TYPE
Axis (X, Y or Z): <Name of an axis>

Prompts

Specify which axis to change the axis type.
Axis type /Linear/: <New axis type>

Specify which new axis type to set. Select LINear (default), LOGarithmic or INVerse. Only the three
first characters are relevant.
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SET_COLOR
Some devices support colours or line thickness. With this command, select different colors or
line types on some types of information on a diagram.
This command can fail if a chosen device does not support colors or line
thickness.
This command gives four sequential prompts (i.e. text and axis, invariant equilibria, tie-lines,
and all other lines), with the keyword and default option (both listed below). Depending on if
the switched-on graphic device (by SET_PLOT_FORMAT) supports colors or line types, the POST
automatically switches on the appropriate Keyword.
Syntax

SET_COLOR
Text and axis keyword /Default option/
<Return or new option>
Invariant equilibria keyword /Default option/: <Return or new option>

Prompt Tie-lines color keyword /Default option/: <Return or new option>
Keyword of all other lines /Default option/: <Return or new option>

This is usually for the solubility lines.

The Keyword is either Color or LineType, depending on if color or line type is
supported by the switched-on graphic device (by SET_PLOT_FORMAT); the POST
module automatically switches on the appropriate Keyword .
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Color Options
The options for Color are:
BACKGROUND

BLUE

PURPLE

GRAY

FOREGROUND (default)

YELLOW

GOLD4

ORANGERED3

RED (default for invariant equilibria)

MAGENTA

TURQUOISE4

MAROON

GREEN (default for tie lines)

CYAN

PINK

PLUM

SIENNA

OLIVEDRAB

SEAGREEN

ORANGE1

CORAL1

USERDEF

LineType Options
The options for LineType are:
INVISIBLE

VERY_THICK (default for invariant equilibria)

NORMAL (default)

THIN (default for tie lines)

THICK

VERY_THIN

DASHED

DOTTED
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SET_CORNER_TEXT
Adds text to the corners on a plotted diagram. Normally, you can write such texts as a
subtitle.
The primary database (not the appended ones) used in calculations and the calculated
conditions are automatically plotted at the upper-left corner as a part of the header on all
plotted diagram. Unless the plotting option WRITE CONDITIONS is switched off by the
command SET_PLOT_OPTIONS, the calculated conditions are always written on plotted
diagrams; and only when the plotting option PLOT HEADER is switched off by the command
SET_PLOT_OPTIONS, the used database also always appear. Under such circumstance, avoid
writing texts at the UPPER_LEFT corners.
Syntax

SET_CORNER_TEXT
Corner/Lower_Left/: <Return or new option>

Choose an option:

Prompt

l

LOWER_LEFT

l

UPPER_LEFT

l

UPPER_RIGHT

l

LOWER_RIGHT

l

TOP_OF_TRIANGLE

Text: <Texts as a subtitle or a note>

Write the texts that are to be written on the specified diagram corner.
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SET_DIAGRAM_AXIS
Specify an axis variable for a plot or a listing. To be able to plot a diagram, at least two axis
variables (X and Y) must be specified. In Console Mode, three axes (X, Y, and Z) can be
specified for a diagram.
The axis variables in the plot can be different from the number of axis used for
the mapping.
If you want to plot a phase diagram with tie-lines in the plane after a MAP calculation, then
the composition axis must be mole-fraction or weight-fraction, or mole-percent or
weight-percent of one specific component. You must not use the stable variable x(comp)
or w(comp) even if that is what you used when calculating the diagram, because that only
gives one side of the two-phase region. It may be sufficient to indicate that mole-fraction is
the same as the stable variable x(*,comp), and weight-fraction is the same as the stable
variable w(*,comp).
If you plot a phase diagram where the tie-lines are not in the plane after a MAP calculation,
then mole-fraction and x(comp) are identical.
When you plot a property diagram after a STEP calculation and want a composition axis
variable, you should normally use x(comp) and not mole-fraction.
The axis must have exactly the same number of columns, or one axis must have one column.
In the first case the columns are plotted matching them one by one; in the latter all columns
on one axis is plotted against the single column. For example, you can have the temperature
on one axis and the amount of each phase on the other. The amount of each phase is the
state variable NP(*) in mole fraction or BPW(*) for mass fractions of phases.
Automatic diagram axis: The POST module can set automatic diagram axis identical to
those used in the MAP command.
If the state variable x(comp) is used in a MAP calculation, then mole-fraction of the
component is used as diagram axis; if a potential or some other state variables are used,
then that is used as a diagram axis.
After a STEP calculation, automatic diagram axis is not set as there is only one axis used in
the calculation.
Syntax

SET_DIAGRAM_AXIS
Axis (X, Y or Z): <Axis name>

Specify which axis (X or Y or Z) to set with a variable.
Prompts Variable type: <Variable name>
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Syntax

SET_DIAGRAM_AXIS

Specify a variable for the chosen axis here.
The valid variables are:
l

TEMPERATURE-CELSIUS as temperature in °C

l

TEMPERATURE as temperature in K

l

PRESSURE as pressure in Pa

l

ACTIVITY for a component

l

LNACTIVITY for a component [ln(ACR(component)]

l

MOLE-FRACTION for a component

l

MOLE-PERCENT for a component

l

WEIGHT-FRACTION for a component

l

WEIGHT-PERCENT for a component

l

ENTHALPY as enthalpy in J/mol

l

ENTROPY as entropy in J/mol/K

l

NONE to clear the axis

l

Any valid state variable including those with wildcards, e.g. NP(*) or x(*,component). Due to
the use of wildcard * in such a state variable, the program asks for a column number.

l

Any entered function or variable.

l

Any entered table.

If you specify an entered table as the variable, then you are given these prompts:
For component: <Component name>

When an activity, mole or weight fraction or percent of a component shall be plotted, the
component name must be supplied here.
Column number: <Column number(s)>

Specify the column number(s) in the chosen table that are to be plotted onto the earlier specified
axis. For example:
l

1 for column 1

l

2,3 for columns 2 and 3

l

2,3 >5 for column 2,3 and all columns above column 5

l

* for all columns
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SET_DIAGRAM_TYPE
Choose the diagram type as perpendicular plot or triangular plot (Gibbs triangle, especially
for ternary systems). The default is with a perpendicular axes.
For phase diagrams of ternary or pseudo-ternary systems, it is usually need to plot
isothermal sections as triangular grams. If desired, all lines outside the region limited by a
line joining the end points of the X- and Y-axis is removed.
Syntax

SET_DIAGRAM_TYPE
Triangular diagram (Y or N) /N/:

The default is to set a perpendicular axis. Perpendicular diagrams have (almost) the same scaling
on both axes.
Prompts Create tetrahedron WRML file (Y or N) /N/:
The 3D plotting in Console Mode does not work. Enter Y to specify a triangular plot
instead.
Plot 3rd axis (Y or N) /N/:

If a triangular plot is selected, enter Y to specify a 3rd axis and to connect (and plot) the end points
of the X- and Y-axes.
Clip along 3rd axis (Y or N) /N/:

If a triangular plot is selected, enter Y so that all lines outside the region limited by a line joining
the end points of the X- and Y-axis are removed.
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SET_FONT
Select the font to use for labels and numbers when plotting the diagram under the currently
selected graphic device (SET_PLOT_FORMAT). For some devices there may be other fonts
available and these are selected by SET_PLOT_FORMAT.
Syntax

SET_FONT
Select font number /1/: <#>

Prompts

Specify an available font number # as the default font for the current graphic
device, or accept the font number 1 by pressing <Enter>. By typing a question mark
? here, the program lists the available fonts under the currently selected graphic
device.
Font size /.34/: <##>

The size of the chosen font is specified. A value around 0.34 is recommended.
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SET_INTERACTIVE_MODE
In the POLY module this is called SET_INTERACTIVE.
Use the SET_INTERACTIVE_MODE command to use it in demonstration or macro files to stop
the execution of the command file and pass over input focus to the keyboard.
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SET_LABEL_CURVE_OPTION
Identify the curves drawn in the post-processor by marking each curve with a digit and then
list the meaning of these digits beside the plot.
The number of digits can be quite large in some cases. If so, use SET_FONT and
reduce the font size; usually, 0.2 is sufficient.
Syntax

SET_LABEL_CURVE_OPTION

Prompt Curve label option (A, B, C, D, E, F OR N) /A/: <Option>
The options:
l

A: List stable phases along line

l

B: As A but curves with same fixed phase have same number

l

C: List axis quantities

l

D: As C but curves with same quantities have same number

l

E: As B with changing colors

l

F: As D with changing colors

l

N: No labels

This question is rather cryptic but usually the option B or E is good for phase diagrams (after a MAP
command) and option D or F for property diagrams (after a STEP command). Those interested can
try out the option A and C by themselves.
Option B or E lists the fixed phases along each curve, whereas option D or F gives
the axis variables used along each curve. E provides varied colors for different
stable-phase curves on phase diagrams (after a MAP command); F provides varied
colors for different property curves on property diagrams (after a STEP command).
The option N (NONE) disables all curve labels and lists.
If, for example, you use T (temperature in K) as the variable axis in a STEP command and then plot
the amount of stable phases (with SET_DIAGRAM_AXIS Y NP(*)) on the Y-axis versus T-C on the Xaxis, then the list may have lines like:
1: T-273.15, NP(LIQUID)
2: T-273.15, NP(FCC_A1)

This means that for curve 1 the X-axis is T-273.15 (the same for all curves, of course) and NP
(LIQUID) on the Y-axis. Curve 2 has the same X-axis but NP(FCC_A1) on the Y-axis.
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SET_PLOT_FORMAT
Adjust the format of the graphical output to another graphical device. This default can be
changed with the SET_PLOT_ENVIRONMENT command in the SYSTEM MONITOR.
Syntax

SET_PLOT_FORMAT
Graphic device number /#/: <Number of the device>

Specify a graphic device number. Depending on the hardware, different plot formats (graphic
Prompt devices) may be available. These are listed online by giving a question mark ?.
For some formats there can be additional sub-prompts (Y or N) about the available fonts being
used for the chosen format. Also enter Y for further specifications, e.g. font type and size.
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SET_PLOT_OPTIONS
You are prompted for and can toggle on (Y) or off (N) the plotting of some options on all
subsequently generated diagrams.
For the Always initiate POST on re-entering prompt, the default is Y which implies
that the POST module automatically reinitiates whenever the POLY3 workspace is changed
upon re-entering. If answered N the same diagram axis variables are kept even if the
workspaces in the POLY module are read from or written to a *.POLY3 file. The N answer is
useful when there are several sets of *.POLY3 files with the same calculation but for
different sets of model parameters.
For the Always solid line prompt, the default answer is N which means that the POST
module plots solid lines for stable phases but dashed lines for metastable phases. This is
normally for plotting property diagram after a STEPPING calculation; however, when there is
a metastable extrapolation in a phase region on a phase diagram after a MAPPING
calculation, this is also enforced. When the alternative answer Y is chosen, all the lines are
always plotted in solid lines.
Syntax

SET_PLOT_OPTIONS
Plot header /Y/:

Prompts

Toggle the plotting of the header text above a diagram.
Plot logo /Y/:

Toggle the plotting of the Thermo-Calc logo at the lower-left corner of a diagram.
Plot footer /Y/:

Toggle the plotting of the footer identifier text at the right margin of a diagram.
White-Contoured-PS-CHARS /Y/:

By default, the PostScript characters are written as a white contoured status.
Plot remote exponent(s) /Y/:

By default the remote exponent on the axis is plotted.
Plot symbols at node points /0/: <#>

This makes it possible to plot symbols at the node points on plotted lines on a
diagram.
Symbol size /.1/: <.#>

Set the size of symbols which are plotted at the node points.
Write condition? /Y/:

By default, the initial equilibrium conditions for the current calculations are
automatically plotted at the upper-left corner as a part of the header. If you enter
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Syntax

SET_PLOT_OPTIONS

N, the calculated conditions are not included on a plotted diagram.
Write database name? /Y/:

By default, the primary database (not appended ones) used in the current
calculations are plotted at the upper-left corner as a part of the header. If you enter
N, the database name is not included on a plotted diagram.
Always initiate POST on re-entering: /Y/:

By default the POST module automatically reinitiates whenever the POLY3
workspaces are changed upon re-entering.
If you enter N, the same diagram axis variables are kept even if the workspaces in
the POLY module is read from or written to a *.POLY3 file. This can be useful when
there are several sets of *.POLY3 files with the same calculation but for different
set of model parameters.
Always solid line: /N/:

By default the POST module plots solid lines for stable phases and dashed lines for
metastable phases. This is normally for plotting property diagrams after a STEPPING
calculation. However, when there is a metastable extrapolation in a phase region on
a phase diagram after a MAPPING calculation, this is also enforced. Enter Y to always
plot solid lines in this case, for example.
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SET_PLOT_SIZE
Change the size of the diagram by specifying a global plot size (as a relative scaling factor).
The default value of the relative scaling factor is 1, while the real size of the plotted diagram
depends on what output device is chosen with SET_PLOT_FORMAT. The default plot size
(corresponding to the default global plot size 1) is adjusted to the chosen device.
Syntax

SET_PLOT_SIZE
Global plot size /1/: <Relative scaling factor>

Prompt Enter the relative scaling factor as a numerical number (e.g. 0.5, 0.8, 1.0, 1.5, etc.). By pressing
<Enter>, the default relative scaling factor (1) is accepted.
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SET_PREFIX_SCALING
Specify on which axis is to have a prefix scaling then set the scaling of remote exponents
with certain powers.
Syntax

SET_PREFIX_SCALING
Axis (X, Y or Z): <Name of an axis>

Prompt

Specify which axis is to have a prefix scaling.
Use prefix scaling /Y/: (Y or N or #)
l
l

l

NO switches off its action.
YES arranges the prefix scaling so that the axis scaling is done with the remote exponents
being powers of three, i.e. ...,-6,-3,0,3,6,.... The default is 3.

# is an integer number that sets the remote exponents as being powers of # (as the powers for
the remote exponents).
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SET_RASTER_STATUS
Plot a raster (i.e. with gridlines on both axis directions) in the diagram.
Syntax

SET_RASTER_STATUS
Raster plot (Y or N) /N/:

Prompt

By default no raster is plotted. Enter Y to plot using a raster plot.
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SET_REFERENCE_STATE
This command is available for the POLY, ED-EXP and POST modules.
The reference state for a component is important when calculating activities, chemical
potentials and enthalpies and is determined by the database being used. For each
component the data must be referred to a selected phase, temperature and pressure, i.e.
the reference state.

All data in all phases where this component dissolves must use the same
reference state. However, different databases can use different reference
states for the same element/component. It is important to be careful when
combining data obtained from different databases.

By default, activities, chemical potentials and so forth are computed relative to the
reference state used by the database. If the reference state in the database is not suitable
for your purposes, use this command to set the reference state for a component using SER,
i.e. the Stable Element Reference (which is usually set as default for a major component in
alloys dominated by the component). In such cases, the temperature and pressure for the
reference state is not needed.
In order to specify conditions in the specific reference state, you can append an R to the
state variables. Thus, AC is the activity (of a system component or of a species in a phase)
with respect to the default reference state, and ACR is the activity with respect to the
selected reference state; MU is the chemical potential of a system component with respect
to the default reference state, and MUR stands for the chemical potential with respect to the
selected reference state. The AC and ACR variables, for both components in a system and
species in a phase, can be specified in natural logarithm, e.g. LNAC(Fe), LNACR(C), LNAC
(O2,GAS), LNACR(O2,GAS).
For the POST module, and after calculating with the STEP_WITH_OPTIONS or MAP commands,
the reference state for a component can also be changed to plot various properties of the
component in the entire system or in a specific phase. Then you can set the diagram axes as
the chemical potential or activity quantities with the R suffix, i.e. MUR(comp), MUR
(comp,ph), ACR(comp), ACR(comp,ph) or the common logarithms [e.g. LNACR(comp,ph)].
Syntax

SET_REFERENCE_STATE
Component: <Name of the component>

Prompts

The name of the component must be given.
Reference phase: <Name of a phase used as the new reference state>
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Syntax

SET_REFERENCE_STATE

Enter the Name of a phase for the system.
For a phase to be usable as a reference for a component, the component needs to
have the same composition as an end member of the phase. The reference state is
an end member of a phase. The selection of the end member associated with the
reference state is only performed once this command is executed.
If a component has the same composition as several end members of the chosen reference
phase, then the end member that is selected at the specified temperature and pressure will have
the lowest Gibbs energy.
The following are example using temperature. Pressure is used in the same way:
l

l

l

In the Fe-C system, BCC can be a reference state for Fe but not for C since BCC can exist as
pure Fe but cannot exist as pure C.
If GAS is chosen as the reference phase of component O at such a high temperature that O1
has the lowest energy, then O1 remains the reference state even at calculations performed at
lower temperatures where O2 has a lower energy than O1.
Setting the reference state for component O as gas (one sublattice) with constituents O1, O2
and O3 results in O2 being the reference state if, at the present temperature, pure O2 has the
lowest energy of O1, O2 and O3. If the reference state is set above a critical higher
temperature, then O1 has the lowest energy and consequently becomes the reference state.

Temperature /*/: <Temperature for the reference state>

Select the Temperature (in K) for the reference state. The wildcard value * means the current
temperature is used at the time of evaluation of the reference energy for the calculation.
The temperature set with this command does not affect the temperature used
when evaluating the energy of the reference state during the end member
selection process.
Pressure /1E5/: <Pressure for the reference state>

Select the Pressure (in Pa) for the reference state. The wildcard value * means the current
pressure is used for evaluating the reference energy at the time of calculation.

Examples
S-R-S Fe SER
S-R-S Cr FCC * 100000
S-R-S H2O AQUEOUS * 100000
S-R-S ZE REF_ELECTRODE * 100000
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SET_SCALING_STATUS
When an axis variable is selected by SET_DIAGRAM_AXIS, the scaling status for the axis is
always set to automatic scaling. By this command, choose between manual or automatic
scaling on a specified axis. If manual scaling is chosen, specify a minimum and a maximum
value. Manual scaling can be used to magnify interesting parts of a diagram.
Syntax

SET_SCALING_STATUS
Axis (X, Y or Z): <Name of an axis>

Prompts

Specify which axis that you want to set the scaling status.
Automatic scaling (Y or N) /N/:

The default is manual scaling. Enter Y for automatic scaling (N).
For manual scaling specify the Min and Max values.
Min value: <Minimum value>

The minimum value at the start point of the specified axis.
Max value: <Maximum value>

The maximum value at the end point of the specified axis.
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SET_TIC_TYPE
Change the drawing of the axis tics. You may alter the placement of tic marks on the axis,
e.g. inside or outside or no tic marks. The size of tic marks cannot be altered by this
command, but these are adjusted based on the selected graphic device and the defined
relative scaling factor (global plot size).
Syntax

SET_TIC_TYPE
TIC Type /1/: <1 or -1 or 0>

Prompt The tic type 1 is default, i.e. the tics are drawn outside the diagram. -1 means that the tics are
inside the diagram and 0 means no tics.
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SET_TIELINE_STATUS
If the tie-lines are in the plane of the calculation, you can select to plot the tie-lines in twophase fields with this command.
Syntax

SET_TIELINE_STATUS
Plotting every tie-line no. /0/: <Number of tie-lines>

Prompt The tie-lines plotted are not equally spaced by the graphics software. Instead, you can select to plot
a subset of the calculated tie-lines, i.e. every one (1), every second (2), every three (3), etc. By
accepting the default value 0, no tie-line is plotted.
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SET_TITLE
Specify a title that displays on all listed tables and plotted diagrams from the POST module.
ADD_LABEL_TEXT
Syntax

SET_TITLE
Title

Enter the title you want to appear on all tabulation or graphic outputs.
Prompt
There is a maximum length of about 60 characters for the title. You can enter simple
text, use LaTeX, rotate the text, as well as adjust the font size.
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SET_TRUE_MANUAL_SCALING
The tic-marks on the axes are normally placed in even intervals using the whole axis length.
The scaling routine adjusts the given minimum and maximum values slightly to accomplish
this. If such an automatic adjustment behaviour is unwanted, it can be avoided by using this
command (followed by a message showing the TRUE MANUAL SCALING set for a specific axis).
The command works like a toggle. To reset the automatic scaling behaviour, repeat the
command a second time for that specific axis (followed by a message saying the SEMI_
MANUAL SCALING set for the specific axis.
Syntax

SET_TRUE_MANUAL_SCALING
Axis (X, Y or Z): <Name of an axis>

Prompt Specify which axis (X or Y or Z) you want to toggle between automatic adjustments or avoid the
adjustment of the given maximum and minimum values.
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SUSPEND_PHASE_IN_PLOT
Specify that lines originating from the presence of a certain phase shall not be plotted on a
diagram. If you want to bring the suspended phase back to the diagram, use RESTORE_PHASE_
IN_PLOT.
Syntax

SUSPEND_PHASE_IN_PLOT
Phase name: <Name of a phase>

Prompt

Specify the name of the phase to be suspended from the diagram.
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TABULATE
This command is available for a table entered in either the POLY or POST
module.
For any entered table, this command gives a table of values from equilibria calculated with
a STEP command.
Unlike the TAB module's command (also called TABULATE) it is not possible to
plot columns from the tabulated tables. For this use normal POST commands.
Syntax

TABULATE
Name: <Name of a table entered in either POLY or POST>

Prompts

Specify a table name that is entered in either the POLY or POST module.
Output on screen or file /Screen/:

Specify a file name if you want to save on a file the table values along the defined STEP calculation,
or press <Enter> if want to see the table values displayed.
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Parameters, Functions and Variables
This section is applicable to both Console Mode and Graphical Mode with respect to
understanding the format these are to be written in for Thermo-Calc to use the parameter,
function or variable. However, many of the sections are specific to Console Mode where the
explicit use of these terms is more often used.
To learn about using variables and functions: For Graphical Mode, see T_07:
User-Defined Functions and for Console Mode, see example 44 .
In this section:
Specifying Parameters

536

About Operators and Functions

538

Thermodynamic Variables

539

Intensive Variables

541

Extensive Variables

542

Special Quantities

546

The u-Fraction Variable

548

Suffixes

549

Thermophysical Properties Variables

555

Derived Variables and Partial Derivatives

557

Units of State Variables and Derived Variables

564

User-Specified Units

565

Examples of User-Defined Units

566
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Specifying Parameters
This section or topic is specific to Console Mode.
Running a command typically requires that several parameter values are specified, which
can be done directly in the command line after the command name. For example, to set an
axis variable for a stepping or mapping operation, enter:
SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025

You can also use SET_AXIS_VARIABLE and press <Enter>. At the command line prompt, you
then specify the parameters one at a time.
On all command lines, you can enter a question mark (?) for help. For some parameters,
enter two question marks (??) for more detailed information.

Default Parameters Values
When you are requested to specify a parameter, Thermo-Calc usually suggests an
appropriate default value, which is displayed at the prompt between two slash signs (//). For
example, this prompt means the default answer is TERMINAL:
OUTPUT FILE /TERMINAL/:

Press <Enter> to accept the default.
If you specify some parameters directly after the command name, then you can still choose
to accept default values for some parameters.
To accept the default value for a parameter, type a comma (,) instead of a value for that
parameter. For the comma to be interpreted correctly, type a blank space on each side of
the comma. However, if you accept the default values for several parameters that follow
each other, then the commas can be typed in without blank spaces separating them: (,,,) is
interpreted in the same way as (, , ,).
For some commands and parameters, Thermo-Calc treats the values previously assigned as
default values if the command is used again. For example, if the first stepping or mapping
axis variable is specified as:
SET_AXIS_VARIABLE 1 X(FCC,FE) 0 0.89 0.025

Then if you want to change a parameter value for this axis variable, type:
SET_AXIS_VARIABLE 1 , 0.1 ,,,
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This changes the minimum value from 0 to 0.1 at which a stepping or mapping operation
halts. The other parameter values remain the same. Consequently, what is typed is
equivalent to:
SET_AXIS_VARIABLE 1 X(FCC,FE) 0.1 0.89 0.025
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About Operators and Functions
Sometimes you need to specify functions when setting up a system. For example, to make
global conditions vary as a function of time.
The following operators can be used in writing functions. Use a semi-colon (;) to mark the
end of a function.

Available Operators for Writing Functions
Operator

Description

+, -, *, /

Addition, subtraction, multiplication, division

**

Exponentiation, raising one quantity to the power of another, e.g. x2.

ABS()

Absolute value

ERF(X)

Error function

EXP(X)

Exponential

LOG(X)

Natural logarithm

LOG10(X)

Base 10 logarithm

SIGN(X)

Sign function
SIGN(X) is -1 when X<0, is 0 when X=0 and is 1 when X>0.

SIN(X), COS(X), ATAN(X)

Sinus, cosinus and arctangent

SQRT(X)

Square root
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Thermodynamic Variables
There are different thermodynamic variables in Thermo-Calc. Some are state variables, for
example temperature, pressure and mole fraction. These characterize the equilibrium state
of a system. You set them when you define your system in the POLY module before
performing a calculation. They are also used in other modules such as DATA, GIBBS and
PARROT. State variables that involve components can be used for the defined components,
but not for any species. (To define new components in a defined system, use DEFINE_
COMPONENTS).
Other useful thermodynamic variables are derive from state variables with a mathematical
function. Some derived variables are pre-defined by Thermo-Calc, such as normalized
energetic and compositional extensive state variables for example. You use these by
appending various normalizing suffixes to abbreviations that are associated with the state
variables.
Thermodynamic variables can also be divided into extensive variables and intensive
variables. An extensive variable is a variable whose value depends on the size of the system,
whereas an intensive variable is a variable whose value is independent of system size.
More information about thermodynamic variables is available in the online help in ThermoCalc Console Mode. Use the command INFORMATION, with a subject keyword such as one
of the following as argument: STATE VARIABLES, INTENSIVE VARIABLES, EXTENSIVE
VARIABLES, DERIVED VARIABLES, CONDITIONS (for condition settings), AXIS-VARIABLES (for
stepping/mapping variable settings).

Common Thermodynamic Variables
The tables below list common thermodynamic variables. Most of these can be used to define
equilibrium conditions in the POLY module unless otherwise indicated.
The variables are divided into the following tables:
l

Intensive variables

l

Energy-related extensive variables for whole system or for a phase

l

l

l

Compositional extensive variables (overall amount of components in the whole
system, or amount of a component in system or in a phase)
Constitutional composition-related extensive variables (amount of a
constituent/species on a sublattice site in a phase)
Special quantities
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How to Read the Tables
l

l

l

l

The Abbrev. column shows the abbreviation that you use in the POLY module for
referring to the variable. If the variable must be given any arguments, then these are
given in parenthesis directly after the abbreviation. For most variables, this is also
the abbreviation that you use to refer to the variable in other modules. However,
some variables are referred to with a different abbreviation in the POST module. If
this is the case, then this is noted at the bottom of the table.
Variables that are specific to a species, in which case the species is specified as an
argument (sp in the table below). If there are two or more sublattices in a given
phase, then this argument is given as constituent#sublattice. This indicates a
constituent on a specific sublattice or site in the phase (referred to by the # sign and
a digit). For example, y(BCC,C#2) stands for the site fraction of the C species on the
second sublattice site of the BCC_A2 solution phase.
The Unit column show which unit that you can use to express the variable in the POLY
module. This unit is always the SI unit. In other modules, state variables may be
expressed in other units.
The Suffix column shows the suffixes you can append to the variables. The R-suffix
can be used with all compositional extensive state variables, but the suffix does not
always change the value of the variable. This is indicated by putting the R in
parenthesis.

These types of variables are listed in the following topics:
l

Intensive Variables

l

Extensive Variables

l

Special Quantities

l

The u-Fraction Variable

l

Suffixes
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Intensive Variables
V

Abbrev.

Unit

Descript.

Domain

T

T1

K

Temperature

System

P

P

Pa

Pressure

System

MU(comp)
μ

J/mol
MU(sp,ph)2

Chemical
potential

AC(comp)
Activity
AC(sp,ph)2

a

LNAC
(comp)3

2

1

Component

R

Species
relative to a
solution
phase

R

Component

R

Species
relative to a
solution
phase

R

Component

R

Species
relative to a
solution
phase

R

N/A

ln(Activity)
LNAC (sp,ph)

Suffix

When plotting in POST, besides T (Kelvin), you can also use T_C or T_F to plot temperature in °C or °F.

2

Only for single-substitutional-lattice solution phases such as AQUEOUS solution and GASeous mixture
phases and for interacting species on the substitutional sublattice of two-sublattice solution phases (such as
the phases BCC_A2 and M6C phases).
3

In natural logarithm (lnAC=MU/RT)
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Extensive Variables
Energy-Related Extensive Variables for Whole System or for a Phase
V

Abbrev.

Unit

Descript.

Domain

Suffix

System

M, W, V, R

Phase

M, W, F, R

VP(ph) 2

Phase

M, W, V, R

G

System

M, W, V, R

Phase

M, W, V, F, R

System

M, W, V, R

Phase

M, W, V, F, R

System

M, W, V, R

Phase

M, W, V, F, R

System

M, W, V, R

Phase

M, W, V, F

System

M, W, V, R

Phase

M, W, V, F, R

System

R

Phase

R

System

R

V
V

V(ph)1

G

m3

J

Volume

Gibbs energy

G(ph) 1
A
A

J
A(ph) 1

Helmholtz
energy

U
U

J

Internal energy

U(ph) 1
H
H

J

Enthalpy6

H(ph)
S
S

J/K

Entropy6

S(ph) 1
HM.T3
Cp

J/mol/K
HM(ph).T3

Cv

HM.T4

J/mol/K

Heat capacity at
constant
pressure
Heat capacity at
constant volume
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V

Abbrev.

Unit

Descript.

HM(ph).T4

DG(ph) 5

D

1

Driving force
(thermodynamic
factor)

N/A

Domain

Suffix

Phase

R

Phase

Always use
with M, W, V
or F. R can also
be used.

For this variable, if the phase is unstable, then the variable gets a value of zero.

2

Do not use VP(ph) as a condition in POLY. Instead, use CHANGE_STATUS PHASE <PHASE>=FIX <AMOUNT>
where the fixed <AMOUNT> is roughly equal to VPF(ph), which cannot be directly evaluated or listed. If
the phase is unstable, then VP(ph) and its normalized quantities get zero value.
3

Use only if pressure has been set as a condition.

4

Use only if volume has been set as a condition.

5

Already divided by RT.

6

When working in the POST module you can also enter the abbreviation for this variable into the Console,
for example, enth or enthalpy, which corresponds to HM, and entr and entropy, which corresponds to SM.

Compositional Extensive Variables
These are for the overall amount of components in whole system, or amount of a
component in system or in a phase.
Do not use NP(ph) or BP(ph) as conditions in the POLY module. Instead use CHANGE_STATUS
PHASE <PHASE>=FIX <AMOUNT> where the fixed <AMOUNT> is roughly equal to NPF(ph) or
BPF(ph), which cannot be directly evaluated or listed. If the phase is unstable, then NP(ph) or
BP(ph) (and its normalized quantities) get zero value.
When plotting the following quantities in POST, refer to each as indicated:
l

X(comp) -> Mole-Fraction

l

W(comp) -> Weight-Fraction

l

X%(comp) -> Mole-Percent

l

W%(comp) -> Weight-Percent

l

u-f(ph,comp) -> U-F

<comp>

(or M_F)

<comp>

<comp>

(or W_F)

(or M_P)

<comp>

(or W_P).

Thermo-Calc User Guide: Console Mode ǀ 543 of 643

Thermo-Calc Documentation Set

V

Abbrev.

Domain

Suffix

N

All components

M, W, V,
(R)

N(comp)

Component

M, W, V,
(R)

N
(ph,comp)

Component in a
phase

M, W, V,
(R)

NP(ph)1

Phase

M, W, V,
(R)

B

All components

M, W, V,
(R)

B(comp)

Component

M, W, V,
(R)

B(ph,comp)

Component in a
phase

M, W, V,
(R)

BP(ph) 1

Phase

M, W, V,
(R)

See above

X(comp)

Component

(R)

See above

Component in a
phase

(R)

Component

(R)

Component in a
phase

(R)

n

Unit

mole

b

gram

x

N/A

Descript.

Moles

Mole fraction

W(comp)
W
(ph,comp)

N/A

See above

Mass

X(ph,comp)

w

Comment

Mass (weight)
fraction

See above

x%

X%(comp)2

N/A

Mole percent

Component

(R)

See above

w%

W%
(comp)2

N/A

Mass (weight)
percent

Component

(R)

See above

u

u-f
(ph,comp)1

N/A

u-fraction

Component in a
stable phase

(R)

See above
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V

Abbrev.

Unit

Descript.

Domain

Suffix

Comment

in

IN(sp)2

mole

Input mole
number

Phase species in the
system

(R)

See above

im

IM(sp)2

gram

Input mass unit

Phase species in the
system

(R)

See above

1

Do not use as a condition in the POLY module.

2

Only available in TQ-Interface and TC-API.

Constitutional Composition-Related Extensive Variable
This is the amount of a constituent/species on a sublattice site in a phase.
V

Abbrev.

Unit

Descript.

Domain

y

Y
(ph,cons#sub)

N/A

Site
fraction

Constituent on a sublattice site (denoted by # and
a digit) in a phase
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Special Quantities
Variable

Abbrev.

Unit

Description or
Example

Domain

Suffix
R

Q

QF(ph)1

n/a

Phase stability function

Phase

Under a condition
and system
definition, QFR
(ph) = QF(ph)
R

Tc

TC(ph) 2

K

Curie temperature

Phase

Under a condition
and system
definition, TCR
(ph) = TC(ph)
R

Mb

D1G

BMAG(ph)3

D1G(phase,
site-fraction)

n/a

n/a

Bohr magneton number

For example, D1G(FCC_
A1#1, Cr#1) for first
derivative of G for first
composition set of FCC_
A1 phase with respect to
Cr site fraction on first
sublattice.

Phase

Under a condition
and system
definition,
BMAGR
(ph) = BMAG(ph)

Phase

n/a

Phase

n/a

Search for
TQGMDY in the
TQ-Interface
Guide

D2G

D2G(phase,
site-fraction,
site-fracton)

n/a

For example, D2G(FCC_
A1#2, Cr#1, Cr#1) for
second derivative of G for
second composition set
of FCC_A1 phase with
respect to Cr site fraction
on first sublattice.

Thermo-Calc User Guide: Console Mode ǀ 546 of 643

Thermo-Calc Documentation Set

Variable

Abbrev.

Unit

Description or
Example

Domain

Suffix

Search for
TQDGYY in the TQInterface Guide
1

Negative when phase composition is inside a spinodal, otherwise positive. Can be used to find out if an
equilibrium is within the miscibility gap for a solution phase. Cannot be used as a condition.
2

Calculated for phases with magnetic contributions in an equilibrium state. Cannot be used as a condition,
but can be plotted in POST or evaluated in POLY using SHOW_VALUE.
3

Calculated for phases with magnetic contributions in an equilibrium state.

n/a = not applicable
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The u-Fraction Variable
The u-fraction is an important quantity in some single-point or stepping paraequilibrium
calculations in the POLY module and in the DICTRA module. You can apply the variable in a
paraequilibrium calculation to the substitutional matrix component, the substitutional
alloying components or the interstitial component. The u-fraction is denoted as ui for the i-th
system component n of a whole system or of a specific phase in various equilibrium states
(such as full-equilibria, partial-equilibria, para-equilibria, local-equilibria).
Generally, the u-fraction is defined as:

The sum of in the denominator is calculated for all substitutional alloying elements in the
whole system or in a specific phase. The variable in the numerator stands for the molefraction of the i-th component in the whole system or in the specific phase.
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Suffixes
Suffixes may be appended to all extensive variables and to some intensive variables. Some
suffixes can be used to enter the value of variables in normalized form. These are referred
to as normalizing suffixes. If the variable that you create with a normalizing suffix is based
on a state variable that can be set as a condition in POLY, then the normalized variable can
also be set as a condition in POLY.
The normalizing suffixes are M (per mole), W (per mass in gram), V (per volume in m3) and
F (per mole formula unit). There is also a reference state suffix R, which you can use if you
want the value of a thermodynamic variable to be calculated with respect to a reference
state that have previously set.

Normalizing Suffixes
When variables that express system and phase quantities are normalized, the following
general rules are used:
l
l

System quantities are normalized by the total system size (in terms of N, B or V).
Phase quantities are normalized by the phase amount [in terms of NP(ph), BP(ph) or
VP(ph)].

The normalized quantities of G(ph), A(ph), U(ph), H(ph), S(ph) and V(ph) are calculated
according to the thermodynamic model used for the phase (e.g. GM(ph), AM(ph), UM(ph),
HM(ph), SM(ph) and VM(ph)). These quantities are calculated using the first derivatives of
the Gibbs energy expressed for the phase with respect to the current composition of the
system.
The tables describe the normalizing suffixes for the different state variables.

G, A, U, H, S and V of a Whole System
Suffix

Description

M (per mole)

Total system size in terms of
N.

W (per mass in
gram)

The total system size in terms
of B.

Example
GM is the Gibbs energy per mole of the system
(J/mol).

GW is the Gibbs energy per mass of the system
(J/g).
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Suffix

V (per volume in
m3)

Description

Example

The total system size in terms
of V.

GV is the Gibbs energy per volume of the system
(J/m3).

VV does not have to be
evaluated.

G(ph), A(ph), U(ph), H(ph), S(ph) and V(ph) of a Phase
Suffix

Example
For example, GM(ph) is Gibbs energy of the phase per mole of the phase (J/mol).

M (per mole)

For example, GW(ph) is Gibbs energy of the phase per mass of the phase (J/mol).
W (per mass in gram)

V (per volume in m3)

F (per mole formula
unit)

For example, GV(ph) is Gibbs energy of the phase per volume of the phase
(J/mol).

For example, GF(ph) is the Gibbs energy of the phase per formula unit of the
phase (J/mol).

DG(ph) of a Phase
Suffix

Description

Example(s)

M (per
mole)

Theoretically, the first derivative of the variable with regard to the phase
amount in terms of NP(ph). Since DG(ph) is not directly calculated, the
second derivative of the Gibbs energy expressed for the phase in question
with respect to the current compositions in the equilibrium state of the
system is calculated instead.

DGM(ph) is
driving force
for
precipitation
of the phase
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Suffix

Description

Example(s)

DGM(ph) cannot not be set as a condition since it is only calculated under a
certain type of equilibrium state.

W (per
mass in
gram)

Theoretically, the first derivative of the variable with regard to the phase
amount in terms of BP(ph). Since DG(ph) is not directly calculated, the
second derivative of the Gibbs energy expressed for the phase in question
with respect to the current compositions in the equilibrium state of the
system is calculated instead.
DGW(ph) cannot not be set as a condition since it is only calculated under a
certain type of equilibrium state.

V (per
volume
in m3)

Theoretically, the first derivative of the variable with regard to the phase
amount in terms of VP(ph). Since DG(ph) is not directly calculated, the
second derivative of the Gibbs energy expressed for the phase in question
with respect to the current compositions in the equilibrium state of the
system is calculated instead.
DGV(ph) cannot not be set as a condition since it is only calculated under a
certain type of equilibrium state.

F (per
mole
formula
unit)

Theoretically, the first derivative of the variable with regard to the phase
amount in terms of NP(ph) and NA (NA is the total atomic number in the
phase formula). Since DG(ph) is not directly calculated, the second
derivative of the Gibbs energy expressed for the phase in question with
respect to the current compositions in the equilibrium state of the system
is calculated instead.
DGF(ph) cannot not be set as a condition since it is only calculated under a
certain type of equilibrium state.

per mole of
components.

DGW(ph) is
driving force
for
precipitation
of the phase
per mass of
components.

DGV(ph) is
driving force
for
precipitation
of the phase
per volume of
components.

DGF(ph) is
driving force
for
precipitation
of the phase
per formula
unit of
components.

N and B of a System
Suffix

M (per mole)

Description

Example(s)

The total system size in
terms of N.

BM is mass (gram) of components per mole of the
system (g/mol).

NM does not have to be
evaluated.
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Suffix

Description

Example(s)

BM cannot be set as a
condition.
The total system size in
terms of B.
W (per mass in
gram)

BW does not have to be
evaluated.

NW is mole number of components per mass of the
system (mol/g).

NW cannot be set as a
condition.

V (per volume
in m3)

The total system size in
terms of V.
BV is the density of the
entire system.

NV is mole number of components per volume of the
system (mol/m3).

BV is the density of the entire system (g/m3).

N (comp) and B(comp) of a Component in the System
Suffix

M (per
mole)

W (per
mass in
gram)

V (per
volume in
m3)

Description

Example(s)

The total system size
in terms of N.

NM(comp) is the mole of a component per mole of the system (i.e.
mole fraction, which also is expressed as X(comp)).

BM(comp) cannot be
set as a condition.
The total system size
in terms of B.

BW(comp) is mass (gram) of a component per mass of the system
(i.e. mass fraction, which also is expressed as W(comp)).

NW(comp) cannot
be set as a condition.

The total system size
in terms of V.

NV(comp) is mole number of a component per volume of the
system (mol/m3).

NP(ph), BP(ph) and VP(ph) of a Phase in the System
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Suffix

Description

Example(s)
BPM(ph) is mass (gram) of a phase per moles of
the system (g/mol).

M (per
mole)

BPM(ph) and VPM(ph): The phase
amount in terms of NP(ph).
NPM(ph): The total system size in
terms of N.

NPM(ph) is number of moles of a phase per
moles of the system (mole fraction).

VPW(ph) is volume (m3) of a phase per mass of
the system (m3/g)
W (per
mass in
gram)

NPW(ph) and VPW(ph): The phase
amount in terms of BP(ph).
BPW(ph):The total system size in
terms of B.

BPW(ph) is mass (gram) of a phase per mass of
the system (mass fraction)

NPV(ph) is number of moles of a phase per
volume of the system (mol/m3).
V (per
volume in
m3)

NPV(ph) and BPV(ph): The phase
amount in terms of VP(ph).
VPV(ph): The total system size in
terms of V.

VPV(ph) is volume (m3) of a phase per volume of
the system (volume fraction).

N(ph,comp) and B(ph,comp) of a Component in a Phase
Suffix

Description

M (per
mole)

The phase amount in
terms of NP(ph) of
the phase.

W (per
mass in
gram)

The phase amount in
terms of BP(ph) of
the phase.

Example(s)
NM(ph,comp) is number of moles of a component per mole of a
phase (i.e. mole fraction of a component in a phase, which is
equivalent to X(ph, comp)).

BW(ph,comp) is mass (gram) of a component per mass of a phase
(i.e. mass fraction of a component in a phase, which is equivalent to
W(ph,comp)).
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Suffix

Description

V (per
volume
in m3)

The phase amount in
terms of VP(ph) of
the phase.

Example(s)

NV(ph,comp) is mole number of a component per volume of a phase
(mol/m3).

The Reference State Suffix R
You can use the reference state suffix R for some thermodynamic variables to calculate their
value with respect to a reference state that you have previously set for a system component
with the SET_REFERENCE_STATE command in POLY (or in a response-driven modules such as
the POURBAIX module). The value of energy-related variables that are used with the R suffix
depends on the reference states of all the components in the defined system.
It is possible to use an R suffix on all compositional extensive state variables as
well, but the value of the state variable is always the same, with or without the
suffix.
If the reference state for a system component is the default reference state (the stable
reference state (SER) which is defined in a Thermo-Calc database), then MUR(comp)= MU
(comp), ACR(comp)= AC(comp) and LNACR(comp)= LNAC(comp).
In the case of some thermodynamic variables, you can also use the R suffix to express
chemical potentials and activities of species relative to some single-substitutional-lattice
solution phases (such as aqueous solution, gaseous mixture, metallic liquid solution, slag
mixture or MO solid solution). These state variables are MU(sp,ph), MUR(sp,ph), AC(sp,ph),
ACR(sp,ph), LNAC(sp,ph) and LNACR(sp,ph).
The reference states and standard states of various solution species are pre-defined for
some solution phases in some databases. For all solution species in any solution model in any
database, it is always the case that MUR(sp,ph)= MU(sp,ph), ACR(sp,ph)= AC(sp,ph) and
LNACR(sp,ph)= LNAC(sp,ph).
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Thermophysical Properties Variables
The Thermo-Calc databases have a variety of properties data included such as molar
volume, thermal conductivity, dynamic and kinematic viscosity, thermal resistivity, and
surface tension. These properties data are being integrated into databases as each new
version of a database is released.

Availability of properties data is dependent on both the database and its
version. Some information is specific to use in Console Mode. There is more
information also available for Graphical Mode and TC-Python for each of the
databases where the properties data is included. More advanced information is
also contained in the Database Manager User Guide PARAMETER section
included with this documentation set.

To determine if the database you are using has this properties data, search the
help (press F1) to review the technical information. The availability of
properties data is also included with the Database Overview document
available on the Thermo-Calc website.

V

Abbrev.

Unit

Descript.

Domain

DVIS

DVIS(ph)

Pa·s

Dynamic viscosity

Liquid phase

KVIS

KVIS(ph)

m2/s

Kinematic viscosity

Liquid phase

ELRS

ELRS

Ωm

Electric resistivity

System

ELRS

ELRS(ph)

Ωm

Electric resistivity

Phase

ELCD

ELCD

S/m

Electric conductivity

System

ELCD

ELCD(ph)

S/m

Electric conductivity

Phase

THCD

THCD

W/(mK)

Thermal conductivity

System

THCD

THCD(ph)

W/(mK)

Thermal conductivity

Phase
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V

Abbrev.

Unit

Descript.

Domain

THRS

THRS

mK/W

Thermal resistivity

System

THRS

THRS(ph)

mK/W

Thermal resistivity

Phase

THDF

THDF

m2/s

Thermal diffusivity

System

THDF

THDF(ph)

m2/s

Thermal diffusivity

Phase

SURF

SURF(ph)

J/m2

Surface tension

Liquid phase
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Derived Variables and Partial Derivatives
Many derived variables can be obtained easily by using partial derivatives of state variables,
such as heat capacity, thermal expansivity, isothermal compressibility, among others.
Derivatives of state variables can be defined or evaluated by putting a dot (.) between two
state variables. The variable after the dot must be a condition that you have set when you
defined your system. For example, the heat capacity (at constant pressure or volume) of a
system is the partial derivative of the state variable enthalpy with respect to temperature.
To evaluate this derivative, use the designation HM.T, where temperature is a state variable
that you have set already.
Any partial derivative of a state variable with respect to another can be defined or evaluated
as a derived variable by using the dot (.) notation.

Derived Variables Dot Notation Examples
The following table shows some examples:
Derived
variable

Description
Heat capacity for the system at either constant P if pressure is a condition or constant V if
volume is a condition.
Heat capacity for a phase at either constant P if pressure is a condition or constant V if
volume is a condition.
Heat capacity for the system multiplied by total mole number of components, i.e.,
if pressure is a condition in a closed system or
if volume is a
condition in a closed system.
Heat capacity for a phase multiplied by the sum of

and

, i.e.,

if pressure is a condition or
if volume is a condition.
Thermal expansivity of the system (already multiplied by the total molar volume), i.e.,
.
Thermal expansivity of a phase (already multiplied by its molar volume), i.e.,
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Derived
variable

Description
.
Thermal expansivity of the system (already multiplied by the total volume), i.e.,
.
Thermal expansivity of a phase (already multiplied by the phase volume) plus the
term, i.e.,
.
Isothermal compressibility of the system (already multiplied by the total molar volume), i.e.,
.
Isothermal compressibility of a phase (already multiplied by its molar volume), i.e.,
.
Isothermal compressibility of the system (already multiplied by the total volume), i.e.,

Isothermal compressibility of a phase (already multiplied by the phase volume) plus the
term, i.e.,
.
Slope of a phase boundary on a T-X(comp) phase diagram with respect to mole fraction of
the component in the system.
Slope of a phase boundary on a T-W(comp) phase diagram with respect to mass of the
component in the system.
Slope of a phase boundary on a T-X(ph,comp) phase diagram with respect to mole fraction of
the component in the phase.
Slope of a phase boundary on a T-W(ph,comp) phase diagram with respect to mole fraction
of the component in the phase.
Slope of a phase boundary on a P-T phase diagram (Note that the equilibrium with phase
assemblage must be calculated first).
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Defining New Derived Variables and Functions
You can define additional derived variables or functions based on a state variable by using
ENTER_SYMBOL. Any derived variable or function must have a unique name that starts with a
letter and has a maximum number of eight characters. These characters can include both
uppercase and lowercase letters, numerical digits and the underscore (_). No other
characters are allowed.
The difference between new derived variables introduced with the ENTER_SYMBOL
command and new functions introduced with the same command is as follows. Whenever
Thermo-Calc calculates the value of a function (as part of an equilibrium calculation for
example), all functions related to the defined system is evaluated. An entered derived
variable, on the other hand, is only evaluated when it is defined and when it is re-evaluated
with EVALUATE_FUNCTIONS.

Derived Variables for Aqueous Solutions
Standard state variables used for other phases can be directly applied to the aqueous
solution phase. In addition, there are pre-defined derived variables for the aqueous solution
phase in particular.
Examples of predefined derived variables for the aqueous solution phase are listed and
briefly described in the following tables. Some derived variables for a gaseous mixture
phase are also shown. This is because EOS (Equation of State) expressions, standard
thermodynamic properties and transport properties of the pure solvent H2O are also
expressions and properties of the pure gaseous species H2O.

For Aqueous Solution Phase
Name

Abbrev.

Units

Description

Comments

pH

PH

N/A

Acidity

Eh

EH

V, mV

Hypothetical
electric
potential

of the aqueous solution phase

Pe

PE

N/A

Logarithm of
the hypothetical
electron activity

of the aqueous solution phase

of the aqueous solution phase
pH = -log10(AC(H+)) = -log10(ACR(H+,AQ))

Eh = u(ZE)/96485.309

pe = u(ZE)/(2.3025851*RT)
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Name

Abbrev.

Units

Description

Comments

Ah

AH

kJ, kcal

Thermodynamic
affinity per
electron

of a redox couple wrt the standard hydrogen
electrode in the aqueous solution phase

yw

YH2O

N/A

Mole fraction

Ah = u(ZE)
of the solvent H2O in the aqueous solution
phase
YH2O = Y(AQ,H2O)

Nw

AH2O

mole

Mole number,

NSH2O
Nsp

Mole number

NS(AQ,H2O)

Mole number,
NS(AQ,sp)

of the solvent (H2O) in the aqueous solution
phase
NS(AQ,H2O) = YH2O*NP(AQ)

NS(AQ,sp) = Y(AQ,sp)*NP(AQ)
of a solute species in the aqueous phase

ML(AQ,sp)

ML(AQ,sp) = Y(AQ,sp)*AH2O/YH2O

mol/kg_
H2O

m*

TIM

equivalent
molality

Total molality

mt

TIC#

equivalent
molality

Total ionic
concentration,
TIC(AQ,sp)

I

ISTR

N/A

Ionic strength

N/A

Activity
coefficient,

RCH2O

of a solute species in the aqueous solution
phase

Molality,

ML#

γ

AH2O = 55.508435

mole
NS#

M

of 1.0 kg of solvent H2O

RC(H2O,AQ)

of all solute species in the aqueous solution
phase
TIM = sum[ML(AQ,sp)]ions + sum[ML
(AQ,sp)]complexes
of a cation I in the aqueous phase
TIC(AQ,spI) = sum[ML(AQ,spJ)*V(spI-in-spJ)]
of the aqueous solution phase
ISTR=1/2*sum[ML(AQ,sp)*Z(AQ,sp)**2]
of the solvent (H2O)
RC(H2O,AQ) = ACR(H2O,AQ)/YH2O

Thermo-Calc User Guide: Console Mode ǀ 560 of 643

Thermo-Calc Documentation Set

Name

Abbrev.

Units

RC#

Description

Comments

Activity
coefficient,

of a solute species

RC(sp,AQ)
Activity,

AIH2O

AI(H2O,AQ)
Activity,

AI#
αi

AI(sp,AQ)
N/A

Log10 Activity,
LogAI(H2O,AQ),

LogAI#

LogAI(sp,AQ)

RC(sp,AQ) = ACR(sp,AQ)/Y(AQ,sp)*YH2O
of the solvent (H2O),
AI(H2O,AQ) = ACR(H2O,AQ)
of a solute species related to the aqueous
solution phase,
AI(sp,AQ) = ACR(sp,AQ)*AH2O
of the solvent or a solute species related to
the aqueous solution phase in common
logarithm,
LogAI(H2O,AQ) = log10[AI(H2O,AQ)]
LogAI(sp,AQ) = log10[AI(sp,AQ)]

αw

AW

N/A

Activity

ɸ

OS

N/A

Osmotic
coefficient

AT1

equil_
mol/kg_
H2O

Titration
alkalinity
(definition 1)

AT2

equil_
mol/kg_
H2O

Titration
alkalinity
(definition 2)

At1

At2

of H2O in the aqueous solution phase
AW = ACR(H2O,AQ)
of aqueous solution phase
OS = -55.508435*lnAW/TIM
of the aqueous solution phase
Generally defined as the equivalent molality
of carbonate and bicarbonate at the methyl
orange endpoint (pH=4.5).
of the aqueous solution phase
Generally defined as the equivalent molality
of carbonate and bicarbonate, plus sulfide, at
the methyl orange endpoint (pH=4.5).

For Gaseous Mixture Phase
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Name

Abbrev.

Units

Description

Comments

RA#

N/A

Activity
coefficient,

of a gaseous species in the gaseous mixture

γ

RA(sp,GAS)

γ*

RF#

N/A

Fugacity
coefficient,
RF(sp,GAS)

F

FUG#

pa, bar,
psi

ft

TFUG

pa, bar,
psi

Fugacity,
FUG(sp,GAS)

Total gas fugacity

RA(sp,GAS) = function(Y,T,P)

of a pure gaseous species under TP
RF(sp,GAS) = function(T,P/V)
of a gaseous species in the gaseous mixture
FUG(sp,GAS) = RA(sp,GAS)*RF(sp,GAS)*Y
(GAS,sp)*P
of the gaseous mixture phase
TFUG = sum[FUG(sp,GAS)]

Defining New Derived Variables for Aqueous Solutions
You can define many different additional derived variables and functions. For instance, the
partition coefficient of a component between two phases is defined as follows:
Pc<name> = X(phase1,component)/X(phase2,component)

Another example is the activity coefficient of a component in the system. It is defined as
follows:
Rc<name> = ACR(component)/X(component)

The activity coefficient of a species in a solution phase depends on which model definitions
on the reference states that are used and it depends on the standard states for the species. If
the standard state of a species is defined to be the same as the pure species in a
substitutional phase, then the activity coefficient of the species can be calculated as:
RC<name> = ACR(species,phase)/Y(phase,species)

In some cases, there are more than one sublattice in the phase and the reference states for
the phase species cannot be presented by the pure species, as in the case of C in FCC [(Fe)1
(C,N,VA)1], where the model may end at fifty percent C and fifty percent Fe. In those cases,
the chemical potential and activity of all phase constituents is not well defined and you
cannot properly define the activity coefficients of the species in the phase.
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For an aqueous solution phase, no matter what model is used, the reference state and
standard state for both the solvent and solutes are defined in a special way in the ThermoCalc software. The reference state for the solvent is set as pure water, the same as its
standard state (according to Raoults's Law). The standard state for a solute species is set the
hypothetical solute species, whilst its reference state is defined as the hypothetical state at
unit molality (one mole dissolved into 1.0 kg of solvent) but in which the environment of
each molecular is the same as at infinite dilution (according to Henry's Law). Under these
definitions, the activity coefficients for solvent species can be calculated as follows:
RC<H2O> = ACR(H2O,aqueous)/ Y(aqueous,H2O)

The coefficients for the solute species can be calculated as follows:
RC<spec> = AI(species,aqueous)/ML(aqueous,species)
= ACR(species,aqueous)/ Y(aqueous,species)*Y(aqueous,H2O)

AI is here the activity of solute species calculated from the model, and ML is the molality of
the species.

Thermodynamic Variables and Wildcard Characters
The ACR (species,phase) and the MUR (species,phase) quantities can only be appropriately
and meaningfully applied to substitutional solution phases (such as GAS, AQUEOUS, LIQUID)
and to solution phases without an interstitial sublattice set. This means that the wild card
characters * and $ normally don’t work properly for the activity and/or chemical potential
properties.
For example, do not use ACR(*,*) or MUR(*,*) for all the species relative to all phases, nor
ACR(*,phase) or MUR(*,phase) for all the species relative to a specific phase, nor ACR
(species,*) or MUR(species,*) for a specific species relative to all phases.
Instead, use specific names for species and (applicable) phase, as in the following examples:
SHOW_VALUE acr(fe+2,aqueous)Lists activity of the Fe+2 species in AQUEOUS solution
phase
SHOW_VALUE mur(c2,gas)Lists chemical potential of the C2 species in GAS mixture
phase
SET_AXIS_VAR y ac(o2,gas)Sets activity of the O2 species in GAS mixture phase as Yaxis
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Units of State Variables and Derived Variables
The units for the state variables in the Units column in the table in User-Specified Units are
the SI units that are used in the POLY module. However, in the POST module, you can both
use pre-defined symbols and define your own symbols which are based on state variables
and derived variables. By doing this, you can express the value of the thermodynamic
variables in non-default units. The following topic briefly describes how you can create your
own symbols and suggests expressions that you can use to convert default units into other
standard units which are not default units in Thermo-Calc.
The topic Examples of User-Defined Units describes some variables of specific species in a
phase and the units in which they are expressed. These variables are not used in POLY or
POST, but in the GIBBS, DATA, PARROT and ED_EXP modules.
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User-Specified Units
You do not always need to use the default units for variables. Using ENTER_SYMBOL, you
can convert the value of variable from the default unit to your preferred unit. (Some
response-driven modules also allow you to set conditions in non-default units.) User-defined
symbols in the form of functions can be used for plotting in the POST module, but they
cannot be used as conditions in POLY. User defined symbols in the form of variables can be
used as conditions.
For example, if you want pressure to be plotted in bar rather than Pa, then you define the
following function PB:
Enter_symbol function PB = P/1E5 ;

If you wanted heat capacity of a system to be shown as in terms of J/mol/K, then you can
define the following function Cp:
Enter_symbol function Cp = Hm.T ;

If the variable you want to convert is a function of one or more derivatives, then you must
enter the symbol as a variable rather as a function. For instance, a symbol expressing heat
capacity of a system in a unit of cal/mol/K can be defined as the following variable Cp2:
Enter_symbol variable Cp2 = Hm.T/4.1858 ;

Examples of User-Defined Units for information about entering conventional functions
and the associated units.
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Examples of User-Defined Units
The following tables give examples of expressions you can use to enter symbols. This enables
you to show the values of thermodynamic variables in a variety of units.
Units of State Variables and Derived Variables and User-Specified Units
You can also use thermodynamic variables with normalizing suffixes in the
expression when you enter a symbol. However, the tables do not have examples
of these expressions.
In the expressions these are defined as follows:
l

i

is for an auxiliary index or letter that corresponds to the component c

l

j

is for an auxiliary index or letter that corresponds to the phase ph, and

l

ij

stands for an auxiliary index or letter that corresponds to the component c in the
phase ph.

Intensive and Extensive Variables of a Defined System
Quantity

Suggested name and expression

Unit

For intensive variables of a defined system
TempC = T-273.15
Temperature

Celsius (C)

TempF = 1.8*T-459.67
Fahrenheit (F)
TempF = 1.8*TempC+32
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Quantity

Suggested name and expression

Unit

PB = P/1E5

bars (bar)

PKb = P/1E8

kilobars (kbar)

PAtm = P/101325

atmosphere (atm)

PSI = P/6894.76

pounds/sq. inch (psi)

PIHg = P/3342.11

inches of Hg

PTor = P/133.322

Tors (millimeters of Hg)

Pressure

For extensive variables of a defined system
BKg = 1E-3*B

kilograms (kg)

BTon = 1E-6*B

tons

VDM = 1E-3*V

cubic decimeters (dm3, l)

VCM = 1E-6*V

cubic centimeters (cm3)

VMM = 1E-9*V

cubic millimeters (mm3)

VCI = 1.6387064E-5*V

cubic inches (in3)

VLi = 1E-3*V

liters (l)

GCal = G/4.1858

cal

ACal = A/4.1858

cal

UCal = U/4.1858

cal

HCal = H/4.1858

cal

SCal = S/4.1858

Cal/K

Amount

Volume

Energy
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Quantity

Heat Capacity

Suggested name and expression

Unit

Cp2 = HM.T/4.1858

cal/mol/K

Cp3 = HW.T/4.1858

cal/g/K

Cp4 = HV.T/4.1858

cal/m3/K

A2 = VM.T*1E-6*VM

cm3/mol/K

A3 = VW.T*1E-6*VM

cm3/g/K

B2 = -VM.P*1E-9*VM

mm3/mol/Pa

B3 = -VW.P*1E-9*VM

mm3/g/Pa

Thermal Expansion

Isothermal Compressibility

Intensive and Extensive Variables of a System Component
Quantity

Suggested name and expression

Unit

For intensive variables of a system component
MUi = MU(c)/4.1858

cal/mol

MURi = MUR(c)/4.1858

cal/mol

pH = -LOG10(ACR(H+1))

dimensionless

Eh = MUR(ZE)/RNF where RNF=96485.309

volts (V)

Chemical Potential

Special quantity for aqueous
solution

For extensive variables of a system component
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Quantity

Suggested name and expression

Unit

MFi = N(c)/N = X(c)

dimensionless

MPi = N(c)/N*100

dimensionless

WFi = B(c)/B = W(c)

dimensionless

WPi = B(c)/B*100

dimensionless

BKgi = 1E-3*B(c)

kilograms (kg)

BToni = 1E-6*B(c)

tons

Amount

Extensive Variables of a Phase
Quantity

Suggested name and expression

Unit

MFj = NP(ph)/N

dimensionless

MPj = NP(ph)/N*100

dimensionless

WFj = BP(ph)/B

dimensionless

WPj = BP(ph)/B*100

dimensionless

BKgj = 1E-3*BP(ph)

kilograms (kg)

BTonj = 1E-6*BP(ph)

tons

VCMj = 1E-3*V(ph)

cubic decimeters (dm3, l)

VCMj = 1E-6*V(ph)

cubic centimeters (cm3)

VMMj = 1E-9*V(ph)

cubic millimeters (mm3)

Amount

Volume
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Quantity

Suggested name and expression

Unit

GCalj = G(ph)/4.1858

cal

ACalj = A(ph)/4.1858

cal

UCalj = U(ph)/4.1858

cal

HCalj = H(ph)/4.1858

cal

SCalj = S(ph)/4.1858

Cal/K

DG2j = DGM(ph)/4.1858

cal/mol

DG3j = DGW(ph)/4.1858

cal/g

DG4j = DGV(ph)/4.1858

Cal/m3

DG5j = DGF(ph)/4.1858

cal/mole_formula_unit

Cp2j = HM(ph).T/4.1858

cal/mol/K

Cp3j = HW(ph).T/4.1858

cal/g/K

Cp4j = HV(ph)/.T/4.1858

cal/m3/K

Cp5j = HF(ph)/.T/4.1858

cal/mole_formula_unit/K

Thermal Expansion

A2j= VM(ph).T/VM(ph)

1/K

Isothermal Compressibility

B2j = -VM(ph).P/VM(ph)

1/Pa

Energy

Driving Force

Heat Capacity

Extensive Variables of a Component in a Phase
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Quantity

Suggested name and expression

Unit

MFij = N(ph,c)/NP(ph) = X(ph,c)

dimensionless

MPij = N(ph,c)/NP(ph)*100

dimensionless

WFi = B(ph,c)/BP(ph) = W(ph,c)

dimensionless

WPij = B(ph,c)/BP(ph)*100

dimensionless

BKgij = 1E-3*B(ph,c)

kilograms (kg)

BTonij = 1E-6*B(ph,c)

tons

Amount

Intensive and Extensive Variables of a Species in a Phase
Quantity

Suggested name and expression

Unit

For intensive variables of a species in a phase
MUCalij = MU(sp,ph)/4.1858

cal/mol

MUErgij = MU(sp,ph)*1E7

cal/mol

FAij = AC(sp,ph)*PATM

atmosphere
(atm)

FBij = AC(sp,ph)*PB

bars (bar)

FCij = AC(sp,ph)*PKB

kilobars (kbar)

FTij = AC(sp,ph)*PTOR

Tors
(millimeters
of Hg)

LnFAij = LNAC(sp,ph)+LN(PATM)

atmosphere
(atm)

LnFBij = LNAC(sp,ph)+LN(PB)

bars (bar)

Chemical Potential

Fugacity

ln(Fugacity)
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Quantity

Suggested name and expression

Unit

LnFCij = LNAC(sp,ph)+LN(PKB)

kilobars (kbar)

LnFTij = LNAC(sp,ph)+LN(PTOR)

Tors
(millimeters
of Hg)

AIij=ACR(FE+3,AQ)*AH2O

dimensionless

RCij=ACR(FE+3,AQ)*YH2O/Y(AQ,FE+3)
Special quantity for
aqueous solution

where AH2O=55.508435 and YH2O=Y(AQ,H2O)

dimensionless

WRCalij = WR(AQ,sp)/4.1858
(WR(AQ,sp) is only valid for aqueous species in a system in
which the AQUEOUS solution phase is considered)

cal/mol

For extensive variables of a species in a phase
MLij=Y(AQ,FE+3)*AH2O/YH2O
Special quantity for
aqueous solution

molality (m)

ISTR=1*IS1+1*IS2+1*IS3
where AH2O=55.508435, YH2O=Y(AQ,H2O) and
ISn=.5*MLi*Zi**2+.5*MLj*Zj**2+.5*MLk*Zk**2

molality (m)

Units for Variables of Specific Species in a Phase
In the GIBBS, DATA, PARROT and ED_EXP modules, there are quantities that describe various
thermodynamic, physical, chemical and transport properties for a compound phase, and for
a certain species or a given species combination in a specific solution phase. The following
table describes the units for those variables.
These variables cannot be directly used in the POLY or POST modules.
Variables
G(ph,sp)
G(ph,sp;0)

Description and unit
Gibbs energy (J/mol) of a pure substance or end-member.
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Variables

Description and unit

G(ph,sp1;sp2;...;0)
G(ph,sp1,sp2,...)
L(ph,sp1,sp2,...)
G(ph,sp1,sp2,...;0)
L(ph,sp1,sp2,...;0)

Zero-order interaction parameter (J/mol) of a specified binary, ternary or higherorder interactions on a certain sublattice site in a solution phase.

G
(ph,sp1,sp2,...;...;0)
L
(ph,sp1,sp2,...;...;0)
G(ph,sp1,sp2,...;i)
L(ph,sp1,sp2,...;i)
G
(ph,sp1,sp2,...;...;i)

The ith -order interaction parameter (J/mol) of a specified binary, ternary or higherorder interactions on a certain sublattice site in a solution phase.

L
(ph,sp1,sp2,...;...;i)
TC(ph,sp)
TC(ph,sp;0)

Curie temperature (K) of a pure substance or end-member.

TC
(ph,sp1;sp2;...;0)
TC(ph,sp1,sp2,...)
TC(ph,sp1,sp2,...;0)
TC
(ph,sp1,sp2,...;...;0)
TC(ph,sp1,sp2,...;i)
TC
(ph,sp1,sp2,...;...;i)

Zero-order Curie-temperature contribution (K) to a specified binary, ternary or
higher-order interactions on a certain sublattice site in a solution phase.

The ith -order Curie-temperature contribution (K) to a specified binary, ternary or
higher-order interactions on a certain sublattice site in a solution phase.

BMAGN(ph,sp)
BMAGN(ph,sp;0)

Bohr magneton number (dimensionless) of a pure substance or end-member.

BMAGN
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Variables

Description and unit

(ph,sp1;sp2;...;0)
BMAGN
(ph,sp1,sp2,...)
BMAGN
(ph,sp1,sp2,...;0)

Zero-order Bohr magneton number (dimensionless) to a specified binary, ternary or
higher-order interactions on a certain sublattice site in a solution phase.

BMAGN
(ph,...;sp1,sp2,...;0)
BMAGN
(ph,sp1,sp2,...;i)
BMAGN
(ph,sp1,sp2,...;...;i)

The ith -order Bohr magneton number (dimensionless) to a specified binary, ternary
or higher-order interactions on a certain sublattice site in a solution phase.

V0(ph,sp)
V0(ph,sp;0)

Molar volume (m3) at 1 bar and reference T0 of a pure substance or end-member.

V0
(ph,sp1;sp2;...;0)
V0(ph,sp1,sp2,...)
V0
(ph,sp1,sp2,...;0)

Zero-order composition-dependent molar volume (m3) of a specified binary,
ternary or higher-order interactions on a certain sublattice site in a solution phase.

V0
(ph,sp1,sp2,...;...;0)
V0(ph,sp1,sp2,...;i)
V0
(ph,sp1,sp2,...;...;i)

The ith-order composition-dependent molar volume (m3) of a specified binary,
ternary or higher-order interactions on a certain sublattice site in a solution phase.

VA(ph,sp)
VA(ph,sp;0)

Integrated thermal expansivity (m3/mol/K) of a pure substance or end-member.

VA
(ph,sp1;sp2;...;0)
VA(ph,sp1,sp2,...)
VA
(ph,sp1,sp2,...;0)

Zero-order composition-dependent thermal expansivity (m3/mol/K) of a specified
binary, ternary or higher-order interactions on a certain sublattice site in a solution
phase.
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Variables

Description and unit

VA
(ph,sp1,sp2,...;...;0)
VA(ph,sp1,sp2,...;i)
VA
(ph,sp1,sp2,...;...;i)

The ith -order composition-dependent thermal expansivity (m3/mol/K) of a
specified binary, ternary or higher-order interactions on a certain sublattice site in a
solution phase.

VC(ph,sp)

High pressure fitting parameter (m3/mol) of a pure substance or endmember.

VC(ph,sp1,sp2,...)

Zero-order composition-dependent high pressure fitting parameter (m3/mol) of a
specified binary, ternary or higher-order interactions on a certain sublattice site in a
solution phase.

VC(ph,sp1,sp2,...i)

The ith -order composition-dependent high pressure fitting parameter (m3/mol) of
a specified binary, ternary or higher-order interactions on a certain sublattice site in
a solution phase.

VK(ph,sp)

Isothermal compressibility (m3/mol/Pa) of a pure substance or endmember.

VK(ph,sp1,sp2,...)

Zero-order composition-dependent isothermal compressibility (m3/mol/Pa) of a
specified binary, ternary or higher-order interactions on a certain sublattice site in a
solution phase.

VK(ph,sp1,sp2,...i)

The ith -order composition-dependent isothermal compressibility (m3/mol/Pa) of a
specified binary, ternary or higher-order interactions on a certain sublattice site in a
solution phase.

WR(ph,sp)
WR(ph,sp;0)

Standard Born function (J/mol) of a specific aqueous species in the AQUEOUS
solution phase (always with a single sublattice) under the reference-state
temperature and pressure.
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Technical Notes
In this section:
Technical Note: Pipe or Redirect Output Data from Console Mode

577
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Technical Note: Pipe or Redirect Output Data from
Console Mode
Audience:

Advanced Programmers and Users

OS:

Windows, Linux, or macOS

Application:

For users who want to pipe or redirect data from Thermo-Calc running a macro in Console
Mode.
For example, you can start the application with the Thermo-Calc.bat file and the entire
application closes when you enter the EXIT command in the Console prompt.

WINDOWS
Thermo-Calc.bat macro.tcm > results.log

Command
examples:

LINUX
Thermo-Calc.sh -E < macro.tcm > results.log

MACOS
Thermo-Calc.command -E < macro.tcm > results.log

Command line definitions

E

For Linux and Mac users, the Emacs style editing feature must be disabled (turned
off) using the switch -E in order for redirection and piping to work correctly with ThermoCalc. For Windows this flag is not necessary.

<>

Redirection commands. The direction of each arrow indicates the flow of data. For
example in ./Console.sh -E < my_commands.tcm > results.log, the contents of my_
commands.tcm is used as input to the Console.sh script file and the resulting output is then
written to results.log.
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Console Mode Examples
In this section:
Thermo-Calc Console Mode Examples

579

Binary Phase Diagram Examples

581

Property Diagram Examples

585

Ternary Phase Diagram Examples

591

Multicomponent Phase Diagram Examples

594

Examples Calculating Thermodynamic and Related Quantities

596

Single Equilibrium Calculation Examples

600

Potential Diagram Example

602

Examples of Scheil-Gulliver Calculations

603

Example Calculating Chemical Ordering

606

Examples of Gibbs Energy System (GES)

607

Example Calculating the T0 Temperature

611

Examples Calculating Paraequilibrium

612

Example Using Functions and Variables

613

Example Using PARROT and EDIT_EXPERIMENT

614

Pourbaix Diagram Examples

616

Pourbaix Examples TCEX40A to 40E

618

POURBAIX_DIAGRAM Commands for Options 1 to 4

622

Example Using Tabulate Reaction (TAB)

635

Example Using REACTOR

636

Examples with Database Properties

637

Application Examples

639
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Thermo-Calc Console Mode Examples
There are many examples to examine and to help you learn Thermo-Calc in Console Mode.
Some of the examples in the table below are included with specific sections, whereas some
of the general examples are included (repeated) in more than one section.
Each topic has a brief description of the example and includes some or all of the commands
used in the macros.
About the Examples
Opening Console Mode Macro Files
All the macro files and the outputs are also combined into one file that you can
search and read. This is included with your installation as a PDF (go to Help >
Manuals folder > All Thermo-Calc Documentation and open Thermo-Calc
Console Mode Example Macros.
Topic

TCEX Examples included

Binary Phase Diagram Examples

1, 4, 13, 16, 17, 26, 31, 34, 50

Property Diagram Examples

2, 8, 9, 11, 12, 22, 23, 25, 28, 29, 32, 41, 49, 50

Ternary Phase Diagram Examples

3, 5, 14, 17, 19A, 19B, 21, 33, 37, 42, 43

Multicomponent Phase Diagram Examples

6, 10, 23, 27

Examples Calculating Thermodynamic and Related
Quantities

2, 13, 14, 18, 22, 26, 34, 39, 51

Single Equilibrium Calculation Examples

7, 18, 20

Potential Diagram Example

35

Examples of Scheil-Gulliver Calculations

15, 30A, 30B, 48, 54

Example Calculating Chemical Ordering

16

Examples of Gibbs Energy System (GES)

31, 38, 39, 49, 52

Example Calculating the T0 Temperature

23
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Topic

TCEX Examples included

Examples Calculating Paraequilibrium

23, 42, 43

Example Using Functions and Variables

44

Example Using PARROT and EDIT_EXPERIMENT

36

Pourbaix Diagram Examples

40, 40A-E, 53

Example Using Tabulate Reaction (TAB)

12

Example Using REACTOR

24

Examples with Database Properties

55, 56

9 - Dew Point
10 - Continuous casting, preventing Cr2O3
clogging
11 - Gas oxidation of Cu2S
20 - Adiabatic decompression in Geological
system
24 - Silicon arc furnace
Application Examples

25 - Refinement of steel
27 - Chemical Vapour Deposition
28 - Materials design of a stainless steel
29 - Gas speciation
41 - Solubility product
44 - Proof strength calculated from empirical
functions
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Binary Phase Diagram Examples
tcex01 - Calculating the Binary Fe-C Phase Diagram
This example calculates the binary Fe-C phase diagram using the Binary module. The TCBIN
database is used and included with your installation.
Some of the main commands used:
l

LIST_EQUILIBRIUM

l

LIST_STATUS

l

LIST_CONDITIONS

l

CHANGE_STATUS

l

COMPUTE_EQUILIBRIUM

l

SET_DIAGRAM_AXIS

l

SET_TIELINE_STATUS

l

PLOT_DIAGRAM

l

SET_SCALING_STATUS

l

SET_LABEL_CURVE_OPTION

l

ADD_LABEL_TEXT

l

MODIFY_LABEL_TEXT

tcex04 - Calculating the Fe-Cr Miscibility Gap
This example calculates the miscibility gap in the Fe-Cr system. The FEDEMO database is
used and included with your installation.
These commands are used:
l

SWITCH_DATABASE

l

GET_DATA

l

LIST_EQUILIBRIUM

l

SET_AXIS_VARIABLE

l

DEFINE_SYSTEM

l

AMEND_PHASE_DESCRIPTION
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l

SET_CONDITION

l

SAVE_WORKSPACES

l

REJECT

l

LIST_STATUS

l

COMPUTE_EQUILIBRIUM

l

SET_TIELINE_STATUS

tcex13 - The Binary Al-Ti Phase Diagram and its G Curve
This example calculates an Al-Ti binary phase diagram and G curve using the BINARY
module. The TCBIN database is used and included with your installation.

tcex16 - Second Order Transition of the Al-Fe System
This example calculates the second order transition line in the Bcc field of the Al-Fe system.
This uses the SSOL database. A license is required to run the example.
These commands are of note and used in this example:
l

REJECT

l

RESTORE

l

ADVANCED_OPTIONS

l

SET_SCALING_STATUS

l

DEFINE_SYSTEM

l

MAKE_EXPERIMENTAL_DATAFILE

l

LIST_EQUILIBRIUM

l

APPEND_EXPERIMENTAL_DATA

l

STEP_WITH_OPTIONS

tcex17 - The Pseudo-binary System - CaO-SiO2
This example calculates the pseudo-binary system CaO-SiO2 using the OXDEMO database,
which is included with your installation.
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The oxide demo (Oxdemo) database can be used both for pseudo-binary systems like the one
in this case, CaO-SiO2, or for full ternary systems like Ca-Fe-O.
These commands are of note and used in this example:
l

LIST_SYSTEM

l

REJECT and RESTORE

l

AMEND_PHASE_DESCRIPTION

l

LIST_STATUS

l

DEFINE_COMPONENTS

l

SET_CONDITION

l

COMPUTE_EQUILIBRIUM and LIST_EQUILIBRIUM

tcex26 - The As-Ga Phase Diagram: Plotting the Partial Pressures of a
Gas Species
This example uses the PG35 Binary Semi-Conductors database and is an example of plotting
the partial pressures of a gas species along the solubility lines in the As-Ga phase diagram.
The calculation makes it possible to monitor the input gases to a process of depositing solid
As-Ga.
These commands are of note and used in this example:
l

REJECT

l

RESTORE

l

SET_DIAGRAM_AXIS

l

SET_SCALING_STATUS

l

SET_AXIS_TEXT_STATUS

l

SET_LABEL_CURVE_OPTION

tcex31 - Using GES to Calculate CVM
Using the Gibbs Energy System (GES) module, this example calculates the CVM and
compares it with the sublattices of a fictitious A B system. You also learn how to overlay
diagrams from two calculations.
These GES commands are of note and used in this example:
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l

ENTER_ELEMENT

l

ENTER_SPECIES

l

ENTER_SYMBOL

l

ENTER_PHASE

l

ENTER_PARAMETER

l

LIST_PHASE_DATA

tcex34 - The Al-Zn Phase Diagram and its G Curve
This example uses the BINARY module to calculate the phase diagram and G curves in the
Al-Zn system. It uses the TCBIN database included with your installation.
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Property Diagram Examples
tcex02 - Plotting Thermodynamic Functions
This example shows how to plot thermodynamic functions in unary, binary and ternary
systems. It also involves working with partial derivatives and partial quantities.
This uses the SSOL database. A license is required to run the example.
These commands are used and may be of interest:
GOTO_MODULE

GET_DATA

SET_CONDITION

SWITCH_DATABASE

AMEND_PHASE_DESCRIPTION

LIST_EQUILIBRIUM

DEFINE_SYSTEM

COMPUTE_EQUILIBRIUM

SET_AXIS_VARIABLE

SAVE_WORKSPACES

STEP_WITH_OPTIONS

SET_DIAGRAM_AXIS

ENTER_SYMBOL

PLOT_DIAGRAM

SET_LABEL_CURVE_OPTION

REJECT

RESTORE

LIST_SYSTEM

LIST_STATUS

CHANGE_STATUS

SHOW_VALUE

SET_INTERACTIVE

tcex08 - Property Diagrams for a High Speed Steel
This example shows how to calculate property diagrams for a high speed steel i.e. phase
fraction plots, activity vs temperature, and so forth.
This uses the TCFE database. A license is required to run the example.
These commands are of note and used in this example:
l

DEFINE_DIAGRAM

l

DEFINE_ELEMENTS
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l

AMEND_PHASE_DESCRIPTION

l

REINITIATE_PLOT_SETTINGS

tcex09 - Calculating a Dew Point with POLY3
This is an example calculating the dew point in the POLY3 module. The SUBDEMO database
is used and included with your installation.
The STEP_WITH_OPTIONS and MAP commands are of note and used in this example.

tcex11 - Oxidation of Cu2S with an H2O/O2 Gas Mixture
This example demonstrates the oxidation of Cu2S with an H2O/O2 gas mixture. Thermo-Calc
is used to find the optimum O/H ratio (i.e. oxygen potential) as certain oxygen potential
values can desulphurize Cu2S without forming copper oxides.
In Thermo-Calc, the problem reduces to perform equilibria calculations in a Cu-S-H-O
system. The amounts of the components should be kept to correct ratio corresponding to
Cu2S and H2O using a command SET_INPUT_AMOUNTS in POLY3. Initially, O/H = 0.5 is
given. Optimum O/H ratio is calculated with the desired calculation conditions. For example,
to simulate one phase disappearing, you can FIX the phase with zero amount.
The tcex11.TDB file is used to access data and this is included with your installation.
These commands are of also of note and used in this example:
l

SET_NUMERICAL_LIMITS

l

SET_REFERENCE_STATE

l

SHOW_VALUE

tcex12 - Tabulation of Thermodynamic Data for Reactions
This example shows a number of independent cases using the TABULATE_REACTION (TAB)
module to tabulate thermodynamic data for reactions.
This uses the SSUB database. A license is required to run the example.
These commands are of note and used in this example:
l

TABULATE_REACTION

l

DEFINE_SPECIES
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l

ENTER_FUNCTION

l

QUICK_EXPERIMENTAL_PLOT

l

SET_SCALING_STATUS

l

LIST_SUBSTANCES

l

TABULATE_SUBSTANCE
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tcex22 - Calculating an Adiabatic Flame Temperature
This example examines a heat balance when C3H8 is burned in oxygen by calculating the
adiabatic flame temperature.
This uses the SSUB database. A license is required to run the example.

tcex23 - Calculating a Paraequilibrium and the T0 Temperature in a
Low Alloyed Steel
This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.
This uses the TCFE database. A license is required to run the example.

tcex25 - Simulating the Refinement of Steel
This example is based on a typical steel refining process. Raw iron used to produce steel
usually has high carbon and silicon content, which is why oxygen is blown into the furnace to
burn off carbon. Lime (CaO) is added to form a slag with silica, and the slag can be
removed. Alloying elements, such as Mn, Ni, Cr and V are added to produce the desired
steel. Since the reaction between O and C increases the temperature, scrap iron is added to
keep the temperature constant (it is assumed the furnace is isolated and no heat is lost to
the environment).
This example simulates blowing oxygen into a liquid steel of one metric ton (1e6 grams)
with 4 w/o C, 2 w/o Si and 1 w/o Mn. 100 moles of CaO (equivalent to 5.6 kg) is added.
Keeping the enthalpy constant is the way to simulate the isolation of the furnace. The oxygen
reacts with carbon and increases the temperature. After blowing a certain amount of
oxygen, scrap iron is added to keep the temperature constant.
This uses the SLAG database. A license is required to run the example.

tcex28 - Pitting Resistance Equivalence (PRE) for a Duplex Stainless
Steel
This example calculates the Pitting Resistance Equivalence (PRE) for a duplex stainless steel.
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This uses the TCFE database. A license is required to run the example.
These commands are of note and used in this example:
l

REJECT

l

RESTORE

l

DEFINE_ELEMENTS

l

AMEND_PHASE_DESCRIPTION

l

EVALUATE_FUNCTIONS

l

SET_START_CONSTITUTION

tcex29 - Calculating the Speciation of a Gas
This example shows how to calculate the speciation of a gas.
This uses the SSUB database. A license is required to run the example.
These commands are of note and used in this example:
l

SET_INPUT_AMOUNTS

l

LIST_CONDITIONS

l

SET_CONDITION

tcex32 - Calculating Oxide Layers on Steel
This example calculates oxide layers on a steel and shows how to append databases.
This uses the TCFE and SSUB databases. These licenses are required to run the
example.
These commands are of note and used in this example:
l

SET_START_CONSTITUTION

l

SET_REFERENCE_STATE

l

APPEND_DATABASE

tcex41 - Calculating a Solubility Product
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Calculation of a solubility product.
This uses the TCFE database. A license is required to run the example.
These commands are of note and used in this example:
l

DEFINE_ELEMENTS

l

REINITIATE_PLOT_SETTINGS

l

SET_DIAGRAM_AXIS

tcex49 - Quasichemical Model Using GES
This example shows how to enter parameters for a FACT quasichemical liquid model and
how to calculate the sulfur activity using the GIBBS_ENERGY_SYSTEM (GES) module
commands.
These commands are of note and used in this example:
l

ENTER_ELEMENT

l

ENTER_SYMBOL

l

AMEND_ELEMENT_DATA

l

ENTER_PARAMETER

l

ENTER_SPECIES

l

SET_REFERENCE_STATE

l

SHOW_VALUE
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Ternary Phase Diagram Examples
tcex03 - Calculating an Isothermal Section
This example calculates an isothermal section using the Ternary module. The
FEDEMO database is used and included with your installation.
These commands are used:
l

AMEND_PHASE_DESCRIPTION

l

ADD_LABEL_TEXT

l

PLOT_DIAGRAM

l

SET_DIAGRAM_AXIS; SET_DIAGRAM_TYPE; and SET_AXIS_TYPE

l

SET_REFERENCE_STATE

l

CHANGE_STATUS

l

SET_SCALING_STATUS

tcex05 - Calculating a Vertical Section in the Al-Cu-Si System
This example calculates a vertical section in the Al-Cu-Si system and of a vertical section
from Al to 10% Cu2Si. The ALDEMO database is used and included with your installation.

tcex14 - Variations in Solidification of an Al-Mg-Si Alloy
This example calculates the heat and heat capacity variations during solidification of an AlMg-Si alloy. The ALDEMO database is used and included with your installation.
These commands are of note and used in this example:
l

LIST_SYSTEM

l

LIST_CONDITIONS

l

SET_AXIS_TEXT_STATUS

tcex17 - The Pseudo-binary System - CaO-SiO2
This example calculates the pseudo-binary system CaO-SiO2 using the OXDEMO database,
which is included with your installation.
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The oxide demo (Oxdemo) database can be used both for pseudo-binary systems like the one
in this case, CaO-SiO2, or for full ternary systems like Ca-Fe-O.
These commands are of note and used in this example:
l

LIST_SYSTEM

l

REJECT and RESTORE

l

AMEND_PHASE_DESCRIPTION

l

LIST_STATUS

l

DEFINE_COMPONENTS

l

SET_CONDITION

l

COMPUTE_EQUILIBRIUM and LIST_EQUILIBRIUM

tcex19a and tcex19b - Mapping of Univariant Equilibria with the Liquid
in Al-Cu-Si
l
l

Part A. Step-by-step calculation using the POLY3 module.
Part B. Using the TERNARY module, you can get the information on invariant
reactions, such as temperature and compositions.

These commands are of note and used in these examples:
l

DEFINE_SYSTEM

l

GET_DATA

l

AMEND_PHASE_DESCRIPTION

l

SET_CONDITION and LIST_CONDITIONS

l

ADVANCED_OPTIONS

l

SAVE_WORKSPACES and READ_WORKSPACES

l

APPEND_EXPERIMENTAL_DATA

l

MAKE_EXPERIMENTAL_DATAFILE

tcex21 - Calculating a Ternary Isotherm in Fe-Cr-Ni
This example calculates a ternary isotherm in Fe-Cr-Ni with a user-defined database
included with the example in the file named tcex21.TDB.
These commands are of note and used in this example:
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l

DEFINE_SYSTEM

l

GET_DATA

l

SET_CONDITION

l

SET_DIAGRAM_TYPE

tcex33 - An Fe-Cr-C Isopleth
This example is a benchmark calculation of an isopleth in the Fe-Cr-C system. The
FEDEMO database is used and included with your installation.

tcex37 - Calculating an Isothermal Section
This example shows how to use command lines to enter and calculate an isothermal section
using the POLY3 module. The FEDEMO database is used and included with your installation.

tcex42 - Paraequilibrium Calculation - Formation of Para-pearlite Isopleth
This uses the TCFE database. A license is required to run the example.
This example uses an Fe-Mn-C system at 2.5%Mn Mass u-fraction to show a paraequilibrium
calculation where there is formation of para-pearlite. It is an isopleth calculation and shows
the STEP_WITH_OPTIONS command using the Paraequilibrium option.

tcex43 - Paraequilibrium Calculation - Formation of Para-pearlite Isothermal
This uses the TCFE database. A license is required to run the example.
This example uses an Fe-Mn-C system at 700 C to show a paraequilibrium calculation where
there is formation of para-pearlite. It is an isothermal calculation and shows the STEP_
WITH_OPTIONS command using the Paraequilibrium option.
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Multicomponent Phase Diagram Examples
tcex06 - An Isopleth in Low Alloyed Fe-Mn-Si-Cr-Ni-C Steel
This example calculates a multicomponent phase diagram using the DEFINE_MATERIAL
command in POLY and the TCFE steel database. The material contains 1.5 %Cr + 0.4 %Mn +
3.5 %Ni + 0.3 %Si and 1 %C (by weight). These conditions and the temperature are set by the
DEFINE_MATERIAL command.
After the first equilibrium results, a phase diagram is calculated with one axis variable as
temperature and the other as the carbon content.
This uses the TCFE database. A license is required to run the example.

tcex10 - Preventing Cr2O3 Clogging in a Continuous Casting Process
The example calculates an equilibrium with suspended or dormant phases and shows how to
avoid Cr2O3 clogging in a continuous casting process.
This uses the SLAG database. A license is required to run the example.
The origin of this example is that a manufacturer wanted to increase the Cr content of a
material from 18 to 25 weight percent but the continuous casting of this material was
problematic because solid Cr2O3 was formed.
Using Thermo-Calc to calculate the equilibria in the steel/slag system, a simple correction
was found: modify the Mn or Si content to decrease the oxygen potential. In Thermo-Calc,
you can FIX a phase with zero amount to simulate how to avoid forming this phase. You then
release one of the conditions, usually one of the compositions, and this composition is
determined by the equilibrium calculation.
These commands are of note and used in this example:
l

DEFINE_SYSTEM

l

CHANGE_STATUS

l

COMPUTE_EQUILIBRIUM

l

DEFINE_SYSTEM

l

DEFINE_SYSTEM

l

LIST_CONDITIONS
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l

LIST_EQUILIBRIUM

l

LIST_STATUS

l

SET_CONDITION

l

SET_NUMERICAL_LIMITS

l

SET_REFERENCE_STATE

l

SHOW_VALUE

tcex23 - Calculating a Paraequilibrium and the T0 Temperature in a
Low Alloyed Steel
This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.
This uses the TCFE database. A license is required to run the example.

tcex27 - Calculating Chemical Vapor Depositions (CVD)
This example calculates the chemical vapor deposition (CVD).
This uses the SSUB database. A license is required to run the example.
These commands are of note and used in this example:
l

DEFINE_COMPONENTS

l

SET_CONDITION

l

ADD_INITIAL_EQUILIBRIUM

l

LIST_AXIS_VARIABLE

l

LIST_INITIAL_EQUILIBRIA
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Examples Calculating Thermodynamic and Related
Quantities
tcex02 - Plotting Thermodynamic Functions
This example shows how to plot thermodynamic functions in unary, binary and ternary
systems. It also involves working with partial derivatives and partial quantities.
This uses the SSOL database. A license is required to run the example.
These commands are used and may be of interest:
GOTO_MODULE

GET_DATA

SET_CONDITION

SWITCH_DATABASE

AMEND_PHASE_DESCRIPTION

LIST_EQUILIBRIUM

DEFINE_SYSTEM

COMPUTE_EQUILIBRIUM

SET_AXIS_VARIABLE

SAVE_WORKSPACES

STEP_WITH_OPTIONS

SET_DIAGRAM_AXIS

ENTER_SYMBOL

PLOT_DIAGRAM

SET_LABEL_CURVE_OPTION

REJECT

RESTORE

LIST_SYSTEM

LIST_STATUS

CHANGE_STATUS

SHOW_VALUE

SET_INTERACTIVE

tcex13 - The Binary Al-Ti Phase Diagram and its G Curve
This example calculates an Al-Ti binary phase diagram and G curve using the BINARY
module. The TCBIN database is used and included with your installation.

tcex14 - Variations in Solidification of an Al-Mg-Si Alloy
This example calculates the heat and heat capacity variations during solidification of an AlMg-Si alloy. The ALDEMO database is used and included with your installation.
These commands are of note and used in this example:
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l

LIST_SYSTEM

l

LIST_CONDITIONS

l

SET_AXIS_TEXT_STATUS

tcex18 - A3 Temperature of a Steel
This example calculates the A3 temperature of a steel and examines the influence of each
alloying element on this temperature.
A3 temperature is the temperature where ferrite starts to form from austenite. You can
easily read A3 from an Fe-C phase diagram. However, for complex multicomponent steels
no simple diagram can be used. Using POLY, it is easy to find out the influence of each
alloying element on the A3 temperature. This information is useful if you want to modify the
compositions of a steel but keep A3 unchanged.
This uses the TCFE database. A license is required to run the example.
These commands are of note and used in this example:
l

DEFINE_ELEMENTS

l

AMEND_PHASE_DESCRIPTION

l

COMPUTE_TRANSITION

l

DEFINE_MATERIAL

l

ENTER_SYMBOL

l

SHOW_VALUE

tcex22 - Calculating an Adiabatic Flame Temperature
This example examines a heat balance when C3H8 is burned in oxygen by calculating the
adiabatic flame temperature.
This uses the SSUB database. A license is required to run the example.

tcex26 - The As-Ga Phase Diagram: Plotting the Partial Pressures of a
Gas Species
This example uses the PG35 Binary Semi-Conductors database and is an example of plotting
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the partial pressures of a gas species along the solubility lines in the As-Ga phase diagram.
The calculation makes it possible to monitor the input gases to a process of depositing solid
As-Ga.
These commands are of note and used in this example:
l

REJECT

l

RESTORE

l

SET_DIAGRAM_AXIS

l

SET_SCALING_STATUS

l

SET_AXIS_TEXT_STATUS

l

SET_LABEL_CURVE_OPTION

tcex34 - The Al-Zn Phase Diagram and its G Curve
This example uses the BINARY module to calculate the phase diagram and G curves in the
Al-Zn system. It uses the TCBIN database included with your installation.

tcex39 - Calculating Reversible Carnot Cycles of a Heat Engine
This example shows how to calculate the reversible Carnot cycle of a heat engine using one
mole of an ideal gas with two fictitious species A and A2. The GES, POLY3 and POST modules
are used, as well as the SUBDEMO database, which is included with your installation.
One application of the Second Law is to the efficiencies of heat engines, pumps and
refrigerators. Whenever there is a difference of temperature, work can be produced - the
principle of heat engines. The Gibbs energy also enables the prediction of the maximum
work that a process may achieve. The goal of this example is to help relate the results to
different thermodynamic quantities.
These commands are of note and used in this example:
l

REINITIATE

l

ENTER_PARAMETER

l

ENTER_SPECIES

l

SET_PLOT_FORMAT

l

ENTER_PHASE

tcex51 - Calculation of Molar Volume, Thermal Expansivity and Density
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This example uses the POLY3 module to calculate the molar volume, thermal expansivity
and density of the FCC_A1, BCC_A2 LIQUID and liquid phases of C-Fe.
This uses the TCFE database. A license is required to run the example.
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Single Equilibrium Calculation Examples
tcex07 - Single Equilibria in Low Alloyed Fe-Mn-Si-Cr-Ni-C Steel
This example shows how to calculate a single equilibria in a low alloyed Fe-Mn-Si-Cr-Ni-C
steel. There are two common ways to perform a single equilibrium calculation:
l

l

Get data from a database, then in POLY use SET_CONDITION and COMPUTE_
EQUILIBRIUM.
Go directly to POLY and use DEFINE_MATERIAL.

The COMPUTE_TRANSITION command is also used to determine the temperature or
composition where one phase forms or disappears. It is the same as the CHANGE_STATUS →
SET_CONDITION→ COMPUTE_EQUILIBRIUM sequence of commands.
A STEP_WITH_OPTIONS command using the option normal is also used in addition to the
other commands that should be becoming more familiar as you work through the examples.
This uses the TCFE database. A license is required to run the example.

tcex18 - A3 Temperature of a Steel
This example calculates the A3 temperature of a steel and examines the influence of each
alloying element on this temperature.
A3 temperature is the temperature where ferrite starts to form from austenite. You can
easily read A3 from an Fe-C phase diagram. However, for complex multicomponent steels
no simple diagram can be used. Using POLY, it is easy to find out the influence of each
alloying element on the A3 temperature. This information is useful if you want to modify the
compositions of a steel but keep A3 unchanged.
This uses the TCFE database. A license is required to run the example.
These commands are of note and used in this example:
l

DEFINE_ELEMENTS

l

AMEND_PHASE_DESCRIPTION

l

COMPUTE_TRANSITION

l

DEFINE_MATERIAL
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l

ENTER_SYMBOL

l

SHOW_VALUE

tcex20 - Adiabatic Decompression in a Geological System
This example calculates the adiabatic decompression in a geological system using the
geochemical database. The database is included with the file named PGEO.TDB, which is in
the same folder as this example.
These commands are of note and used in this example:
l

DEFINE_SYSTEM

l

DEFINE_COMPONENTS

l

SET_INPUT_AMOUNTS

l

LIST_CONDITIONS

l

SET_CONDITION

l

SHOW_VALUE
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Potential Diagram Example
tcex35 - Calculating a Potential Diagram
This example uses the POTENTIAL module to calculate a potential diagram. Note that there
are no commands for this module, you just follow the prompts. The SUBDEMO database is
used and included with your installation.
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Examples of Scheil-Gulliver Calculations
About the Scheil-Gulliver Solidification Simulations
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tcex15 - Simulating the Solidification of a Cr-Ni Alloy
This is an example of a solidification simulation of a Cr-Ni alloy. There is no back diffusion in
the solid, i.e. Scheil-Gulliver model is used.
This uses the TCFE database. A license is required to run the example.
These commands are of note and used in this example:
l

START_WIZARD

l

COMPUTE_TRANSITION

l

ADD_INITIAL_EQUILIBRIUM

l

ENTER_SYMBOL

l

ADVANCED_OPTIONS

l

STEP_WITH_OPTIONS

l

MAKE_EXPERIMENTAL_DATAFILE

l

CHANGE_STATUS

tcex30a and 30b - Scheil Calculation for an Al-4Mg-2Si-2Cu Alloy
The Equilibrium Calculation Module (POLY3) and About the Scheil-Gulliver
Solidification Simulations
These examples show two ways to do a Scheil calculation for an Al-4Mg-2Si-2Cu alloy. In
part A, you use the POLY3 module and the STEP_WITH_OPTIONS command with an
EVALUATE option. Then in part B you use the SCHEIL module commands to do the same
thing. Data from the COST2 database is used and included with the example in the file
named tcex30_cost2.TDB.

tcex48 - Scheil Solidification with C Back Diffusion
This is an example of Scheil solidification with C back diffusion in solid phases. The results
are compared between a simple Scheil and equilibrium calculation. The FEDEMO database
is used.

tcex54 - Scheil Solidification of an Al-2.1Cu-1Si Alloy including Back
Diffusion
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This is an example of a solidification simulation of a Al-2.1Cu-1Si alloy. The back diffusion
option in the Scheil module is used, i.e. there is back diffusion in the primary phase. The
example uses both the thermodynamic ALDEMO and mobility MALDEMO demo databases
included with your installation.
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Example Calculating Chemical Ordering
tcex16 - Second Order Transition of the Al-Fe System
This example calculates the second order transition line in the Bcc field of the Al-Fe system.
This uses the SSOL database. A license is required to run the example.
These commands are of note and used in this example:
l

REJECT

l

RESTORE

l

ADVANCED_OPTIONS

l

SET_SCALING_STATUS

l

DEFINE_SYSTEM

l

MAKE_EXPERIMENTAL_DATAFILE

l

LIST_EQUILIBRIUM

l

APPEND_EXPERIMENTAL_DATA

l

STEP_WITH_OPTIONS
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Examples of Gibbs Energy System (GES)
tcex31 - Using GES to Calculate CVM
Using the Gibbs Energy System (GES) module, this example calculates the CVM and
compares it with the sublattices of a fictitious A B system. You also learn how to overlay
diagrams from two calculations.
These GES commands are of note and used in this example:
l

ENTER_ELEMENT

l

ENTER_SPECIES

l

ENTER_SYMBOL

l

ENTER_PHASE

l

ENTER_PARAMETER

l

LIST_PHASE_DATA

tcex38 - Calculating the Morral “Rose”
This example uses the Gibbs energy system (GES) module to calculate the Morral rose,
which are miscibility gaps.
These commands are of note and used in this example:
l

REINITIATE

l

ENTER_ELEMENT

l

AMEND_ELEMENT_DATA

l

ENTER_PARAMETER

l

ENTER_PHASE

tcex39 - Calculating Reversible Carnot Cycles of a Heat Engine
This example shows how to calculate the reversible Carnot cycle of a heat engine using one
mole of an ideal gas with two fictitious species A and A2. The GES, POLY3 and POST modules
are used, as well as the SUBDEMO database, which is included with your installation.
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One application of the Second Law is to the efficiencies of heat engines, pumps and
refrigerators. Whenever there is a difference of temperature, work can be produced - the
principle of heat engines. The Gibbs energy also enables the prediction of the maximum
work that a process may achieve. The goal of this example is to help relate the results to
different thermodynamic quantities.
These commands are of note and used in this example:
l

REINITIATE

l

ENTER_PARAMETER

l

ENTER_SPECIES

l

SET_PLOT_FORMAT

l

ENTER_PHASE

tcex49 - Quasichemical Model Using GES
This example shows how to enter parameters for a FACT quasichemical liquid model and
how to calculate the sulfur activity using the GIBBS_ENERGY_SYSTEM (GES) module
commands.
These commands are of note and used in this example:
l

ENTER_ELEMENT

l

ENTER_SYMBOL

l

AMEND_ELEMENT_DATA

l

ENTER_PARAMETER

l

ENTER_SPECIES

l

SET_REFERENCE_STATE

l

SHOW_VALUE

tcex52 - Changing the Excess Models for Interaction Parameters in a
Solution Phase
Solution Models in the GIBBS (GES) Module
This example shows how to change the excess models for binary and ternary interactions in
a solution phase, either

Thermo-Calc User Guide: Console Mode ǀ 608 of 643

Thermo-Calc Documentation Set

l

l

through direct interactive amendments of phase descriptions within the GIBBS_
ENERGY_SYSTEM (GES) module, or
enforced by specific type-definitions given in a database file retrieved by the
DATABASE_RETRIEVAL module (also called the TDB module).

For binary excess models, the example changes it from the default R-K model to a MixedExcess-Model. The phase has to be a substitutional phase in this case.
For ternary extrapolation models, the example changes it from the default R-K-M model to a
Toop_Kohler model.

Notes Related to the Example
The following is included in the macro file as part of the instructions but may be of use to
new users:

Amending the binary excess model
The default binary excess model is the Redlich-Kister Model for all the three associated
binary interaction pairs (A-B, A-C and B-C) in the substitutional LIQUID solution phase
(without sublattice) that consists of three elements (A, B and C).
Before changing this default binary excess model for the ternary LIQUID solution phase, one
must have already entered the G parameters (for standard Gibbs energies of all pure endmembers) and L parameters (for binary R-K excess interaction energies), as shown in the
example.
In this particular example, we want to change from the default R-K binary excess model to
the Mixed-Excess-Model (with three different binary excess models, namely Legendre,
Polynom and Redlich-Kister models, applied to the A-B, A-C and B-C binaries, respectively),
as demonstrated below:
For the A-B interaction, the Legendre binary excess model should be used (rather than the
default Redlich-Kister Model), with the first species (i.e. A) as the independent constituent
and the second species (i.e. B) as the dependent constituent, while the L parameters for the
A-B interaction shall remain the same as those handled by the R-K model.
For the A-C interaction, the Polynom binary excess model should be used (rather than the
default Redlich-Kister Model), with the second species (i.e. C) as the independent constituent
and the first species (i.e. A) as the dependent constituent, while the L parameters for the A-C
interaction shall remain the same as those handled by the R-K model.

Amending the ternary extrapolation model
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The default ternary excess model is the Redlich-Kister_Muggianu Model (i.e., the
MUGGIANU_RESTOR method for ternary extrapolation based on binary parameters) for the
associated ternary interaction terms; when no ternary L parameter is entered for that, such
a default Redlich-Kister_Muggianu Model is thus to be used for extrapolation from binary
excess energies to ternary interactions in the substitutional LIQUID solution phase (without
sublattice) that consists of three elements (A, B and C).
However, in this particular example as illustrated in the following, we shall change from this
default R-K-M ternary excess model to the TOOP-KOHLER method for the ternary
extrapolation method, with the species C as the Toop constituent, while the species A and B
as the Kohler constituents (entering A and B, or B and A, as the basis constituent and first
interacting constituent). This will implicitly enforce that, during the ternary extrapolation,
only the A-B binary interaction parameters are utilized in accordance with the Kohler
ternary extrapolation formula for A-B-C ternary interaction, while any other binary
interaction parameters used in line with the Toop-Kohler ternary extrapolation formula (for
the A-C-B and B-C-A ternary interactions). This makes the extrapolated ternary excess
interaction terms different from those handled either by the default MUGGIANU_RESTOR
method or by the alternative KOHLER-ALL method.
Note that only when all the relevant binary excess energies in a ternary system are treated
by the default Redlich-Kister Model (i.e., the Mixed-Excess-Model should have not been
used), the MUGGIANU_RESTOR method for ternary extrapolations is equivalent to the
Redlich-Kister_Muggianu Model, or the KOHLER-ALL method to the Redlich-Kister_Kohler
Model.
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Example Calculating the T0 Temperature
tcex23 - Calculating a Paraequilibrium and the T0 Temperature in a
Low Alloyed Steel
This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.
This uses the TCFE database. A license is required to run the example.
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Examples Calculating Paraequilibrium
tcex23 - Calculating a Paraequilibrium and the T0 Temperature in a
Low Alloyed Steel
This example calculates a paraequilibrium and the T0 temperature in a low alloyed steel.
This uses the TCFE database. A license is required to run the example.

tcex42 - Paraequilibrium Calculation - Formation of Para-pearlite Isopleth
This uses the TCFE database. A license is required to run the example.
This example uses an Fe-Mn-C system at 2.5%Mn Mass u-fraction to show a paraequilibrium
calculation where there is formation of para-pearlite. It is an isopleth calculation and shows
the STEP_WITH_OPTIONS command using the Paraequilibrium option.

tcex43 - Paraequilibrium Calculation - Formation of Para-pearlite Isothermal
This uses the TCFE database. A license is required to run the example.
This example uses an Fe-Mn-C system at 700 C to show a paraequilibrium calculation where
there is formation of para-pearlite. It is an isothermal calculation and shows the STEP_
WITH_OPTIONS command using the Paraequilibrium option.
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Example Using Functions and Variables
tcex44 - Exploring Variables and Functions
This example uses variables and functions to predict properties e.g. proof strength for an
austenitic stainless steel at elevated temperatures (20-550° C). The example was created
using an expression from Eliasson and Sandström (2000)1. .
This uses the TCFE database. A license is required to run the example.

1. "Proof strength values for austenitic stainless steels at elevated temperatures", Steel Res., 71(6–7), 249–254.
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Example Using PARROT and EDIT_EXPERIMENT
tcex36a - Using PARROT and EDIT EXPERIMENTS
The example is divided into parts corresponding to the files in the tcex36a
folder. It is recommended you open tcex.36.readme before continuing with this
advanced exercise.

Also see the Data Optimization User Guide.
Each problem has "selected" experimental data. The example uses a fictitious binary A-B
system where element A is BCC until it melts. Element B is BCC up to 1100 K and FCC above.
There is a compound A2B stable in a limited temperature range.
l

l

l

The creation of the "setup" file is described (tcex36a.TCM) where you enter the
elements and phases into the Gibbs Energy System (GES) module
The creation of the experimental data file is described (tcex 36b.TCM). When you run
the TCEX36a macro, the contents of this macro file is automatically launched and the
experimental data file created.
The actual run in the PARROT module in order to obtain the result (tcex 36cpd.TCM)

There are many commands used in this advanced example (listed in alphabetical order):
ADVANCED_OPTIONS

AMEND_ELEMENT_DATA

AMEND_PHASE_DESCRIPTION

APPEND_EXPERIMENTAL_DATA

COMPILE_EXPERIMENTS

CONTINUE_OPTIMIZATION

CREATE_NEW_EQUILIBRIUM

CREATE_NEW_STORE_FILE

DEFINE_COMPONENTS

EDIT_EXPERIMENTS

ENTER_PARAMETER

ENTER_PHASE

LABEL_DATA

LIST_ALL_VARIABLES

LIST_PHASE_DATA

LIST_RESULT

MACRO_FILE_OPEN

OPTIMIZE_VARIABLES

QUICK_EXPERIMENTAL_PLOT

READ_WORKSPACES
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RESCALE_VARIABLES

SAVE_PARROT_WORKSPACES

SAVE_WORKSPACES

SELECT_EQUILIBRIUM

SET_ALL_START_VALUES

SET_ALTERNATE_CONDITION

SET_ALTERNATE_MODE

SET_FIX_VARIABLE

SET_OPTIMIZING_VARIABLE

SET_STORE_FILE

SET_WEIGHT
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Pourbaix Diagram Examples
tcex40
This is the first in a series of examples to demonstrate the advanced POURBAIX module
calculations and plotting. This example automatically calculates and plots a Pourbaix
diagram for 0.001 m Fe in a 0.1 m NaCl aqueous solution at 25° C and 1 bar. Other
diagrams, along various phase boundaries for the same interactions resulted from the same
Pourbaix module calculation, are also plotted.

It is recommended you read the text file TCEX40-README.txt, which is located
in the Extended subfolder.

Also see the Pourbaix Diagrams Educational Material Guide.
A so-called Pourbaix diagram is actually a phase diagram with independently-varied acidity
(pH) and electropotential (Eh), for a heterogeneous interaction system at a certain bulk
composition (that is by default always set as 1 kg of water dissolving a specified amount of
metals and other solutes), under a defined temperature and pressure condition.

The PAQ2 Database
The example uses the PAQ2 (TCS Public Aqueous Solution Database using the SIT aqueous
solution model) included with your installation. The database contains an AQUEOUS solution
phase and REF_ELECTRODE phase (as a reference for electron in aqueous electrolyte
systems), as well as some data for various solid phases (solution or stoichiometric) and
gaseous mixture phase. The PAQ2 is specially designed for these example calculations of the
so-called Pourbaix diagrams (i.e., pH-Eh plots) and other types of phase diagrams or
property diagrams in some aqueous-bearing multicomponent heterogeneous interaction
systems within the limited chemical framework of Fe-Co-Cr-Ni-C-N-S-H2O-NaCl, via the
Single-Database Option in the advanced POURBAIX module or through the normal TDB-GESPOLY-POST routine.

Additional Examples in this Series
Additional examples (TCEX40A, TCEX40B, TCEX40C, TCEX40D and TCEX40E) are provided to
demonstrate options and features in the Pourbaix module and to show more advanced
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applications of the TCAQ and AQS aqueous solution databases [in the Multiple-Database
Option, i.e., with appended data from the SSOL and SSUB databases]. See Pourbaix Examples
TCEX40A to 40E.

tcex53 - Pourbaix Diagram Calculations for a Heterogeneous
Interaction System
Also see the Pourbaix Diagrams Educational Material Guide.
This example uses the PAQ2 database to calculate some Pourbaix diagrams. The DATABASE_
RETRIEVAL (TDB), GIBBS_ENERGY_SYSTEM (GES), POLY3, and POST modules are used for
the Fe-X-H2O-NaCl heterogeneous interaction system, where X = Cr-Ni-Co.
The initial bulk composition of Fe-based alloy in this calculation is just
preliminarily assigned, in which the BCC_A2 and/or FCC_A1 solution phase(s)
are considered as of primarily interest. For practical calculations, one shall have
more precise inputs for the initial bulk compositions of alloys.

Step 1: Single-Point Calculations for H2O-NaCl system
To demonstrate how to define the molality of NaCl in an aqueous-bearing heterogeneous
interaction system.

Step 2: Single-Point Calculations for Fe-X (X = Cr-Ni-Co) system
To demonstrate how to define the initial amount of alloy in an aqueous-bearing
heterogeneous interaction system. In this example, we are interested in only the BCC_A2
and FCC_A1 phases in the Fe-based alloy.

Step 3: Single-Point Calculations for Fe-Cr-Ni-Co + H2O-NaCl system
Step 4: Pourbaix Diagram Mapping for Fe-Cr-Ni-Co + H2O-NaCl system - define
the variables
From the same mapping calculations you arrive at by the end of the example, you can plot
more diagrams using a variety of X-Y axis variables.
For a list of pre-defined symbols, go to the end of the tcex53.TCM macro file
(open it in a text editor).
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Pourbaix Examples TCEX40A to 40E
These are the extended examples that are described in Pourbaix Diagram Examples.

TCEX 40A
This example shows you how to use Option 1 where you start a completely new
calculation. It uses a single database. The Pourbaix diagram for 0.001 m Fe in a 0.1 m NaCl
solution at 25C and 1 bar is automatically calculated and plotted.
A more advanced version of 40A can be found in TCEX40E, which also uses
Option 1 but with multiple databases. However, licenses are required for three
types of commercial Thermo-Calc databases.
See POURBAIX_DIAGRAM Commands for Options 1 to 4.
A so-called Pourbaix diagram is actually a phase diagram with independently-varied
electropotential (Eh) and acidity (pH), for an heterogeneous interaction system at a certain
bulk composition (that is by default always set as 1 kg of water solving a specified amount of
metals and other solutes), under defined temperature and pressure conditions. Some
property diagrams, along various phase boundaries for the same interactions resulting from
the same Pourbaix module calculation, are also plotted, without leaving Option 1.

At the end of this example, a new POLY3 file called POURBAIX.POLY3 is
automatically saved. The following examples (TCEX40B, TCEX40C and TCEX40D)
use this same POLY3 file for the calculations. Therefore it is important to make
four copies of this file and rename these to TCEX40A.POLY3, TCEX40B.POLY3,
TCEX40C.POLY3 and TCEX40D.POLY3. This must be done outside of the ThermoCalc software and after the TCEX40A calculation and plotting is complete. This
is so that the required POLY3 file structure is not lost.

The reason you do not save from within Thermo-Calc is because of how the file
is saved. When the command sequence (GO POLY3>SAVE TCEX40A.POLY3>Y) is
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3
module monitor and all the initial equilibrium points and the mapping/stepping
calculation results are lost as well as parts of the POLY3 file structure (e.g.,
some definitions of the previously defined POURBAIX-type calculation system).
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A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.

TCEX 40B
This example shows you how to use Option 2 where you Open an old (existing) file and plot
other property diagrams.
Example 40A calculated and plotted the Pourbaix diagram for 0.001 m Fe in a 0.1 m NaCl
solution at 25° C and 1 bar. Example 40B reads the original POURBAIX.POLY3 file , and uses
the calculated results to plot property diagrams for the same heterogeneous interaction
system.
For example 40B, the POLY3 file is not modified. However, it is still
recommended that a copy of the original POLY3 file is used so you do not lose
the file structure and calculated results.
If you have a POLY3 file generated after choosing Option 4, that file can also be
used for Option 2, and vice versa.

TCEX 40C
This example shows you how to use Option 3 where you Open an old file and make
another Pourbaix calculation. The previously calculated (and copied) POURBAIX.POLY3 file
from TCEX40A is edited to make another Pourbaix calculation and plot.
The same chemical system is used (Fe-H2O-NaCl) but with different P-T-X (pressuretemperature-composition) conditions and without the GASeous mixture phase. The new
conditions are 0.01 m Fe in a 1 m NaCl solution at 200° C and 1 kbar.
In this example, the GASeous mixture phase for the Pourbaix diagram is not
considered.
The POLY3 file is modified and rewritten with the new conditions. As previously
recommended, make a copy of the original POLY3 file and rename it
(e.g.TCEX40C.POLY3) so you do not lose the file structure and new calculated
results.
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A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.
After the default Pourbaix diagram is generated and refined, you can also use Option 3 to
plot property diagrams along different phase boundaries for the same system. These
settings are possible from within Option 3 and you do not need to go back to Option 2.

TCEX 40D
This example shows you how to use Option 4 where you Open an old file and make
another stepping calculation. The previously calculated (and copied) POURBAIX.POLY3 file
from TCEX40A is edited to make a stepping calculation and plot.
The same chemical system is used (Fe-H2O-NaCl) but with different P-T-X (pressuretemperature-composition) conditions and using a POLY3 stepping calculation. The new
conditions are 0.01 m Fe in a 0.1 m NaCl solution at 1 kbar and under varied temperature
(from 0 to 400° C). The equilibrium conditions are modified and two stepping calculations
are done. The same stepping calculation is used to plot property diagrams for the
heterogeneous interaction system.
The example also explores settings such as editing the definitions for some system
components and their initial bulk composition conditions. This is done through the direct and
internal POURBAIX-POLY3 intersection, for a Stepping (or Mapping) calculation inside the
Pourbaix module.
The POLY3 file is modified and rewritten with the new conditions. As previously
recommended, make a copy of the original POLY3 file (from example
TCEX40A) and rename it (e.g. to TCEX40D.POLY3) so you do not lose the file
structure and new calculated results.
If you have a POLY3 file generated after choosing Option 2, that file can also be
used for Option 4 and vice versa.
A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.

TCEX 40E
This example shows you how to use Option 1 where you start a completely new
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calculation. It uses multiple databases (TCAQ, SSUBand SSOL). The Pourbaix diagram for
0.001 m Fe90Co5Ni5 alloy (9E-3 m Fe + 5E-4 m Co + 5E-4 m Ni) in an aqueous solution with
2E-2 m H2S and 3 m NaCl at 25° C and 1 bar is automatically calculated and plotted.
You need licenses for three Thermo-Calc databases, i.e.
l

l
l

A: AQS (TGG Aqueous Solution Database; HKF model) or TCAQ (TCS Aqueous Solution
Database; SIT model);
B: SSUB (SGTE Pure Substances Database)
C: SSOL (SGTE Alloy Solutions Database) or TCFE (TCS Steels/Fe-Alloys Database) or
similar.

The TCAQ database contains only an AQUEOUS solution phase (using the SIT model) and
REF_ELECTRODE phase (as a reference state for electron in aqueous electrolyte systems).
The SSUB database is appended for the GASeous mixture phase and some pure solid phases
(so-called secondary phases formed during aqueous-involving interaction processes), and the
SSOL database is appended for various solid solution phases.
The Pourbaix module inside the software also accepts the AQS2 aqueous solution database
(using the complete Revised HKF model) in the Multiple Database Option, in addition to the
TCAQ2 aqueous solution database (using the SIT model).
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POURBAIX_DIAGRAM Commands for Options 1 to 4
Option 1: Start a Completely New Pourbaix Diagram
Calculation
Option 1 is used to make a completely new Pourbaix diagram calculation and automatically
plot a pH-Eh diagram. i.e., define a new chemical system; specify the T-P-X conditions;
calculate the initial equilibria; perform the pH-Eh mapping calculation; plot pH-Eh and
various property diagrams.

Many of the commands in Option 1 are also repeated for Options 2 to 4. The
details for each command are included with this section unless it is specific to
one of the other option choices. The order that the commands display on screen
is also different and based on what is entered at the prompts. These prompts
are also available in other commands and when applicable a link to that
command is included.

Consider the GAS phase in calculating a Pourbaix diagram? /Y/

You can choose to ignore the GAS mixture phase on a calculated/plotted Pourbaix diagram.
However, such a plot is actually not a complete Pourbaix diagram because the
thermodynamically-stable phase boundaries between the AQUEOUS solution phase and GAS
mixture phase will not be calculated.
l

If you enter Y (the default), GAS mixture phase is always considered.

l

If you enter N the GAS mixture phase is completely ignored.

Use single database? /Y/

If you keep the default you are prompted for a database.
Combined database: /PAQ2/

The default is PAQ2, a database included with all installations.
The following information is provided on screen if you chose Y at the first prompt, Need
instruction on the POURBAIX module? /N/.

any

Define a Chemical System and its Initial Bulk Composition
Normally a Pourbaix diagram and its related equilibrium property in a heterogeneous
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interaction system are calculated under a certain bulk composition, which is usually 1 kg of
water with defined amounts of dissolving solute substances. The solutes may either be
completely dissolved into the aqueous solution, or be partially dissolved and simultaneously
form some solid phases.

CHEMICAL SYSTEM (ELEMENTS)
l

l

Default defined elements (solvent H2O): H and O and specially assigned ZE
(electron) and VA(vacancy).
Prompt specified elements (solutes ELEM): Fe Ni Co Cr C N S Na Cl

INITIAL BULK COMPOSITION
l

Default defined composition (solvent): 1.0 kg of H2O

l

Prompt specified composition (solutes): x mole of ELEM

l

Mass of Water (weight) = 1 kg

When entering solutes in chemical formulas, the first element's letter must be
in UPPER case, and second in lower case, for example NaCl, CO2, CoCl3,
Fe0.93S, NaSO4-1, and H2SO4.

First solute

Enter a solute, e.g. Fe.
Molality of <first solute> [mol/kg] /.001/

Enter a molality for the first solute, e.g. Fe.
Second solute

Enter a second solute and its molality on the same line, e.g. NaCl

.1.

Next solute

You can continue to enter solutes. Press <Enter> to skip to the next prompt.
The following information is provided on screen if you chose Y at the first prompt, Need
instruction on the POURBAIX module? /N/.

any

Defined Chemical System and Initial Bulk Composition
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Solutes have been split up into chemical elements and their mole numbers. If confirmed, the
Pourbaix module will, in further steps, count the initial bulk composition in terms of
chemical elements.
Confirm defined system and initial bulk composition? /Y/

If you keep the default (Y) thermodynamic data is retrieved from the database. Then it lists
the database's phases for the defined system.
You can then reject or restore phases as required with the next prompts.
Reject phase(s) /NONE/
Restore phase(s): /NONE/

Then the program lists the phases retained in the system and you prompted whether this is
OK or not.
OK? /Y/

If you answer Y, then a list of references for the assessed data is displayed on the screen.
The next prompt is related to miscibility gap checks, global minimization, saving the
information to a POLY3 file, and setting numerical limits.
Should any phase have a miscibility gap check? /N/

The database usually creates two or more "composition sets" for phases that can have
miscibility gaps. However, for some phases this is not done automatically, for example the
miscibility gap in the bcc phase in Fe-Cr is usually ignored. But if it is important to include a
Cr-rich bcc phase specify this here. It costs some computation time and may make
subsequent MAP or STEP processes more difficult to converge. To keep the default (not to
have any such phase) press <Enter>. Otherwise answer Y and follow the additional prompts.
Enforce Global Minimization Technique in calculations? /N/

If you choose Y, the Global Minimization is done when possible (depending on the conditions
setting), and a Global Minimization test is performed when an equilibrium is reached. This
costs more computer time but the calculations are more robust.
Save all functions, variables and tables in POLY3 file? /Y/

Choose Y if you want to save all the defined symbols (functions, variables and tables) into the
POURBAIX.POLY3 file, for further normal POLY3 calculations or normal POST postprocessing. Choosing yes may result in a large POLY3 file.
Set numerical limits? /N/

SET_NUMERICAL_LIMITS
The Pourbaix module has a default setting for numerical limits.
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l

Maximum number of iterations: 20000

l

Required accuracy: 1E-6

l

Smallest fraction: 1E-15

l

Approximate driving force for metastable phases: Y

If you kept the defaults for the above prompts, the program lists the default and pre-defined
calculation conditions and you are prompted to confirm.
Confirm defined conditions? /Y/

Now Thermo-Calc calculates the start points. This can take a few moments. Near the end of
the calculation there is a list of the default axis variables. The maximum pH limit is
calculated precisely and determined automatically by the Pourbaix module as a function of
the temperature-pressure conditions and initial bulk compositions of the current defined
interaction system. You are prompted to accept these settings.
Accept the default settings for two mapping variables? /Y/

The program now lists the initial equilibria for mapping and continues to calculate the
mapping. Then it sets the automatic diagram axes and starts to plot the diagram. But first
there are several prompts to guide you.
Any missing phase boundary you could possibly think of? /N/

Sometimes the Pourbaix module may miss some phase boundaries during the mapping
process. If you answer Y you can add additional starting point(s) into the calculation. You are
now prompted to specify a pH-Eh coordinate pair, for instance (4.0, -0.15), which is close to
the expected phase boundary. However, such additional pH-Eh point should not outside the
AQUEOUS/GAS(O2) or AQUEOUS/GAS(H2) boundaries; otherwise, the module will fail in
finding any new starting point.
The next set of prompts relate to plotting.
Change the pH/Eh steps for smoother curves? /N/

You can modify the mapping steps of X/Y axes for smoother curves; sometimes it may help
finding missing phase boundaries by decreasing the pH and Eh increments.
Zoom in? /N/

Change the scaling status for both X and Y axes. The program then asks for minimum and
maximum values for the axes. In some cases values are suggested.
Change Curve-Label Option for the diagram? /N/

Change the Curve-Label option to one of the following:
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l

A: List stable phases along phase boundaries

l

B: As A, but curves with same fix phase have same number

l

C: List axis quantities

l

D: As C, but curves with same quantities have same number

l

E: As B, but curves with changing colours

l

F: As D, but curves with changing colours

l

N: No labels

Usually, Option E or B is good for phase diagrams such as pH-Eh plots, and F or D is good for
property diagrams like pH-RC(Fe+2).
SET_LABEL_CURVE_OPTION
Add Label-Texts onto the Pourbaix diagram? /N/

Add label text to an area in the diagram. The label is written starting from the specified
coordinates. Optionally, let the program automatically add the text by calculating an
equilibrium at some specific coordinates and also make a label as the stable phase names in
the area. However, such an automatic calculation may fail, especially for a Pourbaix
diagram where either pH or Eh is not an intensive variables.
In most cases, the program is able to write the label if the coordinates and texts are
specified.
Change the Subtitle of the diagram? /N/

This is the same as the POST module commandSET_CORNER_TEXT → UPPER_RIGHT
<SUBTITLE>. The default subtitle is automatically assigned by the POURBAIX module and is
based on the defined conditions in the system (temperature, pressure and initial bulk
compositions).
If you choose Y then the existing subtitle is displayed and you are prompted to enter a new
subtitle or to have None.
New Subtitle /NONE/

You can change the subtitle for all the diagrams in the same POURBAIX run (i.e., within the
same Option). The new subtitle that can be altered later at the same option, when further
modifying the present graph or when refining any sequentially defined plot. By entering text
(empty space at any position is allowed), the new subtitle is defined. By typing OLD, the
existing subtitle is kept.
By pressing <Enter> (i.e., accepting None), the subtitle is deleted from all sequential plots,
which can be set back later at the same option, too.
Change Axis-Texts? /N/
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Change the axis text for both X and Y axes.
Further Refine the diagram in POST Module? /N/

With this option, you can further change the appearance the plot and use any command in
the normal POST Module.
POST Module Commands
Hard copy of the diagram? /N/

Recommended Responses
l

Hard copy of the diagram? /N/: Y

l

CURRENT DEVICE: MS-Windows

l

GRAPHIC DEVICE NUMBER /1/: 5

l

NEW DEVICE: Postscript portrait mode

l

USE POSTSCRIPT FONTS /YES/: Y

l

SELECT FONTNUMBER /9/: 27

l

NEW FONT: Times-Bold

l

FONT SIZE /.35833/: .32

l

PLOTFILE : /defaultname/: yourfilename

Save X-Y coordinates of curve on text file? /N/

Write all the current graphic information (generated and modified in the above procedure)
on a text file using the DATAPLOT format (see the DATAPLOT User Guide or search the
online help). This also makes it possible to merge two or more diagrams from separate but
similar calculations, or put some experimental data points onto a calculated diagram. You
do this by first writing them onto text files with this option and then edit them together
(using a general text editor). The program asks for a file name. Accept the default (usually
POURBAIX) or use another name. If an extension is not given, the written file is given an
extension of *.EXP.
Modify the diagram? /N/

Further modify the appearance of the created plot. This brings you back to the above
prompts for changing various features.
Any more diagram? /N/

Make many other plots using the same POURBAIX module calculation file.
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Option 2: Open an Existing File and Plot Other Property
Diagrams
Copy and Rename the POLY3 file
At the end of a Pourbaix module calculation, a new POLY3 file is automatically saved.
A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.

If you are using a POLY3 file more than once (as is done in the extended
examples), it is recommended that you copy and rename the previouslygenerated POLY3 file. This is so that the required POLY3 file structure and
Pourbaix results are not lost. Do this outside of Thermo-Calc i.e. do not save
from within Thermo-Calc.

The reason you do not save from within Thermo-Calc is because of how the file
is saved. When the command sequence (GO POLY3>SAVE <FILE NAME>.POLY3>Y) is
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3
module monitor and all the initial equilibrium points and the mapping/stepping
calculation results are lost as well as parts of the POLY3 file structure (e.g.,
some definitions of the previously defined POURBAIX-type calculation system).
Open an existing POLY3 file created by the Pourbaix module (from a previous Pourbaix
calculation Option 1 or 3 or a previous Stepping calculation Option 4), and selectively
plotting other property diagrams. i.e., open the old GES and POLY3 workspaces; plot pH-Eh
or various property diagrams.
File name /ABCDEF/

The name of a previously saved POLY3 file where the POLY3 and GES5 workspaces is to be
read must be specified. You do not need to enter the file extension if it is the default .POLY3
name. The default file name (e.g. ABCDEF) is the most recent specified POLY3-file name or
RESULT if there is no workspace already saved in the run. You can press <Enter> or type a
specific file name to read the POLY3 and GES5 workspaces from the file.
For Windows, and at the prompt, an Open file window displays if a file name is not given or
the file path is incorrect. The file type (i.e. POLY3) cannot be changed. Click Open or Cancel
to continue with the selected file.
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When the file opens, it confirms on screen what kind of calculation is contained in the POLY3
file. For example: The loaded POLY3 file is of POURBAIX-MAPPING Calculation.
On screen it also lists the system components and the default and predefined calculation
conditions to enable you to review these.
Next you are given a set of properties that are available to be selected as axis variables for
making other diagrams from the same calculation.
Abbreviation

Definition

pH

Acidity

Eh

Electronic potential (V)

Ah

Electronic affinity (kJ)

pe

Electronic activity [log10ACRe)

IS

Ionic strength

TM

Total concentration

Aw

Activity of water

Oc

Osmotic coefficient

MF (AQsp)

Mole fractions of aqueous species

ML (AQsp)

Molalities of aqueous species

AI (AQsp)

Activities of aqueous species

RC (AQsp)

Activity coefficients of Aq species

Where AQsp is the name of a specific aqueous species, and "*" can be used as a wild sign for all AQSp. It is not
necessary to give a complete aqueous species name. However, the entered AQsp name must be unique. If
neither AQsp nor * is given, all species are searched.

The rest of the prompts are the same as with Option 1 and relate to plotting.
Enter ? at any prompt for details.
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Option 3: Open an Existing File and Make Another
Pourbaix Calculation
Copy and Rename the POLY3 file
At the end of a Pourbaix module calculation, a new POLY3 file is automatically saved.
A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.

If you are using a POLY3 file more than once (as is done in the extended
examples), it is recommended that you copy and rename the previouslygenerated POLY3 file. This is so that the required POLY3 file structure and
Pourbaix results are not lost. Do this outside of Thermo-Calc i.e. do not save
from within Thermo-Calc.

The reason you do not save from within Thermo-Calc is because of how the file
is saved. When the command sequence (GO POLY3>SAVE <FILE NAME>.POLY3>Y) is
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3
module monitor and all the initial equilibrium points and the mapping/stepping
calculation results are lost as well as parts of the POLY3 file structure (e.g.,
some definitions of the previously defined POURBAIX-type calculation system).
Open an existing POLY3 file created by the Pourbaix module and make another Pourbaix
diagram calculation i.e. open the old GES and POLY3 workspaces, adopt the defined
chemical system, modify the T-P-X conditions, calculate the initial equilibria, perform the
pH-Eh mapping calculation and plot pH-Eh or other property diagrams.

The rest of the prompts are the same as with Option 1 or Option 2. Enter ? at
any prompt for details.

Modify Label-Texts on the Pourbaix diagram? /N/

Once some labels are written by the Add-Label-Text command onto the diagram, you can
also modify the labels (changing their positions and text contents). The text-size cannot be
changed. The program asks which label and you enter its new X/Y coordinates with the new
text. The new text must not be longer than the old one.
Modify Label-Curve-Option on the Pourbaix diagram? /N/
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Because some phase-region labels have been written onto the diagram, the Label-CurveOption might need to be modified, normally to the Option N.

Important Information About Option 3
The default definitions of the Eh and pH quantities in the advanced Pourbaix module (and in
the ordinary TDB-GES-POLY calculation routines) should ALWAYS be as below:
Eh = MUR(ZE)/RNF
pH = -log10[AI(H+1,AQUEOUS)]
= -log10[ACR(H+1,AQUEOUS)*AH2O]

where RNF is the Faraday constant (96485.309 C/mol), and AH2O is the molecular weight of
H2O (55.508435 g). MUR(ZE) is the electrochemical potential (ECP; in the unit of J/mol;
w.r.t. the standard hydrogen electrode). ACR(H+1,AQUEOUS) is the site-fraction-based
activity of the H+1 aqueous species in AQUEOUS solution phase, but AI(H+1,AQUEOUS) [that
equals ACR(H+1,AQUEOUS)*AH2O] is the molality-based activity of the H+1 aqueous species
that should be used for defining the pH quantity.
Within an aqueous-bearing heterogeneous interaction system, the fundamental systemcomponents must be H2O, H+1 and ZE, which are corresponding to the basic elements O &
H and the hypothetical electron (ZE) in the aqueous solution phase. For the additional
chemical elements in the system, their corresponding system-components shall be defined
as in their element forms (such as Fe, Cr, Mn, Ni, Na, Cl, S) or (for some) in their molecular
forms (e.g., NaCl, H2S). The reference state for the H2O component must always be defined
as the solvent species H2O in the AQUEOUS solution phase under the current temperature
(*) and 100000 Pascal (i.e., 1 bar). The reference states for the H+1 and ZE components are
by default set as their SER.
Various conventional properties of aqueous solute species I are converted in the following
manners:
ML = Y(AQUEOUS,I)*AH2O/YH2O
RC = ACR(I,AQUEOUS)*YH2O/Y(AQUEOUS,I)
AI = RC*ML
= ACR(I,AQUEOUS)*AH2O

where YH2O [i.e., Y(AQUEOUS,H2O)] and Y(AQUEOUS,I) are the site-fractions of solvent
H2O and solute species I.
LIST THE DEFINED AXIS-VARIABLES:
Axis No 1: LNACR(H+1)Min: -34.532525Max: 2.3025851 Inc: 0.8
Axis No 2: MUR(ZE)

Min: -150000

Max: 200000

Inc: 7718.85
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The default settings (listed above) for two mapping variables [in terms of lnACR
(H+1) and MUR(ZE), and their minimum/maximum values and increment steps]
are covering the following pH-Eh ranges/steps:
pH:

0.00 -> 14.00, at a step of 0.35

Eh: -1.55 ->

2.07, at a step of 0.08 (V)

The maximum pH limit has been calculated precisely and determined automatically by the
Pourbaix module, as a function of the temperature-pressure conditions and initial bulk
compositions of the current defined interaction system.

Option 4: Open an Existing File and Make another
Stepping Calculation
Open an existing POLY3 file created by POURBAIX Module (from a previous POURBAIX
calculation Option 1 or 3 or a previous STEPPING calculation Option 4), and make a normal
STEPPING calculation. i.e., open the old GES and POLY3 workspaces; adopt the defined
chemical system; specify one of the T-P-X conditions as the stepping variable; calculate the
initial equilibria; perform the stepping calculation; plot various property diagrams.

Many prompts are the same as with Option 1 or Option 2. Enter ? at any
prompt for details.

Copy and Rename the POLY3 file
At the end of a Pourbaix module calculation, a new POLY3 file is automatically saved.
A reminder that Linux and Mac are case sensitive; when applicable ensure you
enter file extensions with capital letters.

If you are using a POLY3 file more than once (as is done in the extended
examples), it is recommended that you copy and rename the previouslygenerated POLY3 file. This is so that the required POLY3 file structure and
Pourbaix results are not lost. Do this outside of Thermo-Calc i.e. do not save
from within Thermo-Calc.
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The reason you do not save from within Thermo-Calc is because of how the file
is saved. When the command sequence (GO POLY3>SAVE <FILE NAME>.POLY3>Y) is
used, the POLY3 workspace of the POURBAIX calculation results in the POLY3
module monitor and all the initial equilibrium points and the mapping/stepping
calculation results are lost as well as parts of the POLY3 file structure (e.g.,
some definitions of the previously defined POURBAIX-type calculation system).
The stepping calculation modifies the POLY3 file but this can be used for other
Stepping calculations inside the Pourbaix module (e.g. repeating Option 4) or in
normal POLY3 module.

Stepping Parameters
The following parameters are suitable for a STEPPING calculation for the defined aqueousbearing system. Choose one of them as the stepping variable:
T Temperature (C)
P Pressure (bar)
pH Acidity
Eh Electronic Potential (V)
N(Comp) Mole of One Component

where "Comp" is the name of a specific component as listed below. One should not use any
key component (H2O or H+1 or ZE) as such a stepping variable, because of that their
compositional definitions and variations are determined by the AQUEOUS solution phase in
the POURBAIX Module.
An interacting component defined as an element (such as Fe or Na or Cl) can be selected as
a stepping variable.
However, if you want to make a stepping calculation with a non-element chemical formula
(such as NaCl or CaS2) as the stepping variable, one must have made some necessary
modifications in the POLY3 Module, before reaching this point, by conducting some POLY3
commands as given below (as an example for the system Fe-Na-Cl-H-O):
POLY_3: def-component H2O H+1 ZE Fe NaCl Cl
POLY_3: set-ref-state H2O AQUEOUS * 1E5
POLY_3: set-ref-state ZE REF_ELEC * 1E5
POLY_3: change-status phase REF-ELEC=SUSPEND
POLY_3: set-cond b(H2O)=1000 n(H+1)=0 n(ZE)=0
POLY_3: set-cond P=1E5 T=298.15**
POLY_3: set-cond n(Fe)=1E-3 n(Cl)=0 n(NaCl)=3 **
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** Here the P-T-n(Fe) conditions can be set as what you wanted, while the initial n(NaCl)
value must be set as between its minimum and maximum values that you are interested in.
Later on, it will be prompted for specifying the n(NaCl) Min-Max-Step values of the stepping
calculation.
Stepping variable: /T/

The chosen stepping variable must be one of the suitable parameters listed above.
Minimum temperature (C) /15/
Maximum temperature (C) /35/
Increment in temperature (C) /1/

The AQUEOUS solution phase under the defined bulk composition and pressure condition is
stable only between 0 and 99° C. However, you can make a stepping calculation outside this
temperature range, where the AQUEOUS solution phase become metastable. In this case,
the resulting POLY3 file is possibly able to be opened by any other option within the Pourbaix
module.
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Example Using Tabulate Reaction (TAB)
tcex12 - Tabulation of Thermodynamic Data for Reactions
This example shows a number of independent cases using the TABULATE_REACTION (TAB)
module to tabulate thermodynamic data for reactions.
This uses the SSUB database. A license is required to run the example.
These commands are of note and used in this example:
l

TABULATE_REACTION

l

DEFINE_SPECIES

l

ENTER_FUNCTION

l

QUICK_EXPERIMENTAL_PLOT

l

SET_SCALING_STATUS

l

LIST_SUBSTANCES

l

TABULATE_SUBSTANCE
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Example Using REACTOR
tcex24 - Simulation of the Silicon Arc Furnace
This is a simple reactor model with output of gases at the top and output of condensed
phases at the bottom. The gas phase from one segment flows to higher segments, 80%
reacts in the first above, 15% in the second above and 5% in the third above.
The condensed phases flow downwards and all of it goes to the next lowest segment. Heat
can be added at any module. The only way to specify the initial state of the reactants added
to the reactor is to specify the heat content.
This uses the SSUB database. A license is required to run the example.
These commands are of note and used in this example:
l

DEFINE_SPECIES

l

CREATE_STAGE_BOXES

l

CREATE_DIVIDERS

l

CREATE_PIPES

l

START_SIMULATION
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Examples with Database Properties
tcex55 - Plotting Viscosity of Cr-Ni at 1873 K
This is an example of including viscosity in the calculations. This property, and others, are
progressively being added to the Thermo-Calc databases starting with Thermo-Calc software
version 2020a.
Using the FEDEMO database, which is the free demonstration version of the TCS Steel and
Fe-alloys Database (TCFE), the viscosity of metallic liquids is plotted at 1873 K for Cu-Ni and
compared to experimental data from Sato (2005).
Not all databases have this property although it is being added to databases as
these are updated over time. Currently it is available with the latest versions of
TCFE, TCHEA, TCNI and TCAL.

Reference
[2005, Sato] Y. Sato, K. Sugisawa, D. Aoki, T. Yamamura, "Viscosities of Fe–Ni, Fe–Co and Ni–
Co binary melts," Meas. Sci. Technol. 16, 363–371 (2005).

You can learn more about the viscosity model by searching the help (press F1
when in Thermo-Calc).

The example includes an experimental data (*.exp) file called Cr-Ni_1873K.exp.
The same example is also provided in Graphical Mode as T_12_Viscosity_in_CrNi.tcu.

tcex56 - Plotting Surface Tension of Cu-Zr at 1373 K
This is an example of including surface tension in the calculations. This property, and others,
are progressively being added to the Thermo-Calc databases starting with Thermo-Calc
software version 2020a.
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Using the ALDEMO database, which is the free demonstration version of the TCS Al-based
Alloy Database (TCAL), the surface tension of liquid metallic is plotted at 1373 K for Cu-Zr
and compared to experimental data from Krasovskyy (2005).
Not all databases have this property although it is being added to databases as
these are updated over time. Currently it is available with the latest versions of
TCNI and TCAL.

Reference
[2005, Krasovskyy] V. P. Krasovskyy, Y. V. Naidich, N. A. Krasovskaya, "Surface tension and
density of copper–Zirconium alloys in contact with fluoride refractories," J. Mater. Sci.
40, 2367–2369 (2005).

You can learn more about the surface tension model by searching the help
(press F1 when in Thermo-Calc).

The example includes an experimental data (*.exp) file called Cr-Zr_ALDEMO.exp.
The same example is also provided in Graphical Mode as T_11_Surface_
tension_in_Cu-Zr.tcu.
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Application Examples
tcex09 - Calculating a Dew Point with POLY3
This is an example calculating the dew point in the POLY3 module. The SUBDEMO database
is used and included with your installation.
The STEP_WITH_OPTIONS and MAP commands are of note and used in this example.

tcex10 - Preventing Cr2O3 Clogging in a Continuous Casting Process
The example calculates an equilibrium with suspended or dormant phases and shows how to
avoid Cr2O3 clogging in a continuous casting process.
This uses the SLAG database. A license is required to run the example.
The origin of this example is that a manufacturer wanted to increase the Cr content of a
material from 18 to 25 weight percent but the continuous casting of this material was
problematic because solid Cr2O3 was formed.
Using Thermo-Calc to calculate the equilibria in the steel/slag system, a simple correction
was found: modify the Mn or Si content to decrease the oxygen potential. In Thermo-Calc,
you can FIX a phase with zero amount to simulate how to avoid forming this phase. You then
release one of the conditions, usually one of the compositions, and this composition is
determined by the equilibrium calculation.
These commands are of note and used in this example:
l

DEFINE_SYSTEM

l

CHANGE_STATUS

l

COMPUTE_EQUILIBRIUM

l

DEFINE_SYSTEM

l

DEFINE_SYSTEM

l

LIST_CONDITIONS

l

LIST_EQUILIBRIUM

l

LIST_STATUS

l

SET_CONDITION

l

SET_NUMERICAL_LIMITS
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l

SET_REFERENCE_STATE

l

SHOW_VALUE

tcex11 - Oxidation of Cu2S with an H2O/O2 Gas Mixture
This example demonstrates the oxidation of Cu2S with an H2O/O2 gas mixture. Thermo-Calc
is used to find the optimum O/H ratio (i.e. oxygen potential) as certain oxygen potential
values can desulphurize Cu2S without forming copper oxides.
In Thermo-Calc, the problem reduces to perform equilibria calculations in a Cu-S-H-O
system. The amounts of the components should be kept to correct ratio corresponding to
Cu2S and H2O using a command SET_INPUT_AMOUNTS in POLY3. Initially, O/H = 0.5 is
given. Optimum O/H ratio is calculated with the desired calculation conditions. For example,
to simulate one phase disappearing, you can FIX the phase with zero amount.
The tcex11.TDB file is used to access data and this is included with your installation.
These commands are of also of note and used in this example:
l

SET_NUMERICAL_LIMITS

l

SET_REFERENCE_STATE

l

SHOW_VALUE

tcex20 - Adiabatic Decompression in a Geological System
This example calculates the adiabatic decompression in a geological system using the
geochemical database. The database is included with the file named PGEO.TDB, which is in
the same folder as this example.
These commands are of note and used in this example:
l

DEFINE_SYSTEM

l

DEFINE_COMPONENTS

l

SET_INPUT_AMOUNTS

l

LIST_CONDITIONS

l

SET_CONDITION

l

SHOW_VALUE

tcex24 - Simulation of the Silicon Arc Furnace
This is a simple reactor model with output of gases at the top and output of condensed
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phases at the bottom. The gas phase from one segment flows to higher segments, 80%
reacts in the first above, 15% in the second above and 5% in the third above.
The condensed phases flow downwards and all of it goes to the next lowest segment. Heat
can be added at any module. The only way to specify the initial state of the reactants added
to the reactor is to specify the heat content.
This uses the SSUB database. A license is required to run the example.
These commands are of note and used in this example:
l

DEFINE_SPECIES

l

CREATE_STAGE_BOXES

l

CREATE_DIVIDERS

l

CREATE_PIPES

l

START_SIMULATION

tcex25 - Simulating the Refinement of Steel
This example is based on a typical steel refining process. Raw iron used to produce steel
usually has high carbon and silicon content, which is why oxygen is blown into the furnace to
burn off carbon. Lime (CaO) is added to form a slag with silica, and the slag can be
removed. Alloying elements, such as Mn, Ni, Cr and V are added to produce the desired
steel. Since the reaction between O and C increases the temperature, scrap iron is added to
keep the temperature constant (it is assumed the furnace is isolated and no heat is lost to
the environment).
This example simulates blowing oxygen into a liquid steel of one metric ton (1e6 grams)
with 4 w/o C, 2 w/o Si and 1 w/o Mn. 100 moles of CaO (equivalent to 5.6 kg) is added.
Keeping the enthalpy constant is the way to simulate the isolation of the furnace. The oxygen
reacts with carbon and increases the temperature. After blowing a certain amount of
oxygen, scrap iron is added to keep the temperature constant.
This uses the SLAG database. A license is required to run the example.

tcex27 - Calculating Chemical Vapor Depositions (CVD)
This example calculates the chemical vapor deposition (CVD).
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This uses the SSUB database. A license is required to run the example.
These commands are of note and used in this example:
l

DEFINE_COMPONENTS

l

SET_CONDITION

l

ADD_INITIAL_EQUILIBRIUM

l

LIST_AXIS_VARIABLE

l

LIST_INITIAL_EQUILIBRIA

tcex28 - Pitting Resistance Equivalence (PRE) for a Duplex Stainless
Steel
This example calculates the Pitting Resistance Equivalence (PRE) for a duplex stainless steel.
This uses the TCFE database. A license is required to run the example.
These commands are of note and used in this example:
l

REJECT

l

RESTORE

l

DEFINE_ELEMENTS

l

AMEND_PHASE_DESCRIPTION

l

EVALUATE_FUNCTIONS

l

SET_START_CONSTITUTION

tcex29 - Calculating the Speciation of a Gas
This example shows how to calculate the speciation of a gas.
This uses the SSUB database. A license is required to run the example.
These commands are of note and used in this example:
l

SET_INPUT_AMOUNTS

l

LIST_CONDITIONS
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l

SET_CONDITION
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Introduction to Data Optimization
This guide describes the basic idea behind data optimization, contains brief descriptions of
the modules and file types that you work with while doing your optimization, as well as
rough outline of overarching workflow that you typically follow when working with
optimization.
This guide assumes that you are familiar with using Thermo-Calc Console Mode. It also
assumes that you understand the principles of thermodynamics and are familiar with the
theoretical foundations of computational thermodynamics.
Press F1 to search the help for information about all the commands available in
the Thermo-Calc Console Mode, including PARROT and ED_EXP. Note that the
commands listed under PARROT and ED_EXP are only commands that are
specific to PARROT and/or ED_EXP. These modules also contain some
commands that are also available in POLY.
Thermo-Calc Console Mode example tcex36 is a detailed example of
assessment and optimization in Thermo-Calc.
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Data Optimization
In a thermodynamic database, each phase in a system is characterized using a mathematical
model of its Gibbs energy. The Gibbs energy of a phase depends on various state variables. It
can be defined individually even in a heterogeneous system with many stable phases since
the properties of one phase are completely independent of the properties of the other
phases in the system. In most alloy systems, the thermodynamic properties of a phase can
be modelled by expressing how the Gibbs energy depends on temperature and composition.
State variables such as pressure, volume or entropy can also serve as parameters in the
Gibbs energy expression. The Gibbs energy of the whole system is the sum of the products of
the Gibbs energy of each phase multiplied by the amount of that phase.
How the Gibbs energy of the phase varies with various state variables is determined by a
mathematical model and how various adjustable parameters of the model is set. By
optimizing these parameters, you can calculate the thermodynamic properties of a system
under various conditions (by calculating phase diagrams for example). The thermodynamic
properties themselves are functions of temperature, pressure or composition. They include,
among other properties, standard enthalpy of formation, entropy, heat capacity, molar
volume, thermal expansivity, compressibility and Curie temperature for magnetic
transformations.
Data optimization is about adjusting the model parameters so that calculated equilibria fit
well with experimental data. An important part of a data optimization is therefore collecting
and assessing available experimental and theoretical information about phase equilibria and
thermochemical properties of a system.
When you optimize the parameters of the model of a phase, you put what is called
optimizing variables into the Gibbs energy expressions of those parameters. During the
optimization, the values of these variables are varied in order to find a fit between the
calculated equilibria and the experimental data that you base the optimization on. Once you
have settled on a Gibbs energy expression for a certain parameter of a phase of the
element, then you must stick to this expression in all future optimizations involving the
element. If you do not do this, then you must re-optimize all previous systems that involve
this element when the expression is changed.
The Thermo-Calc software allows you to optimize parameters that characterize not only
binary systems, but also ternary system and systems of even higher orders. You can even
optimize parameters that characterize systems of different orders at the same time.
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The Least-Squares Method
Data optimization in Thermo-Calc is based on the least-squares method for fitting values
calculated on the basis of a model with observed quantities. The software is accordingly
trying to find the optimizing variable values that lead the minimized sum of the squares of
the differences between the calculated values and the observed quantities (that is, of the
errors or residuals).
The least-squares method works best under the following conditions:
l

The observed quantities have a Gaussian probability distribution.

l

The observed quantities are only subject to random errors.

l

The different observations (experiments) are uncorrelated

l

The standard deviation of each observation can be estimated.

l

The number of observations is large.

l

The models used give precise predictions.

Of course, these conditions are usually not all met in a normal thermodynamic assessment.
But even in non-ideal conditions, there is no known method that works better than the leastsquares method.
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The CALPHAD Approach
The data optimization functionality in Thermo-Calc works according to the CALPHAD
approach to computational thermodynamics. This approach builds on the development of
models that accurately represent thermodynamic properties for various phases. These
models enable you to predict the thermodynamic properties of multicomponent systemsbased data concerning binary and ternary subsystems. The predictions can take many
factors into accounts, such as, for example, crystallography, type of bonding, order-disorder
transitions and magnetic properties.
CALPHAD is originally an abbreviation of CALculation of PHAse Diagrams, but as the
approach has expanded in scope, it now stands for computer coupling of phase diagrams and
thermochemistry.

References
For in-depth information about CALPHAD as well as data optimization, see Computational
Thermodynamics – The Calphad Method by Hans Leo Lukas, Suzana G. Fries and Bo Sundman
(Cambridge University Press, 2007). CALPHAD was given its first general description in
Computer Calculations of Phase Diagrams by Larry Kaufman and Harold Bernstein (Academic
Press, 1970). The book contains some case studies of optimizations using Thermo-Calc.
Information about the concept of ‘lattice stability’ (which is important for the development
of multicomponent thermodynamic databases) can also be found in the paper Hume-Rothery
and Calphad Thermodynamics by Larry Kaufman, published in Calphad and Alloy
Thermodynamics, edited by Patrice E.A. Turchi, Antonios Gonis, Robert Shull (The Minerals,
Metals & Materials Society, 2002), pp. 3-19.
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Working with Data Optimization in Thermo-Calc
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Data Optimization in Thermo-Calc
The actual performance of the optimization of a system is primarily done in the PARROT
module, and in its sub-module ED_EXP. The POLY and POST modules are used to calculate
and plot property or phase diagrams based on the optimized variables. This allows you to
visually assess how good a fit you have achieved between your calculated results and your
experimental data.
The end result of a successful optimization is typically an updated Thermo-Calc database file
(with filename extension *.TDB) or a new database file.
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Data Optimization Workflow
When you carry out an optimization using Thermo-Calc, you typically follow a workflow as
outlined below.
1. Collect experimental data about your system from various sources such as journal
articles and reports.
2. Create a POP-file in which you enter the experimental data you have collected.
3. Create a setup macro file in which you define your system and the variables you
want to optimize. A useful general procedure is to first find a minimum set of
variables that allows you to calculate most of the experiments.
4. Run the setup macro file.
5. Compile your POP-file. This file often contains errors, which need to be corrected,
and the file recompiled several times before the compilation is completed without
errors.
6. In the ED_EXP module, check that the experiments in your POP-file reach equilibrium
with reasonable results. If any experiments do not reach equilibrium with reasonable
results, then try changing the starting values on equilibrium conditions (such as
composition) to see whether the equilibrium can be computed after all. If this does
not work, then you can temporarily exclude the experiment from the optimization. At
a later stage in the optimization, when the optimizing variables have different values,
you can check whether the experiments can be computed with reasonable results.
7. Back in the PARROT module, run the first optimization cycle and evaluate the
feedback in the console. You can also plot diagrams in the POLY module that allow
you to visually inspect the fit between calculated optimization results and the
experimental data. If you are not satisfied with the fit, then enter the ED_EXP module
again and adjust the weights of the experiments in a way that is likely to improve the
fit and run another optimization cycle. Reiterate until you are satisfied with the fit.
8. Once you get the optimization stable and smooth with the minimum set of variables
chosen in step 3 above, try using different sets of variables to see whether
improvements are possible.
9. When you are satisfied with the fit between calculated results and experimental data
with your final set of optimizing variables, update your setup file and POP-file. In the
setup file, enter the calculated optimizing variable values as the variables’ start
values. In the POP-file, enter the final weights of the experiments. With these files
updated, you can easily regenerate the parameter values of your optimized system.
Having the files updated also makes it easier to optimize the system again in light of
new data or new theoretical models.
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10. Finally, update the database with your calculated results or create a new database
with information about the system that you have optimized.
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The PARROT Module
The PARROT module consists of a comprehensive subroutine package for data evaluation of
thermodynamic model parameters from experimental data. The module has 99 variables
that you can use for optimization and the module can handle a thousand experimental
measurements in an optimization. However, there are limits on the simultaneous numbers
of variables and experiments. These limits are listed at each optimization.
The PARROT module is part of the Thermo-Calc software. The module is not
included in the software development kits (SDKs).
The experimental data is entered and edited in a sub-module of PARROT: The EDIT_
EXPERIMENTS Module.
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The EDIT_EXPERIMENTS Module
The EDIT_EXPERIMENTS module, or ED_EXP for short, is used for entering, evaluating and
editing experimental data. To enter the module, go to The PARROT Module and then issue
the command EDIT_EXPERIMENTS.
Since ED_EXP uses the POLY module for doing equilibrium calculations of experimental data
points, many POLY commands are also available in the ED_EXP module. However, the
commands may work somewhat differently in the two modules. There are also unique ED_
EXP commands which are not found in POLY.
When you execute ED_EXP commands, the PARROT workspace is modified. However, note
that you must always first use READ_WORKSPACES in ED_EXP before doing anything in the
module. The command loads the experimental data that you are going to work with during
the optimization. Furthermore, before leaving ED_EXP you must use SAVE_WORKSPACES or
the results of your work in the ED_EXP module is lost.
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Data Optimization in Other Modules
All kinds of thermodynamic data, calculated equilibrium states or dynamic parameters are
transferred back and forth between the PARROT and the GIBBS module as well between
these and the POLY module. Whenever an optimization run is performed, PARROT calls the
GIBBS module for stored system definition data and model parameters.
In Thermo-Calc, the GIBBS module (the Gibbs Energy System) handles the models of the
various phases that can form in a multicomponent system. It stores thermodynamic data and
performs various Gibbs energy equilibrium calculations. It contains subroutines to
analytically calculate the first and second partial derivatives of integral Gibbs energy with
respect to any set of variables. Many thermodynamic models for various types of substances
are implemented in the module. Some commands that are available in the PARROT module
are also available in the GIBBS module.
In the GIBBS module, parameters of the Gibbs energy models are referred to as TPfunctions.
PARROT calls the POLY module for equilibrium calculations. The POLY module is used for
calculating and storing complex heterogeneous equilibria.
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Optimization File Types
These are the important files you work with when optimizing.
File type

Description

POP-file

The POP-file (Parrot OPtimization file) is the file that contains all the experimental data that
you use for optimizing Gibbs energy values for your system. The POP-file is a plain text file
that contains ED_EXP commands. By default, the file has the filename extension *.POP in
Thermo-Calc.

Setup file

The setup file is a Thermo-Calc macro file (*.TCM). This file typically contains commands
that define your system, opens the PARROT workspace (and associated GIBBS and POLY
workspaces) and sets optimizing variables.

Other
macro files

It is often useful to have other macro files than the setup file at hand while you are doing
your optimization. For example, it is convenient to have a macro file that automatically plots
phase diagrams or other diagrams based on the latest values of your optimizing variables.
An optimization process typically involves many optimization cycles, so this operation needs
to be done many times during a typical optimization.

Workspace
files

The PARROT module has its own workspace with dynamic memories, similar to the
workspaces of POLY and GIBBS. It is stored and updated in a PARROT workspace file with
the filename extension *.PAR. The workspace file is a binary file whose format is hardware
dependent. This means that the format is unique for each type of CPU. Hence, a workspace
file saved on a computer with one type of CPU cannot be used on a computer with another
type of CPU.

EXP-file

The EXP-file is a plain text file with information in the form of DATAPLOT Graphical
Language commands. These commands can specify some or all of the data points in your
POP-file. This allows you to plot these data points on top of your plotted optimization results
(with the POST commands APPEND_EXPERIMENTAL_DATA or QUICK_EXPERIMENTAL_
PLOT). You can then visually assess the fit between these results and the experimental data.
The PARROT workspace is not influenced in any way by the creation or use of EXP-files.
DATPLOT User Guide included with this documentation set.
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Optimization Workspaces
When writing the setup file, you enter a CREATE_NEW_STORE_FILE command which creates
a PARROT workspace file. Alternatively, select an existing PARROT workspace file with SET_
STORE_FILE. The workspace file is automatically updated and saved with the latest
optimization results (after each use of the OPTIMIZE_VARIABLES command). You can also
explicitly instruct Thermo-Calc to save the workspace using SAVE_PARROT_WORKSPACES. If
you want to get rid of your latest changes and return to the state of your workspace when it
was last saved, use READ_PARROT_WORKSPACES.
When the PARROT workspace is saved, parts of the POLY and GIBBS workspaces are also
saved to the PARROT workspace file, along with the PARROT workspace itself. Using the
POLY command SAVE_WORKSPACES creates a new POLY3 file, nothing is saved to the
PARROT workspace file.
If you do any POLY calculations based on data in the current workspace file, then a *.POLY3
file is created, which contains a copy of the current set of parameters. If you continue on
your optimization and read the old *.POLY3 file, then the new set of parameters is
overwritten with the old set. It is therefore recommended that you never read a *.POLY3 or
*.GES5 file while you are doing an optimization.
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Method for Optimization and Simulation
The PARROT module typically uses ordinary POLY minimization for equilibrium calculations.
The global minimization technique that is used in POLY cannot be used because it
automatically creates new composition sets which corrupt the PARROT workspace.
Furthermore, the equilibrium definitions that you use as input for your optimization must
each be attributed to a specific phase. Some of these definitions may specify some local or
partial equilibrium state rather than a global minimum. However, it is possible to use the
global minimization technique for some equilibrium calculations by using the ED_EXP
command ADVANCED_OPTIONS with the Toggle_Alternate option.
Optimization in PARROT is performed on the basis of a ‘maximum likelihood’ principle.
According to this principle, the best fit between various calculated results and all the input of
experimental data is found where the sum of the square of the weighted residuals is at its
minimum.
Typically, the results of an optimization is considered to be better the fewer optimizing
variables that are needed to get the same level of fit between computed results and
experimental data. If you can get almost the same fit using eight instead of twelve
parameters, then this should be considered to be a significant improvement. When more
parameters are used, the values of the individual parameters tend to become unrealistic.
This is particularly true when it comes to temperature-dependent parameters. However,
relatively small differences in the number of parameters are often insignificant. For
example, it does not typically matter whether you used 24 or 25 parameters to reach a
certain degree of fit.
It is often difficult to compare the quality of different optimizations based on the number of
optimizing variables that have been optimized. Since you may rely more or less heavily on
different pieces of available experimental data (and do so with good reason), it is possible
that two different users could end up with very different numbers of parameters for the
same system. For example, suppose you optimize the Fe-Al system to incorporate it into an
Al database, while someone else optimizes the same system to incorporate it into an Fe
database. In this situation, the two of you would probably make different judgements about
which experimental information your calculated results must have a good fit with.
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Creating the POP-File
Before starting an optimization in Thermo-Calc, you must collect relevant experimental data
about your system that is available in the research literature. This data is then entered in the
POP-file. The experimental data points and measurements are entered in this plain text file
in the form of ED_EXP commands.
The syntax of the POP-file is in principle independent of the models used for describing the
phases in the system.
In this section:
Experimental Information

18

POP-File Syntax

21

Entering Experimental Information

23

Using Stability Conditions

34

Grouping Equilibria with Labels

35

Dividing the POP-File into Several Blocks

36
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Experimental Information
An optimization of thermodynamic model parameters should be based on a range of reliable
experimental results that is as wide as possible, as well as on empirical or semi-empirical
correlations and theoretical considerations. During an optimization in Thermo-Calc, many
kinds of thermochemical and thermophysical data can be mixed and used together.
The information needed for an optimization represent measurements of thermodynamic
parameters in the system at equilibrium. These can be measurements of any of the
thermodynamic quantities that can be set as conditions in Thermo-Calc. The information
may represent measurements of activities or enthalpies in single-phase regions for example,
or solubilities or transformation temperatures in a multi-phase region.
For each equilibrium that is used in the optimization, at least one quantity must have been
measured and you also need to know the conditions that must be set to compute the
system’s equilibrium state. For example, consider a binary system in a single-phase region.
Suppose that you have measured the temperature, pressure, composition and the chemical
potential. Three of these quantities are necessary to specify the equilibrium state and the
forth can be used as experimental information to model the phase.
If you have a two-phase region and know the temperature and pressure conditions, as well
as which the stable phases are, then you could use the compositions of one or both phases as
experimental data. The former information about the conditions is sufficient to determine
the equilibrium. The experimental information can then be used to optimize the parameters
that are used to characterise and model the system.
For examples how to enter various kinds of experimental data in the POP-file,
see Experiments and Experimental Data.

Conflicting or Missing Information
You are likely to sometimes have inconsistent or conflicting experimental information. In
principle, all available experimental data should still be entered into the POP-file, unless you
have good reasons to exclude some information. For example, if you have reason to believe
that the samples used in some experiments were not pure, then these experiments could be
excluded from the POP-file.
For some systems, you have very little experimental data to go on. When this is the case, do
not try to fit the available data uncritically with high accuracy without considering possible
errors. You can look for data in systems with similar elements to get an idea about what the
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reasonable estimates of data that is lacking could be. Or you can use calculations from first
principles or semi-empirical methods to get reasonable estimates that can be used as
experimental data.

Invariant Equilibria Information
The most valuable experimental information for an optimization is information about stable
invariant equilibria. An invariant equilibrium is such that neither pressure, temperature nor
composition can be changed without there being a change in the set of phases present in the
system. It is recommended that all information about invariant equilibria for a system is
included in the POP-file. These equilibria need not all be based on explicit experimental
measurements of thermodynamic properties.
Reasonable estimates from available experimental data are often useful to include in the
POP-file. Such estimates, which should be based on the available experimental data, helps
Thermo-Calc find a good set of start values on the optimization variables. However, at the
end of the assessment, these estimated equilibria should be excluded and you should
complete the optimization based only on the experimental information that is based on
measurements.
With some experience from phase diagram evaluation, it is possible to make reasonable
estimates of metastable invariant equilibria. Such estimates helps reduce the number of
phases that are assessed simultaneously during the optimization. For example, you may
assume that a certain intermediate phase does not form in a system. Then extrapolate the
liquidus curves below the stable three-phase equilibria and finally, estimate temperatures
and compositions of metastable three-phase equilibria between two other phases and the
liquid.
Another useful technique is to extrapolate a liquidus line from a peritectic equilibrium to
estimate the congruent melting temperature of a compound. This estimate may be more
useful than the information about the peritectic equilibrium itself as the equilibrium involves
only two phases.

Equilibria in Higher-Order Systems Information
When you optimize a binary system, the available experimental information can often be
described equally well by very different sets of parameters. Information about ternary and
higher order systems that include the components of the binary system are then often useful
for optimizing the binary system (the same is true of information about quaternary system
with respect to optimizing ternary systems). Often, it is only when you extrapolate the
optimized parameters to a higher-order system that you can judge which of the sets of
model parameters that is best. Sometimes information from several ternary systems is
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required to make a reliable judgement about which set of parameters best describes a
particular binary system.

Heat Capacities Information
If you want to optimize your system based on data about heat capacities, then the
corresponding parameters should first be optimized separately before you perform the
general optimization of your system. The parameters should be kept fixed during the
general optimization. This is because it is normally not possible to optimize heat capacity
data together with other data in a meaningful way. If you do this, then it is very likely that
the parameters related to the heat capacity are badly determined.
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POP-File Syntax
It is recommended that you specify an experimental equilibrium as close as possible to
actual experimental conditions. Ideally, there is information about the set of stable phases,
temperature, pressure and some or all compositions for the equilibrium.
In addition, it is recommended that you keep the POP-file well-organised and extensively
commented. This is especially important if someone else reassesses the system when new
experimental information is available.
If you have too many equilibria defined in your file, or if you define equilibria with different
sets of components in the same file, then you must divide the POP-file in blocks (using the
FLUSH_BUFFER command). You know whether you have defined too many equilibria for one
block when you compile the file. A too large number of equilibria leads to an error message
when the file is compiled.
If you use the DEFINE_COMPONENTS command, then it must be the first command in the
POP-file (or if you have several blocks, DEFINE_COMPONENTS can also be put as the first
command after FLUSH_BUFFER). This is because the command automatically reinitiates the
current workspace, so the effect of any commands placed before it are not saved.
The last command in the POP-file should always be SAVE_WORKSPACES .

Legal Commands in a POP-File
The following commands can be used in a POP-file.
l

ADVANCED_OPTIONS

l

CHANGE_STATUS

l

COMMENT

l

CREATE_NEW_EQUILIBRIUM

l

DEFINE_COMPONENTS

l

ENTER_SYMBOL

l

EVALUATE_FUNCTIONS

l

EXPERIMENT

l

EXPORT

l

FLUSH_BUFFER
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l

IMPORT

l

LABEL_DATA

l

SAVE_WORKSPACES

l

SET_ALL_START_VALUES

l

SET_ALTERNATE_CONDITION

l

SET_CONDITION

l

SET_NUMERICAL_LIMITS

l

SET_REFERENCE_STATE

l

SET_START_VALUE

l

SET_WEIGHT

l

TABLE_HEAD, TABLE_VALUES and TABLE_END
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Entering Experimental Information
A POP-file in Thermo-Calc (*.POP) mainly consists of descriptions of equilibria, each
equilibrium describing a data point that is based on an experiment from the existing
literature on your system. An equilibrium is specified using ED_EXP commands.
The following is an example of a specification of an equilibrium with a single stable phase in
the Au-Cu system. Equilibria with a single stable phase are often from experiments where
enthalpies of mixing or chemical potentials have been measured.
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE LIQUID=FIX 1
SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563
SET_REFERENCE_STATE AU LIQ * 1E5
SET_REFERENCE_STATE CU LIQ * 1E5
EXPERIMENT HMR=-1520:200
COMMENT Measurement by Topor and Kleppa, Met trans 1984
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Creating a New Equilibrium
The first command in an equilibrium specification is always CREATE_NEW_EQUILIBRIUM.
This command takes two integers as arguments. The first integer should specify a unique
identifier that can be used later to refer to the equilibrium in question. The second integer is
an initialisation code 0, 1 or 2:
l

l

l

Code 1: This means that all components are entered but all phases are suspended.
This code is appropriate in most cases.
Code 0: This means that all components and phases in the equilibrium are suspended
initially. This code is needed if you are using experimental data about systems of
different orders simultaneously, such as data about both binary and ternary systems
for example.
Code 2: This means that all components and phases are initially entered.

Example
For example, the first command in the example above creates an equilibrium data point
with the unique identifier 1. All components of the system are entered but all phases are
suspended:
CREATE_NEW_EQUILIBRIUM 1 1
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Setting Equilibrium Conditions and its Uncertainty
All the equilibrium-related commands that are placed in between two CREATE_NEW_
EQUILIBRIUM commands are interpreted as specifying the conditions of the equilibrium
created by the first command. The values of these conditions should be based on the
conditions specified in the experiment that you base the equilibrium definition on.

Example
In the example, the CHANGE_STATUS command specifies that the equilibrium is a singlephase equilibrium with the liquid phase.
CHANGE_STATUS PHASE LIQUID=FIX 1

Furthermore, the temperature is 1379 K, the pressure is 1 bar (1E5 Pa) and the mole
fraction of Au is 0.0563.
SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563

Sometimes you have reason to think that some information about an equilibrium condition
may not be accurate. If this is the case, then you specify the degree of uncertainty for a
condition with a colon after the condition quantity, directly followed by either an absolute
value or a percentage. For example, if you have reason to doubt the reliability of the Au
mole fraction measurement, then you could write:
SET_CONDITION T=1379 P=1E5 X(LIQUID,AU)=0.0563:10%

This indicates that you think the Au mole fraction is between 0.0507 and 0.0619. PARROT
calculates the equilibrium twice, once for 0.0507 and once for 0.0619, and then computes
the change of each experimental value between these two equilibria. This change is used to
modify the uncertainty specified for the experimental value.
Entering the Experimental Value and its Uncertainty
The possibility of specifying uncertainties on conditions may be useful when you have
experimental data about a ternary system. In a binary system, a tie-line is determined by the
two phases, the temperature and the pressure. Measurements of the compositions of both
phases can then be used as experimental data. To specify the tie-line in a ternary two-phase
equilibrium one of the four compositions must also be set as a condition. If the
measurement of this composition has the same uncertainty as the other compositions, then
you can assign this same degree of uncertainty both to the composition selected as a
condition and the compositions selected as experimental data. Alternatively, the sample
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(overall) composition could be used as a condition and all four phase compositions could be
used as experiment values. These phases must have the status entered (not fixed) since the
relative amount of each is unknown.
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Setting Reference States
If you want to specify a non-default reference state for one or several of your system
components, then you do this with the SET_REFERENCE_STATE command. In the following
example, the reference state for the liquid phase is set to current temperature (*) and a
pressure of 1E5 Pa.

Example
SET_REFERENCE_STATE AU LIQ * 1E5
SET_REFERENCE_STATE CU LIQ * 1E5

Note that in order for these reference states to be taken into account when the
measurement of the enthalpy per mole of the system is entered with experiment, the Rsuffix must be used.
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Entering the Experimental Value and its Uncertainty
The EXPERIMENT command is used to specify the quantity that the calculated results should
be fitted to. When specifying this quantity, you both specify the measured quantity itself and
your estimation of the uncertainty of this value.

Example
In the example, the EXPERIMENT command specifies the enthalpy per mole of the system,
where this value is specified with respect to non-default reference states that you have set in
the equilibrium specification:
EXPERIMENT HMR=-1520:200

The value before the colon is the quantity of the variable. The value after the colon is an
assessment of the uncertainty of this quantity. A higher value means a greater uncertainty.
In the example, the uncertainty has been specified with an absolute value but it could also
be specified in percent of the quantity:
EXPERIMENT HMR=-1520:13%

Several experiments can be specified after the experiment command. Besides assigning
values to conditions, it is also possible to specify that a certain quantity is greater than or
less than a certain value. For instance, the following command would specify that the
activity of the C-component is less than 0.01 and the mass fraction of the BCC phase of Ag is
greater than 0.05:
EXPERIMENT ACR(C)<0.01:0.001 W(BCC,AG)>0.05:10%

Note that an experimental quantity can typically also be treated as an equilibrium condition,
and vice versa. Which measured quantities that you treat as conditions and which quantities
you treat as experimental data should be based on the accuracy of the different
measurements. In most cases, the quantity that is based on the experimental technique with
the lowest accuracy should be used as the experimental value.
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Entering Many Equilibria as a Table
When one thermodynamic variable (e.g. heat capacity) has been measured as a function of
another (e.g. temperature), then experimental data is often presented as a table. By using
the TABLE_HEAD, TABLE_VALUES and TABLE_END commands, you can enter such experimental
information into the POP-file in the form of a table. These three commands should always
be used together and must be entered in the right order. See TABLE_HEAD, TABLE_VALUES
and TABLE_END.
The TABLE_HEAD command is followed by a number. This number identifies the table as a
whole, but also uniquely identifies the first equilibrium that is included in the table. This
numeric identifier is incremented by one for each additional equilibrium in the table. Each
row in the table represents one equilibrium. Thus, the equilibrium defined by the first row in
the table above (on the line immediately below TABLE_VALUE) is uniquely identified with
the number 1, the equilibrium defined by the second row by number 2, and so on until the
last equilibrium on the sixth row, which is identified by the number 6.
Since the unique identifiers of the equilibria in the table are automatically generated from
the unique numerical identifier that you give to the table, the unique numerical identifier
that is normally given to the CREATE_NEW_EQUILIBRIUM command is replaced by two at
signs (@@).
At least one of the equilibria conditions specified with the SET_CONDITION command must
be a condition whose value is set by the numbers in one of the table columns. To assign the
numbers in a column to a condition, use the syntax SET_CONDITION
<condition>=@<column number>. For instance, in the example above, the mole fraction of
X(ALO3/2) is for each equilibrium given by the number in the first column of the table.
At least one of the measured variables that are entered with the experiment command must
be a variable whose value is set by the numbers in a table column. To assign the numbers in
a column to a measured variable, use the syntax EXPERIMENT <variable>=@<column
number>. In the example above, the measured temperature for each equilibrium is given by
the number in the second table column.
The actual table should be entered between TABLE_VALUES and TABLE_END. Separate the
columns with tabs or any number of spaces. The columns do not have to contain numbers,
but can also contain other types of values, such as phase names for example. If a column
contains text with spaces or special characters, then the text must be surrounded by double
quotes (“ABC DEF&ghi”, for example). The table may have columns that are not used, but
each row must have exactly the same number of columns.

Example
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The following block of commands exemplifies how a table can be entered into a POP-file:
TABLE_HEAD 1
CREATE_NEW_EQUILIBRIUM @@ 1
CHANGE_STATUS PHASE TETR=FIX 0
CHANGE_STATUS PHASE ION=ENT 1
SET_CONDITION P=101325 N=1 ACR(O2,GAS)=.21 X(ALO3/2)=@1
EXPERIMENT T=@2:5
TABLE_VALUE
0.46082476
0.57142380
0.66822276
0.7496 2176
0.50382426
0.63132249
TABLE_END
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Setting Site Fraction Start Values
In some systems, you have to set non-default composition start values on some experiments
in order to get them to converge properly during optimization. This may be important if your
system has a miscibility gap for example, in which case several equilibria with different
compositions exist at certain temperatures. In such cases, you have to make sure it is
specified in the POP-file which side of the miscibility gap the equilibrium is on. The
calculated equilibrium could otherwise end up on the wrong side, resulting in a large error.
In the POP-file, you can set the site fraction of a constituent on an equilibrium with SET_
START_VALUE.

Example
For example, the following command sets the composition start value of VA constituent of
the FCC_A1 phase to 0.99:
SET_START_VALUE Y(FCC_A1,VA#2)=0.99

Setting the mole fraction for a component in a phase is not as reliable as setting the site
fraction.
Additional equilibria entered after the last SET_START_VALUE command are automatically
given a similar start value if the following command appears previously in the POP-file:
SET_ALL_START_VALUES Y

If start values are not set automatically for phase constituents, then you may have to set the
composition start value for each equilibrium (or table of equilibria) separately.
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Commenting About an Equilibrium
The COMMENT command inserts a comment about the equilibrium that is saved to the
PARROT workspace file when the POP-file is compiled. The comment must be entered on
one line.
Comments can also be entered immediately after a dollar sign ($), but these are not saved
to the PARROT workspace. Instead, these comments are ignored by Thermo-Calc when the
POP-file is compiled.
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Simultaneous Use of Binary and Ternary Experiments
You can use experimental information about binary and ternary systems (as well as systems
of even higher order) in the same POP-file and optimization. To do this, you must inform the
PARROT module that not all components of the ternary system (or system of even higher
order) should be considered. This allows you, for example, to use experimental information
about a binary equilibrium that exists within a ternary system.
Use CHANGE_STATUS with the keyword component and which components that should be
entered. You should also give the initialization code 0 (rather than 1) to the CREATE_NEW_
EQUILIBRIUM command. This code indicates that all components must be entered.

Example
For example, the following set of ED_EXP commands characterises a binary (A-B) threephase equilibrium (FCC-BCC-LIQ) in a ternary system (A-B-C). It can be used in a POP-file
that otherwise only contain experimental information about the ternary system (A-B-C):
CREATE_NEW_EQUILIBRIUM 1 0
CHANGE_STATUS COMPONENT A B = ENTERED
CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1
SET_CONDITION P=1E5
EXPERIMENT T=1177:10
COMMENT from A-B
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Using Stability Conditions
Early in the optimization when parameter values are not so good it is often useful to set the
driving force for precipitation of a phase (per mole of components) to make sure that it
appears where it should. The DGM condition is very useful for making sure that phases
appear where they should. It can be removed when the optimization becomes stable.
The DGM condition is also useful for suppressing phases that appear where they should not
appear. Do this by setting the value and the uncertainty to something reasonable. For
example, the driving force for precipitation of the BCC phase could be set as follows:
DGM(BCC)<-0.1:0.1

This produces an error even before BCC becomes stable and the weight of the experiment in
question can be adjusted as needed. If you specify that the driving force for the BCC phase
should be below 0 (DGM(BCC)<0:1E-4 for example), then the optimization converges
extremely slowly (if at all). With such a sharp error condition, calculating the equilibrium is
like finding the minimum point on a lawn that gently slopes towards a rock wall. The
optimization keeps bouncing into the wall.
Another useful stability condition is the phase stability function, abbreviated QF. This can be
used to specify that a phase is outside the miscibility gap for a solution phase. If QF(phase) is
negative, then the phase is inside the miscibility gap; if QF(phase) is positive, then it is
outside the miscibility gap.
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Grouping Equilibria with Labels
If you have several equilibria describing experiments that you want to be able to treat
collectively, you can give all of the equilibria one and the same label.
Use LABEL to give an equilibrium a label. The label must start with the letter A and can only
be up to four characters long. For example, you can insert the following command in several
equilibria specifications:
LABEL ALH

During the optimization, you could use this label to, for example, set all the equilibria that
have it to the same weight in the ED_EXP module.
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Dividing the POP-File into Several Blocks
For two different reasons, you may have to divide your POP-file into different blocks:
l

l

PARROT uses a buffer for storing compiled experimental data. If there is not enough
memory in this buffer for storing all the experiments from the POP-file, then the
POP-file can be divided into several blocks. When PARROT encounters the end of a
POP-file block, it saves the experimental data that has been compiled to PARROT
workspace, clears out the memory buffer and then proceeds to read the next block in
the POP-file. This goes on until the experimental data from all the blocks have been
saved to the PARROT workspace.
If you want to put equilibria with different sets of components in one and the same
POP-file, then you must divide the file up into blocks. Each block should only contain
equilibria that all have the same set of components.

To divide the equilibria in the POP-file into different blocks, enter the FLUSH_BUFFER
command between two equilibria. This command marks the beginning of new block. When
the command is encountered during the compilation of the POP-file, the compilation of the
current block is terminated, the equilibria saved to the PARROT workspace file and a new
block is initiated. That the buffer is reinitiated means that all functions and constants that
were entered in the previous block must be entered again in new block in order to be used.
When editing your experimental data in the ED_EXP module, you can select which block to
load and edit using READ_WORKSPACES <block number>. The block before the first
instance of FLUSH_BUFFER is block number 1, the block after the first instance and before
the second instance is block number 2, and so on.
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The Setup File
In this section:
Creating the Setup File

38

Defining the System

39

Entering the Optimizing Variables

40

Initializing Optimizing Variables in PARROT

44

Creating the Workspace File

45

Compiling the POP-file

46

Returning Control to the Console

47
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Creating the Setup File
The second step is to create the setup file. This is an ordinary Thermo-Calc macro file
(*.TCM). Typically, your setup file should contain the following:
l

A system definition.

l

A section where you enter model parameters and optimizing variables.

l

A GO PARROT command.

l

l

l

l

A section where initial values are assigned to the optimizing variables for the first
optimization cycle.
A CREATE_NEW_STORE_FILE <filename.par> which creates the PARROT
workspace file onto which the results of your optimization are continuously saved and
updated. By default this workspace file has the same filename as the setup file, but
with the *.PAR filename extension.
A COMPILE_EXPERIMENTS <filename.pop> command. Since you often encounter
syntax errors when you first try to compile a POP-file, it may be useful to execute this
command from the console rather than as part of the setup macro file.
Normally, you also have a SET_INTERACTIVE at the end of the setup file. This
command returns control over Thermo-Calc to the console.

It is possible to interactively execute all these commands one at a time in the console. It may
be instructive to enter the commands that would normally go into the setup file interactively
while using the on-line help while you are learning to use the PARROT module.
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Defining the System
If you have an existing database with information about your system, then you can write the
system definition part of your setup file in two different ways.
l

l

If you have an unencrypted user database, then you can define your system by
entering DATA module commands directly in the setup file. Use the DATA commands
that you normally use to define a system when doing equilibrium calculations in
Thermo-Calc Console Mode.
Define your system by entering DATA module commands directly in the console, then
generate a macro file with the GIBBS command LIST_DATA <name of setup
file>.tcm p . This command saves all the data that has been loaded in the GIBBS
workspace as a macro file. This file can then be modified as required into an
optimization setup file.

Creating Additional Composition Sets of a Phase
If you need several composition sets of a phase, then these should be created with the GIBBS
command AMEND_PHASE_DESCRIPTION <phase name> composition_sets
<composition set number> in the setup file.
If you add composition sets of a phase after the POP-file has been compiled, the
data structure in the workspace is corrupted and you have to recompile the
POP-file.
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Entering the Optimizing Variables
When you have retrieved the data about your system for the setup file, you must manually
enter the model parameters that you want to optimize. This is done using the GIBBS
command ENTER_PARAMETER, but when you specify the Gibbs energy expression for the
parameter, you enter variables that can be given various values into the expression. It is the
values of these variables (and thus, the Gibbs energy of the parameter) that you are
optimizing.
How you in detail specify the optimizing variables in your set up file depends on which phase
you are trying to optimize and what thermodynamic model that is used in the optimization.
Thermodynamic Models
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Entering Optimizing Variables in Parameter Specifications
There are ninety-nine predefined variables in the PARROT module which you can use in your
optimization. These variables are referred to as V1, V2, V3, … V98 and V 99. When the GIBBS
workspace is initialised, all optimizing variables are set to a fixed numerical value of zero.
When you do an optimization, there is always some variable for which you want to evaluate
the best value, but you can assign fixed values to optimizing variables too. It is often useful
to enter all the variables that you can conceivably want to optimize, and then you can
interactively select and change which variable to focus at various stages of the optimization.
The setup file excerpts that follow show how optimizing variables are entered. However,
before the optimizing variables are introduced in this example, the following command
enters an ionic liquid solution phase (a phase for which you have some experimental
information):
ENTER_PHASE IONIC_LIQ Y,
AL+3,ZR+4 ; ALO2-1,O-2 ; N N

This ENTER_PHASE command enters a phase called IONIC_LIQ into the GIBBS workspace.
This phase is of the type ionic liquid solution, which is specified by type code Y. Such a phase
is modelled by the Ionic Two Sublattice Liquid Model. The next two arguments specify the
two sublattices, in this case the cations AL+3,ZR+4 and the anions ALO2-1,O-2. Components
that interact in a sublattice are separated by a comma. The first N at the end means that no
additional constituents are added to the phase. The second N means that a list of possible
parameters for the phase should not be shown in the console.
There are model parameters that describe the phase which you do not want to optimize, in
which case the Gibbs energy expression of the parameter does not contain any optimizing
variables.

Example 1
For example, the following parameters of the IONIC_LIQ phase do not contain any
optimizing variables:
ENTER_PARAMETER G(IONIC_LIQ,AL+3:ALO2-1;0) 298.15 +2*GAL2O3_L;
6000 N
ENTER_PARAMETER G(IONIC_LIQ,AL+3:O-2;0) 298.15 +GAL2O3_L+400000;
6000 N
ENTER_PARAMETER G(IONIC_LIQ,ZR+4:O-2;0) 298.15 +2*GZRO2L; 6000 N
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These parameters define the Gibbs energy expressions for three constituents in the
constituent array, namely AL+3:ALO2-1, AL+3:O-2 and ZR+4:O-2. The names that occur in
these expressions—that is, GAL2O3_L and GZRO2L—are the names of complex functions of
temperature that are entered in the GIBBS workspace with the ENTER_SYMBOL command.
The numbers that frame the Gibbs energy expressions specify the temperature range within
which the expression should be applied. In the above, the expressions are applied in a
temperature range from 298.15 K to 6000 K.

Example 2
In this example, suppose that you want to optimize the model parameter for the ZR+4:ALO21 combination, then you could enter the variables V1 and V2 in the Gibbs energy expression
for that parameter in the following way:
ENTER_PARAMETER G(IONIC_LIQ,ZR+4:ALO2-1;0) 298.15 +GZRO2L
+2*GAL2O3_L +V1+V2*T; 6000 N

You normally have different optimizing variables in different parameters, but in some cases
you may want several parameters to vary together, in which case you can use the same
variable in the Gibbs energy expressions of several parameters.
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Entering Interaction Parameters
For some systems, you have to consider interaction parameters in order to take excess Gibbs
energy into account and correctly model the phase. By default, the software uses a RedlichKister expression for the excess Gibbs energy. The coefficient is entered after the constituent
array when you use the ENTER_PARAMETER command. In the last section, all the
parameters were entered with a coefficient of zero (0).

Example
To take account of the excess Gibbs energy, you might enter the following:
ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;0) 298.15
6000 N

+V11+V12*T;

ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;1) 298.15
6000 N

+V13+V14*T;

ENTER_PARAMETER L(IONIC_LIQ,ZR+4:ALO2-1,O-2;2) 298.15
6000 N

+V15+V16*T;

Parameters with interaction coefficients are referred to as interaction parameters. The
regular parameter has a coefficient of 0. The subregular parameter has a coefficient of 1. It
is possible to interaction coefficients up to a value of 9, but you are advised not to use more
than three coefficients (that is, with coefficient values of 0, 1 and 2).
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Initializing Optimizing Variables in PARROT
Variables that have been entered into Gibbs energy expressions for model parameters in the
setup file has to be initialized and given start values before they are optimized.
You have to estimate what start values to give to the optimizing variables based on your
knowledge of the system or of relevantly similar systems. There are no general rules for
what start values your optimizing variables should have. If you are not able to make any
informed estimation about what start values to use, then you may not be able to find a good
fit between your experimental data and your calculated results. In this case, it is often best
to start the optimization in the so-called alternate mode. In alternate mode, the PARROT
module helps you find some reasonable start values for your optimizing variables.
About Alternate Mode
Even if you are starting your optimization in alternate mode, you still have to initialize the
optimizing variables though (you can all give them a start value of 0).
To initialize an optimizing variable and to give it a start value, use either SET_OPTIMIZING_
VARIABLE or SET_SCALED_VARIABLE. Using SET-OPTIMZING_VARIABLE results in a scaling
factor equal to the current value of the parameter unless the current value is zero, in which
case the scaling factor is 1000. This is typically appropriate for enthalpic parameters, but not
necessarily for other parameters. The scaling factor is the factor by which the optimizing
variable value is varied during the optimization.

Example
For example, if you want to optimize the variables V1, V2, V11, V13 and V17, then you could
enter the following in the setup file:
SET_OPTIMIZING_VARIABLE 1 +43000
SET_OPTIMIZING_VARIABLE 2 -35.2
SET_OPTIMIZING_VARIABLE 11 +72000
SET_OPTIMIZING_VARIABLE 13 +27000
SET_OPTIMIZING_VARIABLE 17 -100000

The value given to each optimizing variable (+43000 for variable V1 for example) is also that
variable’s initial scaling factor. If you want to set the initial scaling factor of a variable to a
value that is lower or higher than its start value, then use SET-SCALED_VARIABLE <start
value><scaling factor><min value><max value>.
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Creating the Workspace File
In the setup file, after the system definition and the entered optimizing variables, use the
PARROT command CREATE_NEW_STORE_FILE to create and save a PARROT workspace file
for the system defined in the setup file. For example, the following command saves all
current data on system definitions (elements, species, components, phases), symbol
definitions (constants, variables, functions, tables) and parameters that are stored in the
workspace used by GIBBS, POLY and PARROT into a file called AL2O3-ZRO2.PAR:
CREATE_NEW_STORE_FILE AL2O3-ZRO2

The experimental information in the POP-file is not saved to this PARROT
workspace file.
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Compiling the POP-file
At the end of the setup file, use the command COMPILE_EXPERIMENTS followed by the
name of your POP-file to compile the data in that file and save it to the current PARROT
workspace file. Note that you must first have opened or created a new PARROT workspace
file before you compile your POP-file. The other argument to the command can typically be
given default values with comma signs (,):
COMPILE_EXPERIMENTS AL2O3-ZRO2.POP,,,

If Thermo-Calc encounters errors in the syntax of the POP-file, then error messages are
displayed in the console. Normally, the compilation also stops when syntax errors are
encountered. If this happens, then you must correct the errors and recompile the file. It is
useful to have two console windows open when you do this. That way, you can use one
console for editing the experimental data and another console for compiling and reading
any further error messages.
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Returning Control to the Console
Put the command SET_INTERACTIVE at the end of the setup file if you want to return control
to the console when the commands in the setup file have all been executed.
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Optimizing in PARROT
In this section:
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Optimizing the System in PARROT
When you have created a POP-file, a setup macro file and (optionally) EXP-files, you should
start doing optimization runs interactively in the console. This process can be divided into a
number of steps (such as running optimization, evaluating optimization results, modifying
weights and models and adding new information), but usually, you have to go through many
optimization cycles before achieving a satisfactory fit between calculation results and
experimental data.
Typically, it is not obvious when an optimization is finished. You must exercise your
judgement about when the fit you have achieved is good enough.
It is possible to interactively change almost everything in the initial setup macro
file and in the POP-file. For example, you can add more parameters to be
optimized and modify or add more experimental information.
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Changes that Require POP-file Recompilation
Some changes that you do interactively in the PARROT module or the ED_EXP sub-module
destroys the data structure in the workspace. For example, if you add more composition sets
to a phase, then the number of phases actually change and the links break between the
experimental data and the thermodynamic models. Note that if the global minimization
technique is used in POLY, then new composition sets that corrupts the PARROT workspace
may be created automatically. If this happens, then you have to compile the POP-file again.
If you recompile the POP-file, then the experimental equilibria are calculated with the
default start values.
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Optimization Workflow
Normally, the workflow during an optimization is the following:
1. In the PARROT module, run the setup macro file using MACRO_FILE_OPEN.
2. Go to ED_EXP with EDIT_EXPERIMENTS, use READ_WORKSPACES to load your
experimental data and then execute .
3. If an equilibrium cannot be computed, then this either means that the start values
(site fractions, for example) were inappropriate or that the equilibrium cannot be
calculated with the current set of parameters. If the latter, then the equilibrium may
have to be excluded from the optimization. However, you should make an effort to
exclude the possibility that the reason is just that you do not have the appropriate
start values for the equilibrium.
4. When each equilibrium is either successfully computed or excluded from the
calculation, go back to the PARROT module and run the OPTIMIZE_VARIABLES
command. Give the number of optimization iterations you want the Thermo-Calc
program to carry out as an argument to the command. This number specifies how
many different sets of values for the optimizing variables that PARROT tries to fit
with the experimental data. It is recommended that you run 0 iterations first to see
the discrepancy between the experimental data and the initial calculated results. The
current workspace file is automatically updated with the last set of optimized
variables and calculated results.
5. List and evaluate the result of the optimization using LIST_RESULT. Typically, what is
of interest in the results are the relative standard deviation of the optimizing
variables and the error values in the list of calculated experimental data results. If
the relative standard deviation for an optimizing variable is very large, this means
that the variable doesn’t have any effect on the computed results and that the
variable should not be used (you can make PARROT ignore the variable by setting its
value to 0 with SET_FIX_VARIABLE). If the relative standard deviation is close to zero
for a variable, then this might indicate that you need to use more variables. When it
comes to errors in the calculated equilibrium results, these can be decreased by
lowering the weight that PARROT gives the experiment in the calculation (the more
weight, the more the experiment affects the calculated results).
6. Use OPTIMIZE_VARIABLES or CONTINUE_OPTIMIZATION to carry out a new
optimization cycle. Go back to step 5 above and continue to do optimization cycles
until you judge that there is a good enough fit between your calculated results and
your experimental data. It is recommended that you do not only rely on feedback
from LIST_RESULT but also frequently plot various diagrams and compare them
visually to some of your experimental data.
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Ensuring Computation of all Equilibria
When you have run the setup macro file, you should start by trying to compute all the
equilibria that were created when your POP-file was compiled. To do this, you must first go
to the ED_EXP submodule, and load the experimental data from the current PARROT
workspace file with the READ_WORKSPACES <block #> command (normally, the block
number is 1).
When you have loaded all equilibria, you should try to compute them all using the ED_EXP
command . A list of calculated equilibrium results are shown in the console, but the software
is not able to reach an equilibrium for an experiment, then the program cancels the
calculations and displays an error message.
The following list shows an example output where the first two experiments in the POP-file
have been successfully computed, but an equilibrium is not reached for the third
experiment. No other equilibria are computed, since the calculations are aborted when the
error occurs.
Eq

Lab

Iter Weight Temp

Exp

Fix phases or comments

1 A1

22

1.

2575.3

IONIC_ FLUORI TETR

2 A1

18

1.

2156.9

IONIC_ CORUND TETR

*** ERROR

1614 IN QTHISS

*** CONDITIONS CAN NOT BE FULLFILLED

When this happens, try to find out why the equilibrium calculation fail. Are the condition
start values that you have given the equilibrium inappropriate for example? If you have a
similar equilibrium that has already been successfully computed, then you can select the
equilibrium that does not work, use the ED_EXP command SET_ALL_START_VALUES and
accept all the suggestions for the site fractions. Alternatively, use TRANSFER_START_VALUE
<equilibrium number> to make the currently selected equilibrium inherit the start values
of the indicated equilibrium. Run COMPUTE_EQUILIBRIUM again to see if the equilibrium
can be computed with the inherited start value.
If you cannot find an explanation of why the equilibrium cannot be computed, then it may be
that the experiment is faulty. If so, then this experiment should be excluded from the
optimization by being given a weight of 0. You should then run COMPUTE_EQUILIBRIUM
again to make sure that all equilibria can be computed. However, experiments that fail to
reach equilibria could succeed in doing so if the optimizing variables have other values. It is
therefore sometimes worth trying to include experiments later in the optimization process
(when the optimizing variables are relatively close to their final values), even if they had to
be excluded at its start. In some cases, it might also be appropriate to change the error
tolerance for in an experiment (using the ED_EXP command EXPERIMENT).
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You must save the PARROT workspace with SAVE_WORKSPACES before you exit
the ED_EXP module.
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Setting Weights
To change the weight of an experiment, first enter the ED_EXP module from PARROT using
EDIT_EXPERIMENTS. Then use the SET_WEIGHT command to set the weight for a specific
equilibrium (equilibrium number 3 for example), for a range of equilibria (the equilibria 1019) or all the equilibria that have a certain label (such as all the equilibria with the label A1).
To save the new weight(s), use SAVE_WORKSPACES .
By default, all the experimental information in your POP-file is treated equally: each
experiment has a weight of 1. However, experiments that you excluded because they did not
reach equilibrium now have a weight of 0. The higher the weight of an experiment is, the
more Thermo-Calc tries to ensure that the computed result fits the condition measured in
that experiment.
The contribution of an experiment’s error to the sum of errors is multiplied by the square of
the weight set for that experiment. In other words, if you want to cut the error of an
experiment with weight 1.0 by half, then you should use a weight of 0.7. This makes the
experiment’s error 0.49. Setting the weight to 1.4 instead makes the error twice as large
(1.96).
Note that if you use READ_WORKSPACES after you have changed weights on the
experiments, your changes are lost unless you have saved those changes. In the ED_EXP
module, you can get a list of all the experiments in the console if you first read the
experimental data from the workspace file (with READ_WORKSPACES) and then use LIST_
ALL_EQUILIBRIA.
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Optimizing and Evaluating Results
When you have ensured that all the experimental data points can reach equilibrium, go back
to the PARROT module and use OPTIMIZE_VARIABLES <number of iterations> with 0
iterations. Present the result of this initial optimization by using LIST_RESULT.
When evaluating the optimization results, the most important information is found in the list
of experiments at the end of the listed results. The rightmost column shows the difference
between the value of the experimental data and the value computed by Thermo-Calc in the
last optimization cycle.
The following shows part of list of experiments in the output of a LIST_RESULT command:

The experiments for which the optimization has not found a good fit are marked with an
asterisk (*) or a hash sign (#) in the rightmost column. An asterisk in this column indicates
that the experiment has an error that is larger than the error tolerance and a hash sign
indicates that the error is much larger. The error tolerance depends on the degree of
accuracy set for that particular piece of experimental information. The error values are
presented in the next to rightmost column.
Note that if you are optimizing in alternate mode, then you usually do not need to change
the weights for the experiments. Instead, you can simply run OPTIMIZE_VARIABLES again,
specifying, say, thirty iterations, evaluate the results again, and continue in that way until
you are satisfied with the results.
About Alternate Mode
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The Critical Set of Experiments
The set of weighted experiments that you end up with as a result of your optimization is
referred to as the critical set of experiments. When you work to determine this set and the
weights of the experiments, the following factors should be reflected in both the selection of
experiments and the weights of those experiments:
l
l

l

The reliability of the experimental technique.
The extent of agreement/disagreement between independent measurements of the
same quantity.
The extent of agreement/disagreement between data obtained with different
experimental methods.
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Continuing the Optimization and Resetting Variables
To continue the optimization after you have used OPTIMIZE_VARIABLES, you can either use
this command and enter <Number of iterations> again or CONTINUE_OPTIMIZATION
<Number of iterations>.
If you use CONTINUE_OPTIMIZATION, then PARROT continues the optimization using the
same Hessian matrix. If the optimization is going well but you run out of iterations, then
continuing with the same Hessian matrix may be useful.
As before, use LIST_RESULT to inspect the fit between the calculated and the experimental
values for your experiments. If necessary, adjust the weights of the experiments again in the
ED_EXP module. You may even discover that you have to exclude additional experiments
from the optimization.
Besides looking at the rightmost column in the list of experiments (that is produced when
you use LIST_RESULT), it is also useful to look at the sum of squares of the errors of all the
variables. This is shown in the output of OPTIMIZE_VARIABLES and CONTINUE_
OPTIMIZATION. This sum should be as low as possible.
The following shows part of the output that you get when using LIST_RESULT:

In the example you can see that the sum of squares have decreased slightly. (The final sum
of squares that you get after an optimization run is also presented directly in the output
from OPTIMIZE_VARIABLES and CONTINUE_OPTIMIZATION.) As long as the sum of squares
figure is decreasing, the optimization is working as it should.
When your calculated results have been improving for a while, that is, when the sum of
squares has been decreasing, and you are confident that you are making definitive progress,
then you should use the PARROT command RESCALE_VARIABLES to reset the starting values
of the optimizing variables to their current values. When you do this, the start values and
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scaling factors of the optimizing variables (shown in the table’s third column in the
preceding screen shot), are all set to the current values (shown in the table’s second
column).
If your optimization is not going well, then you may want to reset the values of your
optimization variables to their current start values. To do this, use RECOVER_VARIABLES.
After rescaling the variables, continue the optimization using OPTIMIZE_VARIABLES again.
Cycle through calls of the commands OPTIMIZE_VARIABLES/CONTINUE_OPTIMIZATION,
CONTINUE_OPTIMIZATION, RESCALE_VARIABLES and OPTIMIZE_VARIABLES again until your
set of optimizing variables does not seem to improve anymore. Even when it seems to you
that you have reached this point, it is recommended that you use OPTIMIZE_
VARIABLES/CONTINUE_OPTIMIZATION a few extra times to make sure that the variable
values cannot be further improved, that is, that the sum of squares of the errors of all the
variables cannot be reduced further. If the final solution is repeatedly calculated after the
same number of iterations and reaching the same result, then it is generally reasonable to
accept the current variable values.
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Updating the Set of Optimizing Variables
Besides evaluating the fit between the calculated results and the experimental data, you
should also ensure that you have the right number of optimizing variables. If you have too
many or too few optimizing variables, then you may not be able to use your model to
accurately extrapolate thermodynamic properties in a wide range of temperature, pressure
and composition conditions.
With more optimization parameters, the sum of errors usually decrease, but the parameters
also tend to become less precisely determined. A measure of this precision is the Relative
Standard Deviation (RSD) of each optimizing variable. However, the RSD is only significant if
you have used RESCALE_VARIABLES followed by an optimization which converges and the
values of the variables do not change much. The RSD tells you how much the parameter can
be changed in either a positive or in a negative direction without changing the reduced sum
of errors with more than one unit.
A large RSD value thus means that the parameter has not been determined well.

If such a significant RSD has a value larger than 1, then this typically means that you are
using too many optimizing variables. However, the RSD values also depend on the weighting
of the experiments, so it is sometimes possible to reduce the RSD by changing weights.
The RSD should not be too low either. If one or more of them is very close to 0, then this
suggests that you are trying to optimize the system with too few optimizing variables. You
can add optimizing variables interactively using ENTER_PARAMETER in GIBBS. However, it is
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recommended that you add a sufficient number of variables in the setup file from the start
so that do not need to do this. You can fix variables to a value of 0 until you discover that
they are needed.
Besides the RSD, you should also keep an eye on the variable values themselves (shown in
the VALUE column, next to the leftmost column in the table shown in the preceding
screenshot). If the value of a variable is in the order of 1E5 or higher and this variable has
been put in the temperature-independent part of an interaction parameter’s Gibbs energy
expression, then you may not have the right weights on your experiments or you are using
too many optimizing variables. This is also typically the case if a variable with a value in the
order of 10 or more (per mole atoms) is in the temperature-dependent part of the Gibbs
energy expression of an interaction parameter. Such a high parameter value may lead to
inverted miscibility gaps or re-stabilisation of a phase at high temperature. It is important to
keep an eye on this since the temperature-independent and the temperature-dependent
interaction parameter often varies together. If the temperature-dependent interaction
parameter cannot be reliably determined, you may have to fix its value.
Note that even if you have found a good enough fit between calculated and experimental
values after an optimization run, a parameter value may suddenly start to change by several
orders of magnitude when you use OPTIMIZE_VARIABLES is used again. If this happens, then
careful reconsideration of the weighting of the experiments of the set of optimizing
variables is required. However, when the optimization has converged and the parameter
values remain stable after repeated use of OPTIMZE_VARIALBES, this should usually not
happen.
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Reducing the Number of Optimizing Variables
If you have one or more optimizing variables with RSD larger than 1, then you should
remove one or more of the variables by setting them to a value of 0, or alternately, set them
to a reliably estimated value (estimated based on, for example, semi-empirical methods).
To fix an optimizing variable to certain value, use the PARROT command SET_FIX_VARIABLE
<variable number> <value>.
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Plotting Intermediate Results
It is typically not sufficient to look at the plain text output of LIST_RESULT to reliably judge
how the optimization is progressing. Plotting a phase or property diagram of the system you
are optimizing using the POLY and POST modules is often very useful.
It is recommended that you create a macro file for plotting the diagram since you probably
want to repeatedly plot the diagram as you progress with the optimization. This macro file
can then be called directly from the PARROT module with the MACRO_FILE_OPEN
command.
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Superimposing Experimental Data from EXP-files
If you create one or several EXP-files based on the experiments in your POP-file, you can
visually compare the fit your plot and the experimental data you are optimizing the system
against. An EXP-file contains data points specified in the DATAPLOT format. You could make
an EXP-file for each type of data that you are using in the optimization.
Use the POST command APPEND_EXPERIMENTAL_DATA to superimpose the data points in
an EXP-file on a phase or property diagram that you have plotted. For example, to put the
experimental data points from a file entitled DP.EXP onto a plotted diagram, you could enter
the following:
APPEND_EXPERIMENTAL_DATA Y DP.EXP 0 1

Such a command call tells Thermo-Calc to superimpose the data points in dataset 1 of
DP.EXP onto the plot in the Console Results window, but not to impose any information about
axis scaling, labels and other information which is normally found in the prologue of the
DP.EXP file.
The POST command QUICK_EXPERIMENTAL_PLOT can also be used to superimpose data
points on a plotted phase or property diagram.
DATPLOT User Guide included with this documentation set.
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Finalizing the Optimization
In this section:
Finishing the Optimization
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Finishing the Optimization
When to stop optimizing is a matter of judgement. It is rarely the case that you finish
optimizing a system with the feeling that it cannot be improved.
The final step is to update your files with the final results. Besides updating your database
file (or alternatively, creating a new database file), it is advised that you also update your
setup and POP-files with the final weights and optimizing variable values.
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Rounding off Optimizing Variable Values
When you save the optimizing variable values, it is important that you round off the values
correctly. When you have a metallic system, it is usually best to keep whatever number of
decimal digits that you need to make less than one J/mol difference at 1000 K. When you
have an aqueous system or a system that you are optimizing based on data from very
different temperature ranges, then this is not always the only appropriate guideline.
However, rounding off the values in such a way that it gives a difference that is larger than
one J/mol may lead to differences in the phase diagram.
Another approach you can take when rounding off variable values is by progressively fixing
the value of more and more of the variables. This allows you to round-off all but one of the
variables values so that each only has a few significant digits. Variables whose values have
been rounded off in this way are easier to handle compared with those that that are
rounded off so that they continue to have many significant (non-zero) digits.
To round off the variable values according to this second approach, first use SET_FIX_
VARIABLE to set the variable(s) with the highest RSD to a rounded off value (such as, say,
0.4). When you then re-optimize using OPTIMIZE_VARIABLES, the sum or errors changes.
However, you should get almost exactly the same sum of errors as before after you rescale
the variable values using RESCALE_VARIABLES. (If the sum of errors is different, then this
means that the variable with the highest RSD was not rounded off in a good way.) If you
successfully round off the first variable value, then continue to round of the optimizing
variable which now has the highest RSD. Continue doing this until you have fixed all but one
of the optimizing variables to their rounded-off values. The final sum of errors that you get
after having fixed the variable values should not deviate significantly from the initial sum of
errors you had before starting to round-off the variable values.
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Updating the Database File
About the Database Files
To update the database file (with filename extension TDB) open it in a text editor and enter
or update each of the parameters that you have optimized.
For example, suppose you have the following command in your setup file:
ENTER_PARAMETER L(IONIC_LIQ,AL+3,ZR+4:O-2;0) 298.15

+V17; 6000 N

If you then end up with a value for optimizing variable V17 of -100000, then you should enter
the following under the IONIC_LIQ phase in the database file:
PARAM L(IONIC_LIQ,AL+3,ZR+4:O-2;0) 298.15 -100000; 6000 N REF !

If you often need to round-off the optimizing variable value in some way, see
Rounding off Optimizing Variable Values.
When you have updated or entered the parameters that you optimized, save the database
file.
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Creating a Database File
In some circumstances you may want to save all the information about your system into a
new database file. To do this, go to the GIBBS module and use LIST_DATA <Filename> N.
This creates a new user database file that contains all the information about the system that
is in the workspace.
The N-argument tells the LIST_DATA command to save the output into database file rather
than some other type of file, such as a macro file for example. Note that the output
database file that you get from LIST_DATA have to undergo some manual editing before it
can be used as proper database file.
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Updating the Setup File and the POP-file
It may be useful for you to be able to recreate your optimization from scratch. It is therefore
recommended that you do the following when you are done with the optimization:
l

l

Update your POP-file so that it contains the weights of your critical set of
experiments. Use SET_WEIGHT to set the weights directly in the POP-file. You may
also have to use SET_START_VALUE for some conditions in the POP-file. Otherwise,
you may not be able to compute the equilibria with .
Copy the final values of your optimizing variables and set them as start values of the
variables in the setup macro file (with SET_FIX_VARIABLE).

It is important that you round off the values of the optimizing variables
correctly. See Rounding off Optimizing Variable Values. When you have done
this, you can run the setup macro file to recreate the final result of the
optimization.

Data Optimization User Guide ǀ 69 of 106

Thermo-Calc Documentation Set

Alternate Mode
In this section:
About Alternate Mode

71

Optimizing in Alternate Mode

72

Preparing the POP-file for Alternate Mode

73

Examples of SET_ALTERNATE_CONDITION

74
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About Alternate Mode
To turn Alternate Mode ON or OFF, use the PARROT command SET_ALTERNATE_MODE.
When you have one or more multi-phase equilibria (that is, with the fixed phase-status) in
your POP-file and the optimizing values lack appropriate starting values (such as the default
value of 0 for example), then Thermo-Calc may not be able to compute the equilibria for the
experiments. In these cases, a common tangent cannot be found, that is, a state where the
chemical potentials for all components are the same in all phases cannot be found. A
common tangent may not exist or it be found at the wrong composition or temperature
given the initial set of model parameters.
If you are not able to estimate reasonable starting values for the optimizing variables, then
this problem can be overcome by initially running your optimization in alternate mode. The
alternate mode in PARROT module should help you find reasonable starting values for the
optimizing variables. Note that you are only supposed to use alternate mode in the
beginning of the optimization. Once you have achieved a reasonable fit between calculated
results and experimental data, turn off alternate mode and calculate all equilibria again in
the normal mode.
In alternate mode, PARROT modifies multi-phase equilibria so that the chemical potentials
for each stable phases is calculated separately. For example, consider the following
experimental equilibrium:
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE LIQ FCC=FIX 1
SET_CONDITION T=1000 P=1E5
EXPERIMENT X(LIQ,B)=.2:.01 X(FCC,B)=.1

When PARROT optimizes in alternate mode, the computation of this equilibrium is done by
way of the following two calculations:
CHANGE_STATUS PHASE LIQ=FIX 1
SET_CONDITION T=1000 P=1E5 X(LIQ,B)=.2
CHANGE_STATUS PHASE FCC=FIX 1
SET_CONDITION T=1000 P=1E5 X(FCC,B)=.1

The difference between the chemical potentials in every pair of phases is calculated and
PARROT tries to adjust the parameters of the phases so that these differences are
minimized. In other words, PARROT tries to make the chemical potentials equal in all
phases. For PARROT to be able to do this, some additional information about the
experimental multi-phase equilibria is required, at least for all invariant equilibria.
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Optimizing in Alternate Mode
When you are optimizing in the alternate mode, you usually do not need to enter the ED_
EXP module and manually change the weights of experiments that the computed results
have not been fitted well with. Instead, after using OPTIMIZE_VARIABLES initially with no
iterations, and listing the result with LIST_RESULT, simply run OPTIMIZE_VARIABLES again
specifying, say, thirty iterations. Continue to optimize until your optimization seems to be
going in the right direction, then set the optimizing variables’ starting values to their current
values use RESCALE_VARIABLES before you turn alternate mode off by answering N at the
SET_ALTERNATE_MODE prompt.
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Preparing the POP-file for Alternate Mode
Information in your POP-file that concerns equilibria with ENTERED or DORMANT phases is
ignored when you optimize in alternate mode.
To use the alternate mode, ensure that there is enough information about each phase in a
given equilibrium. In addition to the temperature and pressure of the system, you should
specify the composition of all phases in a given equilibrium. This is done with, SET_
CONDITION, EXPERIMENTor SET_ALTERNATE_CONDITION.
If both compositions of a binary tie-line have been measured, then you could specify this in
the POP-file in the following way:
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC BCC=FIX 1
SET_CONDITION P=1E5 T=1000
EXPERIMENT X(BCC,B)=.2:.01 X(FCC,B)=.3:.01

This equilibrium could be calculated with alternate mode without any modification. The
compositions specified with the experiment command is used as condition when the
thermodynamic properties of each phase are calculated.
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Examples of SET_ALTERNATE_CONDITION
The following topics demonstrate how SET_ALTERNATE_CONDITION is used to prepare
different kinds of equilibria for optimization in alternate mode.

How to Specify the Composition of One Side of a Binary Tie-Line
If only one side of the tie-line has been measured, then you must provide an estimate of the
composition of the other phase. You can make such an estimate with SET_ALTERNATE_
CONDITION. This command has no effect unless alternate mode is turned on. The
equilibrium described could thus be specified in the following way:
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC BCC=FIX 1
SET_CONDITION P=1E5 T=1000
EXPERIMENT X(BCC,B)=.2:.01
SET_ALTERNATE_CONDITION X(FCC,B)=.3

When the alternate mode is turned on, the composition given by the SET_ALTERNATE_
CONDITION command is used for the FCC phase. The properties of the BCC phase is
calculated using the composition specified by experiment as a condition.

How to Specify the Compositions of a Three-Phase Equilibrium
If you have a three-phase equilibrium in your POP-file, then one of its compositions can be
specified as experimentally determined, while two can be provided as alternate conditions:
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1
SET_CONDITION P=1E5
EXPERIMENT T=912:5 X(LIQ,B)=0.2:.02
SET_ALTERNATE_CONDITION X(FCC,B)=0.1 X(BCC,B)=.4

How to Specify the Composition of a Stoichiometric Phase
When you specify the composition of stoichiometric phase with SET_ALTERNATE_
CONDITION, the value must be given with at least seven decimal digits, as in the following
example:
CREATE_NEW_EQUILIBRIUM 1 1
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CHANGE_STATUS PHASE LIQ A2B=FIX 1
SET_CONDITION P=1E5 X(LIQ,B)=0.2
EXPERIMENT T=992:5
SET_ALTERNATE_CONDITION X(A2B,B)=.6666667

Entering Other Experiments in the POP with Alternate
Mode
The following table shows some additional examples of how to enter different kinds of
experiments in the POP-file when you are using the alternate mode.
Example

ED_EXP commands

Two-phase equilibrium:
The melting
CHANGE_STATUS PHASE LIQUID FCC=FIX 1 SET_CONDITION X(FCC,CU)=0.14 P=1E5
temperature of an Au-Cu EXPERIMENT T=970:2 SET_ALTERNATE_CONDITION X(LIQUID,CU)=0.16
alloy
Invariant equilibrium
experiment: A threephase equilibrium in a
binary system
Ternary system, with
two compositions
measured (both with
uncertainty 0.02)

CREATE_NEW_EQUILIBRIUM 1 1 CHANGE_STATUS PHASE FCC BCC LIQUID=FIX 1 SET_
CONDITION P=1E5
EXPERIMENT T=912:5 SET_ALTERNATE_CONDITION X(FCC,B)=0.1SET_ALTERNATE_
CONDITION X(BCC,B)=0.4SET_ALTERNATE_CONDITION X(LIQ,B)=0.2
CREATE_NEW_EQUILIBRUM 1 1 CHANGE_STATUS PHASE FCC BCC=FIX 1 SET_CONDITION
T=1273 P=1E5 SET_CONDITION X(FCC,B)=0.1:0.02 EXPERIMENT X(FCC,C)=0.12:.02
SET_ALTERNATE_CONDITION X(BCC,B)=0.17 SET_ALTERNATE_CONDITION X
(BCC,C)=0.07
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Troubleshooting
During an optimization, you are likely to run into many different problems and challenges.
This topic gives some general guidelines that can help avoid common mistakes and
problems.
In this section:
Useful Guidelines

77

Excluding and Including the Correct Equilibria

79

Conflicting Data

80
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Useful Guidelines
The following rules of thumb are generally good to adhere to when you are planning and
executing an optimization:
l

Do not use data from thermochemical tables of unknown origin.

l

Use experimentally determined properties; avoid converted quantities.

l

Carefully estimate the accuracy of the experiments.

l

Correct systematic errors (by adjusting a temperature scale for example).

l

l

l

l

l

l

l

Use negative information such as, for example, the information that a phase should
not be stable in a composition or temperature region.
With a hundred activity measurements in a system but only ten composition points
from the phase diagram, it is often appropriate to decrease the weights on the
activity experiments.
If you initially exclude any intermediate phases to only optimize the liquid and the
terminal or end-member phases for the pure components, then it is often useful to
compute a metastable phase diagram with just these phases. In the metastable
phase diagram, the metastable solubility lines should not have any strange kinks or
turns. Such a diagram is often also useful to compute at later stages in the
optimization.
When you have fitted the liquid phase and some solution phases reasonably well,
then you can fix the optimizing variables that characterise these phases. You can
then go on and optimize the variables for the intermediate phases.
Phases with miscibility gaps are always difficult to optimize. Try to keep control of
the miscibility gaps by using real or estimated experimental information. (Note that
it is not possible to calculate the top of a miscibility gap as a single equilibrium.)
Phases with order/disorder transformation are often difficult to optimize. It may be
difficult to find the right start values on the optimizing variables. The TABULATION
module can be useful sometimes. Properties for specified site fractions can be
calculated in the TABULATION module. This is not possible in the POLY module since
this module only calculates for equilibrium site fractions. The ordered state may also
disappear during the optimization of these phases. If this happens, you may be able
to add an experiment that controls the state of order.
Only use the alternate mode to find an initial set of model parameters that can then
be make it possible to calculate the experimental equilibria in the normal mode.
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l

l

When you have achieved a satisfactory fit between calculated results and
experimental data with an appropriate number of optimization variables, perform a
couple of final optimization runs to make sure that your results are stable.
Make sure that the values of the optimizing variables keep within a reasonable
range. If a variable starts to change several orders of magnitudes, then you must
consider whether you have the right weights on the experiments and whether you
are using too many optimizing variables.
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Excluding and Including the Correct Equilibria
Use as few experiments as possible initially to get a reasonable overall fit. It is generally
best to first focus on the invariant equilibria, as well as metastable states that can be
estimated by excluding some phases. Crucially, any experiments for which the computed
results are clearly faulty should be excluded from the final critical set, while all important
invariant equilibria are calculated and included in this critical set.
If you cannot compute some invariant equilibria with intermediate phases, then it may be
best to first exclude those phases from the optimization and only optimize the liquid and the
most important solution phases. After you have obtained reasonable results for these
phases, you can enter the intermediate phases back in again. With the variables for the
optimized liquid and solid phases set fixed, you can finally optimize the intermediate phases.
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Conflicting Data
It is important that you do not include conflicting sets of data at the same time during an
optimization. After all, if they are genuinely conflicting, then at least one of the sets must be
incorrect. If you have conflicting sets of data, then only use one of these sets at a time
together with the rest of the data. Often, the optimization makes it clear which dataset
coheres best with the other information that is available about the system.
Sometimes, conflicting data cannot be detected directly. For example, you may have activity
data which is inconsistent with solubility data from the phase diagram. This would be
indicated by large errors in the fit when both the activity data and the solubility data are
included. To find these inconsistencies, let alone correct the errors, you may thus have to
optimize with some datasets excluded.
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Experiments and Experimental Data
These topics contain examples of different kinds of equilibria in different kinds of systems.
They are intended to help you figure out how to use various kinds of experimental data when
creating POP-files. The topics that follow contain examples how to enter various kinds of
experimental data into a POP-file.
In this section:
Phase Diagram Data

82

Data for Individual Compounds

84

Single Phase Mixing Enthalpies or Partial Enthalpies

86

Enthalpies of Formation and Enthalpies of Reactions

87

Chemical Potentials via EMF Measurements

88

Driving Force for Metastable Phases

89

Pressure-Temperature-Volume EOS Data

90

Crystal Structure, Lattice Parameters and Site-Occupancy

91

Magnetism and Other Atomistic Properties

92

Data About Systems of Different Orders

93
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Phase Diagram Data
P-T-X phase diagram data for binary and ternary systems, or systems of even higher order
can be used in the POP-file. This includes data of the following types:
l

l

l

l

Data about the temperature- and composition-dependence of various properties
(obtained from differential thermal analysis (DTA) measurements for example),
including enthalpy, lattice parameter, dilatometric length, electronic conductivity
and magnetic susceptibility;
Data about reaction types (invariant/monovariant) and phase relations obtained
from qualitative or quantitative metallographic studies;
Data about phase amounts or compositions obtained from microprobe
measurements (using X-ray spectroscopy or transmission electron microscopy
(TEM));
Data about the positions or directions of two-phase tie-lines and three-phase
equilibria for ternary systems.

Example
The following table shows a POP-file excerpt that demonstrates how some kinds of phase
diagram data can be entered:
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1

Solidus (melting
temperature) of an Au-Cu
alloy

CHANGE_STATUS PHASE LIQUID FCC=FIX 1
SET_CONDITION X(FCC,CU)=0.14 P=1E5
EXPERIMENT T=970:2
CREATE_NEW_EQUILIBRIUM 1 1

Three-phase equilibrium in a
binary A-B system

CHANGE_STATUS PHASE FCC BCC LIQUID=FIX 1
SET_CONDITION P=1E5
EXPERIMENT T=912:5
CREATE_NEW_EQUILIBRIUM 1 1

Congruent transformation in
a binary A-B system

CHANGE_STATUS PHASE BCC LIQUID=FIX 1
SET_CONDITION P=1E5 X(BCC,B)-X(LIQ,B)=0
EXPERIMENT T=1213:10
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Example

ED_EXP commands
An uncertainty factor is set not only for the experimental measurement, but
also for the X(FCC,B) condition. The factor is 0.02.

Tie-line in a ternary A-B-C
system

CREATE_NEW_EQUILIBRUM 1 1
CHANGE_STATUS PHASE FCC BCC=FIX 1
SET_CONDITION T=1273 P=1E5 X(FCC,B)=0.1:0.02
EXPERIMENT X(FCC,C)=0.12:.02
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Data for Individual Compounds
You can use data about individual components in the POP-file. Such data includes activity,
heat capacity, heat content, entropy, Gibbs energy of phase transformations, heat of
transition and heat of melting.

Examples
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC_A1=FIX 1
CHANGE_STATUS PHASE GRAPHITE=D

Carbon activity data in the fcc phase

SET_REFERENCE_STATE C GRAPHITE,,,,
SET_CONDITION P=101325 T=1273 X(MN)=0.03
SET_CONDITION X(C)=0.03
EXPERIMENT ACR(C)=0.29:5%
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE IONIC_LIQ=FIX 1
CHANGE_STATUS PHASE GAS=D

Ln(activity coefficient for O)

SET_CONDITION X(O)=0.02 T=1523 P=101325
SET_REFERENCE_STATE O GAS,,,,
ENTER_SYMBOL FUNCTION LNFO=LOG(ACR(O)/X(O));
EXPERIMENT LNFO=-1.5:0.01
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE CU2O=FIX 1

Entropy at 298.15 K of Cu2O

CHANGE_STATUS PHASE CUO=FIX 0
SET_CONDITION P=101325 T=298.15
EXPERIMENT S=92.36:1
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE SPINEL=ENT 1
CHANGE_STATUS PHASE FCC O2GAS=DORM

Gibbs energy of formation of NiAl2O4 SET_REFERENCE_STATE NI FCC,,,,
SET_REFERENCE_STATE AL FCC,,,,
SET_REFERENCE_STATE O O2GAS,,,,
SET_CONDITION P=101325 T=1000 N(NI)=1 N(AL)=2
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Example

ED_EXP commands
SET_CONDITION N(O)=4
EXPERIMENT GM=-298911:5%
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE SPINEL=ENT 1
SET_CONDITION P=101325 N(FE)=2 N(MG)=1 N(O)=4

Heat capacity of MgFe2O4

SET_CONDITION T=800
ENTER_SYMBOL FUNCTION CP=H.T;
EXPERIMENT CP=207:5%
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE SPINEL=ENT 1
SET_CONDITION P=101325 T=298.15 N(MN)=1 N(FE)=2
SET_CONDITION N(O)=4
ENTER_SYMBOL VAR H298=H;

Heat content (H-H298) for MnFe2O4

ENTER_SYMBOL FUN HMNFE2O4=H-H298;
CREATE_NEW_EQUILIBRIUM 2 1
CHANGE_STATUS PHASE SPINEL=ENT 1
SET_CONDITION P=101325 N(MN)=1 N(FE)=2 N(O)=4
SET_CONDITION T=400
EXPERIMENT HMNFE2O4=16610:5%
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Single Phase Mixing Enthalpies or Partial Enthalpies
You can use calorimetric data for mixing in the POP-file. This data could be the result of, for
example, drop calorimetry or scanning calorimetry. This includes data about, for example,
enthalpy of mixing of liquids, series of mixing-enthalpy and about partial enthalpy.
Information about enthalpies of mixing can also be derived from theoretical principles using
special quasi-random structures (SQSs).
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE LIQUID=FIX 1
SET_CONDITION T=1379 P=1E5

Enthalpy of mixing in the liquid state of an Au-Cu alloy SET_CONDITION X(LIQUID,AU)=0.0563
SET_REFERENCE_STATE AU LIQ * 1E5
SET_REFERENCE_STATE CU LIQ * 1E5
EXPERIMENT HMR=-1520:200
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Enthalpies of Formation and Enthalpies of Reactions
You can use calorimetric data for phase transformations in the POP-file. This data could be
the result of, for example, direct-reaction calorimetry, solution calorimetry or combustion
calorimetry. Information about enthalpies of formation can also be derived from theoretical
principles.

Examples
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE CORUNDUM ZRO2_TETR=FIX 0
CHANGE_STATUS PHASE IONIC_LIQ=ENT 1

Enthalpy of melting of the eutectic in the Al2O3-ZrO2
binary (J/g)

SET_CONDITION P=101325 N=1 LNAC(O)=-80
SET_REFERENCE_STATE ZRO2 TETR,,,,,,
SET_REFERENCE_STATE AL2O3 CORUND,,,,,,
EXPERIMENT HWR=1080:90
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE ZRO2_MONO HALITE CAZRO3_
O=ENT 1

Enthalpy of formation of o-CaZrO3 from the component
oxides

SET_CONDITION T=298.15 P=101325 N(CAO)=.5
SET_CONDITION N(ZRO2)=.5 LNAC(O)=-20
SET_REFERENCE_STATE CAO HALITE,,,,
SET_REFERENCE_STATE ZRO2 ZRO2_MONO,,,,
EXPERIMENT HMR(CAZRO3_O)=-15960:5%
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Chemical Potentials via EMF Measurements
You can use chemical potentials and activities/activity coefficients from electromagnetic
field (EMF) measurements in the POP-file.

Example
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC CU2O=FIX 1
CHANGE_STATUS PHASE O2GAS=DORM

Emf data on Cu(s)/Cu2O(s)

SET_CONDITION P=101325 T=1000
SET_REFERENCE_STATE O O2GAS,, 100000
EXPERIMENT MUR(O)=-95387:1000
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Driving Force for Metastable Phases
You can use chemical driving forces for metastable phases in the POP-file.

Examples
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC_A1 M7C3 M23C6=FIX 1

To prevent BCC_A2 to be stable

CHANGE_STATUS PHASE BCC_A2=D
SET_CONDITION P=101325 T=1473
EXPERIMENT DGM(BCC)<-0.1:0.1
CHANGE_STATUS PHASE BCC M7C3 GRAPHITE=FIX 1
CHANGE_STATUS PHASE CEMENTITE=DORMANT

To promote CEMENTITE to be stable

SET_CONDITION P=P0 T=973
EXPERIMENT DGM(CEM)>0.1:0.01
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Pressure-Temperature-Volume EOS Data
You can use Pressure-Temperature-Volume Equation of State (EOS) data in the POP-file.
Such data includes, for example, molar volume, density, thermal expansion and bulk
modulus/compressibility.
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE LIQUID=ENT 1

Volume of liquid Pt

SET_CONDITION P=101325 N=1 T=1873
EXPERIMENT VM=1.00758E-5:5%
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC_A1=ENT 1

Thermal expansion

SET_CONDITION P=101325 N=1 T=400
ENTER_SYMBOL FUNCTION ALPHA=VM.T/VM/3;
EXPERIMENT ALPHA=2.35E-5:5%
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Crystal Structure, Lattice Parameters and SiteOccupancy
You use information about defects, ordering or site occupancy, as well as information about
crystal structures in the form of lattice parameter values. This information may come from
measurements made by X-ray, neutron diffraction, Mössbauer spectroscopy or perturbed
angular-correlation.

Examples
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE FCC_A1=ENT 1
SET_CONDITION P=101325 N=1 T=298.15

Lattice parameter for fcc

SET_CONDITION X(CR)=0.05
ENTER_SYMBOL FUNCTION LPFCC=((4*VM/6.02214179E23)**
(1/3))*1E10;
EXPERIMENT LPFCC=4.02:5%
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE BCC_A2=ENT 1
SET_CONDITION P=101325 N=1 T=298.15

Lattice parameter for bcc

SET_CONDITION X(AL)=0.08
ENTER_SYMBOL FUNCTION LPBCC=((2*VM/6.02214179E23)**
(1/3))*1E10;
EXPERIMENT LPBCC=2.90:5%
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE SPINEL=ENT 1

Site-occupancy, degree of inversion for
spinel

SET_CONDITION P=101325 N(MG)=1 N(AL)=2 N(O)=4
SET_CONDITION T=1073
EXPERIMENT Y(SPINEL,AL+3#1)=0.31:5%
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Magnetism and Other Atomistic Properties
You can use data about atomistic properties such as magnetism and Curie temperatures in
the POP-file.

Example
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 1
CHANGE_STATUS PHASE SPINEL=ENT 1

Curie temperature of MnxFe3-xO4, x=1.26 SET_CONDITION T=520 P=101325 N(O)=4
SET_CONDITION N(FE)+N(MN)=3 N(MN)=1.26
EXPERIMENT TC(SPINEL)=520:5
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Data About Systems of Different Orders
You might want to use data about systems of different orders in the same optimization, such
as data about a binary equilibrium with components A and B in a ternary system with
components A, B and C, together with data about equilibria in the binary system with
components A and B. To do this, you must first suspend all components in the ternary system
(A, B and C), and then set the two components you want binary information on (A and B) to
status ENTERED.
Suspending all components is done by giving the initialization code 0 to the CREATE_NEW_
EQUILIBRIUM command. The components about which you want to use binary information
must then be entered again using the CHANGE_STATUS command.
Example

ED_EXP commands
CREATE_NEW_EQUILIBRIUM 1 0
CHANGE_STATUS COMPONENT A B = ENTERED

A binary (A-B) three-phase equilibrium (FCCBCC-LIQ) in a ternary system (A-B-C)

CHANGE_STATUS PHASE FCC BCC LIQ=FIX 1
SET_CONDITION P=1E5
EXPERIMENT T=1177:10
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Thermodynamic Models
The most common models used in assessments are described briefly in these topics.
Examples of how to write the phase definitions in the setup-file are also given for each of
these models. In addition to the models described here, a large number of thermodynamic
models for various phases in different states have been implemented.
In this section:
Gas

95

Compound Energy Formalism

96

Substitutional Liquid

97

Ionic Two-Sublattice Liquid Model

98

Models for Ordered Phases

99

4SL Model for FCC, HCP and BCC

101

2SL Model for FCC, HCP and BCC

103

Magnetic Ordering

104

Molar Volumes and High Pressure

105

Excess Models

106
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Gas
The gaseous mixture phase is usually treated as a substitutional phase without sublattice. In
the gaseous mixture phase, there are usually molecules formed, and the number of
constituents of the gas phase is often much larger than the number of elements. These
complex constituents have to be defined as species. The ideal gas model may handle a gas
phase under low pressures (and low temperatures). This implies that the P-V-T relations and
thermodynamic properties of pure gaseous species are calculated as for ideal gas, and that
there is interaction between gaseous species in the mixture. In a defined system, there may
only exist one gaseous mixture phase. Type code G is used for the gas phase:
ENTER_PHASE GAS G, 1 H,H1O1,H1O2,H2,H2O1,H2O2,O,O2,O3; N N
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Compound Energy Formalism
If the atoms are sufficiently different in size, electronegativity or charge, they may prefer
different types of sites in the lattice of crystalline solids. In some cases, a solute atom may
even occupy interstitial sites between the normal lattice sites. All such phenomena are
treated in Thermo-Calc by the sublattice concept. The Compound Energy Formalism (CEF)
has proved to be the most general formalism for many different types of solution phases. It
is therefore by default applied to various solid solution phases in the Thermo-Calc software
package. CEF can also take ionic constraints (charged cation/anion species) into account. For
a comprehensive description on the CEF, please see Hillert (2001), Frisk and Selleby (2001),
Sundman and Ågren (1981).
Since the CEF is used by default, no special notation is needed in the phase definition, except
for ionic phases, where type code I is given.

Examples
Examples of phase definitions in a setup-file using the CEF:
ENTER_PHASE SPINEL I, 4 1 2 2 4
FE+2,FE+3; FE+2,FE+3,VA; FE+2,VA; O-2; N N
ENTER_PHASE SIGMA, 3 10 4 16
AL,CO,CR,FE,NB; AL,CO,CR,FE,NB; AL,CO,CR,FE,NB; N N
ENTER_PHASE FCC_A1, 2 1 1
CR,FE,MN; C,N,VA; N N
ENTER_PHASE BCC_A2, 2 1 3
CR,FE,MN,VA; C,N,VA; N N
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Substitutional Liquid
The liquid phase is normally (but not always) modelled as a substitutional phase with no
sublattice, which is occupied by two or more constituents. The constituents are normally the
elements, but molecules or associates can also be used. Type code L is used for the liquid
phase.

Example
ENTER_PHASE LIQUID L, 1
AL,C,CR,FE,MO,NI,SI ;

N N

ENTER_PHASE LIQUID L, 1
C,FE,FEO,FEO3/2,NI,NIO ;

N N
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Ionic Two-Sublattice Liquid Model
Within the framework of the CEF, the ionic two-sublattice liquid (I2SL) model was developed
to be used when there is a tendency for ionization in the liquid, which happens in liquid
oxides and sulphides for example. The same model can be used both for metallic and oxide
melts. At low levels of oxygen, the model becomes equivalent to a substitutional solution
model between metallic atoms. Two sublattices are assumed, one containing charged
cations and one containing charged anions, neutrals and vacancies. The complication for an
ionic liquid is that the numbers of sites on the cation sublattice and anion sublattice vary
with the composition to preserve electroneutrality. For a comprehensive description on the
I2SL model, see Hillert et al. (1985), Sundman (1991). In these references, the possible
excess parameters are also discussed. Type code Y is used for the I2SL model.

Example
Examples of phase definitions in a setup-file:
ENTER_PHASE LIQUID Y,
AL+3,CR+2,FE+2,NI+2; VA; N N
ENTER_PHASE IONIC_LIQ Y,
CA+2,MG+2; O-2; N N
ENTER_PHASE IONIC_LIQ Y,
AL+3,CA+2,FE+2,MG+2,SI+4;
ALO2-1,O-2,SIO4-4,VA,FEO3/2,SIO2; N N

Data Optimization User Guide ǀ 98 of 106

Thermo-Calc Documentation Set

Models for Ordered Phases
Some solution phases have chemical order-disorder transformations: for example, the
disordered FCC_A1 phase can transform to the ordered L12 or L10 structure where the
atoms of different kinds occupy different sublattices. In some cases, it may be advantageous
and easy to describe such ordered structures as completely different phases; but in some
other cases, like the B2-ordered BCC structure in Al-Fe, the disordered and ordered
structures must be described as one singe phase because the transformation is of second
order along a line in temperature and composition.
The ordering can easily be described by the CEF. For instance, an ordered FCC phase with
only L12 or L10 ordering can be efficiently handled by the so-called Two SubstitutionalSublattice Ordering Model (2SL model), while an ordered FCC with both L12 and L10
ordering must be described with four sublattices using the so-called Four SubstitutionalSublattice Ordering Model (4SL model). Please note that in both these models, all the
substitutional constituents must enter into these sublattices. In addition, you may also have
one sublattice for interstitials.
Thermo-Calc supports a feature of splitting the parameters of a chemically ordered phase
onto two different phase descriptions. This is very convenient. In this way, you can have one
phase for all parameters describing the disordered state (the configuration independent
state) and in the other phase only those parameters needed to describe the remaining part
(the configuration dependent part), that is, the Gibbs energy contribution due to the
ordering transformation. This has been implemented in such a way that the contribution
from the configuration dependent part is zero when the solution phase is disordered. The
optimization of the disordered phase is independent of the order-disorder transformation;
the ordering energy is an add-on to the disordered part. This is particularly useful in higher
order systems, as an ordered phase can dissolve several elements that have no particular
contribution to the actual ordering. The phases Gibbs energy add together by giving this
command in the setup-file: AMEND_PHASE_DESCRIPTION <ordered phase> disordered_
part <disordered phase>

Since PARROT does not automatically create new composition sets, it is necessary to create
composition sets for both the ordered and disordered phases in the setup-file: Amend_
phase_description <phase> composition_sets <new highest set number>,,,,

Example
Example of phase definitions for the corresponding disordered and ordered parts in a setupfile:
ENTER_PHASE FCC_A1, 2 1 1
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AL,CR,FE,NI; VA; N N
ENTER_PHASE FCC_L12, 3 .75 .25 1
AL,CR,FE,NI ; AL,CR,FE,NI; VA; N N
AMEND_PHASE_DESCRIPTION FCC_L12 DIS_PART FCC_A1
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4SL Model for FCC, HCP and BCC
Ordered FCC, HCP and BCC solution phases handled by the 4SL model requires four
sublattices for substitutional ordering and can additionally have an interstitial sublattice. A
4SL model is especially useful for modelling different kinds of ordered phases that are based
on the same disordered phase, such as L10 and L12 based on FCC_A1, and B2, D03, L21 and
B32 based on BCC_A2 etc.
For ordered FCC or HCP phases, these four substitutional sublattices represent four corners
of the regular tetrahedron on these lattices, all of which are the nearest neighbours. These
corners are equivalent lattice points, thus all G parameters for each end-member with the
same elements, but distributed on different sites, must be identical. It should be emphasized
that the end-member energy here represents the ordering energy rather than the formation
energy of the compound.
The constraints on the parameters in the 4SL model can be derived based on the symmetry
of the lattice:
GA:B:B:B=GB:A:B:B=GB:B:A:B=GB:B:B:A
GA:A:B:B=GA:B:A:B=GA:B:B:A=GB:A:A:B=GB:A:B:A=GB:B:A:A
GB:A:A:A=GA:B:A:A=GA:A:B:A=GA:A:A:B
LA,B:*:*:*=L*:A,B:*:*=L*:*:A,B:*=L*:*:*:A,B
The asterisk * means that the interaction parameter is independent of the occupation of that
sublattice. For the disordered phase to be completely disordered, i.e. that all site fractions
are equal on all four sublattices, all constraints must be correct.
For ordered BCC phases, the situation is a bit more complicated, as the four sublattice
ordering phase represents an irregular tetrahedron with two pairs of sites that are next
nearest neighbours. Thus, for an A-B binary solution phase, with A located on two sublattice
sites and B on the other two, the end-member described by GA:A:B:B has four nearest
neighbour bonds between A and B atoms, whereas the end-member described by GA:B:A:B
has two nearest neighbour bonds between A and B atoms and two next nearest neighbour
bonds. Many parameters thus have a relation:
GA:B:B:B=GB:A:B:B=GB:B:A:B=GB:B:B:A
GB:A:A:A=GA:B:A:A=GA:A:B:A=GA:A:A:B
GA:A:B:B=GB:B:A:A
GA:B:A:B=GA:B:B:A=GB:A:A:B=GB:A:B:A
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LA,B:*:*:*=L*:A,B:*:*=L*:*:A,B:*=L*:*:*:A,B
The GA:B:B:B term represents D03, GA:A:B:B B2 and the GA:B:A:B B32 ordering. There are also
two kinds of reciprocal interaction parameters:
LA,B:A,B:*:*;0…9
LA,B:*:A,B:*;0…9
Kusoffsky et al. (2001) have shown the influence of different parameters available in the 4SL
model applied to fcc ordering. The possibility to use the 4SL model to BCC ordering has been
studied by Sundman et al. (2009) in the Al-Fe system.
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2SL Model for FCC, HCP and BCC
The reason for using a 2SL model instead of a 4SL model is that the calculations are faster,
but on the other hand it can only model one kind of ordered phase(s). For instance, it is not
possible to model FCC with both L10 and L21, or BCC with D03 and B2, etc.
In order to get the fully disordered phase to form, constraints are needed as for the 4SL
model. For the symmetric phases, e.g. B2 and L10, the relation between parameters are:
GA:B=GB:A
LA,B:*=L*:A,B
For a 2SL asymmetric model including, but not limited to, L12, more constraints are needed.
This model has many complicated relations between the parameters. The relation between
the parameters for the 2SL L12 model can be derived from a 4SL model. The conversion
from 4SL model parameters to 2SL parameters for L12 can be found in Dupin et al. (2001)
and for L10 in Yuan et al. (2012). Higher-order systems with an L12 phase modelled with two
sublattices require a lot of ternary and some quaternary interaction parameters in order to
make the disordered state stable. These parameters have been derived by e.g. Dupin (1995),
also found in Kusoffsky et al. (2001).
Many publications exist on how to model order/disorder transformations using a twosublattice model, see e.g. Dupin, Ansara (1999), De Keyzer et al. (2009).
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Magnetic Ordering
The magnetic contribution to the Gibbs energy is given by a model proposed by Inden (1975)
and adapted by Hillert and Jarl (1978), and is described by:
G=RTln(b+1)f(t)

where t=T/TC.
The values of the Curie temperature, TC, and Bohr magneton number, b, at a certain
composition are then used in an optimization procedure to calculate the contribution to
Gibbs energy due to magnetic ordering. Curie temperature and Bohr magneton number are
given in the command ENTER_PARAMETER for phases that undergo a magnetic transition:
AMEND_PHASE_DESCRIPTION BCC_A2 MAGNETIC -1.0 0.4
ENTER_PARAMETER TC(BCC_A2,FE:VA;0) 298.15 +V1; 6000 N
ENTER_PARAMETER BMAGN(BCC_A2,FE:VA;0) 298.15 +V2; 6000 N

The arguments -1 and 0.4 specify the values of parameters in the magnetic model: -1 is the
antiferromagnetic factor and 0.4 is the structure factor. Usually the antiferromagnetic
factor =-1 for bcc and =-3 for fcc (and other non-bcc phases). The structure factor
corresponds to the short range order fraction of the enthalpy. This factor is 0.4 for bcc and
0.28 for non-bcc phases.
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Molar Volumes and High Pressure
Including volumes in a thermodynamic database enable calculations of volume changes,
volume fraction, lattice mismatch in cubic structures and phase diagrams at increased
pressure. Pressure independent volumes can be used up to about 1 GPa. At pressures above
1 GPa the pressure dependence of the volumes must be included by using a proper equation
of state (EOS). An EOS has been developed by Lu et al. (2005), based on the EOS from Jacobs
and Oonk (2000). Four parameters are used in the implementation of the model in ThermoCalc:
l

V0: Volume

at 1 bar and at reference temperature T0

l

VA: Integrated thermal

l

VK: Isothermal

compressibility at 1 bar

l

VC: Parameter

to fit high pressure data

expansivity

All parameters can be composition dependent in the same way as all other model
parameters in Thermo-Calc. Experimental information about the temperature, pressure and
composition dependence of the volume can be assessed using these model parameters. To
evaluate V0, VA and VK experimental data at 1 bar only are needed.

Example
Examples on modeling molar volume in a setup-file:
ENTER_PARAMETER V0(BCC_A2,FE:VA;0) 298.15 +V1; 6000 N
ENTER_PARAMETER VA(BCC_A2,FE:VA;0) 298.15 +V2*T+V3*T**2; 6000 N
ENTER_PARAMETER VC(BCC_A2,FE:VA;0) 298.15 +V4+V5*T; 6000 N
ENTER_PARAMETER VK(BCC_A2,FE:VA;0) 298.15 +V6+V7*T; 6000 N
ENTER_PARAMETER V0(FCC_A1,CR,FE:VA;0) 298.15 +V8; 6000 N
ENTER_PARAMETER VA(FCC_A1,CR,FE:VA;0) 298.15 +V9*(T-298.15); 6000
N
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Excess Models
Unless specifically amended, the excess Gibbs energy terms are modelled by the RedlichKister-Muggianu Model. Other excess models for the Gibbs energy are also implemented in
Thermo-Calc, such as e.g. Kohler and Toop-Kohler extrapolation models.
Thermo-Calc is not restricted to binary interaction parameters. Ternary, quaternary and
higher-order interaction parameters can also be used if there is enough information to
evaluate these from experimental data. The ternary interaction parameters are identified
by the degrees of the so-called ternary L parameter (i.e. 0, 1 and 2) in the command ENTER_
PARAMETER. If the parameter is composition-independent, you only need a single
interaction parameter with a degree of zero, i.e. only the 0L term. If there is a ternary
composition-dependent interaction parameter, you must enter all three parameters (0,1 and
2). If such a ternary interaction parameter should be zero, then assign it a function which is
zero. If the three interaction parameters have the same value, then that is identical to
having a composition-independent ternary parameter.

Example
ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N
ENTER_PARAMETER L(LIQUID,A,B,C;1) 298.15 +1000; 6000 N
ENTER_PARAMETER L(LIQUID,A,B,C;2) 298.15 +1000; 6000 N

is identical to
ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N

This also means that
ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N
ENTER_PARAMETER L(LIQUID,A,B,C;1) 298.15 +ZERO#; 6000 N
ENTER_PARAMETER L(LIQUID,A,B,C;2) 298.15 +ZERO#; 6000 N

is NOT identical to
ENTER_PARAMETER L(LIQUID,A,B,C;0) 298.15 +1000; 6000 N
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Introduction to the Database Manager Guide
In this section:
Thermodynamic and Kinetic/Mobility Databases

3

Initialization of the TDB Module

4
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Thermodynamic and Kinetic/Mobility Databases
This guide describes how to define and construct a thermodynamic or kinetic database. It
includes details about the data structures and formats of the Thermo-Calc databases as well
as the Diffusion Module (DICTRA) database-extensions.
The Thermo-Calc databases are created and maintained in the Thermo-Calc Database
Format (TDB) which is an international standard for the CALPHAD-type thermodynamic
calculations and kinetic simulations. This document gives a full description of the TDB
format (with the Diffusion Module (DICTRA) database extension) and is a comprehensive
guide about how to create and manage a Thermo-Calc (and Diffusion Module (DICTRA))
database.
Usually, a Thermo-Calc or Diffusion Module (DICTRA) database is constructed as a single
text file with an extension of TDB, for example, PAQ2setup.TDB. For some databases
(especially large databases used with older versions of Thermo-Calc or Diffusion Module
(DICTRA)) a database may consist of one primary-definition file (***setup.TDB) and several
additional-definition TDB files (such as ***param.TDB, ***funct.TDB, ***refer.TDB, etc.
These are built for a variety of defined parameters, functions, references and so forth, and
are linked to the ***setup.TDB file through the correct use of the TYPE_DEFINITION and/or
FTP_FILE commands inside the ***setup.TDB file.
With Thermo-Calc, the Add-on Modules and Thermo-Calc Software
Development Kits (SDKs), you can code everything into a single ***setup.TDB
file for a database at any scale.
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Initialization of the TDB Module
The following explains how a database initialization file is constructed to work with the socalled TDB (database) module. When you start, the TDB module looks for a file that has
information about the available standard databases. The database initialization file is called
tc_initd.tdb. By default it is located in the data subdirectory of the Thermo-Calc
installation directory.
See Database Installation Folder in the Thermo-Calc User Guide.
The location can be overridden by:
l

l

A command line parameter -t followed by the path to the directory containing the
tc_initd.tdb file.
The environment variable TC_DATABASE_DIRECTORY pointing to the directory
containing the tc_initd.tdb file. This overrides both the default value and a
directory given with the -t command line argument.

Each database defined in tc_initd.tdb represents a database that can be used within
Thermo-Calc. Each entry has three parts:
l

the database short-name (e.g. FEDEMO, maximum seven characters),

l

the path to the database setup file (max 78 characters), and

l

a short description of the database (max 60 characters). The entry must end with an
exclamation mark (!), the first two parts must not contain white space, and it can
span over two lines.

The paths can be relative to the tc_initd.tdb file or absolute. For platform independence,
the recommendation is to always use forward slashes (/) in the paths, but on Windows
backslash (\) also works.
You can add comment lines in the database initialization file. Comments must start with a $
sign.

Each entry record (i.e. for a single database) must finish with an exclamation
mark !. There should be no spaces or commas within the first and second fields
since these characters are taken as field separators, while spaces or commas
can be used in the third field.

Example
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The following are examples of an initialization file defining two databases:
SSOL7 SSOL7\SSOL7SETUP.TDC

SGTE Solutions Database version 7.0 !

MYDB1 ../../../MYDATABASES/ABC.TDB My database 1.0 !
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The Database Definition File and Keywords
In this section:
Database Definition File Syntax

9

ELEMENT

11

SPECIES

12

PHASE

14

CONSTITUENT

20

ADD_CONSTITUENT

22

COMPOUND_PHASE

23

ALLOTROPIC_PHASE

24

TEMPERATURE_LIMITS

25

DEFINE_SYSTEM_DEFAULT

26

DEFAULT_COMMAND

27

DATABASE_INFORMATION

28

TYPE_DEFINITION

29

FTP_FILE

33

FUNCTION

34

PARAMETER

37

OPTIONS

46

TABLE

47

ASSESSED_SYSTEMS

48

REFERENCE_FILE

52

LIST_OF_REFERENCE

54

ADD_REFERENCE

55

CASE and ENDCASE

57

VERSION_DATA

58
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Database Definition File Syntax
The database definition (*.TDB) file (normally named ***setup.TDB) consists of a set of
keyword codes each followed by one or several parameters (arguments).
l
l

l

l

l

A complete keyword entry must end with an exclamation mark (!).
A single keyword entry can be up to 2000 characters long. However, the maximum
length of a line in an *.TDB file is 78 characters--it may be necessary to continue the
keyword parameter (arguments) on several lines. The ! must be at the end of the last
line.
It is recommended to always have at least one empty space at the beginning of each
continuation line for the keyword parameters (arguments); otherwise, the DATA
module can misunderstand the parameters (or arguments), or issue an error
message.
The keyword and its various parameters (arguments) are separated by a space or a
comma.
A dollar sign ($) in the first position of the line indicates that the line is a comment
line, which is ignored by the DATA module.

When the database is selected the DATA module only reads the database definition file
(***setup.TDB) once, from beginning to end. The DATA module checks continuously when
reading the definition file. This implies that (nearly) everything must be declared or defined
before it is used in any other way.
For example, if the GRAPHITE phase is to be included in the database definition, the element
C (carbon) and the phase GRAPHITE must be defined before declaring that carbon dissolves
in graphite. This definition order is necessary to build the internal data structure acceptable
by the DATA module (during its consistency checking).
This topic gives a description of the available keywords and the appropriate arguments. A
basic knowledge of the Gibbs Energy System (GIBBS) module is assumed.
This syntax is used:
KEYWORD [arg.1]*# [arg.2]*## {optional arg.3}!

The keywords are written in full length but can be abbreviated as long as the abbreviation is
unique. A keyword may have syntax consisting of several arguments and optional
arguments. The number, # or ##, in the notation, [...]*# or [...]*##, indicates an argument
with a maximum length of # ASCII characters.
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Arguments within square brackets [...] must always be given, but are optional
when enclosed in curly brackets {...}.
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ELEMENT
ELEMENT [element name]*2 [ref. state]*24 [mass] [H298] [S298] !

The element name (maximum two characters) is the one found in the periodic chart but
there are no naming restrictions. However, the GIBBS module only recognizes UPPER-case
element names (if the Upper Case Mode is selected by the GIBBS command REINITIATE),
which means that lower-case (if defined in a database) is automatically converted to UPPERcase by the DATA/GIBBS module.
The elements are automatically entered as species using the same names of the elements.
If, for example, the species corresponding to FE needs to be named FE1, you can define the
species as FE1, which results in an element named FE and a species named FE1. Vacancies
(VA) and electrons (denoted either as /- in gaseous, liquid or solid phases, or ZE in an
aqueous solution phase), need to be entered as special elements for correct handling by the
DATA module.
The reference (ref.) state (maximum 24 characters) is the stable phase (at 298.15 K and 1
bar) that should contain this element and be used as the reference state for all element
thermodynamic data. The mass, given in gram per mole, is used in various calculation
programs and should always be given the correct value. H298 and S298 denote the enthalpy
and entropy difference between 0 and 298.15 K for the element in SI units. If these are
unknown, the values can be set to zero. All this information (reference state, H298 and S298)
define the SER (Stable Element Reference state).

Examples
ELEMENT /- ELECTRON_GAS

0.0

0.0

0.0 !

ELEMENT VA VACUUM

0.0

0.0

0.0 !

ELEMENT ZE UNIT_CHARGE

0.0000000001

ELEMENT AL FCC_A1

26.98154 4577.296 28.3215 !

ELEMENT C

12.011

1054.0

ELEMENT FE BCC_A2

55.847

4489

ELEMENT O

15.9994 4341

GRAPHITE

1/2_MOLE_O2(G)

0.0

0.0 !

5.74 !
27.28 !
102.5158 !

ELEMENT TI HCP_A3

47.88

4810

30.648 !

ELEMENT ZR HCP_A3

91.224

5566.27

39.181 !

ELEMENT ZY DUMMY

1

1

1 !
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SPECIES
SPECIES [species name]*24 [stoichiometric formula] !

This keyword defines species in the data structure. Every species name (maximum 24
characters) must be unique. The species are built from the predefined set of elements in the
stoichiometric formula. If an undefined element is referenced, DATA displays an error
message and the data structure is probably damaged.
The species names do not have to be the same as the stoichiometry formula, although in
general this is recommended. The elements are automatically entered as species using the
same names of the elements.
You can define a species name as a mixture of UPPER-case and lower-case
letters in a database, but the DATA module automatically converts all lowercase to UPPER-case because the GIBBS module only recognizes UPPER-case
species names.
When naming the species in a database, use special characters (such as +, -, _, / and .) in
species names. Avoid using other special characters (such as ( and )).
The stoichiometric formula is written with a simplified chemical notation, in which the
chemical elements should always be given in UPPER-case and in any preferred order, and
the stoichiometric coefficients are written in either real numerical factors or integer digits.

It is important that the numerical factor of 1 is not left out. Subgroups are not
allowed in a stoichiometry formula; however, while specifying the stoichiometry
formula for a specific species in a database, you can specify it in a way that
some elements (always together with the corresponding partial stoichiometric
coefficients) are repeated (as in the examples below).

Examples
SPECIES AL2O3

AL2O3 !

SPECIES Silica

SI1O2 !

SPECIES NaSb_6OH

NA1SB1O6H6 !

SPECIES FE+2

FE/+2 !

SPECIES SB-3

SB/-3 !
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SPECIES AlCl2/3

AL.33333CL.666667 !

SPECIES AL1CL1H2O2

AL1CL1H2O2 !

SPECIES AlCl3_3H2O

AL1CL3H6O3 !

SPECIES AlO2H2Cl.H6O3

AL1O2H2CL1H6O3 !

SPECIES AlCl2-OH.3H2O

AL1CL2O1H1H6O3 !

SPECIES AlCl2OH.3Water

AL1O1H1CL2H6O3 !
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PHASE
PHASE [phase name]*24 [data-type code]*8 [numb. subl.] [sites in
subl. 1] [sites in subl. 2] etc... {auxiliary text string} !

This keyword defines a phase and its properties (except for what species are allowed to
enter it and for its parameters).
The phase name (maximum 24 characters) must be unique; otherwise the DATA module
sees it as an attempt to redefine a previously defined phase. This causes DATA to display an
error message and ignore the rest of the line. A phase name can be suffixed by an
underscore (_and letters to identify the physical state(s) or structure type(s) of the phase.

Examples of Recommended Suffixes
Suffix

Definition

ABC_S

The ABC phase in solid state.

ABC_S2

The ABC phase in solid state 2.

ABC_S3

The ABC phase in solid state 3.

ABC_LT

The ABC phase in solid state at low temperatures.

ABC_HT

The ABC phase in solid state at high temperatures.

ABC_L

The ABC phase in liquid state.

ABC_LIQ

The ABC phase in liquid state.

FCC_A1

The FCC phase in disordered structure type A1.

FCC_L12

The FCC phase in ordered structure type L12.

The phase name can also be attached with a colon sign (:) and a letter for a legal GIBBS
phase-type code (e.g. IONIC_LIQ:Y and GAS:G).
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GIBBS Phase-type Codes
Code

Definition

G

Bit set for a gaseous mixture phase.

A

Bit set for an aqueous solution phase.

Y

Bit set for an ionic liquid solution phase (specially treated by the Ionic Two-Sublattice Liquid
Model).

L

Bit set for a liquid solution phase (but not A (aqueous) or Y (ionic liquid)).

I

Bit set for a phase with charged species (but not G (gaseous), A (aqueous) or Y (ionic liquid)).

F

Bit set for an ordered FCC or HCP solution phase using the Four Substitutional-Sublattice
Ordering Model (additionally, such a phase can also have interstitial sublattices).

B

Bit set for an ordered BCC solution phase using the Four Substitutional-Sublattice Ordering
Model (additionally, such a phase can also have interstitial sublattices).

Other invalid characters (e.g. M or P) are eventually treated, together with the
colon (:) as a part of a phase name.
A G phase (gaseous mixture) or an A phase (aqueous solution) is usually treated as a
substitutional phase without sublattice, and an L phase (ordinary liquid solution) is normally
(but not always) modelled as a substitutional phase without sublattice, too.
For ordered FCC or HCP phases, these four substitutional sublattices represent four corners
of the regular tetrahedron on these lattices, all of which are the nearest neighbours, as
shown.

FCC Unit Cell Example
An FCC unit cell with the lattice positions indicated that correspond to the G (FCC,A:B:C:D)
end member. All lattice positions are equivalent for a four substitutional-sublattice ordering
model.

Database Manager User Guide ǀ 15 of 91

Thermo-Calc Documentation Set

A Normal 4-Sublattice Model requires that all the G parameters for each of the endmembers with the same elements but distributed on different sites be given separately.
However, as these corners are identical lattice points, the phase-type option F means that
the G parameters need be given only once. The possible permutations are handled
automatically.

Additional Clarification
An A-B binary solution phase (with the element A located on one sublattice site and B on the
other three sublattice sites) treated by the Normal 4-Sublattice Model has to have four G
parameters for four end-members, i.e.
l

G(phase,A:B:B:B)

l

G(phase,B:A:B:B)

l

G(phase,B:B:A:B, and

l

G(phase,B:B:B:A)

This is because in the general case these G parameters can be different from each other. But
for the FCC and HCP orderings, they are identical and thus all G parameters of such endmembers need to be given only once, and the possible permutations are then automatically
handled by the GIBBS module. Also, only one of the identical permutations is listed; in this
example, G(phase,A:B:B:B)where it is alphabetically the first in the list of permutations.
This significantly simplifies the usage of this model (Four Substitutional-Sublattice Ordering
Model) in multicomponent alloys.
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For ordered BCC phases, the phase-type option B means the same thing but it is more
complicated since the 4-substitutional-sublattice ordering phase represents an irregular
tetrahedron with two pairs of sites that are next nearest neighbours as shown:

BCC Unit Cell Example
Two BCC unit cells with the lattice positions indicated that correspond to the G
(BCC,A:B:C:D,0) end member. Lattice positions (A) and (B) are equivalent, as are lattice
positions (C) and (B) for a four substitutional-sublattice ordering model.

For an end member described by the parameter G (phase,A:B:C:D) A and B are next
nearest neighbours, as are C and D. And the nearest neighbours of A (or B) are C and D.
Thus, for an A-B binary solution phase (with the element A located on two sublattice sites
and B on two sublattice sites) treated by the Normal 4-Sublattice Model, the end-member
described by the G(phase,A:A:B:B) term has four nearest neighbour bonds between A and
B atoms, whereas the end-member described by the G(phase,A:B:A:B) term has two
nearest neighbour bonds between A and B atoms and three next nearest neighbour bonds.
The first end-member (described by the G(phase,A:A:B:B) term) represents B2-ordering
and the second (described by the G(phase,A:B:A:B) term) stands for B32-ordering. There
are two permutations of the G(phase,A:A:B:B) term and four permutations of the G
(phase,A:B:A:B) term, automatically conducted in the Four Substitutional-Sublattice
Ordering Model. If you enter the unary, binary, ternary and quaternary parameters you are
dealing with 1, 6, 21, 55 parameters for BCC:B, 1, 5, 15, 35 parameters for FCC:F and 1, 16,
81, 256 parameters for phases without F/B.
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An additional feature with the phase-type options F and B is that a composition set that
represents the solution phase has a suffix (indicating what ordering the phase has) that is
automatically added to its phase name in some listings of equilibrium calculations (when
performing either single-point or stepping or mapping calculations, and when plotting the
calculated property diagrams or phase diagrams).
Such suffix indications can be:
Solution Phase

Suffix for
Disordered Phase

Suffix for
Ordered Phase
FCC_L12

FCC PHASE

FCC_A1
FCC_L10
BCC_B2
BCC_B32

BCC PHASE

BCC_A2
BCC_D03
BCC_L21
HCP_D019

HCP PHASE

HCP_A3
HCP_B19

If you want to convert an existing database TDB file to use the F/B feature, add
the phase-type code to the corresponding phase name in the PHASE and
CONSTITUENT commands in the TDB-file, then when running the LIST_DATA
command in the Gibbs (GES) module. The created database file is in this less
verbose format.
The data-type code consists of 1 to 8 characters where each character must stand for an
action, which is to be coupled to this phase. The keyword TYPE_DEFINITION, described
below, must be used in the current database to specify what action should be taken by DATA
for each character code.
The data entries [numb. subl.] [sites in subl. 1] [sites in subl. 2] etc., specify
the total number of sublattices (always as an integer digit) and the sites (i.e. stoichiometric
coefficients) of each of the sublattices (given in either integer digits or real numerical
factors) for the phase.
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Optionally, an auxiliary text string (maximum 78 characters) can be given after the last [sites
in sublattice #] but before the exclamation mark !. This string displays in connection with
the phase name in some listings within the DATA module.

Examples
PHASE GAS:G

% 1 1.0 !

PHASE LIQUID:L %ZCDQ

2

1.0

1.0

> Metallic liquid solution, modelled by CEF Model. !
PHASE IONIC-LIQ:Y %ZCDQ

2

1.0

1.0

> Ionic liquid solution, modelled by Ionic Two-Sublattice Model. !
PHASE SPINEL:I

%ZA

4

1

2

2

4

> Complex Spinel Solution, by CEF model with ionic constraints. !
PHASE M23C6
PHASE FCC_A1

% 3 20.0 3.0 6.0 !
%&A

2

1 1

> Disordered FCC phase; also as MX carbides/nitrides. !
PHASE FCC_L10

%&AX

3

0.75 0.25 1

> Ordered FCC phase, modelled by 2-Sublattice Model for Ordering.
!
PHASE FCC_L12:F %&AX

5

0.25 0.25 0.25 0.25 1.0

> Ordered FCC phase, modelled by 4-Sublattice Model for Ordering.
!
PHASE AQUEOUS:A %HIJMR 1 1.0
> Aqueous Solution: using the Complete Revised HKF Model. !

Database Manager User Guide ǀ 19 of 91

Thermo-Calc Documentation Set

CONSTITUENT
CONSTITUENT [phase name]*24 [constituent description]*2000 !

This keyword (and the ADD_CONSTITUENT keyword for large solution phase) defines the
phase-constitution as a list of constituents (for a substitutional phase with no sublattice) or of
constituent arrays (for a sublattice phase).
The phase name (maximum 24 characters) must be a predefined phase (i.e. already through
the PHASE keyword).

It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F
and B) in its phase definition (already by the PHASE keyword; such as GAS:G,
SLAG:L, LIQUID:L, IONIC_LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_B2:B,
AQUEOUS:A), such a valid phase-type code must also always be attached to the
phase name in the CONSTITUENT keyword (and the ADD_CONSTITUENT
keyword).

Specifying the phase name in UPPER-case is recommended. You can define a
phase name as a mixture of UPPER-case and lower-case letters in a database,
but the DATA module automatically converts all lower-case to UPPER-case
because the GIBBS module only recognizes UPPER-case phase names.
The constituent description (maximum 2000 characters) is a list of the species that enter a
phase. The list starts with a colon (:), indicating the start of the sub-list of species for the
first sublattice, and different sublattices are separated by colons. The complete sequence
ends with a final colon.
Optionally, each sublattice may specify which species are considered to be major
constituents. This is done by adding a percent sign (%) directly to the species name. The start
values on the site fractions of the major constituents should sum to 0.99 on a specific
sublattice. Thus, the minor constituents (i.e. those without a %) add up to 0.01. A maximum
of 2000 characters can be coded in the constituent description, continuing in sequent lines. If
the phase has a constituent description longer than 2000 characters, the rest can be coded
in one or several ADD_CONSTITUENT keywords.

Examples
CONSTITUENT BCC_A2 :FE
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CONSTITUENT IONIC-LIQ:Y :FE+2 : SB-3: !
CONSTITUENT M23C6 :CR FE :FE CR W MO : C: !
CONSTITUENT AQUEOUS:A :H2O% AG+1 AGF AGCL AGCL2-1 AGI3-2 AGSO4-1
AGC2H4+1
AGN2H6+1 AGC2N2-1 AGC2H4NO2 AL+3 ALF3 ALO2-1, ... : !
CONSTITUENT SPINEL:I

: AL+3% CR+3 FE+2% FE+3 MG+2% NI+2
: AL+3% CA+2 CR+3 FE+2 FE+3 MG+2% NI+2 VA
: FE+2 MG+2 VA%
: N-3 O-2% :!
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ADD_CONSTITUENT
ADD_CONSTITUENT [phase name]*24 [constituent description]*2000 !

This keyword adds more constituents to a phase that already has some constituents. Its
syntax is the same as for the CONSTITUENT keyword. This keyword can be used several
times, if the phase is very large, e.g. a gaseous mixture or a complex aqueous solution. This
is useful when there are so many constituents in a phase that the 2000 characters available
for the constituent description list is not enough.
Constituents are not necessary on all sublattices. In the second example below,
no addition is made to the first sublattice.

Examples
ADD_CONSTITUENT GAS :S1 S2 S3 ... : !
ADD_CONSTITUENT IM-PHASE : :CR:W ... : !
ADD_CONSTITUENT AQUEOUS:A :CUCL+1 CUCL2 CUCL2-1 CUCL3-2 CUOH+1
CUO2H2 CUO3H3-1
CUO4H4-2 CU2OH+3 CU2O2H2+2 CU3O4H4+2 NIO2H2 NIO3H3-1 NIO4H4-2
NI2OH+3
NI4O4H4+4 ZNOH+1 ZNO2H2 ZNO3H3-1 ZNO4H4-2 ... : !
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COMPOUND_PHASE
COMPOUND_PHASE [phase name]*24 [data-type code]*8 [constituent] !

The keyword is a compact way to simultaneously define a species, a compound phase
(maximum 24 characters) and its phase-constituent. It is useful for stoichiometric phases
with constant compositions. The species name and stoichiometric formula must be identical,
i.e. being the given constituent. The phase has this species as its only constituent. This
keyword allows the database definition file for a large substance database to be more
compact; it is a combination of the SPECIES, PHASE and CONSTITUENT keywords.

Examples
COMPOUND_PHASE AL2O3 % AL2O3 !
COMPOUND_PHASE MAGNETITE %MF FE3O4 !
COMPOUND_PHASE QUARTZ % SIO2 !
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ALLOTROPIC_PHASE
ALLOTROPIC_PHASE [phase name]*24 [data-type code]*8 [constituent]
!

This keyword does the same as the COMPOUND_PHASE keyword for entering an allotropic
phase (maximum 24 characters), but does not enter the constituent as a species to the data
structure. Use this if the species is already defined.

Examples
ALLOTROPIC_PHASE BETHA-AL2O3 % AL2O3 !
ALLOTROPIC_PHASE CRISTOBALITE % SIO2 !
ALLOTROPIC_PHASE TRIDYMITE % SIO2 !
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TEMPERATURE_LIMITS
TEMPERATURE_LIMITS [lower limit] [upper limit] !

This keyword sets the default upper and lower temperature limits used by the GIBBS module
for Gibbs energy parameters and functions. It can be used only once in one database
definition file and all its sequential files.

Example
TEMPERATURE_LIMITS 500.0 1800.0 !
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DEFINE_SYSTEM_DEFAULT
DEFINE_SYSTEM_DEFAULT [keyword] {G-ref. type index} !

This keyword sets the default value to ELEMENT or SPECIES in the DATA command DEFINE_
SYSTEM.
For a substance database, it can be appropriate to have ELEMENT as a default value
whereas a large solution database can benefit from having SPECIES as a default value. A
proper default value is useful for beginners. An advanced user is more likely to use the DATA
commands DEFINE_ELEMENT and DEFINE_SPECIES to override the default value.
{G-ref. type index} is an integer indicating the reference state type for an element when
entering and listing data in the GIBBS module. The following lists legal numbers and the
corresponding meaning (the reference state type for an element):
Number

Definition

1

symbol: G

2

symbol: H298

3

symbol: H0

For example:
DEFINE_SYSTEM_DEFAULT element 2 !
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DEFAULT_COMMAND
DEFAULT_COMMAND [secondary keyword and parameters] !

This keyword specifies commands to be executed by the DATA module at database
initialization. The syntax of the available command is currently not the same as the user
available DATA commands but the actions are similar. The available secondary keyword and
parameters in syntax are:
DEFINE_SYSTEM_ELEMENT [element names]
DEFINE_SYSTEM_SPECIES [species names]
DEFINE_SYSTEM_CONSTITUENT [phase] [sublattice] [species]
REJECT_SYSTEM_ELEMENT [element names]
REJECT_SYSTEM_SPECIES [species names]
REJECT_SYSTEM_CONSTITUENT [phase] [sublattice] [species]
REJECT_PHASE [phase names]
RESTORE_PHASE [phase names]

Examples
DEFAULT_COMMAND DEFINE_SYSTEM_ELEMENT FE VA !
DEFAULT_COMMAND REJECT_SYSTEM_CONSTITUENT LIQUID 2 C !
DEFAULT_COMMAND REJECT_PHASE LIQUID !
DEFAULT_COMMAND RESTOR_PHASE GAS !
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DATABASE_INFORMATION
DATABASE_INFORMATION [text]*10000 !

This keyword defines a text for the detailed description of the current database. The text can
be listed with the DATA command DATBASE_INFORMATION. An apostrophe (') can be used
in the text to indicate a new line; and two apostrophes, ('') can be used in the text to
indicate a new line plus an empty line.
The continuous text length (each line with max 78 characters) is 10,000
characters.

Example
DATABASE_INFORMATION This is the XXX-Alloy Solution Database '
in the A-B-C-D-...... System. '
Developed by TCS, released in May 2001. ''
... more ... !
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TYPE_DEFINITION
TYPE_DEFINITION [data-type code]*1 [secondary keyword with
parameters] !

This keyword couples phases to an action performed by the DATA module when the DATA
command GET_DATA is executed.

Secondary Keywords
The secondary keywords and associated parameters in syntax are:
SEQ [filename]
RND# [filename]
GES [valid GIBBS command with parameters]
POLY3 [valid POLY command with parameters]
TDB [valid DATA command with parameters]
IF [conditional statement] THEN [keyword with parameters]
AFTER [valid GIBBS command with parameters]

The secondary keyword SEQ specifies a sequential file that stores parameters belonging to
the phases using the associated data type code (which is defined by this keyword). A special
case where the filename is given as an asterisk (*) implies that the database definition file
also acts as a sequential data storage file. This case makes it possible to have a single file for
a small database, which is especially suited for personal databases.
The secondary keyword RND should be concatenated with a positive integer # to indicate the
type of the random file. Currently, there are these types of random files:
l

RND0,

the default, is used for complete Gibbs energy expressions (G0 parameters),
where the search field is the unabbreviated parameter name.

l

RND1

l

RND2

is designated for functions, where the function name is used as the search field.

is reserved for binary interaction parameters, where its search field is also the
unabbreviated parameter name without any interaction order notation.
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Ternary and higher order interaction parameters must be specified on a
sequential file. Moreover, the internal structures of these random files are
subject to changes with different versions of DATA, and with implementations of
DATA on various computer systems. For more information, see the FORTRAN
program TDBSORT, which is available from Thermo-Calc Software AB.
The secondary keywords GES, POLY3, or TDB specifies a modification of, or addition to,
phases having the associated data type code, such as magnetic contribution, another excess
model, or any other valid GIBBS/POLY/DATA command that applies to a certain phase. By
implementing this as a call to the interactive GIBBS/POLY/DATA module, flexibility is
achieved. If a new type of addition is implemented in a GIBBS/POLY/DATA module, it can be
immediately used in the database definition file without reprogramming the DATA module.
In several examples below, the use of the at (@) sign indicates any phase to
which the relevant type definition (e.g. A, B, 4, or E) applies.
The secondary keywords IF and THEN allow specification of a conditional statement
structured with respect to the phase constitution that controls the execution of a following
type-definition (keyword with parameters) string. See the last four examples.
The secondary keyword AFTER is similar to the GES keyword except the defined GIBBS
command is executed after all parameters are entered. The reason for this is that the
command has no effect unless there is a parameter. Following the AFTER keyword, a GIBBS
command must be given and it is executed after entering the parameters of the phase.
The data-type code (always as one string) can be any normal or special character, e.g. 0, 5,
A, F, M, %, &, and so forth, and is referred in the definition keywords PHASE, COMPOUND_
PHASE and ALLOTROPIC_PHASE for various phases.
A phase can have several ADDITIONAL parts of different types (that are enforced by certain
TYPE_DEFINITIONS which call the GIBBS command AMEND_PHASE_DESCRIPTION for
describing various contributions to Gibbs energy). However, the DATA/GIBBS module
automatically deletes any early-defined ADDITIONAL part(s) of the same type.
The DATA module can selectively retrieve functions that are necessary for a defined system
from a database that has functions stored in its setup file or SEQ sequential function file,
while all other functions irrelevant for the defined system are ignored and are not saved in
associated GIBBS and POLY workspaces.

Examples
TYPE_DEF % SEQ

TCPATH\DATA\[DATABASE]\PARAMETERS.TDB !
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TYPE_DEF I SEQ

TCPATH\DATA\[DATABASE]\INTERACTION-PARAMS.TDB !

TYPE_DEF G RND0 TCPATH\DATA\[DATABASE]\GZERO-PARAMS.TDB !
TYPE_DEF F RND1 TCPATH\DATA\[DATABASE]\FUNCTIONS.TDB !
TYPE_DEF & RND2 TCPATH\DATA\[DATABASE]\BINARY-INTERACTIONS.TDB !
TYPE_DEF A GES AM_PH_DES @ MAGNETIC -1 0.40 !
TYPE_DEF B GES AM_PH_DES @ MAGNETIC -3 0.28 !
TYPE_DEF 4 GES AM_PH_DES @ EXCESS_MODEL REDLICH-KISTER_KOHLER !
TYPE_DEF 5 GES AM_PH_DES AQUEOUS EXCESS_MODEL HKF !
TYPE_DEF 6 GES AM_PH_DES AQUEOUS HKF_ELECTROSTATIC !
TYPE_DEF 7 GES AM_PH_DES AQUEOUS STATUS 02084000,,, !
TYPE_DEF 8 GES AM_PH_DES AQUEOUS MAJOR_CONST 1 H2O !
TYPE_DEF E AFTER AM_PH_DES LIQUID EXCESS MIXED-EXCESS
A B LEGENDRE

C A POLYNOM ,,,, !

TYPE_DEF T AFTER AM_PH_DES LIQUID TERN-EXT TOOP-KOHLER
!

B A C ,,,,

TYPE_DEF Q AFTER AM_PH_DES LIQUID TERN-EXT KOHLER FE CR NI !
TYPE_DEF C IF (PD AND PT AND SN)

THEN TDB RESTORE_PHASE BCT_A5 !

TYPE_DEF D IF (PD AND (PT OR SN)) THEN TDB REJECT_PHASE BCC_A2 !
TYPE_DEF E IF ((NB OR TI OR V) AND (C OR N)) THEN
GES AM_PH_DES @ COMP_SET ,, CR NB TI V: C N: !
TYPE_DEF F IF (ALO3/2 OR CRO3/2 OR FEO OR MNO OR SIO2) THEN
GES AM_PH_DES LIQUID COMP_SET ,, ALN%,ALO3/2%,CRO3/2%,
FEO%,FEO3/2,MNO3/2%,MNS%,SIO2%,TIO2% : !
TYPE_DEF R GES AM_PH_DES FE_LIQUID FRACTION_LIMITS

Fe 0 0.6

Ag 0 0.01

Al 0 0.05

Ca 0 0.05

Co 0 0.01

Cr 0 0.01

Cu 0 0.02

Mg 0 0.05

Mn 0 0.05

Mo 0 0.05

Nb 0 0.05

Ni 0 0.05

Pb 0 0.05

Si 0 0.10

Sn 0 0.02

Ti 0 0.05

U

0 0.01

V

0 0.02

W

0 0.02

Zr 0 0.03

B

0 0.01

C

0 0.01

H

0 0.01

N

P

0 0.01

S

0 0.01

!

0 0.01

O

0 0.01

Ordered Phase Restores Disorder Contribution
When an ordered phase with disordered contribution is restored, the disordered contribution
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is automatically restored as well. You can also restore the disordered phase without
restoring the ordered phase.

However the DIS_PART TYPE_DEFINITION must always be set on the ordered
phase. It is important that the disordered phase is declared before the ordered
phase. Otherwise it causes an error when DIS_PART TYPE_DEFINITION is
executed and then either the ordered or disordered phase is rejected.

Example
TYPE_DEFINITION & GES A_P_D FCC_A1 MAGNETIC
PHASE FCC_A1

%&

2 1

CONSTITUENT FCC_A1

-3.0

2.80000E-01 !

1 !
:CR,NI% : C%,VA :

!

$ THIS PHASE HAS A DISORDERED CONTRIBUTION FROM FCC_A1
TYPE_DEFINITION ' GES AMEND_PHASE_DESCRIPTION FCC_L12 DIS_PART
FCC_A1,,,!
TYPE_DEFINITION ( GES A_P_D FCC_L12 MAGNETIC
!
PHASE FCC_L12

%'(

3 .75

CONSTITUENT FCC_L12

.25

-3.0

2.80000E-01

1 !

:CR,NI% : CR,NI% : C,VA% :

!

For example a GES command such as the following only affects phases defined above or at
the phase with this TYPE_DEFINITION in the TDB file:
TYPE_DEFINITION ( GES A_P_D FCC_L12 DIS_PART FCC_A1,,, !

For example a TDB command such as the following only affects phases defined below the
phase with this TYPE_DEFINITION in the TDB file:
TYPE_DEFINITION ( TDB RESTORE_PHASE FCC_A1 !
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FTP_FILE
FTP_FILE [filename] !

FTP_FILE is a special function random file and the function names correspond to the record
numbers where these record names and the functions are stored. The FTP_FILE decreases
search time for the associated database in the DATA module. The file is used for large
substance databases along with a SEQ sequential or RND0 random file for storage of G0
parameters referring the functions named FxxxxT that are stored in the FTP file. The
integer number xxxx is a search code used by DATA when such files are processed.
No modification of this file type is allowed.

Example
FTP_FILE TCPATH\DATA\[DATABASE]\FTP-FILE.DATA !
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FUNCTION
FUNCTION [function name]*8 [lowest temp. limit]
[expression 2]; [upper temp. limit 2] Y
[expression 1]; [upper temp. limit 1] Y
[expression 3]; [upper temp. limit 2] Y
.......... ; ..... Y
[expression n-1]; [upper temp. limit n-1] Y
[expression n]; [upper temp. limit n] N {Ref. Index} !

GIBBS can use predefined functions in the expression (TP-Function) of a Gibbs energy
parameter or in other functions. This is often used when several parameters (or functions)
have a common sub-expression, such as for metastable modifications of elements. This
keyword can appear in both files for database definition and sequential storage, but not in
FTP files. A valid function name can have up to 8 characters.
A function always starts with a lowest temperature limit of its applicability, followed by one
or more (up to 10) expressions (TP-Functions) that are coded as mathematical relations of
constants, functions of stable variables (T and P) and other entered functions (normally with
a # suffix, e.g. +3*GHSERAL#).
ENTER_PARAMETER
The expression is a FORTRAN-like expression and operators +, -, *, = and ** can be used (**
only with integer powers). Unary-functions LN or LOG (both for natural logarithm) and EXP
(for exponential) can also be used. Each expression (TP-Function) should end with a
semicolon (;), and be followed by its upper applicable temperature limit and a continuation
indicator (Y to continue with the next expression or N to end the function’s expression). If
there is no continuation after a specific expression (TP-Function), the reference index can
optionally be given after the N indicator.
A complete/valid function entry can be written in several continuation lines if the function’s
expression (TP-Function) is too long or if there is more than one applicable expression (TPFunction), as the maximum length of each line is 78 characters.

It is recommended to always have at least one empty space at the beginning of
each continuation line. Otherwise, the DATA module may misunderstand the
expression or issue some error messages when reading the function entry.
Avoid entering functions like the one below.
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FUNCTION GHSERXY

298.15

-1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !

Such a function is read by the DATA module as
1000+1058*T-38.9*T*LOG(T)+GFUNXY#

rather than
-1000+1058*T-38.9*T*LOG(T)+GFUNXY#

This is because the DATA module concatenates all lines and removes extra spaces before
trying to enter the function in the GIBBS workspace. Thus, the - sign is taken as a delimiter
between 298.15 and 1000, and the function incorrectly becomes:
FUNCTION GHSERXY 298.15 1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N
!

Avoid this mistake by giving at least one empty space as the first character of a
new line, such as
FUNCTION GHSERXY

298.15

-1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000 N !

which is read correctly as
FUNCTION GHSERXY
N !

298.15 -1000+1058*T-38.9*T*LOG(T)+GFUNXY#; 6000

The lowest-temperature limit (in Kelvin) for the applicability of the (first) TP-Function in a
function is normally set by default as 298.15 K, in most cases. However, you can set another
limit when it is applicable (according to experimental data and assessments).
An upper-temperature limit (in Kelvin; followed by a Y or N sign) for the applicability of each
TP-Function in a function must be given after the semicolon (;) immediately following the
specific TP-Function. The highest-temperature limit (in Kelvin) for the applicability of the
current function is always followed by the N sign. If a negative number is given as the lowesttemperature limit, it assumes there are breakpoints in pressure for this function. In these
cases, it is interpreted as the lowest-pressure limit (in Pascal), and the other limits in the
current function is also taken as pressure limit values (in Pascal).
The temperature/pressure limits for the functions are checked during calculations. An
indicator is set if the actual temperature/pressure condition is below the lowest
temperature/pressure limit or above the highest temperature/pressure limit. In these cases,
an extrapolation is done using the TP-Function valid in the nearest temperature/pressure
range.
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The optional reference index {Ref. Index} is an integer number indicating where to find the
particular function in a special reference file. The references are listed when doing the GET_
DATA command in the DATA module. They can also be listed in the GIBBS module with the
command LIST_DATA with the option R.
For accounting for the reference indices, also see the keyword REFERENCE_FILE.
The reference index field can also be an abbreviation (such as REF:250, REF_002, or REFSGTE) which denotes the original reference. In this case, the reference cannot be obtained
when issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the
option R).
However, the references directly coded in the database definition file (***setup.TDB)
starting with a letter can be shown when issuing the DATA command GET_DATA or the
GIBBS command LIST_DATA (with the option N or R). Normally, such references must be
located after the LIST_OF_REFERENCE keyword. It is recommended to use reference code
names such as REF001, REF018, etc. The reference list, which is generated by the GIBBS
command LIST_DATA <file> with the N or R option, is also possible to be directly read by
the DATA module.
The DATA module can selectively retrieve functions which are necessary for a defined
system from a database that has functions stored in its setup file or SEQ sequential function
file, while all other functions irrelevant for the defined system are ignored and are not saved
in associated GIBBS and POLY workspaces. Previously, this can only be done for large
databases that have functions stored in RND1 random or FTP function files.

Examples
FUNCTION GFREE

298.15

1000+GFUNXY#; 6000 N !

FUNCTION GFUNXY 298.15 -1000+200*T+30*T*LOG(T); 6000 N 505 !
FUNCTION G0_CAO 298.15 -663538.11+352.67749*T-57.7533*T*LN(T)
+5.3895E-03*T**2-8.879385E-07*T**3+575530*T**(-1);
1400.00 Y -625196.99+78.896993*T-20.40145*T*LN(T)
-1.112923E-02*T**2+5.1896733E-07*T**3-6917350*T**(-1);
2900.00 Y -499226.55-490.37695*T+51.95912*T*LN(T)
-2.961051E-02*T**2+1.4033905E-06*T**3-48114685*T**(-1);
3172.00 Y -587711.89+375.04117-62.76*T*LN(T);
6000.00 N REF020 !
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PARAMETER
PARAMETER [GIBBS parameter name] [lowest temp. limit]
[expression 1]; [upper temp. limit 1] Y
[expression 2]; [upper temp. limit 2] Y
[expression 3]; [upper temp. limit 2] Y
.......... ; ..... Y
[expression n-1]; [upper temp. limit n-1] Y
[expression n]; [upper temp. limit n] N {Ref. Index} !

This keyword can appear in both files for database definition and sequential storage, but not
in FTP files. After the keyword, a valid GIBBS parameter name should be given.
It is used to define standard Gibbs energies (i.e. the G parameters for Gibbs energy of
formations) of all valid end-members of various stoichiometric and solution phases, and
excess Gibbs energies (i.e. the L parameters for Gibbs energy of interactions) of all binary,
ternary, quaternary or higher-order interactions in various solution phases; both standard
Gibbs energies and excess energies can also have parameters for contributions from PTdepended volume variations (i.e. the V0, VA, VC and VK parameters for molar volume,
thermal expansivity, bulk modulus, isothermal compressibility and high-pressure fitting
parameter), magnetic ordering (i.e. the TC and BM parameters for Curie temperature and
Bohr magneton number) and hypothetical electrostatic interactions (i.e. BM parameter for
Born functions ωPr,Tr of aqueous solute species).
The general form of a parameter is:
<identifier>(<phase>, <constituent array>; <digit>) <xxx>
<expression> <yyy> <keyword Y or N> <zzz> !

General Form
Name

Description

identifier

The parameter type.

phase

The phase name (maximum 24 characters).

constituent
array

The specific constituent array in the phase.
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Name

Description

digit

The degree of composition-dependent interaction contribution (an integer number from 0
to 9), that is only for excess energy (L), Curie temperature (TC) and Bohr magneton number
(BMAGN), as well as for volume-related parameters (V0 or VA or VB or VC or VK); if it is valued
as zero, or if it is for the standard Gibbs energy (G) for which the degree is always zero, it
can be omitted.

expression

The mathematical relation to describe the parameter.

xxx and
yyy

The low and high temperature limits respectively for the applicable temperature range of
the parameter expression

keyword Y
or N

The indicator on if there is continuation for the parameter expression or not

zzz

The reference index/number for the assessment of this parameter;

!

The exclamation mark is used to indicate that the current parameter definition is ended

GIBBS Parameter Name
The GIBBS parameter name has a general form of:
<identifier>(<phase>,<constituent array>;<digit>)

Type-Identifier and Definition
The GIBBS parameter name consists of several parts. The first is a type-identifier. The
following type-identifiers are legal:
TypeIdentifier

Definition

G

Standard energy parameter (Gibbs energy of formation)

L

Excess energy parameter (Gibbs energy of interaction)

TC

Curie temperature for magnetic ordering
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TypeIdentifier

Definition

BMAGN or
BM

Bohr magneton number for magnetic ordering (or Born function
species).

V0

Molar volume at 298.15 K and 1 bar (a numeric value only)

VA

Pr,Tr for aqueous solute

Integrated thermal expansivity

VC

High-pressure fitting parameter

VK

Isothermal compressibility

VISC

RT*ln(η) where η is the dynamic viscosity

ELRS

Electric resistivity

THCD

Thermal conductivity

SIGM

Surface tension of a liquid end-member

XI

Surface tension dampening factor/interaction for one constituent in a two-constituent
combination. See the examples for how to use these parameters

Examples
Parameter

Definition

G(GAS,C1O2)

The Gibbs energy of formation of a CO2 molecule in gas.

G(FCC,FE:VA)

The Gibbs energy of formation of fcc Fe with interstitials.

L(LIQ,Fe,Cr;0)

The regular solution parameter for Fe and Cr in liquid.

L(LIQ,Fe,Cr;1)

The sub-regular solution parameter.

TC(BCC,Fe:Va)

The Curie temperature of bcc Fe.
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Parameter

Definition

BMAGN(BCC,Fe:Va)

The Bohr magneton number parameter of bcc Fe.

SIGM
(LIQUID,AL;0)

Surface tension of Al in LIQUID. Constant value or linear temperature dependence.

XI
(LIQUID,AL,CU;0)

Surface tension dampening factor for Al in the Al-Cu combination in LIQUID.
Constant value.

XI
(LIQUID,AL,CU;1)

Surface tension dampening factor for Cu in the Al-Cu combination in LIQUID.
Constant value.

You can also use G for interaction parameters; and on output list (performed by the GIBBS
command LIST_PARAMETER or LIST_PHASE_DATA) the type-identifier L is always used for
interaction parameters. Note that the type-identifier BM is also used for Born functions
ωPr,Tr of aqueous solute species.
The identifier must be followed by an opening parenthesis, a phase name, a comma and a
constituent array. Optionally, the constituent array can be followed by a semicolon and a
digit. The parameter name is terminated by a closing parenthesis.

It is important that if a phase bears a legal phase-type (among G, A, Y, L, I, F
and B) in its phase definition (already by the PHASE keyword; such as GAS:G,
LIQUID:L, SLAG:L, IONIC_LIQ:Y, SPINEL:I, FCC_L12:F, HCP_D021:F, BCC_
B2:B, AQUEOUS:A), such a valid phase-type code should not be attached to the
phase name in the PARAMETER keyword.

Specifying the phase name in UPPER-case is recommended. You can define a
phase name as a mixture of UPPER-case and lower-case letters in a database,
but the DATA module automatically converts all lower-case to UPPER-case
because the GIBBS module only recognizes UPPER-case phase names.
The constituent array consists of a list of constituent names. Interaction parameters have
two or more constituents from the same sublattice separated by a comma. If the phase has
sublattices, at least one constituent in each sublattice must be specified. The exception is if
the phase is ionic liquid (specified with the "phase bit" :Y), then neutral endmember and
interaction parameters are written as if the first sublattice does not exist, e.g. PARAM G
(IONIC_LIQ,FEO3/2;0), i.e. the constituent array does not contain any constituents from
the first (cation) sublattice.
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For more ionic liquid specific parameters, see Parameters for the Two Sublattice Ionic
Liquid Model.
The constituents in different sublattices must be given in sublattice order and are separated
by a colon.
After the component array, a sub-index digit can be specified after a semicolon. This digit
must be in the range 0 to 9. The interpretation of the sub-index depends on the excess
energy model used for the phase. If no semicolon and digit are given, the sub-index value is
assumed to be as zero.
The excess energy parameters, e.g. the regular/subregular (binary) parameter or ternary
parameters, are multiplied with two or more fractions of the constituents from the same
sublattice of the solution phase. These additional constituents must be given as interacting
constituents.

Be careful about the sign of odd terms, for example, L(BCC, B, A:VA;1) is
treated as L(BCC,A,B:VA;1), i.e. it is always put into alphabetical order.

Solution phases with sublattices may have interacting constituents in each
sublattice.
You can use an asterisk (*) to denote that the excess interaction parameter is independent
of the constituents of a specific sublattice. For example, L(FCC_L12,AL,NI:*) means that
the interaction parameter is for the binary interaction between constituents AL and NI on
the first sublattice in the FCC_L12 solution phase, while it is independent of all constituents
on the second sublattice. A interaction parameter in the list of constituents is always added
to the Gibbs energy and the asterisk (*) is calculated with the term of [1-∑y(specified
constituents)], which implies that in an A-B binary system the following three L
parameters are identical (but in higher-order systems, they are different):
l

L(phase,A,B)is multiplied with X(A)*X(B)

l

L(phase,A,*)is multiplied with X(A)*(1-X(A))

l

L(phase,B,*)is multiplied with X(B)*(1-X(B))

A parameter always starts with a lowest temperature limit of its applicability, followed by
one or more (up to 10) expressions (TP-Functions) coded as mathematical relations of
constants, functions of stable variables (T and P) and entered functions (normally with a #
suffix, e.g. +3*GSERAL#).
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The expression is a FORTRAN-like expression and operators +, -, *, = and ** can be used (**
only with integer powers). Unary-functions LN or LOG (both for natural logarithm) and EXP
(for exponential) can also be used. Each expression (TP-Function) should ends with a
semicolon (;) and be followed by its upper applicable temperature limit and a continuation
indicator (Y to continue with the next expression, or N to end the parameter’s expression). If
there is no continuation after a specific expression (TP-Function), the reference index can be
optionally given after the N indicator.
A complete/valid parameter entry can be written in several continuation lines if the
parameter’s expression (TP-Function) is too long or if there is more than one applicable
expression (TP-Function), as the maximum length of each line is 78 characters.

It is recommended to always have at least one empty space at the beginning of
each continuation line. Avoid entering parameters such as:

PARAMETR G(LIQUID,A,B) 298.15
-2000+4568*T+2*GFUNAB#; 6000 N !

Such a parameter is read by the DATA module as 2000+4568*T+2*GFUNAB#, rather than as 2000 +4568*T+2*GFUNAB#.
Avoid this mistake by giving at least one empty space as the first character of a
new line, such as
PARAMETR G(LIQUID,A,B) 298.15
-2000+4568*T+2*GFUNAB#; 6000 N !

The lowest-temperature limit (in Kelvin) for the applicability of the (first) TP-Function in a
parameter is normally set by default as 298.15 K, in most cases; however, you can set
another limit when it is applicable (according to experimental data and assessments). An
upper-temperature limit (in Kelvin; followed by a Y or N sign) for the applicability of each TPFunction in a parameter must be given after the semicolon (;) immediately following the
specific TP-Function; and the highest-temperature limit (in Kelvin) for the applicability of the
current parameter is always followed by the N sign. If a negative number is given as the
lowest-temperature limit, it is assumed that there are breakpoints in pressure for this
parameter. In such cases, it is interpreted as the lowest-pressure limit (in Pascal), and the
other limits in the current parameter are also taken as pressure limit values (in Pascal).
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The temperature/pressure limits for the parameters are checked during calculations. An
indicator is set if the actual temperature/pressure condition is below the lowest
temperature/pressure limit or above the highest temperature/pressure limit. In these cases,
an extrapolation is done using the TP-Function valid in the nearest temperature/pressure
range.
The optional reference index {Ref. Index} is an integer number indicating where to find the
particular parameter in a special reference file. The references are listed when doing the
GET_DATA command in the DATA module. These can also be listed in the GIBBS module with
the command LIST_DATA and the option R or N.
For accounting the reference indices, also see the keyword REFERENCE_FILE.
The reference index field can also be an abbreviation (such as REF:250, REF_002, or REFSGTE) denoting the original reference. In this case, the reference cannot be obtained when
issuing the DATA command GET_DATA or the GIBBS command LIST_DATA (with the option R
or N).
However, the references directly coded in the database definition file (***setup.TDB) that
starts with a letter can be shown when issuing the DATA command GET_DATA or the GIBBS
command LIST_DATA (with the option R or N). Normally, such references must be located
after the LIST_OF_REFERENCE keyword. It is recommended to use reference code names
such as REF001, REF018, etc. The reference list, which is generated by the GIBBS command
LIST_DATA <file> with the N option, is thus also possible to be directly read by the DATA
module.

Examples
PARAMETER G(BCC,FE:VA) 298.15 1000+200*T+...; 6000 N 91DIN !
PARAMETER TC(BCC,FE:VA)

298.15 +1043; 6000 N 91DIN !

PARAMETER BMAGN(BCC,FE:VA) 298.15 +2.22; 6000 N 91DIN !
PARAMETER G(SIGMA,FE:CR:CR;0) 298.15 1000+200*T+...; 6000 N 101 !
PARAMETER G(LIQUID,AL;0)

298.15

+11005.553-11.840873*T

+7.9401E-20*T**7+GHSERAL#;
933.60 Y +10481.974-11.252014*T+1.234264E+28*T**(-9)+GHSERAL#;
2900.00 N

REF:283 !

PARAMETER G(BCC_A2,PB:C)

298.15 UN_ASS#; 300 N REF:0 !

PARAMETER G(BCC_A2,NI:C;0) 298.15 +GHSERNI#+3*GHSERCC#
+400000-100*T; 6000 N REF071 !
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PARAMETER G(BCC_A2,MN:VA)

298.15 +GMNBCC#; 6000 N REF285 !

PARAMETER BM(AQUEOUS,OH-1) 298.15 +Z0002PW0#; 1600 N 155 !
PARAMETER L(BCC,FE,CO:VA;0) 298.15 1000+200*T+...; 6000 N !
PARAMETER L(BCC,FE,CO:VA;1) 298.15 1000+200*T+...; 6000 N !
PARAMETER L(BCC,FE,CO:VA;2) 298.15 1000+200*T+...; 6000 N !
PARAM

TC(BCC_A2,CO,MO:VA;0) 298.15

-3700;

6000 N R454 !

PARAM

TC(BCC_A2,CO,MO:VA;1) 298.15

+2300;

6000 N R454 !

PARAM BMAGN(BCC_A2,CO,MO:VA;0) 298.15 -3.445;

6000 N R454 !

PARAM V0(BCC_A2,CR,FE:VA;0) 298.15 +ZERO#; 6000 N REF06V !
PARAM V0(BCC_A2,CR,FE:VA;1) 298.15 -1.10524097E-7; 6000 N REF06V !
PARAM V0(BCC_A2,CR,FE:VA;2) 298.15 +1.40024130E-7; 6000 N REF06V !
PARAM VA(BCC_A2,CR,FE:VA;0) 298.15 -6.49444634E-6*DELTAT#; 6000 N
REF06V !
PARAM VA(BCC_A2,CR,FE:VA;1) 298.15 +2.91269321E-5*DELTAT#; 6000 N
REF06V !

Parameters for the Two Sublattice Ionic Liquid Model
For the two sublattice ionic liquid model (specified with the "phase bit" :Y in the phase
declaration), there are some additional requirements on the allowed parameters. While in
the regular case all combinations of a phase’s constituents are allowed as end-members,
there are some constraints on the allowed parameters for ionic liquid.
In the ionic liquid model, the vacancy has been given an “induced” charge -Q, where Q is
the average charge of the first (cation) sublattice.
All allowed parameters are listed below. The following notations are used:
= Cation

l

C

l

C1

l

A

l

VA

l

N

= Neutral

l

D

= Anion or vacancy or neutral (i.e. anything on the second sublattice)

= Cation 1 if more than one. Similar for anions and neutrals.
= Anion
= Vacancy

The phase description is:
(C1,C2…Ci)P(A1,A2...Ai,VA,N1, N2...Ni)Q
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In the ionic liquid model,the Vacancy has been given an “induced” charge -Q, where Q is
the average charge of the first (cation) sublattice.
Allowed end-members, assuming the phase name is IONIC_LIQ:
G(IONIC_LIQ,C:A;0)
G(IONIC_LIQ,C:VA;0)
G(IONIC_LIQ,N;0)

(The last line is an exception to the case that the constituent array must contain constituents
from all sublattices)
This leaves one not allowed end-member:
G(IONIC_LIQ,C:N;0)

Allowed binary interaction parameters, where i is the interaction order in a Redlich-Kister
expansion.
G(IONIC_LIQ,C1,C2:A;i)
G(IONIC_LIQ,C1,C2:VA;i)
G(IONIC_LIQ,C:VA,N;i)
G(IONIC_LIQ,N1,N2;i)
G(IONIC_LIQ,C:A1,A2;i)
G(IONIC_LIQ,C:A,VA;i)
G(IONIC_LIQ,C:A,N;i)

No other binary interactions are allowed.
Allowed ternary interaction parameters. The interaction is composition independent if there
is one parameter with i = 0. It is composition dependent if there are three parameters with
i = 0, 1 and 2. There can only be one or three parameters for one combination of
constituents
G(IONIC_LIQ,C1,C2,C3:A;i)
G(IONIC_LIQ,C1,C2,C3:VA;i)
G(IONIC_LIQ,N1,N2,N3;i)
G(IONIC_LIQ,C1,C2:VA,N;i)
G(IONIC_LIQ,C:VA,N1,N2;i)
G(IONIC_LIQ,C:A,D1,D2;i)
G(IONIC_LIQ,C1,C2:A,D;i)

No other ternary interactions are allowed.
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OPTIONS
OPTIONS /[alloy name]([composition limitations for all alloying
elements]) !

This keyword defines an alloy in a database. An alloy has a name, a major component and a
number of alloying elements. The purpose for defining an alloy is to be able to tell you about
applicable composition limits of the current database in applications to that particular type
of alloy. It is possible to have several alloys in the same database. The alloys are given after
the keyword in the database.
The alloy name must be proceeded by a slash (/) and terminated by the opening
parenthesis, with no spaces are allowed in between.
l
l

l

l
l

The alloy name is maximum 8 characters.
After the parenthesis, follows the major element and a parenthesis with its minimum
mass and minimum mole percent given inside.
Then, the alloying element names, each with its maximum mass and mole percent
are given within parenthesis.
There must a space between definitions for each alloying element.
The alloy definition is terminated by a closing parenthesis, and the whole OPTIONS
keyword by the exclamation mark (!).

Example
OPTIONS /SSteel(Fe(60,60) CR(30,30) NI(15,15) SI(1,1) N(.1,1)) !
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TABLE
It is recommended to always have at least one empty space at the beginning of
each continuation line. Otherwise, the DATA module may issue some error
messages when reading the table entry.

TABLE [name]*8 [start temp] [end temp] [delta temp] [table values]
!

This keyword can appear in both files for database definition and sequential storage, but not
in FTP files. It makes a table of Gibbs energy as a function of temperature where the values
are given from the start temperature to the end temperature, at a step of the delta
temperature.

Example
TABLE DEMTAB 1000.0 1500.0 100.0 -2912.9008 -2834.2416 -2755.5824
-2677.7600 -2600.7744 -2524.2072 !
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ASSESSED_SYSTEMS
ASSESSED_SYSTEM [descriptions on special treatments for specific
assessed systems]*8000 !

This keyword can be included in the database definition file (the ***setup.TDB file). A
maximum of 8000 characters after the keyword (to describe some special options when the
DATA, GIBBS and POLY models deal with the existing systems with assessed data) is allowed
until the exclamation mark (!).
Several ASSESSED_SYSTEMS keywords can be used in the same TDB file in order to have
more lists of assessed systems. There is no limit to the number of the entries in the same
TDB file.
The assessed systems in the database, and the special treatment options, are typed after the
keyword. The elements (always in UPPER CASE) in each assessed system must be in
alphabetical order and be separated by a hyphen, such as C-FE for the Fe-C binary system,
and C-CR-FE for the Fe-Cr-C ternary system. A space must be between each assessed
system. Information on assessed binary, ternary or higher-order systems may also be given
in this way.
A ternary system like C-CR-FE does not imply that the binary C-CR, C-FE and CRFE are assessed. There is no way to indicate partially assessed systems.
l

l
l

l
l

There is a field to give some descriptive information for a specific system, with
various options about how to:
Reject or restore phase(s) from the current database in the DATA module;
Set major constituent(s) in the first composition set and to set a second composition
set for a specific phase available in the current database in the GIBBS module; and
Calculate this specific system in the POLY module.
This is the facility used by the BIN (binary phase diagrams) and TERN (ternary phase
diagrams) modules in the Thermo-Calc software/database package.

The descriptive information must immediately follow the specific system name, and must be
enclosed within parenthesis ( and ), and the left parenthesis must follow directly after the
system, such as :
AL-NI(TDB +L12 ;G5 C—S:L12/NI:AL:VA ;P3 STP:.8/1200/1
STP:.2/600/1)
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The syntax TDB means that the commands to the DATA module proceed, and +L12 in the
example means that the phase called L12 should be restored (it has been rejected by
default).
The directive ;G5 means that the following are commands to the GIBBS module. C_S:
means creating a second composition set, after the colon follows the phase name and after
the slash the major constituents.
After the directive ;P3 follows commands to the POLY module. STP: means setting a start
point with the value of the X-axis first (composition for the second element in a binary
system), the slash separates the Y-axis value (temperature), and possibly one or more
directions (-1, 1, -2 or 2).
A summary of the allowed syntax is:
TDB accepts
and -phase for restore/reject.

l

+phase

l

;G5

l

MAJ:phase/constituent-array

for major constituents of the first composition set.

l

C_S:phase/constituent-array

for a second composition set.

l

;P3

l

accepts

accepts

TMM:lt/ht for the low-/high-temperature limits (lt and ht; for instance
TMM:500/4000) suitable for calculating phase diagrams and property diagrams of

a

binary system.
l
l

l

l

l

l

*

for a default start point which is set as:

for a binary system: at the composition X(2nd
T=1100 K and with the default directions; or

element)=.1234,

temperature

for a ternary system: at the compositions X(2nd element)=.1234 and X(3rd
element)=.1234 and with the default directions.
STP:x/t/d1/d2/d3 for a specific start point in a binary system which is set as at the
composition X(2nd element)=x and temperature T=t (in K), and with the directions
d1, d2 and/or d3.
STP:x1/x2/d1/d2/d3 for a specific start point in a ternary system which is set as at
the compositions X(2nd element)=x1 and X(3rd element)=x2 and with the
directions d1, d2 and/or d3.

The direction(s) can be defined as -1, 1, -2 or 2. If no direction is specified, all
default directions are used (meaning no ADD command is enforced in the POLY
module).

Database Manager User Guide ǀ 49 of 91

Thermo-Calc Documentation Set

l

If only one start point is specified, the direction(s) may be omitted; if more than one
start points are specified, at least one direction for each start point must be given for
all start points.

Each entry for a specific binary or ternary sub-system can be written in one or several lines
(each line with 78 characters).

Other Examples
ASSESSED_SYSTEMS
AL-NI(TDB +L12 +BCC_B2 ;G5 C_S:L12/NI:AL:VA
;P3 STP:.8/1000/1 STP:.45/700/1 STP:.7/700/1)
AL-PB(TDB -HCP -BCC
;G5 MAJ:LIQ/AL MAJ:FCC/AL:VA C—S:LIQ/PB C—S:FCC/PB:VA ;P3
*)
CR-FE(;G5 C—S:BCC/CR:VA ;P3 STP:.6/1200/1/-2/2)
AG-CU(;G5 MAJ:FCC/AG:VA C_S:FCC/CU:VA ;P3 STP:.3/1000)
C-NB(;P3 STP:.9/1100/1)
C-SI(;P3 *)
CO-CR(;G5 MAJ:FCC/CO:VA C_S:FCC/CR:VA ;P3 STP:.1/1100)
CR-FE(TDB -HCP ;G5 C_S:BCC/CR:VA ;P3 STP:.6/1200/1/-2/2)
CR-NI(;P3 *)
CR-W(;G5 MAJ:BCC/W:VA C_S:BCC/CR:VA
;P3 TMM:500/4000 STP:.3/700/1 STP:.3/1800/2 )
CU-FE(TDB -HCP ;G5 MAJ:LIQ/CU MAJ:FCC/FE:VA C_S:FCC/CU:VA
;P3 STP:.9/1400)
FE-N(TDB +FE4N ;P3 *)
FE-O(TDB -LIQUID +IONIC ;G5 C_S:ION_LIQ/FE+2:O-2 MAJ:ION_
LIQ/FE+2:VA
;P3 STP:.2/2000/1 )
FE-S(TDB -LIQUID +IONIC ;G5 C_S:ION_LIQ/FE+2:S MAJ:ION_LIQ/FE+2:S2 ;P3 *)
AL-MG-SI(;P3 *)
C-CR-FE ;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA ;P3 *) !
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The semicolon (;) is a part of the ;G5 and ;P3 directives. A long descriptive
information can be written in more than one line, such as for the AL-NI, AL-PB ,
CU-FE and FE-O systems shown above.
The directive ;P3 * is needed if the default start point should be used. If there is no P3
directive, the BIN or TERN module generates some 20 different start points in order to cover
all possible compositions and temperatures (for a binary system) or all possible compositions
(for a ternary system under any specific temperature).
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REFERENCE_FILE
REFERENCE_FILE [file name] !

This keyword takes a reference file name as its argument. This reference file (that must be
edited in a restrictive way and be saved as a blocked file with a fixed line-length for each
line in the file, as described below) contains a complete list of the references for the various
parameters (and sometimes functions) in the database. The file must have a fixed record
structure: each reference entry with one or several records, and each record with exactly 78
characters written in one single blocked line; and no empty space is allowed at the
beginning of all lines in the file. If there are more than one record entered for a reference
entry, all the continuation lines must start with an ampersand (&). The line number of the
first record for a specific reference entry is then accounted as the unique integer for that
specific reference, which is referred when a parameter or function calls this integer as the
optional {Ref. Index}.
Keywords PARAMETER or FUNCTION have information about specifying a reference
index.

Example
/-1<G>

T.C.R.A.S. Class 1

AG1.64TE1

THERMODATA 01/93

&28/01/93
&SILVER 1.64-TELLURIDE. Solid Standard State.
AG1

HULTGREN SELECTED VAL.

SGTE **

&AT.WEIGHT 107.870,STANDARD STATE:CODATA KEY VALUE.MPT=1234.93K.
&--U.D. 30/10/85.
AG1<G>

T.C.R.A.S

Class: 1

AG1/+1<G>

T.C.R.A.S

Class: 1

AG1BR1

N.P.L.

SGTE **

&Tfusion uncertain and heat vaporization estimated.
AG1BR1<G>

THERMODATA 01/93

&28/01/93
&Gaseous Standard State.
AG1BR1O3
&AGO3BR

BARIN & KNACKE.SUPPL.REF:62,* SGTE **
SILVER OXYTRIBROMIDE
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In the example, the unique integers of related references (for assessed elements, species,
phases, interactions, etc.) are:
1/-1<G>
2AG1.64TE1
5 AG1
8AG1<G>
9AG1/+1<G>
10AG1BR1
12AG1BR1<G>
15AG1BR1O3
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LIST_OF_REFERENCE
LIST_OF_REFERENCE
NUMBER SOURCE
[REFxxx]

'[Detailed reference]'

..........
.......... !

This keyword starts a reference list that is directly coded in the database definition file
(***setup.TDB). Its argument begins on the following line, and normally has an explanation
line (NUMBER SOURCE) that is followed by various reference codes. Each reference code
may occupy one or more lines (each line with maximum 78 characters), but must have a
reference code name (that starts with a letter) and the detailed reference information (that
is written within two single-quotation marks, ''). It is recommended to use reference code
names such as REF001, REF018, etc. A maximum of 400,000 characters after the keyword is
allowed until the exclamation mark (!).
Such a reference list can be shown when issuing the DATA command GET_DATA or the
GIBBS command LIST_DATA (with the R option). The reference list, which is generated by the
GIBBS command LIST_DATA <file> with the N option, has this structure, and is thus possible
to be directly read by the DATA module.

Example
LIST_OF_REFERENCES
NUMBER

SOURCE

REF283 'Alan Dinsdale, SGTE Data for Pure Elements,
Calphad Vol 15(1991) p 317-425,
also in NPL Report DMA(A)195 Rev. August 1990'
REF224 'P-Y Chevalier, Thermochimica Acta, 130 (1988) p 33-41; AGSI'
!
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ADD_REFERENCE
ADD_REFERENCE
[REFxxx]

'[Detailed reference]'

..........
.......... !

Use this keyword to have an unlimited number of references. The use of this is the same as
that of LIST_OF_REFERENCE, and is used after it. Several ADD_REFERENCES sections can be
used in a single database if there are too many references.
It is recommended to always start with a so-called empty reference (such as the DUMP0
reference in the following example) as the first entry in each of the ADD_REFERENCE sections
to make sure that all references are listed appropriately as retrieving data by issuing the
GET_DATA command.

Example
ADD_REFERENCE
DUMP0

'Empty reference 0'

REF4 'J-O Andersson, B. Sundman, CALPHAD Vol 11, (1987), p 8392
TRITA 0270 (1986); CR-FE'
REF5 'J-O Andersson, Met. Trans A, Vol 19A, (1988) p 627-636
TRITA 0207 (1986); C-CR-FE'
REFS 'Pingfang Shi (2006), TCS PTERN Public Ternary Alloys
Database,
v1.2; Modified L0(BCC,Fe,C) and L0(BCC,Cr,C) parameters
at high temperatures.'
... ...
!
ADD_REFERENCE
DUMP1

'Empty reference 1'

REF275 'A. Fernandez Guillermet, Z. Metallkde. Vol 79(1988)
p.524-536,
TRITA-MAC 362 (1988); C-CO-NI AND C-CO-FE-NI'
REF393

'K. Frisk, Metall. Trans. Vol 21A (1990) p 2477-2488,
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TRITA 0409 (1989); CR-FE-N'
REF1096

'P. Gustafson, Metall. Trans. 19A(1988) p 2547-2554,
TRITA-MAC 348, (1987); C-CR-FE-W'

... ...
!
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CASE and ENDCASE
CASE [ELEMENT/SPECIE/PHASE] !
IF (boolean algebra on element, species or phase names) THEN
[GIBBS/POLY/DATA command] !
ENDCASE !

This keyword takes as its argument, a definition on which type of the following Boolean
algebra operates. A simple Boolean algebra using AND and OR with a maximum of four levels
of parentheses works. The CASE construction must end with the ENDCASE keyword. This
makes it possible to have additional GIBBS or POLY commands executed depending on the
user selection of elements, species or phases. The DATA commands that can be given as
secondary keyword to DEFAULT_COMMAND can also be executed.

Example 1
CASE ELEMENT !
IF((CR OR TI OR V) AND N)
THEN GES AM_PH_DES @ C_S ,, CR MO TI V:C N: !
ENDCASE !

Example 2
CASE ELEMENT !
IF(O) THEN TDB DEFINE_SYSTEM_ELEMENT /- !
ENDCASE !

Example 3
CASE ELEMENT !
IF(AL AND FE)
THEN TDB DEF_SYS_ELEMENT VA !
ENDCASE !
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VERSION_DATA
VERSION_DATE [string]*78 !

The string is denoted as the version/revision date and database manager of the database.
Nowadays, this directive is used mainly for the purpose of keeping the development and
revision history mostly updated.

Example
VERSION_DATE Last update and adjustment: Database Manager, 201509-25 !

Database Manager User Guide ǀ 58 of 91

Thermo-Calc Documentation Set

Working with the Mobility Databases
In this section:
Extensions to Database Definition File Syntax

60

PARAMETER

61

DIFFUSION

62

ZEROVOLUME_SPECIES

63
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Extensions to Database Definition File Syntax
Software packages for simulation of diffusional phase transformations, such as the Diffusion
Module (DICTRA) and Precipitation Module (TC-PRISMA), need both thermodynamic data
and kinetic data (i.e. diffusivities or mobilities). Naturally, the handling and storage of kinetic
data also benefits from the use of some kind of database management. Thus, the TDB
database definition file syntax has been extended to incorporate some new keywords
needed for storing kinetic data - PARAMETER, DIFFUSION, and ZEROVOLUME_SPECIES .
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PARAMETER
PARAMETER [special GIBBS parameter name] [low temp. limit]
[expression 1]; [upper temp. limit 1] Y
[expression 2]; [upper temp. limit 2] Y
[expression 3]; [upper temp. limit 2] Y
.......... ; ..... Y
[expression n-1]; [upper temp. limit n-1] Y
[expression n]; [upper temp. limit n] N {Ref. Index} !

This keyword allows you to enter all types of normal GIBBS parameters for thermodynamic
data as well as five special extensions suitable for kinetic data used in the Diffusion Module
(DICTRA).
Valid extensions to special GIBBS parameter names are:
l

MQ: Activation enthalpy for

l

MF: Pre-exponential

l

DQ: Activation enthalpy for

l

DF: Pre-exponential

l

VS: Volume

mobility equation.

factor for mobility equation.
diffusivity equation.

factor for diffusivity equation.

counted per mole of volume carrying species.

Example
See the TDB file for DICTRA example exa4: Carburization of binary Fe-C alloy:
Comparison to an analytical erf solution. Press F1 in Thermo-Calc to search the
help for more information.
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DIFFUSION
DIFFUSION [model keyword] [phase name] [additional parameter(s)] !

This keyword specifies the type of diffusion model to use for a phase if the default model is
not desired. The default model calculates the full diffusion matrix. A diffusivity is calculated
from the different mobilities and the thermodynamic factors. The former ones are
calculated as:
M = exp (∑ MF/RT) exp (∑ MQ/RT) / RT

where ∑ stands for a weighted summation of the different MF’s and MQ’s plus possibly a
Redlich-Kister term.

Valid Model Keywords
Keyword

Description

NONE

No diffusion in this phase

DILUTE

Constitution list of dependent species in each sublattice must be given as an additional
parameter. Only the diagonal terms in the diffusion matrix are calculated. D = exp (∑
DF/RT) exp (∑DQ/RT).

SIMPLE

Constitution list of dependent species in each sublattice must be given as additional
parameter. Only the diagonal terms in the diffusion matrix are calculated. D = ∑ DF + ∑ DQ.

MAGNETIC

The so-called ALPHA and ALPHA2 parameters must be given as additional parameters.
ALPHA is for the substitutional magnetic model and ALPHA2 for the interstitial one. By
appending an & sign and a species name after the alpha keyword one can supply individual
values for the different species. The full diffusion matrix is calculated.

Examples
DIFFUSION NONE SIGMA !
DIFFUSION DILUTE CEMENTITE : FE : C : !
DIFFUSION MAGNETIC BCC_A2 ALPHA=0.3 ALPHA2&C=1.8 ALPHA2&N=0.6 !
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ZEROVOLUME_SPECIES
ZEROVOLUME_SPECIES [list of species] !

In the Diffusion Module (DICTRA), the assumption that the volume is carried by the
substitutional elements only is applied. The interstitial elements are assumed to have zero
molar volumes. This keyword uses a list of which species are to be considered as zero
volume ones for an argument.
There is no underscore (_) between Zero and Volume.

Example
ZEROVOLUME_SPECIES VA C N !
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Database Definition File Examples
In this section:
Example 1: A Steel Database

65

Example 2: A Custom Database for the Sb-Sn Binary System

67

Example 3: A Public Database for the Fe-Cr-C Ternary System

71
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Example 1: A Steel Database
TEMP-LIM 500.0 2000.0 !
$
$ELEMENT, NAME, REF.STATE, ATOMIC-MASS, H0, S0 !
ELEMENT VA VACUUM

0.0

0.0 0.0 !
0.0 0.0 !

ELEMENT C

GRAPHITE

12.011

ELEMENT V

BCC

50.9415 0.0 0.0 !

ELEMENT CR BCC-PARAMAGNETIC 51.996

0.0 0.0 !

ELEMENT FE FCC-PARAMAGNETIC 55.847

0.0 0.0 !

ELEMENT NI FCC-PARAMAGNETIC 58.69

0.0 0.0 !

ELEMENT MO BCC

95.94

0.0 0.0 !

183.85

0.0 0.0 !

ELEMENT W

BCC

$
$PHASE, NAME, TYPE, NR-OF-SUBL, SITES-IN-EACH-SUBL. !
PHASE BCC

B1M

2 1.0 3.0 !

PHASE FCC

F2M

2 1.0 1.0 !

PHASE HCP

0

2 2.0 1.0 !

PHASE LIQUID

3

2 1.0 1.0 !

PHASE CEMENTITE 4

2 3.0 1.0 !

PHASE M23C6

4

2 23.0 6.0 !

PHASE M7C3

4

2 7.0 3.0 !

PHASE M6C

4

4 2.0 2.0 2.0 1.0 !

PHASE SIGMA

0

3 10.0 4.0 16.0 !

PHASE MU-PHASE

0

3 7.0 2.0 4.0 !

PHASE R-PHASE

0

3 27.0 14.0 12.0 !

PHASE GRAPHITE

4

1 1.0 !

$
$CONSTITUENT, PHASE-NAME : CONSTITUENTS !
CONSTITUENT BCC :V CR FE NI MO W:VA C: !
CONSTITUENT FCC :V CR FE NI MO W:VA C: !
CONSTITUENT HCP :CR FE NI:VA C N: !
CONSTITUENT LIQUID :C V CR FE NI MO W VA:VA C: !
CONSTITUENT CEMENTITE :CR FE:C: !
CONSTITUENT M23C6 :CR FE:C: !
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CONSTITUENT M7C3 :CR FE:C: !
CONSTITUENT M6C :FE:W:FE W:C: !
CONSTITUENT SIGMA :FE:V CR MO:FE V CR MO: !
CONSTITUENT MU-PHASE :FE:MO W:FE MO W: !
CONSTITUENT R-PHASE :FE:MO :FE MO: !
CONSTITUENT GRAPHITE :C: !
$
$TYPE_DEFINITIIONS:
TYPE-DEFINITION 0 SEQ TCPATH\DATA\METDATA\TC-THEREST.TDB !
TYPE-DEFINITION 1 SEQ TCPATH\DATA\METDATA\TC-BCC.TDB !
TYPE-DEFINITION 2 SEQ TCPATH\DATA\METDATA\TC-FCC.TDB !
TYPE-DEFINITION 3 SEQ TCPATH\DATA\METDATA\TC-LIQUID.TDB !
TYPE-DEFINITION 4 SEQ TCPATH\DATA\METDATA\TC-CARBIDES.TDB !
TYPE-DEFINITION M SEQ TCPATH\DATA\METDATA\TC-CURIE-BOHR.TDB !
TYPE-DEFINITION B GES AM-PH BCC MAGNETIC -1 .4 !
TYPE-DEFINITION F GES AM-PH FCC MAGNETIC -3 .28 !
$
$DEFAULT_COMMANDS:
DEFAULT-COMMAND DEF_ELEMENT VA !
DEFAULT-COMMAND REJ_SYS-CONST LIQUID 1 VA !
$DATABASE_INFORMATION:
DATABASE-INFO The following binary and ternary systems are available: '
FE-CR-NI by Hertzman'
FE-MO

Fernandez'

FE-CR-C

Andersson'

FE-W-C

Gustafson'

FE-W

Andersson & Gustafson' !
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Example 2: A Custom Database for the Sb-Sn Binary
System
$
$ELEMENT, NAME, REF.STATE, ATOMIC-MASS, H0, S0 !
ELEM VA VACUUM

0.0

ELEM MG HCP(A3)

0.0 0.0 !

24.305 0.0 0.0 !

ELEM SB RHOMBOHEDRAL(A7) 121.75

0.0 0.0 !

ELEM SN BCT(A5)

0.0 0.0 !

118.69

ELEM /- ELECTRON-GAS

0

0

0 !

$
$SPECIES, NAME, STOICHIOMETRIC-FORMULA !
SPECIE MG1 MG1!
SPECIE MG2 MG2!
SPECIE MG2+ MG/+2!
SPECIE SB1 SB1!
SPECIE SB2 SB2!
SPECIE SB4 SB4!
SPECIE SB3- SB/-3!
SPECIE SB5- SB/-5!
SPECIE SN1 SN1!
SPECIE SN4- SN/-4!
$
$PHASE, NAME, TYPE, NR-OF-SUBL, SITES-IN-EACH-SUBL. !
PHASE BCT

Z 1 1.0!

PHASE HCP

Z 1 1.0!

PHASE RHOMBO

Z 1 1.0!

PHASE GAS:G

Z 1 1.0!

PHASE LIQUID:L

Z 1 1.0!

PHASE IONICLIQ:Y Z 2 1 1!
PHASE SPLIQ:Y

Z 2 1 1!

PHASE BMG3SB2:I

Z 2 3 2!

PHASE AMG3SB2:I

Z 2 3 2!

PHASE MG2SN:I

Z 2 2 1!

PHASE SBSN

Z 2 1 1!
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PHASE SB2SN3

Z 2 2 3!

$
$CONSTITUENT, PHASE-NAME : CONSTITUENTS !
CONSTITUENT RHOMBO :SB SN:!
CONSTITUENT HCP :MG SN:!
CONSTITUENT BCT :SB SN:!
CONSTITUENT GAS:G :MG1 MG2 SB1 SB2 SB4 SN1:
> Gas phase, using the Ideal EOS and Mixing Model. !
CONSTITUENT LIQUID:L :SB SN:!
CONSTITUENT IONICLIQ:Y :MG2+:SB SB3- SN SN4- VA:
> This is the Ionic Liquid Solution Phase. !
CONSTITUENT SPLIQ:Y :MG2+:SB SB3- SN SN4- VA:!
CONSTITUENT BMG3SB2:I :MG2+:SB3- SB5- VA SN4-:!
CONSTITUENT AMG3SB2:I :MG2+:SB3- VA SN4-:!
CONSTITUENT MG2SN:I :MG2+ VA:SB3- SN4-:!
CONSTITUENT SBSN :SB SN:SB SN:!
CONSTITUENT SB2SN3 :SB:SN:!
$
$DEFAULT_COMMANDS:
DEFAULT-COM DEF-ELEM VA /-!
DEFAULT-COM REJ-PHASE LIQUID!
DEFAULT-COM REJ-PHASE SPLIQ!
$
$TYPE_DEFINITIIONS:
TYPE-DEFINITION Z SEQ * !
$
$DATABASE_INFORMATION:
DATABASE_INFO The Sb-Sn system with isentropic temperatures!
$
$VERSION_DATE:
VERSION_DATE Last update 1986-05-18 11:39:49 !
$
$
$ HERE COMES THE THERMODYNAMIC DATA (expressed in functions & parameters):
$
FUNCTION MGLIQUID 298.15 -4630.90976+192.994374*T-34.0888057*T*LOG(T)
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-36544605.6*T**(-2); 6000 N!
$
FUNCTION MGSOLID 298.15 -8367.34+143.677876*T-26.1849785*T*LOG(T)
+4.858E-4*T**2-1.393669E-6*T**3+78950*T**(-1);
923.00 Y -13804.4772 +202.909445*T-34.0888057*T*LOG(T)
-3.65446056E7*T**(-2) +1.06753982E28*T**(-9); 6000 N!
$
FUNCTION SBLIQUID 298.15 9071.98+146.800*T-31.38*T*LOG(T)
-2.441646E8*T**(-2); 6000 N!
$
.....
..... <more>
$
FUNCTION LFCT 298.15 -17325.6+5.03600*T; 6000 N!
FUNCTION GFCTSBSN 298.15 LFCT+SBSOLID+SNSOLID+2948.291+3721.286;
6000 N!
FUNCTION ISB 298.15 15000; 6000 N!
FUNCTION ISN 298.15 47199.9-95.6270*T; 6000 N!
$
.....
..... <more>
$
PARAMETER G(RHOMBO,SB;0) 298.15 SBSOLID; 6000 N!
PARAMETER G(RHOMBO,SN;0) 298.15 2035+SNSOLID; 6000 N!
$
PARAMETER G(HCP,MG;0) 298.15 MGSOLID; 6000 N!
PARAMETER G(HCP,SN;0) 298.15 32000+SNSOLID; 6000 N!
PARAMETER G(HCP,MG,SN;0) 298.15 -69566-9.23183*T; 6000 N!
$
PARAMETER G(BCT,SN;0) 298.15 SNSOLID; 6000 N!
PARAMETER G(BCT,SB;0) 298.15 1000+SBSOLID; 6000 N!
PARAMETER G(BCT,SB,SN;0) 298.15 0.5*ISB+0.5*ISN; 6000 N!
PARAMETER G(BCT,SB,SN;1) 298.15 0.5*ISB-0.5*ISN; 6000 N!
$
PARAMETER G(IONICLIQ,MG2+:SB3-;0) 298.15 -204389-4.98506*T
-2.75637E9*T**(-2)+3*MGLIQUID+2*SBLIQUID; 6000 N!
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PARAMETER G(IONICLIQ,MG2+:SN4-;0) 298.15 -98639.5+881.073*T
-174.523*T*LOG(T)-1.79808E9*T**(-2); 6000 N!
PARAMETER G(IONICLIQ,MG2+:SB;0) 298.15 SBLIQUID; 6000 N!
$
......
...... <more>
$
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Example 3: A Public Database for the Fe-Cr-C
Ternary System
$
$

Revision history:

$

Created as PDEMO

by Pingfang Shi

on 2004-10-05

$

Renamed to DFeCrC by Pingfang Shi

on 2006-10-25

$
$ FURTHER MODIFICATIONS:
$ ======================
$ pfs: /20041005 (PDEMO)
$

* Retrieved all definitions from PTERN for the Fe-Cr-C ternary !

$
$ pfs: /20061025 (DFeCrC)
$

* Ignore ELEMENT /- definition.

$

* Modify the L(BCC_A2,FE:C,VA;0) [and L(BCC_A2,CR:C,VA;0)]

$

parameters, in order to avoid BCC-appearance (Fe-C)

$

at temperatures higher than 3900 K.

$
$
$
$
$
$

$L(BCC_A2,CR:C,VA;0) 298.15 -190*T;

L(BCC_A2,CR:C,VA;0) 298.15 -190*T; 3000 Y 0; 6000 N REF1 !
$L(BCC_A2,FE:C,VA;0) 298.15 -190*T;

* Add Cr into HCP_A3 phase, and
add all necessary G0/L parameters (according to SSOL2/TCFE3):
G(HCP_A3,CR:VA;0)

$

TC(HCP_A3,CR:VA;0)

$

BMAGN(HCP_A3,CR:VA;0)

$

G(HCP_A3,FE:C;0)

$

G(HCP_A3,CR:C;0)

$

L(HCP_A3,CR:C,VA;0)

$

L(HCP_A3,CR,FE:VA;0)

$
$
$

6000 N REF3 !

L(BCC_A2,FE:C,VA;0) 298.15 -190*T; 3900 Y 0; 6000 N REF3 !

$

$

6000 N REF1 !

* Add "TMM:300/3000" limits to all three binary joins in the
ASSESSED_SYSTEM section.
* Change the reference indices, e.g., 101 to REF1, in order to
always get the reference list correctly.
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$

* Re-arrange database format slightly.

$

* Updated the DATABASE_INFO section.

$-----------------------------------------------------------------------$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$ DATABASE INFORMATION:
$************************************************************************
$
DATABASE_INFO

DFeCrC '
TCS Demo Fe-Cr-C Alloy Solutions Database'

(only for demonstration purposes in TCC-Demo/TCW-Demo)'
************************************************************ '
(Version 1.2, Oct. 2006) ''
Copyright @ 2004-2012: Thermo-Calc Software AB, Sweden ''
The DFeCrC database (previously called PDEMO) is the TCS Demo Fe-Cr-C '
Alloy Solutions Database, which is especially designed for primarily '
demonstrating the uses of: '
* TCC-Demo software: BIN, TERN, SCHEIL and some other modules; '
* TCW-Demo software: '
"Binary" module calculations of phase diagrams and property diagrams'
in available binary systems; '
"Ternary" module calculations of phase diagrams (e.g., isothermal'
sections, monovariant lines involving liquid, liquidus'
surface projections) and property diagrams in available'
ternary systems; '
"Scheil" module simulations of alloy solidifications; and/or '
"Equilibrium" calculation routines for phase diagrams and property'
diagrams in available binary or ternary systems. '
It can also be used for other types of calculations/simulations in both'
TCC and TCW software, and in their application programming interfaces.''
It includes critically-assessed data for all possible three binary joins'
(i.e. Cr-C, Fe-Cr and Fe-Cr) and one complete ternary alloy solutions '
within the Fe-Cr-C system. However, due to the fact that experimental'
data for the Fe-C and Cr-C binary joins and Fe-Cr-C ternary system at '
extremely-high temperatures are not sufficient, the available assessed'
data can not be applied to temperature conditions higher than 4000 K.''
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Included thermodynamic data are available for various stoichiometric '
and solution phases, e.g. liquid mixture, various alloy solutions and '
intermetallic phases. But the gaseous mixture phase is excluded in this'
DEMO version.''
The DFeCrC database can be used not only in calculating various types '
of phase diagrams (binary phase diagrams, ternary isothermal sections,'
ternary monovariant lines involving liquid, ternary liquidus surface '
projections, ternary isopleth sections, etc.) and property diagrams '
(the easiest ways are through the BIN and TERN modules), but also in '
simulating alloy solidification processes (with the SCHEIL module) of'
Fe-based or Cr-based alloys (but limited within the Fe-Cr-C ternary '
system in this DEMO version). Many unique features of the TCC/TCW '
software can be demonstrated using this and other specially-designed '
DEMO databases. ''
However, this DFeCrC database (similar to other DEMO and/or PUBLIC TC '
databases) is provided within the TCC-Demo/TCW-Demo software only for '
the purposes of demonstration, testing and evaluation. For R&D projects'
and teaching activities, you are highly encouraged to only use the FULL'
versions of the TCC and/or TCW software together with some commercial '
databases that are appropriate for your specific applications. Please '
contact us for all kinds of details. ''
Release History: Version 1.1 with minor improvements,

Oct. 2004 '

Version 1.2 with minor modifications, Oct. 2006 ''
Edited by: Dr. Pingfang Shi (Thermo-Calc Software, Oct. 2006). ''
!

$ ----------------------------------------------------------------------$VERSION_DATE Last update and adjustment: Pingfang Shi, 2004-10-05 !
VERSION_DATE Last update and adjustment: Pingfang Shi, 2006-10-25 !

$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$ Definition of Elements in the Database System:
$-----------------------------------------------------------------------$ELEM NAME STABLE_ELEMENT_REF

ATOMIC MASS

H298-H0

S298 !

$------------------------------------------------------------------------
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$ELEMENT /-

ELECTRON_GAS

0.0000E+00

0.0000E+00

0.0000E+00!

ELEMENT VA

VACUUM

0.0000E+00

0.0000E+00

0.0000E+00!

ELEMENT C

GRAPHITE

1.2011E+01

1.0540E+03

5.7400E+00!

ELEMENT CR

BCC_A2

5.1996E+01

4.0500E+03

2.3560E+01!

ELEMENT FE

BCC_A2

5.5847E+01

4.4890E+03

2.7280E+01!

$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$ TYPE_DEFINITIONS for data inclusions:
$-----------------------------------------------------------------------TYPE_DEFINITION % SEQ *!

$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$

TYPE_DEFINITIONS for phase descriptions:

$-----------------------------------------------------------------------$... For magnetic contributions:
TYPE_DEFINITION A GES AMEND_PHASE_DES @ MAGNETIC

-1.0

4.00000E-01 !

TYPE_DEFINITION B GES AMEND_PHASE_DES @ MAGNETIC

-3.0

2.80000E-01 !

$... For Cr/Fe-C in FCC phase and Cr/Fe-C in HCP phase:
TYPE_DEFINITION C IF(C) THEN GES AMEND_PHASE_DES @ C_S ,, :C: !

$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$ Default Commands:
$-----------------------------------------------------------------------$DEFINE_SYSTEM_DEFAULT SPECIES 2 !
DEFINE_SYSTEM_DEFAULT ELEMENT 2 !

DEFAULT_COMMAND DEF_SYS_ELEMENT VA !

$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$ FUNCTIONS for various phases:
$------------------------------------------------------------------------
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$
FUNCT GHSERCC

298.15 -17368.441+170.73*T-24.3*T*LN(T)

-4.723E-04*T**2+2562600*T**(-1)-2.643E+08*T**(-2)
+1.2E+10*T**(-3); 6000 N!
FUNCT GHSERCR

298.15 -8856.94+157.48*T-26.908*T*LN(T)

+.00189435*T**2-1.47721E-06*T**3+139250*T**(-1);

2180 Y

-34869.344+344.18*T-50*T*LN(T)-2.88526E+32*T**(-9); 6000 N!
FUNCT GHSERFE

298.15 +1225.7+124.134*T-23.5143*T*LN(T)

-.00439752*T**2-5.8927E-08*T**3+77359*T**(-1);

1811.00 Y

-25383.581+299.31255*T-46*T*LN(T)+2.29603E+31*T**(-9); 6000 N!

FUNCT GFELIQ

298.15 +GHSERFE#+12040.17-6.55843*T

-3.6751551E-21*T**7;

1811 Y

-10839.7+291.302*T-46*T*LN(T);
FUNCT GFEFCC

6000 N!

298.15 +GHSERFE#-1462.4+8.282*T

-1.15*T*LN(T)+6.4E-04*T**2;

1811 Y

-27098.266+300.25256*T-46*T*LN(T)+2.78854E+31*T**(-9);
FUNCT GFECEM
FUNCT GFEM23C6

6000 N!

298.15 +GPCEM1#-10745+706.04*T-120.6*T*LN(T); 6000 N!
298.15 +7.666667*GFECEM#-1.666667*GHSERCC#

+66920-40*T; 6000 N!

FUNCT GCRFCC

298.15 +GHSERCR#+7284+.163*T;

6000 N!

FUNCT GCRM23C6 298.15 -521983+3622.24*T-620.965*T*LN(T)
-.126431*T**2;
FUNCT GCRM3C2

298.15 -100823.8+530.66989*T-89.6694*T*LN(T)

-.0301188*T**2;
FUNCT GCRM7C3

6000 N!

6000 N!

298.15 -201690+1103.128*T-190.177*T*LN(T)

-.0578207*T**2;

6000 N!

FUNCT GPCLIQ

298.15 +YCLIQ#*EXP(ZCLIQ#);

6000 N!

FUNCT ACLIQ

298.15 +2.32E-05*T+2.85E-09*T**2;

6000 N!

FUNCT BCLIQ

298.15 +1+3.2E-10*P;

6000 N!

FUNCT CCLIQ

298.15 1.6E-10;

6000 N!

FUNCT DCLIQ

298.15 +1*LN(BCLIQ#);

6000 N!

FUNCT ECLIQ

298.15 +1*LN(CCLIQ#);

6000 N!

FUNCT VCLIQ

298.15 +7.626E-06*EXP(ACLIQ#);

6000 N!
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FUNCT XCLIQ

298.15 +1*EXP(.5*DCLIQ#)-1;

6000 N!

FUNCT YCLIQ

298.15 +VCLIQ#*EXP(-ECLIQ#);

6000 N!

FUNCT ZCLIQ

298.15 +1*LN(XCLIQ#);

6000 N!

FUNCT GPCGRA

298.15 +YCGRA#*EXP(ZCGRA#);

FUNCT ACGRA

298.15 +2.32E-05*T+2.85E-09*T**2;

6000 N!

FUNCT BCGRA

298.15 +1+3.6E-10*P;

6000 N!

FUNCT CCGRA

298.15 3.3E-10;

6000 N!

FUNCT DCGRA

298.15 +1*LN(BCGRA#);

6000 N!

FUNCT ECGRA

298.15 +1*LN(CCGRA#);

6000 N!

FUNCT VCGRA

298.15 +5.259E-06*EXP(ACGRA#);

6000 N!

FUNCT XCGRA

298.15 +1*EXP(.9166667*DCGRA#)-1;

6000 N!

FUNCT YCGRA

298.15 +VCGRA#*EXP(-ECGRA#);

6000 N!

FUNCT ZCGRA

298.15 +1*LN(XCGRA#);

6000 N!

FUNCT GPCFCC

298.15 +YCFCC#*EXP(ZFEFCC#);

FUNCT ACFCC

298.15 +1.44E-04*T;

6000 N!

FUNCT VCFCC

298.15 +1.031E-05*EXP(ACFCC#);

6000 N!

FUNCT YCFCC

298.15 +VCFCC#*EXP(-EFEFCC#);

6000 N!

FUNCT GPCRLIQ

298.15 +YCRLIQ#*EXP(ZCRLIQ#);

6000 N!

FUNCT ACRLIQ

298.15 +1.7E-05*T+9.2E-09*T**2;

6000 N!

FUNCT BCRLIQ

298.15 +1+4.65E-11*P;

6000 N!

FUNCT CCRLIQ

298.15 3.72E-11;

6000 N!

FUNCT DCRLIQ

298.15 +1*LN(BCRLIQ#);

6000 N!

FUNCT ECRLIQ

298.15 +1*LN(CCRLIQ#);

6000 N!

FUNCT VCRLIQ

298.15 +7.653E-06*EXP(ACRLIQ#);

6000 N!

FUNCT XCRLIQ

298.15 +1*EXP(.8*DCRLIQ#)-1;

6000 N!

FUNCT YCRLIQ

298.15 +VCRLIQ#*EXP(-ECRLIQ#);

6000 N!

FUNCT ZCRLIQ

298.15 +1*LN(XCRLIQ#);

6000 N!

FUNCT GPCRBCC

298.15 +YCRBCC#*EXP(ZCRBCC#);

FUNCT ACRBCC

298.15 +1.7E-05*T+9.2E-09*T**2;

6000 N!

FUNCT BCRBCC

298.15 +1+2.6E-11*P;

6000 N!

FUNCT CCRBCC

298.15 2.08E-11;

6000 N!

FUNCT DCRBCC

298.15 +1*LN(BCRBCC#);

6000 N!

6000 N!

6000 N!

6000 N!
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FUNCT ECRBCC

298.15 +1*LN(CCRBCC#);

6000 N!

FUNCT VCRBCC

298.15 +7.188E-06*EXP(ACRBCC#);

6000 N!

FUNCT XCRBCC

298.15 +1*EXP(.8*DCRBCC#)-1;

6000 N!

FUNCT YCRBCC

298.15 +VCRBCC#*EXP(-ECRBCC#);

6000 N!

FUNCT ZCRBCC

298.15 +1*LN(XCRBCC#);

6000 N!

FUNCT GPFELIQ

298.15 +YFELIQ#*EXP(ZFELIQ#);

FUNCT AFELIQ

298.15 +1.135E-04*T;

FUNCT BFELIQ

298.15 +1+4.98009787E-12*P+3.20078924E-14*T*P; 6000 N!

FUNCT CFELIQ

298.15 +4.22534787E-12+2.71569924E-14*T;

6000 N!

FUNCT DFELIQ

298.15 +1*LN(BFELIQ#);

6000 N!

FUNCT EFELIQ

298.15 +1*LN(CFELIQ#);

6000 N!

FUNCT VFELIQ

298.15 +6.46677E-06*EXP(AFELIQ#);

6000 N!

FUNCT XFELIQ

298.15 +1*EXP(.8484467*DFELIQ#)-1;

6000 N!

FUNCT YFELIQ

298.15 +VFELIQ#*EXP(-EFELIQ#);

6000 N!

FUNCT ZFELIQ

298.15 +1*LN(XFELIQ#);

6000 N!

FUNCT GPFEFCC

298.15 +YFEFCC#*EXP(ZFEFCC#);

FUNCT AFEFCC

298.15 +7.3097E-05*T;

FUNCT BFEFCC

298.15 +1+3.25236341E-11*P+3.36607808E-16*T*P; 6000 N!

FUNCT CFEFCC

298.15 +2.62285341E-11+2.71455808E-16*T;

6000 N!

FUNCT DFEFCC

298.15 +1*LN(BFEFCC#);

6000 N!

FUNCT EFEFCC

298.15 +1*LN(CFEFCC#);

6000 N!

FUNCT VFEFCC

298.15 +6.688726E-06*EXP(AFEFCC#);

6000 N!

FUNCT XFEFCC

298.15 +1*EXP(.8064454*DFEFCC#)-1;

6000 N!

FUNCT YFEFCC

298.15 +VFEFCC#*EXP(-EFEFCC#);

6000 N!

FUNCT ZFEFCC

298.15 +1*LN(XFEFCC#);

6000 N!

FUNCT GPFEBCC

298.15 +YFEBCC#*EXP(ZFEBCC#);

FUNCT AFEBCC

298.15 +2.3987E-05*T+1.2845E-08*T**2;

FUNCT BFEBCC

298.15 +1+2.80599565E-11*P+3.06481523E-16*T*P; 6000 N!

FUNCT CFEBCC

298.15 +2.20949565E-11+2.41329523E-16*T;

6000 N!

FUNCT DFEBCC

298.15 +1*LN(BFEBCC#);

6000 N!

FUNCT EFEBCC

298.15 +1*LN(CFEBCC#);

6000 N!

FUNCT VFEBCC

298.15 +7.042095E-06*EXP(AFEBCC#);

6000 N!

FUNCT XFEBCC

298.15 +1*EXP(.7874195*DFEBCC#)-1;

6000 N!

6000 N!
6000 N!

6000 N!
6000 N!

6000 N!
6000 N!
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FUNCT YFEBCC

298.15 +VFEBCC#*EXP(-EFEBCC#);

6000 N!

FUNCT ZFEBCC

298.15 +1*LN(XFEBCC#);

6000 N!

FUNCT GPFEHCP

298.15 +YFEHCP#*EXP(ZFEHCP#);

6000 N!

FUNCT AFEHCP 298.15 +7.3646E-5*T;

6000 N!

FUNCT BFEHCP 298.15 +1+32.5236341E-12*P+3.36607808E-16*P*T; 6000 N!
FUNCT CFEHCP 298.15 +26.2285341E-12+2.71455808E-16*T;

6000 N!

FUNCT DFEHCP 298.15 +LOG(BFEHCP#);

6000 N!

FUNCT EFEHCP 298.15 +LOG(CFEHCP#);

6000 N!

FUNCT VFEHCP 298.15 +6.59121E-6*EXP(AFEHCP#);

6000 N!

FUNCT XFEHCP 298.15 +EXP(0.8064454*DFEHCP#)-1;

6000 N!

FUNCT YFEHCP 298.15 +VFEHCP#*EXP(-1*EFEHCP#);

6000 N!

FUNCT ZFEHCP 298.15 +LOG(XFEHCP#);

6000 N!

FUNCT GPCEM1

298.15 +VCEM1#*P;

6000 N!

FUNCT ACEM1

298.15 -1.36E-05*T+4E-08*T**2;

6000 N!

FUNCT VCEM1

298.15 +2.339E-05*EXP(ACEM1#);

6000 N!

FUNCT GPSIG1

298.15 +1.09E-04*P;

6000 N!

FUNCT GPSIG2

298.15 +1.117E-04*P;

6000 N!

$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$ Define the various Phase and their Constituents, and
$ Assign parameters to phases:
$-----------------------------------------------------------------------$PHASE

NAME:TYPE

MARKCODE

#SUBL

SITES_IN_EACH_SUBL. !

$------------------------------------------------------------------------

$***** LIQUID (Solution) ************************************************
PHASE LIQUID:L %

1

1.0

> This is metallic liquid solution phase, with C species !
CONST LIQUID:L

: C,CR,FE :

PARAM G(LIQUID,C;0)

!

298.15 +GHSERCC#+GPCLIQ#
+117369-24.63*T; 6000 N REF0 !
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PARAM G(LIQUID,CR;0)

298.15 +GHSERCR#+GPCRLIQ#

+24339.955-11.420225*T+2.37615E-21*T**7;

2180 Y

+GHSERCR#+GPCRLIQ#
+18409.36-8.563683*T+2.88526E+32*T**(-9); 6000 N REF0 !
PARAM G(LIQUID,FE;0)

298.15 +GFELIQ#+GPFELIQ#;

6000 N REF0 !

PARAM L(LIQUID,C,CR;0)

298.15 -90526-25.9116*T; 6000 N REF1 !

PARAM L(LIQUID,C,CR;1)

298.15 +80000;

6000 N REF1 !

PARAM L(LIQUID,C,CR;2)

298.15 +80000;

6000 N REF1 !

PARAM L(LIQUID,C,FE;0)

298.15 -124320+28.5*T;

6000 N REF3 !

PARAM L(LIQUID,C,FE;1)

298.15

+19300;

6000 N REF3 !

PARAM L(LIQUID,C,FE;2)

298.15

+49260-19*T;

6000 N REF3 !

PARAM L(LIQUID,CR,FE;0)

298.15 -14550+6.65*T;

6000 N REF4 !

PARAM L(LIQUID,C,CR,FE;0)

298.15 -496063;

6000 N REF2 !

PARAM L(LIQUID,C,CR,FE;1)

298.15

+57990;

6000 N REF2 !

PARAM L(LIQUID,C,CR,FE;2)

298.15

+61404;

6000 N REF2 !

$***** FCC_A1 (Solution) ************************************************
$PHASE FCC_A1

%BC

2 1

1 !

$ Note the C TYPE_DEF for 2nd FCC composition-set (MC) is not necessary
$

for the (Fe,Cr)-C system.

PHASE FCC_A1

%B

2 1

CONST FCC_A1

: CR,FE%

1 !

: C,VA% :

PARAM G(FCC_A1,CR:VA;0)

!

298.15 +GCRFCC#+GPCRBCC#;

6000 N REF0 !

PARAM TC(FCC_A1,CR:VA;0)

298.15 -1109;

6000 N REF0 !

PARAM BMAGN(FCC_A1,CR:VA;0)

298.15 -2.46;

6000 N REF0 !

PARAM G(FCC_A1,FE:VA;0)

298.15 +GFEFCC#+GPFEFCC#;

6000 N REF0 !

PARAM TC(FCC_A1,FE:VA;0)

298.15 -201;

6000 N REF0 !

PARAM BMAGN(FCC_A1,FE:VA;0)

298.15 -2.1;

6000 N REF0 !

PARAM G(FCC_A1,CR:C;0)

298.15 +GHSERCR#+GHSERCC#
+1200-1.94*T;

PARAM G(FCC_A1,FE:C;0)

6000 N REF2 !

298.15 +GFEFCC#+GHSERCC#+GPCFCC#
+77207-15.877*T;

6000 N REF3 !
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PARAM TC(FCC_A1,FE:C;0)

298.15 -201;

6000 N REF3 !

PARAM BMAGN(FCC_A1,FE:C;0)

298.15 -2.1;

6000 N REF3 !

PARAM L(FCC_A1,CR:C,VA;0)

298.15 -11977+6.8194*T; 6000 N REF2 !

PARAM L(FCC_A1,FE:C,VA;0)

298.15 -34671;

6000 N REF3 !

PARAM L(FCC_A1,CR,FE:VA;0) 298.15 +10833-7.477*T;

6000 N REF4 !

PARAM L(FCC_A1,CR,FE:VA;1) 298.15

6000 N REF4 !

PARAM L(FCC_A1,CR,FE:C;0)

+1410;

298.15 -74319+3.2353*T; 6000 N REF2 !

$***** BCC_A2 (Solution) ************************************************
PHASE BCC_A2

%A

2 1

CONST BCC_A2

: CR%,FE%

3 !

: C,VA% :

PARAM G(BCC_A2,CR:VA;0)

!

298.15 +GHSERCR#+GPCRBCC#;

6000 N REF0 !

PARAM TC(BCC_A2,CR:VA;0)

298.15 -311.5;

6000 N REF0 !

PARAM BMAGN(BCC_A2,CR:VA;0)

298.15

6000 N REF0 !

PARAM G(BCC_A2,FE:VA;0)

-.01;

298.15 +GHSERFE#+GPFEBCC#;

6000 N REF0 !

PARAM TC(BCC_A2,FE:VA;0)

298.15 1043;

6000 N REF0 !

PARAM BMAGN(BCC_A2,FE:VA;0)

298.15 2.22;

6000 N REF0 !

PARAM G(BCC_A2,CR:C;0)

298.15 +GHSERCR#+3*GHSERCC#+GPCRBCC#+3*GPCGRA#
+416000;

6000 N REF1 !

PARAM TC(BCC_A2,CR:C;0)

298.15 -311.5;

6000 N REF1 !

PARAM BMAGN(BCC_A2,CR:C;0)

298.15

6000 N REF1 !

PARAM G(BCC_A2,FE:C;0)

-.008;

298.15 +GHSERFE#+3*GHSERCC#+GPFEBCC#+3*GPCGRA#
+322050+75.667*T;

6000 N REF3 !

PARAM TC(BCC_A2,FE:C;0)

298.15 1043;

6000 N REF3 !

PARAM BMAGN(BCC_A2,FE:C;0)

298.15 2.22;

6000 N REF3 !

$ PF-20061025: Modify the L(BCC_A2,FE:C,VA;0) [and L(BCC_A2,CR:C,VA;0)]
$

parametera, in order to avoid BCC-appearance (Fe-C)

$

at temperatures higher than 3900 K.

$PARAM L(BCC_A2,CR:C,VA;0) 298.15 -190*T;

6000 N REF1 !

PARAM L(BCC_A2,CR:C,VA;0) 298.15 -190*T; 3000 Y 0; 6000 N REFS !
$PARAM L(BCC_A2,FE:C,VA;0) 298.15 -190*T;

6000 N REF3 !
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PARAM L(BCC_A2,FE:C,VA;0) 298.15 -190*T; 3900 Y 0; 6000 N REFS !
$
PARAM L(BCC_A2,CR,FE:VA;0) 298.15 +20500-9.68*T;

6000 N REF4 !

PARAM TC(BCC_A2,CR,FE:VA;0)

298.15 1650;

6000 N REF4 !

PARAM TC(BCC_A2,CR,FE:VA;1)

298.15

550;

6000 N REF4 !

PARAM BMAGN(BCC_A2,CR,FE:VA;0)

298.15 -.85;

6000 N REF4 !

PARAM L(BCC_A2,CR,FE:C;0)

298.15 -1250000+667.7*T; 6000 N REF2 !

PARAM TC(BCC_A2,CR,FE:C;0)

298.15 1650;

6000 N REF5 !

PARAM TC(BCC_A2,CR,FE:C;1)

298.15

550;

6000 N REF5 !

PARAM BMAGN(BCC_A2,CR,FE:C;0) 298.15 -.85;

6000 N REF5 !

$***** HCP_A3 (Solution) ************************************************
$PHASE HCP_A3

%BC

2 1

.5 !

$ Note the C TYPE_DEF for 2nd HCP composition-set (M2C) is not necessary
$

for the (Fe,Cr)-C system.

PHASE HCP_A3

%B

2 1

CONST HCP_A3

: CR,FE,

.5 !

: VA%,C :

!

PARAM G(HCP_A3,CR:VA;0) 298.15 +GHSERCR#+4438;
PARAM TC(HCP_A3,CR:VA;0)

6000 N REF1 !

298.15 -1109;

6000 N REF1 !

PARAM BMAGN(HCP_A3,CR:VA;0) 298.15 -2.46;

6000 N REF1 !

PARAM G(HCP_A3,FE:VA;0) 298.15 +GHSERFE#+GPFEHCP#
-3705.78+12.591*T-1.15*T*LN(T)+6.4E-04*T**2; 1811 Y
+GHSERFE#+GPFEHCP#
-3957.199+5.24951*T+4.9251E+30*T**(-9);

6000 N REF0 !

PARAM G(HCP_A3,CR:C;0) 298.15 +GHSERCR#+.5*GHSERCC#
-18504+9.4173*T-2.4997*T*LN(T)+.001386*T**2; 6000 N REF1 !
PARAM G(HCP_A3,FE:C;0) 298.15 +GFEFCC#+.5*GHSERCC#+GPCFCC#
+52905-11.9075*T;

PARAM L(HCP_A3,CR:C,VA;0)

298.15

+4165;

6000 N REF1 !

PARAM L(HCP_A3,FE:C,VA;0)

298.15 -22126;

6000 N REF3 !

$PARAM L(HCP_A3,FE:C,VA;0)

298.15 -17335;

6000 N REF3 !

6000 N TCFE3 !

PARAM L(HCP_A3,CR,FE:VA;0) 298.15 +10833-7.477*T; 6000 N REF4 !
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$***** SIGMA (Solution) *************************************************
PHASE SIGMA

%

3 8

CONST SIGMA

: FE

4

18 !

: CR
: CR,FE :

!

PARAM G(SIGMA,FE:CR:CR;0)

298.15 +8*GFEFCC#+22*GHSERCR#
+92300-95.96*T+GPSIG1#;

PARAM G(SIGMA,FE:CR:FE;0)

6000 N REF4 !

298.15 +8*GFEFCC#+4*GHSERCR#+18*GHSERFE#
+117300-95.96*T+GPSIG2#;

6000 N REF4 !

$***** CEMENTITE (Solution) *********************************************
PHASE CEMENTITE

%

2 3

CONST CEMENTITE

: CR,FE%
: C :

1 !

!

PARAM G(CEMENTITE,CR:C;0)

298.15 +3*GHSERCR#+GHSERCC#
-48000-9.2888*T; 6000 N REF2 !

PARAM G(CEMENTITE,FE:C;0)

298.15 +GFECEM#;

PARAM L(CEMENTITE,CR,FE:C;0)

6000 N REF3 !

298.15 +25278-17.5*T;

6000 N REF2 !

$***** M3C2 (Compound) **************************************************
PHASE M3C2

%

2 3

CONST M3C2

: CR
: C :

2 !

!

PARAM G(M3C2,CR:C;0)

298.15 +GCRM3C2#;

6000 N REF2 !

$***** M7C3 (Solution) **************************************************
PHASE M7C3

%

2 7

CONST M7C3

: CR%,FE
: C :

3 !

!

PARAM G(M7C3,CR:C;0)

298.15 +GCRM7C3#;

6000 N REF2 !
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PARAM G(M7C3,FE:C;0)

298.15 +7*GHSERFE#+3*GHSERCC#
+75000-48.2168*T; 6000 N REF2 !

PARAM L(M7C3,CR,FE:C;0)

298.15 -4520-10*T;

6000 N REF2 !

$***** M23C6 (Solution) *************************************************
PHASE M23C6

%

3 20

3

CONST M23C6

: CR%,FE%

6 !

: CR%,FE%
: C :

!

PARAM G(M23C6,CR:CR:C;0)

298.15 +GCRM23C6#;

6000 N REF5 !

PARAM G(M23C6,FE:CR:C;0)

298.15 +.1304348*GCRM23C6#
+.8695652*GFEM23C6#; 6000 N REF5 !

PARAM G(M23C6,CR:FE:C;0)

298.15 +.8695652*GCRM23C6#
+.1304348*GFEM23C6#; 6000 N REF5 !

PARAM G(M23C6,FE:FE:C;0)

298.15 +GFEM23C6#;

6000 N REF5 !

PARAM L(M23C6,CR,FE:CR:C;0) 298.15 -205342+141.6667*T; 6000 N REF2 !
PARAM L(M23C6,CR,FE:FE:C;0) 298.15 -205342+141.6667*T; 6000 N REF2 !

$***** GRAPHITE (Compound) **********************************************
PHASE GRAPHITE

%

1

CONST GRAPHITE

: C :

PARAM G(GRAPHITE,C;0)

1.0

!

!

298.15 +GHSERCC#+GPCGRA#; 6000 N REF0 !

$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$ ASSESSED_SYSTEMS information:
$

*

necessary for the BIN and TERN modules in TCC

$

the Binary Phase Diagram module in TCW

$

and the Equilibrium calculation routine in TCW

$-----------------------------------------------------------------------ASSESSED_SYSTEM
$... Binary ...
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C-FE(;P3 TMM:300/4000 *)
C-CR(;P3 TMM:300/4000 *)
CR-FE(;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA
;P3 TMM:300/3000 STP:.6/1200/1/-2/2)
$ CR-FE(TDB -HCP ;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA
$

;P3 TMM:300/3000 STP:.6/1200/1/-2/2)

$
$... Ternary ...
C-CR-FE(;G5 MAJ:BCC/FE:VA C_S:BCC/CR:VA
;P3 STP:.4/.5/1 STP:0.1/0.5/1)
!

$
$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$$
$
$ LIST OF REFERENCE:
$
$-----------------------------------------------------------------------LIST_OF_REFERENCES
NUMBER

SOURCE

REF0 'Alan Dinsdale, SGTE Data for Pure Elements, Calphad Vol 15(1991)
p 317-425, also in NPL Report DMA(A)195 Rev. August 1990'
REF1 'J-O Andersson, Calphad Vol 11 (1987) p 271-276, TRITA 0314; C-CR'
REF2 'Byeong-Joo Lee, unpublished revision (1991); C-Cr-Fe-Ni'
REF3 'P. Gustafson, Scan. J. Metall. vol 14, (1985) p 259-267
TRITA 0237 (1984); C-FE'
REF4 'J-O Andersson, B. Sundman, CALPHAD Vol 11, (1987), p 83-92
TRITA 0270 (1986); CR-FE'
REF5 'J-O Andersson, Met. Trans A, Vol 19A, (1988) p 627-636
TRITA 0207 (1986); C-CR-FE'
REFS 'Pingfang Shi (2006), TCS PTERN Public Ternary Alloys Database,
v1.2; Modified L0(BCC,Fe,C) and L0(BCC,Cr,C) parameters
at high temperatures.'
!
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The Database Checker
In this section:
About the Database Checker

86

Database Checker Revision History

88
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About the Database Checker
The Thermo-Calc software package includes a program to check that the syntax of
unencrypted database files is correct. The program applies the syntax rules set out in the
Database Manager User Guide and reports errors and issues warnings. This program is
intended for advanced users who develop and manage databases.
Thermo-Calc accepts deviations from these syntax rules. This means that a
database can work even if the Database Checker reports errors and warnings.
For example, an error is reported if an abbreviated phase name is found, but
phase name abbreviations are accepted by Thermo-Calc and its Add-on
Modules.
The executable DatabaseChecker file is found in the Thermo-Calc home directory. The
program can also be launched by selecting Tools→ Database Checker from the main menu.
Database Checker Revision History for releases notes that may assist database
developers.

Custom Databases: GES5 and GES6 Calculation Engine Version
As of Thermo-Calc version 2019b, the default calculation engine is set to GES6. For custom
database users, you may sometimes see messages in the log indicating that additional
preparation is being done by Thermo-Calc prior to a calculation. The preparation is carried
out automatically; it is usually fast and only needed the first time a custom database is used
after a modification. While databases with warnings are tolerated, databases that contain
errors can only be loaded by GES6 after the errors are corrected.
The Database Checker tool uses the same parser as GES6 and can be used to verify the
consistency and correctness of databases during development, before the databases are
actually used.
Database Checker

To globally set the default from GES6 back to GES5, go to the Tools → Options
→ General tab and click Version 5 for the Preferred Gibbs Energy System
setting. The SET_GES_VERSION Console Mode command is used to change GES
versions for a single Thermo-Calc session.
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Contact Thermo-Calc Software AB at info@thermocalc.com for more
information about the changes or if you encounter any issues you think are
related to the new version of the calculation engine.
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Database Checker Revision History
The DatabaseChecker application is standalone and need not be installed separately, just
download the containing zip file, open it and follow the instructions in the README.TXT file.
The program requires that Java is installed on the target machine. Please note that large
amounts of RAM may be required when checking large databases.

Release Notes Version 1.4
l

l

l

The DatabaseChecker user interface has been modified to allow checking of several
database files in one batch. Instead of selecting an individual database file, the user
now selects a directory that contains databases. The application then shows a tree
structure with all database files in the chosen directory and its subdirectories. The
user may then select any number of these files for processing.
A check of parameters whose interaction order is 3 has been introduced. For such
parameters, there must either exist one parameter with the interaction degree 0 or
three parameters with the interaction degrees 0, 1 and 2.
To facilitate optimization of databases, the tool now generates information messages
about functions and parameters that will always return 0.

Release Notes, Version 1.3.2
l

The tool now detects conflicts between identical parameters even if one of them
have been defined with the G prefix and the other with the L prefix.

Release Notes, Version 1.3
A bug prevented integers bigger than 32 bits from being parsed. This has been corrected.
The tool now checks that the species and number of sublattices used in parameter
definitions match the phase definition and generates an error message for every mismatch.
Ionic liquid parameters are currently exempted from this check as not to break the
widespread use of defining only one constituent for ionic liquid parameters.
Type definitions and case statements are now parsed for errors. However, only a subset of
all possible GES, POLY and TDB commands are accepted and all other commands will result
in an error message. The accepted commands are:
l

GES AMEND_PHASE_DESCRIPTION
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l

COMPOSITION_SETS

l

MAJOR_CONSTITUENTS

l

DISORDERED_PART

l

MAGNETIC_ORDERING

l

STATUS_BITS

l

DEFAULT_STABLE

l

FRACTION_LIMITS

l

EXCESS_MODEL

l

REDLICH-KISTER_MUGGIANU

l

HKF

l

HKF_ELECTROSTATIC

l

DEBYE_HUCKEL

l

GES CHANGE_STATUS

l

TDB DEFINE_SYSTEM_ELEMENTS

l

TDB RESTORE_PHASES

l

TDB REJECT_PHASES

Some improvements to warning and error messages have been made to facilitate finding
errors.

Release Notes, Version 1.2
l

l

l

The tool now uses parallel processing of database files on multi-core systems. This
significantly improves performance when large databases are checked.
It is no longer required that inter-dependent database statements are defined in a
specific order in the database file (e.g., species need not any longer be defined
before the elements on which they depend). However, for the sake of readability, it is
still advised that the database statements occur in a natural order in the file.
Because of the parallel processing of database statements, multiple definition errors
(cases where one name has been used to define more than one entity in the
database e.g, two identically named species) may now be generated for any of the
violating occurences and not only for the last occurence in the file.

Release Notes, Version 1.1
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l

l

l

l

l

l

Phase names were not properly recognized in parameter definitions if there was one
or more whitespace characters between the opening parenthesis and the phase
name. This has been corrected.
The error message Could not parse parameter, <species name> has been given
without a sublattice number but is defined in more than one sublattice is now
displayed only for phases where the general diffusion model is used. Note: this
implementation is temporary and may be subject to changes later.
The meaning of the information message The phase <phase name> expects the
following parameters: [<parameter names>] was unclear to users. It is now longer
shown for the parameter names T and P. For all other names, the message is now
displayed as an error message with the following text: The phase <phase name>
contains references to the following undefined functions: [<function names>].
The tool now looks for function names that are abbreviations of other function names
and warns about this, since abbreviated names may cause problems during the
execution of macro files that have been auto-generated from GES.
The tools also warns for functions whose names are in the format V<integer>, since
this may cause conflicts with names that are used by PARROT.
Parameter names are now shown in a format that is less cryptic and more resembles
the format used in the database. However, the format of diffusion parameters may
still differ somewhat from what is used in the database.

Release Notes, Version 1.0
l

l
l

l
l

The tool parses a TDB file and produces a log with error, warning and information
messages about the state of the file
The message log can be exported and saved as a separate file for later analysis
The tool is based on the database command definitions given in TC_Database_
ManagersGuide and DICTRA27_UsersGuide. All commands in these documents are
supported. Some undocumented DIFFUSION commands are not supported.
Databases that span several files are correctly handled, also blocked files
The tool is in some aspects more strict than required by the guides (see Additional
Information below)

l

The tool performs the following checks:

l

Syntax control of database statements: ERROR

l

Line size: ERROR or WARNING depending on context

l

Multiply defined elements, species or phases: ERROR
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l

Multiply defined functions and parameters: ERROR

l

Multiply defined assessed system: ERROR

l

Multiply defined references: ERROR

l

References entries that are never used: WARNING

l

References to non-existent type definitions: ERROR

l

Type definitions that are never used: WARNING

l

Unused functions and parameters: WARNING

l

Functions and parameters with undefined references: WARNING

l

References to undefined elements, species or phases: ERROR

l

Dependencies to external names from a phase: INFORMATION. (All parameters of a
phase are evaluated with respect to their dependencies to other parameters and
functions and all unresolved names are listed. Typically, this should only yield
dependencies on T and possibly P)

Additional Information
In addition to the command definitions given in the user guides listed above, the following
rules are also applied:
l

l

Names are case-sensitive, meaning that e.g., the defined element MN cannot be
referred to under the name Mn;
Phase names cannot be abbreviated. When referred to in parameter descriptions
their full names must be used.
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Introduction to the DATAPLOT User Guide
In this section:
Using this Guide

3

About the DATAPLOT Graphical Language

4

Plotting Experimental Data Files

5
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Using this Guide
The DATAPLOT User Guide gives all the details on the graphical language DATAPLOT that a
phase diagram or property diagram calculated by Thermo-Calc or a kinetic profile simulated
by the Diffusion Module (DICTRA) can be defined.
This guide
l

Discusses the important features of the DATAPLOT language.

l

Describes the commands to define PROLOGUE and DATASET.

l

Several examples and the standard codes for formatting are provided.

One topic introduces the method of formatting DIGLIB symbols in LaTeX documents, for the
purpose of necessarily/appropriately referring to the corresponding LaTeX symbols (closest
to those DIGLIB symbols which have been plotted on a diagram using the DATAPLOT
Graphical Language) in the texts of LaTeX documents for publications/reports.
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About the DATAPLOT Graphical Language
In order to obtain graphical output of any numerical data and informative strings, a
graphical language called DATAPLOT was developed in connection with the graphical
software DIGLIB. Using this graphical language, you can store information in a normal text
file (*.EXP), which can be plotted as graphical symbols, lines, texts or Greek letters on any
plot device support by DIGLIB.
You can generate and plot DATAPLOT (*.EXP) files together with various calculation and/or
experimental results from, for example, phase and property diagrams calculated with the
Thermo-Calc software composition profiles or other diagrams simulated by the Diffusion
Module (DICTRA).
An EXP file automatically generated by the POST-processor (using the MAKE_
EXPERIMENTAL_DATAFILE command) in the Thermo-Calc software is a DATAPLOT (*.EXP)
file and may contain all types of legal DATAPLOT commands and parameters. With a text
editor, you can modify or add some DATAPLOT commands and related parameters in an
existing EXP file. This is useful when appending experimental information to
calculated/simulated plots, and when specifying user-defined texts, symbols, colors, fonts,
filled patterns, diagram types, diagram sizes, symbol/character sizes, titles, special
characters, etc.
There is another type of experimental data file that is generated in Thermo-Calc
when working with the PARROT module. For more information seeExperimental
Data Files (*.POP, *.DOP).

DATAPLOT Examples
To help you prepare your EXP (experimental) files to use for your plotted diagrams
generated by Thermo-Calc simulations, there are examples of EXP files using the DATAPLOT
graphical language standard, which are normally independent of software versions.
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Plotting Experimental Data Files
You can read and plot experimental data files in both Console Mode and Graphical Mode.

Graphical Mode
In Graphical Mode, the Experimental File Reader activity can only be created from the top
My Project node. This activity allows you to read an experimental data file (*.EXP). This type
of file has information specifying a plotted diagram, written in the DATAPLOT graphical
language. From this activity node you can plot the EXP file or save a copy of the file to
another location.

How to Plot an EXP file in Experimental File Reader
1. Right-click My Project and from the Create New Activity submenu choose
Experimental File Reader.
2. In the Configuration window in the EXP file field, enter the name of the EXP file to
plot. Or click the Select Exp file
button to navigate to a location on the computer
to add the dataset.
3. Once the .EXP file is added, under Dataset Selection you can choose to include or
exclude specific datasets. Use the Select/Deslect all datasets check box as required.
4. Right-click the Experimental File Reader node and from the Create New Successor
submenu choose Plot Renderer.
If the source EXP file is changed, you can also click the Reload the selected EXP file
from disk
button to refresh the data. If you want to save or export the loaded file,
click the Save EXP file
button, then navigate to where you want to save it and
give it a file name.
5. In the Configuration window click Perform or right-click the Plot Renderer node
and select Perform.

Console Mode
In Console Mode you use the QUICK EXPERIMENTAL PLOT command found in the POLY-3
POST module (as well as in the Diffusion Module (DICTRA) POST module) to plot the .EXP
files. This command can be used when there is no graphical information to be plotted in the
POLY3 workspace. It defines a pair of axes, sets the axis labels to X and Y, and scales both Xand Y-axes between 0.0 and 1.0 unless a prologue is read from the DATAPLOT (*.EXP) data
file.
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How to Plot an EXP file in POST
1. Go to the POLY-3 Module: At the SYS prompt type Go

Poly.

2. Go to the POST module: At the POLY_3 prompt type Post.
3. At the POST prompt, type Quick.
4. Enter Prologue and Dataset numbers (if applicable). See QUICK_EXPERIMENTAL_
PLOT.
5. AT the POST prompt, type Plot.

DATAPLOT User Guide ǀ 6 of 92

Thermo-Calc Documentation Set

Using DATAPLOT Graphical Language
In this section:
DATAPLOT File Structure

8

DATAPLOT Language Syntax

9

Coordinate Systems

10

Graphical Operation Codes

11

Tables or Blocks

13

Drawing a Polygon

14

Drawing an Analytical Function

15

Painting of an Enclosed Area

16

Writing a Text

17

Plotting a Symbol

18

Other Commands

19

Interactive Plotting

20

Formatting DIGLAB Symbols in LaTeX Documents

21

LaTeX Formatting Codes

23
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DATAPLOT File Structure
A DATAPLOT file is a normal text file with the extension EXP that can be created with a text
editor or by a program. The file must contain one or more DATASETS and possibly also one
or more PROLOGUES. Each PROLOGUE/DATASET is an entity that can be individually selected
for plotting.
A PROLOGUE/DATASET is identified by a unique positive number in the file. A PROLOGUE
normally contains various DATASET commands for defining information about axis scaling,
axis text, axis length, title and so on. A PROLOGUE is terminated by another PROLOGUE or
by the first DATASET. This means that all PROLOGUES must be placed at the beginning of the
file, before the first DATASET.
A DATASET normally contains DATASET commands that are associated to separate data
points, as well as with one or more BLOCKS of data (calculated or experimental). A DATASET
is terminated by another DATASET command or the end of file.
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DATAPLOT Language Syntax
The DATAPLOT language consists of commands with or without parameters:
COMMAND {parameter(s)}

The basic graphical command consists of an X/Y coordinate pair and a Graphical Operation
Code (GOC). With other commands, the interpretation of this basic command can be
modified. There are separate commands to draw a polygon or a function and ways to get
texts in different fonts.
To edit a DATAPLOT file, the graphical commands can be abbreviated.
A command (with parameters) must not exceed 80 characters. If it is too long
(normally as writing necessary codes in a command’s parameters for a complex
expression), two or more lines can be edited.

DATAPLOT User Guide ǀ 9 of 92

Thermo-Calc Documentation Set

Coordinate Systems
The DATAPLOT language accepts coordinates in three different coordinate systems, which
are called world, virtual and normalized.
l

l

l

The world coordinates are selected to represent any kind of data and be of “any”
magnitude.
The virtual coordinate system uses centimeters as units. However, the actual size of
one unit is dependent on the implementation of the device driver in DIGLIB. It is not
recommended to use this coordinate system if different output devices are used for
preliminary and final plots.
The normalized coordinate system goes from zero to one. When plotting, you
interactively scale each axis by selecting the minimum and maximum word
coordinates on the axis. In the normalized coordinate system, the minimum axis
value is represented by zero and the maximum by one. DIGLIB draws a square
between the four points (of the X and Y axes) that are determined by the coordinates
zero and one in the normalized coordinates.
It is also possible to draw triangular plots as described below. However, in most
places, it only references square diagrams. All data points within the minimum
and maximum word coordinates are plotted inside this square. DIGLIB also
writes tic marks and corresponding word values at such tic marks.

It may be convenient to use normalized coordinates to draw boxes and texts. You can give
normalized coordinates outside zero and one if you want to write texts outside the area
enclosed by the square. To ensure proper operation outside the normalized box, the clipping
must be turned off.
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Graphical Operation Codes
The Graphical Operation Code (GOC) determines how the coordinates are interpreted and
what is done at the point determined by the coordinates. For an individual data point, its
GOC codes must be given. For each data BLOCK, you define a default GOC that is used for
the whole BLOCK, unless a GOC is explicitly defined for a specific point.
l

l

l

l

If S is omitted, no symbol is plotted. A number selecting the symbol can optionally
follow the character S. The DIGLIB software determines which symbol the number
represents. See Plotting a Symbol.
If any of the other characters are omitted, the default defined for the BLOCK is used.
Absolute values imply the current coordinates; relative values mean that these are
added to the current coordinates. The GOC must be written without any space
between various characters, but the order for the characters is irrelevant.
If no GOC is defined for a BLOCK, the system default is MWA, (Move Word Absolute),
i.e., move to the given point that is interpreted as absolute word coordinates.
GOC=DNA means draw a line from the current point to the new one interpreting the
coordinates as normalized. After each draw or move operation, the so-called current
point is the new point.
The TEXT following the ’ command is interpreted and expanded by the DIGLIB
software, if it includes any ^ operator or STRING names using the ~ descriptor. To get
PostScript outputs, the TEXT must be edited by the LaTeX Text Formatting Program
instead (see LaTeX Formatting Codes).

GOC Character Definitions
The GOC is a combination of the following characters:
Character

Meaning

W, V or N

To use word (W), virtual (V) or normalized (N) coordinates. W is the default.

A or R

XY are absolute (A) or relative (R) values. A is the default.

M or D

To perform a move (M) or draw (D) operation to XY. M is the default.

B

To apply “soft” splines on a line drawn between the coordinate pairs (used only on BLOCK
data).
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Character

Meaning

S

To plot default symbol at XY.

S#

To change default symbol to No # symbol and plot it at XY.

‘TEXT

To plot TEXT at XY. It must be the last operation in a GOC code. The TEXT following the ’
command is interpreted and expanded by the DIGLIB software, if it includes any ^
operator or STRING names using the ~ descriptor.
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Tables or Blocks
In many cases, you have (calculated or experimental) data in the form of tables, and want to
plot one or several columns as X-axis and one or more columns as Y-axis. A single table can
contain many sets of data records of the same kind of information for a specific data BLOCK.
There can be many data BLOCKS in a DATASET.
By enclosing these tables in a data BLOCK, you can select which column(s) is the X-axis and
which is the Y-axis. For example,
BLOCK X=C1; Y1=C3; Y2=C2; GOC=C4,DAW

Where the X-axis values are in column 1, the Y-axis values are in columns 2 and 3, and any
GOC codes are in column 4. The default GOC for this BLOCK is Draw Absolute Word. The
GOC code inside the table is only necessary if the default GOC is not applicable.
A more elaborate use of the table is shown in this example:
BLOCK X=C3; Y=1E3/(C3+273); GOC=C8,MAWS1

Where the X-axis values are in column 3, the Y-axis values are in column 1 with some
additional calculations applied. Any GOC is in column 8, and the default GOC is Move
Absolute Word and plot the symbol no. 1.
Columns in a table must be separated by one or more space characters and do not have to
be justified.
It is possible to have tables with mixed text and numbers, but each word followed by a space
is counted as one column. The columns used for plotting also must be numerical. An
example of a legal line in a table is
298.15 This_is_the_second_column 11.5 This_is_the_fourth_column

A line in the table must not exceed 80 characters. A BLOCK must be terminated
by a line with the BLOCKEND command.
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Drawing a Polygon
Normally, each point is written on a separate line. But in order to draw a line in a more
compact way, use the command DRAWLINE. DRAWLINE is followed by a couple of X/Y
number pairs. The X/Y pairs must be separated by a space, and there must be a comma sign
between the X and Y values. DRAWLINE makes a move operation to the first pair of X/Y
coordinates, and then draws a line among all pairs up to the last one. All pairs must fit on
one line of 80 characters, but there can be several consequent DRAWLINE commands.
Example 2 – Draw Polygons and Symbols
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Drawing an Analytical Function
Use a BLOCK command to set an axis to a function. It is not necessary to use a value from
any column in order to compute the function value to be plotted. Use the FUNCTION
command to plot a function with an even increment of the independent variable.
Example 4 – Draw Curves Defined by Functions
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Painting of an Enclosed Area
Use the PAINT command to paint or fill an area in a specified pattern in the plot. Available
patterns are determined by the DIGLIB software. A related command to PAINT is
PCFUNCTION.
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Writing a Text
Use the TEXT command to write a text at the current point. You can write a text at any X/Y
pair by appending a single quote followed by the text on the same line. For example:
1.1 1.0 NAM’This is a text

writes This

is a text

at the normalized coordinates (1.1,

1.0).

Use the command FONT to select the font used for the text, and CHARSIZE to select the size
of the characters. Set this size of the symbols with SYMBOLSIZE.
If a text or a single character should be of a different font than all the other text, or to use
subscripts or superscripts in a text, use the ^ operators or STRING command to create the
text. The command STRING stores the text in a specified variable that includes all textformatting information defined by the DIGLIB software.
Example 3 – Using Strings and Various Line Types and Example 5 – Use Included
Files for Predefined Symbols.
However, if a graphical output is done on a PostScript device using the PostScript hardcopy
fonts, special text formatting codes as LaTeX Formatting Codes should be used and the
STRING formatting syntax is then not valid.
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Plotting a Symbol
As described in Graphical Operation Codes, a GOC code in a data BLOCK may contain an S
option to plot a symbol for an X/Y pair or the same symbols for the data BLOCK. A number
selecting the symbol can optionally follow the character S. You can plot a symbol at any
current X/Y position by appending a quote specified by the symbol number in the GOC code
(e.g., 1.1 1.0 MANS5’This is a text).
You can also insert DIGLIB symbols into LaTeX-edited documents.
Example 1 – Draw Lines and Symbols, Example 2 – Draw Polygons and Symbols
and Example 8 - DIGLIB Symbols
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Other Commands
General
l

l

When plotting symbols representing various experimental data, it is important that
the symbols are centered around the coordinate values.
The dollar sign $ as the first character of a line stands for a comment character,
which means the whole line is ignored when plotting.

ATTRIBUTE
Use the ATTRIBUTE command to change the coordinates where text is displayed. The default
is the lower left corner of the first character in the text.

CLIP
Use the CLIP command to change the default where all data outside the normalized
coordinates zero and one are not plotted.

COLOR
If you are using a color device, use the COLOR command to change color of the lines. On
some black and white devices, colors are simulated with different width and dashing of the
lines.

INCLUDE
Use the INCLUDE command to create libraries with texts and include these in similar plots.

LINETYPE
Use the LINETYPE command to define line types as solid, long dashed, short dashed or
dotted.
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Interactive Plotting
The DATAPLOT file is read into the POST module in the workspace with APPEND_
EXPERIMENTAL_DATA or QUICK_EXPERIMENTAL_PLOT. These commands ask for the name
of the DATAPLOT file and also which PROLOGUE(S) and DATASET(S) are to be plotted.

Press F1 and search the Help for details.

By giving the PROLOGUE/DATASET number as -1, you get a list of the available
PROLOGUES/DATASETS in the file. Note that if DATASET 0 is in a DATAPLOT file, its data is
always used even if other DATASETS are chosen.
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Formatting DIGLAB Symbols in LaTeX Documents
When using the LaTeX editor, you can use the DIGLIB symbols in texts and in figures. This
then refers to the corresponding LaTeX symbols (closest to those DIGLIB symbols which are
plotted on a plot using the DATAPLOT Graphical Language) in the texts of LaTeX documents
for publications/reports.
This topic shows how to generate some DIGLIB symbols in texts, through the attached LaTeX
source file and its converted jpg file.
Example 8 - DIGLIB Symbols

DIGLIB_Sym.tex
\documentclass[dvips,12pt]{article}
\textwidth 165mm
\textheight 225mm
\oddsidemargin 1mm
\evensidemargin 1mm
\topmargin 1mm
%%\usepackage{amssymb}
%% next replace amssymb and to get udtimes
\usepackage[utopia]{mathdesign}
\usepackage{rotating}
\usepackage[latin1]{inputenc}
\usepackage{graphics}
\usepackage{graphicx,subfigure}% with figures
%\usepackage[draft]{graphicx}% without figures
\usepackage{subfigure}% with figures
\topmargin 1mm
\oddsidemargin 1mm
\evensidemargin 1mm
\begin{document}
{\Large \bf Diglib symbols and their corresponding LaTeX symbols}
\vspace{5mm}
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The information below gives the closest corresponding LaTeX symbol. All symbols (except +)
must be generated in math mode. Most of these require the package amssymb, i.e., you
need a directive usepackage{amssymb} in the preamble. Two of the symbols require the
more extensive mathdesign that can be included with usepackage[utopia]{mathdesign}.
\vspace{5mm}
{\Large
\begin{tabular}{llll}
Diglib & Latex & Latex name & Note\\
1& $\vartriangle$& $\backslash$vartriangle & amssymb \\
2& $\square$& $\backslash$square\\
3& {\Huge $\diamond$} & $\backslash$diamond & size $\backslash$Large \\
4& $\udtimes$& $\backslash$udtimes & mathdesign \\
5& $\triangledown$& $\backslash$triangledown & amssymb\\ 6 & +& normal + \\
7& $\ast$& $\backslash$ast & amssymb\\
8& $\times$& $\backslash$times \\
9& {\Huge $\circ$}& $\backslash$circ & size $\backslash$Large \\
10& {\Huge $\star$}& $\backslash$star & size $\backslash$Large, amssymb\\
11& $\curlyvee$& $\backslash$curlyvee & amssymb\\
12& $\Join$& $\backslash$Join\\
13&& - & nothing similar, overlapping $> <$\\
14&& - & nothing similar, 10-edged star \\
15& $\maltese$& $\backslash$maltese& mathdesign \\
16&& - & nothing similar, a pentagon \\
17& $\curlywedge$& $\backslash$curlywedge & amssymb\\
\end{tabular}}
\end{document}
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LaTeX Formatting Codes
For a list of supported LaTeX commands, see:
http://www2.ph.ed.ac.uk/snuggletex/documentation/math-mode.html.

By default when using the LaTeX command, you are in math mode and ThermoCalc automatically interprets the entered text as math. The above link uses the
dollar sign ($) in all the examples but this is NOT required. For example, if you
enter $E=mc^2$ this is displayed including the $ instead of the equation.

As of Thermo-Calc 2015a the LTEXT text formatting is replaced by LaTeX. For
existing users who may have plots and files that use the LTEXT format, and
especially when using Console Mode, the following examples show the
command changes from LTEXT and its LaTeX equivalent:

LTEXT vs LaTeX Commands for Labels
Symbol or text
format

LTEXT

LaTeX

Subscripts in an axis
text

S-A-TEXT Y N Mole-fraction
Al^DO2$O^DO3$

S-A-TEXT Y N \latex Mole-fraction
Al_2O_3

Label with subscript

add .13 .15 n c-ZrO^DO2$

add .13 .15 n \latex c-ZrO_2

Greek symbol

ADD .05 .50 N ^GRd$

ADD .05 .50 N \latex \delta
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PROLOGUE Commands
In this section:
PROLOG

25

DIAGRAM_TYPE

26

TIC_TYPE

27

TITLE

28

XLENGTH

29

XSCALE

30

XTEXT

31

XTYPE

32

YLENGTH

33

YSCALE

34

YTEXT

35

YTYPE

36
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PROLOG
PROLOG is the beginning of a number of consequent lines of user-defined diagram layout
commands. The lines are displayed with the optional text when using the -1 option in the
POST-processor as prompted for the PROLOG number with APPEND_EXPERIMENTAL_DATA
or QUICK_EXPERIMENTAL_PLOT.
Examples of DATAPLOT Files and Outputs
Syntax

PROLOGUE # optional text
# is an unsigned integer

identifying the PROLOG.
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DIAGRAM_TYPE
DIAGRAM_TYPE sets the diagram type to square (the default) or triangular.
Example 6 – Triangular Diagrams for Ternary Systems
Syntax

DIAGRAM_TYPE type plot_3rd_axis clip_along_third-axis
type is

a character string reading SQUARE (default) or TRIANGULAR. If type reads
TRIANGULAR, then two additional parameters are given: plot_3rd_axis and clip_
along_third-axis that are characters strings reading YES or NO.
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TIC_TYPE
TIC_TYPE sets the relative length of the tic marks.
Syntax

TIC_TYPE #
# is a real number. Default value

is 1. Negative number gives tics on the inside of the

diagram frame. 0 gives no tics.
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TITLE
TITLE sets the title text string to be printed above the diagram.
Syntax

TITLE text
text is an arbitrary text string that may contain text-formatting codes
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XLENGTH
XLENGTH sets the X-axis length to approximately # centimeters.
Syntax

XLENGTH #
# is a positive

real number (the approximate X-axis length in centimeters).
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XSCALE
XSCALE sets the scaling in word coordinates of the X-axis.
Syntax

XSCALE min max
min and max are

real numbers.
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XTEXT
XTEXT sets the X-axis text.
Syntax

XTEXT text
text is an arbitrary text string that may contain text-formatting codes.
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XTYPE
XTYPE sets the X-axis type as linear (default), logarithmic or inverse.
Syntax

XTYPE type
type is a character

string reading LIN, LOG or INV.
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YLENGTH
YLENGTH sets the Y-axis length to approximately # centimeters.
Syntax

Y LENGTH #
# is a positive

real number (the approximate Y-axis length in centimeters).
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YSCALE
YSCALE sets the scaling in word coordinates of the Y-axis.
Syntax

YSCALE min max
min and max are

real numbers.
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YTEXT
YTEXT sets the Y-axis text.
Syntax

Y TEXT text
text is an arbitrary text string that may contain text-formatting codes.
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YTYPE
YTYPE sets the Y-axis type as linear (default), logarithmic or inverse.
Syntax

Y TYPE type
type is a character

string reading LIN, LOG or INV.
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DATASET Commands
In this section:
ATTRIBUTE

38

BLOCK

39

BLOCKEND

40

CHARSIZE

41

CLIP

42

COLOR

43

DATASET

45

DATAPOINT

46

DRAWLINE

47

FONT

48

FUNCTION

49

GLOBALSIZE

50

INCLUDE

51

LINETYPE

52

PAINT

53

PCFUNCTION

54

SYMBOLSIZE

55

STRING

56

TEXT

58
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ATTRIBUTE
ATTRIBUTE specifies where the current XY position is in the character or symbol plotbox.
Example 2 – Draw Polygons and Symbols, Example 3 – Using Strings and Various
Line Types, and Example 5 – Use Included Files for Predefined Symbols
Syntax

ATTRIBUTE

Prompts attribute
attribute may be

TOP, CENTER or BOTTOM. ATTRIBUTE CENTER is default for symbols;
ATTRIBUTE BOTTOM is default for characters.
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BLOCK
BLOCK defines how the following numeric data block shall be interpreted. The definitions of
X and Y coordinates may also be expressed as a function of the column values, making it
possible to perform transformations.
Syntax BLOCK X&=C#; ...; Y&=C#; ...; GOC=C#,@@@...
&’ are

optional unsigned integers that make it possible to plot several (maximum 9) X- or Y- axis
columns. #’ are unsigned integers identifying the column numbers. The column number # in
“GOC=C#” is the location of any possible GOC codes in the current data BLOCK; @@@ stands for
the default Graphical Operation Code (GOC) for the current BLOCK. The GOC code inside the
current table is only necessary if the current default GOC is not applicable.

GOC Characters
The GOC is a combination of the following characters:
Character

Meaning

W, V or N

To use word (W), virtual (V) or normalized (N) coordinates. W is the default.

A or R

XY are absolute (A) or relative (R) values. A is the default.

M or D

To perform a move (M) or draw (D) operation to XY. M is the default.

B

To apply “soft” splines on a line drawn between the coordinate pairs (used only on BLOCK
data).

S

To plot default symbol at XY.

S#

To change default symbol to No # symbol and plot it at XY.

‘TEXT

To plot TEXT at XY. It must be the last operation in a GOC code. The TEXT following the ’
command is interpreted and expanded by the DIGLIB software, if it includes any ^
operator or STRING names using the ~ descriptor.
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BLOCKEND
Use BLOCKEND to terminate the local definition of the graphical operation code defined by
the earlier BLOCK command.
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CHARSIZE
CHARSIZE redefines the default size of the characters in the plot. The character size has an
initial default value, which may vary with the current font setting and the output device (the
plot format).
Examples of DATAPLOT Files and Outputs
Syntax

CHARSIZE $$
$$ must be

an unsigned real.
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CLIP
CLIP turns clipping on or off. If it is OFF, it allows output outside the ordinary plot area
defined by normalized coordinates zero and one.
Example 2 – Draw Polygons and Symbols and Example 9 - DIGLIB Fonts and
Lines
Syntax

CLIP CLP
clp is a character

string reading ON or OFF.
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COLOR
Use COLOR to redefine the current color setting. There are 22 legal color codes (from 0 to
21).
Example 7 – Color Codes
Syntax

COLOR code
code is an unsigned integer

number (from 0 to 21) identifying the color, or a
character string specifying the color.

DIGLIB Color Codes
Code

Color

Equivalent
Character

0

Background

Invisible

1

Black

Normal

2

Red

Very_Thick

3

Green

Thin

4

Blue

Thick

5

Yellow

Very_Thin

6

Magenta

Dashed

7

Cyan

Dotted

8

Purple

9

Gold

10

Turquoise
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Equivalent
Character

Code

Color

11

Pink

12

Gray

13

Orange-red

14

Maroon

15

Plum

16

Sea green

17

Olive

18

Sienna

19

Orange

20

Coral

21

UserDef

22 and
higher

Any digit larger than 21 has the color effect as
1 (black).
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DATASET
DATASET indicates the beginning of a number of consequent lines comprising a set of userdefined data. The DATASET lines are displayed on the terminal along with the optional
text when using the -1 option in the POST-processor as prompted for the DATASET number
in the APPEND_EXPERIMENTAL_DATA or QUICK_EXPERIMENTAL_PLOT command.
Syntax

DATASET # optional text
# is an unsigned integer

identifying this set of data.
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DATAPOINT
DATAPOINT is not a DATASET command, but the basic DATAPLOT command (see synopsis
below) performs an action at the current point determined by the specified X/Y- coordinates.
A DATASET may contain various data points, in addition to one or more data BLOCKs. Such
data points are separated and independent on each other.
Syntax X Y GOC
X and Y are unsigned real numbers identifying the X/Y-coordinates for the current data point. GOC
stands for Graphical Operation Code (GOC) for the current point. Legal GOC characters.
Example
0.7 0.95 N'Example 6
0.5 0.08 MNA'E^FS18^SQ(^SK^FS10A+5#8*C#^FS10 -!a^FS18)^FS11+B^DIa#b#$
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DRAWLINE
DRAWLINE draws a line starting at (x1,y1) to (xn,yn) through (x2,y2) à (x(n-1), y(n-1)).
Example 1 – Draw Lines and Symbols and Example 2 – Draw Polygons and
Symbols
Syntax

DRAWLINE x1,y1 x2,y2 .... xn,yn
x and y may be

reals or integers of any value. This is the same as connecting all
points in a table:
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FONT
FONT redefines the default font setting in the POST-processor.
Example 9 - DIGLIB Fonts and Lines
Syntax

FONT #
# is an unsigned integer.

Font Numbers
Number

Font

1

Bold

2

Normal

3

Italic

5

Bold and Italic

10

Monotype Normal

11

Monotype Italic

12

Monotype Bold

13

Monotype Bold and Italic

14

Narrow Normal

15

Narrow Italic
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FUNCTION
FUNCTION defines and plots a user-defined function.
Example 4 – Draw Curves Defined by Functions
FUNCTION Y=f(X); start end number_of_XY_pairs; GOC;

Syntax
FUNCTION X=f(Y); start end number_of_XY_pairs; GOC;
f(X) or f(Y) are legal mathematical functions of X or Y, understandable by a FORTRAN program.
start and end are unsigned real numbers, and number_of_XY_pairs an unsigned integer. GOC is a

legal graphical operation code as defined with BLOCK.
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GLOBALSIZE
GLOBALSIZE redefines the default global size of the plot. The global size has an initial default
value.
Syntax

GLOBALSIZE $$
$$ must be

an unsigned real.
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INCLUDE
INCLUDE adds a file into the current input stream.
Example 5 – Use Included Files for Predefined Symbols.
Syntax

INCLUDE filename
filename is a legal filename

(with its correct path) for the operation

system.
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LINETYPE
LINETYPE redefines the current linetype in the plot.
Example 3 – Using Strings and Various Line Types, Example 8 - DIGLIB Symbols
and Example 9 - DIGLIB Fonts and Lines
Syntax LINETYPE #
# must be

an unsigned integer. Legal linetypes are (for both normal graphical outputs and for
PostScript formats):
l

Solid (default)

l

Long dashed

l

Short dashed

l

Dotted

Line Types
Number

Type

1

Straight line

2

Dashed line

3

Dotted line

4

Dash-Dot line
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PAINT
PAINT paints the area enclosed by the current path in the current pattern. The current path
starts at the last MOVETO given and includes all subsequent DRAWs. This command only
works for the PostScript format (as graphical files or on printed hardcopy).
PCFUNCTION
Syntax

PAINT <code> <video> <mode>

<> denotes optional parameters. To set a new current pattern, supply any or all of
the optional parameters.
l

<code> is a single letter 0-9, A-Z or a-t (if <code>=t, also supply a space and a
number in the range 0.00-1.00). The default is 0.

l

<video> is a string reading NORMAL (the default) or INVERSE.

l

<mode> is a string reading TRANSPARENT (the default) or OPAQUE.
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PCFUNCTION
PCFUNCTION appends a user-defined function to the current path. It is used with PAINT.
PCFUNCTION Y=f(X); start end number_of_XY_pairs; GOC;

Syntax
PCFUNCTION X=f(Y); start end number_of_XY_pairs; GOC;
f(X) or f(Y) are

legal mathematical functions of X or Y, understandable by a
FORTRAN program. start and end are unsigned real numbers, and number_of_XY_
pairs an unsigned integer. GOC is a legal graphical operation code as defined with
BLOCK.

DATAPLOT User Guide ǀ 54 of 92

Thermo-Calc Documentation Set

SYMBOLSIZE
SYMBOLSIZE redefines the current symbol size setting. The symbol size has an initial default
value.
Example 3 – Using Strings and Various Line Types, Example 7 – Color Codes and
Example 8 - DIGLIB Symbols
Syntax

SYMBOLSIZE $$
$$ must be

an unsigned real.
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STRING
STRING defines a string containing a text and operation codes (e.g., to change the default
font settings).
Example 3 – Using Strings and Various Line Types and Example 5 – Use Included
Files for Predefined Symbols
Syntax

STRING name text_with_each_character_in_^S#^G^F#^U#^D#^R#^L#^N
name is a valid alphanumeric

name (variable) to represent the text including all text
formatting codes. It is highly recommended that all the characters in the name are
in CAPITAL CASE (e.g. ACA2SO4); otherwise, the defined STRING can be incorrectly
plotted.
text_with_each_character_in_^S#^G^F#^U#^D#^R#^L#^N

means the text is coded with each of its characters (and/or numeric numbers) that
are formatted with various operators (^S#, ^G, ^F#, ^U#, ^D#, ^R#, ^L# and/or ^N). #’
are unsigned integers. ^ is the caret character and does not mean a control
character. Between an # (in an operator) and a numeric number (as a part of the
text), there must always be a comma sign (,) or the number is not plotted in the
text, because the # with the number is interpreted as another incorrect #. In some
of the commands, #=0 resets the option to previous (or default) value.

String Operation Codes in the DIGLIB Software
For the PostScript hardcopy fonts, these operation codes are not valid; see LaTeX Formatting
Codes:
Operator

Operation

^S#

Set character size to size #

^G

Set font to Greek

^F#

Set font to font number #

^U#

Move up # units

^D#

Move down # units
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Operator

Operation

^R#

Move right # units

^L#

Move left # units

^N

Do not move, remain at current

Examples
STRING Alpha1 ^Ga^F0^D0^S8,1^S0^U0

is set to α1
STRING M23C6 M^D0^S8,23^S0^U0C^D0^S8,6^S0^U0

is set to M23C6
STRING ACA2CO3 ^Ga^F0^D0^S8Ca^D0^S4,2^S0^U0^S8CO^D0^S4,3^S0^U0

is set to Ca2CO3
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TEXT
TEXT outputs, at the current position, the text following the keyword TEXT or the text in the
string string_name that is defined with STRING.
Syntax

TEXT text or ~string_name

It is possible to mix ^ operators and previously defined string names using the ~
operator.
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Examples of DATAPLOT Files and Outputs
Once your Thermo-Calc software is installed you can open the Examples and PDF
documentation (Manuals) from the main menu:
l

l

To open the Manuals folder select Help → Manuals Folder. Note for Linux openSUSE
users: This link is not functional. To access the folder, navigate to the default location
based on your installation type
To open the Examples based on whether you are in Console Mode or Graphical
Mode, select File → Examples Files or Help → Examples Files.

In this section:
Example 1 – Draw Lines and Symbols

60

Example 2 – Draw Polygons and Symbols

62

Example 3 – Using Strings and Various Line Types

64

Example 4 – Draw Curves Defined by Functions

67

Example 5 – Use Included Files for Predefined Symbols

69

Example 6 – Triangular Diagrams for Ternary Systems

71

Example 7 – Color Codes

77

Example 8 - DIGLIB Symbols

82

Example 9 - DIGLIB Fonts and Lines

90
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Example 1 – Draw Lines and Symbols
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 1 - Draw Lines and Symbols.EXP available
with your installation. To open the folder: From the Thermo-Calc menu, select Help →
Manuals Folder.

Output Example

Macro Text
DATAPLOT Example 1
PROLOG 1 EXAMPLE 1 0<X<100, 0<Y<100
XSCALE 0.00000 100
YSCALE 0.00000 100
XTYPE LINEAR
YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE EXAMPLE 1
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XTEXT X
YTEXT Y
DATASET 1 Two lines started with two symbols
ATTRIBUTE CENTER
0.05 0.95 N'Example 1
0.7 0.95 NS'Line 1
0.7 0.90 NS2'Line 2
10 10 S1
20 80 D
80 80 S2
80 10 D
50 60
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Example 2 – Draw Polygons and Symbols
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 2 - Draw Polygons and Symbols.EXP
available with your installation. To open the folder: From the Thermo-Calc menu, select
Help → Manuals Folder.

Output Example

Macro Text
$DATAPLOT Example 2
PROLOG 2 EXAMPLE 2 0<X<100, 0<Y<100
XSCALE 0.00000 100
YSCALE 0.00000 100
XTYPE LINEAR
YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE EXAMPLE 2
XTEXT X
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YTEXT Y
DATASET 2 Two ploygons with three types of symbols
ATTRIBUTE CENTER
CLIP OFF
0.05 0.95 N'Example 2
1.1 0.95 NS1'SYMBOL 1
1.1 0.90 NS2'SYMBOL 2
1.1 0.85 NS3'SYMBOL 3
BLOCK X=C1; Y=C2; GOC=C3,DSWA
40 40 M
40 60
60 60 S2'CHANGE OF SYMBOL
60 40
40 40 S0
BLOCKEND
BLOCK X=C1*100; Y=C2*100; GOC=C3,DSWA
0.2 0.2 MS1
0.2 0.8
0.8 0.8
0.8 0.2
0.2 0.2
BLOCKEND
$Draw an additional polygon:
DRAWLINE 20,10 30,15 40,30 50,80
DRAWLINE 50,80 60,60 90,30
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Example 3 – Using Strings and Various Line Types
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 3 - Using String and Line Types.EXP
available with your installation. To open the folder: From the Thermo-Calc menu, select
Help → Manuals Folder.

Output Example

Macro Text
$DATAPLOT Example 3
PROLOG 3 EXAMPLE 3 0<X<10, 0<Y<100
XSCALE 0.00000 10
YSCALE 0.00000 100
XTYPE LINEAR
YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE EXAMPLE 3
XTEXT X
YTEXT Y
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DATASET 3 Draw curves; plot formatted texts and symbols
$Define some strings:
STRING BCC \latex \alpha
STRING BCC1 \latex \alpha_1 + M_23C_8
STRING M23C6 M_23C_6
STRING ACA2CO3 \latex \alpha Ca_2CO_3
STRING AMG2SO4 \latex \alpha Mg_2SO_4
ATTRIBUTE CENTER
CLIP OFF
FONT 2
0.05 0.95 NS1'SYMBOL 1
CHARSIZE 0.2
0.05 0.90 NS2' SYMBOL 2
CHARSIZE 0.3
0.05 0.85 NS3'SYMBOL 3
0.05 0.80 N' ~BCC
0.05 0.75 NS1'~BCC1
SYMBOLSIZE 0.4
CHARSIZE 0.4
0.45 0.42 N'~ACA2CO3
0.58 0.30 N'~AMG2SO4
CLIP ON
LINETYPE 1
BLOCK X=C1; Y=C1*C1; GOC=C2, DWA
0 M
1
2
3
4
5
6
7
8
9
10
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BLOCKEND
LINETYPE 2
BLOCK X=C1; Y=C1*C1+10; GOC=C2, DWA
0 M
1
2
3
4
5
6
7
8
9
10
BLOCKEND
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Example 4 – Draw Curves Defined by Functions
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 4 - Curves and Functions.EXP available with
your installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals
Folder.

Output Example

Macro Text
$DATAPLOT Example 4
PROLOG 4 EXAMPLE 4 0<X<100, 0<Y<100
XSCALE 0.00000 100
YSCALE 0.00000 100
XTYPE LINEAR
YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE EXAMPLE 4
XTEXT X
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YTEXT Y
DATASET 4 Plot two functions as lines:
ATTRIBUTE CENTER
0.05 0.95 N'Example 4
$ Draw two lines defined by FUNCTIONS:
FUNCTION Y=10+0.5*X+20*Sin(X/5); 0 100 100; DWA;
FUNCTION Y=50+0.5*X; 0 100 10; DS1WA;
$ Write functions beside the lines:
$ Note the real rotation angle (27 degree) can be seen
$ only on the PostScript hardcopy
0.25 0.68 N'^RO27Y=50+0.5*X
0.25 0.45 N'^RO27Y=10+0.5*X+20*Sin(X/5)
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Example 5 – Use Included Files for Predefined
Symbols
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 5 - Predefined Symbols.EXP available with
your installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals
Folder.

Output Example
In the plot result, the hard-to-read LaTeX line is intended to highlight how to
type readable text using LaTeX.

Macro Text
$DATAPLOT Example 5 Symbols
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PROLOG 5 EXAMPLE 5 0<X<100, 0<Y<100
XSCALE 0.00000 100
YSCALE 0.00000 100
XTYPE LINEAR
YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE EXAMPLE 5
XTEXT X
YTEXT Y
DATASET 5 Write equations and strings with different properties
STRING TEST1A \latex \alpha \beta \gamma \delta \epsilon \zeta \eta \theta
STRING TEST1B \latex \iota \kappa \lambda \mu \nu \xi \omicron
STRING TEST1C \latex \pi \rho \sigma \tau \upsilon \phi \chi \psi \omega
STRING TEST2A a b c d e f g h i j k
STRING TEST2B l m n o p q r s t u v w x y z
STRING BCC1 \latex \alpha_1
STRING ACA2CO3 \latex \alpha_{Ca_2CO_3}
ATTRIBUTE CENTER
CHARSIZE 1
0.05 0.95 N'Example 5
CLIP OFF
0.01 0.85 N'~TEST1A
0.01 0.80 N'~TEST1B
0.01 0.75 N'~TEST1C
FONT 1
0.01 0.65 N'~TEST2A
FONT 2
0.01 0.60 N'~TEST2B
0.01 0.55 N'\latex \textrm{Roman text in LaTeX}
0.01 0.50 N'\latex as opposed to non-roman math mode LaTeX
0.01 0.45 N'~BCC1
CHARSIZE 0.8
0.01 0.40 N'\latex M_{23}C_6
0.01 0.35 N'~ACA2CO3
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Example 6 – Triangular Diagrams for Ternary
Systems
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 6 - Ternary Plots.EXP available with your
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals
Folder.

Output Example
In the DATAPLOT language, this type of diagram is only available for Console
Mode.

Macro Text
$DATAPLOT Example 6 - Ternary Phase Diagram
PROLOG 6 EXAMPLE 6 0<X<0.969224, 0<Y<1.00000
XSCALE 0.00000 0.969224
YSCALE 0.307492E-01 1.00000
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XTYPE LINEAR
YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE A-B-C at T=1000 K
XTEXT MOLE_FRACTION B
YTEXT MOLE_FRACTION C
DIAGRAM_TYPE TRIANGULAR YES YES
DATASET 6 Plot a ternary phase diagram
CLIP OFF
0.80 0.90 N'Example 6
0.86 0.31 N'B2C
0.52 0.97 N'Diamond
CHARSIZE 0.25
1.4E+01 1.10E+01 MVA'1:*B2C Liquid
1.4E+01 1.05E+01 MVA'2:*Diamond Liquid
0.10 0.10 N'Liquid
0.48 0.45 N'Diamond+
0.48 0.40 N' B2C+Liquid
5.80E-01 5.40E-02 MWA' 1
1.90E-01 2.40E-01 MWA' 1
0.65E-01 2.50E-01 MWA' 2
CHARSIZE 0.45
-0.10 -0.05 N'A
1.06 -0.05 N'B
0.48 1.05 N'C
CHARSIZE 0.35
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$$ Calculated A-B-C Phase Equilibrium Data:
$ PHASE REGION FOR:
$F0 LIQUID
$E DIAMOND_A4
$F0 B2C
$ INVARIANT EQUILIBRIUM
COLOR 2
BLOCK X=C1; Y=C2; GOC=C3,WAD;
2.4555855989E-01 3.5568857193E-01 M
0.0000000000E+00 9.9999523163E-01
2.4555855989E-01 3.5568857193E-01 M
6.6666668653E-01 3.3333334327E-01
0.0000000000E+00 9.9999523163E-01 M
6.6666668653E-01 3.3333334327E-01
COLOR 1
BLOCKEND
$ PHASE REGION FOR:
$E LIQUID
$F0 B2C
BLOCK X=C1; Y=C2; GOC=C3,WAD;
$ PLOTTED COLUMNS ARE : X(LIQUID,B) and X(LIQUID,C)
2.2030337155E-01 1.2340000272E-01 M
2.2632879019E-01 1.1058768630E-01
2.3371633887E-01 9.9345825613E-02
2.4253317714E-01 8.9345827699E-02
2.6429468393E-01 7.2744041681E-02
2.8429466486E-01 6.2814079225E-02
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2.9617273808E-01 5.8319382370E-02
3.2811737061E-01 4.9470417202E-02
3.6353862286E-01 4.3130427599E-02
3.9895987511E-01 3.8979098201E-02
4.5209178329E-01 3.5266116261E-02
5.2293431759E-01 3.3152002841E-02
6.1148744822E-01 3.3077053726E-02
6.4690870047E-01 3.3490389585E-02
6.8232995272E-01 3.4017231315E-02
7.3546189070E-01 3.4814555198E-02
7.5317251682E-01 3.5033416003E-02
8.0630439520E-01 3.5373892635E-02
8.5943627357E-01 3.4983776510E-02
9.1256815195E-01 3.3575300127E-02
9.6747112274E-01 3.0857827514E-02
9.6922445297E-01 3.0749246478E-02
2.2030337155E-01 1.2340000272E-01 M
2.1294665337E-01 1.5308913589E-01
2.1171525121E-01 1.8851040304E-01
2.1532440186E-01 2.2393165529E-01
2.2180187702E-01 2.5935292244E-01
2.2992117703E-01 2.9477417469E-01
2.3888295889E-01 3.3019542694E-01
2.4555855989E-01 3.5568857193E-01
$ PLOTTED COLUMNS ARE : X(B2C,B) and X(B2C,C)
6.6666668653E-01 3.3333334327E-01 M
6.6666668653E-01 3.3333334327E-01

DATAPLOT User Guide ǀ 74 of 92

Thermo-Calc Documentation Set

$ TIELINES
COLOR 3
6.6666668653E-01 3.3333334327E-01 M
8.7775242329E-01 3.4625384957E-02
6.6666668653E-01 3.3333334327E-01 M
7.9250496626E-01 3.5342670977E-02
6.6666668653E-01 3.3333334327E-01 M
2.4555824697E-01 3.5568737984E-01
6.6666668653E-01 3.3333334327E-01 M
2.3944084346E-01 9.2542596161E-02
6.6666668653E-01 3.3333334327E-01 M
2.3359020054E-01 3.0954307318E-01
6.6666668653E-01 3.3333334327E-01 M
2.2585247457E-01 2.7766343951E-01
6.6666668653E-01 3.3333334327E-01 M
2.1618695557E-01 1.3621240854E-01
2.2632879019E-01 1.1058768630E-01 M
6.6666668653E-01 3.3333334327E-01
COLOR 1
BLOCKEND
$ PHASE REGION FOR:
$F0 DIAMOND_A4
$E B2C
BLOCK X=C1; Y=C2; GOC=C3,WAD;
$ PLOTTED COLUMNS ARE : X(DIAMOND_A4,B) and X(DIAMOND_A4,C)
0.0000000000E+00 9.9999523163E-01 M
0.0000000000E+00 9.9999976158E-01
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BLOCKEND
$ PHASE REGION FOR:
$E LIQUID
$F0 DIAMOND_A4
BLOCK X=C1; Y=C2; GOC=C3,WAD;
$ PLOTTED COLUMNS ARE : X(LIQUID,B) and X(LIQUID,C)
2.4555855989E-01 3.5568857193E-01 M
2.0263540745E-01 3.3483061194E-01
1.6243904829E-01 3.1375369430E-01
1.2243904918E-01 2.9153180122E-01
8.2439050078E-02 2.6854267716E-01
4.2439054698E-02 2.4548016489E-01
2.4390530307E-03 2.2313812375E-01
2.4999999937E-07 2.2181616724E-01
$ TIELINES
COLOR 3
0.0000000000E+00 9.9999511242E-01 M
2.3529186845E-01 3.5085919499E-01
0.0000000000E+00 9.9999469519E-01 M
1.9826586545E-01 3.3260950446E-01
0.0000000000E+00 9.9999409914E-01 M
1.3240024447E-01 2.9716023803E-01
0.0000000000E+00 9.9999397993E-01 M
1.1439975351E-01 2.8695335984E-01
BLOCKEND
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Example 7 – Color Codes
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 7 - Color Codes.EXP available with your
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals
Folder.

Output Example

Macro Text
$DATAPLOT Example 7 - DIGLIB Colors
PROLOG 1 DIGLIB Colors
XSCALE 0.0 1.0
YSCALE 0.0 1.0
XTYPE LINEAR
YTYPE LINEAR
XLENGTH 15.5000
YLENGTH 11.5000
TITLE DIGLIB Colors
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XTEXT X
YTEXT Y
DATASET 1 DIGLIB Colors:
$ DIGLIB Colors:
CHARSIZE 0.3
SYMBOLSIZE 0.5
COLOR 1
0.05 0.95 N' Black 1
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.95 M
0.275 0.95 D
BLOCKEND
COLOR 2
0.05 0.85 N' Red 2
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.85 M
0.275 0.85 D
BLOCKEND
COLOR 3
0.05 0.75 N' Green 3
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.75 M
0.275 0.75 D
BLOCKEND
COLOR 4
0.05 0.65 N' Blue 4
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.65 M
0.275 0.65 D
BLOCKEND
COLOR 5
0.05 0.55 N' Yellow 5
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.55 M
0.275 0.55 D

DATAPLOT User Guide ǀ 78 of 92

Thermo-Calc Documentation Set

BLOCKEND
COLOR 6
0.05 0.45 N' Magenta 6
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.45 M
0.275 0.45 D
BLOCKEND
COLOR 7
0.05 0.35 N' Cyan 7
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.35 M
0.275 0.35 D
BLOCKEND
COLOR 8
0.05 0.25 N' Purple 8
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.25 M
0.275 0.25 D
BLOCKEND
COLOR 9
0.05 0.15 N' Gold 9
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.15 M
0.275 0.15 D
BLOCKEND
COLOR 10
0.05 0.05 N' Turquoise 10
BLOCK X=C1; Y=C2; GOC=C3,N
0.175 0.05 M
0.275 0.05 D
BLOCKEND
COLOR 11
0.5 0.95 N' Pink 11
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.95 M
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0.725 0.95 D
BLOCKEND
COLOR 12
0.5 0.85 N' Gray 12
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.85 M
0.725 0.85 D
BLOCKEND
COLOR 13
0.5 0.75 N' Orange-red 13
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.75 M
0.725 0.75 D
BLOCKEND
COLOR 14
0.5 0.65 N' Maroon 14
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.65 M
0.725 0.65 D
BLOCKEND
COLOR 15
0.5 0.55 N' Plum 15
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.55 M
0.725 0.55 D
BLOCKEND
COLOR 16
0.5 0.45 N' Sea green 16
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.45 M
0.725 0.45 D
BLOCKEND
COLOR 17
0.5 0.35 N' Olive 17
BLOCK X=C1; Y=C2; GOC=C3,N
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0.625 0.35 M
0.725 0.35 D
BLOCKEND
COLOR 18
0.5 0.25 N' Sienna 18
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.25 M
0.725 0.25 D
BLOCKEND
COLOR 19
0.5 0.15 N' Orange 19
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.15 M
0.725 0.15 D
BLOCKEND
COLOR 20
0.5 0.05 N' Coral 20
BLOCK X=C1; Y=C2; GOC=C3,N
0.625 0.05 M
0.725 0.05 D
BLOCKEND
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Example 8 - DIGLIB Symbols
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 8 - DIGLIB Symbols.EXP available with your
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals
Folder.

Output Example

A default symbol is the current symbol in the run of the software (it is usually the No 1
symbol if the POST-processor is switched on for the first time). S (i.e., # is not specified)
means that the current symbol is plotted. S0 (i.e., #=0) means that no symbol is plotted.

Macro Text
$DATAPLOT DIGLIB Symbols 2
PROLOG 1 DIGLIB Symbols 2 0<X<2.0, 0<Y<1.2
XSCALE 0.0 2.0
YSCALE 0.0 1.2
XTYPE LINEAR
YTYPE LINEAR
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XLENGTH 15.5000
YLENGTH 11.5000
TITLE DIGLIB Symbols
XTEXT DIGLIB SYMBOLS
DATASET 1 Various DIGLIB Symbols:
$ DIGLIB Symbols:
CHARSIZE 0.3
SYMBOLSIZE 0.5
0.05 0.95 WS1' 1
0.05 0.85 WS2' 2
0.05 0.75 WS3' 3
0.05 0.65 WS4' 4
0.05 0.55 WS5' 5
0.05 0.45 WS6' 6
0.05 0.35 WS7' 7
0.05 0.25 WS8' 8
0.05 0.15 WS9' 9
0.05 0.05 WS10' 10
0.15 0.95 WS11' 11
0.15 0.85 WS12' 12
0.15 0.75 WS13' 13
0.15 0.65 WS14' 14
0.15 0.55 WS15' 15
0.15 0.45 WS16' 16
0.15 0.35 WS17' 17
0.15 0.25 WS18' 18
0.15 0.15 WS19' 19
0.15 0.05 WS20' 20
0.25 0.95 WS100' 100
0.25 0.85 WS101' 101
0.25 0.75 WS102' 102
0.25 0.65 WS103' 103
0.25 0.55 WS104' 104
0.25 0.45 WS105' 105
0.25 0.35 WS106' 106
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0.25 0.25 WS107' 107
0.25 0.15 WS108' 108
0.25 0.05 WS109' 109
0.35 0.95 WS110' 110
0.35 0.85 WS111' 111
0.35 0.75 WS112' 112
0.35 0.65 WS113' 113
0.35 0.55 WS114' 114
0.35 0.45 WS115' 115
0.35 0.35 WS116' 116
0.35 0.25 WS117' 117
0.35 0.15 WS118' 118
0.35 0.05 WS119' 119
0.45 0.95 WS120' 120
0.45 0.85 WS121' 121
0.45 0.75 WS122' 122
0.45 0.65 WS123' 123
0.45 0.55 WS124' 124
0.45 0.45 WS125' 125
0.45 0.35 WS126' 126
0.45 0.25 WS127' 127
0.45 0.15 WS128' 128
0.45 0.05 WS129' 129
0.55 0.95 WS130' 130
0.55 0.85 WS131' 131
0.55 0.75 WS132' 132
0.55 0.65 WS133' 133
0.55 0.55 WS134' 134
0.55 0.45 WS135' 135
0.55 0.35 WS136' 136
0.55 0.25 WS137' 137
0.55 0.15 WS138' 138
0.55 0.05 WS139' 139
0.65 0.95 WS140' 140
0.65 0.85 WS141' 141
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0.65 0.75 WS142' 142
0.65 0.65 WS143' 143
0.65 0.55 WS144' 144
0.65 0.45 WS145' 145
0.65 0.35 WS146' 146
0.65 0.25 WS147' 147
0.65 0.15 WS148' 148
0.65 0.05 WS149' 149
0.75 0.95 WS200' 200
0.75 0.85 WS201' 201
0.75 0.75 WS202' 202
0.75 0.65 WS203' 203
0.75 0.55 WS204' 204
0.75 0.45 WS205' 205
0.75 0.35 WS206' 206
0.75 0.25 WS207' 207
0.75 0.15 WS208' 208
0.75 0.05 WS209' 209
0.85 0.95 WS210' 210
0.85 0.85 WS211' 211
0.85 0.75 WS212' 212
0.85 0.65 WS213' 213
0.85 0.55 WS214' 214
0.85 0.45 WS215' 215
0.85 0.35 WS216' 216
0.85 0.25 WS217' 217
0.85 0.15 WS218' 218
0.85 0.05 WS219' 219
0.95 0.95 WS220' 220
0.95 0.85 WS221' 221
0.95 0.75 WS222' 222
0.95 0.65 WS223' 223
0.95 0.55 WS224' 224
0.95 0.45 WS225' 225
0.95 0.35 WS226' 226
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0.95 0.25 WS227' 227
0.95 0.15 WS228' 228
0.95 0.05 WS229' 229
1.05 0.95 WS300' 300
1.05 0.85 WS301' 301
1.05 0.75 WS302' 302
1.05 0.65 WS303' 303
1.05 0.55 WS304' 304
1.05 0.45 WS305' 305
1.05 0.35 WS306' 306
1.05 0.25 WS307' 307
1.05 0.15 WS308' 308
1.05 0.05 WS309' 309
1.15 0.95 WS310' 310
1.15 0.85 WS311' 311
1.15 0.75 WS312' 312
1.15 0.65 WS313' 313
1.15 0.55 WS314' 314
1.15 0.45 WS315' 315
1.15 0.35 WS316' 316
1.15 0.25 WS317' 317
1.15 0.15 WS318' 318
1.15 0.05 WS319' 319
1.25 0.95 WS320' 320
1.25 0.85 WS321' 321
1.25 0.75 WS322' 322
1.25 0.65 WS323' 323
1.25 0.55 WS324' 324
1.25 0.45 WS325' 325
1.25 0.35 WS326' 326
1.25 0.25 WS327' 327
1.25 0.15 WS328' 328
1.25 0.05 WS329' 329
1.35 0.95 WS330' 330
1.35 0.85 WS331' 331
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1.35 0.75 WS332' 332
1.35 0.65 WS333' 333
1.35 0.55 WS334' 334
1.35 0.45 WS335' 335
1.35 0.35 WS336' 336
1.35 0.25 WS337' 337
1.35 0.15 WS338' 338
1.35 0.05 WS339' 339
1.45 0.95 WS340' 340
1.45 0.85 WS341' 341
1.45 0.75 WS342' 342
1.45 0.65 WS343' 343
1.45 0.55 WS344' 344
1.45 0.45 WS345' 345
1.45 0.35 WS346' 346
1.45 0.25 WS347' 347
1.45 0.15 WS348' 348
1.45 0.05 WS349' 349
1.55 0.95 WS350' 350
1.55 0.85 WS351' 351
1.55 0.75 WS352' 352
1.55 0.65 WS353' 353
1.55 0.55 WS354' 354
1.55 0.45 WS355' 355
1.55 0.35 WS356' 356
1.55 0.25 WS357' 357
1.55 0.15 WS358' 358
1.55 0.05 WS359' 359
1.65 0.95 WS360' 360
1.65 0.85 WS361' 361
1.65 0.75 WS362' 362
1.65 0.65 WS363' 363
1.65 0.55 WS364' 364
1.65 0.45 WS365' 365
1.65 0.35 WS366' 366
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1.65 0.25 WS367' 367
1.65 0.15 WS368' 368
1.65 0.05 WS369' 369
1.75 0.95 WS370' 370
1.75 0.85 WS371' 371
1.75 0.75 WS372' 372
1.75 0.65 WS373' 373
1.75 0.55 WS374' 374
1.75 0.45 WS375' 375
1.75 0.35 WS376' 376
1.75 0.25 WS377' 377
1.75 0.15 WS378' 378
1.75 0.05 WS379' 379
1.85 0.95 WS380' 380
1.85 0.85 WS381' 381
1.85 0.75 WS382' 382
1.85 0.65 WS383' 383
1.85 0.55 WS384' 384
1.85 0.45 WS385' 385
1.85 0.35 WS386' 386
1.85 0.25 WS387' 387
1.85 0.15 WS388' 388
1.85 0.05 WS389' 389
$ DIGLIB Line Types:
LINETYPE 1
BLOCK X=C1; Y=C2; GOC=C3,DWA
0.05 1.10 M
0.35 1.10
BLOCKEND
LINETYPE 2
BLOCK X=C1; Y=C2; GOC=C3,DWA
0.45 1.10 M
0.75 1.10
BLOCKEND
LINETYPE 3
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BLOCK X=C1; Y=C2; GOC=C3,DWA
0.85 1.10 M
1.15 1.10
BLOCKEND
LINETYPE 4
BLOCK X=C1; Y=C2; GOC=C3,DWA
1.25 1.10 M
1.60 1.10
BLOCKEND
0.10 1.12 W' LINETYPE 1
0.50 1.12 W' LINETYPE 2
0.90 1.12 W' LINETYPE 3
1.30 1.12 W' LINETYPE 4
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Example 9 - DIGLIB Fonts and Lines
The macro text below produces the example output. You can copy the text into your own
EXP file, or use the example file DATAPLOT 9 - DIGLIB Fonts.EXP available with your
installation. To open the folder: From the Thermo-Calc menu, select Help → Manuals
Folder.

Output Example

Macro Text
$DATAPLOT Example 9 - DIGLIB Fonts
PROLOG 1 DIGLIB Fonts & Line Types 0<X<1, 0<Y<1
XSCALE 0.0 1.0
YSCALE 0.0 1.0
XTYPE LINEAR
YTYPE LINEAR
XLENGTH 11.5000
YLENGTH 11.5000
TITLE DIGLIB Fonts
XTEXT X
YTEXT Y
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DATASET 1 Various DIGLIB Fonts and Line Types:
$ DIGLIB Fonts:
CHARSIZE .35
FONT 1
0.05 0.95 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 2
0.05 0.90 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 3
0.05 0.85 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 5
0.05 0.80 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 10
0.05 0.75 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 11
0.05 0.70 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 12
0.05 0.65 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 13
0.05 0.60 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 14
0.05 0.55 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 15
0.05 0.50 N'ABCDEFGHIJKLmnopqrstuvwxyz
FONT 1
CLIP OFF
CHARSIZE .30
1.10 0.95 N'FONT 1
1.10 0.90 N'FONT 2
1.10 0.85 N'FONT 3
1.10 0.80 N'FONT 5
1.10 0.75 N'FONT 10
1.10 0.70 N'FONT 11
1.10 0.65 N'FONT 12
1.10 0.60 N'FONT 13
1.10 0.55 N'FONT 14
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1.10 0.50 N'FONT 15
CLIP ON
$ DIGLIB Line Types:
LINETYPE 1
BLOCK X=C1; Y=C2; GOC=C3,DWA
0.05 0.40 M
0.50 0.40
BLOCKEND
$DRAWLINE 0.05,0.40 0.5,0.40
LINETYPE 2
BLOCK X=C1; Y=C2; GOC=C3,DWA
0.05 0.30 M
0.50 0.30
BLOCKEND
$DRAWLINE 0.05,0.30 0.5,0.30
LINETYPE 3
BLOCK X=C1; Y=C2; GOC=C3,DWA
0.05 0.20 M
0.50 0.20
BLOCKEND
$DRAWLINE 0.05,0.20 0.5,0.20
LINETYPE 4
BLOCK X=C1; Y=C2; GOC=C3,DWA
0.05 0.10 M
0.50 0.10
BLOCKEND
$DRAWLINE 0.05,0.10 0.5,0.10
0.55 0.40 N' LINETYPE 1
0.55 0.30 N' LINETYPE 2
0.55 0.20 N' LINETYPE 3
0.55 0.10 N' LINETYPE 4
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About Pourbaix Diagrams in Thermo-Calc
This guide is for Thermo-Calc software users who know the basics of thermodynamics and
want to know more about Pourbaix Diagrams.
You are introduced to the concept of a Pourbaix diagram and shown how to interpret such
diagrams through a series of examples.
Materials corrosion occurs almost everywhere. It may lead to serious material damages,
unexpected application failures, tremendous economic costs and environmental
degradations. Consequently, scientists and engineers must often conduct expensive and
time-consuming corrosion experiments as part of failure analyses, risk evaluations, quality
improvements and application enhancements.
Under certain conditions, when a metal or alloy is exposed to an aqueous solution with a
concentration of inorganic/organic mixture, corrosion phenomena occur at a corresponding
degree. During corrosion, some metallic phases dissolve, the metal or alloy surface gets
damaged and some secondary solid phases form at the solid-liquid interfaces (such as
oxides, hydroxides, silicates, sulphides, sulphates, carbonates, nitrates, phosphates, borates,
or halides). Such corrosive chemical or electrochemical reactions can be studied by means
of the so-called Pourbaix diagrams if the reactions reach their equilibrium states [1973 and
1974, Pourbaix; 2003, Cramer; 2011, Verink; 2011, Thompson].

GES5 and GES6 Calculation Engine Version
As of Thermo-Calc version 2019b, the default calculation engine is set to GES6. For
POURBAIX module users, you need to use GES5. When you try to enter this module, you are
instructed to switch to GES5 using the SET_GES_VERSION command.
About the Gibbs Energy System (GES) Module

To globally set the default from GES6 back to GES5, go to the Tools → Options
→ General tab and click Version 5 for the Preferred Gibbs Energy System
setting. The SET_GES_VERSION Console Mode command is used to change GES
versions for a single Thermo-Calc session.

Contact Thermo-Calc Software AB at info@thermocalc.com for more
information about the changes or if you encounter any issues you think are
related to the new version of the calculation engine.
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GES6 is a re-write and new implementation of the Gibbs Energy System module
of Thermo-Calc and it is the default engine. The previous version, GES5, is still
available and will continue to work in the background of the program where
necessary. The main purpose of GES6 is to support faster development of new
features. However, not all GES5 functionality is implemented in GES6. In such
cases (except for the POURBAIX module), GES6 falls back silently and uses
functionality from GES5 in the background.
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Pourbaix Diagrams
Marcel Pourbaix applied thermodynamics to predict materials corrosion resistance. He
determined the phase stability relations in terms of varied pH and Eh values for an
interaction system of metal and pure water or dilute aqueous solution. He presented the
stability regions of metal and secondary phases (such as metal-oxides/hydroxides) on a pHEh diagram, which is now known as a Pourbaix diagram.
A Pourbaix diagram is a kind of phase diagram that shows the stability boundaries for a
metal-aqueous interaction system. The phase boundaries are shown as a function of pH
(acidity) and Eh (standard hydrogen electronic potential). An aqueous solution phase is
always present in such a system. At a given pH and Eh, a metal may lose its stability to a
soluble or corrosive aqueous solution, or be in equilibrium with either the aqueous solution
(insoluble/immune) or with a secondary-phase file that has formed (consisting of oxides,
hydroxides, sulphides or other solids). In the latter case, further dissolution of the passive or
protective metal is prevented.
The speciation and partition in the aqueous solution and the interacting phases depend not
only on pH and Eh, but also on other factors such as the bulk composition, temperature and
pressure in the system. The interacting phases may be gas mixtures, stoichiometric solids or
solid solutions.
A Pourbaix diagram is divided in regions of immunity, corrosion and passivity. These regions
provides information about the stability of a particular metal or alloy in a specific aqueous
electrochemical environment under certain pH, Eh, pressure and temperature conditions.
l

The immunity region is the region in which there is no metal dissolution.

l

The corrosion region is the region in which there is active metal dissolution.

l

The passivation region is the region in which a protective metal-oxide film that
prevents metal dissolution is formed.

The following shows these three regions in a Pourbaix diagram for the heterogeneous
interaction between 0.001 mole of austenite steel (Fe-19Cr-9Ni [at%]) and 1 kg of water
(with 3 m NaCl), at 200° C and 100 bar:
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Depending on the system’s bulk chemical composition, secondary phases may form during
the transformation process. These can not only be oxides, but also be, for example,
hydroxides, sulphides, sulphates, carbonates, nitrates, phosphates, borates, silicates, hydrous
silicates and halides. Information about these secondary phases may help one understand
the passivation behaviours in corrosion processes. For example, it may be important to
understand whether any secondary phases are formed in different pH-Eh regions during
hydrolysis, oxidation, reduction or other reaction processes.
In a Pourbaix diagram, the predominant ion boundaries are often represented by dashed
and straight lines imposed on a traditional Pourbaix diagram for a simple interaction system
(Pourbaix, 1973, 1974; Cramer and Covino, 2003; Verink, 2011; Thompson et al., 2011). Such
a predominance boundary is normally an equal molality (or equal activity) line for a pair of
two most-concentrated aqueous solute species (charged or neutral) involving a common
metal. A line is then simply determined by a reaction constant of its corresponding
electrochemical reaction in the homogeneous aqueous solution phase. However, this is not
the case in Thermo-Calc.
You cannot get any information about predominant ion boundaries from a
Pourbaix diagram in Thermo-Calc.
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Working with Pourbaix Diagrams
With the Thermo-Calc software package, Pourbaix diagrams can be calculated over a wide
range of pressure, temperature and composition conditions for complex heterogeneous
interactions between multicomponent primary alloy solution or compound phases,
concentrated aqueous solutions (with dissolved inorganic and organic substances),
complicated secondary solids and oxidizing/reducing gaseous mixtures. In the Console
Mode, diagrams can be calculated and plotted either using the response-driven POURBAIX
module or directly using the DATA, GIBBS, POLY and POST modules.
This command or module is not available with GES6.

GES6 is a re-write and new implementation of the Gibbs Energy System module
of Thermo-Calc and it is the default engine. The previous version, GES5, is still
available and will continue to work in the background of the program where
necessary. The main purpose of GES6 is to support faster development of new
features. However, not all GES5 functionality is implemented in GES6. In such
cases (except for the POURBAIX module), GES6 falls back silently and uses
functionality from GES5 in the background.

It is possible in Thermo-Calc to set aqueous properties other than pH and Eh as axis
variables. For example, the following properties can also be set as axis variables: Ah
(electronic affinity), pe (electronic activity log10ACRe), IS (ionic strength), TM (total aqueous
concentration, in molality), OC (Osmotic coefficient), activity or activity coefficient of solvent
H2O, and activities or activity coefficients or concentrations in m (molality) of charged or
neutral solute species.
Beside a concentrated aqueous solution phase handled by a proper thermodynamic model
named SIT, HKF or PITZ, it is also possible to consider complex alloy solution phases or
compound phases, as well as secondary solid phases and gaseous mixtures, which are
treated by specific solution models.
Most frequently, a Pourbaix diagram is calculated for a specific alloyed phase with the initial
alloying composition, such as the FCC solution phase in an austenite steel. However, it is
possible to calculate a Pourbaix diagram for two co-existing phases, such as the FCC+BCC
solution phases in a duplex steel for example, or even for more than two co-existing phases
in a steel/alloy.
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Each point on the line in a pH-Eh diagram in Thermo-Calc represents a certain
minimum state of Gibbs energy. When a line is crossed, a phase transformation
should occur. This means that a Pourbaix diagram in Thermo-Calc does not
provide any information about any predominant ion boundary.
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Key Concepts
The following are two key concepts important for understanding how aqueous solutions
behave and how an aqueous-bearing heterogeneous interaction system is properly defined
and calculated in Thermo-Calc.

Effective Interaction Ratio
A pH-Eh plot is always related to a certain amount of initial alloys or other condensed
materials that has effectively reacted with an aqueous solution in the system. This is the
amount of condensed material that is fully in equilibrium with the defined aqueous solution
phase. The amount is specified relative to an aqueous solution that is normally comprised of
1 kg of water with certain specified solute concentrations at certain temperature and
pressure conditions. (This is why a calculated Pourbaix diagram is typically presented for an
initial amount of the interacting metal or alloy at a certain level, such as 10-6, 1E-3, 0.1 or 1
mole of metal or alloy.) It is called the Effective Interaction Ratio (between the initial alloy
or alloyed phases and the initial aqueous solution) and it is expressed in terms of molality
(mol/kg).
The Effective Interaction Ratio is important for two reasons. First, the ratio has implications
for kinetic or dynamic effects such as chemical reaction mechanism and kinetics, fluid flow
dynamics, surface area and interaction time. Secondly, the ratio, being expressed as 10-6
mole of metal (or alloy), is the solubility limit that can be detected for cathodic corrosion
protection by immunity.
One should always be careful when setting initial amounts and compositions in the original
condensed materials, as well as when setting the initial concentrations of dissolved solutes in
the original aqueous solution phase. It is often useful to make a series of calculations for
different levels of initial amount of the interacting metal/alloy while the conditions are fixed
for other settings (such as initial aqueous concentration, pressure, temperature, pH, and Eh).

Solubility
When a heterogeneous equilibrium has a dissolving solution or mixture phase and a
stoichiometric or solution phase, then the concept of solubility becomes important. A
solubility of a phase (the solute) is its property of dissolving in the solvent phase. This
concept concerns the constitution of a phase and is applied where one or several of the
constituents are dominant (which is highly concentrated and dissolving) while there are only
small amounts of the other remaining species (which are less concentrated and dissolved).
The dissolving solution or mixture phase can be liquid, gas, aqueous or solid, as long as it has
dissolving capacity. The stoichiometric or solution phase has some constituents which tend to
be dissolved into the dissolving solution or mixture phase.
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Key Points about Solubility
l

l

l

l

Under certain temperature, pressure and composition conditions, a Fe- or Crdominant BCC phase can dissolve certain amounts of Ni and C from a carbide phase
such as M23C6, M7C3 or M3C. The Ni and C elements in the carbides have the
solubility defined relative to the BCC phase.
An aqueous solution phase is always dominant in the solvent water, that is, H2O.
Under specific temperature, pressure and aqueous composition conditions, any other
element (such as Fe and C) or substance (such as a pure SO2 gas, stoichiometric
phase Cu2S and solution phase (Fe,Ni)1(O,Va)1) have a certain solubility limit in the
defined aqueous solution.
Under certain temperature and pressure conditions, and under given certain
concentrations of other dissolved species in the mixture, an O2-dominant gaseous
mixture phase can dissolve certain amounts of Fe+2 or Fe+3 species from magnetite
(Fe3O4). The magnetite solid has solubility defined relative to the gaseous mixture
under the given conditions.
Under certain temperature and pressure condition, under specific concentrations of
other dissolved species in the liquid phase, a Fe-dominant liquid mixture phase can
dissolve certain amounts of, for example, Cr and O. The Cr and O components have
the solubility defined in the liquid mixture.
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Basic Settings and Definitions
In a homogeneous aqueous solution or an aqueous-bearing heterogeneous interaction
system, the most essential definition is for system-components there must be H2O, H+1 and
ZE (electron) plus those for elements dissolved in aqueous solution (such as Na, Cl, S) and
associated in interacting metals/alloys (such as Fe, Cr, Mn, Mg, Ni, Al, Si, Zn). Three
fundamental phases in a system are the AQUEOUS solution, the GAS mixture and the REF_
ELECTRODE. The REF_ELECTRODE phase is used for setting the reference state for
electrostatic potential in the system and for calculating the Eh condition (defined as MUR
(ZE)/RNF). Other phases should be appropriately selected and retrieved from criticallyassessed databases that cover not only the target phases (solution or stoichiometric) in
interacting metals/alloys but also the secondary phases (solution or stoichiometric). The two
public databases PAQ and PAQS are specially designed as single-database choices that cover
all kinds of phases necessary for calculations. However, these databases are each limited to
a framework of a very small number of elements. When it comes to simulations of complex
multicomponent systems with a wide variety of elements and phases, the thermodynamic
data must be selected and retrieved from several databases: AQUEOUS solution and REF_
ELCTRODE phases must be retrieved from TCAQ or AQS; alloy phases (such as FCC_A1, BCC_
A2, HCP_A3, CEMENTITE) from alloy solution databases (such as SSOL for general alloy
phases, TCFE for steel/Fe-alloy phases, TCAL for Al-based alloy phases; TCMG for Mg-based
alloy phases, and TCNI for Ni-based superalloy phases); gaseous mixture phase and
secondary phases from specific substance or solution databases (such as SSUB for GAS phase
and various solid compound phases or TCOX for oxide solution phases). Note that the REF_
ELECTRODE phase should always be suspended in equilibrium calculations, while GAS phase
could be set as ENTERED, SUSPENDED or DORMANT, depending on the purpose of the
calculation.
When defining an interaction system, the initial condition for the H2O component is always
set as 1 kg of water. The initial composition conditions for dissolving and interacting
elements are normally defined in moles (such as n(Fe)=0.009, n(Cr)=5E-4, n(Ni)=3E-4, n
(Mn)=5E-5, n(S)=5E-5, n(Na)=3, n(Cl)=3). This makes it straightforward and convenient to
count various related aqueous solution properties based on molality. The initial conditions
for the H+1 and ZE components can be given as molar compositions (such as n(H+1)=0, n
(ZE)=0) or their activities or potentials (such as lnACR(H+1)=-9.21, MUR(ZE)=8400).
The pH and Eh properties of the aqueous solution in the interacting system are always
defined in the following way:
pH = -log10[ACR(H+1,AQUEOUS)*AH2O]]Eh = MUR(ZE)/RNF

The symbol AH2O is the molecular weight of solvent H2O (equals 55.508435) and RNF is the
Faraday constant (equals 96485.309).
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The activity of the solvent water (ACRH2O, Aw), the osmatic coefficient of aqueous solution
(OSMC, Os), electronic affinity (Ah), electronic activity log10ACRe (pe), ionic strength (IS),
total aqueous concentration, in molality (TM) and total alkaline concentrations under two
definitions (At1/AT2) are calculated and listed for each equilibrium state.
POLY3 calculations for mass balances in Thermo-Calc are always based on site-fractions.
Consequently, when functions for describing various properties of aqueous solutes are
defined, such as molality (MLi), activity coefficient (RCi) and activity (AIi), they should be
converted to molality-based quantities:
MLi = Y(AQUEOUS,i)*AH2O/YH2O
RCi = ACR(i,AQUEOUS)*YH2O/Y(AQUEOUS,i)
AIi = ACR(i,AQUEOUS)*AH2O

Here, YH2O is the site-fraction of solvent H2O and AH2O equals 55.508435.
Many more variables, functions and tables can be entered for various purposes. For
instance, an equilibrium constant for a homogeneous reaction or a solubility product for a
solid dissolution reaction can be entered.
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Thermodynamic Data Requirements
In this section:
Required Thermodynamic Data

14

Including or Excluding the Gas Phase

15
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Required Thermodynamic Data
To calculate a Pourbaix diagram, thermodynamic data for at least the following four types
of phases must be available:
l

l

l

l

The aqueous solution phase which applies a certain aqueous solution model. In
Thermo-Calc, information about this phase could be retrieved from, for instance, the
TCAQ or AQS database (these also include data for the REF_ELECTRODE phase that is
used for setting the reference state of the standard hydrogen electrode).
The alloy solution and/or compound phases for the primary matrix phases (and
possibly also for the precipitated phases in the alloy. Examples of such phases include
FCC_A1, BCC_A2, HCP_A3, SIGMA and CEMENTITE. In Thermo-Calc, information
about such phases could be retrieved from, for example, the TCFE database for
steels/Fe-alloys, the TCNI database for Ni-based superalloys, the TCAL database for
Al-based alloys, the TCMG database for Mg-based alloys, the TCSLD for Sn-/Au-/Bi/Zn-based solder alloys or the SSOL for general alloys.
The secondary solid phases that would form as a result of the heterogeneous
chemical or electrochemical reactions. These phases could be, for example, oxides,
hydroxides, silicates, hydrous silicates, sulphides, sulphates, carbonates, nitrates,
phosphates, borates or halides. In Thermo-Calc, information about such phases could
be retrieved from, for example, the SSUB database for pure solid compounds or the
TCOX database for complex oxide solids.
The gaseous mixture phase. Information about this phase could be retrieved from,
for example, the SSUB database. However, note that is also possible to perform
Pourbaix diagram calculations that ignore the gaseous mixture phase.

All this thermodynamic data about the various phases must be critically assessed and
internally consistent. Furthermore, when the data is retrieved from several databases, the
data taken from each database must be consistent with the data taken from the other
databases. When Pourbaix diagrams and other diagrams of steel corrosion processes are
calculated, it is typically recommended that the TCAQ, TCFE, SSUB and TCOX databases or
the AQS, TCFE, SSUB and TCOX are used in combination.
The public PAQ database contains thermodynamic data for all four phase types and can be
used for calculating Pourbaix diagrams. They have been designed specifically for the
purpose of demonstrating the POURBAIX module functionality in Thermo-Calc. However,
these databases only allow you to perform test calculations for simple cases with major
phases in which only a few elements can be considered.
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Including or Excluding the Gas Phase
Under defined pressure and temperature conditions, the solvent water’s thermodynamic
stability limits are determined by the following two electrochemical reactions:
H2O(water) + 2e- = H2(gas) + 2OH-1
2H2O(water) = O2(gas) + 4H+1 + 4e-

The first reaction describes the formation of H2-dominated gaseous mixture, under reducing
conditions. The second reaction describes the formation of O2-dominated gaseous mixture,
under oxidising conditions.
If the system reaches global equilibrium, then the water component is electrolyzed to H+
and O-2 at all pH conditions. The degree of electrolysis depends on the pH value in the
aqueous solution phase. If Eh gets high enough, then the O-2 anion is oxidized to O2 (aqs).
On the other hand, if Eh gets low enough, then the H+ cation is reduced to H2 (aqs). The
major electrolysis and redox reactions are the following:
H2O (water) = H+ + OH- → Electrolysis of water at all pH.
H2O (water) = 2H+ + O-2 → Electrolysis of water at all pH.
O-2 - 2e- = 0.5O2 (aqs) → Oxidation or de-electronization of O-2 at high Eh.
2H+ + 2e- = H2 (aqs) → Reduction or electronization of H+ at low Eh.

At a critically high Eh value under a given pH condition, an aqueous solution phase with a
high enough O2 activity becomes less stable than an O2-dominated gaseous mixture phase.
At this point, the gas phase replaces the aqueous solution phase in the system. The
replacement process can be characterised by the following phase-transformation on the
aqueous-gas phase boundary and oxidation of remaining water:
O2 (aqs)

= O2 (gas)

H2O (water) - 2e- = 2H+(gas) + 0.5O2 (gas)

Similarly, at a critically low Eh value under a given pH condition, an aqueous solution phase
with a high enough H2 activity becomes less stable than a H2-dominated gaseous mixture
phase. At this point, the gas phase replaces the aqueous solution phase in the system,
through the following phase-transformation on the aqueous-gas phase boundary and
reduction of remaining water:
H2 (aqs)

= H2 (gas)

H2O (water) + 2e- = O-2 (gas) + H2 (gas)

The phase transformation from an aqueous solution phase to an O2- or H2-dominated
gaseous mixture phase also depends on the total molar Gibbs energies of the phases (which
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are complex functions of the phase constituents, the temperature and the pressure). The
Gibbs energy minimization technique used in Thermo-Calc ensures that the phase
transformation is accurately simulated.
The following Pourbaix diagrams show the result of a calculation where the gaseous mixture
phase was included. In the upper region (high Eh) and lower region (low Eh), the aqueous
solution phase has been oxidized and reduced, respectively, to an O2- or H2-dominated
gaseous mixture phase.
The two example diagrams show that the upper and lower boundaries between the aqueous
phase (water) and the gas phase (dominated by either O2 or H2) can shift when solutes
dissolve or when the temperature and pressure change.
Accordingly, if one does not take a gaseous mixture phase into account when performing a
calculation of Pourbaix diagram (as above), then the aqueous solution phase may end up
with an extremely high O2 (aqs) concentration at high Eh condition, or an extremely high H2
(aqs) concentration at low Eh condition. Under either of these two extreme circumstances,
the concept of “aqueous solution phase” is no longer valid and consequently no proper
aqueous solution model can actually be applied. Therefore, from a restrictive
thermodynamic equilibrium point of view, one shall normally include a gaseous mixture
phase in an aqueous-bearing heterogeneous interaction system. This is true for all types of
equilibrium calculations for an aqueous-bearing heterogeneous interaction system, not only
of Pourbaix diagram calculations.
Hence, to perform a completely accurate Pourbaix diagram calculation, the gaseous mixture
phase must be taken into account. However, since these electrochemical reactions normally
have much higher kinetic barriers and are slower than other electrochemical and chemical
reactions in the interaction system, one can sometimes ignore the gaseous mixture phase in
the calculation. Note that if the gaseous mixture phase is ignored in this way, then the
Pourbaix diagram does not show the H2O-stability limiting lines.

Examples
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Figure 11: A pH-Eh diagram for pure water at 25° C and 1 bar.

Pourbaix Diagrams ǀ 17 of 29

Thermo-Calc Documentation Set

Figure 12: A pH-Eh diagram for 3mNaCl-0.001mCO2-0.001mSO2 aqueous solution at 150° C and
100 bar.
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Examples of Pourbaix Diagrams for Fe
The following two topics are examples of Pourbaix diagrams for Fe. For the first example,
the calculations on which the diagrams are based have not taken the gas phase into account.
The diagrams in the second example are based on calculations that have taken the gas
phase into account.
In this section:
Pourbaix Diagrams with Gas Phase Excluded

20

Pourbaix Diagrams with Gas Phase Included

21
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Pourbaix Diagrams with Gas Phase Excluded
This is an example of a Pourbaix diagram of Fe, in which the gas phase has not been
considered in the calculation. The system has 0.001 mole of Fe in 1 kg of pure water at a
temperature of 25oC and a pressure of 1 bar. Magnetite (Mt, Fe3O4) and hematite (Hm,
Fe2O3) co-exist with the Fe-containing dilute aqueous solution. The formation of magnetite
and hematite represent the passivation of iron in the upper right pH-Eh field.
If pH is low and Eh is relatively high, then Fe eventually completely dissolves into the
aqueous solution phase. Under conditions of low Eh, Fe remains in its stable solid state, the
BCC phase, and neither dissolves into water nor into alternates to Fe (the immunity of Fe).
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Pourbaix Diagrams with Gas Phase Included
With all the possible redox reactions involving the aqueous solution phase and gaseous
mixture phase being considered in the equilibrium system, that is, the gaseous mixture
phase is included in the calculation, the Pourbaix diagram of Fe in a system with 0.001 mole
of Fe in 1 kg of pure water at 25oC and 1 bar.

Comparing this Pourbaix diagram with that from Basic Settings and Definitions, you can see
that both diagrams are for the same interaction system under the same temperaturepressure condition, but the present diagram shows the results of calculations where the
gaseous mixture phase has been included. It presents the complete Pourbaix diagram for the
defined interaction system, in a full thermodynamic equilibrium. In the upper region (high
Eh) and lower region (low Eh), the aqueous solution phase is oxidised and reduced to the O2or H2-dominated gas phase. Hematite coexists with the O2-dominated gas, while Fe-BCC is
stable with the H2-dominated gas. The stability field of magnetite may extend slightly into
the H2-dominated gas region, where it coexists with the gaseous mixture instead of the
aqueous solution. Its boundary with Fe (BCC) cannot be drawn due to the absence of aqueous
solution phase.
It is not possible to calculate the pH value in both the O2- and H2-dominated gaseous
mixture phase stability regions where the aqueous solution phase is absent. Hence, in a
normal Pourbaix diagram, no line is drawn that indicates a phase boundary between the gas
phase and the metallic phases or secondary phases (that is, metal-oxides).
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Other Examples of Pourbaix Diagrams
In this section:
Variations of Pourbaix Diagrams
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Variations of Pourbaix Diagrams
The shape of a Pourbaix diagram of an alloy or condensed material and the stability
relations of various secondary phases depend upon the following system factors:
l

Initial amount of the alloy or other condensed materials

l

Initial composition of the alloy or other condensed materials

l

Initial amount of the interacting aqueous solution phase

l

Initial composition of the interacting aqueous solution phase

l

Temperature and pressure conditions

In the interaction system that the diagrams in Pourbaix Diagrams with Gas Phase Excluded
and Pourbaix Diagrams with Gas Phase Included are based on, the initial amount of pure Fe
that was taken to have effectively reacted with 1 kg of pure water at 25° C and 1 bar was
0.001 m. The following diagrams are Pourbaix diagrams of Fe where other initial amounts of
pure Fe have been used, or where the interacting aqueous solution compositions have been
alternated, or the temperature and/or pressure have been changed. Gaseous mixture
phases have been included in all the calculations that these diagrams are based on.

Figure 13: 1E-3 m Fe actively reacted with 1 kg of pure water at 25° C and 1 bar (as in the
calculation in Pourbaix Diagrams with Gas Phase Included).
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Figure 14: 1E-6 m Fe actively reacted with 1 kg of pure water at 25° C and 1 bar. Note that the
active metal corrosion region gets enlarged as the initial Fe amount decreases from 1E-3m to 1E6m.

Figure 15: 1E-6 m Fe actively reacted with 1 kg of water, 3m NaCl and 1E-5 m SO2 at 25° C and 1
bar. Introducing SO2 into the system leads to the formation of various metal-sulphides (Py-pyrite,
Popyrrhotite, Tr-troilite). In addition, the passivation region becomes larger.
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Figure 16: 1E-6 m Fe actively reacted with 1 kg of water, 3m NaCl and 1E-5 m SO2 at 150° C and
100 bar. Here, changing the temperature and pressure affects the stability fields of various Feoxides/sulphides.

As you can see from the figures, the aqueous-gas phase boundaries shift as the initial bulk
compositions, pressure and temperature conditions in the interaction system change.
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Pourbaix Diagrams for Complex Alloys
Thermo-Calc can not only be used to simulate how pure metals interact with pure water or
simple aqueous solutions under normal pressure and temperature conditions. It can also be
used to calculate how complex alloys and concentrated aqueous solutions interact over a
very wide pressure, temperature and composition ranges. This is illustrated with the two
examples.
The first example is a Pourbaix diagram calculated for the heterogeneous interaction
between 0.001 mole of steel (Fe-7.676Cr-5.0Ni-2.1887Mn-1.0Cu [at%]) and 1 kg of water
(and with 1.2 m H3BO3, 0.022 m Li and 0.001 m NH3), at 25° C and 1 bar. This application is
particularly useful for safety assessments of nuclear reactors and nuclear waste repositories.

The next example is a Pourbaix diagram calculated for the heterogeneous interaction
systems between 0.1 mole of AISI4340 stainless steel (Fe-0.80Cr-1.85Ni-0.70Mn-0.25Mo0.25Si-0.40C [wt%]) and 1 kg of seawater (with the equivalent of 0.6054 m NaCl), at 25° C
and 1 bar. This application is particularly useful for failure analysis of petroleum exploitation
industry.
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